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Introduction      1

Introduction

W 
elcome to the wonderful world of AutoCAD and to the fame and fortune 
that awaits you as an AutoCAD user. (Would I lie to you?)

Believe it or not, AutoCAD is 34 years old, having been born in December 
1982, when most people thought that personal computers weren’t capable of 
 industrial-strength tasks like CAD. The acronym stands for Computer-Aided 
Drafting, Computer-Aided Design, or both, depending on whom you talk to. 
What’s equally scary is that many of today’s hotshot AutoCAD users, and most of 
the readers of this book, weren’t even born when the program first hit the street 
and the grizzled old-timer writing these words began using it.

AutoCAD remains the king of the PC computer CAD hill by a tall margin, mak-
ing it one of the longest-lived computer programs ever. It’s conceivable that the 
long-term future of CAD may belong to special-purpose, 3D-based software such 
as the Autodesk Inventor and Revit programs, or to specialized market-specific 
variations built on top of AutoCAD. At any rate, AutoCAD’s DWG file format is the 
de facto standard, so AutoCAD will be where the CAD action is for the foreseeable 
future.

You may have heard that AutoCAD is complex and difficult to learn and use. Yes, 
the menu system includes about 1,300 icons. Well, it has been my observation 
that the easier any software is to learn and use, the sooner you bump up against 
its limitations. A car with no accelerator, one forward gear, no steering, and no 
brakes would be easy to use until you reached a hill, a curve, or a stop sign or you 
needed to back out of a parking space.

Yes, AutoCAD is complex, but that’s the secret to its success. Some claim that few 
people use more than 10 percent of AutoCAD’s capabilities. Closer analysis reveals 
that most people use the same basic 5 percent and everyone else uses a different 
5 percent after that. The trick is to find your 5 percent, the sweet spot that suits 
your particular industry. If you follow my advice, I think you will find that using 
AutoCAD is as simple and intuitive as driving a car.

It should also be perfectly clear that if your career path has put you in a position 
where you need to know how to use AutoCAD, you’re no dummy!
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About This Book
Unlike many other For Dummies books, this one often tells you to consult the official 
software documentation. AutoCAD is just too big and powerful for a single book 
to attempt to describe it completely. The book that ultimately covers every Auto-
CAD topic would need a forklift to move it. Literally. They stopped shipping paper 
instruction manuals with the software somewhere around 1995, when the full 
documentation package grew to about a dozen volumes and more than 30 pounds.

In AutoCAD For Dummies, I occasionally mention differences from previous releases 
so that everyone gains some context and so that upgraders can more readily 
understand the differences; plus, you’re bound to encounter a few of the billions 
and billions of drawings that were created using older methods. I also mention the 
important differences between AutoCAD and AutoCAD LT. In particular, AutoCAD 
LT has no programming language and has extremely limited support for para-
metrics (Chapter 19) and 3D (Chapter 21).

This book is not Mechanical Drafting For Dummies, or Architectural Drafting For Dum-
mies, or even Crash Testing For Dummies It doesn’t cover drafting principles and 
procedures, but it does cover the AutoCAD commands necessary to create draw-
ings. Remember, though, that knowing AutoCAD’s drawing commands won’t 
make you a great designer, just as knowing how to touch-type and run a word 
processor won’t make you a great author. The job title CAD operator doesn’t exist, 
but almost all drafters and designers use CAD.

In addition, the book does not cover the discipline-specific features in AutoCAD-
based vertical market products, such as AutoCAD Electrical or AutoCAD Mechani-
cal, although most of the information in this book applies to the general-purpose 
features of those programs as well.

This book covers AutoCAD 2015 through 2017. The obvious major differences 
between these versions and 2014 and earlier are the initial startup screen and the 
format of the Ribbon menu. The underlying principles remain the same. I will 
draw your attention to other differences where appropriate.

Late in 2010, Autodesk released the first non–Microsoft Windows version of 
AutoCAD in 20 years. Although AutoCAD for Mac is now available, AutoCAD For 
Dummies covers only the Windows version. The two versions are file-compatible, 
but they differ in many ways in how they look and what they can do. If you have 
AutoCAD for Mac, you should be able to grasp basic concepts but you might 
be better off with a Mac-specific book such as Mastering AutoCAD For Mac, by 
George Omura and Rick Graham (Sybex Publishing) or What’s Inside? AutoCAD for 
Macintosh, by Ralph Grabowski, available as an e-book at www.worldcadaccess.
com/ebooksonline/2015/07/wia.html.

http://www.worldcadaccess.com/ebooksonline/2015/07/wia.html
http://www.worldcadaccess.com/ebooksonline/2015/07/wia.html
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Foolish Assumptions
AutoCAD has a large, loyal, dedicated group of longtime users. AutoCAD For Dum-
mies is not for you if you’ve been using AutoCAD for a decade or more, if you plan 
your vacation time around Autodesk University, if you used AutoCAD to create 
your wedding invitations, if you tell police officers that you can walk a straight 
line if they will press F8 first, or if you read 1,200-page technical tomes about 
AutoCAD for pleasure. This book is for you if you want to get going quickly with 
AutoCAD, and you understand the importance of developing proper CAD tech-
niques from the beginning.

However, you do need to have an idea of how to use your computer system 
before tackling AutoCAD and this book. You need to have a computer system with 
AutoCAD or AutoCAD LT (preferably the 2017 version but at least 2015 or later). 
A printer or plotter and a connection to the Internet are helpful, too.

You also need to know how to use your version of Windows to copy and delete 
files, create a folder, and find a file. You need to know how to use a mouse to select 
(highlight) or to choose (activate) commands, how to close a window, and how to 
minimize and maximize windows. You should be familiar with the basics of your 
operating system before you start using AutoCAD.

Conventions Used in This Book
Here are some conventions that you’ll run across in this book.

Using the command line
The command line is that grey area near the bottom of the screen that says Type 
a command. One way of using AutoCAD is to type command names in this area. In 
addition, this is where AutoCAD talks back when it needs information from you. 
Examples of AutoCAD prompts appear in a special typeface, as does any other 
text in the book that replicates a message, a word, or text that appear onscreen. 
Sequences of prompts that appear in the AutoCAD command line have a shaded 
background, like this:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>:
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When there is a specific action that I want you to take at one of these prompts, 
look for the italic passage at the end of this line, where I want you to press Enter:

Specify ending width <5.0000>: Press Enter

Text that I want you to type into the program at the command line, in a dialog 
box, in a text box, or elsewhere appears in boldface type, like the 3 at the end of 
the following line.

Specify starting width <0.0000>: 3

Many figures in this book also show AutoCAD command-line sequences that 
demonstrate AutoCAD’s prompts and sample responses.

Using aliases
Many AutoCAD commands have aliases — these shortcut versions have fewer let-
ters than their full commands, in case you like to type commands at the AutoCAD 
command line. In this book, I show aliases in uppercase as part of the command 
names. To start a command, you have to type only its uppercase letters. For exam-
ple, to draw a line, type either LINE (the official command), or just L (its alias) 
and then press Enter to execute the command. When I tell you to start a com-
mand, I spell it out in full (such as Line, Circle, or COpy), but you need to enter 
only the letters shown in uppercase (L, C, or CO, respectively). Note also that the 
uppercase letters aren’t always the initial letters nor are they always adjacent. For 
example, the eXit command can be entered as the full word or as just the letter X 
and DimANgular can be entered simply as DAN.

Command entry at the keyboard became even easier starting with AutoCAD 2014. 
As you begin to type a command name, the program will try to guess what you 
want and display a list of suggestions. You can then click the one you want or keep 
typing until your choice rises to the top.

Icons Used in This Book
Throughout this book, I point out certain morsels of particularly important or 
useful information by placing handy little icons in the margin. Naturally, different 
icons indicate different types of information:
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Herein lies a pointed insight that can save you time and trouble as you use Auto-
CAD. In many cases, Tip information acts as a funnel on AutoCAD’s impressive but 
sometimes overwhelming flexibility: After telling you many of the ways that you 
can do something, I tell you the way that you should do it, in most cases.

The Technical Stuff icon points out places where I delve a little more deeply into 
AutoCAD’s inner workings or point out information that most people don’t need 
to know most of the time. These paragraphs definitely are not required reading, 
so if you see one at a point when you’ve reached your techie-detail threshold, feel 
free to skip it.

Warning tells you how to stay out of trouble when living close to the edge. Failure 
to heed its message may have unpleasant consequences for you or your  drawing — 
or both.

You have a lot to remember when you’re using AutoCAD, so I’ve remembered to 
remind you not to forget about some of those things that you should remember.

Beyond the Book
I have written a lot of extra content that you won’t find in this book. Go online to 
find

 » AutoCAD drawings: Drawings that you can use with this book are at

www.dummies.com/go/autocadfd17

The drawings, which are on the Downloads tab, are in Zip format; just down-
load and unzip them and they’re ready to open in AutoCAD. The Zip files, 
which are named according to chapter, contain one or more drawing files. For 
example, afd03.zip contains the versions of the drawing in Chapter 3. Note 
that not all chapters have associated drawing files.

 » Cheat sheet: The cheat sheet for this book has a roadmap for setting up your 
drawings as well as a list of keyboard shortcuts. To get to the cheat sheet, go 
to www.dummies.com and type AutoCAD For Dummies in the Search box.

 » Updates: If I have any updates to the book, you can find them at www.
dummies.com/extras/autocad17.

http://www.dummies.com/go/autocadfd17
http://www.dummies.com
http://www.dummies.com/extras/autocad17
http://www.dummies.com/extras/autocad17
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Where to Go from Here
Because you’re reading this Introduction, you’re like me — you like to read. (The 
cut-to-the-chase people tend to flip to the index right away and look up what 
they need to know at that instant.) If you’re a total AutoCAD newbie, you can read 
this book in order, from front to back; it follows a straightforward route from set-
ting up the drawing environment to outputting your masterworks on hard copy to 
sharing your work with others.

If you’re an experienced user, you’ll probably be an index-flipper who looks for 
the missing information needed to complete a specific task. You can probably find 
the index on your own, but I encourage you to browse through this book anyway, 
with a highlighter or sticky notes in hand, so that you can find those particularly 
important places when you need them again.

Whichever route you choose, I hope that you enjoy your time with AutoCAD For 
Dummies. A-a-and, you’re off!



1Getting Started  
with AutoCAD



IN THIS PART . . .

Find your way around the AutoCAD screen, and see 
where the tools you use most often, such as the 
Ribbon, the graphic screen, and command line, are at.

Discover the half-dozen commands that account for 
much of your AutoCAD activities.

See the big picture: from how to start a drawing to 
printing it.

Correctly set up AutoCAD and create templates for 
drawing success.

Navigate through your drawing by panning and 
zooming.
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IN THIS CHAPTER

Launching AutoCAD

Creating your first drawing in 
AutoCAD

The complete picture

The difference between pixels and 
vectors

Comprehending the Cartesian 
coordinate system

The DWG file format

Introducing AutoCAD 
and AutoCAD LT

This chapter helps ease you into using AutoCAD to create engineering 
 drawings and how to get started. Although it’s not uncommon to feel over-
whelmed the first time you see AutoCAD, rest assured that you don’t need to 

learn all of the controls that you see in the default environment to be an efficient 
user of the program.

After a brief introduction to the program, I take you through an exercise to show 
you just how easy it can be to use AutoCAD. The exercise is followed up with some 
key concepts that you should understand when using AutoCAD, including how it 
differs from most other computer applications.

When you’re starting out with AutoCAD, heed this quote from The Hitchhiker’s 
Guide to the Galaxy:

Don’t panic!

Chapter 1
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Launching AutoCAD
The first thing you need to do to start using AutoCAD is to launch the AutoCAD 
program (well, duh!) and, if necessary, maximize its screen display. AutoCAD has 
so many tools and palettes that you’ll almost always want to use it in full-screen 
mode. Follow these steps:

1. Launch AutoCAD.

As indicated in the Introduction, I assume that you have a working knowledge 
of how to use your version of Windows, including how to launch applications. 
Depending on your version of Windows and how it is set up, you might have to 
double-click a desktop icon or find a suitable entry in the Start → [All] Programs 
menu or Start → All Apps menu on the start screen. The wording of the 
selections varies depending on the version of AutoCAD and Windows.

2. Start a new drawing.

Click the large Start Drawing icon towards the upper-left corner of the screen.

3. If something called the Design Feed palette is displayed, close it by clicking 
the X in its top-left corner.

I’m assuming that you aren’t quite ready to post your drawing to the web so 
you can share it and collaborate live with other people.

4. If necessary, expand AutoCAD to full-screen mode.

Click the middle Windows button in the upper-right corner of the application 
window.

5. If necessary, expand the graphic area (the big, gray area in the middle) to 
full-screen size.

Click the middle button in the upper-right corner, near the compass rosette.

6. Place the cursor in the gray graphics area (midscreen), and then press the Esc 
key twice to make sure that no commands are active.

Now you’re ready to start drawing in AutoCAD, as shown in Figure 1-1. You can 
find out how to create a custom profile in the cheat sheet for this book. Go to 
www.dummies.com and search for AutoCAD For Dummies.

Your screen may look a little different from Figure 1-1 depending on your version 
of AutoCAD and Windows and your screen resolution. Note too that although you 
will draw using white on dark gray (refer to Figure 1-1), I drew using black on 
white (see Figure 1-2), and my menu icons have a white background compared to 
your dark gray background.

http://www.dummies.com
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Drawing in AutoCAD
AutoCAD offers a wide range of commands to create, modify, and annotate 2D 
designs. Don’t feel as though you need to learn and master every one of the 1,300 
or so commands and options that AutoCAD offers to be a proficient drafter; most 
veteran drafters probably use only 20 or so commands for most basic drafting 
tasks.

FIGURE 1-1:  
Your AutoCAD 

2017, ready  
to draw!

FIGURE 1-2:  
My AutoCAD 
2017, ready  

to draw!
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The following simple exercise introduces a few of the commonly used commands 
to establish the size of your drawing area as well as the commands for creating 
straight line segments and circles.

You can start a command by clicking its button in the Ribbon menu, across the 
top of the screen, or by entering the command’s name in the command line, which 
is the light-gray text-entry area at the bottom of the screen that reads Type a 
command.

In this exercise and others in this book, AutoCAD’s command line entries look 
like this, and you type the commands and responses shown in bold. Press Enter 
after each command or response that you type.

You don’t even have to move the cursor to the command line. As you type, Auto-
CAD tries to guess which command you want and displays a list of possibilities at 
the command line, even if the cursor is in the Ribbon menu area. When you see the 
command you want, simply click it in the list.

In the following exercise, don’t add spaces on either side of a comma! In most sit-
uations, AutoCAD treats pressing the spacebar the same as pressing Enter which 
makes keyboard entry fast and easy but messes things up if you do it at the wrong 
time. In addition, make sure you use a comma as the X,Y separator and the period 
(.) as the decimal delimiter, and don’t use a thousands separator. Some parts of 
the world use the comma as the decimal separator and the space as the thousands 
delimiter, either of which confuses AutoCAD no end.

In this first exercise I ask you to do things without explaining why. Trust me; all 
will become clear in later chapters:

1. Set up an appropriate size for the drawing:

LIMITS
Reset Model space limits:
Specify lower left corner or [ON/OFF] <0.0000,0.0000>: 0,0
Specify upper right corner <12.0000,9.0000>: 60,40

Now type the letters Z A and press Enter. Note that there must be a space 
between the Z and the A.

2. Disable Dynamic Input mode to work with the command line:

DYNMODE
Enter new value for DYNMODE <3>: -3
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3. Draw the frame:

Line
Specify first point: 26,12
Specify next point or [Undo]: 13,12
Specify next point or [Undo]: 22,24
Specify next point or [Undo]: 40.5,24
Specify next point or [Undo]: 41,22
Specify next point or [Undo]: 26,12
Specify next point or [Undo]: 20.6667,28
Specify next point or [Undo]: 25,28
Specify next point or [Undo]: Enter

4. Draw a bit more:

Line
Specify first point: 45,12.5
Specify next point or [Undo]: 42.87,14.53
Specify next point or [Undo]: 39.38,28.5
Specify next point or [Undo]: 35.3,30
Specify next point or [Undo]: Enter

5. Draw a round thing:

Circle
Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]: 13,12
Specify radius of circle or [Diameter]: 8

6. Draw another round thing:

Circle
Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]: 45,12.5
Specify radius of circle or [Diameter]: 8

Figure  1-3 shows the bicycle you’ve drawn, and you didn’t even need training 
wheels!

It has been claimed that Line and Circle are the second- and third-most-used 
commands after UNDO. You should now SAVE your drawing as an historic artifact. 
That was easy, wasn’t it?
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Understanding Pixels and Vectors
To use AutoCAD effectively (or even at all) you need to understand how an image 
is displayed on your computer screen, and how the image is stored when it is not 
being displayed.

 » An image on a computer screen 
is made up of pixels. If you look 
closely at the screen with a strong 
magnifying glass, you’ll see that 
the image is formed from a large 
number of small dots of light, as 
shown in Figure 1-4, called pixels. 
This has nothing to do with Tinker 
Bell, except that an on-screen image 
of her would indeed be made up 
of pixels.

 » All programs that display a 
graphic image simply turn on 
or off suitable spots to build 
the  picture. This is a raster image. A straight line in a raster image is just a 
fortuitous alignment of appropriate dots, and after it’s been created, it can’t 
be edited as a single object.

 » A major difference between CAD programs and computer graphics 
programs (such as Microsoft Paint) lies in how they save the image to 
disk. When the image from a Paint-type program is saved to disk, it’s stored 
as a bitmap that simply lists the color of each pixel. What gets saved to disk is 
simply a snapshot of what you see onscreen.

FIGURE 1-3:  
Your first  
AutoCAD  
drawing.

FIGURE 1-4:  
Pixels.
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 » All CAD programs work with and store on a vector file on disk. A vector file 
is a big collection of numbers and words that list the type, size, and location 
of every entity in the drawing. When a CAD program displays your drawing 
onscreen, it analyses the vector data and calculates which pixels to turn on or 
off, depending on which portion of the drawing you’re viewing. CAD programs 
understand that a circle is a closed curve with a center point and a constant 
radius. If you change its radius, the CAD program redraws the image onscreen 
to show the new size.

 » AutoCAD doesn’t limit you to working only with what you can see 
onscreen. You can include as much detail in a drawing as needed. You can 
zoom in to see more detail and zoom out to see the big picture. At any time, 
the screen shows only those entities and their detail that the screen is capable 
of showing.

Some screens can show more pixels than others can. The number ranges 
from the 320 per row by 200 rows (320 x 200) of the very old Color Graphics 
Adapter (CGA) to 4000 x 3000 and beyond for special-purpose adapters. 
However, the drawing file always contains the same information. If it were 
moved to a computer with a higher resolution graphics adapter and monitor, 
then greater detail would show without you having to zoom in as far. 
Conversely, a drawing file moved to a computer with a lower screen resolu-
tion does not lose any detail, but you will need to zoom in closer to see it.

How big is “the big picture”? AutoCAD can draw a circle with a radius of 1099  
(a 1 followed by 99 zeros) units, but the observable (so far) universe is “only” 
about 5.5 x 1023 miles in diameter, depending on how you measure and 
whose numbers you use (subject to change without notice). Check out  
en.wikipedia.org/wiki/Observable_universe for the latest number.

Conversely, AutoCAD can draw a circle with a with a radius as small as 10-99 
(which equals 0.00000[plus 90 more zeros plus]0001) units in diameter, as 
opposed to the classical radius of an electron, which is 2.8179403267 x 10-13 cm.

 » It’s possible for a drawing file to contain much more than you can see 
at any one time. The computer screen is not really the drawing; it is just a 
viewer that lets you look at all or part of the drawing file.

The Cartesian Coordinate System
AutoCAD uses the Cartesian coordinate system to define all locations in the draw-
ing. This includes things like the start and end of lines, the center of circles, the 
location of text notes, and so on. Cartesian coordinates are named for French 
philosopher René Descartes, who is famous for statement “I think, therefore  

https://en.wikipedia.org/wiki/Observable_universe
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I am,” although today he might say, “I tweet, therefore I am” — although tweet-
ing doesn’t always involve thinking.

In his Discourse on Method, Descartes, wearing his mathematician’s hat, came up 
with the idea of locating any point on a planar surface by measuring its distance 
from the intersection of a pair of axes. (That’s axes as in more than one axis, not 
several tools for chopping wood.) By convention, the intersection of these axes 
(called, also by convention, the X-axis and the Y-axis) are perpendicular to one 
another, and their intersection point is identified as 0,0 — or the origin.

For example, if your address is 625 East 18th Street in a typical town, you live 6¼ 
blocks east of First Avenue and 18 blocks north of Main Street.

AutoCAD also uses the notation that the origin is at point 0,0. Positive values are 
to the right of and above this point, and negative values are to the left of and below 
it. You can identify any location on a drawing by its horizontal distance from the 
origin, followed by its vertical distance from the same starting point.

AutoCAD shows Cartesian coordinates as a pair of numbers separated by a 
comma. The number to the left of the comma is the X (horizontal) coordinate, 
and the value to the right is the Y (vertical) coordinate. You used this  convention 
when creating your bicycle drawing. When working in three dimensions  
(see Chapter 21), AutoCAD adds a third coordinate: Z.

It’s worth repeating my earlier warning: Make sure you use a comma as the X,Y 
separator and the period (.) as the decimal delimiter, and don’t use a thousands 
separator.

The Importance of Being DWG
To take full advantage of AutoCAD in your work environment, be aware of the DWG 
file format — the format in which AutoCAD saves drawings. Here are some DWG 
facts to keep in mind:

 » In many cases, an older release of AutoCAD can’t open a DWG file that’s 
been saved by a newer AutoCAD release. Table 1-1 shows the relationship 
between AutoCAD versions and their corresponding file formats.

 » A newer release of AutoCAD can always open files saved by older ver-
sions. I have sample files dating back to 1984 that open in AutoCAD 2017.

 » Some previous AutoCAD releases can open files saved by a subsequent 
version or two. As Table 1-1 shows, Autodesk changed the DWG file format 

www.allitebooks.com

http://www.allitebooks.org
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every three years or so starting in 2000 but has leveled off recently so that 
drawings created in or saved by AutoCAD 2017 can be opened with AutoCAD 
2013 and later.

 » You can use the Save As option in a newer release to save a file to an 
older DWG format. In fact, AutoCAD 2017 can save as far back as AutoCAD 
Release 14, which dates all the way in the last millennium to 1997. In addition, 
you can save a file as a simple text-based DXF format as far back as Release 12. 
Table 1-1 shows which versions use which DWG file formats.

Earlier formats may not support all the features of later ones. AutoCAD does 
its best at translating, but some items may be lost or may not fully survive the 
round trip to an older release and back to the newer one.

So, do you have to use AutoCAD to produce DWG files? The answer is no. Several 
low-cost to no-cost programs claim to be compatible with AutoCAD’s DWG file 
format. They usually come with a few crunchy bits, however.

 » Because these programs have to reverse-engineer the file format, they are 
often one release behind AutoCAD’s current version.

 » These programs usually don’t fully support all AutoCAD features because of 
copyright, patent, or perceived market size limitations. In particular, para-
metrics (Chapter 19), annotative objects (Chapters 13-15), and 3D models 
(Chapters 21-23) may not survive unscathed from a round trip to the other 
brand and back to AutoCAD.

 » Yes, a line is a line and a circle is a circle in a DWG file, but the commands that you 
use in other programs to put them in the file may not operate in the same way.

TABLE 1-1 AutoCAD Versions and DWG File Formats
AutoCAD Version AutoCAD LT Version DWG File Format

AutoCAD 2013–2017 AutoCAD LT 2013–2017 AutoCAD 2013

AutoCAD 2010–2012 AutoCAD LT 2010–2012 AutoCAD 2010

AutoCAD 2007–2009 AutoCAD LT 2007–2009 AutoCAD 2007

AutoCAD 2004–2006 AutoCAD LT 2004–2006 AutoCAD 2004

AutoCAD 2000, 2000i, 2002 AutoCAD LT 2000, 2000i, 2002 AutoCAD 2000

AutoCAD R14 AutoCAD LT 1998, 1997 AutoCAD R14

AutoCAD R13 AutoCAD LT 1995 AutoCAD R13

AutoCAD R11, R12 AutoCAD LT R2 AutoCAD R11
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IN THIS CHAPTER

Touring the AutoCAD screens

Going bar-hopping: Title bars and the 
status bar

Unraveling the Ribbon

Practicing with palettes

Discovering the drawing area

Using online help

The Grand Tour 
of AutoCAD

Over the years, AutoCAD’s interface has undergone many changes, ranging 
from a simple text menu down the right side (still the second-fastest way 
of using AutoCAD) to drop-down menus, toolbars, the Dashboard (which 

only survived two releases — 2007 and 2008), tool palettes, and, for now, the 
Ribbon menu.

Like the rest of this book, this chapter is written for someone who has used 
other Windows programs but has little or no experience with AutoCAD. Here and 
throughout the rest of the book, I show you how to do things by using AutoCAD’s 
implementation of Microsoft’s flavor of the year of its Fluent User Interface (or 
FUI; pronounced “foo-ey”). AutoCAD has always been big on backward compat-
ibility, and this includes the interface. You can always shift between earlier and 
newer versions of the user interface.

Chapter 2
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Looking at AutoCAD’s Drawing Screen
When you first open AutoCAD, you encounter the Start screen. I can already hear 
your plaintive cry: “Where do I draw? The screen is full!” No problem. The Start 
screen (shown in Figure 2-1) is just a menu of available actions. It should be quite 
obvious as to what each item does. For now, just click the big Start Drawing icon.

You can always get the Start screen back by clicking its tab in the upper-left  corner 
of the large gray drawing area.

If the screen is still partially obscured by the Design Feed palette, close it by 
 clicking the X in its upper-left corner. AutoCAD remembers that you closed it and 
doesn’t open it next time. Don’t worry: When you’re ready to upload your draw-
ings to the web so you can share and collaborate, getting the palette back on the 
screen is easy; click the button on the Palettes panel of the View tab on the Ribbon 
menu.

Figure 2-2 shows the screen you then see, AutoCAD’s default drawing window.

Your screen will have a dark gray background. I’m using a white background 
because it is clearer on the printed page.

FIGURE 2-1:  
AutoCAD’s 

Start screen.
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Now you’re ready to get to work. Starting from the top down, AutoCAD’s interface 
has eight main sections:

 » The Application menu: Click the Application button (known informally as ”the 
big red A”) at the top-left corner of the AutoCAD window to open the AutoCAD 
Application menu. It presents mostly file-related commands; from this menu 
you can create new drawings, open existing drawings, save files, or print 
 masterpieces. It also gives access to the Options command.

 » The Quick Access toolbar: This toolbar, in the top-left corner of the screen, 
includes buttons for some of the most commonly used functions, such as 
Save and Undo. You can add functions that you use all the time and delete 
unneeded buttons by clicking on the down-facing triangle at the right-hand 
end of the toolbar.

 » The Ribbon: Whereas the Application menu focuses on file management, the 
Ribbon holds commands to create and modify drawing objects.

 » Tabs: The series of tabs across the top of the graphic screen, one for each 
open drawing, makes it easy to jump from drawing to drawing, compared to 
earlier releases. New tabs appear as you open or start additional drawings.

 » The graphic screen: It’s the “piece of paper” on which you draw.

Application button

Quick Access toolbar

Open drawing tabs

Title bar InfoCenter Ribbon

Navigation bar

Workspace Switching button

Graphic screenStatus barCommand line

FIGURE 2-2:  
AutoCAD’s 

default  
drawing  
window.
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 » The command line: This window, the chat room between you and AutoCAD, 
displays your input to AutoCAD and (equally important) tells you what it needs 
from you.

If you’re having a problem and all else fails, read the command line.

 » The space tabs: These tabs let you switch between model space and any 
paper spaced layouts. I discuss paper space layouts in Chapter 12.

 » The status bar: The status bar tells you an awful lot about how many of 
AutoCAD’s operating variables are set and in which way. The status bar does 
more than show you settings, however. You can set, reset, and change most 
settings from the status bar. I discuss many of these settings in later chapters.

Because of the way that AutoCAD has evolved, you usually have four or five ways 
to invoke a command, primarily the Ribbon, keyboard entry, toolbars, menu bar, 
and screen menus. Throughout this book, I focus on the Ribbon and direct key-
board entry because the other methods, from earlier releases, aren’t turned on in 
recent releases of AutoCAD.

PROFILING YOUR DISPLAY
The illustrations and descriptions in this chapter and throughout the book show the 
default configuration of the AutoCAD 2017 Drafting & Annotation workspace. That is, 
I show the way the screen looks if you use the standard version of AutoCAD and not 
a flavored version, such as AutoCAD Architecture or AutoCAD Mechanical. The main 
change I make in this book from AutoCAD’s default settings is to configure the drawing 
area background to be white because the figures show up better in print. The default 
background color in both AutoCAD and AutoCAD LT is dark gray, but many longtime 
users prefer a pure black background for less glare but this is much less of an issue with 
LCD flat-panel displays. You may want to set a black or a white background on your own 
system or stay with the default gray background. It’s your choice, and there’s no right 
or wrong way. Some AutoCAD object colors show up better on a light background, and 
some are better on a black one.

If you want to print in color, you may use a white screen so that WYSIWYG (What You See 
Is What You Get) on your monitor matches what you see on paper. This is discussed in 
Chapter 16.

You may also notice subtle differences in AutoCAD’s appearance, depending on which 
version of Windows you’re using and if you have used the Windows Control Panel to set 
it up for best performance instead of the default setting of best  appearance.
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As slick as they are, navigating Ribbon panels and browsing the Application menu 
aren’t always the most efficient ways of doing things. When you want to do real 
work, you need to combine the Ribbon panels with other methods, especially 
entering commands and options at the keyboard or choosing them from right-
click menus.

A workspace defines an operating environment including such things as which version 
of the Ribbon menu to use and whether or not toolbars are used. In  addition to the 
default Drafting & Annotation workspace, a few additional preconfigured work-
spaces are available from the Workspace Switching button. You can also create 
customized workspaces. I stick with the out-of-the-box Drafting & Annotation 
workspace, except in Part 5, which describes 3D modeling.

For your information
Located at the right side of the program title bar, InfoCenter serves as Information 
Central in AutoCAD. You can

 » Search for information. Type a keyword and then click the binoculars for 
more information.

 » Sign in to your Autodesk 360 account. Click the Sign In link and log in with 
your username and password. Autodesk 360 is a free, web-based file storage 
and collaboration service in the cloud.

 » Download free or inexpensive add-ons. Click the button that looks like a 
half-positive, half-negative X to open the Autodesk Exchange Apps website.

 » Connect to Autodesk via social media. Click the triangle button to see a list 
of links for product updates and to connect to Autodesk via social networks 
such as YouTube, Twitter, and Facebook.

 » Find help. Click the question mark button in the InfoCenter area to open a 
Help page.

If you’re floundering, looking for the weird icon for the command you want to use, 
click the down arrow at the right end of the Quick Access toolbar and select Show 
Menu Bar. A classic text-based menu appears above the Ribbon.

You may already be familiar with the Quick Access toolbar from Microsoft Office 
applications. Other features AutoCAD has in common with Office (and most 
 Windows applications) are the capability to have more than one file open at a 
time, to cut or copy and paste between files, to tile or cascade multiple open files 
(see Figure 2-3), and to minimize, restore, and maximize individual drawings and 
the application itself.
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Making choices from the Application menu
The Application menu is accessible from all workspaces. The AutoCAD Application 
menu follows the Microsoft FUI guidelines in placing file management commands 
there. The Application menu is divided into ten categories. You’ll find the following 
commands on the Application menu:

 » New: Create a new drawing from a list of templates.

 » Open: Open an existing drawing.

 » Save: Save the current drawing in the current location; if the current drawing 
hasn’t been saved, you’re prompted for a filename and a location.

 » Save As: Save the current drawing to a new filename or location or both, and 
make the newly named or located file the current drawing.

 » Import: Open drawing files stored in formats other than DWG. I discuss this 
feature in Chapter 24.

 » Export: Save the current drawing to a large variety of file formats, including 
Design Web Format (DWF), PDF, and several other CAD file formats.

 » Publish: Send a 3D model to an outside 3D printing service, or create an 
archived sheet set. (AutoCAD LT doesn’t support 3D.) Use eTransmit to create 
a package that includes all files referenced by the selected drawings, or email 
the current drawing by using your configured email client.

Drawing window control buttonsDrawing window title bar

FIGURE 2-3:  
The  AutoCAD 

screen with 
several 

windowed 
 drawings  

in view.
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 » Print: Print a single drawing or batch-plot multiple drawings, create or modify 
named page setups, and manage plotters and plot styles. I cover most of 
these operations in Chapter 16.

 » Drawing Utilities: Set file properties or drawing units; purge unused blocks, lay-
ers, and styles from the current drawing; and audit or recover damaged drawings.

 » Close: Close the current drawing or close all drawings. If any drawings have 
changed, you’re prompted to save them before AutoCAD closes the file.

The CLOSEALLOTHER command, new in AutoCAD 2016, closes all open drawings 
except for the active one. You won’t appreciate the significance of this feature 
until you have opened 20 or so drawings looking for a particular one and now want 
to close the rest. Unfortunately, the command doesn’t appear in the Ribbon menu.

In addition to the Application menu’s file menu items, a few other features are 
worth a mention:

 » Recent Documents: If you choose this option, the right pane displays a list of 
recently edited drawings that aren’t open. You can show them in a simple list 
or as thumbnail images. You can also pin them to stop them from scrolling off 
the list. Naturally enough, clicking an icon opens the drawing.

The Recent Documents feature is hardly necessary, however. Instead, click the 
Start tab near the upper-left corner of the screen to bring back the Start 
screen, which displays a scrollable series of thumbnail views of the last few 
open drawings, as shown in Figure 2-1 earlier in the chapter.

 » Open Documents: Choose this option to see which documents are already 
open, and click an item to switch to it.

This feature, like Recent Documents, isn’t necessary because a series of tabs 
appears across the top of the graphic screen, one for each open drawing. 
Hovering the cursor over a tab produces a quick preview of its drawing, which 
makes jumping from drawing to drawing much easier compared to earlier releases.

 » Options: Click this button to open the Options dialog box, where you can 
adjust hundreds of system settings. You can also open Options by typing OP 
(the alias for the OPtions command).

 » Search: If you’re unsure of a command name or you want help on a topic, just 
start typing in the search bar, at the top of the Application menu. AutoCAD 
quickly displays a categorized list, complete with links to start commands or to 
access the online Help system. See Figure 2-4.

You can also search directly from the command line. Just start typing the 
name of a command. As you type, AutoCAD displays a list of what it thinks you 
are searching for. When you see the one you want, click the question mark 
beside its name to get help about the selected item.
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A quick way to close AutoCAD is to 
double-click the big red A. AutoCAD 
asks whether you want to save unsaved 
drawings before it shuts down.

Unraveling  
the Ribbon
The primary interface element in the 
Drafting & Annotation, 3D Basics, and  
3D Modeling workspaces is the Rib-
bon, an adjustable area that contains 
different collections of tabbed, task-
oriented collections of panels. Those 
panels marked with a little down-
facing triangle on the panel label have 
more tools concealed on a slideout 
(see Figure 2-5). Click the panel label 
to open the slideout. You can click the 
pushpin icon to pin open the slideout if 
you don’t want it to slide home when 
you’re done using it.

If you use a particular Ribbon panel often, click and drag it into the drawing 
area. If, for example, you’re doing a whack of dimensioning, you can drag the 

Pin the slideout Panel slideout

FIGURE 2-5: 
More tools 

than you can 
wave a  

Ribbon at.

FIGURE 2-4:  
If you can’t find it on the Ribbon or in the tool 
buttons, just start typing!



CHAPTER 2  The Grand Tour of AutoCAD     27

Dimensions panel into the drawing and it stays put, even as you switch to other 
panels or tabs.

You can fully customize the Ribbon, but I don’t get into customizing AutoCAD in 
this book. If you want to find out more, enter Customization Guide in the search 
window.

By default, the Ribbon is docked at the top of the screen, but you can dock it 
against any edge, anchored to the left or right side of the AutoCAD window, or 
floated. To gain some screen space, you can click the little white button to the 
right of the last tab on the Ribbon’s tab bar to reduce the amount of space the Rib-
bon occupies, or use the drop-down menu next to the little white button to tailor 
the Ribbon’s display, or drag individual tabs over to a second monitor.

Depending on your screen’s resolution the Ribbon may not show all of the com-
mand buttons within a panel, all the available panels within a tab, or even all 
available tabs. If a panel looks empty, click on the down arrow at its lower edge to 
see all the buttons. If entire tabs or panels seem missing then simply right-click 
anywhere within the Ribbon and then click on Show Tabs to see a list of all the 
tabs, or on Show Panels to see all the available panels within the current tab.

NO EXPRESS SERVICE?
If the Ribbon in your version of AutoCAD doesn’t include the Express Tools tab (at the far 
right end — refer to Figure 2-2), consider installing them. AutoCAD LT does not include 
or support the Express Tools.

When you first install AutoCAD, you choose between the Typical and Custom installa-
tions. If you choose Typical, the next screen asks whether you want to install the Express 
Tools. If you choose a Custom installation, on the next screen, make sure to select the 
Express Tools item in the list of components. If you don’t install the Express Tools during 
initial setup, you have to rerun the setup routine. If you haven’t installed AutoCAD yet, 
I strongly recommend that you choose the Typical installation option or at least make 
sure that the Express Tools check box is selected during a Custom installation. So what 
are the Express Tools? They are what programmers play with in their spare time. They 
can be extremely useful but aren’t fully supported by Autodesk. If users show enough 
interest in particular tools then they often get rolled into future releases. Examples 
include a tool to arrange text around a circular arc, or to draw a jagged break symbol 
when the real line is longer than line in the drawing such as a long shaft.
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The tabs on the Ribbon are organized by task:

 » Home: Contains Draw, Modify, Layers, Annotation, Block, Properties, Groups, 
Utilities, Clipboard, and View panels. Some panels may be displayed as col-
lapsed, depending on the screen resolution. I cover most of the commands in 
these panels in other parts of the book.

 » Insert: Groups Block and Reference panels as well as Point Cloud tools, 
Import commands, and a series of commands for working with nongraphical 
information including attributes, fields, data links, and geographic data.  
I cover blocks (see Chapter 17) and external references (see Chapter 18), but  
a description of point clouds and data tools is beyond the scope of this book.

 » Annotate: Expands on the minimalist Annotation panel on the Home tab, 
with many more options for creating text, dimensions, leaders, and tables, as 
well as markup functions and a few annotation-scaling tools.

 » Parametric: Serves as home base of one of AutoCAD’s most powerful 
features. You can apply geometric or dimensional parameters or constraints 
(rules of behavior) to drawing objects so that, say, two circles always have 
equal diameters or the length of a rectangle is always twice its width. I intro-
duce parametric drawing in Chapter 19.

AutoCAD LT is limited when it comes to parametrics. You can modify or delete 
existing constraints, but you need the full version of AutoCAD to create them.

 » View: Contains tools and panels for controlling drawing display, working with 
viewports, loading various palettes, and organizing Windows functions, such 
as cascading open files or displaying different parts of the application window. 
I explain most of the features on this tab later in the book.

 » Manage: Contains panels that access the Action Recorder and CAD Standards, 
neither of which is in AutoCAD LT, and a set of drawing management and 
customization tools. I don’t cover anything on the Manage tab in this book.

 » Output: Has panels that allow you to get those drawings off your hands by 
printing (also known as plotting) or publishing them, exporting them to PDF 
or DWF files, or simply sending them electronically to others. I cover some of 
these functions in Chapter 16.

 » Add-Ins: The number and names of panels varies between releases, but they 
all have a Content panel with a single Explore button that runs the Content 
Explorer tool. After you let Content Explorer index your file folders, it can win-
now through all your drawings, looking for specific blocks, layers, layouts, and 
even text strings.

 » A360: Most of the buttons fire up a login screen for the AutoCAD 360 service. 
Using an A360 account, which you can create for free, you can upload draw-
ings to a secure website and then access them on your iPad (you do have an 
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iPad, right?) or Android device or on any computer with a web browser. You 
can also invite non-AutoCAD users to view and mark up your drawings or to 
join you for a discussion, using a standard web browser.

 » Express Tools: Holds an invaluable set of custom commands that streamline 
your work procedures in pretty well every aspect of AutoCAD. The Express 
Tools are created when a programmer says, “Hey, how about if we try . . .” The 
tools often serve as the final beta-test version of new features that sometimes 
are incorporated directly into later releases. They’re officially unsupported, 
but they’ve been an install option in many recent releases, and, mostly, they 
work well. Express Tools are not available in AutoCAD LT.

 » Layout: Has a series of panels used to create and modify paper space layouts, 
and to create 2D drawing views from 3D models. I mention paper space 
layouts in Chapters 4 and 5, and I introduce 3D in Part 5. This tab appears only 
when you are working in paper space, which I cover in Chapter 23.

Some Ribbon buttons may be hidden under other, similar ones. For example, 
POLygon may be hidden under RECtangle or vice versa, depending on which you 
used last.

Other Ribbon tabs may exist if you purchased AutoCAD as part of a suite — a series 
of collections of related Autodesk products that are sold in one package.

Getting with the Program
In most of this book I focus on 2D drafting, which is by far the easiest way to get 
your feet wet with AutoCAD. Just don’t drip water on your computer. If you’re 
not already in the Drafting & Annotation workspace (the default workspace), you 
can return to it by clicking the Workspace Switching button, towards the right 
end of the Status bar (and shown in the margin). I cover workspace switching in 
more detail in Chapter 21, where I discuss 3D modeling that has a different work-
space. When you are in the Drafting & Annotation workspace, AutoCAD displays 
the interface shown earlier, in Figure 2-2.

Like all good Windows programs, AutoCAD has tooltips, those short descriptions 
that appear in little text boxes whenever you hover the mouse pointer over a but-
ton. In AutoCAD, tooltips display two levels of information. When you hover the 
mouse pointer over a tool button, you first see a short identification of the com-
mand. If you continue hovering, a longer description of the icon’s function, often 
with a graphical image, appears in an extended tooltip. As helpful as they are 
when you’re starting with AutoCAD, you’ll probably want to remove these train-
ing wheels sooner or later because they cover up some of your drawing. You can 
do so in the Options dialog box. See the online Help system for more information.
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I’m intrigued by the computer industry’s fascination with icons. Traditional Chi-
nese uses about 450,000 icons, but in the 1950s Simplified Chinese came into 
being with only 4,500 icons. On the other hand, Korean is generally considered 
to be the best written language in the world. It has 24 “letters,” no punctuation 
marks, does not distinguish between uppercase and lowercase, and is perfectly 
phonetic. On the other, other hand, AutoCAD uses about 1,300 icons.

Looking for Mr. Status Bar
The application status bar (see Figure 2-6), which appears at the bottom of the Auto-
CAD screen, displays — and allows you to change — several important drawing 
modes, aids, and settings that affect how you draw and edit in the current drawing.

Earlier AutoCAD releases allowed you to set status bar buttons to display icons or 
traditional text labels. Now, unfortunately, we’re stuck with icons only. The good 
news is that the F keys (F3, F5, and so on) can be used to turn on and off the most 
commonly used drawing modes.

In Figure 2-6, I present the status bar in two rows so you can see the icons at a 
reasonable size. On the AutoCAD screen, the status bar is one long line of icons 
(unless your computer has a lower screen resolution, which forces the bar onto 
two lines).

I cover each status bar setting as appropriate when I discuss its relevant com-
mands. See the online extras for a description of each of the status bar buttons.

Using Dynamic Input
The F12 key turns Dynamic Input on and off. When it is active, most command 
input and responses from the command line are repeated in the graphic area of 
the screen, close to the current cursor location. Dynamic Input is supposed to 
increase efficiency because you don’t have to shift your focus between the com-
mand line and the current cursor location. On the other hand, many users find it 
too distracting to have everything dancing and flashing around the cursor, and it’s 
probably not good for your eyes to always be focused on the same point.

When Dynamic Input is on, coordinate values you enter from the keyboard are 
relative to the current location. When Dynamic Input is off, values are absolute 
relative to the drawing origin.

FIGURE 2-6:  
Status (bars) 

check.
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Don’t get in the habit of relying on Dynamic Input. Sometimes there simply isn’t 
room in the Dynamic Input tooltip to show as much information as you get at the 
command line.

The Dynamic Input tooltip doesn’t dis-
play options unless you press the down-
arrow key, as shown in Figure  2-7. 
Pressing the up-arrow key displays pre-
vious input.

I like Dynamic Input. Really, I do. 
But sometimes it fights with normal  
command input, and that can make 
things really confusing.

Let your fingers do the talking:  
The command line
The command line (or command win-
dow, or command prompt, or command 
area, or whatever you want to call it), 
as shown in Figure 2-8, is a throwback 
to the dark ages of AutoCAD. It puzzles 
newcomers and delights AutoCAD aficionados. Despite Dynamic Input, the com-
mand line is the most efficient way of performing many AutoCAD operations.

Cozy up to the command line because it’s AutoCAD’s primary communications 
conduit back to you. AutoCAD displays prompts, warnings, and error messages in 
the command line that Dynamic Input may not show. Even if Dynamic Input gives 
you the same info, glancing at the command line is more efficient.

If you take away only one tip from this book, it should be this: “When all else fails, 
read the command line!”

The command line is a semitransparent toolbar that can float anywhere on the 
screen, allowing drawings to show through it. This recovers some of the vertical 
window area that was lost to the Ribbon. Hey, Microsoft, computer screens are 
getting wider, not taller! By default, the command line displays one command 
input line plus the last input prompts, but you can change the number of input 
prompts that are displayed.

As a command is running, the command line often displays several options that 
can be invoked during the command. You invoke an option by entering the upper-
case letter or letters shown in each option, such as End or Mid. It’s usually but not 

FIGURE 2-7:  
Choosing command options from the Dynamic 
Input menu.

FIGURE 2-8:  
Obey the command line; that is an order.
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always the first letter. Some commands have more than one option whose name 
begins with the same letter, such as Entity versus Exit, so you enter E for Entity 
but X for eXit. For consistency, some options use a letter other than the first letter 
even if the current command doesn’t have conflicts. The most common example is 
eXit, which always uses X even if no other options start with E. Entering command 
option choices is not case-dependent. X or x will both work. However, ON and OFF 
must be entered in full because they are shown in all uppercase.

You don’t even need to type the option letter. You can invoke an option by using 
the mouse to select it in the command line.

The key(board) to AutoCAD success
Despite (or because of) AutoCAD’s long heritage as the most successful CAD 
 software for personal computers, newcomers are still astonished at the amount 
of typing they have to do. Modern programs have much less dependency on the 
keyboard than AutoCAD does, but as you get used to it, you’ll find that no other 
input method gives you as much flexibility or speed as pounding the ivories — 
oops, wrong keyboard!

Typing at your computer’s keyboard is an efficient way to run certain commands, 
and it’s the only way to run a few others. Instead of hunting for a button or scroll-
ing through a menu, you can start a command by typing the command name and 
pressing Enter. Even better, for most common commands, you can type the short 
form for a command name (an alias) and press Enter. For example, you can simply 
type L for the Line command, C for Circle, and CO for the COpy command. Hands 
up, everyone who’d rather type APPLY instead of APPLYGLOBALCAPACITIES!

Aliases are not case-sensitive, so entering, for example, C or c will start the Circle 
command.

Print a list of aliases and highlight the ones you use most often. To see a complete 
list of command aliases, look in the AutoCAD (or AutoCAD LT) Program Parameters 
(PGP) file by going to the Manage tab and clicking Edit Aliases on the Customiza-
tion panel. When Windows Notepad opens with the acad.pgp (or acadlt.pgp) file 
loaded, scroll down to the Sample Aliases for AutoCAD Commands section.

Get comfortable using the keyboard and command line. Several everyday commands 
are nowhere to be found on the Ribbon. If you want to run those commands, you 
have to type them!

AutoCAD’s AutoComplete feature can help you become a keyboard jockey. Start 
typing a command name, and a list appears at the cursor showing all commands 
and options that start with the letters you’ve typed. You can continue until only the 
command you want appears, or you can scroll down the list and select a command.
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The command line has more functionality beyond simply entering commands and 
options. It includes a spel checquer for command names so that close enough is good 
enough, the same as hand grenades and dancing. For example, it recognizes the mis-
spelled LABLE as the correct LABEL. It also has a synonym list so that entering ROUND 
(an otherwise non-existent command) starts the FILLET  command, and it’s adaptive 
so that commands you use more frequently rise to the top of the suggestion list.

The following steps demonstrate how to use the keyboard to run commands and 
view and select options. If Dynamic Input is toggled on, press F12 to turn it off — 
temporarily, at least. Follow these steps to work with the command line:

1. Type L and then press Enter.

AutoCAD starts the Line command and displays the following prompt in the 
command line:

LINE Specify first point:

2. Click a point anywhere in the drawing area.

The command line prompt changes to

LINE Specify next point or [Undo]:

3. Click another point anywhere in the drawing area.

AutoCAD draws the first line segment.

4. Click a third point anywhere in the drawing area.

AutoCAD draws the second line segment and prompts you:

LINE Specify next point or [Close/Undo]:

5. To activate the Undo option, type U and press Enter.

You can type the option letter in lowercase or uppercase.

AutoCAD undoes the second line segment.

If you type an option that the command line doesn’t recognize (for example, X 
isn’t a valid option for the Line command), the command line displays an error 
message and prompts you again for another point — in this case, a point for 
the Line command:

Point or option keyword required.
Specify next point or [Close/Undo]:

Option keyword is programmer jargon for letters, shown in uppercase, that 
activate a command option. This error message is AutoCAD’s way of saying, 
“Huh? I don’t understand what you mean by typing X. Either specify a point or 
type a letter that I do understand.”
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6. Type 3,2 (with no spaces) and press Enter.

AutoCAD draws a new line segment to the point whose X coordinate is 3 and  
Y coordinate is 2.

7. Click several more points anywhere in the drawing area.

AutoCAD draws additional line segments.

8. Type C and then press Enter.

The C instructs AutoCAD to draw a final line segment, which creates a closed 
figure and ends the Line command. A blank command line returns, indicating 
that AutoCAD is ready for the next command:

Type a command:

Here are a few other tips and tricks for effective keyboarding:

 » Display the much larger text window. The normal two-line command line 
usually shows you what you need to see, but occasionally you want to review 
a larger chunk of command-line history. Press F2 to see the AutoCAD text 
window, which is simply an enlarged, scrollable version of the command line, 
as shown in Figure 2-9, left.

Press Ctrl+F2 to see the editable version, as shown in Figure 2-10, right. In this 
mode, you can copy and paste command history. Question: How do you think 
I make sure that all my examples and exercises work properly? Answer: I have 
an excellent Technical Editor who checks everything.

 » Press Esc to bail out of the current operation. Sometimes, you might get 
confused about what you’re doing in AutoCAD or what you’re seeing in the 
command line. If you need to bail out of the current operation, press Esc one 
or more times until you see a blank command line. A blank command line 
indicates that AutoCAD is resting, waiting for your next command.

FIGURE 2-9: 
My, how  

you’ve grown:  
Pressing F2  
(on the left 

side) or Ctrl+F2 
(right side) 

expands the 
command line 
to a command 

text window.
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 » Press Enter to accept the default action. Some command prompts include 
a default action in angled brackets. For example, the first prompt of the 
POLygon command is

Enter number of sides <4>:

The default is four sides, and you can accept it by simply pressing Enter. (That 
is, you don’t have to type 4 first.)

 » AutoCAD uses two kinds of brackets when it prompts.

• Command options appear in regular square brackets: [Close Undo]. To 
activate a command option, type the letter(s) that appear in uppercase and 
then press Enter.

• A default value or option appears in angled brackets: <4>. To choose the 
default value or option, press Enter.

You can also right-click and choose Enter as input to a command. Easier yet, 
you can use the spacebar instead of Enter as long as you’re not entering text.

 » Watch the command line. You can discover a lot about how to use the 
 command line by simply watching it after every action you take. When you 
click a toolbar button or menu choice, AutoCAD displays the name of the 
 command in the command line. If you’re watching the command line, you 
absorb the command names more or less naturally.

 » Leave the command line in the default configuration. The command line, 
like most other parts of the AutoCAD screen, is resizable and movable. The 
default location (at the bottom of the AutoCAD screen) and size (one line in 
the command line and three fading semitransparent line extending into the 
drawing area) work well for most people. Resist the temptation to mess with 
the command line’s appearance, at least until you’re comfortable with using it.

 » Right-click in the command line for options. If you right-click in the 
 command line, you see a menu with some useful choices. For example, 
Recent Commands shows the last six commands you ran.

 » Press the up- and down-arrow keys to cycle through the stack of 
 commands you’ve used recently. This is another handy way to recall and 
rerun a command. Press the left- and right-arrow keys to edit the command-
line text you’ve typed or recalled.

Here’s the easiest way to run a command again. Suppose you want to draw  several 
circles. Start the Circle command and draw the first circle. To draw the next one, 
simply press the spacebar and the Circle command repeats. If you press the space-
bar whenever AutoCAD is waiting for you to start a new command, it repeats the 
last command you used.
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Keeping tabs on palettes
Palettes are refined (well-mannered) versions of dialog boxes. Unlike regular  dialog 
boxes, which insist on your undivided attention as long as they’re open, palettes 
stay discreetly on the screen as you carry on with other tasks. AutoCAD still has 
many dialog boxes, but over the past several releases, palettes have replaced quite 
a few former dialog boxes.

AutoCAD contains more than a dozen palettes (less than a dozen in AutoCAD LT). 
Unless noted otherwise, you can open any of these palettes from the Palettes panel 
of the View tab. I describe just a few of them, in their appropriate chapters.

Down the main stretch: The drawing area
After you’ve taken some warm-up laps, you’re probably itching for the main event. 
The AutoCAD drawing area is where you do your drawing. Gee, what a  surprise! In 
the course of creating drawings, you click points to specify locations and dis-
tances, click objects to select them for editing, and zoom and pan to get a better 
view of what you’re working on.

Most of this book shows you how to interact with the drawing area, but you should 
know a few things upfront.

Model space and paper space layouts
AutoCAD operates in two parallel universes, called spaces, which AutoCAD  indicates 
with either a status bar button or two or more tabs in the lower left section of the 
drawing area:

 » Model: Where you create and modify the objects that represent things in the 
real world, such as wheels, wires, walls, widgets, waterways, or whatever.

 » Paper: Where you create particular views of these objects for plotting, usually 
with a title block around them. Paper space comprises one or more layouts, 
each of which can contain a different arrangement of model space views and 
different title block information. See Chapter 15 for information about creating 
paper space layouts, and see Chapter 16 for the lowdown on plotting them.

Drawing on the drawing area
Here are a few things you should know about the AutoCAD drawing area:

 » Get in the habit of looking at the command line after every action you take. 
Efficient, confident use of AutoCAD requires that you continually glance from the 

www.allitebooks.com
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drawing area to the command line (to see those all-important prompts) and then 
back up to the drawing area. This sequence isn’t a natural reflex for most people, 
and that’s why the Dynamic Input tooltip at the cursor was introduced. But you 
still get information from the command line that you don’t get anywhere else.

 » When you click in the AutoCAD drawing area, you’re almost always 
performing an action. Clicking at random in the drawing area isn’t quite as 
harmless in AutoCAD as it is in many other Windows programs. AutoCAD 
interprets clicks as specifying a point or selecting objects for editing. If you 
get confused, press Esc a couple of times to clear the current operation and 
return to the naked command line.

 » You can still right-click. In most cases, you can right-click in the drawing area 
to display a menu with some options for the current situation.

Fun with F1
Unfortunately, in AutoCAD, F1 doesn’t stand for Formula One. Pressing F1 at any 
time opens the online Help window, shown in Figure 2-10, as does clicking the 
question mark.

Click the down arrow beside the question mark to open the Help menu with 
 additional help-related options.

As is the case with most Windows programs, AutoCAD Help is context-sensitive; 
for example, if you start the Line command and just don’t know what to do next, 
Help will, er, help. You can browse the online Product Documentation from the 

FIGURE 2-10: 
Help is at your 

F1 fingertip.
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AutoCAD Help page or type words in the Search box to look for specific topics. In 
this book, I sometimes direct you to the AutoCAD online Help system for information 
about advanced topics.

As mentioned, when Dynamic Input (F12) is turned off, the command line tries 
to anticipate the next command you want to use. Better yet, when you move the 
cursor into a suggested command, a question mark appears next to the command 
name. Click the question mark to get help. The Help screen appears. Click the 
Find button near the top, and AutoCAD switches the Ribbon menu to the tab that 
 contains the command in question and highlights its specific panel and icon.

AutoCAD is one program where you really need to take advantage of the online 
Help resources. AutoCAD contains many commands, options, and quirks. Alas, the 
quirks aren’t listed in the online Help system. Everyone from the greenest begin-
ner to the most seasoned expert can find out something by using the AutoCAD 
online Help. Take a moment to peruse the home page of the main Help system so 
that you know what’s available. Throughout this book, I direct you to pages in the 
Help system that I think are particularly useful, but don’t be afraid to explore on 
your own when you get stuck or feel curious.

The good news is that the online Help system is always being monitored and 
updated to reflect how people are using it and to update any errors or omissions. 
The bad news is that if you don’t have a current Internet connection, all you get 
is the local stripped-down version. The good news is that you can go to https://
knowledge.autodesk.com/support/autocad, where you can download and install 
the latest version of the full-meal deal. (You’ll probably have to scroll down the 
page a bit to find it.) After you do so, AutoCAD always looks for an Internet con-
nection first so that you get the latest help — but if it can’t connect, it falls back 
to the downloaded version you installed. The install program offers to download 
Help, which should be pretty well mandatory for your laptop.

https://knowledge.autodesk.com/support/autocad
https://knowledge.autodesk.com/support/autocad
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IN THIS CHAPTER

Setting up a simple drawing

Drawing some objects

Zooming and panning in a drawing

Editing some objects

Plotting a drawing

A Lap around the 
CAD Track

Chapters 1 and 2 introduce you to the AutoCAD world and to the AutoCAD 
interface. Other chapters in this book present the techniques that underlie 
good drafting practice. By now, you’re probably eager to start moving the 

cursor around and drawing something. This chapter leads you on a gentle tour 
of the most common CAD drafting functions, including setting up a new draw-
ing, drawing and editing objects, zooming and panning the view, and plotting (or 
printing) a drawing. I don’t go into full detail about every option of every com-
mand, but I give you a feel for what it can do. Go ahead and slam the tires, and 
don’t worry about putting a dent in the doors!

In this chapter, you create a drawing of an architectural detail of a base plate and 
column. Even if you don’t work in architecture or building construction, this exer-
cise gives you some simple shapes to work with and demonstrates commands you 
can use in most drafting disciplines.

Throughout this book, I show AutoCAD running in the Ribbon-based Drafting & 
Annotation workspace that is present in both AutoCAD and AutoCAD LT. Likewise, 
I tell you where to find commands and what to select by using the Ribbon.

Although the drafting example in this chapter is simple, the procedures that it 
demonstrates are real, honest-to-CAD-ness, proper drafting practice. I emphasize 

Chapter 3
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from the beginning the importance of proper drawing setup, putting objects on 
appropriate layers, and drawing and editing with due concern for precision. Some 
of the steps in this chapter may seem a bit strange at first, but they reflect the way 
that experienced AutoCAD users work. My goal is to help you develop good CAD 
habits and do things the right way from the start.

The steps in this chapter, unlike the steps in most chapters in this book, form a 
sequence. You must complete the steps in order. Figuring out how to use AutoCAD 
is a little like figuring out how to drive, in which parallel parking comes before 
Indy car racing, except that with AutoCAD you’re free to stop in the middle of the 
street and take a break. If things get away from you, press Esc two or three times 
to terminate any command that’s in progress, and type the letter U and then press 
the Enter key to undo the last thing you did. Incidentally, U and UNDO are two 
similar commands and between them are probably the most-often-used com-
mands in AutoCAD.

If you find that selecting and editing objects work differently from the way 
I describe in this chapter, you have (or someone else has) probably changed the 
configuration settings on the Selection tab in the Options dialog box. Chapter 24 
describes these settings and how to restore the AutoCAD defaults.

A Simple Setup
In this chapter, I walk you through the steps to create, edit, view, and plot a new 
drawing. See Figure 3-1 to get an idea of what the finished product looks like. I use 
Imperial units in this chapter (you know — inches and feet, for example). I describe 
how to set imperial units versus metric units in Chapter 4.

In the following exercise, we use sev-
eral of the status bar buttons at the 
bottom of the screen. I don’t like 
the icons that AutoCAD displays, 
and I  grew bored from hovering the 
mouse cursor over each button until 
the tooltip appeared. Earlier versions 
of AutoCAD allowed us to switch from 
icons to Text mode, wherein each 
button had a text label instead of an 
icon. Unfortunately, AutoCAD no lon-
ger supports this feature, so I have 
to refer to each button by its tooltip 
description along with the relevant 

FIGURE 3-1: 
How base is my plate.
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icon in the margin. The good news is that you can toggle ten settings by using 
the F keys (such as F3), which I reference in the text in parentheses, as in (F3).   
A light grey icon indicates that the button’s function is Off, while a light blue icon 
indicates On. (Your screen will show icons against a dark grey background, but  
I used a white background for a clearer image on the printed page.)

You can find the files I use in this sequence of steps at this book’s companion 
website: Go to www.dummies.com/go/autocadfd17 and download afd03.zip. The 
Zip file contains imperial and metric versions of the base plate exercise at various 
stages, and the Read Me file on the Downloads tab describes the files in details.

Pay attention to feedback from AutoCAD. Glance at the messages the program 
sends after each step via the command line at the bottom of the screen or the 
Dynamic Input tooltip near the cursor so that you become familiar with the names 
of commands and their options. If you don’t see messages next to the cursor as 
you use the program, click the Dynamic Input (F12) button on the status bar so 
that its icon is light blue rather than gray.

In this first set of steps, you create a new drawing from a template, change a few 
settings to establish a 1:10 scale (that is, 1 inch on the drawing is equivalent to 10 
inches on the real object), and save the drawing:

1. Start AutoCAD.

As indicated in Chapter 1, the startup procedure can vary depending on your 
version of Windows and how it is set up

2. Check your workspace.

The workspaces in AutoCAD look similar. To make sure that you’re using the 
same workspace as I am in this chapter (and in most of this book), click the 
gear icon, near the right end of the status bar (and shown in the margin). If the 
check mark in the drop-down list isn’t beside Drafting & Annotation, click on 
Drafting & Annotation.

3. Start a new drawing that uses AutoCAD’s default template.

a. Click the Application button (the big red A), in the upper-left corner of the screen, 
to display the Application menu. Then click New.

Don’t click the big Start Drawing icon in the graphic screen or the New  
button on the Quick Access toolbar. You must use the Application menu.  
I explain why in Chapter 4 — humor me for now.

The Select Template dialog box appears with a list of drawing templates 
(DWT files), which you can use to create a new drawing. Templates in 
AutoCAD are similar to templates in Microsoft Word and other programs. 
Chapter 4 describes how and why to create and use custom drawing 
templates.

http://www.dummies.com/go/autocadfd17
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b. Select acad.dwt, as shown in Figure 3-2, and click Open. (In AutoCAD LT, select 
acadlt.dwt.)

AutoCAD creates a new, blank drawing that uses the settings in acad.dwt. 
The acad.dwt template (acadlt.dwt in AutoCAD LT) is AutoCAD’s default, 
plain-Jane (or should that be plain-Pat to be gender-neutral?) template for 
creating drawings that use imperial units (units expressed in inches or feet 
or both). Chapter 4 contains additional information about these and other 
templates.

4. Set up the initial working environment.

Make the following settings:

a. Click all the buttons on the left half of the status bar as necessary until they look 
dimmed (gray), except Dynamic Input (F12) and Ortho (F8), which should be 
bright blue.)

b. Turn the background grid (F7) on or off.

Most beginners seem to like it turned on, and most experienced users 
turn it off.

Some of the other settings can make point selection difficult. Start with them 
all turned off, and then toggle them on and off as needed. I tell you which ones 
to use in the remaining steps.

5. Set the drawing limits that define the working area.

a. Type LIMITS and press Enter.

(I explain drawing limits in more detail in Chapter 4.)

FIGURE 3-2:  
Starting a new 

drawing from a 
template.
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b. For now, ignore the Dynamic Input tooltip next to the cursor, and look at the 
command line. AutoCAD echoes the command name and replies to it. Set the 
limits of the drawing area by responding to the prompts:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>: 
Press Enter

Specify upper right corner <12.0000,9.0000>: 100,50

Don’t add a space before or after the comma of a coordinate value. If you 
press the spacebar before you enter the entire coordinate value, AutoCAD will 
process only the text you’ve typed.

6. Display the defined working area.

a. Start the Zoom command.

The Zoom command is in the Ribbon in the Navigate panel of the View tab, 
but it is usually far faster and easier to simply type Z and press Enter.

ZOOM Specify corner of window, enter a scale factor (nX 
or nXP), or [All/Center/Dynamic/Extents/Previous/Scale/
Window/Object] <real time>:...

b. Type A and press Enter.

AutoCAD zooms so that the screen shows the limits (that is, all) of 
your drawing

I use a special font to show you what AutoCAD is saying. You either type the 
characters in bold and press Enter, or just press Enter (such as in Step 4a) to 
accept AutoCAD’s default option or recent value. For simplicity, rather than 
show AutoCAD’s complete response, I often show only what’s necessary for 
you to understand what’s going on.

7. Establish the snap and grid drafting settings.

a. Right-click the Display Drawing Grid button near the left end of the status bar 
and then choose Settings.

The Snap and Grid tab in the Drafting Settings dialog box appears, as shown 
in Figure 3-3. Note that AutoCAD LT lacks some options that are present in 
the full version of AutoCAD.

b. Change the values in the Drafting Settings dialog box to match those in 
Figure 3-3, and click OK when you’re finished:

• Snap On: When selected, constrains the cursor to moving in an invisible 
grid of equally spaced points (0.5 units apart, in this case).

• Grid On: When selected, displays a visible grid of little dots or grid lines 
on the screen (5 units apart, in this case), which you can use as refer-
ence points. The grid doesn’t appear on printed drawings.
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• Snap X Spacing: 0.5

• Snap Y Spacing: 0.5

• Grid X Spacing: 5

• Grid Y Spacing: 5

You see a network of grid lines, 0.5 units apart, with brighter lines every 5 units, 
in the drawing area. If you move the mouse pointer around and watch the 
coordinate display area at the left side of the status bar, you notice that the 
values still change in tiny increments, just as they did before. I have more 
information on snap mode and grid display in Chapter 4.

8. Save your work:

a. Click the Save button on the Quick Access toolbar, or press Ctrl+S.

Because you haven’t saved the drawing yet, AutoCAD opens the Save 
Drawing As dialog box. Navigate to a suitable folder by choosing from the 
Save In drop-down list or double-clicking folders in the list of folders below it.

I remembered to remind you to remember where you save the file so that 
you can find it later. (And remember the three signs of old age: The first is 
loss of memory . . . I forget the other two.)

b. Type a name in the File Name text box.

For example, type My Plate Is Base. Depending on your Windows Explorer 
or File Explorer settings, you may or may not see the .dwg extension in the 
File Name text box. In any case, you don’t need to type it — AutoCAD adds 
it for you.

FIGURE 3-3:  
Snap and Grid 

settings.
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c. Click Save.

AutoCAD saves the new DWG file to the folder you specified.

If you forget the name of the file later, simply click the Start tab in the upper-left 
corner of the drawing or check the Recent Documents list of the Application menu.

The good news is that it isn’t necessary to complete all these steps for every new 
drawing. Chapter 4 goes into more detail about drawing setup, describes why all 
these gyrations are necessary, and tells you how to avoid doing them more than 
once by defining your own template files.

Drawing a (Base) Plate
When your drawing is properly set up, you’re ready to draw some objects. In this 
example, you use the Line command to draw a steel base plate and column, the 
Circle command to draw an anchor bolt, and the POLygon command to draw a 
hexagonal nut

AutoCAD, like most CAD programs, uses layers as an organizing principle for all 
objects you draw. Chapter 9 describes layers and other object properties in detail. 
For now, think of layers as sheets of transparent plastic lying on top of the draw-
ing. You can hide or display individual drawing elements by simply removing or 
replacing their particular sheet of plastic.

In this example, you create separate layers for the base plate, column, anchor 
bolts, nuts, and crosshatching. This might seem like layer madness, but when 
you’re creating complex drawings, you need to use layers properly to keep every-
thing organized.

The following steps demonstrate how to create and use layers, as well as how to 
draw lines, circles, rectangles, and polygons. You also see how to move, copy, 
mirror, offset, and apply fillets.

1. Complete the drawing setup in the earlier section “A Simple Setup.”

2. Prepare to create the five layers you will use to organize the objects that will 
make up the base plate example by invoking the LAyer command.

Do one of the following:

• On the Layers panel of the Home tab, click the Layer Properties button.

The Layer Properties button is at the left edge of the Layers panel.
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• Enter LA from the keyboard.

As you type, a list of commands that start with LA appears near the cursor. 
The full command name is LAYER, but as soon as LA is highlighted, press 
Enter.

The LAyer command starts and AutoCAD displays the Layer Properties 
Manager palette, as shown in Figure 3-4. If you want to move any palette to a 
different screen location, just move the cursor to the vertical bar on the 
palette’s left edge and then drag the palette to a new location.

3. Follow these steps to create the needed layers:

a. Click the New Layer button.

It’s the leftmost of the group of four buttons that include the green check 
mark and the red X. AutoCAD adds a new layer to the list and gives it the 
default name Layer# where # is a number. For the first layer, the default 
name is Layer1 (see Figure 3-4).

b. Name That Layer.

Type Plate as the name of the first layer on which you’ll draw the base 
plate, and press Enter.

c. Click the color swatch or name (white) in the Color column of the new Plate row.

The Select Color dialog box appears, as shown in Figure 3-5.

d. Click the fourth color square (cyan/light blue, index color 4), for the first layer 
in the single, separate row to the left of the ByLayer and ByBlock buttons, and 
then click OK.

The Select Color dialog box closes, and the color for the Plate layer 
becomes cyan.

FIGURE 3-4:  
Creating a  
new layer.
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e. With the Layer Properties Manager still open, repeat Steps 3a through 3d to cre-
ate four more layers with these names and colors:

Layer Name Color

Column 5 (blue)

Anchor Bolts 3 (green)

Nuts 1 (red)

Hatch 6 (magenta)

You don’t have to create a separate layer for every type of object you draw. For 
example, you can draw both the anchor bolts and nuts on a Hardware layer. Layer 
names and usage depend on industry and office practices, in addition to a certain 
amount of individual judgment. Having too many layers is better than having too 
few, because lumping together two or more layers is much easier than dividing 
the objects on one layer into two or more layers. I cover working with layers in 
more detail in Chapter 9.

Start with the objects that will be drawn on the Plate layer by following these steps:

1. Make the Plate layer current before drawing the objects that make up 
the plate.

a. Double-click the Plate layer name.

A green check mark appears beside the layer name, indicating that it’s current. 
Anything you draw now will be on the Plate layer and will inherit its color.

FIGURE 3-5:  
Select Cyan 

from the 
 standard  

color tiles.
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b. Click the Close button (the X at the upper-left corner of the palette shown in 
Figure 3-4) to close the Layer Properties Manager palette.

The Layer Properties Manager palette can be left open on the screen or 
reduced to a vertical bar, but you might as well close it because you won’t 
need it again in this drawing session.

2. Draw the base plate.

a. Start the Line command by clicking its button on the Draw panel of the Ribbon’s 
Home tab or by typing L and pressing Enter.

b. Draw three lines by responding to AutoCAD’s prompts:

LINE
Specify first point: 68,7 and press Enter.
Specify next point or [Undo]: Move the cursor to the left 

and then enter 36

You don’t need to enter a negative value for the second point. AutoCAD 
knows which way to draw the line because the cursor is located to the left of 
the first point.

Because the Ortho (F8) button is turned on, AutoCAD constrains the cursor 
to move only exactly horizontally or vertically. In this case, a horizontal line 
exactly 36 units long is drawn, no matter how far away the cursor is from 
the first point.

Specify next point or [Undo]: Move the cursor up and then 
enter 36

Specify next point or [Undo]: Move the cursor to the right 
and then enter 36

Specify next point or [Undo]: C

Entering C (uppercase or lowercase) closes the line back to the 
starting point.

If you didn’t complete the previous steps, start from this point by using draw-
ing afd03a-i.dwg, available in the afd03.zip download at www.dummies.com/go/
autocadfd17. Download it to a suitable location, click the Application button, and 
then click Open. Browse to the file.

Time to add a bolt. You first need to change to the Anchor Bolts layer, and then 
draw the bolt:

1. Go to the Layers panel of the Home tab.

2. Click the arrow at the right-hand end of the Layer drop-down list.

The current entry (from the running example) is Plate.

http://www.dummies.com/go/autocadfd17
http://www.dummies.com/go/autocadfd17
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3. Choose the Anchor Bolts entry to set the Anchor Bolts layer as the current 
layer.

Using the Layer drop-down list, in the upper-right corner of the Layers panel of 
the Home tab of the Ribbon, saves you from having to open the Layer 
Properties Manager, select the layer, click the Set Current button, and close the 
Layer Properties Manager when you want to change to a different layer. 
Becoming an AutoCAD master is all about efficiency. The real heart of  
all human progress is laziness — we will work hard at finding ways to  
avoid work.

4. Draw the bolt:

a. Start the Circle command, either from the Draw panel or by simply typing C and 
pressing Enter.

b. Draw a circle by responding to AutoCAD’s prompts this way:

CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan tan 

radius)]: int
Of: Move the cursor until it is close to the lower-left 

corner of the rectangle and then click when a green X 
appears at the intersection of the two lines.

Specify radius of circle or [Diameter]:
AutoCAD defaults to the radius of a circle, but you want to 

specify the diameter, so enter D.
Specify diameter of circle: 1.5

5. Save your drawing.

AutoCAD automatically backs up your work, but you could still lose the last ten 
minutes or so. Now is a good time to press Ctrl+S.

Now add a hexagon nut for the bolt:

1. Make the Nuts layer current by using the Layer drop-down list from the 
Layers Ribbon panel.

2. Start the POLygon command.

Its button is either in the upper-right corner of the Draw panel or on the 
drop-down list with the RECtangle button, depending on which command you 
last used. You can also type POL and press Enter.
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3. Draw a hexagon.

a. Respond to these AutoCAD prompts:

POLYGON Enter number of sides <4>: 6
Specify center of polygon or [Edge]: cen
Of: Click anywhere on the circle.
Enter an option [Inscribed in circle/Circumscribed about 

circle] <I>: C

The Inscribed option draws a polygon whose corners touch the circumfer-
ence of the imaginary circle. The Circumscribed option draws a polygon 
whose sides are tangent to the circumference of the circle and has nothing 
to do with a medical procedure. Bolt heads and nuts are normally specified 
by the width across the flats (unless you own a vintage British car such as a 
1937 Rolls-Royce, where Whitworth wrenches are arbitrarily defined by the 
diameter of the thread), so choose the C option.

b. Move the cursor.

The hexagon rotates about its center. You should still have ORTHO turned 
on, so AutoCAD shows only two possible choices for the vertex of the poly-
gon: horizontal or vertical from the center of the imaginary circle.

c. Move the mouse until a vertex is horizontal from the center of the circle.

d. Respond to this AutoCAD prompt:

Specify radius of circle: 1.5

e. Press Enter, and AutoCAD draws the hexagon.

Okay, suppose that you draw the circle and the hexagon in the wrong location. 
Easy enough. Just move objects to another location as follows:

1. Start the Move command, which is on the Modify panel.

When AutoCAD prompts you, respond this way:

MOVE
Select objects: Click the circle or the hexagon. 1 found
Select objects: Click the hexagon or the circle. 1 found, 2 

total
Select objects: Press Enter.
Specify base point or [Displacement]: 6,6
Specify second point or <use first point as displacement>: 

Press Enter.

Like magic, AutoCAD moves the hexagon and the circle six units to the right 
and six units up.
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2. Take a break.

Press Ctrl+S to save the drawing. It may be time for a hydraulic break; 
remember that the mind can’t hold more than the bladder.

There are several different ways to produce additional nuts and bolts. The next 
two procedures combine to demonstrate one method:

1. Start the COpy command, which is on the Modify panel. Then follow 
these prompts.

COPY
Select objects: p Selects the Previous selection set, being 

the objects you selected to move. 2 found
Select objects: Press Enter
Current settings: Copy mode = Multiple
Specify base point or [Displacement/mOde] <Displacement>: 

0,24
Specify second point or [Array] <use first point as 

displacement>: Press Enter.

Presto! AutoCAD creates a copy of the circle and the hexagon 24 units above 
the first set.

2. Start the MIrror command, found on the Modify panel. Then follow the 
prompts.

MIRROR
Select objects: p Selects the Previous selection set, being 

the first nut and bolt. 2 found

Select objects: Click the upper circle or the upper 
hexagon. 1 found

Select objects: Click the upper hexagon or the upper 
circle. 1 found, 4 total

Select objects: Press Enter.
Specify first point of mirror line: mid
of: Select the upper horizontal line.
Specify second point of mirror line: Make sure Ortho (F8) 

is still on and pick a point above or below the upper 
line.

Erase source objects? [Yes/No] <N>: Press Enter.

That was a little faster than drawing four circles and four hexagons by hand, 
wasn’t it?
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3. Draw the column. Start by selecting Column to set it as the current layer.

a. On the Layers panel of the Home tab, click the Layer drop-down list to display 
the list of layers. Select Column to set it as the current layer.

Now you’re ready to create the hollow column, starting with its outside 
profile. Be sure to keep the cursor in the drawing area during this step and 
the next one.

b. Start the RECtang command, found on the Draw panel.

RECTANG
Specify first corner point or [Chamfer/Elevation/Fillet/

Thickness/Width]: 44,16
Specify other corner point or [Area/Dimensions/Rotation]: 

@12,18

A rectangle is drawn in the middle of the square base plate.

c. Start the FILLET command, on the Modify panel, and watch the command 
line closely.

In this step, you round the corners of the column with the FILLET command 
and then use OFFset to give it a wall thickness.

FILLET
Current settings: Mode = TRIM, Radius = 0.0000
Select first object or [Undo/Polyline/Radius/Trim/

Multiple]: r
Specify fillet radius <0.0000>: 2
Select first object or [Undo/Polyline/Radius/Trim/

Multiple]: p
Select 2D polyline or [Radius]: Move your cursor over 

the new rectangle and observe how AutoCAD shows you a 
preview. Click the rectangle.

4 lines were filleted

You can pick the lines at each corner that need to be filleted (that’s eight 
picks), but because the column is a continuous polyline, a more efficient 
method in this case is to use the FILLET command’s Polyline option to fillet 
all four corners in one fell swoop. I discuss polylines in Chapter 6 and fillets 
in Chapter 11.
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d. Now give the column a ¾-inch wall thickness. Start the OFFset command. Once 
again, it’s a Modify item.

OFFSET
Current settings: Erase source=No Layer=Source 

OFFSETGAPTYPE=0
Specify offset distance or [Through/Erase/Layer] <Through>: 

.75
Select object to offset or [Exit/Undo] <Exit>: Click the 

filleted rectangle.

Make sure that the Object Snap (F3) status bar button is toggled off for 
these next prompts, or AutoCAD may offset the object back on top of itself:

Specify point on side to offset or [Exit/Multiple/Undo] 
<Exit>: Move your cursor over the new rectangle and 
observe how AutoCAD shows you a preview. Click inside the 
rectangle.

Select object to offset or [Exit/Undo] <Exit>: Press Enter.

There you go! You created a hollow 
structural shape with wall thickness 
and radiused corners (see Figure 3-6) 
in just four simple steps.

4. Press Ctrl+S to save the drawing.

AutoCAD saves the drawing and 
renames the previously saved 
version drawingname.bak — for 
example, My Plate is Base.bak. 
AutoCAD uses the filename 
extension .bak for a backup file. 
When (not if) things get out of hand, 
you can always rename the .bak 
file to .dwg to return to the most 
recent version.

Now that you’ve given Dynamic Input 
a test drive, turn it off for the rest of 
this chapter by clicking its button 
(F12) on the status bar so that the but-
ton looks dimmed. If you like it, toggle it back on.

The drawing afd03b-i.dwg contained in the afd03.zip download includes the 
base plate and column and one anchor bolt.

FIGURE 3-6:  
Give the column some thickness with OFFSET.
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Taking a Closer Look with Zoom and Pan
The drawing example in this chapter is uncluttered and manageable, but most 
real CAD drawings are neither — technical drawings are usually jam-packed with 
lines, text, and dimensions. CAD drawings are often plotted on sheets of paper 
that measure 2 to 3 feet on a side (in the hundreds of millimeters, if you’re a met-
ric maven). Anyone who owns a monitor of that size probably can afford to hire 
a room full of drafters and therefore isn’t reading this book. You need to zoom 
and pan in drawings — a lot. I cover zooming and panning in detail in Chapter 5. 
These quick definitions should suffice for now:

 » Zoom: Change the magnification of the display. When you zoom in, you move 
closer to the drawing objects so that you can see more detail; when you zoom 
out, you move farther away so that you can see more of the drawing area. 
Zooming does not change the size of the objects in the file. You can think of 
zoom in AutoCAD like the zoom function on your camera: You get closer, but 
you see less.

 » Pan: Move from one area to another without changing the magnification. If 
you’ve used scroll bars in an application, you’ve panned the display. Panning 
does not change the location of objects in the file.

Frequently, zooming and panning let you see details better, draw more confi-
dently because you can see what you’re doing, and edit more quickly because 
object selection is easier when a bazillion objects aren’t on the screen.

Fortunately, zooming and panning in AutoCAD are as simple as they are necessary.

If you have a wheel mouse, you can zoom by simply rolling the wheel back and 
forth. To pan, press and hold the wheel (yes, the wheel is also a button) and drag 
the view around. These actions can be performed even when another command is 
active. If you don’t have a wheel mouse, run out and buy one. The small amount 
you’ll pay ($20 for cordless or $5 for a USB corded version) is easily recovered 
by your new operating efficiency. (Disclaimer: I have no financial interest in any 
mouse company or wheel company.)

Meanwhile, until you buy a wheel mouse, check out Chapter 5 to see how to use 
AutoCAD’s Zoom and Pan Realtime features.

The fastest way to return to a full view of the entire drawing is to type, at the 
command line, Z A, which is short for Zoom All. Note the space between the two 
letters, and remember to press Enter or the spacebar after you type each letter.
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Modifying to Make It Merrier
When you have a better view of the base plate by zooming, which I talk about in 
the preceding section, you can edit the objects on it more easily. In the following 
few sections, you use the Hatch command to add crosshatching to the column and 
use the Stretch command to change the shape of the plate. As always, I cover these 
commands in detail later in this book.

The drawing afd03c-i.dwg contained in the afd03.zip download adds the 
remaining anchor bolts.

Crossing your hatches
The next editing task is to add crosshatching to the space between the inner and 
outer edges of the column. The hatch lines indicate that the drawing shows a cross 
section of the column. To do so, follow these steps:

1. Turn off Object Snap (F3), Ortho (F8), and Snap (F9), modes by clicking 
their respective buttons on the status bar or by pressing the indicated 
key until the icons look dimmed.

2. Select the Hatch layer from the Layer drop-down list at the top of the Layers 
panel on the Home tab.

3. On the Home tab’s Draw panel, click the Hatch button (shown in the mar-
gin) or type Hatch at the keyboard.

The Hatch Creation tab appears on the Ribbon. For more information on this 
tab, and on hatching in general, see Chapter 15. Note that the Ribbon now has 
a light blue/green bar at the bottom and that all the panels now show actions 
related to creating and formatting crosshatching.

4. On the Hatch Creation tab’s Pattern panel, select ANSI31.

Depending on your screen resolution, the panels may show more or less 
information. If you don’t see an ANSI31 sample swatch, click the down arrow at 
the bottom of the lower-right corner of the Pattern panel. A scrollable list of all 
available patterns will appear.

The ANSI31 swatch is the American National Standards Institute (ANSI) 
standard pattern number 31 (ANSI 31) and not ANS 131.
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a. Move the cursor over the drawing objects.

A live preview shows you the result if you click at the current crosshair posi-
tion. AutoCAD prompts you:

Pick internal point or [Select objects/Undo/seTtings]: Move 
the cursor so it’s between the inside and outside edges 
of the column. Zoom in if you need to get closer.

The live preview shows the ANSI31 hatch pattern filling the space between 
the two filleted rectangles. Live preview not only shows you the pattern but 
also lets you preview the hatch angle and scale. In this case, it looks like the 
hatch pattern may be too fine.

b. In the Scale window in the lower-
right corner of the Hatch Creation 
tab’s Properties panel, change 
the value to 5 and press Tab to 
confirm it.

c. Move the cursor back to the area 
between the two filleted rectangles 
to preview the hatch again. If it 
looks okay, click within the hatched 
area to confirm the hatch object, 
and then press Enter to finish 
the command.

The finished column and base plate 
should look much like the one 
shown in Figure 3-7.

Perfect! But suppose that the nutty engineer (hey, I resemble that remark!) has 
decided that the column needs to measure 18 x 18 inches rather than 12 x 18 inches. 
Therefore, the base plate is too small, and the anchor bolts are in the wrong place. If 
you were drafting from paper on the drawing board, you’d pull out the eraser right 
about now to rub out all your efforts — and if you were lucky, you’d have an electric 
eraser. At some point, you simply tore up the paper and started over, or labeled the 
appropriate dimensions as NTS (Not To Scale). It’s AutoCAD to the rescue.

Now that’s a stretch
The Stretch command is powerful: It can stretch or move objects, or stretch some 
and move others at the same time, depending on how you select them. The key to 
using Stretch is specifying a crossing selection box properly. Chapter 10 gives you 
more details about crossing selection boxes and how to use them with the Stretch 
and other editing commands.

FIGURE 3-7:  
Button-downed base plate.
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Begin with the drawing from the previous section open in AutoCAD, or open the 
file afd03c-i.dwg contained in the afd03.zip download.

1. On the Modify panel of the Home tab click the Stretch button (shown in 
the margin).

The Stretch command starts, and AutoCAD prompts you to select objects. This 
is one of those times and one of those command that requires you to watch 
the command line.

2. Follow the command line instructions to click points from right to left to 
define a crossing selection box.

Select objects to stretch by crossing-window or crossing-
polygon...

Select objects: Click a point above and to the right of the 
upper-right corner of the plate (Point 1 in Figure 3-8).

Specify opposite corner: Move the cursor down and to the 
left. Click a point below the plate, roughly under the 
center of the column (Point 2 in Figure 3-8).

The pointer changes to a dashed rectangle enclosing a rectangular green area, 
which indicates that you’re specifying a crossing selection box. The crossing 
selection box must cut through the plate and column for the Stretch command 
to work (see Figure 3-8). You see the following:

11 found
Select objects: Press 

Enter.

3. If these drafting settings aren’t 
already set this way, turn off 
Snap (F9) and turn on Ortho 
(F8) and Object Snap (F3). Then 
set a base point for the stretch 
operation.

Specify base point 
or [Displacement] 
<Displacement>: Move 
the mouse pointer over 
the lower-right corner 
of the plate, and click 
when you see a square 
box with an Endpoint 
tooltip.

Point 1

Point 2
FIGURE 3-8:  
Specifying a crossing selection box for the 
Stretch command.
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This point serves as the base point for the stretch operation. (Chapter 11 
describes base points and displacements in greater detail.) As before, if you 
can’t get the cursor to snap to the endpoint, right-click the Object Snap (F3) 
button and select Endpoint.

4. Specify a displacement for the stretch operation.

AutoCAD prompts you at the command line:

Specify second point or <use first point as displacement>:

Move the cursor horizontally to the right, type 6, and press Enter, as shown 
in Figure 3-9.

AutoCAD stretches the plate and column with its hatching, and moves the 
anchor bolts by the distance you indicated (see Figure 3-9).

5. Enter Z A at the command line to see the entire drawing.

If the first stretch didn’t work properly, press Ctrl+Z to undo, and then try again. 
Stretch is an immensely useful command that makes you wonder how drafters 
used to work with only erasers and pencils.

6. When the stretched drawing is as you want it, press Ctrl+S to save the 
drawing.

The drawing afd03d-i.dwg contained in the afd03.zip download is the stretched 
version of the base plate. How does it compare with your version?

FIGURE 3-9:  
Stretching the 

base plate.
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After some drawing and editing, you may wonder how you’re supposed to know 
when to turn off or on the various status bar modes (Snap, Grid, Ortho, Object 
Snap, and others). Rest assured that you eventually begin to develop an instinctive 
sense of when they’re useful and when they’re in the way. If a mode is in your way 
or you realize that you need one, you can click the buttons or press the F keys at 
any time while using the editing and drawing commands. Later in this book, I give 
you more-specific guidelines.

Following the Plot
Looking at drawings on a computer screen and exchanging them with others via 
email or websites is all well and good, but sooner or later, someone — maybe 
you — will want to see the printed versions. Plotting drawings in AutoCAD (as 
CAD geeks refer to printing in AutoCAD) is a little more complicated, however, 
than printing a word processing document or a spreadsheet. You have to address 
issues such as drawing scales, lineweights, title blocks, and weird paper sizes. I 
delve deeper into plotting in Chapter 16, but this section describes an abbreviated 
procedure that can help you generate a recognizable printed drawing.

The steps in the following section show you how to plot the model space portion of 
the drawing. As Chapter 12 describes, AutoCAD includes a sophisticated  feature — 
paper space layouts — for creating arrangements, usually including a title block, 
of the drawings you plot. Because I promised you a gentle tour of AutoCAD draft-
ing functions, I save our discussion of paper space layouts and title blocks for later 
in this chapter. When you’re ready for the whole plotting enchilada, turn to Chap-
ter 12 for information about how to set up paper space layouts and see Chapter 16 
for full plotting instructions.

Plotting the drawing
The following steps should produce a satisfactory plot in almost all circumstances, 
though specific brands and models of plotter or printer might sometimes vary the 
result. Writers call this introduction the CYA, or Cover Your Backside, statement.

Follow these steps to plot a drawing:

1. Click the Plot button on the Quick Access toolbar or press Ctrl+P.

The Quick Access toolbar is at the left end of the program’s title bar, just to the 
right of the Application button. The Plot icon looks like an ordinary desktop printer.

AutoCAD opens the Plot – Model dialog box, with the title bar showing what 
you’re plotting (Model, in this case). See Figure 3-10.
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If you don’t see all the option windows shown down the right side of the dialog 
box in Figure 3-10, click the arrow in the lower-right corner.

2. In the Printer/Plotter section, select a printer from the Name drop-down list.

If in doubt, the Default Windows System Printer usually works.

3. In the Paper Size section, use the drop-down list to select a paper size that’s 
loaded in the printer or plotter.

Anything Letter size (8½ x 11 inches) [A4 (210 x 297mm)] or larger works for 
this example.

4. In the Plot Area section, select Limits from the What to Plot drop-down list.

This is the entire drawing area, which you specified when you set up the 
drawing in the section “A Simple Setup,” earlier in this chapter.

5. In the Plot Offset section, select the Center the Plot check box.

Alternatively, you can specify offsets of 0 or other amounts to position the plot 
at a specific location on the paper.

6. In the Plot Scale section, deselect the Fit to Paper check box and choose 1:10 
from the Scale drop-down list.

You receive no prize for guessing the metric equivalent of 1:10.

FIGURE 3-10: 
 The Plot dialog 

box, with the 
More Options 

area visible.
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7. In the Plot Style Table (Pen Assignments) section, click the drop-down list and 
choose monochrome.ctb.

The monochrome.ctb plot style table ensures that all lines appear in solid black 
rather than as different colors or weird shades of gray. See Chapter 16 for 
information about plot style tables and monochrome and color plotting.

8. Click Yes when the question dialog box appears, asking Assign This Plot Style 
Table to All Layouts?

You can leave the remaining settings at their default values as shown in 
Figure 3-10.

9. Click the Preview button.

If the plot scale you entered in the Plot dialog box is out of sync with the 
drawing’s annotation scale, the Plot Scale Confirm dialog box appears, advising 
you that the annotation scale isn’t equal to the plot scale. This drawing doesn’t 
contain text or dimensions, and you didn’t make the hatch annotative, so you 
can click Continue to generate the plot.

Annotative scaling controls the printed size of text, dimensions, hatching, and 
other types of annotation objects at plot time — as long as the drawing’s 
annotation scale matches the plot scale. I explain annotative objects in 
Chapters 13 and 14.

The Plot dialog box disappears temporarily, and AutoCAD shows how the plot 
will look on paper

10. Right-click in the preview area and choose Exit.

11. If the preview doesn’t look the way you want, adjust the settings in the Plot 
dialog box and click the Preview button again. Continue to adjust the set-
tings until the plot looks right.

12. Click OK.

The Plot Scale Confirm dialog box pops up again. You may be tempted to click 
Always Continue Under These Conditions, but I recommend against it until 
you’re more familiar with annotative objects.

The Plot dialog box closes. AutoCAD generates the plot and sends it to the 
printer. AutoCAD then displays a Plot and Publish Job Complete balloon 
notification from the right end of the status bar. A link labeled Click to View Plot 
and Publish Details displays more information about the plot job.
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13. Click the Close (X) button in the Plot and Publish Job Complete balloon 
 notification.

The balloon notification disappears.

If you’re not happy with the lineweights of the lines on your plot at this point, 
fear not: You can use the lineweights feature (see Chapter 9) or plot styles (see 
Chapter 16) to control plotted lineweights.

14. Press Ctrl+S to save the drawing.

You successfully executed your first plot in AutoCAD. Chapter 16 tells you 
much more about AutoCAD’s highly flexible but occasionally perplexing 
 plotting system.

Today’s layer forecast: Freezing
Oops — the nutty engineer is back. Now the requirement is a shop drawing of the 
base plate alone with its four holes but no column and no nuts. No problem.

Expand the Layer drop-down list from the Layers tab and click the sunshine icons 
beside the Column, Hatch, and Nuts layers. As you do so, each sunshine turns to 
a snowflake and everything on the corresponding layer disappears. Frozen layers 
cannot be seen, edited, or plotted. Click a snowflake, and its layer thaws to sun-
shine. I discuss layers in Chapter 9.

Congratulations! You have now used the few commands that will account for the 
majority of your long and prosperous AutoCAD career!
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IN THIS CHAPTER

Developing a setup strategy

Starting new drawings

Setting up model space

Creating and using drawing 
templates

Setup for Success

The good news is that AutoCAD is extremely powerful and versatile. And the 
not-quite-so-good news is that it’s extremely powerful and versatile. This 
means that you can set it up to work in virtually any segment of virtually 

any industry or application, virtually anywhere in the world. AutoCAD is used for 
mechanical design, electrical and electronic circuit schematics, hydraulics, build-
ings, bridges, theatre stage layouts, cloth-cutting layouts in the clothing industry, 
designing big floppy clown shoes, keeping track of season’s ticket holders’ seats 
in a hockey arena, and so on. In short, everything from autos to zoos.

Because most companies and schools will already have set things up to suit their 
particular standards, all you need to do — and in fact, must do — is to use their 
existing template files. If you’re working alone, however, you should read on.

In the long (or even medium or short) term, AutoCAD is much easier to use when 
you start from a drawing that’s set up properly. There can be quite a few things to 
set up, but the good news is that if you do things properly, you need to do them 
only once.

Sloppy setup really becomes apparent when you try to plot (note that CAD geeks 
say, “Plot,” whereas normal people say, “Print”) your drawing. Things that 
seemed more or less okay as you zoomed around on the screen are suddenly the 
wrong size or scale on paper. Chapter 16 covers plotting, but the information in 
this chapter is a necessary prerequisite to successful plotting and sheet setup. 
If you don’t get this stuff right, there’s a good chance you’ll find that the plot 
sickens.

Chapter 4
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This chapter describes the decisions you need to make before you set up a new 
drawing, shows the steps for doing a complete and correct setup, and demon-
strates how to save setup settings for reuse.

Don’t assume that you can just create a new blank DWG file and start drawing 
things. Do read this chapter before you wander too far away from this book. Many 
AutoCAD drawing commands and concepts depend on proper drawing setup, so 
you’ll have a much easier time drawing and editing things after you do your setup 
homework.

Then, after you digest the detailed drawing setup procedures described in this and 
the following chapters, use the AutoCAD Drawing Setup Roadmap on the Cheat Sheet 
as a quick reference to guide you through the process.

A Setup Roadmap
Before you start the drawing-setup process, you need to make only two initial 
decisions about your new drawing:

 » What system of measure — metric or Imperial — will you use?

 » What drawing units will you use?

Choosing your units
AutoCAD is extremely flexible about drawing units; it lets you have them your way. 
Usually, you choose the type of units that you normally use to talk about whatever 
you’re drawing: feet and inches for a building in the United States, millimeters for 
almost everything in almost all the rest of the world, and so on.

Speaking of millimeters, here’s another choice you have to make even before you 
choose your units of measure — and that’s your system of measure.

Most of the world abandoned local systems of measure generations ago. Even 
widely adopted ones, like the Imperial system, have mostly fallen by the wayside 
(just like their driving force, the British Empire) — except, of course, in the United 
States, where feet, inches, pounds, gallons, and degrees-Fahrenheit still rule.

Make sure everyone agrees on the units being used. NASA once crashed a very 
expensive space probe onto Mars because of a mix-up between imperial versus 
metric systems.
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During drawing setup, you choose 
settings for length units (for measur-
ing linear objects and distances) and 
angle units (for measuring angles 
between nonparallel objects or points 
on arcs or circles) in the Draw-
ing Units dialog box, as shown in  
Figure 4-1. (I show you how to specify 
these settings in the section “Setting 
your units,” later in this chapter.) 
AutoCAD’s length unit types are as 
follows:

 » Architectural units are based in 
feet and inches and use fractions 
to represent partial inches: for 
example, 12′3 1/2″. The base unit 
is the inch unless otherwise speci-
fied, so if you enter a number like 
147.5, then AutoCAD will understand it to be 12′3 1/2″.

 » Decimal units are unitless — that is, they’re not based on any particular real-
world unit. With decimal units, each unit in the drawing could represent an 
inch, a millimeter, a parsec, a furlong, a fathom, a cubit (if you’re into building 
arks in case that rainy day should come), or any other unit of measure you 
deem suitable, from Danish alens to the Swiss zoll. An example would be 15.5.

 » Engineering units are based in feet and inches and use decimals to represent 
partial inches: for example, 12′3.5″.

 » Fractional units, like decimal units, are unitless and show values as fractions 
rather than decimal numbers: for example 15 1/2.

 » Scientific units, also unitless and show values as exponents, are used for 
drawing really tiny or really large things. If you design molecules or galaxies, 
this is the unit type for you. Examples would be 15.5E+06 (which is 15,500,000) 
and 15.5E–06 (which is 0.0000155).

AutoCAD’s angle unit types are as follows:

 » Decimal Degrees show angles as decimal numbers and are by far the easiest 
to work with, if your type of work allows it.

 » Deg/Min/Sec is based on the old style of dividing a degree into minutes and 
minutes into seconds. Seconds aren’t fine enough to display AutoCAD’s preci-
sion capabilities, though, so seconds can be further divided into decimals. 

FIGURE 4-1:  
The Drawing Units dialog box.
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There is no degree symbol on a standard keyboard, so AutoCAD uses the 
lowercase letter d. An example would be 45d30′10.7249″. One nautical mile 
(6,076 feet) is approximately 1 minute of arc of longitude on the equator. 
David Letterman once said that the equator is so long that it would reach once 
around the world.

 » Grads and Radians are mathematically beautiful (so we’re told) but are not 
widely used in drafting. Apparently, the French artillery uses grads but as long 
as we’re friends with them we shouldn’t have to worry. There are 400 grads, 
and 2*pi (6.2831. . .) radians, in a circle.

 » Surveyor’s Units type is similar to Deg/Min/Sec but uses quadrants (quarter 
circles) rather than a whole circle. An angle in Deg/Min/Sec might measure 
300d0′.00″, while the same angle in Surveyor’s Units would be represented as 
S 30d0′0.00″ E.

The unit types you’ll most likely use are Decimal, Architectural, and Decimal 
Degrees. You’ll know or be told if you need to use one of the other types.

AutoCAD always works internally to something like 16-digit accuracy. Changing 
the type of units changes only how values are displayed, suitably rounded off. For 
example, a line that’s 15.472563 decimal units long would display as 12″3 1/2″ 
long when units are changed to Architectural. The actual length — and any calcu-
lations based on it — remains at 15.472563 and does not change to 15.5″.

When you use dash-dot linetypes (Chapter  10) and hatching (Chapter  14) in a 
drawing, it matters to AutoCAD whether the drawing uses an Imperial (inches, 
feet, miles, and so on) or metric (millimeters, meters, kilometers, and so on) sys-
tem of measure. The MEASUREINIT and MEASUREMENT system variables con-
trol whether the linetype and hatch patterns that AutoCAD lists for you to choose 
from are scaled with inches or millimeters in mind as the plotting units. For both 
variables, a value of 0 (zero) means inches (that is, an Imperial-units drawing), 
whereas a value of 1 means millimeters (that is, a metric-units drawing). If you 
start from an appropriate template drawing (as described in the section “A Tem-
plate for Success,” later in this chapter), the system variable values will be set 
correctly, and you won’t ever have to think about it. For an explanation of system 
variables and how to set them, see Chapter 25.

So why are there two variables? Simple. MEASUREINIT (short for measurement 
initial) sets the default value for all new drawings, and MEASUREMENT changes 
the value for the current drawing.

AutoCAD automatically sets the measurement system according to your country 
when it’s being installed, but it can be changed.
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Weighing up your scales
Somewhat surprisingly, you don’t need to consider scale when setting up a new 
drawing. In fact, rule number 1 in AutoCAD is to always draw everything full size. 
Hmmm, that makes quite a few rule number 1s, doesn’t it?

“Wait a minute! I want to draw a map of the known universe! If I draw full size, 
where am I going to find a sheet of paper big enough to print it and who will help 
me fold it?”

Trust me. All will become clear shortly.

“Okay,” you’re saying, “I understand that I need to print my drawings at a scale 
acceptable to the discipline I work in. But if I’m drawing stuff full size, when do I 
need to worry about the scale factor?” Grab yourself a nice mug of cocoa and settle 
down ’round the fire because we’re going to tell you. By now you know (because 
I’ve told you so) that you draw real things full size, but drawings contain other 
things that are not real, such as text, dimensions, hatch patterns, title blocks, 
dash-dot linetypes, and so forth. And those nonreal things need to be legible on 
your plotted drawing.

DRAFTING ON PAPER VERSUS 
 ELECTRONICALLY
If you’ve ever done paper-and-pencil drafting (and there are fewer and fewer of us left 
who have), you’ll find that AutoCAD’s electronic paper works backward from dead-tree 
paper.

• Dead-tree paper: In the (distant) past, we considered the approximate size of the 
object that we were drawing and the views we wanted, selected a suitable sheet 
of paper from a set of standard sizes, and then scaled the drawing of the object to 
suit the sheet of paper. We were constantly translating sizes between the real-world 
object and our drawing of it. The height of text and the size of the components in 
dimensions were fixed. Again, scales were selected from a list of preferred values. 
You rarely saw a paper drawing at a scale of, say, 1:2.732486921.

• Electronic paper: Now we draw everything full size and then tell the PLOT com-
mand to stretch or shrink things accordingly. This approach is much easier because 
we never have to translate sizes. Admittedly, in the early days of AutoCAD, the 
sizing of text and of the components in dimensions could get a little awkward, but 
Chapters 12–15 show you how AutoCAD now makes text and dimension sizing 
extremely simple.
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Say, for example, you draw a plan of your garage, and now you want to plot it on 
an 11 x 17″ sheet of paper. No problem; just tell the PLOT command to scale every-
thing down by a scale factor of 1:24, which architects would commonly represent 
as 1/2″=1′0″.

Oops, problem. Text annotations are typically about 3/32″ or 1/8″ high. Now, if 
you draw your 6 inch–wide wall full size, put a 1/8″-high title beside it, and then 
print the drawing at a scale of 1:24, the wall itself will measure 1/4″ on the sheet, 
and the note will be an illegible little speck beside it. You fix it by making the text 
24 times larger, or 3 inches tall, so that it scales down to the correct size when 
plotted. See, sometimes two wrongs do make a right. Unusually, it takes three, 
although three rights make a left and two Wrights made an airplane.

The “Drawing scale versus drawing scale factor” sidebar explains how you arrive 
at the scale factor, but this isn’t an issue until it comes time to annotate your 
drawing. I cover noncontinuous linetype scaling in Chapter  10, text sizing in 
Chapter 13, dimensions in Chapter 14, and crosshatching in Chapter 15. The good 
news is that AutoCAD can now take care of all this automatically, but rumor has it 
that there may still be a few drawings out there that did it the old way so I cover 
both methods in the appropriate chapters.

DRAWING SCALE VERSUS  
DRAWING SCALE FACTOR
CAD users employ two different ways of talking about a drawing’s intended plot scale: 
drawing scale and drawing scale factor.

Drawing scale is the traditional way of describing a scale: “traditional” because it existed 
long before CAD came to be. Drawing scales are expressed with an equal sign or colon: 
for example, 1/8″ = 1′0″, 1:20, or 2:1. You can translate the equal sign or colon as “corre-
sponds to.” In all cases, the measurement to the left of the equal sign or colon indicates 
a paper measurement, and the number to the right indicates a real-world measurement. 
A metric drawing scale is usually expressed without units, as a simple ratio. Thus, a scale 
of 1:20 means 1 unit on the plotted drawing corresponds to 20 units in the real world.

Drawing scale factor is a single number that represents a multiplier, such as 96, 20, or 0.5. 
The drawing scale factor for a drawing is the conversion factor between a measurement 
on the plot and a measurement in the real world.



CHAPTER 4  Setup for Success     69

You shouldn’t just invent some arbitrary scale based on what looks okay on what-
ever size paper you happen to have handy. Most industries work with a small set 
of approved drawing scales that are related to one another by factors of 2 or 10. If 
you use other scales, at best, you’ll be branded a clueless newbie. At worst, you’ll 
have to redo all your drawings at an accepted scale.

The SCale command covered in Chapter 11 has nothing to do with ladders, fish, or 
setting drawing scales or scale factors!

Table 4-1 lists some common architectural drawing scales, using both Imperial 
and metric systems of measure. The table also lists the drawing scale factor cor-
responding to each drawing scale and the common uses for each scale. If you work 
in industries other than those listed here, ask drafters or co-workers what the 
common drawing scales are and for what kinds of drawings they’re used.

After you choose a drawing scale, engrave the corresponding drawing scale factor 
on your desk, write it on your hand (don’t reverse those two, okay?), and put it 
on a sticky note on your monitor. You eventually need to know the drawing scale 
factor for many drawing tasks, as well as for some plotting. You should be able 
to recite the drawing scale factor of any drawing you’re working on in AutoCAD 
without even thinking about it.

TABLE 4-1 Common Architectural Drawing Scales
Drawing Scale Drawing Scale Factor Common Uses

1/16″ = 1′-0″ 192 Large-building plans

1/8″ = 1′-0″ 96 Medium-sized building plans

1/4″ = 1′-0″ 48 House plans

1/2″ = 1′-0″ 24 Small-building plans

1″ = 1′-0″ 12 Details

1:200 200 Large-building plans

1:100 100 Medium-sized building plans

1:50 50 House plans

1:20 20 Small building plans

1:10 10 Details
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Even if you’re going to use the Plot dialog box’s Fit to Paper option (rather than a 
specific scale factor) to plot the drawing, you still need to choose a scale to make 
the nonreal things (such as text, dash-dot linetypes, hatch patterns, and so on) 
appear at a useful size. I cover plotting in Chapter 16.

Thinking about paper
You don’t normally need to worry about the size of the paper that you want to use 
for plotting your drawing until much later in the drawing process. And that’s the 
beauty of CAD: You can easily move views around to suit after you get the basic 
object drawn, and you don’t need to worry about scale factors until you’re ready 
to add annotations. I cover this in excruciatingly more (just kidding, it’s actually 
quite simple) detail in Chapters 12–15. Here again, most industries use a small 
range of standard sheet sizes.

Here are the two ways of laying out a drawing so it’s ready to be plotted:

 » In model space: In this process, everything was drawn in model space, which 
was the only known universe. The drawing was created full size, while text and 
dimension component sizes, hatch pattern scaling, title blocks, and borders 
were all created at the inverse of the final plotting scale. This was the only way 
for many years, so you’ll encounter many drawings that were made this way.

 » In paper space: Finally, Autodesk programmers figured out how to tunnel 
through into a parallel universe called paper space, which revolutionized 
drawing production. Current preferred practice is to draw the object in model 
space, cut a viewport in paper space so you can look through to the model 
space, and then apply documentation in paper space.

I cover model space versus paper space in Chapter 16.

Defending your border
The next decision to make is what kind of border your drawing needs. The options 
include a full-blown title block, a simple rectangle, or nothing at all around your 
drawing. If you need a title block, do you have one?, can you borrow an existing 
one?, or will you need to draw one from scratch? Although you can draw title 
block geometry in an individual drawing, you’ll save time by reusing the same 
title block for multiple drawings. Your company or client should already have a 
standard title-block drawing ready to use, or someone else who’s working on your 
project may have created one for the project.
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The most efficient way of creating a title block is as a separate DWG file, drawn 
at its normal plotted size (for example, 36″ x 24″ for an architectural D-size title 
block, or 841mm x 594mm for an ISO A1-size version). You then insert (see Chap-
ter 17) or xref (see Chapter 18) the title block drawing into each drawing sheet.

A Template for Success
When you start in either the Drafting & Annotation workspace (as I do throughout 
this book) or the old AutoCAD Classic workspace, AutoCAD creates a new, blank 
drawing configured for 2D drafting. Depending on where you live (your country, 
not your street address!) and the dominant system of measure used there, Auto-
CAD will base this new drawing on one of two default drawing templates:

 » acad.dwt for the Imperial system of measure, as used in the United States

 » acadiso.dwt for the metric system, used throughout most of the rest of 
the galaxy

In AutoCAD LT, the two default templates are acadlt.dwt and acadltiso.dwt. 
When you explicitly create a new drawing from within AutoCAD, the Select Tem-
plate dialog box, shown in Figure 4-2, appears by default so you can choose a 
template on which to base your new drawing.

FIGURE 4-2:  
A toolbox of 

templates.
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You may be familiar with Microsoft Word or Excel template files, and AutoCAD 
drawing templates work pretty much the same way because Autodesk stole the 
idea from them, encouraged, of course, by Microsoft, although one could argue 
that it was the other way around.

A template is simply a drawing whose name ends in the letters DWT, which you use 
as the starting point for another drawing. When you create a new drawing from a 
template, AutoCAD makes a copy of the template file and opens the copy in a new 
drawing editor window. The first time you save the file, you’re prompted for a new 
filename to save to; the original template file stays unchanged.

Using a suitable template can save you time and worry because many of the setup 
options are already set correctly for you. You know the drawing will print cor-
rectly; you just have to worry about getting the geometry and text right. Of course, 
all this optimism assumes that the persons who set up the template knew what 
they were doing.

The stock templates that come with AutoCAD are okay as a starting point, but 
you’ll want to modify them to suit your purposes or create your own from scratch. 
In particular, the stock AutoCAD templates are probably not set up for the scales 
or layers you’ll want to use. The instructions in the rest of this chapter tell you 
how to specify scale-dependent setup information.

So, the only problems with templates are creating good ones and then later find-
ing the right one to use when you need it. Later in this chapter, in the “Making 
Templates Your Own” section, I show you how to create templates from your own 
setup drawings. Here I show you how to use an already-created template — say, 
one of the templates that comes with AutoCAD or one you get from a CAD-savvy 
colleague. If you’re lucky, someone in your office has created suitable templates 
that you can use to get going quickly.

Follow these steps to create a new drawing from a template drawing:

1. Run the NEW command by pressing Ctrl+N or clicking the Application 
button and choosing New.

The Select Template dialog box appears.

The first button on the Quick Access toolbar runs the QNEW (Quick NEW) 
command instead of the ordinary NEW command. If you or someone else has 
changed the Default Template File Name for QNEW in the Options dialog box, 
QNEW will not open the Select Template dialog box; instead, it simply presents 
you with a new, blank drawing — possibly not the one you wanted. You can 
take advantage of QNEW, though. For information how, see the “Making 
Templates Your Own” section, later in this chapter.
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2. Click the name of the template you want to use as the starting point for your 
new drawing and then click the Open button.

A new drawing window with a temporary name, such as Drawing2.dwg, 
appears. The template you opened remains unchanged on your computer’s 
hard drive.

Depending on which template you choose, your new drawing may open in a 
paper space layout, not in model space. If that’s the case, click the Model 
button on the status bar before changing the settings described in the next 
section. I describe how to set up and take advantage of paper space layouts in 
Chapter 15.

3. Press Ctrl+S or click the Application button and choose Save to save the file 
under a new name.

Take the time to save the drawing to the appropriate name and location now.

4. Make needed changes.

With most of the templates that come with AutoCAD, consider changing the 
units, limits, grid and snap settings, linetype scale, and dimension scale. See 
the next section for instructions.

5. Save the drawing again.

If you’ll need other drawings in the future similar to the current one, consider 
saving your modified template as a template in its own right. See the section 
“Making Templates Your Own,” later in this chapter, for the lowdown on saving 
templates.

A few of the remaining templates that come with AutoCAD include title blocks for 
various sizes of sheets. In addition, most templates come in two versions: one for 
people who use color-dependent plot styles and one for people who use named plot 
styles. You probably want the color-dependent versions. Chapter 16 describes the 
two kinds of plot styles and why you probably want the color-dependent variety.

Making the Most of Model Space
After you decide on drawing scale and sheet size, you’re ready to set up your 
drawing. Most drawings require a two-part setup:

1. Set up model space, where you’ll create most of your drawing.

2. Create one or more paper space layouts for plotting.
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As I explain in Chapter 2, model space is the infinitely large, three- dimensional 
environment in which you create the “real” objects you’re drawing. You can set up 
your model space as described in this section; Chapter 16 introduces you to setting 
up your paper space layouts.

Setting your units
Follow these steps to set the linear and angular units that you want to use in your 
new drawing:

1. Click the Application button 
and then choose Units from the 
Drawing Utilities group.

The Drawing Units dialog box 
appears, as shown in Figure 4-3.

2. Choose a linear unit type from 
the Length Type drop-down list.

Choose the type of unit represen-
tation that’s appropriate for your 
work. Engineering and 
Architectural units are displayed in 
feet and inches; the other types of 
units aren’t tied to any particular 
unit of measurement. You decide 
whether each unit represents a 
millimeter, centimeter, meter, inch, 
foot, or something else. Your 
choice is much simpler if you’re working in metric: Choose Decimal units.

AutoCAD can think in inches! If you’re using Engineering or Architectural units 
(feet and inches), AutoCAD interprets any distance or coordinate you enter as 
that many inches. You must use the ′ (apostrophe) character on your keyboard 
to indicate a number in feet instead of inches. Using the ″ symbol to indicate 
inches isn’t required but is acceptable.

3. From the Length Precision drop-down list, choose the level of precision you 
want when AutoCAD displays coordinates and linear measurements.

The Length Precision setting controls how precisely AutoCAD displays coordi-
nates, distances, and prompts in some dialog boxes. For example, the 
Coordinates section of the status bar displays the current coordinates of the 
cursor, using the current precision.

FIGURE 4-3:  
Set your units here.
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The linear and angular precision settings affect only AutoCAD’s display of 
coordinates, distances, and angles on the status bar, in dialog boxes, and in the 
command line and Dynamic Input tooltip areas. For drawings stored as DWG 
files, AutoCAD always uses maximum precision to store the locations and sizes 
of all objects that you draw, regardless of how many decimal places you 
choose to display in the Drawing Units dialog box. In addition, AutoCAD 
provides separate settings for controlling the precision of dimension text. (See 
Chapter 14 for details.)

4. Choose an angular unit type from the Angle Type drop-down list.

Decimal Degrees and Deg/Min/Sec are the most common choices.

The Clockwise check box and the Direction button provide additional angle 
measurement options, but you’ll rarely need to change the default settings: 
Unless you’re a land surveyor, measure angles counterclockwise and use east 
as the 0-degree direction.

5. From the Angle Precision drop-down list, choose the degree of precision you 
want when AutoCAD displays angular measurements.

6. In the Insertion Scale area, choose the units of measurement for this 
drawing.

Choose your base unit for this drawing — that is, the real-world distance repre-
sented by one AutoCAD unit. I discuss the significance of this in Chapter 17.

The AutoCAD (but not the AutoCAD LT) Drawing Units dialog box includes a 
Lighting area where you specify the unit type to be used to measure the 
intensity of photometric lights. I introduce lighting as part of rendering 3D 
models in Chapter 23.

7. Click OK to exit the dialog box and save your settings.

Making the drawing area  
snap-py (and grid-dy)
For the first three decades, AutoCAD’s grid consisted of a set of evenly spaced dots 
that served as a visual distance reference. You can still configure a dot grid, but 
starting with AutoCAD 2011, the default is a snazzy graph–paper–like grid made 
up of a network of lines.

AutoCAD’s snap feature creates a set of evenly spaced, invisible hot spots, which 
make the cursor move in nice, even increments as you specify points in the draw-
ing. Both Grid mode and Snap mode are like the intersection points of the lines on 
a piece of grid paper, but the grid is simply a visual reference — it never prints — 
whereas Snap mode constrains the points that you can pick with the mouse. You 
can set grid and snap spacing to different values.
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You don’t have to toggle Snap mode on and off. It’s on only when you’re using a 
command that asks you to specify a point. For example, when Snap is on, you can 
move your crosshairs freely around the screen, but when you start the Line com-
mand, Snap mode kicks in, and your cursor jump to the closest snap point.

Set the grid and the snap intervals in the Drafting Settings dialog box by following 
these steps:

1. Right-click the Snap 
Mode or Grid Display 
button on the status 
bar and choose 
Settings from the 
menu that appears.

The Drafting Settings 
dialog box appears 
with the Snap and 
Grid tab selected, as 
shown in Figure 4-4.

The Snap and Grid tab 
has six sections, but 
the Snap Spacing and 
Grid Spacing areas 
within that tab are all 
you need to worry 
about for most 2D 
drafting work.

2. Select the Snap On check box to turn on Snap mode.

This action enables default snaps half a unit apart (ten units apart if you’re 
working with the default metric template).

AutoCAD usually has several ways of doing things. You can also click the Snap 
Mode button on the status bar to toggle snap on and off; the same goes for 
the Grid Display button and the grid setting. Or you could press the function 
keys: F7 toggles the grid off and on, and F9 does the same for Snap mode.

3. Enter the snap interval you want in the Snap X Spacing text box.

Use the information in the sections preceding these steps to decide on a 
reasonable snap spacing.

If the Equal X and Y Spacing check box is selected, the Y spacing changes 
automatically to equal the X spacing, which is almost always what you want. 
Deselect the check box if you want to specify unequal snap spacing.

FIGURE 4-4:  
Get your drafting settings here!
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4. Select the Grid On check box to turn on the grid.

5. Enter the desired grid spacing in the Grid X Spacing text box.

Use the information in the sections preceding these steps to decide on a 
reasonable grid spacing.

As with snap spacing, if the Equal X and Y Spacing check box is selected, the Y 
spacing automatically changes to equal the X spacing. Again, you usually want 
to leave it that way.

X measures horizontal distance; Y measures vertical distance. The AutoCAD 
drawing area normally shows an X and Y icon in case you forget.

If you’re an old AutoCAD hand and find the graph paper grid too obtrusive, 
select the Display Dotted Grid in 2D Model Space check box in the Grid Style 
area to switch to the old-style rows and columns of dots. Interestingly, it seems 
most beginners like the grid, but most experienced users turn it off.

6. Specify additional grid display options in the Grid Behavior area:

• Adaptive Grid: AutoCAD changes the density or spacing of the grid lines or 
dots as you zoom in and out.

• Allow Subdivision Below Grid Spacing: Select this check box in conjunction 
with the Adaptive Grid check box. The spacing can go lower than what 
you’ve set, and it may go higher if you’re zoomed a long way out of your 
drawing. (If it didn’t, you couldn’t see your drawing for the grid!)

• Display Grid Beyond Limits: This allows the grid to display over the entire 
drawing area, no matter how far you’re zoomed out. Clearing this check box 
makes AutoCAD behave the way it always behaved in earlier releases — that 
is, the grid is displayed only in the area defined by the drawing limits.

• Follow Dynamic UCS: This option (not available in AutoCAD LT) is a 3D-specific 
feature that changes your drawing plane as you mouse over 3D objects. 
I cover this feature in Chapter 21.

7. Click OK to close the Drafting Settings dialog box.

Setting linetype and dimension scales
Even if you’ve engraved the drawing scale factor on your desk and written it on 
your hand — not vice versa — AutoCAD doesn’t know the drawing scale until 
you enter it. Keeping AutoCAD in the dark is fine as long as you’re just drawing 
continuous lines and curves representing real-world geometry because you draw 
these objects at their real-world size, without worrying about plot scale.

However  .  .  . as soon as you start using noncontinuous dash-dot linetypes (line 
patterns that contain gaps in them), you need to tell AutoCAD how to scale the 
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gaps in the linetypes based on the plot scale. If you forget this, the dash-dot line-
type patterns can look waaaay too big or too small. Figure 4-5 shows what I mean.

The scale factor that controls dash-dot linetypes is found in a system variable 
called LTScale (as in, LineType Scale). You can change this setting at any time, but 
it’s best to set it correctly when you’re setting up the drawing.

The following steps include directions for typing system variable and command 
names. To set the linetype scale at the keyboard, follow these steps:

1. Type LTSCALE (or LTS) and press Enter.

AutoCAD responds with a prompt, asking you for the scale factor. The value at 
the end of the prompt is the current linetype scale setting, as shown in the 
following command line example:

Enter new linetype scale factor <1.0000>:

2. Type the value you want for the linetype scale and press Enter.

The easiest choice is to set the linetype scale to the drawing scale factor. Some 
people, however, find that the dashes and gaps in dash-dot linetypes get a bit 
too long when they use the drawing scale factor. If you’re one of those people, 
set LTSCALE to one-half of the drawing scale factor. (Feel free to experiment 
with this value; some people prefer a linetype scale of three-quarters the scale 
factor. If you’re working in metric, try 0.75 times the scale factor instead — just 
ask your calculator if you don’t believe us.)

Alternatively, you can specify linetype scale in the Linetype Manager dialog box: 
Click the Linetype drop-down list on the Properties panel of the Ribbon’s Home 
tab and select Other. Then in the Linetype Manager dialog box, click the Show 
Details button, and type your desired linetype scale in the Global Scale Factor 
text box.

Besides LTSCALE, there are three other similarly named system variables you can 
use to control the display of dash-dot linetypes:

FIGURE 4-5: 
 And this 

little center line 
looks juuuust 

right!
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 » PSLTSCALE: Makes linetype spacing look the same in paper space viewports, 
regardless of the viewport scale

 » CELTSCALE: Changes the effective linetype scale factor for new objects

 » MSLTSCALE: Visually displays dash-dot linetypes in the model tab based on 
the annotative scale setting

If any of these sound useful — and I highly recommend that you enable 
PSLTSCALE — check them out in the online help index.

You should set linetype scale only when you’re starting a new drawing from one 
of the generic AutoCAD templates (acad.dwt or acadiso.dwt in the full version, 
acadlt.dwt or acadltiso.dwt in AutoCAD LT) and you’re not using the default 
linetype scale. Don’t change LTSCALE in existing drawings without knowing 
exactly why you’re doing it and what values to set them to, in case someone before 
you set those values for good reasons.

Entering drawing properties
I recommend one last bit of house-
keeping before you’re finished with 
model space drawing setup: Enter 
summary information in the  Drawing 
Properties dialog box, as shown in 
Figure 4-6. Click the Application but-
ton; in the Drawing Utilities section, 
choose Drawing Properties to open 
the Drawing Properties dialog box; 
then click the Summary tab. Enter the 
drawing scale and the drawing scale 
factor you’re using in the Comments 
area, plus any other information you 
think useful.

Don’t confuse drawing properties 
(which are really file properties) with 
your drawing’s object properties — 
they’re different things. The proper-
ties you enter here can help you or someone you love when they open your drawing 
and wonders how you set it up. Object properties are a big enough topic to merit 
their own chapter. See Chapter 9.

Want to find a specific file hidden on your hard drive? You can search for values 
you’ve entered in the Drawing Properties dialog box by using Windows Explorer’s 
search functions.

FIGURE 4-6:  
Surveying your drawing’s properties.
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Making Templates Your Own
You can create a template from any DWG file by using the Save Drawing As dialog 
box. Follow these steps to save your drawing as a template:

1. Click Save As on the Quick Access toolbar.

The Save Drawing As dialog box appears, as shown in Figure 4-7.

2. From the Files of Type drop-down list, choose AutoCAD Drawing Template 
(*.dwt) or AutoCAD LT Drawing Template (*.dwt).

3. Navigate to the folder where you want to store the drawing template.

The default folder for AutoCAD drawing templates is buried deep in the bowels 
of your Windows user profile, which by default isn’t visible in Windows 
Explorer. Hey, I never said this made any sense! Save your templates there if 
you want them to appear in AutoCAD’s Select Template list. You can save your 
templates in another folder, but if you want to use them later, you have to 
navigate to that folder every time you want to use them unless you change 
your Options settings. I explain how to do this later in the chapter.

4. Enter a name for the drawing template in the File Name text box and then 
click Save.

A dialog box for the template description and units appears.

5. Specify the template’s measurement units (English or Metric) from the drop-
down list.

Enter the key info now; you can’t do it later unless you save the template to a 
different name. Don’t bother filling in the Description field; AutoCAD doesn’t 

FIGURE 4-7:  
Saving a 

drawing as 
a template 

and applying 
options.
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display it in the Select Template dialog box. Don’t worry about the New Layer 
Notification area shown in Figure 4-7 for now; I tell you all about drawing layers 
in Chapter 9.

6. Click OK to save the file.

The Template Options dialog box closes, and the template is saved to your 
hard drive.

7. To save your drawing as a regular drawing, click Save As on the Quick Access 
toolbar.

The Save Drawing As dialog box appears again.

8. From the Files of Type drop-down list, choose AutoCAD 2013 Drawing (*.dwg).

Choose the AutoCAD LT equivalent, if that’s your version. AutoCAD uses the 
same file format for 2013 to 2017 (so far), and this format can’t be opened by 
2012 or earlier releases. Choose a previous DWG file format if you want to be 
able to open your drawing in AutoCAD 2012 or earlier, but note that some 
features introduced in later releases may not translate properly to earlier ones 
and may not survive a round trip back into 2013 or later.

9. Navigate to the folder where you want to store the drawing.

Use a different folder from the one with your template drawings.

10. Enter the name of the drawing in the File Name text box and click Save.

The file is saved. Now, when you save it in the future, the regular file — not the 
template file — is updated.

Okay, do you want to know the real secret behind template files? One letter. That’s 
right, the only difference is that a drawing file has the extension DWG, and a tem-
plate’s extension is DWT. You can convert a drawing to a template just by using 
Windows Explorer to change the extension. The further secret to this is that a 
DWT can hold any information that you can put in a DWG. For example, you may 
often need to produce a drawing of a new machine shaft. All details are the same 
as previous shafts except for the length. Draw it once and convert it to a template. 
Now, when you need a new shaft drawing, just start it from the shaft template, 
change the length, and you’re done!

In Chapter 3, I warn you to not use the New buttons on the Application menu 
or the Quick Access toolbar. These buttons launch the QNEW (Quick NEW) com-
mand, which bypasses the Select Template dialog box and creates a drawing from 
a default template. The good news is that you can easily put the Quick into QNEW 
so that it uses your favorite template as the default. Just do this:

1. Click the Application button and then click the Options button at the 
lower-right corner of the Application menu.
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FINDING YOUR USER FOLDER
Microsoft insists that any program that uses files unique to or modifiable by individual 
users must be kept in a separate folder system for each user so that different people 
sharing a computer won’t mess up each other’s settings. There are just two minor flaws 
with this edict:

• Hardly anyone shares a computer these days. In fact, my tech editor claims that a 
typical user today has multiple computers, and brags (or complains) that he has 
three, not including Android models. I have two, and my wife has one.

• By default, this is a hidden system folder that you can’t see in Windows Explorer, 
making it difficult to copy, rename, or move files in it.

The solution:

Windows XP

1. Start Windows Explorer.

2. In its menu, click Tools then Folder Options.

3. Under the View tab, click the Show Hidden Files and Folders button and then dese-
lect the Hide Extensions for Known File Types check box.

4. Click OK.

Windows 7

1. Start Windows Explorer.

2. Choose Organize ➪ Folder ➪ Search Options.

3. Under the View tab, click the Show Hidden Files and Folders button and then dese-
lect the Hide Extensions for Known File Types check box.

4. Click OK.

Windows 8

1. In File Explorer, choose the View tab.

2. Click the Options button.

3. Follow the remaining steps as for Windows 7 (in the preceding list).
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2. On the Files tab, choose Template Settings, and then choose Default 
Template File Name for QNEW.

The QNEW default file name setting is None, which causes QNEW to act just 
like NEW (that is, QNEW opens the Select Template dialog box). Specify the 
name of your favorite template here, and you get a new drawing file based on 
it every time you click QNEW.

AutoCAD stores drawing templates and many other support files under your 
Windows user folder. To discover where your template folder is hiding, open the 
Options dialog box. On the Files tab, choose Template Settings and then Drawing 
Template File Location, as shown in Figure 4-8.

Windows 10

1. In File Explorer, choose the View tab.

2. In the Show/Hide tab, turn on the Hidden Items option.

Now you can see what’s happening in your private folder.

FIGURE 4-8:  
Seek and 

you shall find 
your template 

folder.
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You don’t have to keep your template files where that bossy Mister Gates told you. 
Create a folder that you can find easily (for example, C:\Acad-templates or F:\
Acad-custom\templates on a network drive), put the templates that you actu-
ally use there, and change the Drawing Template File Location setting so that it 
points to your new template folder. How many Microsoft employees does it take to 
change a light bulb? None. Dark simply becomes the new standard.

In an office environment in particular, the template folder should live on a net-
work drive so that everyone starts from the same set of templates.

Once you get everything set up properly, you don’t need to do the setup again. 
Setting up a drawing requires about 20 minutes, on average, but this time drops 
to almost zero if you configure your templates properly. By using templates, you 
can save enough time in a year or so to pay for a tropical vacation.
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IN THIS CHAPTER

Zooming and panning

Naming and restoring views

Zooming and panning in paper space 
layouts

Regenerating the display

A Zoom with a View

O 
ne advantage that AutoCAD has over manual drafting is its ability to show 
you different views of a drawing.

You move the viewpoint in, or zoom in, to see a closer view of the objects in a 
drawing; you move the viewpoint out, or zoom out, to see a more expansive (not 
expensive) view. If you watch TV or movies or own a camera, you should under-
stand zooming.

Panning doesn’t refer to looking for gold but rather, looking at a different part of 
a drawing without changing the magnification of the view. If you zoom in so that 
part of the drawing is no longer shown onscreen, you’ll pan around in the draw-
ing without zooming in and out. Think of the monitor as a window through which 
you’re looking at part of the drawing. Now reach through the window and slide 
the drawing around until you can see a different portion of it through the window.

Panning and zooming do not change the size or position of objects within the 
drawing. They change only how you see them.

In fact, you not only can zoom and pan in the drawing but also, in most kinds of 
drawings, you must zoom and pan frequently to be able to draw and edit effectively.

Why do you need to pan and zoom often? For starters, though many architectural 
drawings plot out at 3 feet by 2 feet, you probably aren’t fortunate enough to own 
a monitor of that size with sufficient resolution to be able to see every little detail.

Chapter 5
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In addition, technical drawings are jam-packed with lines, text, and dimensions. As 
discussed in Chapter 8, drawing with precision is essential to following best prac-
tices for AutoCAD drawings. Frequent zooming and panning enables you to better 
see detail, to draw more precisely because you can see what you’re doing, and to edit 
more quickly because object selection is easier when the screen isn’t cluttered with 
objects. This chapter describes the most useful display control  features in AutoCAD.

Zooming and Panning with Glass and Hand
AutoCAD makes panning easy, by offering scroll bars and real-time panning. In 
real-time panning (as opposed to pretend-time panning?), you can see objects 
moving on the screen as you drag the mouse upward and downward or back and 
forth. Of course, the viewpoint is moving, not the objects.

Both panning and zooming change the view — the current location and magnifi-
cation of the AutoCAD depiction of the drawing. Every time you zoom or pan, you 
establish a new view. You can name a specific view so that returning to it is easy, 
as I demonstrate in the later section “A View by Any Other Name.”

You can gain a better sense of panning and zooming in a drawing when you’re 
looking at a drawing. Draw some objects on the screen, open an existing drawing, 
or launch a sample drawing in AutoCAD. If you haven’t done so already, you can 
download sample files from www.autodesk.com/autocad-samples. The AutoCAD 
LT sample files are also online at www.autodesk.com/autocadlt-samples.

The wheel deal
Later in this chapter, I cover in detail various commands and options in AutoCAD 
for panning and zooming — if you have a wheel mouse, however, you’ll rarely 
need to use other methods, especially when working in 2D drawings. If you don’t 
have a wheel mouse, run out and buy one now because the slight cost will be more 
than offset by your increased productivity. The following three actions usually 
suffice for almost all panning and zooming needs:

 » Zoom in, zoom out: Roll the scroll wheel forward and backward.

 » Pan: Hold down the scroll wheel as you move the mouse. (The scroll wheel is 
also considered a button.)

 » Zoom to the extents of a drawing: Double-click the scroll wheel. This 
method is particularly useful when you accidentally press Enter at the wrong 
time during a Move or Copy operation, as described in Chapter 11.

www.allitebooks.com

http://www.autodesk.com/autocad-samples
http://www.autodesk.com/autocadlt-samples
http://www.allitebooks.org
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Using the scroll wheel (or middle button on a mouse that has three buttons) for 
zoom and pan operations depends on the setting of the obscure AutoCAD system 
variable named MBUTTONPAN. When MBUTTONPAN is set to the default value 
of 1, you can use the scroll wheel or middle button to pan and zoom. Unless the 
system has been customized, if you change MBUTTONPAN to 0, clicking the scroll 
wheel or middle mouse button displays the Object Snap menu at the cursor, as it 
did in earlier AutoCAD releases. If you can’t zoom or pan using the scroll wheel or 
middle mouse button, set MBUTTONPAN to 1. When MBUTTONPAN is set to 1 you 
can press Shift+right-click 
to display the Object Snap 
menu at the cursor. I discuss 
Object Snaps in Chapter 8.

Navigating a 
drawing
You may believe that Auto-
CAD is all about drawing 
and, occasionally, even about 
erasing. If so, you may be sur-
prised to read that two of the 
most frequently used com-
mands in all of AutoCAD are 
Pan and Zoom although the 
hands-down favorite is Undo. 
You can find these two com-
mands in a couple of conve-
nient places in AutoCAD:

 » On the Navigation 
bar: The Navigation 
bar contains both 
Zoom and Pan buttons. 
Figure 5-1 shows the 
upper-right corner of 
the AutoCAD window 
with the Navigation bar 
in its default location, 
linked to the ViewCube. 
Because the ViewCube is 
more useful in 3D draw-
ing, I tell you about it in 
Chapter 21.

ViewCube

Pan

Zoom

Navigation bar menu

Navigation bar

FIGURE 5-1: 
Belly up to the Navigation bar.
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 » In the Navigate and Navigate 2D panels on the View tab on the Ribbon: 
These two panels contain a Pan button and a drop-down set of Zoom 
tool  buttons. This location is not the most convenient for frequently used 
 commands — and to make matters worse, this panel may not even be visible. 
To display it you must right-click anywhere in the View tab, click Show Panels, 
and then click Navigate.

If you’re primarily creating 2D drawings, you can remove some of the 3D 
related viewing tools from the Navigation bar or turn off the ViewCube itself, 
either for the drawing session or permanently. Choose a method:

 » Turn off navigation buttons. Open the Navigation bar menu by clicking the 
down arrow in its lower-right corner (as shown in Figure 5-1) and deselect 
SteeringWheels, Orbit, and ShowMotion.

 » Turn off the ViewCube or the Navigation bar (or both) in the current 
viewport. From the User Interface panel on the View tab, click User Interface 
and deselect ViewCube or Navigation bar or both.

 » Turn off the ViewCube permanently. Open the Options dialog box (choose 
Options from the Application menu or type OPtions) and select the 3D 
Modeling tab. In the Display Tools in Viewport section, under the Display the 
ViewCube line, deselect the two options 2D Wireframe Visual Style and All 
Other Visual Styles.

Scrolling is the same in AutoCAD as in any other Windows program: Either click 
the arrows on the scroll bars on the right and bottom borders of the drawing win-
dow to scroll, or pan, a step at a time, or click and drag the little scroll boxes to pan 
as little or as much as you want. To turn scroll bars off or on, choose Options from 
the Application menu (or type OPtions) to display the Options dialog box. On the 
Display tab, select or deselect the Display Scroll Bars in Drawing Window check 
box. My own preference is not to use scroll bars to regain the screen space they 
occupy so that’s why you don’t see them in most figures in this book.

Zoom, Zoom, Zoom
Because zooming is a frequent activity in AutoCAD, you should know some alter-
native ways to zoom.

In addition to the Zoom button on the Navigation bar I describe earlier in this 
chapter, you’ll find tool buttons for all the Zoom options in the Navigate panel 
on the View tab. Click the down arrow beside the magnifying-glass button in the 
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lower-right corner of the panel and a menu with the other options 
opens as shown in Figure 5-2.

The Zoom command has 11 options. The most important ones are 
described in this list:

 » Extents and All: The Zoom Extents button (with the four-headed 
arrow and the magnifying glass) zooms out just far enough to 
show all objects in the current drawing. The Zoom All button 
(showing the sheet with the folded-over corner) does almost the 
same thing: It zooms to show the rectangular area defined by the 
drawing limits set with the LIMITS command, or it zooms to show 
the extents — whichever is larger. These two options are espe-
cially  useful when you zoom in too close or pan off into empty 
space and want to see the entire drawing again.

Limits and extents are slightly different. Limits are set by the 
Limits command. You can configure AutoCAD to not allow you to 
draw anything outside the limits, but this usually causes more 
problems than it solves. Extents are defined by the smallest imag-
inary rectangle that will just surround every object in your draw-
ing. A good April Fool’s trick is to sneak up to another person’s 
computer and draw a tiny circle by typing the location coordinates 
as something like 10000,10000. The next time the person does a 
Zoom Extents, his or her drawing will seem to disappear.

Use Zoom All or Zoom Extents and then save the drawing before you close it 
to ensure that:

• The next person who opens the drawing can see the full drawing as soon 
as they start working.

• Any objects that you accidentally copied beyond the drawing limits show 
up so that you can delete or move them.

• The drawing preview that appears in the Select File dialog box and on the 
Start screen displays the full drawing rather than a tiny, unidentifiable 
corner of it.

 » Window: This option, which is useful for zooming in quickly and precisely, 
zooms to a section of the drawing that you specify by clicking two points. The 
two points define the diagonal of a window around the area you want to see.

The Zoom command’s Window option is not a click-and-drag operation, unlike 
in most other Windows programs and — confusingly — unlike in the Zoom/
Pan Realtime Zoom Window option. To use the Zoom command’s Window 
option, you click one corner, release the mouse button, and then click the 
other corner.

FIGURE 5-2: 
A menu for 
 magnifying.
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 » Realtime: Enables you to zoom in and out by starting a real-time zoom 
and then dragging the magnifying-glass cursor up (to zoom in) or down 
(to zoom out).

 » Previous: Use this option to undo the last zoom or pan sequence (or both), 
returning to where you started. You can repeat this option to step through 
previous views, even if you create or edit objects after changing the view.

 » Object: This option zooms in close enough to show selected objects as large 
as they can be displayed onscreen. Using Zoom Object is similar to examining 
selected objects under the AutoCAD microscope.

Entering the keyboard command sequences Z A, Z P, or Z W (note the mandatory 
space between the letters) is usually faster than trying to find the corresponding 
zoom tools on the ribbon or various toolbars. Z is the command alias for the Zoom 
command, while A, P, and W start the All, Previous, and Window options, respec-
tively. These three command sequences, in combination with the wheel mouse, 
typically account for more than 99 percent of your panning and zooming needs. (I 
almost never use any Ribbon or navigation bar options.)

I cover another important Zoom option when discussing paper space viewports in 
Chapter 12.

A View by Any Other Name
If you repeatedly have to zoom and pan to the same area, you can quickly see 
what you want to see by using a named view. After you name and save a view of a 
particular area of a drawing, you can return to that area quickly by restoring the 
view. You use the View command, which displays the View Manager dialog box, to 
create and restore named views.

Follow these steps to create a named view:

1. Zoom and Pan until you find the area of the drawing to which you want 
to assign a name.

2. Start the View command from the keyboard. Or on the View tab on the 
Ribbon, click View Manager in the Views panel.

If the Views panel is not visible, right-click anywhere in the View tab, click Show 
Panels, and then click Views.

The View Manager dialog box opens.
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3. Click New.

The New View/Shot Properties (New View in AutoCAD LT) dialog box appears, 
as shown in Figure 5-3.

4. Type a name in the View Name text box.

5. (Optional) Type a new category in the View Category text box, or select 
an existing one from the drop-down list.

You create your own view categories to organize views and certain display 
characteristics of views. This feature is used mainly in sheet sets. If you aren’t 
using them, you can leave the default value, <None>, in the View Category box or 
clear the current value. (A discussion of sheet sets is beyond the scope of this book.)

6. Make sure that the View Type drop-down list is set to Still.

The Still option creates a static thumbnail image of the objects in the area that 
is defined by the named view for use in ShowMotion. Visit the online Help 
system if you want to know more about the Cinematic and Recorded Walk 
options that you can choose from this drop-down menu, which are used 
mainly in 3D work.

AutoCAD LT doesn’t support view types, so if you’re working with AutoCAD LT, 
skip Step 6. The New View dialog box in AutoCAD LT omits the View Type list 
box, most of the Settings drop-down options, and the Background area.

FIGURE 5-3: 
Save a view in 

the drawing.
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7. In the Boundary area, select the Current Display radio button, if it isn’t 
selected already.

If you want to save a different view boundary, select the Define Window radio 
button instead, click the Define View Window button that appears to the right 
of it, and pick two corners of the region’s boundary (as though you’re zooming 
windows).

8. Confirm or change the choices in the Settings area.

If you select the Save Layer Snapshot with View check box, when you later 
restore the view, AutoCAD also restores the layer visibility settings (On/Off and 
Freeze/Thaw) that were in effect when you created the view. I discuss layer 
visibility settings in Chapter 9. The Live Section and Visual Style settings are 
intended primarily for 3D drawings; these two settings aren’t included in 
AutoCAD LT.

9. Click OK.

The New View/Shot Properties (New View in AutoCAD LT) dialog box closes, 
and you see the new named view in the list in the View Manager dialog box.

10. Click OK.

The View Manager dialog box closes.

To restore a named view, follow these steps:

1. From the View tab on the Ribbon, click View Manager from the 
View panel.

Alternatively, type View and press Enter. The View Manager dialog box 
appears.

2. In the Views list, expand either Model Views or Layout Views (depending on 
where you saved the view).

3. Double-click the name of the view you want to restore, and then click OK 
to close the dialog box.

In both AutoCAD and AutoCAD LT, you can set named views to be current without 
having to open the View Manager dialog box. From the Views panel on the View 
tab, simply choose a named view to restore from the drop-down list.

You also can plot the area defined by a named view. See Chapter 16 for instructions 
on plotting views.
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Degenerating and Regenerating
As you zoom and pan around the drawing, you may wonder how the image you 
see onscreen is related to the DWG file that AutoCAD saves on the hard drive. Well, 
maybe you don’t wonder about it, but I tell you in this section anyway.

When you draw and edit objects, AutoCAD stores all their geometrical properties 
(that is, location and size) in a highly precise form — technically, double floating-
point precision. The program always maintains this precision when you save the 
DWG file. For reasons of computer performance, however, AutoCAD does not use 
that high-precision form of the data to display the drawing onscreen. Instead, 
AutoCAD converts the highly precise numbers in the DWG file into slightly less 
precise integers in order to create the view you see onscreen.

The happy consequence of this conversion is that zooming, panning, and other 
display changes happen a lot faster than they would otherwise. The unhappy 
consequence is that the conversion can make circles and arcs look like polygons. 
AutoCAD solves this problem by regenerating the drawing (also known as per-
forming a REgen operation).

In most cases, AutoCAD regenerates drawings automatically whenever it needs 
to. You sometimes see command-line messages such as Regenerating model 
or  Regenerating layout indicating that AutoCAD is handling the regenerating 
for you.

If, on the other hand, you see the command-line message Regen queued, AutoCAD 
is warning you that it’s not performing a regeneration, even though one might be 
advisable. In addition, you might see the warning message About to regen -- 
proceed?. AutoCAD is saying, “What the drawing looks like onscreen now may 
not exactly match the real version of the drawing database that’s stored when you 
save the drawing. I’ll update the display version at the next regeneration.”

You can control whether regenerations happen automatically by using the REGEN-
MODE system variable. See the online Help system for more information on this 
variable, and see Chapter 23 for general information on system variables.

The REgenAll command, available only from the command line, regenerates all 
viewports in a paper space layout. If you run the REgenAll command in model 
space, it has the same effect as the ordinary REgen command.
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If you zoom in a long way in a large drawing that has small circles and arcs and 
you find them converted into hexagons, simply run the REgen command. You 
can also minimize this effect in the future by running the VIEWRES command 
and increasing the value from the default of 1,000 to as high as 20,000 although 
doing so can also slow down a complex drawing. This value is stored in the cur-
rent drawing, so you can set up the template file (covered in Chapter 4) to cover 
most of your work.

Almost every new release of AutoCAD, particularly AutoCAD 2017, has improved 
graphics performance. The program has come a long way from the so-called 
high-resolution 640x480 16-color Tecmar Graphics Master adapter, which  
I started with.
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Draw lines and other mostly linear objects, as well as 
the curvy bits.

Find out how to draw objects with precision.

Manage object properties.

Select and edit objects.

Set up a paper space layout in anticipation of printing.
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IN THIS CHAPTER

Drawing linear things with the 
AutoCAD drawing commands

Lining up for lines and polylines

Closing up with rectangles and 
polygons

Along the Straight 
and Narrow

As you may recall from your crayon-and-coloring-book days, drawing is 
fun. Computer-aided drafting (CAD) imposes a little more discipline, but 
drawing with AutoCAD is still fun. Trust me on this one. In computer-aided 

drafting, you usually start by drawing geometry from basic shapes — lines, circles, 
and rectangles — to represent the real-world object that you’re documenting.

For descriptive purposes, I divide the drawing commands into three groups:

 » Straight lines and objects composed of straight lines, covered in this chapter

 » Curves, which I explain in Chapter 7

 » Points, explained in Chapter 7 as well if you’re wondering what the point of all 
this is

After you’ve created some straight or curvy geometry, you’ll probably need to add 
dimensions, text, and hatching, but those elements come later (in Part 3). Or you 
may want to use that geometry as the basis for some cool 3D modeling. I introduce 
you to that topic in Part 5. Your first task is to get the geometry right; then you can 
worry about labeling elements.

Chapter 6
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Drawing geometry properly in AutoCAD depends on the precision of the points 
that you specify to create the objects. I cover this topic in Chapter 8, so don’t start 
any production CAD drawings until you review that chapter.

Proper geometry creation also depends on creating objects that have the correct 
appearance. In Chapter 9, I show you how to create hidden lines, center lines, 
 section lines, and other elements.

Drawing for Success
AutoCAD offers a wide range of tools that allow you to create designs in a virtual 
world that will be accurately manufactured or built in the real world. The 2D and 
3D tools that you use require some up front preparation to ensure that the designs 
you create are precisely drawn. Nothing is worse than spending time creating 
a great design, only to find out that the objects you drew weren’t drawn at the 
 correct size and that lines don’t intersect. Okay, I lied. Worse yet is that your 
imprecise drawing was used to program a CNC machining center and now the 
expensive metal parts don’t fit.

Here are a few important techniques to use when you draw objects:

 » Use precision tools to make sure objects intersect and are drawn at 
the correct angle. Precision tools allow you to reference points on existing 
objects, constrain the cursor to a specific angle or snap distance, and quickly 
locate a point based on a distance and direction in which the cursor is moved. 
I cover precision techniques and tools in Chapter 8.

 » Understand the difference between command line and Dynamic Input 
coordinate entry. Second and next points entered at the command line are 
interpreted differently from those entered at the Dynamic Input tooltip. The 
second and next points entered at the Dynamic Input tooltip are formatted 
as polar and relative to the previously entered coordinate value automati-
cally, unlike at the command line where you must first type @ before the 
 coordinate value.

AutoCAD’s Dynamic Input system displays a lot of the information at the 
cursor that you used to have to look down to the command line to see. To use 
Dynamic Input, make sure that the Dynamic Input button on the status bar is 
turned on (that is, it looks highlighted). You can also press F12 to toggle 
Dynamic Input on and off.
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 » Watch the command line. The command line at times displays additional 
information about the current command that’s not displayed in the Dynamic 
Input tooltip. This information might be the current text style or justification, 
or the active extend mode. I cover using the command line in Chapter 2.

 » Organize objects on layers. All the objects you draw should be placed on 
specific layers. For example, annotation objects that communicate design 
information might be placed on a Notes layer, and the lines that are used to 
represent a wall might be placed on a Walls layer. I cover layers in Chapter 9.

Introducing the Straight-Line 
Drawing Commands

As I harp on elsewhere in this book, CAD programs are designed for precision 
drawing, so you’ll spend a lot of time in AutoCAD drawing objects composed of 
straight-line segments. The rest of this chapter covers these commands, all of 
which are found on the Draw panel of the Home tab on the Ribbon. The icons in 
the left margin match those from the Ribbon:

 » Line: Draws a series of one or more visually connected straight-line segments; 
that is, the end of the current segment has the same coordinates as the start 
of the next segment. Although the lines appear to be physically connected, 
each segment (piece of a line with endpoints) is in fact a separate object with 
its own start and endpoints.

 » PLine: Draws a polyline, which is a series of straight- or curved-line segments 
(or both) connected as a single object. We’re cheating slightly here because 
I cover curvy components in Chapter 7, but I don’t want you to have to read 
about one command in two different places.

 » RECtang: Provides a convenient way to draw four equi-angular polyline seg-
ments. AutoCAD has no rectangle object.

 » POLygon: Gives you a convenient way to draw a polyline in the shape of a 
regular polygon (a closed shape with all sides and all angles equal).

The POLygon command may be hidden under the Rectangle button on the Ribbon 
or vice versa, depending on which button you used last.
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The following additional straight-line drawing commands, also available in Auto-
CAD LT, are found in the drop-down list below the Draw panel:

 » XLine: Draws a line (known as an ex-line or a construction line) that passes 
through a point at a specified angle and extends to infinity in both directions.

 » RAY: Draws a line (known as a ray) that starts at a point and extends to infinity 
at a specified angle away from the start point.

Use the RAY and XLine commands to draw construction lines that guide the con-
struction of additional geometry. Drawing construction lines is less common 
in AutoCAD than in certain other CAD programs and is far less common than in 
pencil-and-paper drawings. The many precision techniques in AutoCAD usually 
provide methods for creating new geometry that are more efficient than adding 
construction lines to a drawing. In particular, object snap tracking (discussed in 
Chapter 8) and parametrics (discussed in Chapter 19) usually eliminate the need for 
construction geometry or even for a mitre line when creating orthographic views.

Although xlines and rays are infinitely long, they don’t increase the extents of your 
drawing to infinity. The question of the day is, “Which is longer; an XLine that extends 
to infinity in both directions or a RAY that extends to infinity in one direction?”

Drawing Lines and Polylines
The Line command works well for many drawing tasks, but the PLine command works 
better for others. Experience can help you choose which will work best for design 
needs. The PLine command draws a special kind of object — a polyline — and you 
might hear CAD drafters refer to a polyline as a p-line (rhymes with  “bee-line”, 
not to be confused with the queue in a busy restroom).

Here are the primary differences between the Line and PLine commands:

 » The Line command draws a series of separate line segments. Even though 
they appear to be connected onscreen, each one is a separate object. If you 
move one line segment, none of the other segments you drew at the same 
time moves with it.

 » The PLine command draws a single, connected, multisegment object. 
A polyline is what a line appears to be; each segment is connected to form 
a single object. If you select any segment for editing, the changes affect the 
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entire polyline. Figure 6-1 shows 
how the same sketch drawn with 
the Line and the PLine commands 
responds when you select one  
of the objects. A polyline is not  
a pickup line used by parrots in  
a bar.

Use the PLine command rather 
than the Line command in most 
cases where you need to draw a 
series of connected line segments. 
If you’re drawing a series of end-to- 
end segments, those segments 
may well be logically connected. 
For example, they might represent 
the outline of a single object or a continuous pathway. If the segments are 
connected logically, it makes sense to keep them connected in AutoCAD. The 
most obvious practical benefit of grouping segments into a polyline is that 
many editing operations are more efficient when you use polylines. When you 
select any segment in a polyline for editing, the entire polyline is selected.

As covered in Chapter 19, using parametrics on line segments can often 
 produce the same results as using the PLine command.

 » The PLine command can draw curved segments as well as straight ones. 
If you want a combination of separate linear and curved segments, you must 
switch between the Line and ARC commands. (I cover arcs in Chapter 7.) Using 
the PLine command, though, you can switch between linear or circular-curve 
segments within a single polyline.

 » A polyline can have width. Polyline segment width is visually similar to the 
lineweight object property in AutoCAD (which I discuss in Chapter 9) except 
that polyline width can vary from segment to segment, and individual seg-
ments can be tapered. Polylines are often used for the copper conductors on 
electronic printed circuit boards.

 » Polylines can be smooth. After drawing a polyline, you can use the PEdit 
command to automatically reshape the polyline into a smooth, flowing curve 
based on the vertex points you selected. I touch on this topic in Chapter 11.

The following sections show you how to create a line and a polyline.

Each segment is a
separate object

All segments form
one object 

FIGURE 6-1:  
Results of drawing with the Line and PLine 
 commands.
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Toeing the line
Unlike many AutoCAD drawing commands, Line offers limited options. It has a 
Close option only to create one more segment back to the first point you picked in 
the current run of the command, and it has an Undo option to remove the most 
recently drawn segment. You can repeat the Undo option back to the start of the 
current run of the command.

Real-world drawings include several different types of lines, such as hidden, 
 center, and section. Chapter 9 covers how to set these, and several other, properties 
of lines.

Follow these steps to use the Line command:

1. Start the Line command by clicking the Line button on the Draw panel on 
the Ribbon, or by entering L and then pressing Enter.

2. Draw line segments by picking several random points.

3. Terminate the command by pressing Enter, Esc, or the spacebar.

4. Press Enter or the spacebar to repeat the Line command.

In AutoCAD, Pressing Enter or the spacebar when no command is underway 
always repeats the last command.

5. Draw more line segments to complete the figure.

If you need to undo some line segments, enter U and press Enter.

6. Enter C and press Enter to close the figure, which draws one more 
 segment back to the first point you picked.

Pressing Enter or the spacebar whenever AutoCAD asks for a first point auto-
matically selects the last point you picked, regardless of the previous or current 
command.

Connecting the lines with polyline
Drawing polylines composed of straight segments is much like drawing with the 
Line command, as shown in the steps in this section. The PLine command has 
lots of options, so watch the prompts. If the Dynamic Input feature is on, press the 
down-arrow key to see the options listed near the cursor, or right-click to display 
the PLine right-click menu, or simply read the command line.
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To draw a polyline composed of straight segments, follow these steps:

1. Click the Polyline button on the Draw panel of the Ribbon, or type PL at 
the command line and press Enter.

AutoCAD starts the PLine command and prompts you to specify a start point.

2. Specify the starting point by clicking a point or typing coordinates.

Now you truly need to read the command line because the Dynamic Input 
tooltip at the cursor doesn’t display any of the options.

You can right-click or press the down-arrow key to see a list of the options 
at the cursor, as shown in Figure 6-2, but it’s usually faster to use the 
 command line.

AutoCAD displays the current polyline segment line width at the command line 
and prompts you to specify the other endpoint of the first polyline segment:

Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:

FIGURE 6-2: 
The optional 

extras.
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3. If the current line width isn’t zero, change it to zero by typing W to select 
the Width option and then entering 0 as the starting and ending widths, 
as shown in this command-line sequence:

Specify next point or [Arc/Halfwidth/Length/Undo/Width]: W
Specify starting width <0.0000>: 0
Specify ending width <0.0000>: 0
Specify next point or [Arc/Halfwidth/Length/Undo/Width]:

Despite what you may think, a zero-width polyline segment isn’t the AutoCAD 
equivalent of drawing with invisible ink. Zero width means, “Display this 
segment using the normal, single-pixel width on the screen, and plot as thin as 
possible.”

4. Specify additional points by clicking or typing.

After you specify the second point, AutoCAD adds the Close option to the 
prompt. The command line shows

Specify next point or [Arc/Close/Halfwidth/Length/Undo/
Width]:

What you do next can get a little weird. If you invoke the Close option after 
selecting only the first and second points, PLine doubles back on itself and 
creates the second segment back over the first. Normal practice would be to 
not invoke Close until you have created at least two non-collinear segments.

5. Pick several points to create several line segments, and then enter W to 
start the Width option. Then set a new width, as shown in this command 
line sequence:

Starting width <0.0000>: 5
Specify ending width <5.0000>: Press Enter

6. Pick several more points and note the line width of the new segments.

7. Set the Width option again:

Starting width <5.0000>: 15
Specify ending width <0.0000>: 0
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8. Pick another point.

You just created a cool arrowhead!

Any time AutoCAD prompts for a length or distance, you can either type a 
value or you can show it what you want by picking two points.

9. After you finish drawing segments, press Enter to leave the figure open or 
type C and press Enter to close it back to the start.

AutoCAD draws the final segment and miters all the corners perfectly.

After you create a polyline, you can adjust its segments by grip-editing any of the 
vertex points. See Chapter 11 for details on grip editing.

ALTERNATIVES TO THE LINE  
AND PLINE COMMANDS
The Line and PLine commands work well for drawing a series of end-to-end single lines, 
but you may want to draw a series of double lines to represent, for example, the edges 
of a wall or roadway. Here are some options:

• Use the AutoCAD MLine command to draw a multiline, which is a series of two or 
more parallel straight lines. The AutoCAD Multiline feature was full of limitations 
when it debuted way back in 1994 (in the notorious Release 13), and despite minor 
tweaks in AutoCAD 2006, it hasn’t improved significantly since then. It exists mostly 
for compatibility with MicroStation files. Look up the MLine and MLStyle commands 
in the AutoCAD online help system if you want to tangle with this feature, but be 
prepared to spend time experimenting, struggling, and (possibly) cursing. Don’t let 
small children hear you.

• Use the PLine command to draw a single set of connected line or arc segments or 
both, and then use the OFFset command (described in Chapter 11) to create one or 
more sets of parallel segments.

• In AutoCAD LT only, use the DLine, or Double Line, command to draw pairs of 
 parallel line or arc segments or both. AutoCAD LT doesn’t have the MLine command, 
which, given the problems of using the MLine command, is more of a blessing than 
a limitation. AutoCAD, on the other hand, doesn’t have the DLine command. (Score 
one for the little brother!)
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In the following steps, I spice things up by adding an arc segment to a polyline.

Curved segments in polylines are circular arcs that you can draw using the AutoCAD 
Arc command. AutoCAD can draw other kinds of curves, including ellipses and 
splines, but not within the PLine command.

To draw a polyline that includes curved segments, follow these steps:

1. Repeat Steps 1–4 in the preceding step list.

2. To add one or more arc segments, type A and then press Enter to select 
the Arc option.

The prompt changes to show arc segment options. Most of these options 
correspond to the many ways of drawing circular arcs in AutoCAD; see the 
section on arcs in Chapter 7. The command line shows

Specify endpoint of arc or [Angle/CEnter/CLose/Direction/
Halfwidth/Line/Radius/Second pt/Undo/Width]:

3. Specify the endpoint of the arc by clicking a point or typing coordinates.

AutoCAD draws the curved segment of the polyline. The prompts continue to 
show arc segment options.

Specify endpoint of arc or [Angle/CEnter/CLose/Direction/
Halfwidth/Line/Radius/Second pt/Undo/Width]:

The options at this point are to

• Specify additional points to draw more arc segments.

• Choose another arc-drawing method, such as CEnter or Second point.

• Return to drawing straight-line segments with the Line option.

In this example, you draw straight-line segments.

Perhaps the most useful of the alternative arc-drawing methods is Second pt. 
It gives you more control over the direction of the arc but at the cost of losing 
tangency of adjacent segments. (Sometimes, it’s best not to go off on a 
tangent, anyway.) If you want both ends of the arc segments to be tangent to 
the adjacent line segments, you should generally draw the polyline as straight-
line segments and then use the Fillet command (described in Chapter 11) to 
add the arcs later.
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4. Type L and then press Enter to select the Line option.

The prompt reverts to showing straight-line segment options.

Specify next point or [Arc/Close/Halfwidth/Length/Undo/
Width]:

5. Specify additional points by clicking or typing.

6. After you’re finished drawing segments, either press Enter or type C 
and press Enter.

Figure 6-3 shows some elements you can draw with the PLine command by using 
straight segments, arc segments, varying-width segments, or a combination of 
all of them.

Squaring Off with Rectangles
You can use the PLine or Line command to draw a rectangle, segment by segment. 
In most cases, though, you’ll find that using the special-purpose RECtang com-
mand is easier. The following steps show you how:

1. Click the Rectangle button on the Draw panel of the Home tab, or type 
REC and press Enter.

Can’t find a command? Some commands may be hidden in slideout panels in 
the Ribbon interface. Many Ribbon panels display a down-facing arrowhead 
beside the name of the panel. Click the arrowhead to see a collection of related 
but less-used commands. Still can’t find the command? Some Ribbon com-
mand buttons may be hidden under others in the same category. AutoCAD 
remembers the last one you used. For example, you may find POLygon under 
RECtangle or vice versa.

FIGURE 6-3: 
A plethora of 

polylines.
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AutoCAD starts the RECtang command and prompts you to specify a point for 
one corner of the rectangle. The command line displays the prompt:

Specify first corner point or [Chamfer/Elevation/Fillet/
Thickness/Width]:

You can add fancy effects by using additional command options. The default 
options work best for most purposes. Look up RECTANG in the AutoCAD help 
system if you want to know more about the options.

2. Specify the first corner by clicking a point or typing coordinates.

AutoCAD prompts you to specify the corner of the rectangle that’s diagonally 
opposite from the first one.

Specify other corner point or [Area/Dimensions/Rotation]:

3. Specify the other corner by clicking a point or typing coordinates.

The rectangle is drawn after you specify the second corner point.

If you know the size of the rectangle that you want to draw (for example, 
100 units long x 75 units high), type D to enter the Dimensions option, and 
then simply type the width and height. Pick a point to indicate which of the 
four possible alignments you want, and AutoCAD draws the rectangle.

Choosing Sides with POLygon
Rectangles and other closed polylines are types of polygons, or closed figures with 
three or more sides. The AutoCAD POLygon command provides a quick way of 
drawing regular polygons wherein all sides and angles are equal. The command 
has nothing to do with missing parrots.

The following steps show you how to use the POLygon command:

1. Click Polygon from the Rectangle drop-down list on the Draw panel of the 
Home tab, or type POL and press Enter.

AutoCAD starts the POLygon command and prompts you to enter the number 
of sides for the polygon.

Enter number of sides <4>:

2. Type the number of sides for the polygon that you want to draw and then 
press Enter.

Your polygon can have from 3 to 1,024 sides.
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AutoCAD prompts you to specify the center point of the polygon:

Specify center of polygon or [Edge]:

You can use the Edge option to draw a polygon by specifying the length of one 
side instead of the center and then the radius of an imaginary inscribed or 
circumscribed circle. The imaginary circle method is much more common.

3. Specify the center point by clicking a point or typing coordinates.

After you specify the center point, nothing happens in the graphics area but 
the command line prompts you to specify whether the polygon is inscribed in 
an imaginary circle whose radius you specify in Step 5 (the corners touch the 
circumference of the circle) or circumscribed about the circle (the sides are 
tangent to the circle).

Enter an option [Inscribed in circle/Circumscribed about 
circle] <I>:

4. Type I (for inscribed) or C (for circumscribed), and press Enter.

The command line prompts you to specify the radius of an imaginary circle:

Specify radius of circle:

5. Specify the radius by typing a distance or clicking a point.

AutoCAD draws the polygon.

If you type a distance or you click a point with Ortho Mode turned on, the 
polygon will align orthogonally. I cover using Ortho Mode in Chapter 8.

Rectangles and polygons aren’t special object types. They’re simply regular poly-
lines that have been constructed by special command macros.

Figure 6-4 shows the results of drawing plenty of polygons — a practice known 
as polygony, which, as far as I know, is legal nearly everywhere.

FIGURE 6-4: 
A party of 
polygonal 

parts.
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IN THIS CHAPTER

Rounding the curves with circles, 
arcs, splines, and clouds

Employing eccentric ellipses

Dunking for donuts

Making your points

Dangerous Curves 
Ahead

Although straight-line segments predominate in many CAD drawings, even 
the most humdrum, rectilinear design is likely to have a few curves. And 
if you’re drawing Audi car bodies or Gaudí buildings, those drawings will 

contain a lot of curves! In this chapter, I cover the AutoCAD curve-drawing com-
mands. Your drawings should also have a point; in fact, they may have several 
points, so at the end of this chapter, I fill you in on creating point objects in 
AutoCAD.

(Throwing) Curves
Curves are used to represent many different types of features in a drawing. A circle 
is used to show a hole in a steel beam, but can also be used for a bicycle tire. After 
circles, the next most commonly used curve objects are arcs. Arcs can be found in 
drawings where two pieces of steel meet to show fillets or even in curved lips on 
countertops. The design of the ark probably included arcs. Other curve types that 
you can create are filled circles, ellipses, and splines.

Chapter 7
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AutoCAD supports the following curve commands, all of which can be found on 
the Draw panel of the Home tab:

 » Circle: Draws circles. (You were expecting hyperbolic paraboloids?)

 » Arc: Draws circular arcs with center points and fixed radii, not arcs cut from 
ellipses, parabolas, or another complex curve 

 » ELipse: Draws ellipses and elliptical arcs.

 » SPLine: Draws smoothly flowing curves of a variety of shapes.

 » DOnut: Draws filled-in rings and circles (but not the jelly, unfortunately).

 » REVCLOUD: Draws freeform clouds, the most common application of which is 
to indicate revised areas in the drawing.

Can’t find a command? Some commands may be hidden in slideout panels in the 
Ribbon interface. Many Ribbon panels display a down-facing arrowhead beside 
the name of the panel. Click the arrowhead to see a collection of related but less-
used commands. Still can’t find the command? Some Ribbon command buttons 
may be hidden under others in the same category. AutoCAD remembers the last 
one you used. For example, you may find any one of the eleven Arc options on top 
of the heap.

Going Full Circle
AutoCAD offers several ways to define circles. In the following list, the infor-
mation in parentheses indicates which characters to type at the command line 
to initiate an option after you start the Circle command. On the other hand, the 
drop-down list below the Circle button in the Draw panel on the Home tab of the 
Ribbon starts the Circle command and then feeds it the appropriate option. Center 
point/radius and center point/diameter are likely to cover most of your needs.

You can define circles in AutoCAD using these options:

 » Radius: This setting is the default. Simply pick the center point, and then spec-
ify a radius by either typing a value or dragging the circle to the size you want.

 » Diameter (D): Pick the center point and then define the diameter. Even 
though Radius is the default setting, the vast majority of circles you draw are 
defined by diameter.
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 » 2-Point (2P): Choose this option to draw a circle where the distance between 
two specified points is equal to the diameter of the circle. If you’re using the 
command line, enter 2P to choose this option; it’s spelled out as 2-Point on 
tooltips.

 » 3-Point (3P): Choose this option to draw a circle through any three specified 
points.

 » Tangent-Tangent-Radius (Ttr): To draw a circle tangent to two existing 
 drawing objects and a specified radius, pick this option.

 » Tangent-Tangent-Tangent: This option lets you draw a circle tangent to 
three valid existing drawing objects. By valid, I mean that it’s mathematically 
possible to construct a circle tangent to the three selected objects.

Note that you can’t create a T-T-T circle by typing a command option at the 
command line, because no such command option even exists. This method is 
a menu macro — the only way to run it is to choose Tan, Tan, Tan from the 
Circle button’s drop-down list in the Draw panel on the Home tab.

AutoCAD can draw circles tangent to lines, arcs, polylines, or other circles. You can 
mix and match, so a Ttr circle can be tangent to a line and to an arc.

Figure  7-1 illustrates these six ways to draw circles. Whether these additional 
methods are useful depends on the kinds of drawings you make and how geometry 
is defined in your industry. Become familiar with the default center point/radius 
method, and then experiment with other methods. Or you can always draw circles 
using the default method and move them into position using object snaps by ref-
erencing points on other geometry.

FIGURE 7-1:  
Pi R squared: 

Circles R 
round; pizzas 

are flat and 
round.
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Watch the command line. Pressing Enter repeats the last command; it doesn’t 
repeat the options of the last command. If you draw a circle by using the Ttr option, 
for example, pressing Enter doesn’t repeat that method; instead, it repeats the 
Circle command in its default radius mode.

Arc-y-ology
An arc is simply a piece of a circle. On the other hand, if you want a boat full of 
animals, you can use AutoCAD to design an ark.

AutoCAD offers you an easy way to define arcs. Just start the Arc command, and 
then specify three points onscreen to define the arc: where to start the arc, how 
much to curve it, and where to end it. Easy, right?

The trouble is that you nearly always need to specify arcs more precisely than is 
possible by using this method. AutoCAD helps you specify such arcs by allowing a 
total of 12 generous option combinations.

To experiment with all the available options, start the Arc command, and specify a 
start point or choose the Center option. AutoCAD prompts you first for the center 
point and then for the start point. AutoCAD normally draws arcs in a counterclock-
wise direction, so pick a start point in a clockwise direction from the endpoint.

On the other hand, after you pick the first point, AutoCAD offers two more options: 
the included angle and the chord length (the straight-line distance) from the start 
point to the end point.

To get a feel for how these permutations can be strung together to create differ-
ent arc-drawing methods, click the down arrow below the Arc button on the Draw 
panel of the Ribbon to unfurl the drop-down menu, as shown in Figure 7-2. Using 
the Ribbon is also the most direct way to use these options, at least until you’re 
truly familiar with the program and you’re adept at entering keyboard shortcuts.

The Arc command draws counterclockwise from the start point. Over the years, so 
many people (novice and expert alike) have been confused by "arcs go counter-
clockwise” that AutoCAD 2014 introduced this new option: If you press and hold 
down the Ctrl key while selecting the end point, AutoCAD draws the arc in a clock-
wise direction. A bit of experimenting and cursing will show you what I mean.
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As usual, whenever AutoCAD asks for the first point, you can simply press Enter to 
automatically select the last point you specified, even if it’s from a different com-
mand. Arc has an added twist, however: If the previous point was at the end of a 
line, a polyline, or another arc, the new arc automatically starts from that point 
and is tangent to the previous object.

The converse is also true. Draw an Arc and start the Line command. When the 
command line asks for a starting point, press Enter to make the new line tangent 
to the end of the arc.

You probably don’t need to use the Arc command often. The Fillet, TRim, and 
BReak commands (discussed in Chapter 11) cover the vast majority of arc-creation 
needs.

Solar Ellipses
In case you’ve forgotten your ninth grade math, an ellipse is sort of a squished 
circle although it may be more accurate to say that a circle is an unsquished 
ellipse. Please excuse the technical jargon. Mathematically, an ellipse is defined 
by a major (long) axis and a minor (short) axis. These axes determine the ellipse’s 
length, width, and degree of curvature. An elliptical arc is an arc cut from an ellipse.

The AutoCAD ELlipse command provides a straightforward way to draw an ellipse: 
You specify the two endpoints of one of its axes and then specify an endpoint 

FIGURE 7-2:  
A deluge of 

Arc options, 
and the results 
of using some 

of them.
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on the other axis. Like the Arc command, however, the ELlipse command offers 
 several other options:

 » Arc: Generates an elliptical arc, not a full ellipse. You define an elliptical arc 
just as you define a full ellipse. The methods I discuss in this section for creat-
ing an ellipse apply to either one.

 » Center: Requires that you define the center of the ellipse and then the 
endpoint of an axis. You can then either enter the length of the other axis or 
specify that a rotation around the major axis defines the ellipse. If you choose 
the latter option, you can enter (or drag the ellipse to) a specific rotation angle 
for the second axis that, in turn, completely defines the ellipse.

 » Rotation: Specifies an angle that defines the curvature of the ellipse — small 
angles create wide ellipses (0 degrees creates a circle, in fact), and large angles 
make thin ellipses. After dinner, when your plate is empty, hold it vertically to 
look at it straight on. It looks like a circle. Slowly rotate the plate about its verti-
cal axis until you’re looking at it edge-on. Between these two views, you will 
see every possible ellipse as defined by the rotation angle — and your dinner 
guests will begin to wonder about you.

The following command line example creates an ellipse by using the default end-
points of the axes method. Enter ELlipse and press Enter or click the Ellipse but-
ton on the Ribbon:

Specify axis endpoint of ellipse or [Arc/Center]: Pick or type 
the first endpoint of one axis.

Specify other endpoint of axis: Pick or type the other endpoint 
of one axis.

Specify distance to other axis or [Rotation]: Pick or type the 
endpoint of the other axis.

Figure 7-3 shows an ellipse and an elliptical arc.

You can create elliptical arcs (as 
opposed to the circular arcs that the 
Arc command draws) by using the 
Arc option of the ELlipse command; it 
can draw a respectable representation 
of a snowball trajectory, neglecting 
air resistance. Alternatively, you can 
draw a full ellipse and use the TRim 
and BReak commands, discussed in  
Chapter 11, to cut a piece from it.

FIGURE 7-3: 
To make an omelet, sometimes you have to 
break a few ellipses.
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Splines: Sketchy, Sinuous Curves
Most people use CAD programs for precision drawing tasks: straight lines, care-
fully defined curves, and precisely specified points, for example. You may believe 
that AutoCAD is not the appropriate program to free your inner artist (unless your 
inner artist is Mondrian) — nonetheless, even meticulously created CAD draw-
ings sometimes need free-form curves. In fact, the advent of processes such as 
computer numerical control (CNC) machining and 3D printing mean that many 
consumer goods and even quite a few industrial products are taking on smoother 
free-form shapes. The AutoCAD spline object is just the tool for the job.

You can use AutoCAD splines in one of two ways:

 » Wing it. Eyeball the location and shape of the curve, and don’t worry about 
making it just so. That’s the free-form, sketchy, less-than-precise approach 
described in this section.

 » Be precise. Specify the control points and curvature characteristics precisely.

Beneath the easygoing, informal exterior of the AutoCAD spline lies the truly 
highly precise, mathematically defined entity known as the Non-Uniform Ratio-
nal B-Spline curve — the NURBS curve – wherein a B-Spline is a generalization 
of the Bézier curve. You can always go to http://mathworld.wolfram.com/ 
B-Spline.html to learn far too much about B-splines. Mathematicians and 
mechanical and industrial designers often care deeply about the precise char-
acteristics of the curves they work with. For these people, the AutoCAD SPLine 
and SPLINEDIT commands include a number of advanced options. Look up spline 
curves in the AutoCAD online Help system if you need precision splines.

Drawing a spline is straightforward, if you ignore the advanced options. Follow 
these steps to draw a free-form curve by using the SPLine command:

1. Start a new drawing.

2. Click the Spline Fit button on the Draw panel slideout of the Home tab, or 
type SPL and press Enter.

AutoCAD starts the SPLine command and prompts you to specify the start 
point of the spline. The command line shows

Current settings: Method=Fit Knots=Chord
Specify first point or [Method/Knots/Object]:

http://mathworld.wolfram.com/B-Spline.html
http://mathworld.wolfram.com/B-Spline.html
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3. Specify the start point by clicking a point or typing coordinates.

AutoCAD prompts you to specify additional points:

Enter next point or [start Tangency/toLerance]:

4. Specify additional points by clicking or typing coordinates.

After you pick the second point, press the down-arrow key to display additional 
options at the Dynamic Input tooltip. You can turn on Dynamic Input from the 
status bar or by pressing the F12 key. The command line displays

Enter next point or [end Tangency/toLerance/Undo/Close]:

Because you’re drawing a free-form curve, you usually don’t need to use object 
snaps or other precision techniques to pick spline points, except perhaps at 
the start and end of the spline. I discuss precision techniques in Chapter 8.

5. Press Enter after you choose the endpoint of the spline.

AutoCAD draws the spline.

You can specify the start and end tangency of the spline to control the curvature of 
the start points and endpoints of the spline. If all you want is a swoopy, free-form 
curve, picking only points works well.

Figure 7-4 shows examples of splines.

After you draw a spline, you can grip-edit it to adjust its shape. (See Chapter 11 for 
information about grip-editing.) If you need finer control over spline editing, look 
up the SPLine Edit command in the AutoCAD online help system.

FIGURE 7-4:  
A slew of 

splines.
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The Polyline Edit (PEdit) command can convert a straight-line-segmented poly-
line into a spline curve form. I cover polylines in Chapter 6, and I touch on PEdit 
in Chapter 11.

Donuts: Circles with a Difference
Don’t tell Homer Simpson, but there’s no such thing as a donut in AutoCAD. A 
donut in AutoCAD is simply a closed polyline consisting of two 180-degree arc 
segments that you create with (what else?) the DOnut command. By the way, the 
rectangles and regular polygons described in Chapter 6 are also polyline objects. 
A common use for the DOnut command is drawing component-mounting pads on 
printed-circuit boards; a common use for donuts is as a snack during your coffee 
break.

When you start the DOnut command, AutoCAD prompts you for the inside diam-
eter and the outside diameter (the size of the hole and the size of the donut) as 
measured across their widest points. After you’ve entered these values, AutoCAD 
prompts you for the center point of the donut. But one donut is rarely enough, 
so AutoCAD continues prompting you for additional center points until you press 
Enter. It’s the AutoCAD equivalent of saying, “No, really — I’m full now.”

The following example draws a regulation-size donut, with a 1.5-inch hole and a 
3.5-inch outside diameter. Enter DOnut and press Enter or click the Donut button 
on the Ribbon. You’ll find this button on the slideout panel below the Draw panel 
of the Home tab of the Ribbon.

Specify inside diameter of donut <0.5000>: 1.5
Specify outside diameter of donut <1.0000>: 3.5
Specify center of donut or <exit>: Pick or type the center point 

of one or more donuts.

You can use the DOnut command to create a filled circle, also known as a jelly-
filled donut. (Seriously!) Simply specify an inside diameter of 0 (zero). Figure 7-5 
shows both kinds of donuts.

If you’re Canadian, the DOughnut command also works but TimHortons doesn’t 
(unless you use the ALIASEDIT command from Express Tools to create it as a new 
alias).
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Revision Clouds on the Horizon
In many industries, designers and drafters customarily submit a set of draw-
ings at different project milestones or stages of completion and then submit 
them again later with revisions, such as corrections, clarifications, and requested 
changes. Usually, the recipients of these drawings easily locate information that 
has changed, and a common drafting convention calls attention to revised items 
by drawing free-form clouds around them. The REVCLOUD command makes quick 
work of drawing these clouds.

Drawing revision clouds is easy, after you understand that you click only once in 
the drawing area. That single click defines the starting point of the cloud’s perim-
eter. Then you simply move the cursor around and the cloud takes shape. When 
you return to a spot near the point you first clicked, AutoCAD automatically closes 
the cloud.

The following command line example shows you how to draw a revision cloud. 
The REVCLOUD button is on the Markup panel of the Annotate tab. Or enter REV-
CLOUD and press Enter:

Minimum arc length: 0.5000   Maximum arc length: 0.5000    
      Style: Normal   Type: Freehand
Specify first point or  
      [Arclength/Object/Rectangular/Polygonal/  
      Freehand/Style/Modify] <Object>:
If the Type is indicated as anything other than Freehand,  
      type F and press Enter.
Pick a point along the perimeter of your future cloud.
Guide crosshairs along cloud path... Sweep the crosshairs  
      around to define the cloud’s perimeter.

FIGURE 7-5:  
Donuts, plain 

and jelly-filled.
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Don’t click again. Simply move the crosshairs around without clicking. AutoCAD 
draws the next arc segment of the cloud when the crosshairs reach the minimum 
arc length distance from the end of the previous arc segment.

Continue moving the crosshairs around until you return close to the point where 
you first clicked. AutoCAD will automatically draw one last arc to close the loop.

AutoCAD 2016 added three Type options to revision clouds:

 » Object: Pick an existing rectangle, polyline, circle, line, or arc, and it turns into a 
revision cloud.

 » Rectangular: Pick two points, and AutoCAD draws a rectangular revision cloud.

 » Polygonal: Pick a series of points, and AutoCAD connects them with straight-
line wavy sections.

If the revision cloud’s arcs are too small or too large, erase the cloud, restart 
the REVCLOUD command, and use the command’s Arc Length option to change 
the minimum and maximum arc lengths. The default minimum and maximum 
lengths are 0.5 (or 15 in metric drawings). If you make the minimum and maxi-
mum lengths equal (the default setting), the lobes are approximately equal. If you 
make them unequal, the lobe size will vary more, and you’ll create fluffier clouds. 
Finally, if you change the Style to Calligraphy, each arc section will taper down its 
length. Fortunately, these options are more than most non-meteorologists need.

Figure 7-6 shows various revision cloud types and styles.

FIGURE 7-6: 
 Today’s 

 forecast: 
 Revision 

cloudy.
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Here are a few tips for using revision clouds:

 » Create a cloud layer. Place a revision cloud on its own layer (as described in 
Chapter 9) so that you can choose to plot with or without the clouds visible. In 
the days of paper and pencils, revision clouds were sketched on the back of 
the drafting vellum so that they could easily be erased.

 » Turn off Ortho mode. To more easily control the shape of a revision cloud, 
turn off Ortho mode before you start the command.

 » Include the revision number. Common practice is to delete revision clouds 
with each new release of a drawing, but your company’s policy may be to 
leave them on, tagged with the revision number. A good way to handle this 
requirement is to use a new revision cloud layer for each new release.

Scoring Points
I considered skipping a description of points in this book, but I didn’t want you to 
complain that AutoCAD For Dummies was pointless.

The word point describes two different elements in AutoCAD:

 » A location in the drawing that you specify (by typing coordinates or clicking 
with the mouse)

 » An object that you draw by using the POint command

Throughout this chapter, and most of this book, whenever we tell you to specify 
points, we’re usually referring to the location. This section tells you how to draw 
POint objects.

A POint object in AutoCAD can serve one of two purposes:

 » Identify a specific location in a drawing to other people viewing the 
drawing: A point can be displayed onscreen, as either a tiny dot or another 
symbol, such as a cross enclosed in a circle.

 » Serve as a precise object snap location: Think of it as a construction point. 
For example, when you’re laying out a new building design, you might draw 
point objects at several engineering survey points and then snap to those 
points as you sketch the building’s shape with the PLine command. You use 
Node Object Snap mode to snap to AutoCAD point objects. I discuss Snap 
modes in Chapter 11.
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The factor that complicates AutoCAD 
point objects is their almost limitless 
range of display options, provided to 
accommodate these two purposes and 
possibly some others that we haven’t 
figured out yet. You use the Point Style 
dialog box, shown in Figure  7-7, to 
specify how points should look in the 
current drawing.

To open the Point Style dialog box, 
open the Utilities panel slideout on the 
Home tab, or type its command name, 
DDPTYPE, which has to be one of the 
least intuitive command names in all of 
AutoCAD. The upper half of the dialog 
box shows the available point display 
styles. Most of the choices do much the 
same thing — just select one.

Avoid the first two choices if you want 
point objects to show up onscreen and 
on plots. The first choice, a single-pixel dot, is hard to see onscreen, and the sec-
ond choice, which is invisible (a stealth point?), is impossible to see. The single-
pixel dot, which is the default display style, works well if you use point objects as 
object snap locations and want to omit obtrusive points on plots.

The remaining settings in the Point Style dialog box control the size at which 
points appear onscreen at different zoom magnifications. The default settings 
often work well, but if you’re not satisfied with them, click the Help button in the 
dialog box to find out how to change them.

After you specify the point style, placing POints onscreen is easy. Simply type 
POint at the command line and press Enter to see this prompt:

Current point modes: PDMODE=0 PDSIZE=0.0000
Specify a point: Pick or type the coordinates of a location in 
the drawing.

The PDMODE and PDSIZE items listed in the command line are system variables 
that correspond to the point display mode and display size options in the Point 
Style dialog box. If you want to know exactly how the system variables correspond 
to the dialog box choices, you have all the makings of a successful CAD nerd. 
Click the Help button in the Point Style dialog box to find out more about system 
 variables — not about yourself.

FIGURE 7-7: 
You use the Point Style dialog box to control 
how point objects appear onscreen.
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IN THIS CHAPTER

Typing coordinates at the keyboard

Getting to know the AutoCAD 
coordinate systems

Snapping to object features

Using other precision drawing and 
editing techniques

Preciseliness Is Next 
to CADliness

Drawing precision is vital to good CAD drafting practice, even more than 
for manual drafting. Accuracy, of course, is vital to both types of draft-
ing. If you’re sketchy on the difference between accuracy and precision, 

look ahead to the “CAD precision versus accuracy” sidebar in this chapter. If you 
think CAD managers become tense when you assign properties directly to objects 
instead of ByLayer (see Chapter 9), wait until someone — I sincerely hope it’s not 
you — fails to use precision techniques when creating drawings in AutoCAD.

You must draw with precision, at least until you see Chapter 19. Now there’s a 
teaser for you. Typically, the only point you select at random in a drawing is the 
first one. Then virtually all line starts and lengths or ends, and all circle and arc 
centers and radii or diameters, for example, should be specified using exact key-
board input or a suitable object snap.

Chapter 8
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Controlling Precision
In AutoCAD, a lack of precision makes editing, hatching, and dimensioning tasks 
much more difficult and time consuming. Keep these facts in mind:

 » Small errors in precision in the early stages of creating or editing a drawing 
often significantly affect productivity and precision later.

 » CAD drawings are often used for much more than giving pictures to someone. 
If the drawings have been properly created, they can also be queried for fac-
tors such as size, area, and quantity.

 » Drawings may guide manufacturing and construction projects; drawing data 
may drive automatic manufacturing machinery. Huge amounts of money, and 
even lives, can ride on a drawing’s precision.

In recognition of these facts, a passion for precision permeates the profession. 
Precision is one characteristic that separates CAD from ordinary illustration-type 
drawing work. The sooner you get fussy about precision in AutoCAD, the happier 
everyone is.

When I talk about drawing elements precisely, I mean using precision techniques 
and tools to specify points and distances with as much exactness as the pro-
gram allows. Luckily, AutoCAD provides a comprehensive package of tools for this 
task. Table 8-1 lists the more important AutoCAD precision techniques, along with 
visual cues to the status bar buttons you click to toggle certain features. Note that 
this list omits status bar buttons that don’t directly affect drawing precisely.

You can switch many of the buttons — and hence their functionality — on and 
off by using the F keys. Table 8-1 lists the icons and F keys, where appropriate, 
for each button.

Precision is especially important when you’re drawing or editing geometry — the 
lines, arcs, and other elements that make up whatever you’re representing in the 
CAD drawing. Precision placement usually is less important with notes, leaders, 
and other annotations that describe, not show.

To use object snap tools, follow these steps:

1. Make sure all status bar buttons are turned off.

They should have gray, not blue, icons.

2. Start the Line command.

3. Pick three points to draw two sides of a triangle.
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4. Draw the third side of the triangle.

Pick a point as close as you can to the start of the first line (that is, the first 
point you picked). Don’t use the Close option.

5. Press Enter to complete the command.

Pressing the spacebar is usually faster than pressing Enter.

6. Right-click the Object Snap button and choose Settings.

7. Deselect all items except for Endpoint and Object Snap On. Click OK.

With these two settings, you’re turning on object snap functionality and one of 
the object snap modes (Endpoint).

TABLE 8-1 Precision Tools and Techniques

Technique F Key Status Bar 
Button What It Does

Infer constraints — Applies geometric constraints at specific pick points (not 
in AutoCAD LT), as covered in Chapter 19

Snap mode F9 Forces the cursor to move on an imaginary grid of 
equally spaced hot spots

PolarSnap — Forces the cursor to move specific distances along polar 
tracking angles

Grid display F7 Displays a nonprinting reference grid of lines or dots 
arranged in rows or columns

Ortho mode F8 Forces the cursor to move horizontally or vertically from 
the previous point

Polar tracking F10 Causes the cursor to jump to specified angles

Object snap F3 Lets you pick specific points on existing drawing objects 
without having to initiate a specific snap mode every time

3D Object snap F4 Lets you pick specific points on existing 3D objects 
multiple times (not in AutoCAD LT)

Object snap tracking F11 Causes the cursor to locate new points based on one 
object snap point (or more)

Object snap overrides — — Lets you pick specific points on existing drawing objects 
one time only

Coordinate input — — Lets you type exact X,Y or polar coordinates

Direct distance entry — — Lets you locate a point by moving the cursor to show the 
direction and then typing a distance
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8. Start the Line command again.

9. Hover the cursor over the first line so that a green square box lights up at 
the end of the line closest to its starting point. Pick the line at this point.

10. Repeat Step 9 for the ending point of the third line and then press Enter.

The second green square box may look like it’s in the exact location as the first, 
but it probably isn’t.

11. Enter Zoom Object Last and press Enter.

AutoCAD zooms in to display a tiny line segment — the last line you drew. The 
triangle now consists of four lines. The last line may be quite small, but it is a 
fourth line nonetheless.

12. Enter Zoom Previous.

13. Repeat Steps 8–10, but select two lines that form one of the other two verti-
ces of the triangle.

Press F2 to expand the command line, where AutoCAD reports that it created a 
“zero-length line”. Obviously, the two lines now touch perfectly because 
the last one snapped like a magnetic attraction to the endpoint of the first line. 
Okay, it was the start point, but we’re sure that you . . . get the point.

CAD PRECISION VERSUS ACCURACY
You often hear the words precision and accuracy used interchangeably, but it’s useful to 
understand the difference. In this book, precision refers to controlling the placement of 
objects so that they lie exactly where you want them to lie in the drawing. For example, 
lines whose endpoints meet must meet exactly, and a circle that’s supposed to be cen-
tered on the coordinates 0,0 must be drawn with its center exactly at 0,0. Accuracy refers 
to the degree to which your drawing matches its real-world counterpart. An accurate 
floor plan is one in which the dimensions of the CAD objects equal the dimensions of 
the as-built house. In a sense, then, it isn’t the drawing that should be accurate — it’s the 
house! Another example is NASA Mars lander that crashed because of a mix-up in impe-
rial versus metric units. Values may have been very precise, but they weren’t accurate.

CAD precision usually, but not always, helps produce accurate drawings. You can pro-
duce a precise CAD drawing that’s inaccurate because you started from inaccurate 
information. For example, the contractor gave you incorrect field measurements. Don’t 
sacrifice accuracy if you want to exaggerate certain distances to convey the relationship 
between objects more clearly on the plotted drawing. In AutoCAD, you can quite easily 
show a detail view at a different scale.
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If you were able to make the first and third lines touch at the limit of AutoCAD’s 
16-place accuracy, you should throw away this book and buy every lottery 
ticket you can find.

If you had tried to use the original three lines to control a computer numerically 
controlled (CNC) milling machine, you would have had problems at the final apex. 
You need to draw the triangle using the Close option of the Line command or the 
endpoint object snap.

Before you draw objects, always check the status bar buttons and set them accord-
ing to your need for precision.

 » ON: The button icon is bright blue.

 » OFF: The button icon is light gray.

Understanding the AutoCAD 
Coordinate Systems

Every point in an AutoCAD drawing file can be identified by its X,Y,Z coordinates. 
In most 2D drawings, the Z-coordinate value is 0.0 This system of coordinates is 
referred to in AutoCAD as the world coordinate system, or WCS.

Keyboard capers: coordinate input
The most direct way to enter points precisely is to type numbers with the key-
board. AutoCAD uses these keyboard coordinate entry formats:

 » Absolute Cartesian (X,Y) coordinates in the form X,Y (for example, 7,4): 
This format is the default for input at the command line.

 » Relative X,Y coordinates in the form @X,Y (for example, @3,2): Defines a 
new point that is X units horizontally (3, in the example) and Y units vertically 
(2, in the example) away from the current point.

Dynamic Input mode works with relative coordinates even though the @ 
prefix isn’t used.
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 » Relative polar coordinates in the form @distance<angle (for example, 
@6<45): Defines a new point that is the specified distance (6, in the example) 
units away from the current point at the specified angle (45 degrees, in the 
example) from the origin.

If you want to use absolute coordinates while using Dynamic Input mode, use 
the # (pound) sign prefix.

AutoCAD nearly always measures angles counterclockwise from the positive 
X-axis (east), except for surveyors. You know who you are, and you know how 
your angles work!

Introducing user coordinate systems
Many times, you can conveniently define an additional coordinate system (or “roll 
your own”) to more easily create drawings. This non–world coordinate system is 
known as a user coordinate system.

Why would you want to diverge from the standard WCS? Well, the most com-
mon reason is that it’s much easier to calculate and enter coordinates if they’re 
based on the plane you want to work on in 3D. Suppose that you’re modeling an 
old-fashioned, wedge-shaped rubber doorstop and you want to add the manu-
facturer’s logo to the sloping surface of the wedge. It isn’t easy if you stay in the 
WCS, but AutoCAD lets you set a new UCS based on that sloping surface. After the 
UCS is made current, you draw in it just as you draw in the WCS. I have more to 
say about UCSs in 3D in Chapter 21.

Think of the real world. A specific latitude and longitude (WCS) always identifies 
the same point, but the actual location for a description, such as “the corner of 
33rd and Main,” depends on which city you’re in (UCS).

Although originally intended for 3D work, a UCS can be useful in two dimensions 
as well. The WCS assumes that the north direction is straight up (90 degrees, 
according to the AutoCAD default settings), but you may be working on a building 
layout where one wing is at a 37.8 degree angle to the other. No problem: Sim-
ply create a UCS that’s aligned appropriately. You can look up this process in the 
online help system (this book has only so many pages, after all), but here’s a quick 
hint: Click the UCS icon in the lower-left corner of the screen to make grips appear 
at the origin and the ends of the axis indicators. Then drag the icon by its grips to 
set a new UCS. I cover this feature more fully in Chapter 21.

Creating a UCS by typing options at the command line is generally easier than 
using the UCS Manager dialog box, but after they’re created, they’re easier to 
manage from the UCS dialog box. Type UCSMAN and press Enter to display it.
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Drawing by numbers
AutoCAD locates absolute X,Y coordinates with respect to the 0,0 point (otherwise 
known as the origin) of the drawing — usually, its lower-left corner. AutoCAD locates 
relative X,Y coordinates and relative polar coordinates with respect to the previous 
point you picked or typed. Figure 8-1 demonstrates how to use all three coordinate 
formats to draw a pair of line segments that start at the absolute coordinates 2,1, 
and then move to the right 2 units and up 1 unit (@2,1) relative to the first point, and 
then (relative to that point) move 2 units at an angle of 60 degrees (@2<60). Note 
in particular how the first two coordinate pairs use the same numbers (2,1) but the 
second pair defines a different point because of the leading @ symbol.

You can find out the X,Y location of the cursor by moving it around in the draw-
ing area and reading the coordinate values in the status bar. The X,Y coordinates 
should change as you move the cursor. If the coordinates don’t change, click the 
drawing coordinates area until you see <Coords on> in the command line.

If you’re using the full version of AutoCAD, you may have noticed that three num-
bers are at the left end of the status bar. AutoCAD LT is numerically challenged and 
only has two. AutoCAD is showing you the X,Y coordinates of the cursor and the 
current elevation (the Z value). However, in 2D drafting, the Z value is or should be 
0 (zero), so you can continue calling them X,Y coordinates.

Although it isn’t apparent at first, AutoCAD has, in fact, four coordinate display 
modes. Clicking the coordinates readout cycles through these modes:

 » Off (<Coords off>): The status bar coordinate readout is dimmed, and the 
coordinate values don’t update until you pick a point.

Relative X,Y
coordinates

Relative polar
coordinates

Absolute X,Y
coordinates

FIGURE 8-1:  
Coordinat-

ing from the 
keyboard.
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 » On, showing X,Y coordinates (<Coords on>): The coordinate readout is 
bright and the absolute X,Y coordinates update continuously as you move the 
cursor. If no command is active, clicking the coordinates readout alternates 
between this mode and <Coords off>.

 » On, showing polar coordinates (<Coords on>): This mode, which displays 
distance and angle relative to the last point picked rather than absolute X,Y 
values, appears only if a command is active and AutoCAD is waiting for you to 
pick a point.

 » On, showing geographic coordinates (<Coords on>): This mode dis-
plays coordinates as latitude and longitude values, but it can be used 
only after you set the drawing’s geographic location with the (what else?) 
GEOGRAPHICLOCATION command.

If you start a command such as Line, pick a point, and then click the Coordi-
nates area a few times, the display changes from coordinates Off to live absolute 
coordinates (X,Y position) to live polar coordinates (distance and angle from the 
previous point).

If you’re working in AutoCAD’s architectural or engineering units, the default unit 
of entry is inches, not feet. Here are some guidelines for entering numeric values 
when you work with feet and inches:

 » To specify feet, you must enter the apostrophe (‘) symbol for feet after 
the number:

6’ is 6 feet.

 » To separate feet from inches (as architects often do), enter a dash:

6’-6” is 6 feet, 6 inches.

 » When you enter coordinates and distances, both the dash and the inch 
mark are optional:

6’6” and 6’6 are the same as 6’-6”.

 » To type a coordinate or distance that contains fractional inches, you must 
enter a dash — not a space — between the whole number of inches and the 
fraction:

6’6-1/2 (or 6’-6-1/2) represents 6 feet, 6-1/2 inches.

 » To enter partial inches (if all this dashing about confuses you), use decimals 
instead:

6’6.5 is the same as 6’6-1/2” to AutoCAD, whether you’re working in architec-
tural or engineering units.
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To check the accuracy (or precision) of objects that are already drawn, the MEA-
suregeom command is a one-stop shop where you can query drawing objects for 
distances, angles, areas, and other geometric or locational information about 
drawing objects. You can find the command on the Utilities panel of the Home 
tab — look for an icon with a yellow ruler. The LIst command also tells you all you 
need to know about selected objects.

Grabbing an Object and Making It Snappy
After you’ve drawn a few objects precisely in a new drawing, the most efficient 
way to draw more objects with equal precision is to grab specific, geometrically 
precise points, such as endpoints, midpoints, or quadrants, on the existing objects. 
Every object type in AutoCAD has at least one of these points, and you can snap to 
them precisely as you draw by using object snaps (osnaps).

AutoCAD provides two ways to use an object snap:

 » Object snap override: Active for a single pick.

 » Running object snap: Remains in effect until you turn it off.

AutoCAD (but not AutoCAD LT) has a suite of object snaps specifically for working 
in 3D. Although I cover them fully in Chapter 21, I point them out here because the 
3D Object Snap status bar button sits next to the standard Object Snap button, and 
it isn’t easy to distinguish them. In this section, you use the regular Object Snap 
button — it shows the square with the little green spot in the upper-left corner, 
not the 3D-looking box with the little green spot in the upper-left corner.

Grabbing points with object snap overrides
Here’s how to draw precise lines by using object snap overrides:

1. Open a drawing containing some geometry, or start a new drawing and 
create some.

2. Turn off running object snap mode by clicking the Object Snap (F3) button 
on the status bar until the button appears to be dimmed and <Osnap 
off> appears in the command line.

Although you can use object snap overrides while running object snaps are 
enabled, I recommend that you turn off running object snaps while you’re 
becoming familiar with object snap overrides. After you get the hang of each 
feature separately, you can use them together.
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3. Start the Line command by clicking the Line button in the Draw panel on the 
Ribbon or by typing Line (or L) and pressing Enter.

AutoCAD prompts you to select the starting point of the line:

Specify first point:

4. Hold down the Shift key, right-click anywhere in the drawing area, and 
release the Shift key.

The Object Snap menu appears, as shown in Figure 8-2.

5. Choose an Object Snap mode, 
such as Endpoint, from the Object 
Snap menu.

The Object Snap menu disappears 
and the command line displays an 
additional prompt indicating that 
you’ve directed AutoCAD to seek 
out, for example, the endpoints of 
existing objects:

_endp of:

6. Move the cursor slowly around 
the drawing, pausing over vari-
ous lines and other objects. Don’t 
click yet.

When you move the cursor near an 
object with an endpoint, a colored 
square icon appears at the end-
point, indicating that AutoCAD can 
snap to that point. If you stop 
moving the cursor for a moment, a 
tooltip displaying the Object Snap 
mode (for example, Endpoint) 
appears, to reinforce the idea.

7. Click when the ENDpoint object 
snap square appears on the point 
you want to snap to.

AutoCAD snaps to the endpoint, 
which becomes the first point of the 
new line segment that you’re about 
to draw. The command line 
prompts you to select the other endpoint of the new line segment:

Specify next point or [Undo]:

FIGURE 8-2: 
The Object Snap right-click menu.
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When you move the cursor around the drawing, AutoCAD no longer seeks out 
endpoints, because object snap overrides last for only a single pick. You can 
use the Object Snap right-click menu again to snap the other end of the new 
line segment to another point on an existing object.

8. Display the Object Snap menu again (refer to Step 4). Then choose another 
Object Snap mode, such as MIDpoint, from the Object Snap menu.

The command line displays an additional prompt indicating that you directed 
AutoCAD to seek, for example, midpoints of existing objects:

_mid of:

When you move the cursor near the midpoint of an object, a colored triangle 
appears at the snap point, as shown in Figure 8-3. Each object snap type (such 
as ENDpoint, MIDpoint, and INTersection) displays a different symbol. If you 
stop moving the cursor, the tooltip text reminds you of what the symbol means.

9. Draw additional line segments by picking additional points. Use the Object 
Snap right-click menu to specify a single object snap type before you pick 
each point.

Try the INTersection, PERpendicular, and NEArest object snaps. If the drawing 
contains arcs or circles, try Center and Quadrant.

10. When you finish working with object snap overrides, right-click anywhere 
in the drawing area and choose Enter from the menu or press the space-
bar to end the Line command.

You can activate object snap overrides during a command by entering the first 
three letters of a mode at the command line whenever AutoCAD is asking you to 
select a point.

Object snapped to endpoint

New line segment About to object snap to midpoint

FIGURE 8-3:  
A snappy line.
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Snap goes the cursor
Table 8-2 explains the subtleties of the different object snap modes.

TABLE 8-2 Object Snap Modes
Mode What It Does

ENDpoint Snaps to the nearest end of an open drawing object, such as a line, an arc, a 
polyline segment, or an elliptical arc.

MIDpoint Snaps to the nearest midpoint of an open drawing object, such as a line, an arc, a 
polyline segment, or an elliptical arc.

CENter Snaps to the center of a circle, an arc, or an elliptical arc.

Geometric CEnter Snaps to the center of gravity of a closed polyline or a spline.

NODe Snaps to a point object, or to the definition point of a dimension, or to the insertion 
point of dimension text.

QUAdrant Snaps to the quadrant points (0, 90, 180, or 270 degrees) of a circle or an arc, or to 
the ends of the major or minor axis of an ellipse or an elliptical arc.

INTersection Snaps to the point where two drawing objects cross or meet.

EXTension Displays a temporary extension line when you pass the cursor over the end of an 
object so you can snap to a point along this temporary extension.

INSertion Snaps to the insertion point of text, mtext, or a block insertion.

PERpendicular Snaps to the point that forms a right angle between the start point and the object 
being selected. Perpendicular is not confined to the common image of a horizontal 
line with a vertical line attached at one end. Lines do not need to be horizontal 
and vertical nor do they even need to touch to be perpendicular. A line can also be 
perpendicular to a circle, an ellipse, or even to the sinuous curve of a spline.

TANgent Snaps to the tangent of an arc, a circle, an ellipse, an elliptical arc, a polyline arc, or 
a spline.

NEArest Snaps to the point on the selected object that is the shortest distance from the 
starting point.

APParent Intersection Snaps to the point where objects appear to intersect in the current view, even when 
they don’t actually intersect in 3D.

PARallel Creates a new line segment, polyline segment, ray, or xline that is parallel to an 
existing linear object. ORTHO mode must be turned off before using the PARallel 
object snap.

M2P Snaps to a point midway between two other points.
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Deferred object snaps are turned on automatically when the first point you pick 
doesn’t fully satisfy the current object snap. Following are two examples:

 » Deferred tangent: You would normally draw a line from a first point to a 
TANgent point on a circle. On the other hand, if you select the circle first and 
then select the second point, the line is drawn outwards from the circle to the 
point. This technique can be used to draw a line that is tangent to two non-
collinear circles.

 » Deferred perpendicular: You normally draw a line from a first point to a 
PERpendicular point on a circle. On the other hand, if you select the circle first 
and then select the second point, the line is drawn outwards from the circle to 
the point. This technique can be used to draw a line that is perpendicular to 
two non-collinear circles.

Right-clicking and Shift+right-clicking do different things in the drawing area:

 » Right-click: Displays menu options for the current command (or common 
commands and settings when no command is active).

 » Shift+right-click: Always displays the same Object Snap menu.

Running with object snaps
Often, you use an object snap setting (such as ENDpoint) repeatedly. Use running 
object snaps to address this need.

Follow these steps to set a running object snap:

1.  Right-click the Object Snap button on the status bar.

The Object Snap menu appears, as shown in Figure 8-4.

Many status bar buttons display shortcut menus when you right-click, as 
shown in Figure 8-4. Object Snap and Object Snap Tracking both display the 
menu of running object snaps. Many settings, including all running Object Snap 
types, can be set by clicking a menu item.
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2. Click in the menu to select one or more 
Object Snap settings.

Active running Object Snap settings show a 
check mark beside the icon (see Figure 8-4).

You click the Object Snap button on the  status 
bar or press the F3 key to toggle Running 
Object Snap mode. After you turn on this mode, 
 AutoCAD hunts for points that correspond to 
the object snaps you selected on the Object Snap 
button’s right-click menu. As with object snap 
overrides, AutoCAD displays a special  symbol — 
such as a square for an ENDpoint object snap — 
to indicate that it has found an object snap 
point. If you keep the cursor still, AutoCAD also  
displays a tooltip that lists the object snap  
point type.

Use object snap overrides or running object 
snaps to enforce precision by ensuring that 
new points you pick coincide exactly with points 
on existing objects. In AutoCAD, you can’t let 
points almost coincide or look like they coincide. 
You lose points, both figuratively and literally, 
if you don’t use object snaps or another preci-
sion technique covered in this chapter to enforce 
precision.

When using earlier releases of AutoCAD, applying crosshatching rapidly became 
impossible if the boundary of the area you were hatching had even microscopic 
leaks. Current releases have a Hatch Gap option to overcome this problem, but 
using this option it is almost never correct. Although you can crosshatch a leaky 
area, you will run into far greater problems downstream. For example, leaky 
geometry will create havoc if you try to use it to program a CNC machining 
center.

Most, but not all, object snap overrides have running object snap equivalents. For 
example, ENDpoint, MIDpoint, and CENter work as either overrides or running 
object snaps, but M2P (Mid between 2 Points) works only in override mode.

Inactive

Active

FIGURE 8-4: 
Grabbing multiple object features is 
an osnap.
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Other Practical Precision Procedures
The following list describes additional AutoCAD precision techniques (refer to 
Table 8-1):

 » Snap: If you turn on Snap mode, AutoCAD constrains the cursor to an 
imaginary rectangular grid of points at the spacing that you’ve specified when 
AutoCAD prompts you to specify a point.

When you enable Snap mode, at first it seems to be broken because the 
cursor doesn’t snap to the imaginary grid but travels freely. Snap mode 
becomes active only when the program asks you to pick a point.

Follow these steps to turn on Snap mode:

a. Right-click the Snap Mode button on the status bar.

b. Choose Settings.

The Snap and Grid tab in the Drafting Settings dialog box appears.

c. Enter a snap spacing in the Snap X Spacing field and click OK.

Click the Snap Mode button on the status bar or press F9 to toggle Snap mode 
off and on.

Usually, you can turn on Snap mode all the time, set at the usual smallest 
measurement increment. For example, to design doorknobs, I set it to 0.001, 
whereas an architect might set it to 1/8”. Now, I know that even randomly 
selected points have the degree of accuracy I want.

You can switch between Grid Snap (snap points in rows and columns) and 
Polar Snap (snap points based on distances and angles) by using the Snap 
mode button’s shortcut menu. See the Polar Snap bullet for more  information.

 » Ortho: Using Ortho mode forces the cursor to move horizontally or vertically 
relative to the current coordinate system’s X- and Y-axes. To toggle Ortho 
mode, click the Ortho Mode button on the status bar or press F8. You can also 
hold down the Shift key to temporarily go in and out of ortho mode. Because 
technical drawings often include lots of orthogonal lines, you may use Ortho 
mode a lot — but take a close look at polar tracking as well.

According to Autodesk Evangelist Lynn Allen, you know you’ve been using 
AutoCAD too long when the police officer asks you to walk a straight line and 
you reply “No problem. Can you press F8 please?”

 » Direct distance entry (DDE): This point-and-type technique is an easy and 
efficient way to draw with precision. You simply point the cursor in a particular 
direction, type a distance value at the command line, and press Enter. You can 
use DDE at any time the cursor is anchored to a point, and the command line 
or Dynamic Input tooltip prompts you for another point or a distance.
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You usually use DDE with polar tracking turned on to specify distances in par-
ticular directions (for example, in angle increments of 45 degrees). You can 
also combine DDE with Ortho mode to specify a distance in an orthogonal 
direction (0, 90, 180, or 270 degrees).

 » Object snap tracking: This feature extends running object snaps so that you 
can locate points based on more than one object snap point. For example, 
you can define a point at the center of a square by tracking to the MIDpoints 
of two perpendicular sides. Click Object Snap Tracking on the status bar or 
press F11 to toggle Object Snap Tracking.

You can locate points based on more than one object snap point. Follow these 
steps:

a. Draw a rectangle with the RECtang command.

b. Right-click the Object Snap button, choose Settings, turn on MIDpoint, and then 
click OK.

c. Make sure Object Snap (F3) and Object Tracking (F11) are turned on.

d. Start the Circle command.

e. Move the cursor close to the middle of the bottom line of the rectangle until the 
green triangle osnap marker appears. Don’t pick this point.

f. Move the cursor vertically and note that the green triangle disappears to be 
replaced by a green + sign, and a vertical dotted green line appears.

g. Move the cursor close to the middle of one of the vertical lines of the rectangle 
until the green triangle osnap marker appears. Don’t pick this point either.

h. Move the cursor horizontally until the two dotted green lines cross and an X 
appears, along with a midpoint tooltip, as shown in Figure 8-5.

i. Click this point to define the center of a circle that is exactly in the middle of the 
rectangle.

You can use this same technique to transfer points from a front view to a top 
view or to a side view without having to use construction lines.

FIGURE 8-5:  
Using Object 

Snap  Tracking 
to find the 

exact middle of 
a rectangle.



CHAPTER 8  Preciseliness Is Next to CADliness     141

 »  Polar tracking: When you turn on polar tracking, the cursor jumps to incre-
ments of the angle you specified in the Drafting Settings dialog box or chose 
on the right-click menu. When the cursor jumps, a tooltip label starting with 
Polar: appears. Right-click the Polar Tracking button on the status bar and 
choose the Settings option to display the Polar Tracking tab in the Drafting 
Settings dialog box. Select an angle from the Increment Angle drop-down list 
and then click OK. Click the Polar Tracking button on the status bar or press 
F10 to toggle Polar Tracking mode.

Remember that you can set a predefined polar tracking angle by right-clicking 
the Polar Tracking button and choosing an angle from the menu. If you want 
to add an angle that isn’t on the list, you have to click Settings to open the 
Drafting Settings dialog box.

Polar and Ortho modes are mutually exclusive. Turning on one turns off the 
other.

 » PolarSnap: You can force polar tracking to jump to specific incremental dis-
tances along the tracking angles by changing the snap type from Grid snap to 
PolarSnap. For example, if you turn on polar tracking and set it to 45 degrees, 
and then turn on PolarSnap and set it to 2 units, polar tracking jumps to 
points that are at angle increments of 45 degrees and distance increments of 
2 units from the previous point. PolarSnap has a similar effect on Object Snap 
tracking.

To activate PolarSnap, right-click the Snap Mode button and choose PolarSnap 
from the menu. To specify a PolarSnap distance, follow these steps:

a. Right-click the Snap button on the status bar.

b. Choose Settings.

The Snap and Grid tab on the Drafting Settings dialog box appears.

c. Click the PolarSnap radio button, type a distance in the Polar Distance text box, 
and then click OK.

When you want to return to ordinary rectangular snap, as described at the 
beginning of this list, right-click the Snap Mode button and choose Grid Snap 
from the menu.

 » Temporary override: Settings such as Snap, Ortho, and Polar remain on until 
you turn them off. You can also use a temporary override, which lasts only as 
long as you hold down its key or key combination. For example, when Ortho 
mode is turned off, holding down the Shift key puts AutoCAD into Ortho mode 
temporarily for as long as you press Shift. For additional information, see the 
online help system.
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If you’re new to AutoCAD, its wide range of precision tools may seem overwhelm-
ing. Rest assured that there’s more than one way to use the program’s precision 
tools. You can make perfectly precise drawings without using every single imple-
ment in the AutoCAD precision toolkit. I recommend these steps:

1. Become comfortable with typing coordinates, Ortho mode, direct distance 
entry, and Object Snap overrides.

2. Become familiar with running object snaps, and experiment with Snap mode.

3. After you’re comfortable using all these precision features, experiment with 
polar tracking, PolarSnap, and object snap tracking.

Snap constrains the cursor to locations whose coordinates are multiples of the 
current snap spacing, and it works whether or not the drawing has objects in it. 
Object snap (osnap) enables you to grab points on existing objects, whether or not 
those points happen to correspond with the snap spacing.

What happens if some of your drawing-with-precision choices seem to contradict 
each other? The answer is simple: AutoCAD uses the one that requires the greater 
effort to initiate. That is, Snap is overridden by Object Snap, which is overrid-
den by a snap override, which is overridden by the keyboard entry of points or 
distances.
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IN THIS CHAPTER

Managing object properties, such as 
color, linetype, and lineweight

Managing layers

Copying layers and other named 
objects between drawings with 
DesignCenter

Manage Your 
Properties

Contrary to what you might believe, managing properties has nothing to do 
with real estate holdings. CAD programs are different from other drawing 
programs in that you have to pay attention to little details, such as object 

properties or the precision of points that are specified when you draw and edit 
objects. If you ignore these details and start drawing, you’ll produce a mess of 
sloppy geometry that’s difficult to edit, view, and plot.

This chapter introduces object properties — one set of AutoCAD tools and tech-
niques that can help prevent you from making CAD messes. Chapter 8 explains 
the most important precision drawing techniques that you need to observe to cre-
ate usable AutoCAD drawings. You must understand the information in Chap-
ters 8 and 9 before you start drawing and editing objects in production drawings 
(described in Chapters 6, 7, 10, and 11).

When you first start using AutoCAD, the number of property settings and preci-
sion controls necessary to draw a simple line can seem intimidating. Unlike in 
many other programs, you cannot simply draw a line in a more-or-less-adequate 
location and then slap some color on it. But all these settings and controls can 
inspire the feeling that you have to learn how to drive a Formula 1 car to make a 
trip down to the corner store. Wait a minute. That could be fun. The benefit is that 
after you are comfortable in the driver’s seat, AutoCAD takes you on the long-haul 
trips and gets you there a lot faster.

Chapter 9
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Using Properties with Objects
All the objects you draw in AutoCAD are like good Monopoly players: They own 
properties. In AutoCAD, these properties aren’t physical items; instead, they’re 
the object’s characteristics, such as layer, color, linetype, lineweight, transpar-
ency, and plot style. You use properties to communicate information about the 
characteristics of the objects you draw, such as the kinds of real-world objects 
they represent, their materials, their relative location in space, or their relative 
importance. In AutoCAD, you also use properties to organize objects for editing 
and plotting purposes.

AutoCAD gives you different ways to control object properties:

 » By layer: Each layer has a default color, linetype, lineweight, transparency, 
and plot style property. Unless you tell AutoCAD otherwise, objects inherit the 
properties of the layers on which they’re created. When objects are selected 
in a drawing created by using this system, the object properties are listed 
as ByLayer.

 » By object: AutoCAD also enables you to override the property settings that an 
object inherits from its assigned layer. This gives you control over the object’s 
color, linetype, lineweight, transparency, or plot style properties so they can 
differ from the layer’s properties. When Autodesk introduced this capability, 
they gleefully announced that “Now you have total control over an object’s 
properties.” But as you will see shortly, the opposite is true; you just lost 
control.

It is almost never good practice to apply property overrides to individual objects 
so that a line on a layer that has the color red as a property is actually displayed 
as green.

Using the ByLayer approach
In almost all cases, you should create layers, assign properties to each layer, and 
let the objects on each layer inherit that layer’s properties. Here are two benefits 
of using the ByLayer approach:

 » You can modify properties by layer instead of individually. You can easily 
change the properties of a group of related objects that you place on one 
layer. You simply change the properties for the layer, not for a bunch of sepa-
rate objects.
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 » You can exchange drawings with other people. Experienced drafters use 
the ByLayer approach, so if you work with drawings from other people, you’ll 
be much more compatible with them if you work the same way. (You’ll also 
avoid the wrath of irate CAD managers, whose job duties include haranguing 
any hapless newbie who assigns property overrides to individual objects.)

In the worst-case scenario, you receive an architectural drawing from someone 
else, and everything looks good — even all the object colors are correct. You want 
to plot the drawing with no dimensions showing, so you freeze the Dimension 
layer. Oh, poo! (Or words to that effect.) Only half the dimensions disappear, but 
so do some center lines, a couple of walls, the toilet, and other items. This is what 
I meant when I said that you have lost control of object properties.

If you assign properties with the ByLayer approach, all you have to do is set layer 
properties in the Layer Properties Manager palette, as shown in Figure  9-1. (I 
tell you how in this section.) Before you draw any objects, verify that the Color 
Control, Linetype Control, and Lineweight Control drop-down lists — and the 
Transparency button in the Properties panel on the Home tab of the Ribbon — are 
all set to ByLayer, as shown in Figure 9-2. Remember that the configuration of 
panels and drop-down lists may vary according to the resolution of the display. 
If the drawing is set to use color-based plot styles rather than named plot styles, 
as described in Chapter 16, the Plot Style Control drop-down list is inactive and 
displays ByColor.

If the drawing is set to use named plot styles rather than color-based plot styles 
(see Chapter 16), the Plot Style control drop-down list should also display ByLayer.

Don’t assign properties to objects in either of these ways:

 » Don’t choose a specific color, linetype, lineweight, transparency, or plot style 
from the appropriate drop-down list in the Properties panel on the Home tab 

FIGURE 9-1:  
Use layer 

properties to 
control object 

properties.
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of the Ribbon, 
or from the 
Properties 
palette, and 
then draw the 
objects. All 
new objects 
will be on the 
current layer 
but will have 
property over-
rides applied.

 » Don’t draw the 
objects, select 
them, and 
then choose a 
property from 
the same drop-
down lists.

If you prefer to do things the right way (that is, my way), assign these properties 
ByLayer, as described in the later section “Working with Layers.”

If you want to become a good CAD manager, learn how to edit the Customizable 
User Interface (CUI) file in AutoCAD, and then delete the property override items 
from the Ribbon.

The SETBYLAYER command in AutoCAD lets you correct non-ByLayer properties. 
On the Home tab of the Ribbon, click the Modify panel label to open the panel 
slideout, and then click Set to ByLayer. Answer the prompts at the command line 
to finish modifying objects. For more information, refer to SETBYLAYER in the 
online Help system.

Changing properties
You can view and change all properties of an object in the Properties palette (its 
icon is shown in the margin), and many of them in the Quick Properties palette 
(the second icon in the margin). In Figure 9-3, the Properties palette at the left 
and the Quick Properties palette at the right show properties for the selected line 
object.

Plot Style control

Color control

Linetype control

Lineweight control

FIGURE 9-2:  
ByLayer (nearly) all the way.
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The Properties palette was joined in AutoCAD 2009 by its more streamlined little 
sibling, Quick Properties (QP). When you turn on the QP paletted on the status bar, 
selecting an object opens a floating palette that displays a customizable selection 
of that object’s properties.

Handy as it is, the Quick Properties palette has a knack of popping up on top 
of drawing objects that you need to see. In AutoCAD, you can let Quick Proper-
ties mode remain turned off at the status bar and instead use the QuickProper-
ties command. Type its alias (QP) and then select an object to display the Quick 
Properties panel. You can also double-click most objects to display their quick 
properties.

To toggle the full Properties palette on and off, click the Properties button on the 
View tab of the Ribbon or press Ctrl+1. Before you select an object, the Properties 
palette displays the current properties — properties that AutoCAD applies to new 
objects when you draw them. After you select an object, the Properties palette 
displays the properties for that object. If you select more than one type of object, 
the Properties palette displays, and then changes the properties that they have in 
common.

Properties and QuickProperties let you change any properties of one or more 
selected objects. You should change the main properties (such as color, linetype, 
and lineweight) only by moving the objects to a different layer.

If you’re a CAD manager, you can easily customize the Quick Properties palettes 
to remove undesirable properties. For detailed instructions, search for customize 
quick palettes in the Help search window.

FIGURE 9-3: 
 Comprehen-
sive or quick? 

Sometimes 
you need lots 

of information, 
and sometimes 

you don’t.
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Working with Layers
Every object has a layer as one of its properties. Conceptually, layers had their 
origins in complex paper-and-pencil architectural drawings. After laying out the 
basic foundation plan on a sheet of paper, the architect placed a sheet of clear 
plastic on top and drew the walls. This process was repeated with separate sheets 
for tasks such as plumbing, electrical, and ventilation. When all layers of plastic 
were in place, the architect could check for interferences to prevent a ventila-
tion duct from running directly through a major support column, for example. 
When everything checks out, the architect could produce suitable blueprints for 
the plumber and other interested parties by simply removing layers that weren’t 
appropriate. An electrician doesn’t need to know where the pipes run, for example.

AutoCAD, like most CAD programs, uses the layer as the primary organizing prin-
ciple for all objects you draw. You use layers to organize objects into logical groups 
of items. For example, walls, furniture, dimensions, and text notes usually belong 
on four separate layers, for a couple of reasons:

 » Layers give you a way to turn groups of objects on and off, both on the screen 
and on the plot.

 » Layers provide the most efficient way of changing object color, linetype,  
lineweight, transparency, and plot style.

STACKING UP LAYERS
How do you decide what to call layers and choose which objects to put on them? 
Some industries have developed layer guidelines, and many offices have created 
 documented layer standards. For example, the American Institute of Architects has 
 created a  comprehensive set of layer standards. Some projects even impose specific 
layer  requirements. By the way, be careful: If someone says, “You need a brick layer for 
this project,” that statement can have a couple of different meanings. Ask experienced 
CAD drafters in your office or industry how they use layers in AutoCAD. If you can find 
no definitive answer, create a chart of layers for yourself. Each row in the chart should 
list the layer name, default color, default linetype, default lineweight, default transpar-
ency, and the kinds of objects that belong on that layer. If you use named plot styles 
to control the plotted output, add a default plot style to the list. (I cover plot styles in 
Chapter 16.)
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So, to work in AutoCAD efficiently, you create as many layers as the drawing needs 
and assign them suitable names and properties, such as colors and linetypes. Then 
you draw objects on specific layers. When you draw an object, AutoCAD automati-
cally puts it on the current layer — the layer you see in the Layer drop-down list on 
the Layers panel of the Home tab when no objects are selected. If a layer already 
exists in the drawing, you can make it the current layer by choosing it from the 
Layer drop-down list, as shown in Figure 9-4.

You don’t have to create all layers before drawing an object, but it saves you some 
time if you start as many layers as you estimate you need and then add more lay-
ers only as needed. You can save even more time by creating all the layers you 
need in a new drawing and then saving it as a template file (covered in Chapter 4). 
Now each drawing you start from that template has all the layers you need. In fact, 
most companies have (or should have) a standard template file already set up to 
their layer standards. Similarly, outside clients probably have standard layer sets.

No objects can be selected before you use the Layer drop-down list to change 
the current layer, so press the Esc key twice to be certain. If objects are selected, 
selecting another layer from the Layer drop-down list changes their layers. When 
no objects are selected, the Layer drop-down list displays (and lets you change) 
only the current layer.

FIGURE 9-4:  
Setting 

an existing 
layer as the 

current layer.



150     PART 2  Let There Be Lines

Accumulating properties
Besides layers, the remaining object properties that you’re likely to want to 
use often are color, linetype, lineweight, transparency, and possibly plot style. 
Table 9-1 summarizes the properties you use most often.

Long before AutoCAD could display lineweights on the screen and print those 
same lineweights on paper, object colors controlled the printed lineweight of 
objects. Color identified different objects, such as part outlines, hidden lines, cen-
ter lines, and cutting plane lines. When the time came to plot the drawing using 
(now mostly defunct) pen plotters, AutoCAD sent all red objects to pen 1, yellow to 
pen 2, green to 3, and so on.

Although pen plotters could plot in color, most companies installed pens that used 
black ink but had different pen widths. For example, the color red in a drawing 
told the plotter to use pen 1 that was black and might have had a width of 0.12mm. 
The color green plotted using pen 3 that was black and might have had a width 
of 0.20mm. This was done for each color that was used in a drawing, which were 
commonly not more than 8 because a pen plotter typically did not hold more than 
eight pens.

AutoCAD 2000 introduced a more logical system, by which you could assign an 
actual plotted lineweight to an object. As logical as this method seems, the older 
method — in which the color of an object determines its plotted lineweight — 
continues to dominate, perhaps in part because of the ready availability of color 
printers. You may work this way even in AutoCAD 2017, for compatibility with 
drawings (and coworkers) that use the old way. Figure 9-5 shows you the idea. The 
model space view at the left shows objects in different colors but with the same 
default lineweight. The paper space view at the right (showing what the plotted 
drawing will look like) shows that although the lines are black, their thicknesses 
vary, determined by the model space colors. For example, blue is thick, and black 
is thin.

TABLE 9-1 Useful Object Properties
Property What It Controls

Color Displayed colors and plotted lineweights or colors

Linetype Displayed and plotted dash-dot line patterns

Lineweight Displayed and plotted line widths

Transparency Displayed and plotted opacity of objects

Plot style Plotted characteristics (see Chapter 16)
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Creating new layers
If no suitable layer exists, you create one in the Layer Properties Manager palette. 
Follow these steps:

1. Click the Layer Properties button in the Layers panel on the Home tab of 
the Ribbon, or type LA at the command line and then press Enter.

The Layer Properties Manager palette appears. A new drawing has only one 
layer: Layer 0 (zero). You need to add the layers necessary for the drawing.

The Layer Properties Manager palette, as well as individual columns within it, 
can be stretched wider so as to not truncate information. The easy way is to 
right-click a column header and then choose Maximize All Columns.

2. Click the New Layer button (it looks like a sheet of paper with a little sun-
burst on one corner) to create a new layer.

A new layer appears. AutoCAD names it Layer1 but highlights the name in an 
edit box so that you can type a new name to replace it easily, as shown in 
Figure 9-6.

3. Type a name for the new layer.

Type a layer name using initial caps — only the first letter of each word is in 
uppercase. Because layer names written in all uppercase letters are much 
wider than others, they’re often truncated (abbreviated) in the Layer drop-
down list.

FIGURE 9-5:  
Change my line 

thickness, but 
color me black.

FIGURE 9-6:  
Adding a new 

layer in the 
Layer  

Properties 
Manager 

palette.
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Layer names should be descriptive and organized so that they’re easily 
identifiable and can be sorted logically. For example, names such as Floor 01 
Plan, Floor 01 Walls, Floor 01 Electrical, and Floor 02 Plan are better than a 
drawing I saw recently that had 132 layers named with the sequence 001, 002, 
003, 004, and so on.

As of 2014, AutoCAD sorts in natural order:

Old Way New Way

Floor 1 Walls Floor 1 Walls

Floor 10 Walls Floor 2 Walls

Floor 2 Walls Floor 10 Walls

4. On the same line as the new layer, click the color block or color name (by 
default, the same as the current layer) of the new layer.

The Select Color dialog box appears, as shown in Figure 9-7, with Magenta 
selected from the Color Index list.

The normal AutoCAD color scheme, known as the AutoCAD Color Index (ACI), 
provides 255 colors. That number of choices is overkill for ordinary drafting, 
but if you truly want to go overboard, the True Color tab provides more than 
16 million colors, whereas the Color Books tab gives access to many standard 
color books such as Pantone books, which are used by the design and printing 
industries.

FIGURE 9-7:  
The Select 

Color dialog 
box.
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For now, stick with the first nine colors — the ones that appear in a single, 
separate row to the left of the ByLayer and ByBlock buttons on the Index Color 
tab in the Select Color dialog box — for these reasons:

• These colors are easy to distinguish from one another.

• Using a small number of colors makes configuring plot parameters easier.  
(I describe plot parameters in Chapter 16.)

5. Click a color to select it as the color of this layer and then click OK.

The Select Color dialog box closes. In the Layer Properties Manager palette, the 
Color column now has the new layer color — either the name or the number 
of the color you selected.

The first seven AutoCAD colors have numbers, standard names, and initials: 
1 = Red, 2 = Yellow, 3 = Green, 4 = Cyan, 5 = Blue, 6 = Magenta, and 7 = White 
(which appears black when displayed on a white background). The remaining 
248 colors have numbers only.

6. On the same line as the new layer, click the Linetype name of the new layer 
to draw a dashed (hidden) line.

The Select Linetype dialog box appears, as shown in Figure 9-8.

The default AutoCAD linetype is Continuous — the line has no gaps.

If you already loaded the linetypes you need for the drawing, or if the initial 
template file has linetypes loaded, the Select Linetype dialog box displays them 
in the Loaded Linetypes list. If not, click the Load button to open the Load or 
Reload Linetypes dialog box. By default, AutoCAD displays linetypes from the 
standard AutoCAD or AutoCAD LT linetype definition file — acad.lin for 
imperial-unit drawings or acadiso.lin for metric-unit drawings (acadlt.lin 
and acadltiso.lin in AutoCAD LT). Load a linetype by selecting its name and 
clicking OK.

FIGURE 9-8:  
The Select 

Linetype  
dialog box.
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Unless you have a truly good reason (for example, your boss tells you so), 
avoid loading or using any linetypes labeled ACAD_ISO. These linetypes are 
normally used only in metric drawings based on standards from ISO 
(International Organization of Standards) — and rarely even then. It’s easier to 
use the linetypes with the more descriptive names: CENTER and DASHED, for 
example.

7. Click a linetype in the Loaded Linetypes list to select it as the linetype for the 
layer; then click OK.

The Select Linetype dialog box disappears, returning you to the Layer 
Properties Manager palette. In the Name list, the linetype for the selected layer 
changes to the linetype you just chose.

8. On the same line as the new layer, click the new layer’s lineweight.

The Lineweight dialog box appears, as shown in Figure 9-9.

9. Select the lineweight you want 
from the list and click OK.

 Using the lineweight property is a 
two-step process. After you assign a 
lineweight to a layer, you must click 
the Show/Hide Lineweight button 
on the status bar to see the effect. 
You can turn the feature off and on 
with this button.

A lineweight of 0.00mm tells 
AutoCAD to use the thinnest 
possible lineweight on the screen 
and on the plot. I recommend, for 
now, leaving the lineweight set to 
Default, and instead later map 
screen colors to plotted lineweights, 
as described in greater detail in 
Chapter 16.

10. (Optional) In the same line as the 
new layer, click the value in the Transparency column.

You’ll appreciate AutoCAD’s transparency property if you’re preparing drawings 
for a presentation. Clicking in the Transparency column opens the Layer 
Transparency dialog box; type a numeric value between 0 and 90 or use the 
drop-down list to set a value. Transparency = 0 (no transparency) is the default; 
objects drawn on a layer set to Transparency = 0 are opaque.

FIGURE 9-9:  
The Lineweight dialog box.
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Set the value to greater than 0, and you start seeing things through the objects 
you draw.

11. (Optional) Set the plot style for the new layer.

The Plot Style column’s contents depend on whether the drawing uses named 
plot styles or the traditional color-based plotting. Drawings set up to use 
color-based plotting display an unchangeable plot style name based on the 
layer’s color property. The grayed-out style name changes only when the layer 
color changes. If, on the other hand, the drawing uses named plot styles, you 
can assign a named plot style to the layer in this column. (Chapter 16 explains 
why you might not want to.)

12. (Optional) Turn plotting on and off.

The setting in the Plot column controls whether the layer’s objects appear on 
plots. Click the little Printer icon to turn off this setting (the little printer gets a 
red bar through it) for any layer whose objects you want to see on the screen 
but hide on plots. Layout viewports, covered in Chapter 12, are a good use for 
this feature.

Another use for this feature is antagonizing coworkers. Go into one of their 
drawings, start the Layer Properties Manager, and turn off plotting on a few 
random layers. Now go to the top of the Plot column, click the divider between 
it and the adjacent column, and reduce the Plot column’s width to nearly zero. 
Even a senior experienced AutoCAD user can go nuts trying to figure out why 
some layers won’t plot.

13. (Optional) To add a description to the layer, scroll the layer list to the right to 
see the Description column, click in the Description box corresponding to the 
new layer, and type a description.

If you use layer descriptions, stretch the Layer Properties Manager palette to 
the right so that you can see the descriptions without having to scroll the layer 
list.

14. Repeat Steps 1–13 to create any other layers you want.

15. Select the new layer that you want to make current, and click the Set 
Current button (the green check mark).

Changes you make in the Layer Properties Manager palette are instantaneous. 
Therefore, if objects in the drawing are already on a particular layer and you 
change the color for that layer, the existing drawing objects change color 
immediately and don’t wait for you to close the palette.

The Layer drop-down list now displays the new layer as the current layer — the 
one on which AutoCAD places new objects you draw.
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As with all palettes in AutoCAD, you can leave the Layer Properties Manager 
open while you do other things in the drawing. Also like other palettes, the Layer 
Properties Manager can be set to automatically hide itself to its title bar, to be 
either floating or docked, or to be anchored (I get the sense that some Auto-
CAD programmers would rather be sailing) to either side of the screen. If your  
computer has two monitors, you can drag the palettes to the second monitor.

Layer 0 (zero) must exist in every drawing. You can assign any of the other  
properties to it such as color and line type, but you cannot rename it.

Set up layers in a template file and then you almost never need the Layer  
Properties Manager while you’re working.

Here are a few things you can do to work effectively with layers:

 » Set a layer to be the current layer. Make sure that no objects are selected, 
and then choose the layer name from the Layer drop-down list on the Layers 
panel on the Ribbon or the Layers toolbar.

A LOAD OF LINETYPES
When you load a linetype, AutoCAD copies its linetype definition — a formula for how to 
create the dashes, dots, and gaps in that particular linetype — from the acad.lin  
(imperial units) or acadiso.lin (metric units) file into the drawing. The files are 
acadlt.lin and acadltiso.lin, respectively, in AutoCAD LT. The definition doesn’t 
automatically appear in other drawings; you have to load into each drawing the linetype 
you want to use. If you find that you’re loading the same linetypes repeatedly into  
different drawings, consider adding them to template drawings instead. See Chapter 4 
for information about templates and how to create them. After you add linetypes to a 
template drawing, all new drawings you create from that template start with those  
linetypes loaded automatically.

Don’t go overboard on loading linetypes. For example, you don’t need to load all  
linetypes in the acad.lin file because you might use them all someday. The resulting 
linetype list would be long and unwieldy. Most drawings require only a few linetypes, 
and most industries and companies settle on a half dozen or so linetypes for common 
use. Your industry, office, or project manager may have guidelines about which linetypes 
to use for which purposes.

If you’re the technodweeb type and don’t mind editing a text file that contains linetype 
definitions, you can define your own linetypes or weed out the ones you’ll never use. 
Press F1 to open the online help system; search for custom linetypes.
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 » Toggle properties on and off. You have to turn on the Transparency button 
on the status bar to see through objects. You can also toggle the Lineweight 
and Transparency buttons on the status bar to see the effect of assigning 
these properties.

 » Adjust the lineweight properties and scale. When you finish defining layers 
and return to the command line, the Lineweight dialog box lets you adjust 
several lineweight properties, including inches-versus-millimeters and the 
display scale.

The display scale affects only how elements appear onscreen, not how they’re 
plotted.

 » Let the command line find layers for you. The command line automati-
cally completes layer names, among other named objects, and it searches for 
matching partial text within layer names. Follow these steps:

1. Open a drawing that contains layers.

If you created the base plate in in Chapter 3, open that.

2. Make sure that Dynamic Input (F12) is turned off.

Unfortunately, this functionality works only when DYNamic Input is off.

3. Start typing letters in the layer name you’re looking for, but don’t press Enter.

If you’re using the base plate, you type BO. Figure 9-10 shows how the 
command line displays the three command names that start with BO —  
plus, it shows Layer: Anchor Bolts because it found the Bo in Bolts.

4. Click the layer name.

It becomes the current layer.

Manipulating layers
After you create layers and draw objects on them, you can turn a layer off or 
on to hide or show the objects on that layer. In the Layer Properties Manager 

FIGURE 9-10:  
Type, and the 

command line 
shall find.
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palette, the first three icons to the right of the layer name control AutoCAD’s layer  
visibility modes:

 » Off/On: Click the lightbulb icon to toggle visibility of all objects on the selected 
layer. AutoCAD doesn’t regenerate the drawing when you turn layers back 
on. On the other hand, frozen layers don’t regenerate while you’re working 
on the drawing. I give you the lowdown on regeneration in Chapter 5. Current 
computers are usually fast enough that regens aren’t a problem, so Off/On is 
seldom used.

 » Freeze/Thaw: Click the sun icon to toggle off visibility of all objects on the 
selected layer. Click the snowflake icon to toggle visibility on. AutoCAD  
regenerates the drawing when you thaw layers.

 » Lock/Unlock: Click the padlock icon to lock and unlock layers. When a layer is 
locked, you can see (but not edit) objects on that layer.

You can rearrange the column order within the Layer Properties Manager by  
simply dragging and dropping the column label to a new place. And you can right-
click any column label to display a menu from which you can turn columns off 
and on.

Off/On and Freeze/Thaw do almost the same thing — both settings let you make 
objects visible or invisible by layer. Very early releases had only Off/On. The differ-
ence is that frozen layers effectively don’t exist temporarily, so AutoCAD ignores 
them when regenerating the drawing.

Normally, it’s faster and easier to turn layers off and on, freeze and thaw them, 
and lock and unlock them by clicking the appropriate icons in the Layer drop-
down list on the Ribbon instead of using the Layer Properties Manager Palette.

Here are a few other useful tricks you can try when working with layers:

 » Create layer states. Say you have a floor plan of a house that includes a layer 
showing the plumbing and another layer showing the wiring. You’d probably 
never show both elements on the same drawing, so you’d need to manage 
some layers to show the drawing to plumbers or electricians. Rather than 
turn off a dozen layers and turn on another dozen layers when you want a dif-
ferent view in the drawing, you can save groups of layer settings as a named 
layer state. Click the Layer States Manager button in the Layer Properties 
Manager to open the Layer States Manager dialog box, or enter LAYERSTATES 
at the command line, or choose Manage Layer States from the Layer State 
drop-down list in the Layers panel.
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 » Fade objects on locked layers. AutoCAD fades objects on locked layers, giv-
ing you a truly effective visual reference without confusing you about which 
layers might be locked. You can control the amount of fading by setting a 
nonzero value for the system variable LAYLOCKFADECTL. See Chapter 26 for 
an explanation of system variables, and check out the online Help system for 
specific info on this one. You can turn off fading but retain the current setting 
for future use by adding a minus sign (–) in front of the fade value, or you can 
turn off the fading altogether by setting this value to 0.

The LAYISO command incorporates the same layer-fading feature, and it locks 
the layers. Set it up the way you want by entering S (for Settings) at the com-
mand line and pressing Enter; and then type the option letter for the specific set-
tings you want. Look up LAYISO in the online Help index for more information.

 » Create a layer filter. If you find that you’re using lots of layers, you can create 
layer filters to make viewing and managing the layer list easier:

• A group filter is a subset of layers you choose (by dragging layer names into 
the group filter name or by selecting objects in the drawing).

• A property filter is a subset of layers that AutoCAD creates and updates 
automatically according to layer property criteria that you define (for 
example, all layers whose names contain Wall or whose color is green).

To find out more, press F1 in the Layers Properties Manager palette, and click 
the New Property Filter hyperlink.

 » Isolate a layer. On the Layers panel of the Home tab of the Ribbon (shown 
in Figure 9-11), click the Layer Isolate and Layer Off button to specify the layer 
to isolate (that is, fade all layers except the chosen one) or turn off altogether. 
You may have to open the panel slideout to see these buttons.

For more information on layers, open the online Help system and search on 
controlling layers manager.

FIGURE 9-11:  
Tooling 

through the 
layer tools.
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 » Hide or isolate objects on a layer. Rather than turn off a layer when only 
a few items are in the way, you can hide or isolate individual objects by 
using the ISOLATEobjects and HIDEOBJECTS commands while maintaining 
normal visibility for other objects on the layer. I discuss these commands in 
Chapter 10.

Scaling an object’s linetype
Linetype scale controls the display of dash-dot linetypes in a drawing. Some line-
types that you assign to a layer or an object directly might not look correct on 
every object based on the drawing’s current linetype scale. The problem with the 
linetypes is that the dashes and gaps are not always noticeable on every object 
because of the object’s size or the way the object was drawn.

To fix this problem, you can change the object’s linetype scale that is normally set 
to a value of 1. The object’s linetype scale is used as a multiplier with the draw-
ing’s linetype scale factor. For example, if you change an object’s linetype scale 
factor to 1.5 and the drawing’s linetype scale factor is 12, the linetype applied to 
the object is actually displayed with a linetype scale of 16 (1.5 x12).

Follow these steps to scale the object’s lineweights:

1. Start a new drawing by using the standard acad.dwt or acadlt.
dwt template.

2. Create a layer that uses the Hidden linetype and set this layer to be current.

If you don’t feel like creating a new layer, you can always simply set the linetype 
for Layer 0 (zero) to hidden.

3. Set the limits to be from 0,0 to 100,100.

4. Enter Zoom and press Enter. Then enter A and press Enter to zoom to the 
limits you set.

5. Start the Line command, and type coordinates to draw a line from 10,10 
to 70,70.

Hey, what happened? That doesn’t look like a hidden line! Well, it is, even if it 
doesn’t look like one. The problem is that the line is so long and you’ve zoomed 
out so far that the individual spaces and dashes are too small and have all 
merged into one. The bigger problem is that if you were to plot this drawing to 
fit an A-size (8½ x 11) sheet of paper, the line would look just as it does 
onscreen.
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6. Start the LTScale (LineTypeScale) command and enter 20.

Ah, that’s better! As I mention in Chapter 4, you need to apply a plotting scale 
of 1:20 to fit the line on the paper, but then everything scales down, including 
the spaces and dashes in noncontinuous lines. The LTScale command with a 
value of 20 tells AutoCAD to make the dashes and spaces 20 times longer so 
that they scale down properly when you plot. I cover this topic in more detail in 
Chapters 13–15.

7. Start the Line command, and type coordinates to draw a line from 30,10 to 
100,80.

The new line should look just like the first line you drew.

8. Select the second line you drew and right-click. Choose Properties.

The Properties palette is displayed.

9. On the Properties palette, click in the Linetype Scale field and enter 2.

The display of the linetype for the second line is displayed at a scale of 40.

Using Named Objects
One thing that can make AutoCAD interesting is the somewhat cavalier naming 
conventions used in the program’s documentation. For years, elements such as 
lines, arcs, and other graphical items were called entities, but then they started 
being called objects. Fair enough, but object has also long been used to define cer-
tain nongraphical components of a drawing — items you’d hardly even consider 
to be objects — and those are the kind of named objects I describe in this section.

Hidden in the innards of every AutoCAD drawing file is a set of named objects, 
which are organized into symbol tables, and the properties that are common to 
all AutoCAD objects are defined in these tables. For example, all line objects in a 
drawing are stored on one or more layers, so a layer property is common to all 
lines and is defined in the layer table. But the coordinates that define the start 
and end points of a given line are unique to that line (or they should be!), so the 
coordinate properties aren’t common to all lines.

A layer is one example of a named object. The layer table in a given drawing con-
tains a list of the layers in the current drawing, along with the settings for each 
layer including the color, linetype, and on/off setting.

Named objects don’t appear as graphical objects in the drawing. They’re like the 
hardworking behind-the-scenes pit crews who keep race cars running smoothly. 
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These named objects are the ones you’re likely to use most often (including 
cross-references):

 » Layer: They’re covered in the section “Working with Layers,” earlier in 
this chapter.

 » Linetype: They’re covered in the section “Managing Properties,” earlier in this 
chapter.

 » Text style: See Chapter 13.

 » Table style: See Chapter 13.

 » Multileader style: See Chapter 13.

 » Multiline style: This object isn’t covered in this book; see the online Help 
system.

 » Dimension style: See Chapter 14.

 » Block definition and xref: See Chapters 17 and 18.

 » Layout: See Chapter 12.

When you use commands such as LAyer, LineType, and DimSTyle, you’re creating 
and editing named objects. After you create named objects in a drawing, the Auto-
CAD DesignCenter or Content Explorer give you the tools to copy them between 
drawings.

Donald Trump might believe otherwise, but you can have too many properties 
(at least in AutoCAD). You may have created layers or loaded linetypes, text, or 
dimension styles that you don’t use. When you suspect that you have some of 
these superfluously named objects in the drawing, the PUrge command can help 
you get rid of them. Click the application button to display the Application menu. 
Choose Drawing Utilities ➪ Purge to open the Purge dialog box. You can click the 
plus sign (+) beside a category to purge individual items, or you can click Purge All 
and get rid of tons of stuff all at one time. Visit the online Help system for more 
about purging.

Using AutoCAD DesignCenter
DesignCenter is a useful, if somewhat busy, palette. The DesignCenter palette is 
handy for copying the specifications of named objects: layers, linetypes, block 
definitions, text styles, and other organizational objects in drawings from one 
drawing to another.
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The DesignCenter palette, shown in Figure 9-12, consists of a toolbar at the top, 
a set of three tabs below that, a tree view pane on the left, and a content pane on 
the right. The tree view pane displays a Windows Explorer–like navigation panel, 
showing drawing files and the symbol tables contained in each drawing. The con-
tent pane usually displays the contents of the selected drawing or symbol table.

The three tabs just below the DesignCenter toolbar control the elements you see in 
the tree view and content panes:

 » Folders: Shows the folders on the local and network drives, just as the 
Windows Explorer Folders pane does. Use this tab if the drawing you want to 
copy from isn’t open now in AutoCAD.

 » Open Drawings: Shows the drawings that are open in AutoCAD. Use this tab 
(it’s current in Figure 9-12) to copy named objects between open drawings.

 » History: Shows drawings that you’ve recently browsed in DesignCenter. 
Use this tab to jump quickly to drawings that you’ve used recently on the 
Folders tab.

Tabs

Tree view pane Content pane

FIGURE 9-12:  
The AutoCAD 
DesignCenter 

palette.



164     PART 2  Let There Be Lines

The toolbar buttons further refine what you see in the tree view and content panes. 
A few of these buttons toggle different parts of the panes.

A detailed description is beyond the scope of this book, but the bottom line is that 
you can drag and drop the specifications of named objects from one drawing into 
another. This can be handy at times, but it must be used with care. In particular, 
if your company or client has defined standards, they should be set up in a tem-
plate file (see Chapter 4). A danger of copying from an existing drawing is that the 
standards may have been revised over time, and you might not be copying from 
the latest version.
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IN THIS CHAPTER

Using command-first editing

Selecting objects with maximum 
flexibility

Editing with grips

Grabbing Onto 
Object Selection

Editing objects is the flip side of creating them, and in AutoCAD, you usually 
spend more time editing than drawing objects from scratch. That’s partly 
because the design and drafting process is, by its nature, subject to changes, 

and also because AutoCAD lets you easily edit objects cleanly.

Creating an object and then editing it can also be faster than doing it correctly the 
first time. In particular, placing a circle and then breaking or trimming it is often 
faster than fighting your way through all the Arc command’s options.

Specifying precise locations and distances is as vital to editing objects in AutoCAD 
as it is to creating them. Become familiar with the precision techniques described 
in Chapter 8 before you apply the editing techniques described in this chapter to 
drawings.

Chapter 10
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Commanding and Selecting
AutoCAD offers three styles of editing:

 » Command-first

 » Selection-first

 » Direct-object (grip)

AutoCAD refers to command-first editing as verb-noun editing and to selection-
first editing as noun-verb editing. When you see this terminology in the Options 
dialog box or the online Help system, for example, don’t worry — you haven’t 
dropped back into fifth grade English class!

Command-first editing
In command-first editing, you start a command and then select the objects on 
which the command works. This method is also the only way to use certain editing 
commands (such as Fillet and BReak). It’s no surprise that command-first editing 
is the traditional editing style in AutoCAD, and the one you should be the most 
comfortable using.

Selection-first editing
In selection-first editing, you perform the same steps — in the same order — as in 
most Windows applications: Select the object first, and then choose the command. 
Some people claim that selection-first editing tends to be easier to master and 
makes AutoCAD more approachable if you’re a new or an occasional user.

Direct-object manipulation
In direct-object manipulation, you perform common editing operations by using the 
mouse to grab the selected object and perform an action on it, such as moving all 
or part of it to a different place in the drawing. No named command is involved; 
the act of moving the mouse and clicking the mouse buttons in certain ways com-
pletes the editing changes. AutoCAD supports direct-object manipulation via the 
powerful technique called grip-editing. Grips are the little square, rectangular, or 
triangular handles that appear on an object when you select it. You can use grips 
to stretch, move, copy, rotate, scale, or otherwise edit the object. I discuss grip-
editing in Chapter 11.
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Choosing an editing style
This book emphasizes command-first editing, but I also discuss grip-editing 
in Chapter  11. AutoCAD, in its heart of hearts, is a command-first program. In 
fact, it started out offering only command-first editing and later added selection-
first methods; current releases of AutoCAD inherit this ancestral trait. I stress 
 command-first editing for these reasons:

 » Longevity: It’s the oldest editing style in AutoCAD, and the one with which 
experienced AutoCAD users are most familiar.

 » Naturalness: Would you say, “I want to eat my lunch”? or “My lunch I want to 
eat”? Okay, so Yoda might say, “Eat my lunch I want to!”

 » Consistency: It works consistently with all editing commands — some editing 
commands remain command-first only.

 » Flexibility: It provides added object selection flexibility, which is useful when 
you work on complicated, busy drawings.

After you know how to do command-first editing, you can simply reverse the 
order of many editing operations to perform them in selection-first style instead. 
But if you don’t become familiar with command-first editing in the beginning, 
you’ll be bewildered by a few useful AutoCAD commands that work only in the 
command-first style; commands such as these ignore any already selected objects 
and prompt you to select objects before you can continue.

Much of the information in the rest of this book assumes that you’re using the 
default AutoCAD selection settings. If you find that object selection or grip-editing 
is working differently from the way it’s described in this chapter, click the Appli-
cation button, click Options from the bottom of the Application menu to open the 
Options dialog box, and then check the settings on the Selection tab. The follow-
ing check box settings should be selected (as shown in Figure 10-1), and all other 
check box settings should be deselected:

 » Noun/Verb Selection

 » Object Grouping

 » Implied Windowing

 » Allow press and drag for Lasso

 » Show Grips

 » Show Grip Tips

 » Show Dynamic Grip Menu
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 » Allow Ctrl+Cycling Behavior

 » Show Single Grip on Groups

 » Show Bounding Box on Groups

 » Selection Preview when a Command Is Active

 » Selection Preview when No Command Is Active

 » Command Preview

 » Property Preview

For information on what these options do, hover the mouse pointer over an option 
to display a tooltip with information from the online help system.

Selecting Objects
Part of AutoCAD’s editing flexibility comes from its object-selection flexibility. 
For example, command-first editing offers 16 selection modes! I describe the 
most useful ones in this chapter. Don’t worry, though: You can squeak by most of 
the time using only three selection modes, each of which I describe in this section:

 » Select a single object by picking it.

 » Select multiple objects by enclosing them in a window selection box or polygon.

FIGURE 10-1:  
Setting  

selection 
options in 

the Options  
dialog box.
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 » Select multiple objects by enclosing them in a crossing selection box or 
polygon.

One-by-one selection
The most obvious way to select objects is to pick (by clicking) them one at a time. 
Objects (even just one) that are selected and ready for editing are called a selection 
set. You can build a selection set cumulatively by using this pick-one-object-at- 
a-time selection mode, but this cumulative convention may be different from the 
one you’re used to. In most Windows programs, if you select one object and then 
another, the first object is deselected, and the second one is selected; only the object 
you select last remains selected. In AutoCAD, all objects you select, one at a time, 
remain selected and are added to the selection set, no matter how many objects 
you pick. Most editing commands affect the entire group of selected objects.

Selection boxes left and right
Selecting objects one at a time works well when you want to edit a small number 
of objects, but many CAD editing tasks involve editing lots of objects. Do you really 
want to pick 132 lines, arcs, and circles, one at a time? Okay, maybe you do if you’re 
paid by the hour, but after a while your company won’t be able to afford you.

Like most Windows graphics programs, AutoCAD provides a selection window fea-
ture for grabbing a bunch of objects in a rectangular area. As you may guess, the 
AutoCAD version of this feature is a bit more powerful than the similar feature in 
other Windows graphics programs. AutoCAD calls its version implied windowing. 
Here’s how you use it:

 » Window object selection: When you click a blank area of the drawing (not on 
an object), you’re indicating that you want to specify a selection by dragging a 
window around the objects. If you move the cursor to the right before picking 
the next corner of the selection area, you’re further implying that you want to 
select all objects that reside completely within the selection area.

 » Crossing object selection: When you click a blank area of the drawing (not on 
an object), you’re indicating that you want to specify a selection by dragging 
a window around and through the objects. If you move the cursor to the left 
before picking the next corner of the selection area, you’re indicating that you 
want to select all objects that reside completely within or touch or cross the 
selection area boundary.

Fortunately, AutoCAD gives you visual cues that there’s a difference. As you move 
to the right, the window area appears as a rectangular or polygonal area with a 
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blue fill and a solid border. As you move to the left, the crossing area appears as a 
rectangle or polygon with green fill and a dashed border.

If your editing method of preference is selection-first, AutoCAD gives you the 
option to drag a polygonal window or crossing area or to simply drag a series of 
lines through the objects you want to select. Simply click a point and then type 
the appropriate alias at the command line to initiate the Fence, WPolygon, or 
CPolygon option.

Figures  10-2 and 10-3 show a window box and a crossing box, respectively, in 
action.

Tying up object selection
AutoCAD 2015 added another selection mode called lasso. As with the other modes, 
lasso isn’t a specific command but is initiated based on how you manipulate the 
mouse. The window modes are initiated when you click two different points. To 
initiate lassoing, on the other hand, move the mouse to a desired starting point, 
and then press and hold down the left mouse button. Continue to hold down 
the left mouse button as you move the cursor, creating a lasso trail around and 
among drawing objects. When you release the left button, the trail automatically 
closes itself back to the start point, the trail disappears, and all the lassoed objects 
become selected.

Pick point 2

Selection box

Pick point 1

FIGURE 10-2:  
A window 

selection box, 
drawn from 
left to right, 
selects only 

the two objects 
(the two  

vertical lines) 
that are  

completely 
within the box.
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After you initiate lassoing, your first mouse movement dictates whether the lasso 
is a crossing lasso or a window lasso. If your first movement is to the right, it’s a 
window lasso. If your first mouse movement is to the left, it’s a crossing lasso.

You can mix and match, selecting individual objects, specifying a window box, 
specifying a crossing box, and lassoing. Each selection adds to the current selec-
tion set, allowing you to build an enormously complicated selection of objects and 
then operate on them with one or more editing commands.

You can press Shift in combination with any of the four standard selection 
modes — single object, window area, crossing are, and lasso — to remove already 
selected objects from the selection set. This feature is especially useful when 
you’re building a selection set in a crowded drawing; you can select a big batch of 
objects by using Window or Crossing and then holding down Shift while selecting 
to remove the objects that you want to exclude from the editing operation. You can 
carve a statue of an elephant the same way by starting with a big block of marble 
and cutting off anything that doesn’t look like an elephant.

Perfecting Selecting
When you edit in command-first mode, you have all the selection options described 
in the earlier section “Selecting Objects” — single object, window box, window 
polygon, crossing polygon, and crossing box — plus a slew of others. If you type ? 

Pick point 2

Selection box

Pick point 1

FIGURE 10-3:  
A crossing 

selection 
box, drawn 

from right to 
left, selects 

11 objects that 
are completely 

or partially 
within the box.
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and press Enter at any Select objects prompt, AutoCAD lists all the selection 
options at the command line:

Window/Last/Crossing/BOX/ALL/Fence/WPolygon/CPolygon/Group/Add/
Remove/Multiple/Previous/Undo/AUto/SIngle/SUbobject/Object

Table 10-1 summarizes the most useful command-first selection options.

To use any command-first selection options at the Select objects prompt, type 
the uppercase letters (see Table 10-1) that correspond to the option you want, and 
then press Enter. Select the objects, and press Enter again to tell AutoCAD that you 
finished selecting objects and you want to start the editing operation.

After you finish selecting objects, you must press Enter to tell AutoCAD that you 
want to start the editing operation. Say . . . is there an echo in here? As a matter of 
fact, I am repeating myself. Many new AutoCAD users find it difficult to remember 
the necessity of pressing Enter after they finish selecting objects.

The selection preview features in AutoCAD remove a lot of doubt about which 
objects you’re selecting. Rollover highlighting displays individual objects with a 
thick, dashed lineweight as you move the cursor over them. Area selection displays 
a transparent, colored highlight over multiple selections when you use Window 
and Crossing options.

TABLE 10-1 Useful Command-First Selection Options
Option Objects That It Selects

Window All objects completely within a rectangular area that you specify by picking two points

Crossing All objects within, crossing, or touching a rectangular area that you specify by picking two 
points

WPolygon All objects completely within a polygonal area whose corners you specify by picking points

CPolygon All objects within, crossing, or touching a polygonal area whose corners you specify by 
picking points

Fence All objects touching an imaginary polyline whose vertices you specify by picking points

Last The last object you drew (whether or not it’s visible in the display)

Previous The previous selection set that you specified

ALL All objects on layers that aren’t frozen or locked and that are in the current space (model 
space or paper space), including objects that aren’t displayed because you’ve zoomed in
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The following steps show you how to use the Erase command in command-first 
mode with several different selection options. The selection techniques used in 
this example apply to most AutoCAD editing commands:

1. Open a drawing that contains objects, or start a new drawing and create 
lines, arcs, or circles.

Don’t be too particular in drawing them because you blow them away in this 
step list.

2. Press Esc to make sure that no command is active and no objects are 
selected.

If any objects are selected when you start an editing command, the command, 
in most cases, operates on those objects (selection-first editing) instead of 
prompting you to select objects (command-first editing). For the reasons 
I describe in the section “Commanding and Selecting” earlier in this chapter, 
I recommend using the command-first editing style until you’re thoroughly 
familiar with it. Later, you can experiment with selection-first editing, if you like. 
Just reverse the sequence of commanding and selecting.

3.  Click the Erase button in the Modify panel on the Home tab.

AutoCAD displays the Select objects prompt at the command line, and 
if dynamic input is enabled on the status bar, the Dynamic Input tooltip.

4. Select two or three individual objects by clicking each one.

AutoCAD adds each object to the selection set. All the objects you select 
remain highlighted, and AutoCAD continues to display the Select objects 
prompt.

5. Specify a window selection box that completely encloses several objects.

Move the cursor to a point below and to the left of the objects, click, release 
the mouse button, move the cursor above and to the right of the objects, and 
click again.

All objects that are completely within the box are selected.

6. Specify a crossing selection box that completely encloses a few objects and 
cuts through several others.

Move the cursor to a point below and to the right of some objects, click, release 
the mouse button, move the cursor above and to the left of some of the 
objects, and click and release again.

All objects that are completely within, crossing through, or touching the box 
are selected. AutoCAD continues to display the Select objects prompt.
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7. Type WP and press Enter to activate the WPolygon (Window Polygon) selec-
tion option.

AutoCAD prompts you to pick points that define the selection polygon.

8. Pick a series of points and press Enter.

Figure 10-4 shows an example. After you press Enter, AutoCAD selects all 
objects that are completely within the polygon. AutoCAD continues to display 
the Select objects prompt until you press Enter.

9. Press Enter to end object selection.

AutoCAD erases all selected objects and returns to an empty command 
prompt.

Did you notice how you can use a combination of object selection methods to 
build a selection set and then press Enter to execute the command on the selected 
objects? Most AutoCAD editing commands work this way in command-first mode.

If after erasing a selection set, you immediately realize that you didn’t mean to 
do away with so many objects, click the Undo command or button on the Quick 
Access toolbar to restore them all. But AutoCAD has one additional unerase trick 
up its sleeve — the aptly named OOPS command. When you type OOPS and press 
Enter, AutoCAD restores the last selection set that you erased — even if you’ve run 
other commands after Erase.

The Erase command isn’t the only way to remove unwanted objects from the 
drawing. The easiest method in any workspace is to simply select an item and 
press the Delete key on the keyboard.

FIGURE 10-4:  
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Drawing objects on top of other objects is all too easy, and after you’ve done so, it’s 
pretty well impossible to recognize that there are multiples so that you can weed 
out the ones you don’t want. In certain earlier releases, holding down the Shift 
key and the spacebar together while clicking suspected multiple objects highlights 
them, one after the other; when the one you’re after lights up, you pressed Enter 
to select it. AutoCAD 2011 introduced a more powerful selection cycling method: 
When Selection Cycling is enabled on the status bar, AutoCAD displays a blue, 
overlapping-rectangles icon if it detects multiple objects under the cursor. When 
you pick an object with this icon displayed, AutoCAD opens a Selection dialog box 
where you can choose the object you want.

AutoCAD Groupies
AutoCAD lets you select a bunch of objects and gather them into a group so that 
when you click one object, everything in the group is selected. You simply select 
objects and click Group on the Groups panel of the Home tab. If you want, you can 
name the group as you create it. The buttons on the main Groups panel let you 
create new groups, toggle group selection off and on, edit groups by adding or 
removing individual objects, or permanently ungroup a selected group.

Object Selection: Now You See It . . .
The many object-selection modes that I describe in earlier sections — and some 
that I don’t even describe, such as the FIlter command (check out the online Help 
system for more on that topic) — are useful as far as they go.

AutoCAD lets you control the visibility of individual objects, which is a big deal. 
Before AutoCAD 2011, the only way to control the display of objects was to turn 
off or freeze the layer on which they resided. If the layer held other objects that 
you did want to see — too bad. These three commands turn this limitation into 
ancient history:

 » HIDEOBJECTS: Prompts you to select the objects that you want to make tem-
porarily disappear

 » ISOLATEobjects: Prompts you to select the objects that you want to see while 
temporarily making everything else disappear

 » UNISOLATEobjects: Ends the hiding and isolating of objects
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The primary method of invoking these commands is via the right-click menu. 
Using either command-first or selection-first editing as described in the section 
“Commanding and Selecting,” earlier in this chapter, simply right-click and you 
see the Isolate item, shown in Figure 10-5. A status bar icon — a lightbulb at the 
lower-right corner of the display — is dimmed when objects are either hidden 
or isolated. Click this icon to open a menu that lets you turn off the hiding or 
isolating.

If you’re worried about the possible implications of this concept (“Hmm. I was 
sure I added those center lines. Do I need to add them again?”), relax. Hiding and 
isolating objects is temporary — it lasts only as long as the current drawing ses-
sion. If you end a drawing with objects isolated or hidden, they reappear when you 
reopen the file.

Rumor has it that the Autodesk programmers stole this cloaking-and-uncloaking 
concept from the Romulans.

FIGURE 10-5:  
Making 
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IN THIS CHAPTER

Moving, copying, and stretching 
objects

Manipulating whole objects

Changing pieces of objects

Fixing your mistakes — oops, I mean 
changing your mind

Grip editing

Edit for Credit

In Chapter 10, you can see that AutoCAD offers several methods of modifying 
drawing objects. You can see how to select those objects in the first place so that 
you can then edit them. Now it’s time to roll up your sleeves and get dirty. In 

this chapter, I introduce the primary edit commands in AutoCAD.

The following sections cover the most important AutoCAD editing commands, 
using command-first editing mode.

As I explain in Chapter  10, command-first editing (or verb-noun editing, in 
AutoCAD-ese) is one of three different approaches to modifying objects in Auto-
CAD. I concentrate on this method, where you start a command and then pick the 
objects on which the command will act, because it’s the only method that works 
for every editing command in AutoCAD.

Assembling Your AutoCAD Toolkit
Table 11-1 lists AutoCAD’s most frequently used editing commands. It shows the 
tool icons found on the Ribbon and it specifies the official command names with 
their corresponding aliases where they exist, in case you prefer typing over click-
ing. Ribbon buttons are found on the Home tab’s Modify panel in the Drafting & 
Annotation workspace.

Chapter 11
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TABLE 11-1 AutoCAD’s Modify Commands
Button Command 

-ARRAY (-AR)

ARRAYEDIT

ARRAYPATH

ARRAYPOLAR

ARRAYRECT

BLEND

BREAK (BR); one point

BREAK (BR); two points

CHAMFER (CHA)

COPY (CO or CP)

ERASE (E)

EXPLODE (X)

EXTEND (EX)

FILLET (F)

Button Command 

-ARRAY (-AR)

JOIN (J)

LENGTHEN (LEN)

MIRROR (MI)

MOVE (M)

OFFSET (O)

OVERKILL

PEDIT (PE)

REVERSE

ROTATE (RO)

SCALE (SC)

STRETCH (S)

TRIM (TR)

The ARray command underwent such a massive revision in AutoCAD 2012 that it 
hardly still qualifies as a Modify command. I cover the associative array feature 
in Chapter 18. However, I think that there’s still a need for simple arrays (that is, 
copies of objects in regular patterns), so I explain in this chapter how to create 
those. In addition, you will probably run into a great many existing drawings that 
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were produced using the older process. The icons of the four Array commands 
shown in Table  11-1 run the new associative array commands that I cover in  
Chapter 18; I include them here because they’re still grouped with the other Mod-
ify commands on the Ribbon.

No matter how you start an editing command, in almost all cases AutoCAD 
prompts you for object selection, points, distances, and options at the command 
line. Read the prompts during every step of the command, especially when you’re 
figuring out how to use a new editing command. When all else fails, read the com-
mand line!

As I describe in Chapter 8, maintaining precision when you draw and edit is crucial 
to good CAD work. Nothing ruins a drawing faster than eyeball editing, in which 
you shove objects around without worrying about precise distances and points.

Users of Windows Paint and other bitmap drawing programs may be familiar with 
the concept of nudging — selecting objects and using the arrow keys to move them 
a certain number of pixels horizontally or vertically. For better or worse, AutoCAD 
has joined the nudging party. You can move an object a pixel’s-worth this way or 
that way by holding down the Ctrl key and pressing an arrow key. When work-
ing with AutoCAD, you should always use tried-and-true precision drafting tech-
niques; moving objects by the pixel instead of by real-world units is the opposite of 
precise. You can move a piece of text by nudging it, but never move actual drawing 
geometry that way.

The Big Three: Move, COpy, and Stretch
Moving, copying, and stretching are, for many drafters, the three most common 
editing operations. AutoCAD obliges this need by supplying the Move, COpy, and 
Stretch commands.

Base points and displacements
The Move, COpy, and Stretch commands all require that you specify how far, and 
in what direction, you want objects to be moved, copied, or stretched. After you 
start the command and have selected objects to be edited, AutoCAD prompts you 
for these two pieces of information:

Specify base point or [Displacement] <Displacement>:

Specify second point or <use first point as displacement>:
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For the first prompt, you pick a point.

In a subtle way, the second prompt says that you have two possible methods to 
specify how far and in what direction you want the objects to be copied, moved, 
or stretched:

 » Pick or type the coordinates of a second point. AutoCAD calls the first point 
the base point and calls the second point the, uh, the second point. Imagine an 
arrow pointing from the base point to the second point — the arrow defines 
how far, and in what direction, the objects are copied, moved, or stretched.

 » Supply an X,Y pair of numbers that represents a distance rather than 
a point. This distance is the absolute displacement that you want to copy, 
move, or stretch the objects.

How does AutoCAD know whether your response to the first prompt is a base point 
or a displacement? It depends on how you respond to the second prompt. First, 
pick a point onscreen or enter coordinates at the Base point prompt. Next, there 
are two possibilities:

 » If you then pick or type the coordinates of a point at the second point 
prompt: AutoCAD says, “A-ha! — displacement vector,” and moves the 
objects according to the imaginary arrow pointing from the base point to the 
second point.

 » If you press Enter at the second prompt (without having supplied any 
information): AutoCAD says, “A-ha! — displacement distance,” and uses 
the X,Y pair of numbers that you supplied at the first prompt as an absolute 
displacement distance.

What makes this displacement business interesting is that AutoCAD lets you pick a 
point at the first prompt and then press Enter at the second prompt. AutoCAD still 
says, “A-ha! — displacement distance,” but now it treats the coordinates of the 
point you picked as an absolute distance relative to the drawing’s origin. If the point 
you picked has relatively large coordinates, you had better hope that the selected 
objects are wearing their thermal underwear because they’ll end up somewhere 
northeast of Greenland. You probably won’t see where they’ve gone  — you’ve 
zoomed into part of the normal drawing area, so the objects seem to have vanished!

When you give the Move, COpy, or Stretch command, press Enter in response 
to the second prompt only if you want AutoCAD to use your response to the first 
prompt as an absolute displacement. If you make a mistake, click Undo or press 
Ctrl+Z to back up and try again. You can use the Zoom All command (described in 
Chapter 5) to look for objects that have flown off the screen.
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Move
The steps in this section demonstrate command-first editing with the Move com-
mand, using the base point/second point method of indicating how far and in 
what direction to move the selected objects. Follow these steps to use precision 
techniques when you use the Move command:

1. Press Esc to make sure that no command is active and no objects 
are selected.

2. Click the Move button on the Modify panel of the Home tab.

The command line displays the Select objects prompt.

3. Select at least one object.

You can use any of the object selection techniques described in Chapter 10.

4. Press Enter when you finish selecting objects.

AutoCAD displays the following prompt:

Specify base point or [Displacement] <Displacement>:

5. Specify a base point by clicking a point or typing coordinates.

This point serves as the tail end of the imaginary arrow that indicates how far 
and in what direction you want the objects to move. After you pick a base 
point, it’s fairly easy to see what’s going on because AutoCAD displays a 
temporary image of the object that moves around as you move the cursor. 
Figure 11-1 shows what the screen looks like.

Specify a base point somewhere on or near the object(s) that you’re moving. 
You can (and most of the time should) use an object snap mode to choose a 
point exactly on one of the objects.

AutoCAD displays the following prompt:

Specify second point or <use first point as displacement>:

FIGURE 11-1:  
Dragging 

objects in  
the middle of 

the Move  
command.
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6. Specify the second point by clicking a point or typing coordinates.

The second point serves as the arrow end of the imaginary displacement 
arrow. After you specify the second point, AutoCAD moves the objects.

Press Enter in response to the second prompt only if you want AutoCAD to use 
your response to the first prompt as an absolute displacement.

AutoCAD has two common precision techniques for specifying the second point:

 » Use an object snap mode to pick a second point exactly on another object in 
the drawing.

 » Use direct distance entry to move objects in an orthogonal or polar-tracking 
direction. See Chapters 6 and 8 for instructions.

The following steps demonstrate command-first editing with the Move com-
mand, using the distance method to indicate how far and in what direction to 
move selected objects:

1. Repeat Steps 1–4 in the preceding step list.

2. When AutoCAD displays the Specify base point... prompt, specify a 
direction and distance by typing the appropriate values:

• Enter 6,2, for example, to move selected objects 6 units to the right and 2 
units up.

• Enter 3<45, for example, to move selected objects 3 units at an angle of 45 
degrees counterclockwise from the east (3 o’clock).

3. Press Enter to complete the move.

COpy
The COpy command works almost identically to the Move command except that 
AutoCAD leaves the selected objects in place and makes new copies of them in the 
new location.

The COpy command creates multiple copies by default. If you want only one copy, 
press Enter after placing the first copy in the drawing. Choosing mOde at the com-
mand prompt or the Dynamic Input options list lets you switch between making 
a single copy and multiple copies. If you mostly make multiple copies or mostly 
make single copies, you’ll appreciate being able to change the default setting.
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The COpy command includes an Array option. In addition to plunking down copied 
objects just about anywhere, type A to choose the Array option and specify spac-
ing for an evenly laid-out linear array. That’s good if you want only a single row 
of copies, but using the -ARray command (which I describe later in this chapter 
and in Chapter 18) is required to create rows and columns or circular patterns of 
copied objects.

The COpy command includes the Undo option, with which you can roll back mul-
tiple copies within a single COpy operation.

Copy between drawings
You can’t copy or move objects from one drawing to another by using the COpy 
command or by simply dragging from one drawing to another. Instead, you use 
the COPYCLIP or CUTCLIP commands together with their companion command, 
PASTECLIP.

COPYCLIP, CUTCLIP, and PASTECLIP use the Windows Clipboard to temporarily 
store drawing objects from one file so that they can be pasted into another file. 
The Clipboard panel on the Ribbon contains Cut, Copy, and Paste tools — the three 
standard Clipboard buttons you find in every Windows program.

As you’re figuring out where commands lurk on the AutoCAD Ribbon, the stan-
dard Windows keyboard shortcuts — Ctrl+X (cut), Ctrl+C (copy), and Ctrl+V 
(paste) — are still available and are often the most efficient ways of using the 
Windows Clipboard. Better yet, they even work within a single drawing or between 
drawings. Within certain limitations, you can also Ctrl+X (cut), Ctrl+C (copy), and 
Ctrl+V (paste) between AutoCAD drawings and many other Windows applications, 
although this process may not be the best to use in many situations. I discuss this 
topic a little more in Chapter 24.

AutoCAD has a total of nine Windows Clipboard commands. COPYCLIP, CUTCLIP, 
and PASTECLIP are by far the most useful — and hence the most often used. Of 
the remaining commands, PASTEBLOCK (Ctrl+Shift+V) can sometimes be conve-
nient. It pastes a previous Windows Clipboard selection as a block, which I discuss 
in Chapter  17. A description of the remaining modes, which are rarely used, is 
beyond the scope of this book.

Stretch
The Stretch command is superficially similar to COpy and Move: It has the same 
base point and displacement prompts, and it shifts objects to other locations in 
the drawing. But it also has one important difference: It can move one end of one 
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object or of multiple objects, leaving the other end (or ends) unscathed so that you 
can use it to change the length of lines, for example.

Here are the things you need to know to make Stretch your friend:

 » Select objects to stretch: To use Stretch to change the length of objects, you 
must select the objects by using a crossing selection box or crossing polygon, 
as described in Chapter 10. See Figure 11-2.

 » Define points: Stretch operates on the defining points of objects (endpoints 
of a line, vertices of a polyline, and the center of a circle, for example) accord-
ing to this rule:

If a defining point is within the crossing selection box that you specify, 
AutoCAD moves the defining point and updates the object accordingly.

For example, if the crossing selection box surrounds one endpoint of a line 
but not the other, Stretch moves the selected endpoint and redraws the line 
in the new position dictated by the selected endpoint’s new location. It’s as 
though a rubber band is tacked to the wall with two pins and you move one of 
the pins.

 » Compress and stretch: Stretch can make lines longer or shorter, depending 
on the crossing selection box and displacement vector. In other words, the 
Stretch command combines stretching and compressing.

 » Get in the mode: Depending on what you’re trying to accomplish, you may 
want to turn on Ortho mode (F8) or Polar Tracking (F10) mode before stretch-
ing. Figure 11-3 shows the results of an Ortho stretch and a non-Ortho stretch.

FIGURE 11-2:  
Use a  crossing 

selection 
box to select 

objects for 
stretching.
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Follow these steps to stretch some lines:

1. Draw some lines.

Start stretching with simple objects, as shown in Figure 11-4. You can work 
your way up to more complicated objects, such as polylines and arcs, after you 
limber up with lines.

2. Press Esc to make sure that no command is active and no objects are 
selected.

3. Click the Stretch button in the Modify panel of the Ribbon’s Home tab to 
start the Stretch command.

FIGURE 11-3:  
The hazards of 
stretching with 

Ortho mode 
and Polar 

Tracking mode 
turned off.

FIGURE 11-4:  
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the Stretch  
command.
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The command line displays the Select objects prompt with a reminder to 
use the Crossing or CPolygon object-selection mode:

Select objects to stretch by crossing-window or crossing-
polygon...

Select objects:

4. Pick points to specify a crossing selection box that encloses some, but not all, 
endpoints of the lines.

Figure 11-4 shows a sample crossing selection box that completely encloses 
the two vertical lines on the right side of the figure. This crossing selection box 
cuts through the four horizontal lines, enclosing only one endpoint apiece.

You specify a crossing selection box by picking a point, moving the mouse to 
the left, and picking a second point.

5. Press Enter to end the object selection.

AutoCAD displays the following prompt:

Specify base point or [Displacement] <Displacement>:

6. Specify a base point by object snapping to a point on an existing object or by 
typing absolute X,Y coordinates.

AutoCAD displays the following prompt:

Specify second point or <use first point as displacement>:

Toggle Ortho mode on and then off by clicking the Ortho Mode button on the 
status bar or by pressing F8; move the cursor around first with Ortho mode 
turned on and then off to see the difference. Refer to Figure 11-3.

Figure 11-4 shows what the screen looks like as you move the cursor around 
without the benefit of Ortho mode or Polar Tracking mode.

7. Toggle Ortho (F3) mode on (if it isn’t on already), and then specify the second 
point — usually, by using direct distance entry.

You can also specify the second point by object snapping to a point on an 
existing object or by typing relative X,Y coordinates.

After you pick the second point, AutoCAD stretches the objects. Notice that the 
Stretch command moved the two vertical lines because the crossing selection 
box contained both endpoints of both lines. Stretch lengthened or shortened 
the four horizontal lines because the crossing selection box enclosed only one 
endpoint apiece.
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Here are some additional tips for using the Stretch command:

 » Practice makes perfect. Using the Stretch command effectively takes some 
practice, but it’s worth the effort. You can stretch with different crossing selec-
tion box locations as well as different base points and second points.

 » Don’t try to stretch text. Create a line of text (I cover text in Chapter 13) that 
contains the two words The Truth. Start the Stretch command, and specify 
a crossing selection window that starts to the right of the text and ends up 
passing between the two words. When you finish the command, observe that 
although you can stretch a great deal in AutoCAD, you can’t stretch The Truth. 
Text doesn’t stretch, but it moves, if its insertion point falls within the crossing 
window.

 » Use a crossing-polygon selection instead of a crossing-window selec-
tion. The Stretch command prompt says Select objects to stretch by 
crossing-window or crossing-polygon, but picking points doesn’t give 
you the crossing-polygon option. See Chapter 10 for information on crossing-
polygon selection. To use a crossing-polygon selection, type CP at the Select 
objects prompt and press Enter.

 » Use multiple windows to move objects. You can use more than one cross-
ing window within a single run of the Stretch command, and you can select 
objects that are outside a crossing window to have them move when other 
objects that cross the selection window(s) are stretched. The only objects 
that change their size are stretchable objects crossed by a crossing window or 
polygon.

More Manipulations
The commands in this section — MIrror, ROtate, SCale, ARray, and Offset — 
provide ways other than the Move, COpy, and Stretch commands to manipulate 
objects or create new versions of them. To use these commands, you need to be 
familiar with the techniques for object selection and precision editing for the 
Move, COpy, and Stretch commands. See Chapter 8 to find out about object selec-
tion and precision editing, and see the discussion earlier in this chapter about 
Move, COpy, and Stretch.

Mirror, mirror on the monitor
The MIrror command creates a reverse copy of an object. After you select some 
objects, AutoCAD prompts you to select two points that define a line about which 
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the objects will be mirrored. You can then retain or delete the source objects. 
 Follow these steps to use the MIrror command:

1. Press Esc to make sure that no command is active and no objects 
are selected.

2. Click the Mirror button on the Home tab’s Modify panel, or enter MI and 
press Enter.

3. Select at least one object, and press Enter to end the object selection.

AutoCAD prompts you to define the mirror line by picking points:

Specify first point of mirror line:

4. Specify the start of the mirror line by clicking a point or typing coordinates.

AutoCAD prompts you:

Specify second point of mirror line:

5. Pick a second point.

Most of the time, you’ll enable Polar Tracking mode or Ortho mode so that you 
can mirror objects precisely. You can also use object snaps on existing objects, 
including ones being mirrored, which ensure exact symmetry between the 
source and the mirrored objects. AutoCAD now prompts you:

Erase source objects? [Yes/No] <N>:

6. Finish the mirror by using one of these options:

• Type Y at the final prompt. The source objects disappear, leaving only the 
new, mirrored copy.

• Accept the default No option. The source objects are retained along with the 
mirrored copies.

Normally, when you mirror text or dimensions, the words read backward. The 
system variable MIRRTEXT can handle this little problem. By default, MIRRTEXT 
is turned off (that is, its value is 0), so the text itself still reads the right way 
around after the objects are mirrored. If you really want your drawing text to 
appear in reverse, change the value of MIRRTEXT to 1. I cover system variables in 
a little more detail in Chapter 23.
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ROtate
The ROtate command pivots objects around a point that you specify. Follow these 
steps to use the ROtate command:

1. Press Esc to make sure that no command is active and no objects 
are selected.

2. Click the Rotate button on the Home tab’s Modify panel, or enter RO and 
press Enter.

3. Select one or more objects and then press Enter to end object selection.

AutoCAD prompts you for the base point for rotating the selected objects:

Specify base point:

4. Specify a base point by clicking a point or typing coordinates.

The base point becomes the point around which AutoCAD rotates the objects. 
You also have to specify a rotation angle:

Specify rotation angle or [Copy/Reference] <0>:

5. Specify a rotation angle by one of these methods:

• Type an angle measurement and press Enter.

• Press Enter to accept the default value shown in angle brackets (which is the 
last-used value).

• Click a point onscreen.

• Enter R to specify a Reference angle.

Alternatively, you can indicate an angle on the screen by moving the cursor 
until the Coordinates section of the status bar indicates the desired angle and 
then clicking. If you choose this alternative, use Ortho (F3) mode or Polar 
Tracking (F10) mode to indicate a precise angle (for example, 90 or 45 degrees) 
or an object snap to rotate an object so that it aligns precisely with other 
objects.

Positive angle values rotate objects counterclockwise (counter to what you 
might expect), and negative values rotate them clockwise. For example, 
entering 270 degrees or –90 degrees produces the same result, making objects 
point down.

After you specify the rotation angle by typing or picking, AutoCAD rotates the 
objects into their new positions. The ROtate command’s Copy option makes a 
rotated copy while leaving the source object in place.
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The Reference option can seem a little confusing, but it is actually simple. A 
typical use for this option is when you want to rotate one or more objects so 
that they are parallel to an existing object.

The first three steps are the same as what you just did, but enter R when you 
get to Step 4. The command line now asks you to specify the reference angle. 
Pick two points, usually on the object or objects that you want to rotate. 
AutoCAD suggests an angle that is the last one you used. Now for the slightly 
tricky part. By default, angles are defined counter-clockwise from the X-axis 
(east). If you want to align the objects with some other angle, enter P for Points 
and then define two points. The objects then rotate so that the angle from the 
X-axis defined by the first two points matches the angle from the X-axis 
defined by the second two points.

SCale
If you’ve read all my harping about drawing scales and scale factors in Chapter 4, 
you may think that the SCale command performs magical drawing-scale setup on 
an entire drawing. No such luck, nor does it have anything to do with ladders or 
fish. The SCale command uniformly scales — enlarges or reduces — objects up or 
down by a factor that you specify. Here’s how it works:

1. Press Esc to make sure that no command is active and no objects 
are selected.

2. Click the Scale button on the Home tab’s Modify panel, or enter SC and 
press Enter.

3. Select at least one object, and press Enter to end the object selection.

AutoCAD prompts you for the base point from which it will scale all selected 
objects:

Specify base point:

4. Specify a base point by picking a point or typing coordinates.

AutoCAD now prompts you for the scale factor:

Specify scale factor or [Copy/Reference] <1.0000>:

Don’t assume that AutoCAD will scale the objects but leave them more or less 
where they are in the drawing. AutoCAD scales the distance between objects as 
well as the objects themselves. For example, if you select a circle to scale, pick a 
point outside the circle as the base point and then specify a scale factor of 2. 
AutoCAD not only makes the circle twice as big but also moves the circle twice 
as far away from the base point that you specified. To make a circle bigger but 
leave it where it’s located, use the CENter object snap to select its center point 
as the base point of the scale operation.
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5. Type a scale factor and press Enter.

AutoCAD scales the objects by the factor that you type, using the base point 
that you specified. Numbers greater than 1 increase the objects’ sizes; num-
bers smaller than 1 but greater than 0 decrease the objects’ sizes. Negative 
scale factors are invalid.

Just like the ROtate command, SCale has a Copy option with which you can make 
enlarged or reduced duplicates of selected objects without altering the source 
objects. And throughout the drawing session, both SCale and ROtate remember 
the last scale factor or rotation angle that was entered.

-ARray
The -ARray command is a supercharged COpy command. You use it to create a 
rectangular grid of objects at regular X and Y spacings or a radial arrangement of 
objects around a center point at a regular angular spacing. For example, you can 
use rectangular arrays to populate an auditorium with chairs or use a polar array 
to populate a bicycle wheel with spokes.

The kind of array I describe in this chapter is the old-style — but still very 
 useful  — non-associative array. I cover the new-style array in Chapter  18.  
Non-associative arrays are simply copies of the source object; they dwell on the 
same layers as their source, and they can be edited individually, even in older 
releases of AutoCAD.

The following steps describe how to create a rectangular array, which you’ll prob-
ably do more often than you create a polar array:

1. Press Esc to make sure that no command is active and no objects 
are selected.

2. Type -ARray (don’t forget the leading hyphen) and press Enter.

Typing a hyphen in front of an AutoCAD command normally tells the program 
to run the command line prompts rather than a dialog box. Starting with 
AutoCAD 2012, however, typing -ARray (with the leading hyphen) versus typing 
ARray (without the leading hyphen) runs two different commands. The 
difference is that ARray creates associative arrays, whereas -ARray creates 
non-associative ones. I cover associative arrays in Chapter 18.

AutoCAD prompts you to select the objects you want to array.

Select objects:
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3. Select one or more objects; then press Enter.

AutoCAD prompts you to choose the type of array you want:

Enter the type of array [Rectangular/Polar] <R>:

4. Type R and press Enter to create a rectangular array.

AutoCAD prompts you to specify the number of rows and columns you want, 
and the distance between each of them:

Enter the number of rows (---) <1>:

5. Enter a value and press Enter.

AutoCAD asks for the number of columns, the distance between rows, and 
(finally) the distance between columns.

The Rows and Columns numbers include the row and column of the original 
objects themselves. In other words, entries of 1 don’t create any new objects in 
that direction.

6. Enter values for the number of columns, and the distances between adjacent 
rows and columns, and then press Enter.

AutoCAD creates regularly spaced copies of the selected objects in neat rows 
and columns.

To create regularly arrayed objects in rows and columns or arranged around a 
center point, you must use the command line version of -ARray: Type a hyphen 
in front of the command name. Typing ARray without the hyphen creates 
 new-style associative array objects. Associative arrays, covered in Chapter 18, 
are more powerful and versatile, but non-associative arrays may still be 
 adequate for many applications and are found all over pre-2012 drawings.

Offset
You use Offset to create parallel or concentric copies of lines, polylines, circles, 
arcs, or splines. Follow these steps to use Offset:

1. Click the Offset button on the Home tab’s Modify panel, or enter Offset 
and press Enter.

AutoCAD displays the current command settings and prompts you for the 
offset distance — the distance from the original object to the copy you’re 
creating:

Current settings: Erase source=No Layer=Source 
   OFFSETGAPTYPE=0

Specify offset distance or [Through/Erase/Layer] <Through>:
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2. Type an offset distance and press Enter.

Alternatively, you can indicate an offset distance by picking two points on the 
screen. If you choose this method, you should normally use object snaps to 
specify a precise distance from one existing object to another.

AutoCAD prompts you to select the object from which you want to create an 
offset copy:

Select object to offset or [Exit/Undo] <Exit>:

3. Select a single object, such as a line, a polyline, a circle, or an arc.

Note that you can select only one object at a time with the Offset command. 
AutoCAD asks where you want the offset object:

Specify point on side to offset or [Exit/Multiple/Undo]  
  <Exit>:

4. Point to one side or the other of the object and then click.

It doesn’t matter how far away from the object the cursor is when you click. 
You’re simply indicating a direction.

AutoCAD repeats the Select object prompt, in case you want to offset other 
objects by the same distance:

Select object to offset or [Exit/Undo] <Exit>:

5. Repeat Step 3 to offset another object, or press Enter if you’re finished 
offsetting objects.

Figure  11-5 shows the Offset command in progress. For information on the 
 command options — Multiple, Erase, and Layer are all useful options — look up 
OFFSET in the online Help system’s Command Reference section.

FIGURE 11-5:  
Offsetting a 

polyline.
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If you want to offset a series of connected lines, for example a rectangular house 
plan outline or one side of a pathway on a map, either draw it as a polyline or 
convert the individual line or arc segments (or both) into a polyline with the Join 
command. I cover Join later in this chapter. If you draw a series of line segments 
with the Line command and then try to offset the segments, you have to pick each 
segment and offset it individually. Even worse, the corners usually aren’t finished 
in the way you expect, because AutoCAD doesn’t treat the segments as connected. 
You avoid all these problems by offsetting a polyline, which AutoCAD treats as a 
single object. Figure 11-5 shows an offset polyline. See Chapter 6 for more infor-
mation about the differences between lines and polylines.

Slicing, Dicing, and Splicing
TRim, EXtend, BReak, Fillet, CHAmfer, BLEND, and Join are commands that are 
useful for shortening and lengthening objects, for breaking them in two, and for 
putting them back together again.

TRim and EXtend
TRim and EXtend are the twin commands for making lines, polylines, and arcs 
shorter and longer. They’re the yin and yang, the Laurel and Hardy, the Jack Sprat 
and his wife of the AutoCAD editing world. The two commands and their prompts 
are almost identical, so the following steps cover both. I show the prompts for the 
TRim command; the EXtend prompts are similar.

1. Click the Trim or Extend button on the Home tab’s Modify panel.

AutoCAD prompts you to select cutting edges that will do the trimming (or, if 
you choose the EXtend command, boundary edges for extending to):

Current settings: Projection=UCS, Edge=None
Select cutting edges ...
Select objects or <select all>:

2. Press Enter to accept the default option to select all drawing objects, or 
select individual objects by picking them. Press Enter to end the object 
 selection.

The objects you select become the cutting edge of the TRim command or the 
boundary to which objects will be extended by the EXtend command.

Figure 11-6 shows a cutting edge (for TRim) and a boundary edge (for EXtend).
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AutoCAD prompts you to select objects that you want to trim or extend 
(EXtend doesn’t have the eRase option):

Select object to trim or shift-select to extend or  
    [Fence/Crossing/Project/Edge/eRase/Undo]:

3. Select a single object to trim or extend. Choose the portion of the object that 
you want AutoCAD to trim away or the end of the object that’s closer to the 
extend-to boundary.

AutoCAD trims or extends the object to one of the objects that you selected in 
Step 2. If AutoCAD can’t trim or extend the object — for example, if the 
trimming object and the object to be trimmed are parallel — the command line 
displays an error message such as Object does not intersect an edge.

You can select multiple objects to trim and extend by typing F and pressing 
Enter to use the Fence object-selection mode or by entering C to use a crossing 
selection. Even better, you can use implied windowing and drag a selection box 
to select multiple objects. Refer to Chapter 10 for more on multiple object 
selection.

The command line continues to prompt you to select other objects to trim or 
extend:

Select object to trim or shift-select to extend or  
    [Fence/Crossing/Project/Edge/eRase/Undo]:

4. Choose additional objects or press Enter when you’re finished trimming or 
extending.

Here’s a triple-treat tip: If you accidentally trim or extend the wrong object and 
you’re still using the TRim or EXtend command, type U and press Enter to undo 
the most recent trim or extend operation. You can switch between TRim and 
EXtend without exiting the command by holding down the Shift key. And, 
finally, if a remnant won’t trim because it doesn’t cross the cutting edge, type R 
(for eRase) and press Enter to erase it without leaving the TRim command.

The example in Figure 11-6 shows trimming to a single cutting edge, in which 
the end of each trimmed line gets lopped off. Another common use of the TRim 
command is to trim out a piece of a line between two cutting edges. In the 

Cutting edge (for trim) Boundary edge (for extend)

FIGURE 11-6:  
Anatomy  

of the TRim  
and EXtend  
operations.
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two-cutting-edges scenario, TRim cuts a piece out of the middle of the trimmed 
line. The default option for selecting cutting edges or boundaries is <select all>, 
which works well in this scenario. Pressing Enter to accept the default option 
selects all objects in the drawing as a cutting edge if you’re using the TRim com-
mand, or a boundary if you’re using the EXtend command.

An object being trimmed or extended can also be a cutting edge or extending 
boundary, and vice versa, all in the same run of the command.

The LENgthen command provides other useful ways to make lines, arcs, and poly-
lines longer (or shorter). You can specify an absolute distance (or delta) to lengthen 
or shorten by, a percentage to lengthen or shorten by, or a new total length. Look 
up the LENgthen command in AutoCAD’s Help system for more information.

LENgthen is an option on the grip pop-up menus on lines and arcs. I discuss grips 
later in this chapter. To display the menu, just hover the mouse pointer over an 
endpoint grip on either of those object types, or over one of the new triangular 
grips on an elliptical arc, and click Lengthen.

BReak
The BReak command isn’t what you use before heading out for coffee. AutoCAD 
doesn’t have a command for that yet, but I keep hoping. The BReak command cre-
ates gaps in lines, polylines, circles, arcs, or splines. BReak also comes in handy if 
you need to split one object in two without actually removing any visible material.

The following steps show you how to break an object (don’t worry — in AutoCAD, 
you won’t have to pay for it):

1. On the Ribbon’s Home tab, click the label of the Modify panel to open its 
slideout, and then click the Break button.

AutoCAD prompts you to select a single object that you want to break.

2. Select a single object, such as a line, a polyline, or an arc.

The point you pick when selecting the object serves double duty: It selects the 
object, of course, but it also becomes the default first break point (that is, it 
defines one side of the gap that you’ll create). Thus, use one of the AutoCAD 
precision techniques, such as an object snap, to pick the object at a precise 
point or use the First point option (described in Step 3) to repick the first 
break point.

AutoCAD prompts you to specify the second break point or to type F and press 
Enter if you want to respecify the first break point:

Specify second break point or [First point]:
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3. If the point that you picked in Step 2 doesn’t also correspond to a break 
point (see the preceding Tip), type F and press Enter to re-specify the first 
break point. Then pick the point with an object snap or another precision 
 technique.

If you type F and press Enter and then re-specify the first break point, AutoCAD 
prompts you to select the second break point:

Specify second break point:

4. Specify the second break point by picking a point or typing coordinates.

AutoCAD cuts a section out of the object, using the first and second break 
points to define the length of the gap.

If you want to cut an object into two pieces without removing anything, click the 
Break at Point button on the Modify panel’s slideout. You first select the object 
and then choose a point that defines where AutoCAD breaks the object in two. You 
can then move, copy, or otherwise manipulate each section of the original object 
as a separate object.

Approach the EXPLODE command with caution — it breaks up complex objects 
into AutoCAD primitive objects. For example, a multi-segment polyline explodes 
into separate line and arc objects. Most of the time, these complex objects are cre-
ated that way for a reason. The things you can explode but shouldn’t unless you 
have a really, really good reason include polylines, blocks, 3D solids, associative 
arrays, tables, and multiline text. And even though AutoCAD lets you, never, ever 
explode dimensions or leaders. They become extremely difficult to edit.

Fillet, CHAmfer, and BLEND
Whereas TRim, EXtend, and BReak alter one object at a time, the Fillet and CHAm-
fer commands modify a pair of objects. As Figure  11-7 shows, Fillet creates a 
curved corner between two lines, whereas CHAmfer creates a beveled corner. In 
case you wondered, it’s pronounced “FILL-et,” not “fill-AY.” Saying that you 
know how to “fill-AY” may secure you a job in a butcher shop, but it will only 
draw strange looks in a design office.

FIGURE 11-7:  
Cleaning up 

corners with 
Fillet and 

CHAmfer.
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Fillet and CHAmfer show a preview of the results of the operation as soon as you 
select the objects to modify. If the fillet radius or the chamfer distances don’t look 
right in the preview, you can change their values before completing the command.

The following steps describe how to use the Fillet command — the CHAmfer com-
mand works similarly except that, rather than specify a fillet radius, you specify 
either two chamfer distances or a chamfer length and angle:

1. Click the Fillet button on the Home tab’s Modify panel.

Fillet and CHAmfer share a flyout button; if you see a straight-line corner 
instead of a rounded one, click the flyout arrow to select Fillet.

AutoCAD displays the current fillet settings and prompts you to either select 
the first object for filleting or specify one of three options:

Current settings: Mode = TRIM, Radius = 0.0000
Select first object or [Undo/Polyline/Radius/Trim/  

    Multiple]:

2. Type R and press Enter to set the fillet radius.

AutoCAD prompts you to specify the fillet radius that it uses for future fillet 
operations:

Specify fillet radius <0.0000>:

3. Type a fillet radius and press Enter.

The number you type will be the radius of the arc that joins the two lines.

AutoCAD then asks you to select the first object:

Select first object or [Undo/Polyline/Radius/Trim/  
    Multiple]:

4. Select the first line of the pair that you want to fillet.

AutoCAD prompts you to select the second object for filleting:

Select second object or shift-select to apply corner or  
    [Radius]:

5. Select the second line of the pair that you want to fillet.

AutoCAD fillets the two objects, drawing an arc of the radius that you specified 
in Step 3. The arc isn’t connected to the two objects.

If you pick the first and last segments of an open polyline, an appropriate fillet 
or chamfer is then applied to close the polyline.
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Fillet has more tricks up its sleeve:

 » You can fillet two lines and specify a radius of 0 (zero) to make them meet at a 
point. Note that this technique produces no arc rather than a zero-radius arc.

 » If you have lots of lines to fillet, whether with a zero radius or the same non-
zero radius, use the Fillet command’s Multiple option to speed the process.

 » When you start Fillet and select two parallel lines, you see a nice 180-degree 
arc joining them.

 » You can add fillets to arcs and splines.

 » You can fillet between any two combinations of line, arc, circle, polyline, and 
spline.

 » You can fillet all vertices on a polyline at one time by choosing the Polyline 
option before selecting the object.

 » Hold down the Shift key before picking the second line to automatically 
produce a clean intersection as though you’d set the fillet radius to zero even 
if the current radius setting isn’t zero. The CHAmfer command has the same 
Shift+select option.

The BLEND command joins Fillet and CHAmfer, offering another method for cre-
ating transitions between 2D drawing objects. Whereas CHAmfer creates beveled 
corners (that is, straight lines), and Fillet creates round corners (circular arcs), 
BLEND corners are spline objects. Figure 11-8 shows the two types of available 
blend; the feature is connecting the green lines. Choosing the Tangent option pro-
duced the red spline, and choosing the Smooth option produced the blue spline. 
Unlike Fillet and CHAmfer, both of which would modify the source objects to make 
a radiused or beveled transition, BLEND leaves the source objects intact. Blends 
appeal to industrial designers and other purveyors of swoopy shapes. If you’re a 
mechanical drafter, stick with fillets and chamfers.

FIGURE 11-8:  
Blending 

smoothly (or 
tangentially).
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Join
Use the Join command to fill gaps between lines, arcs, elliptical arcs, open splines, 
2D and 3D polylines, and helixes. If the lines are collinear (they lie in the same 
straight line) or the arcs, splines, polylines, or elliptical arcs are on a similarly 
curved path, Join creates a single new entity to replace the existing separate 
pieces, as shown in Figure 11-9.

Objects to be joined must be collinear or else their ends must be coincident. You 
can’t join noncollinear objects that have gaps between them or that cross or overlap.

The following steps describe how to use the Join command:

1. Click the Modify panel title at the bottom edge of the Ribbon’s Home tab 
to open the Modify panel’s slideout, and then click the Join button.

If you foresee doing a lot of joinery, you can pin open the slideout. See 
Figure 11-9. AutoCAD prompts you to select the source object.

2. Select the source object — that is, the object you want to join other objects to.

AutoCAD prompts you according to the object type you selected. If you select a 
line, the command line or Dynamic Input tooltip shows this message:

Select source object or multiple objects to join at once:

3. Select valid objects to join to the original source object.

For example, if you selected a line as the source object, AutoCAD continues 
prompting for additional adjoining lines until you press Enter to end the object 
selection.

FIGURE 11-9:  
Joining  

sundered 
pieces.
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4. Press Enter to end the command.

AutoCAD joins the selected objects into a single object. The new object inherits 
relevant properties, such as the layer or linetype of the source object.

You aren’t limited to selecting a single object at the first prompt. If you select 
multiple objects by using windowing, Join joins whatever objects it can and rejects 
those that it can’t.

You can turn an arc into a circle or an elliptical arc into a full ellipse with Join’s 
cLose option.

Other editing commands
The REVERSE command provides an easy way to reverse the direction of lines, 
polylines, splines, and helixes. Why does that matter? Well, most of the time it 
doesn’t, but if you happen to be using a complex linetype that uses text or a direc-
tional arrow block, you probably want the text to read right way up and the arrow 
to point in the right direction. Lines, polylines, and other entity types have start 
points and endpoints and, therefore, a direction that runs from the former to the 
latter. Rather than redraw linework so that the text or symbols appear the right 
way up, use the REVERSE command to flip the start points and endpoints.

This command also reverses variable-width polylines. The system variable PLI-
NEREVERSEWIDTHS controls how REVERSE handles them. When set to the default 
of 0 (zero), REVERSE reverses the start and end sequence but doesn’t affect the 
width; when set to 1, the start and end widths of segments are also reversed.

The Delete Duplicate Objects tool (also known as the OVERKILL command) looks 
for fully or partially overlapping objects, and either combines or deletes them. 
Overlapping objects, such as one line partially or completely on top of or beneath 
another line, can mess up editing and other commands.

The PEdit (Polyline Edit) command can perform a great many operations on poly-
lines. The operations fall into two categories:

 » They affect the entire polyline, such as width, curve fitting and unfitting, 
reversing, and defining how noncontinuous line types behave at vertices.

 » They affect the polyline at specific vertices, such as setting the start and end-
ing width of individual segments.

PEdit can also be used to turn a regular line into a single-segment polyline, and 
to join additional line and arc segments to an existing polyline as new segments. 
Check the Help facility for additional information.
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POLISHING THOSE PROPERTIES
When you contemplate how to edit objects, you probably think first about editing their 
geometry, such as moving, stretching, and making new copies. That’s the kind of editing 
I cover in this chapter.

Another kind of editing changes an object’s properties. As I describe in Chapter 9, every 
object in an AutoCAD drawing has a set of nongeometrical properties, including layer, 
color, linetype, lineweight, transparency, and (perhaps) plot style. Sometimes you need 
to edit those properties — when you accidentally draw on the wrong layer, for example. 
Here’s a handful of ways to edit an object’s properties in AutoCAD:

• The Properties palette: It’s the most flexible way to edit properties. Select any 
object (or objects), right-click in the drawing area, and choose Properties from the 
menu. The Properties palette displays the names and values of all properties. Click 
in the appropriate value cell to change a particular property.

• The Quick Properties palette: When the Quick Properties palette is enabled (click 
its status bar button), a palette pops up near the cursor when you select an object. 
Like the Properties palette, the Quick Properties palette contains value cells that you 
can click to change the specific property. You can choose how many lines of infor-
mation you want Quick Properties to display by right-clicking the Quick Properties 
status bar button and choosing Settings.

• Layers and Properties control lists: Another way to change properties is to select 
objects and then choose from the drop-down lists (Layer, Color, and so on) on the 
Properties palette. It’s fine to change layers this way, but don’t be slapdash about 
changing the other properties. See Chapter 9 and the following bullet for more 
information.

• Match Properties button: You can use Match Properties to copy the properties 
from a source object to other objects. You can find the Match Properties button on 
the Clipboard panel of the Ribbon’s Home tab. Match Properties works similarly to 
the Format Painter button in Microsoft applications. Match Properties works even 
when the objects reside in different drawings.

Warning: As discussed in Chapter 9, it’s almost never correct to set the color, line-
type, or lineweight to be anything other than ByLayer. To do so invites chaos.

• Change Space command: Sometimes, you add some geometry to paper space and 
then realize that it should have been in model space, or vice versa. I introduce the 
concepts of model space and paper space in Chapter 12. The CHSPACE command 
can come to the rescue. You’ll find it on the Modify panel slideout on the Ribbon’s 
Home tab. For more information, look up CHSPACE in the Command Reference of 
the online Help system.
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Getting a Grip
At the beginning of this chapter, I say that I cover only verb-noun editing. Grip 
editing, however, is — by its nature — noun-verb. You grab the selected object 
and then perform an action on it.

A grip is a little square, rectangular, or triangular handle that appears on an object 
after you select it. The shape of the grip indicates its function. In its simplest 
guise, a grip can simply be clicked and dragged to a new location. For example, 
you can

 » Drag one end of a line to change the line’s length and ending position.

 » Drag the midline grip to move a line without changing its length or angle.

 » Drag the center of an arc or circle to a new location.

 » Drag the diameter of a circle to a new size.

 » Drag either end of an arc to a new location.

 » Drag an arc to a new radius.

 » Type in a coordinate pair to specify the new location.

 » Use direct distance entry (DDE, 
discussed in Chapter 8) to specify the 
distance and direction of the change.

 » Use object snaps to existing objects 
to specify the new location. You 
can drag one grip until it’s close to 
a grip on another object and snaps 
to it, even if object snap modes are 
turned off. Figure 11-10 shows a hot 
(red) endpoint grip of a line being 
connected to the endpoint grip of 
another line. The angled line shows 
the original position of the line being 
edited, and the thin vertical line 
shows the new position. Using a grip 
in this way as a visible object snap 
offers the same advantage as using 
Object Snap overrides (as described 
in Chapter 7): It ensures precision by 
making objects meet exactly. FIGURE 11-10:  

Using grips to connect two objects.
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 » Select multiple objects. Hold down 
the Shift key while selecting multiple 
grips. Each one turns red to indicate 
that it’s hot. When you move one 
grip, all the hot ones move in parallel 
with the selected one, as shown in 
Figure 11-11.

Select one or more objects to activate 
the grips, and then click a grip. Now 
take a look at the command line, which 
displays

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]:

So far, so good. As you move the cursor, AutoCAD displays a ghost image to show 
you what would happen if you clicked at that moment.

Before you click, however, press the spacebar several times and note the changes 
to the command line and to the ghost image. The command line scrolls through 
the full rotation of choices:

** STRETCH **
Specify stretch point or [Base point/Copy/Undo/eXit]:
** MOVE **
Specify move point or [Base point/Copy/Undo/eXit]:
** ROTATE **
Specify rotation angle or [Base point/Copy/ Undo/ 
       Reference/eXit]:
** SCALE **
Specify scale factor or [Base point/Copy/ Undo/Reference/eXit]:
** MIRROR **
Specify second point or [Base point/Copy/Undo/eXit]:

That’s right: The six most-often-used editing options become available in rota-
tion. Wait a minute — only five are in the list! Copy is an option for the other five.

Grips on lines, arcs, and elliptical arcs have become multifunctional. Hovering 
over an endpoint grip displays a pop-up menu that offers you a choice of length-
ening or stretching the object. Hovering over the midpoint grip on an arc offers 
the choice of stretching the arc by its midpoint (that is, keeping the same end-
points) or changing its radius. Elliptical arcs display triangular grips that let you 
increase the length of the arc without changing its other parameters. Hovering 

FIGURE 11-11:  
Stretching multiple objects with multiple  
hot grips.
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over a rectangular grip on the midpoint of a polyline segment offers the choice of 
stretching (that is, moving the current segment while maintaining its connections 
to its siblings), adding a new vertex (that is, splitting the current segment in two), 
or turning a line segment into an arc (or vice versa).

When Editing Goes Bad
Analysis of AutoCAD users’ actions suggests that one of the most commonly 
used functions is undo. It comes in several forms and depths of action. If you’re 
the impatient type, you can jump ahead to the last two items in this list because 
they’ll probably account for the majority of your undo actions:

 » OOPS: The OOPS command un-erases the last set of erased objects, even 
if other editing or drawing actions have taken place in between. This com-
mand has no menu option or Ribbon icon, so you have to type it at the 
command line.

 » UNDO: The UNDO command is quite versatile and powerful, with several 
options. Among other things, you can have it undo a specified number of 
actions, drop a marker flag, or undo as far back as the marker flag. See the 
Help facility for more information. You need to type this command on the 
command line because the only menu option is the typical Windows undo 
arrow on the Quick Access menu, which undoes only one step and doesn’t 
prompt for the other options.

 » U: This command is available in two forms:

• Type it as a command. It undoes your last action, and you can use it repeat-
edly to step back through the current editing session. Just press Enter until 
you back up to the step you need.

• Enter it as a prompt during a number of other commands, such as Line, PLine, 
and COpy. In this case, it undoes the last line or polyline segment, or the 
last objects to be copied — but then the parent command resumes, and 
you can continue drawing or placing copies.

 » REDO: This command reverses the last U or UNDO operation. To make REDO 
work, you must use it immediately after one of these operations. It appears as 
the typical Windows undo arrow on the Quick Access menu.

 » DOO-DOO: Or words to that effect. This isn’t a command — instead, it’s what 
you say when you undo too many steps and then realize, to your horror, that 
REDO can only redo the last Undo step.
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 » MREDO: This command reverses multiple Undo actions and pretty much 
eliminates the need for DOO-DOO. It has several advanced options, though 
the prompts are self-explanatory.

 » BAK: This isn’t a command — it’s a file type. Whenever you save your work 
in process, AutoCAD creates a file with the extension .bak that stores your 
drawing the way it looked immediately after the previous save operation. You 
can go back to this version by simply using Windows Explorer to rename the 
BAK file to one with the .dwg extension.

 » SV$: This one is also a file type. As you work, AutoCAD automatically saves a 
copy of your drawing every ten minutes and gives it the .sv$ file extension. 
You can go back to this version by simply using Windows Explorer to rename 
the SV$ file to one with the .dwg extension. You’ll find your SY$ files in the  
c:\Users\<login name>\appdata\local\temp folder, but you can use the 
Files tab of the OPtions command to store them in any location you like.

 » Undo button: It invokes the UNDO 1 command and option. The Quick Access 
menu includes an Undo button, just as many Windows applications do.

 » Redo button: It invokes the MREDO 1 command and option. The Quick 
Access menu includes a Redo button, just like many Windows applications do.

Don’t you just wish that the real world had Undo and Redo buttons?
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IN THIS CHAPTER

Setting up paper space layouts

Looking into viewports

Examining details at other scales

Working in paper space

Planning for Paper

Most of this book revolves around setting up and using the model space 
environment that is an infinitely large (or at least 1099 units across), 
three-dimensional realm in which you create your gleaming towers, 

tomorrow’s wondrous electronic gadgetry — or everyday garden sheds, angle 
brackets, and doorknobs. You may, however, have picked up a hint here and there 
that AutoCAD has a whole different parallel universe available to you, known as 
paper space.

The final product of all this setup, remember, is a printed drawing on a piece of 
paper. In most industries, paper drawings are legal contract documents, so they 
need to be easy to read and understand. In the first part of this documentation 
process, you configure the layout of the sheet in paper space, which I explain 
in this chapter. For the actual process of outputting either model space or paper 
space layouts to printer or plotter, see Chapter 16.

Chapter 2 introduces you to the two parallel universes of model space and paper 
space, and Chapter 4 explains how to configure model space for efficient drawing. 
This chapter explains how to set up layouts in paper space for efficient plotting.

Model space is the drawing environment that’s current when the Model tab (not 
the Model button) on the status bar is active. In model space, you create the “real” 
objects you’re drawing, so these objects are referred to as model geometry whether 
they’re 2D or 3D entities. When the Model tab is active, you see only objects in 
model space. Anything in paper space is invisible.

Chapter 12
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Imagine that your screen is displaying your drawing in model space. Now place a 
sheet of paper in front of your monitor and cut a square hole in it so you can look 
through it to see all or part of model space. This is like a one-way mirror; you can 
look through this paper space viewport to see model space, but model space can’t 
look back at you through the hole. You must have at least one paper space view-
port in each layout to display anything in model space.

To see what I mean, try this:

1. Start a new, blank drawing.

By default, it starts in model space.

2. Draw several random lines.

3. Click the Layout1 tab in the lower-left corner of the screen.

AutoCAD switches to the default layout, which has one viewport into model 
space. All the lines you just drew fit into the central, rectangular viewport.

4. Draw a circle within the central, rectangular viewport.

5. Click the Model tab in the lower-left corner of the screen.

Hey, where did the circle go?

6. While you’re here, draw an ellipse within the general area of the lines.

7. Click the Layout1 tab.

Like magic, the ellipse appears and the circle reappears.

That’s the basic principle of paper space layouts. Everything you draw in model 
space can be seen from paper space layouts, but nothing you draw in paper space 
layouts can be seen when you are in model space. This feature is particularly use-
ful for borders and title blocks that you need when you plot a drawing but only get 
in the way in model space.

Figure 12-1 shows the arrangement of a default layout tab. It contains the follow-
ing items:

 » The white rectangular area represents a sheet of paper.

 » The dotted rectangle shows the boundary of the actual area in which the 
current printer can print. Anything drawn outside this boundary (the margin) 
won’t print.

 » The inner rectangle shows the viewport through to model space.
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I turned on the grid when I did the screen capture to emphasize the fact that this 
is model space. As explained in Chapter 3, the grid can be turned on or off, and is 
never printed.

An AutoCAD drawing file always contains one and only one model space, but paper 
space can include more than one layout. For example, a complex drawing might 
have one layout for a general overview and several other layouts for larger-scale 
detail views. Each layout can then be plotted to its own sheet of paper. If the model 
space drawing is edited, all layouts automatically show the latest version.

Best practice these days is to draw the real stuff, such as the building, the machine, 
or the doorknob, in model space and the paper stuff, such as the border, the title 
block, the view labels, and general notes, in a paper space layout.

As I point out in a number of places in this book, the sacred mantra is “always 
draw everything full size.” The use of paper space layouts greatly simplifies this 
process. As discussed a little later in this chapter, you can define the scale  factor 
for each viewport, as well as the size of the physical sheet of paper that your 
printer or plotter produces. Now you can simply plot every paper-space layout as 
full size and everything will fit.

FIGURE 12-1:  
All spaced out.
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In AutoCAD, you can ignore paper space layouts entirely and do all your drawing 
and plotting in model space. Originally, AutoCAD only had model space. Paper 
space wasn’t added to AutoCAD until 1990. But you owe it to yourself to give lay-
outs a try. You’ll find that they make plotting more consistent and predictable and 
they give you more plotting flexibility. You’ll certainly encounter drawings that 
use paper space exclusively, so you should understand both systems.

Setting Up a Layout in Paper Space
Aside from arranging drawing sheets, layouts store plot information. AutoCAD can 
save several separate plot settings with each layout, as well as for model space, so 
that you can produce different types of plot for each one. For example, with one 
layout you can do quick check plots to a letter-size laser printer; with a second 
layout, you can do full-size final plots to a large-format plotter. In practice, you’ll 
probably use only one paper space layout tab most of the time, especially when 
you’re getting started with AutoCAD.

The layout two-step
Setting up a layout is a two-step process. The first step is to define the paper, and 
the second step is to define the viewport or viewports.

Pick a paper, any paper
Defining the paper is a simple process. Follow these steps:

1. Click the desired layout tab.

2. Click the Layout tab of the Ribbon menu.

The Layout tab appears on the Ribbon only when AutoCAD is in layout mode.

3. In the Layout panel, click Page Setup.

The PAGESETUP command starts, and displays the Page Setup Manager 
dialog box.

4. Click New.

The New Page Setup dialog box appears.

5. Type a suitable name and click OK.

Next up is the Page Setup dialog box. This dialog box looks remarkably like the 
Plot dialog box that I discuss in Chapter 16.
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6. Specify the printer you want to use, its paper size, and so on (as per 
Chapter 16), but leave the Plot Area drop-down list set at Layout.

Many of the names in the Printer/Plotter Name list should look familiar 
because they’re the Windows printers (system printers, in AutoCAD lingo). 
Names with the .pc3 extension represent nonsystem printer drivers. See 
Chapter 16 for details.

7. Click OK.

The Page Setup dialog box closes, and the New Page Setup dialog box returns.

8. Click Close to apply your new setup to the current layout.

You can repeat the page setup as often as you like within one drawing. You thus 
can have multiple layouts or multiple page setups or both in one drawing. Each 
layout can have a different page setup, and you can use the PAGESETUP command 
at any time to switch a given layout to a different setup.

View that port
Now that you have the paper set up properly, it’s time to move on to the viewport 
setup. By default, AutoCAD starts a new drawing with a single viewport in Lay-
out1 and in Layout2, and each viewport is on layer 0 (zero). A single viewport in a 
single layout is often appropriate for most drawings. You can add more layouts to 
the drawing, and each layout can have many viewports.

A viewport is an actual drawing object. As such, you can move, copy, grip-edit, 
print, and delete it, and change its properties. You can even use it as the boundary 
for cross-hatching, but I’m not sure why you would want to.

The default settings are probably not optimal for your needs, so you should follow 
these steps:

1. Set the layer.

A viewport boundary is a drawing object and so it will print, which you usually 
don’t want. Using the Layer Properties Manager, create a new layer, perhaps 
called VPORTS, and turn off plotting for this new layer. You may also want to 
change the layer color or line type or both so you can easily identify viewports 
in drawings. I cover layers in Chapter 9.

2. Move the viewport object to your new VPORTS layer.

3. Click the viewport object, and then click on your VPORTS layer name in the 
drop-down list below Layers in the Layers panel of the Home tab.

The viewport object remains visible, but now it won’t plot.
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4. Set the viewport scale.

When you did the simple exercise near the beginning of this chapter, did you 
notice that the first time you clicked the Layout 1 tab, everything you drew in 
model space just happened to exactly fit within the viewport? To make this 
happen, AutoCAD automatically adjusted the viewport scale factor. The 
problem is that it almost never turns out to be a standard scale that anyone 
would use. For example, when I did the exercise, the scale factor turned out to 
be 0.11036728. A more logical scale would be 0.1, or 1:10. No problem:

a. Click the viewport boundary.

b. Click the viewport scale button, near the right end of the status bar.

c. Select a suitable scale from the list of standard scales that appears. The list 
shows every drawing scale registered in the scales list, including metric 
scales, even if you’re working in a drawing using English units and vice versa.

Most of the time, way too many scales are shown in the list you see in the 
Viewport Scale button and in the Plot dialog box. AutoCAD has a handy-dandy 
Edit Drawing Scales dialog box that lets you remove imperial scales if you never 
work with feet and inches, and vice versa if you never work in metric. To run 
through the scales, choose Scale List from the Annotation Scaling panel on the 
Annotate tab, or type SCALELISTEDIT and press Enter to open the Edit Drawing 
Scales dialog box. If (okay — when) you make a mistake, click the Add button in 
the Edit Drawing Scales dialog box to add a lost scale factor, or click the Reset 
button to restore all default scales.

5. Lock the viewport scale.

When a viewport is selected, a padlock icon appears to the left of the viewport 
scale button. The icon is a toggle that turns viewport scale locking on or off.

Always lock the viewport scale immediately after setting it. You’ll see why later in 
this chapter when I discuss details at different scales.

Practice playing with the paper space and model space layouts in AutoCAD’s 
 sample drawings. I don’t cover sheet sets in this book, but the individual drawings 
in the sheet sets all use paper space layouts along with model space. For example, 
from AutoCAD’s Start screen, click Explore Sample Drawings. When the file dialog 
box opens, click Sheet Sets, and then click Civil, and then click Site Grading Plan. 
Click Yes in the alert box that appears to see a drawing that has four paper space 
layouts based on four views of the common model space drawing.

Put it on my tabs
The Autodesk documentation sometimes refers to the Model tab or to layout tabs, as 
I sometimes do. Out of the box, AutoCAD displays selectable tabs at the lower-left 
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edge of the drawing window, clearly labeled Model, Layout1, and Layout2. Hover-
ing your cursor over a tab pops up a preview of its contents. You can jump to a 
desired view just by clicking its preview image.

AutoCAD 2014 added drawing tabs at the top left of the graphic screen for each 
open drawing. Hovering the cursor over a tab also produces quick views of model 
space and all layouts in the drawing. Figure 12-2 shows a typical arrangement in 
which AutoCAD has several drawings open. If you are hovering the cursor over the 
current drawing, a blue border indicates the currently active view. You can jump 
from view to view within a drawing or directly to a desired view in a different 
drawing just by clicking its preview image.

You can rename a layout tab (but not the Model tab) by double-clicking the layout 
name and typing a new one.

FIGURE 12-2:  
View those 

layouts, and 
make it quick!
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Any Old Viewport in a Layout
The viewports I talk about in this chapter are paper space viewports. You can 
also create viewports in model space, but they’re completely different animals. 
Model space viewports are also known as tiled viewports because (like bathroom 
tiles) they can’t have any spaces between them. You can use tiled viewports to 
look closely at widely separated areas of the screen or different viewports of a 
3D model. I cover tiled model space viewports in Chapter 22 when I discuss 3D 
modeling. The potentially confusing aspect is that AutoCAD uses the same com-
mand name, and even the same dialog box, for creating the two different types 
of viewports. In this chapter, ensure that you’re in paper space when you create 
viewports.

Up and down the detail viewport scales
Paper space viewports are assigned drawing scales, and you can have multiple 
viewports, each with a different scale, all in the same layout. For example, one 
viewport can show the layout of a machine at 1:20, and another viewport can show 
an enlarged view of a small detail at 1:2. Because the individual viewports are 
scaled, the entire layout can be plotted at 1:1. Try the following steps:

1. On the Ribbon, click the Layout tab; then in the Layout Viewports panel, 
choose Rectangular.

If the Rectangular button is grayed out (I know, they’re all rectangular — it’s the 
one that is labeled Rectangular), you’re still in model space. Switch to paper 
space.

AutoCAD prompts you to pick the first corner of the new viewport.

2. Pick a point somewhere on the layout page to locate the first corner of the 
new viewport.

AutoCAD prompts you to pick the second corner.

3. Pick another point to place the second corner of the new viewport.

AutoCAD draws the viewport, and the model space geometry appears inside it.

Unlike tiled model space viewports, paper space layouts can overlap each 
other or have spaces between them.

4. Zoom and pan until the new viewport shows the desired region of model 
space.

If you zoom and pan in paper space, you simply zoom and pan the entire 
layout. If you zoom and pan in model space, it has no effect on the paper space 
viewport.
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Okay, here’s the clever part. While you’re in paper space, double-click inside the 
viewport. You have now reached through the hole in the time-space contin-
uum and are working in model space. Any panning and zooming you do here 
does affect what’s visible in the layout viewport. When things are to your liking, 
return to the current layout by double-clicking anywhere in paper space 
outside the viewport.

5. Click the viewport boundary to which you want to apply a scale.

The Viewport Scale button appears toward the right end of the status bar.

6. Find the scale that you want to apply to the active viewport, and then select 
it from the list.

The display zooms in or out automatically to adjust to the chosen viewport 
scale.

7. Lock the viewport when the scale is correct.

Click the padlock icon, which appears to the left of the viewport scale button 
near the left end of the status bar, to toggle viewport scale locking on or off.

Okay, here’s the warning I warned you about earlier in the chapter. If you don’t 
lock the viewport scale, someone (not you, of course) can mess up the viewport 
scale factor in all innocence, thinking he or she is just zooming in for a closer look.

You can zoom directly to an exact scale factor while reaching into model space 
through a viewport. Start the Zoom command, and then enter the desired scale 
factor immediately followed by the letters XP (“times paper,” not case sensitive). 
For example, Z 2XP will zoom in 2:1, and Z .5XP will zoom out 1:2. Now return to 
paper space and lock the viewport.

When a viewport is locked, you can still double-click in it to enter model space and 
create or edit objects that are visible in the viewport. Panning and zooming do not 
affect what appears in the viewport but do affect the entire layout, as though you 
had momentarily slipped back into paper space.

Viewports have most of the properties and capabilities of other drawing objects. 
You can still stretch, move, copy, delete, and so on, even when the viewport is 
locked. Grip editing, described in Chapter 11, can be particularly useful.

Earlier in this chapter, I said that viewport boundaries should normally be placed 
on their own non-plotting layer. That is generally true for the main viewport that 
shows all or most of the objects in model space. Standard practice, however, is 
for details at different scales to display their viewport boundaries, as shown in 
Figure 12-3. The solution is to create two layers for viewports, one that plots and 
one that doesn’t.
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Keeping track of where you’re at
When you start working in layouts, it may not always be crystal-clear whether 
you’re in model space or paper space. The status bar button helps because it says 
PAPER if you’re in paper space or MODEL if you’re in model space. You can tell the 
layout spaces apart in a few other ways:

 » Check the cursor. If you’re in paper space, you can move the cursor over the 
entire drawing area. If you’re in model space by reaching through a layout 
viewport, you can move the cursor only within the active viewport; if you try 
to move the crosshair cursor outside the viewport, it turns into the Windows 
arrow cursor.

 » Select some model geometry. Try clicking some objects that you know are 
in model space. If you can select and highlight them, you’re in model space. If 
nothing happens when you click them, they’re inaccessible because you’re in 
paper space.

 » Check the UCS icon. The User Coordinate System (UCS) icon is the symbol at 
the lower-left corner of the drawing area. The model space icon shows two 
lines at right angles to each other, with the letters indicating the direction 
of the X-axis and the Y-axis. The paper space icon is triangular — its closed, 
three-sided shape represents a flat plane. If you don’t see this symbol, type 
UCSICON and press Enter, and then type either ON (to display the UCS icon in 
the lower-left corner of the display) or OR (to display the icon at the drawing’s 
origin — its 0,0 coordinates). I explain more about user coordinate systems in 
Chapter 8.

FIGURE 12-3:  
Show me the 

viewport!
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Practice Makes Perfect
Best practice when creating new drawings is to use paper space layouts with 
viewports. This greatly simplifies the drawing scale problem and related plotting 
issues. In particular, note the following:

 » Model space

• Always draw everything full size.

• Use self-scaling notes (Chapter 13), dimensions (Chapter 14), crosshatching 
(Chapter 15), and non-continuous line types (Chapter 9).

 » Paper space:

• Everything “non-model” goes here, including the drawing border, the title 
block, and any generic notes.

• Configure layouts with appropriate plotter, printer, and sheet size 
specifications.

• Create appropriately scaled viewports.

• Plot full size (1:1).

Clever Paper Space Tricks
The following list shows a few useful tips and tricks that will help you become a 
paper space guru:

 » Create additional layouts as necessary. You can do this in several ways, 
including using the New button in the Layout tab of the Ribbon menu or 
 simply clicking the + (plus) sign to the right of the rightmost layout tab.

 » Delete unused layouts. Simply right-click the undesired layout tab, and then 
click Delete in the context menu that appears.

 » Viewports don’t have to be rectangular. The Ribbon’s Layout tab includes 
three options in the Layout Viewports tab, but two will be hidden under the 
last one used. The options are Rectangular, Polygon (you pick a series of 
points that lasso the desired region), and Object, which lets you choose any 
existing closed shape and convert it to a viewport. That’s how I created the 
elliptical detail in Figure 12-3.
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 » Freeze layers in individual viewports. You don’t always want to show every-
thing in every viewport. If you enter model space by double-clicking inside 
a viewport, the Layer Properties Manager (see Chapter 9) lets you freeze 
selected layers in the current viewport. Conversely, the drop-down list below 
the Layers panel of the Home tab includes a command to freeze the layer of 
the selected object in all other viewports except the current one.

 » Snap into model space. Even when you are in paper space, it’s still pos-
sible to snap onto objects in model space that are visible in a viewport. This 
technique was used mostly before self-scaling annotations came along. 
Dimensions could be applied from paper space without having to worry about 
scaling them. The problem is that it’s usually more helpful to have the dimen-
sions in model space when you are working there.

 » Use templates. Ah, now here’s the biggie. I refer to template files in several 
chapters, but a quick refresher wouldn’t hurt. A template file serves as the 
starting point for a new drawing and can contain anything that a normal 
drawing file can contain. This includes everything discussed in this chapter: 
layouts, viewports, plotting configurations, borders, title blocks, and so on. 
John Walker, one of the founders of Autodesk, is rumored to have once said 
that an AutoCAD user should never have to do anything twice. I don’t think he 
said it again.

But wait! There’s more! A bit of exploring will reveal that the commands for 
creating and configuring layouts and viewports all have a From Template 
option. You can browse through the current drawing and through any existing 
drawing or template file anywhere to inhale the complete layout setup specifi-
cations. Complete means everything; for example, if you are setting up a layout 
from a template and the source includes viewports, a border, and a title block, 
it all comes over to the new layout, including the creation of any new layer, 
text, and dimension specifications and block definitions required.

If the current drawing contains any specifications with the same names as the 
source, the host drawing wins and the incoming specifications are ignored. 
The existing specifications will be applied to the incoming objects.
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Include text, including numbered and bulleted lists 
and tables, in your drawings.

Place text labels — dimensions — in your drawings.

Add hatches to your drawings.

Print — or plot, as AutoCAD aficionados call it — your 
drawings.
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IN THIS CHAPTER

Creating annotative text

Employing text styles to control text 
appearance

Placing single-line and multiline text

Using fields and background masks 
with text

Making numbered and bulleted lists

Working with columns and 
paragraphs

Editing text contents and properties

Creating tables

Drawing multileaders

Text with Character

It has been said that “a word is worth one-one-thousandths of a picture.” On 
the other hand, the opposite is often true as well. Adding a few words to your 
drawing can save you from having to draw thousands of lines and arcs. It’s a lot 

easier to write Simpson A35 framing clip next to a simple, schematic represen-
tation of a clip than to draw one in microscopic detail and hope that the contractor 
can figure out what it is.

Most CAD drawings include some text in the form of explanatory notes, object 
labels, and titles. This chapter shows you how to add general drawing text and 
leaders (descriptive notes with arrows that point to specific drawing objects) to 
your drawings. In this chapter I show you how to take advantage of AutoCAD’s 
annotative text objects and text styles, how to find specific text, and how to check 
for speling erors. Chapter 14 covers text that’s connected with dimensions.

Chapter 13
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In most cases, adding text, dimensions, and other descriptive symbols is a task 
that you should do later in the drafting process, after you’ve drawn at least some 
of the geometry. In CAD drawings, text and other annotations are usually intended 
to complement the geometry, not to stand alone. You generally need to have the 
geometry in place before you annotate it. Many drafters find that it’s most effi-
cient to draw as much geometry as possible first, and then to add text annotations 
and dimensions to all the geometry at the same time. In this way, you develop a 
rhythm with the text and dimensioning commands instead of bouncing back and 
forth between drawing geometry and adding annotations.

As I mention in Chapter  4, AutoCAD’s annotative objects present a streamlined 
way to add notes, dimensions, and other annotations to drawings. This chapter 
introduces annotative text, and subsequent chapters cover annotative dimensions 
and hatches. See the “Annotatively yours” sidebar later in this chapter for some 
background.

Getting Ready to Write
In AutoCAD, adding text to a drawing is similar to adding it to a word processing 
document. Here are the basic steps, which I explain in more detail in the sections 
that follow:

1. Select an existing AutoCAD text style, or create a new style that includes 
the font and other text characteristics you want to use.

Just like a word processor, AutoCAD uses styles — collections of formatting 
properties — to control the appearance of drawing text. I explain text styles in 
the next section.

2. Make an appropriate layer current.

To make your AutoCAD drawing efficient and easy to edit for you and others, 
create text on its own layer. Most drafting offices already have a set of CAD 
standards that establish specific layers for text and other object types.

3. Run one of these commands to draw text:

• TEXT: Places single-line text

• mText: Places paragraph text, also called multiline text

4. Specify the text alignment points, justification, and (if necessary) height.

5. Type the text.

6. (Optional) For annotative text, assign additional annotation scales to the 
text you just typed, if desired.
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In the next few sections of this chapter, I review the particularities of AutoCAD text 
styles, the two kinds of AutoCAD text, and ways to control height and justification.

ANNOTATIVELY YOURS
One helpful aspect of AutoCAD is that it offers multiple ways to accomplish drafting 
tasks. This usually comes about because successive releases of AutoCAD add new or 
improved methods of performing existing tasks. One less-helpful aspect of AutoCAD is 
that it offers multiple ways to accomplish drafting tasks. You’re almost always better off 
adopting the newer methods, but in this book I give you a taste of the older methods 
because literally billions of existing drawings were created using the older methods — 
and you’re bound to encounter them sooner rather than later in your career. Text and 
dimensions are prime examples. I cover text annotations in this chapter, and dimensions 
in Chapter 14.

AutoCAD supports these three methods for annotating drawings:

• Add text and dimensions in model space, multiplying the drawing scale factor 
times the desired plotted text height. For example, suppose that you have drawn 
a floor plan in full size in model space, following mandatory AutoCAD practice. Now 
you want to plot it at a scale of 1/4” = 1’-0” (corresponding to a drawing scale 
factor of 1:48) so that it fits on the desired sheet of paper. You want your notes to 
appear 1/8-inch high when the drawing is plotted to scale, so you have to create text 
that’s 48 times 1/8-inch, or 6 inches, high. And that works fine — until you want to 
plot the drawing at a different scale or create a detail at a different scale.

This calculation is particularly cumbersome if you’re working with feet, inches, and 
fractions, but it’s a bit easier to complete when you’re using decimals of inches or 
metric units.

• Add text and dimensions on a paper space layout. I cover paper space layouts 
in Chapter 12. Because paper space is plotted at 1:1, you create annotations at their 
actual plotted sizes. The scale calculations are simple (“Hey, boss, what’s 1/8-inch 
times 1?” “I don’t know; my calculator’s broken.”), but sometimes it’s beneficial to 
have drawing annotations in the same space as the drawing geometry. A potential 
problem is that you might have to create duplicate notes in each layout or view 
because you can create multiple layouts in paper space and multiple views in a 
layout.

• Add text and dimensions in model space by using annotative text and 
 dimension styles. This method is similar to the first one described in the first bullet, 
except that AutoCAD automatically completes the size calculations for you based on 
a desired plotted size and specified annotation scale.

(continued)
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Creating Simply Stylish Text
AutoCAD assigns text properties to individual lines or paragraphs of text based on 
text styles. These text styles are similar to the paragraph styles in a word processor: 
They contain font settings and others that determine the look and feel of text. An 
AutoCAD text style includes

 » The font, or basic shape style of the characters

 » A text height, which you can set to a specific value or leave at 0 for later 
flexibility

 » Special effects, depending on the font, such as italic, bold, and bold italic

 » Truly special effects, such as vertical and upside down, which have highly 
specialized applications

Before you add text to a drawing, use the Text Style dialog box to select an exist-
ing style or create a new one with settings that are appropriate to your purpose.

You can assign the annotative property to text styles in old drawings by opening 
the Text Style dialog box in the drawing, choosing the individual text style you 
want to update, selecting the Annotative check box, and then saving the drawing.

Most drawings require only a few text styles. You can create one style for all notes, 
object labels, and annotations, and then create another text style for special titles. 
You may also want to create a unique text style for dimensions. See Chapter 14 
for more on dimension text. A title block may require one or two additional fonts, 
especially if you want to mimic the font used in a company, client, or project logo.

Using annotative objects makes the most sense to us because they can automatically 
cover all plot scales, and they don’t have to be duplicated on multiple layouts because 
they’re in model space. One tricky concept to grasp in AutoCAD is the necessity of scaling 
text and dimensions to apparently ludicrous sizes (6-inch-high text, for example) so that 
they plot correctly. Annotative objects do the scale calculations for you. Better yet, details 
at different scales are handled almost automatically.

Annotative object types include both single-line and multiline text (covered in the 
 sections “Using the Same Old Line” and “Saying More in Multiline Text,” respectively, 
later in this chapter), leaders (covered in the later section “Take Me to Your Leader”), 
dimensions (covered in Chapter 14), hatches (see Chapter 15), and blocks and attributes 
(see Chapter 17).

 (continued)
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As with layers, your office should have its own standards for text styles. If so, 
you’ll make everyone happy by following those standards. One of the best ways 
to make sure your use of text styles is efficient and consistent is to organize them 
into a template drawing that you use to start every new drawing. If your office 
is  well organized, it should already have one or more template drawings with 
company-approved styles defined in it. See Chapter 4 for information about cre-
ating and using templates. Another technique is to copy existing text styles from 
one drawing to another by using the DesignCenter palette. This strategy is men-
tioned in Chapter 6, but isn’t always desirable.

Font follies
When you create a text style in AutoCAD, you have a choice of a huge number of 
fonts. AutoCAD can use two different kinds of fonts: native AutoCAD SHX (com-
piled shape) fonts and Windows TrueType fonts:

 » SHX: In the Text Style dialog box, SHX font names appear with a drafting 
compass to the left of the name and display the .shx file extension. SHX 
fonts usually provide better performance because they’re optimized for 
AutoCAD’s use.

 » TrueType: In the Text Style dialog box, TrueType font names appear with a 
TT symbol to the left of the name and no file extension. TrueType fonts give 
you more and fancier font options, but they can slow down AutoCAD when 
you zoom, pan, or select and snap to objects. TrueType fonts also can cause 
greater complications when you exchange drawings with other AutoCAD users.

AutoCAD defaults to using Arial, a TrueType font. AutoCAD and TrueType fonts 
are available also with specialized mathematical, astronomical, and astrological 
characters.

The best AutoCAD font is probably Romans.shx (Roman Simplex). You may also run 
into Simplex.shx, an older version of Roman Simplex. For drafting in AutoCAD, 
Romans.shx is a good, general-purpose font that closely resembles traditional 
hand lettering. Avoid complicated, thick fonts. They can slow down AutoCAD, and 
they’re usually more difficult to read than the simpler fonts. Remember that it’s 
CAD — not fancy graphical design or reproductions of medieval manuscripts! The 
best advice, however, is to stick with whatever font is standard for your office, 
your company, or your clients.

Whenever possible, avoid font files not supplied with AutoCAD or Windows. 
 AutoCAD doesn’t embed font files in drawings but must refer to the font files 
installed locally for either AutoCAD (for SHX fonts) or Windows (for TrueType 
fonts). If you use a custom font of either type, exchanging drawings with other 
people becomes more complicated. It’s far less hassle to avoid custom fonts 
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 altogether. See Chapter 20 for additional information about how to deal with fonts 
when you send and receive drawings.

Get in style
The steps in this section describe how to create a new text style for use with text 
in a drawing. If you want to experiment with an existing drawing that contains  
a variety of text styles, download the AutoCAD sample drawings from www.
autodesk.com/autocad-samples. Look for the architectural_-_annotation_ 
scaling_and_multileaders.dwg file.

Commonly, you create a text style once in a drawing template so it can be used in 
all future drawings. After a text style is created and before you add text to a draw-
ing, you set the text style current that you want to use with the Text Style drop-
down list on the Text panel of the Annotate tab on the Ribbon.

1. Start the STyle command: On the Ribbon’s Home tab, click the 
Annotation panel’s label to open the slideout and then click Text Style.

The Text Style dialog box appears, as shown in Figure 13-1.

2. From the Styles list, select each style in turn to examine the properties of the 
text styles that have been created in this drawing.

Note the font name and look at the Preview panel in the lower-left corner of 
the dialog box to get a feel for what the different fonts look like.

3. Click the New button to create a new style.

Pay attention to the style that’s current when you click New. If it’s an annotative 
style, the new style is also annotative; if the current style isn’t annotative, the 
new style isn’t, either. It’s easy enough to select or deselect the Annotative 
check box, but you may overlook this action at first.

FIGURE 13-1:  
Text — with 

style.

http://www.autodesk.com/autocad-samples
http://www.autodesk.com/autocad-samples
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The New Text Style dialog box appears, with a text box for you to type a  
name.

4. Type a name for the new text style and then click OK.

The new text style is added to the Styles list and becomes the current style.

5. Choose a font from the Font Name list.

The best all-purpose font for most drafting work is Romans.shx. If you want to 
use a different font, review the font suggestions and warnings in the preceding 
section.

The font that you choose becomes the font that’s assigned to the new text style.

6. To create an annotative text style, select the Annotative check box. Deselect 
the check box for non-annotative text.

See the “Annotatively Yours” sidebar, earlier in this chapter, to find out more.

7. Adjust the remaining text style settings.

The text style shown earlier (refer to Figure 13-1) has the following setup:

• Paper Text Height (just Height for non-annotative styles) = 0.0

• Width Factor = 1.0

• Oblique Angle = 0

• All check boxes other than Annotative are deselected.

A text style height of 0.0 makes the style of variable height, which means that 
you have to specify the height separately for each text object as it’s created. 
Assigning a fixed (that is, nonzero) height to a text style forces all text that uses 
the style to be the same height. Variable height styles are more flexible, but 
fixed height styles usually make it easier to draw text of consistent height. The 
decision to use styles of variable height versus fixed height is another aspect of 
text that depends on office practice; if you work with other AutoCAD users, ask 
around.

Most drawings require only two or three text sizes, such as a Normal (1/8-inch) 
for general notes, Larger (1/4-inch) for view and detail labels, and Large 
(1/2-inch) for section line identifiers. The best way is to create several appropri-
ate fixed-height styles.

In certain cases, the fixed height value isn’t the final text size. It needs to be 
corrected by the drawing scale factor, as covered in the section “Calculating 
non-annotative AutoCAD text height,” later in this chapter.

Dimensions use text styles to format the appearance of the dimension text. 
When you create a text style that you think you might use for your dimensions, 
you must set the height to 0. Otherwise, the setting that controls the dimension 
text won’t work, and the dimension text is likely to be either enormous or 
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microscopic. This paragraph should have an extra Warning icon because this is 
one of the most common mistakes made by new AutoCAD drafters. The best 
practice is to create a Dimensions text style.

8. Click Apply and then click Close.

The Text Style dialog box closes, and the text style you selected or created is 
now the current style for new text objects.

Taking Your Text to New Heights
Drawing scale is the traditional way to describe a scale with an equal sign or 
colon — for example 1/4” = 1’-0”, 1:20, or 2:1. The scale factor represents the 
same relationship with a single number, such as 48, 20, or 0.5. The drawing scale 
factor is the multiplier that converts the first number in the drawing scale into the 
second number.

You must determine the scale factor of a drawing before you add non-annotative 
text to it.

Plotted text height
Most industries have plotted text height standards, which AutoCAD refers to as 
paper text height. A plotted text height of 1/8" or 3mm is common for notes. Some 
companies use slightly smaller heights (for example, 3/32" or 2.5mm) to squeeze 
more text into small spaces.

Calculating non-annotative 
AutoCAD text height
To calculate non-annotative text height, you need to know the drawing scale fac-
tor, the desired plotted text height, and the location of the multiplication button 
on your calculator. Follow these steps to calculate the text height:

1. Determine the drawing scale factor.

Drawing scale is based on the size of the object you’re drawing versus the size 
of the sheet of paper on which it will be printed. For example, a house floor 
plan would have to be scaled down 1:96 (1/8″=1′) to fit an A-size sheet, whereas 
a watch gear would have to be scaled up 50:1 to appear as more than a dot in 
the middle of the sheet. As noted, the drawing scale factor is the inverse of the 
drawing scale: 96 for the house plan, and 1/20 or 0.05 for the watch gear.
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You shouldn’t select a scale factor at random. Different industries have lists of 
“preferred” (which you should read as “mandatory”) scale factors, and indi-
vidual companies in turn may have a short list within the preferred values.

When you edit an existing drawing, it should have a bar scale or text note 
indicating the drawing scale. If not, and if the drawing dimensions are in model 
space, you can check the value of the DIMSCALE variable (the system variable 
that controls dimension scale), as described in Chapter 14, or work backwards 
from existing text sizes.

2. Determine the height at which notes should appear when you plot the draw-
ing to scale.

See the earlier section “Plotted text height” for suggestions.

3. Multiply the numbers resulting from Steps 1 and 2.

After you know the AutoCAD text height, you can use it to define the height of 
a text style or of an individual text object.

If you assign a nonzero height to a text style (refer to Step 8 in the earlier section 
“Get in style”), all text that you create in that style uses the fixed height. If you 
leave the text style’s height set to 0 (zero), AutoCAD asks you for the text height 
every time you draw single-line text objects, which soon becomes a real nuisance.

This discussion of text height assumes that you’re adding non-annotative text 
in model space. In addition to annotative text in model space, you have a third 
alternative: Add annotative or non-annotative text to a paper space layout — for 
example, when you draw text in a title block or add a set of sheet notes that 
doesn’t directly relate to the model space geometry. When you create text in paper 
space, you specify the actual, plotted paper height instead of the scaled-up height. 
(I cover paper space in Chapter 12.)

Entering Text
AutoCAD offers two different kinds of text objects and two corresponding text-
drawing commands:

 » Single-line text: TEXT (DT). Designed to create single lines. Although you can 
press Enter to create more than one line of text, each line becomes a separate 
text object. Text doesn’t wrap if you add or remove anything.

 » Paragraph text: MTEXT (T): Designed to create multiple lines, with word-
wrapping. AutoCAD groups multiple lines as a single object. Other special 
formatting, such as on a numbered or bulleted list or column, is possible. The 
mText command basically launches a small word processor.
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Although you may be inclined to ignore the older, single-line text option, you 
should know how to use both kinds of text. The TEXT command is quite a bit 
simpler to use than the mText command, and it’s still useful for entering short, 
single-line pieces of text such as object labels and one-line notes. It’s also the 
command of choice for CAD comedians who want to document their one-liners!

Both the TEXT and mText commands offer a full array of text justification 
options — the way the text flows from the point or points that you pick in the 
drawing to locate it. For most purposes, the default left justification (for single-
line text) or top-left justification (for paragraph text) works fine. Occasionally, 
you may want to use a different type of justification, such as center, for labels or 
titles. Both commands provide options for changing the text justification.

Using the Same Old Line
Despite its limitations, the TEXT command is useful for labels and other short 
notes for which mText (multiline) would be overkill. The following steps show 
you how to add text to a drawing by using AutoCAD’s TEXT command.

The TEXT command doesn’t use a dialog box, fancy formatting toolbar, or contex-
tual Ribbon tab, like the mText command’s In-Place Text Editor. You set options 
by typing them in the command line or in the Dynamic Input tooltip.

Here’s how to add text by using the TEXT command:

1. Set an appropriate non-annotative text style current, as described in the 
section “Simply stylish text,” earlier in this chapter.

It’s possible to set an already created text style current at the TEXT command 
prompt, but it’s usually more straightforward to set the style before starting 
the command.

An alternative to opening the Text Style dialog box to make an existing style 
current is to click the Text Style drop-down list and choose the style there. Look 
for the Text Style drop-down list on the Annotation panel’s slideout (on the 
Home tab) or on the Text panel of the Annotate tab.

If you know the name of the text style that you want to use, begin typing it at 
the command line. The AutoCAD command line searches for text styles; they 
appear at the bottom of the command line window. When you see the one you 
want, just select it.
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2. (Optional) Use the Object Snap button on the status bar to enable or disable 
running object snaps.

You may or may not want to snap text to existing objects. For example, you’d 
want to use a Center object snap to locate a letter or number precisely at the 
center of a circle. Make sure that you specify middle-center (MC) text justifica-
tion to ensure that object snapping works perfectly.

3. On the Home tab’s Annotation panel, click the lower part of the big but-
ton labeled Text, and then choose Single Line from the drop-down menu 
to start the TEXT command.

Don’t click the upper part of the Text button. That action starts the multiline 
text command, mText, which I cover in the later section, “Saying More in 
Multiline Text.”

If your text style is annotative and this annotative object is the first one you’re 
creating in this drawing session, AutoCAD usually displays the Select 
Annotation Scale dialog box, which advises you that you are indeed creating an 
annotative object and asks you to set the scale at which you want the annota-
tion to appear; click OK to continue. Later, I explain how and why to turn off 
this annoying dialog box.

AutoCAD tells you the current text style and height settings and then prompts 
you to either select a starting point for the text or choose an option for 
changing the text justification or current text style first:

Current text style: “Standard” Text height: 0.2000 
Annotative: No

Specify start point of text or [Justify/Style]:

4. If you want a justification style different from the default (left), type J, press 
Enter, and choose another justification option.

Look up the term create single-line text in the online Help system if you need 
help with the justification options.

5. Specify the insertion point for the first text character.

You can enter the point’s coordinates from the keyboard, use the mouse to 
click a point onscreen, or press Enter to locate new text immediately below the 
most recent single-line text object that you created.

AutoCAD prompts you for the text height:

Specify height <0.2000>:
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6. Specify the height of the text.

The text height prompt doesn’t appear if you’re using a text style with a fixed 
(that is, nonzero) height. See the “Simply stylish text” section, earlier in this 
chapter, for information about fixed-versus-variable text heights. Now here’s 
the nuisance: If you haven’t specified a fixed height for the current text style, 
you’ll be asked for the text height every time you create text, and you’ll have to 
enter the correctly scaled value to get things to come out right.

AutoCAD prompts you for the text rotation angle:

Specify rotation angle of text <0>:

7. Specify the text rotation angle by typing the rotation angle and pressing 
Enter or by rotating the line onscreen with the mouse.

AutoCAD prompts you to type the text.

8. Type the first line of text and press Enter.

9. (Optional) Type additional lines of text, pressing Enter at the end of each line.

Each line of text is neatly aligned below the previous line and is a separate, 
independent object and cannot be edited as a single paragraph. If you want a 
single paragraph, use the mText command.

10. To stop entering text and return to the command line, press Enter at the 
start of a blank line.

AutoCAD adds to the drawing the new, single-line text object — or objects, if 
you typed more than one line.

Beginning with AutoCAD 2014, the TEXT command remembers its last-used set-
tings (style, justification, height, and rotation angle), so you don’t need to reapply 
them every time.

If your text will occupy more than one line, it is better to use mText, covered later 
in the chapter. To edit single-line text, double-click it to open the In-Place Text 
Editor.

An in-place editing box highlights the selected text object, enabling you to edit 
the contents of the text string. If you want to edit other text properties such as 
text height, select the text, right-click, and choose Properties to display the Prop-
erties palette. Use this palette to change properties as needed.

If the Quick Properties button on the application status bar is enabled, clicking a 
single-line text object opens the Quick Properties panel, allowing you to change 
some (but not all) of the same properties as you can on the Properties palette.
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Saying More in Multiline Text
When you just can’t shoehorn your creative genius into one or more one-line 
pieces of text, AutoCAD’s multiline text object gives you room to go on and on and 
on. The following sections show you how to create multiline text with the mText 
command.

Making it with mText
The first part of the mText command prompts you for various points and options. 
Read the prompts carefully to avoid confusion.

Here’s how to use the mText command:

1. Set an appropriate text style current, and (optional) turn off running 
object snaps, as described in Steps 1 and 2 in the “Using the Same Old 
Line” section, earlier in this chapter.

Make sure to also set an appropriate layer current before creating the text 
object.

2. On the Home tab’s Annotation panel, click the upper part of the split 
 button, labeled Text, to start the mText command.

The command line displays the current text style and height settings and 
prompts you to select the first corner of an imaginary rectangle that deter-
mines the word-wrapping width of the text object:

Current text style: “Standard” Text height: 0.2000 
Annotative: No

Specify first corner:

3. Pick a point in the drawing.

The command line prompts you for the opposite corner of a rectangle that will 
determine the word-wrapping width; it also gives you the option to change 
settings first:

Specify opposite corner or [Height/Justify/ Line spacing/
Rotation/Style/Width/Columns]:

4. Type H and press Enter to change the default text height.

The command line prompts you for a new default text height if the current text 
style has a height of 0.0:

Specify height <0.2000>:
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5. If applicable, type an appropriate text height.

See the “Taking Your Text to New Heights” section, earlier in this chapter, for 
information. If you’re adding text in model space, I highly recommend that you 
use annotative text.

The prompt for the opposite corner of the mText rectangle reappears. The 
command line displays

Specify opposite corner or [Height/Justify/ Line spacing/
Rotation/Style/Width/Columns]:

6. If you want a different justification from the default (top left), type J, press 
Enter, and choose another justification option.

Enter justify multiline text in the Search box of the online Help system if you 
want an explanation of the other justification options.

7. Pick another point in the drawing.

Don’t worry about the height of the rectangle that you create by choosing the 
second point; the width of the rectangle is all that matters. AutoCAD adjusts 
the height of the text rectangle to accommodate the number of lines of 
word-wrapped text. Don’t worry too much about the width, either, because 
you can adjust it later.

The In-Place Text Editor window appears with the tab and indent ruler above it 
(as shown in Figure 13-2), and the previously hidden Text Editor contextual tab 
appears on the Ribbon. If you don’t see the tab and indent ruler at the top of 
the Text Editor window, right-click inside the window, choose Editor Settings, 
and then choose Show Ruler from the right-click menu.

New isn’t always better; you may prefer the classic Text Formatting toolbar over 
the Ribbon’s Text Editor contextual tab. If you want to give the classic version a 
test-drive, change the value of the system variable MTEXTTOOLBAR. The 
default value (2) displays the Text Editor tab only; setting the value to 1 displays 
both the Ribbon tab and the toolbar. I don’t recommend setting this variable to 
0; it turns off the Text Formatting toolbar in all workspaces. For more about 
system variables, see Chapter 23.

Tab and indent ruler

FIGURE 13-2:  
Adding 

 immortal 
 multiline text.
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When you create multiline text in either AutoCAD or AutoCAD LT, text objects 
default to Dynamic Column mode. You can tell that’s what you’re going to get if 
the In-Place Text Editor displays a double-headed-arrow symbol in the center 
of the bottom border of the rectangle you define (refer to Figure 13-2). As I 
indicate earlier, the initial selection window primarily sets the width. By default, 
if you enter enough text to fill the window, mText defaults to splitting the text 
into two columns, as in a newspaper. If you don’t like this arrangement, you 
can dynamically stretch the text editor window to become wider or longer.

If you never want to use columns in the current drawing, click Columns in the 
Insert panel of the Text Editor tab, which appears only when you’re creating or 
editing multiline text. This action sets the MTEXTCOLUMN system variable to 0. 
It affects only the current drawing, so if you never want columns, set it up in 
your template drawings. (I cover templates in Chapter 4.)

8. Verify the text font and height.

The text font and height should be correct if you properly completed Steps 1, 4, 
and 5. If you didn’t, you can change these settings in the Font drop-down list 
and the Text Height text box on the Text Editor tab (or on the classic Text 
Formatting toolbar).

9. Type text into the text area of the In-Place Text Editor.

AutoCAD word-wraps multiline text automatically. If you want to force a line 
break at a particular location, press Enter.

10. If you want to set other formatting options, select text, right-click, and make 
an appropriate choice from the menu, as shown in Figure 13-3.

By convention in most industries, text in drawings is always uppercase. To 
always have your notes in uppercase, right-click in the In-Place Text Editor and 
choose AutoCAPS from the menu.

11. Click Close Text Editor on the Ribbon or OK on the classic Text Formatting 
toolbar.

The In-Place Text Editor window closes, and AutoCAD adds your text to the 
drawing.

You can close the text editor much more easily by simply clicking outside its 
window. But if you like clicking buttons instead, AutoCAD has amply provided 
for you.

12. If you set an annotative text style current in Step 1, assign an annotation 
scale to the multiline text object.

See the “Turning On Annotative Objects” section, later in this chapter.
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As you can tell by looking at the Text Editor tab (or the Text Formatting tool-
bar) and multiline text right-click menu, the mText command gives you plenty of 
other options. You can show or hide the toolbar, the ruler, or the Options buttons, 
and you can give the In-Place Text Editor an opaque background. Other tool but-
tons give you access to columns and numbered or bulleted lists. Both covered in 
the section “Doing a number on your mText lists,” later in this chapter.

Between them, the Text Editor tab (or the Text Formatting toolbar) and the right-
click menu also include a Stack/Unstack feature for fractions, a Find and Replace 
utility, tools for toggling lowercase and uppercase, options for applying back-
ground masks and inserting fields, a special Symbol submenu, and an Import Text 
option for importing text from a TXT (ASCII) file or RTF (Rich Text Format) file. I 
discuss background masks and fields in the next section.) If you think you can use 
any of these other features, choose Resources ➪ Commands ➪ mText in AutoCAD’s 
online Help browser to find out more about them.

mText dons a mask
When you turn on background masking, AutoCAD hides the portions of any objects 
that lie under the multiline text. This feature is used primarily when adding text 
to an area that has already been crosshatched. I cover hatching in Chapter 15. Use 
these steps to turn on, and control, this feature:

FIGURE 13-3:  
Right-click your 

way to textual 
excellence.
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1. Right-click in the In-Place Text Editor and choose Background Mask 
from the menu.

The Background Mask dialog box appears.

2. Mark the Use Background Mask check box so that this option is turned on.

3. Either click Use Drawing Background Color to make the mask the same color 
as the drawing area’s background color or choose a color from the drop-
down list to make the text appear in a solid rectangle of the specified color.

4. Click OK to return to the In-Place Text Editor.

If you’ve turned on background masking but it isn’t having the desired effect, use 
the TEXTTOFRONT command to move the text on top of other objects. Click the 
Bring to Front drop-down button on the Home tab’s Modify panel slideout, and 
choose Bring Text to Front.

Insert Field
The Insert Field option on the In-Line Text Editor’s right-click menu creates a 
text field that updates automatically every time you open, save, plot, or regenerate 
the drawing. Fields can contain data such as the date, filename, or author’s name. 
Fields draw information from the operating system settings, Drawing Properties 
dialog box, sheet sets feature (not covered in this book), AutoCAD system vari-
ables (see Chapter 23), and specific drawing object properties, such as the circum-
ference of a circle or the area enclosed by a closed polyline. Follow these steps to 
add a field while you’re creating multiline text:

1. Right-click in the In-Place Text Editor and choose Insert Field 
from the menu.

The Field dialog box appears.

2. Choose a Field Name in the left column.

3. Choose a Format in the right column or, for date fields, type a format in the 
Date Format box.

4. Click OK.

AutoCAD adds the field to the mText object that you’re creating or editing.

Doing a number on your mText lists
The mTtext command supports bulleted and numbered lists. This feature is 
 especially useful for creating general drawing notes, as shown in Figure 13-4.
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AutoCAD automates the process of creating numbered lists almost completely. 
Follow these steps:

1. Follow Steps 1–8 in the earlier section, “Making it with mText,” to open 
the In-Place Text Editor.

2. Type a title (for example, DESIGN CRITERIA).

If you want the title underlined, click Underline on the Formatting panel before 
you type the title; click Underline again to turn it off. Press Enter to go to the 
next line, and press Enter again to leave a little more space.

3. On the Paragraph panel of the Text Editor tab, click the Bullets and 
Numbering drop-down button; verify that Allow Auto-List, Use Tab Delimiter 
Only, and Allow Bullets and Lists are selected; then click Numbered, as 
shown in Figure 13-4.

The number 1 followed by a period appears on the current line, and the cursor 
jumps to the tab stop that’s visible on the ruler, at the top of the In-Place Text 
Editor window. Enabling the Numbered option places numerals followed by 
periods in front of items in a list. The Bulleted option places bullet characters in 
front of items in a list. Allow Auto-List enables automatic numbering; every 
time you press Enter to move to a new line, AutoCAD increments the number.

4. Type the text corresponding to the current number or bullet.

As AutoCAD wraps the text, the second and subsequent lines align with the tab 
stop, and the text is indented automatically.

Indentation of �rst line

Tab

In-Place Text Editor right-click menu

FIGURE 13-4:  
Tabs, indents, 

and automatic 
numbering are 

set to create 
numbered 

lists.
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5. Press Enter at the end of the paragraph to move to the next line.

As with creating numbered lists in your favorite word processor, AutoCAD 
automatically inserts the next number at the beginning of the new paragraph, 
with everything perfectly aligned.

To create nested numbered or bulleted items (as shown in Figure 13-4), simply 
press Tab at the start of the line. If you change your mind, you can bump up a 
nested text item up one level by selecting the item in the In-Place Text Editor 
and pressing Shift+Tab.

6. Repeat Steps 4 and 5 for each subsequent numbered or bulleted item.

For legibility, you sometimes add spaces between the notes. If you press Enter 
twice to add a blank line, AutoCAD — like every good word processor — thinks 
you’re finished with the list and turns off numbering. AutoCAD is smart, so you 
need to be smarter. If you put the cursor at the end of the first note and press 
Enter, you get a blank line. The problem is, the blank line is now numbered, 
and the intended Note 2 is now Note 3. Just press the Backspace key. The 
number on the blank line disappears, and Note 2 is back to being Note 2. When 
you delete a numbered item, the remaining numbers adjust automatically.

If you don’t like the horizontal spacing of the numbers or the alignment of 
subsequent lines, you can adjust them easily by manipulating the tab and 
indent markers in the In-Place Text Editor’s ruler.

7. In the ruler, drag the upper slider (the triangle pointing down) to the right 
a short distance. Drag the lower slider (the triangle pointing up) a slightly 
greater distance to the right.

The upper slider controls the indentation of the first line in each paragraph. 
The lower slider controls the indentation of the second and subsequent lines. 
An indent of one to two of the short, vertical tick marks usually works well for 
the first line. An indent of two to four tick marks works well for the second and 
subsequent lines.

8. Click in the ruler just above the lower slider.

A small L appears above the lower slider. The L shows the left-justified tab stop.

Make sure that the corner of the L aligns horizontally with the point of the 
lower slider triangle. If not, click and drag the L until it aligns.

If you prefer to manually enter tab and indent distances (rather than adjust them 
with the cursor), open the Paragraph dialog box by either

 » Clicking the little arrow at the right end of the Paragraph panel label (in 
AutoCAD-ese, it’s a Panel dialog box launcher)

 » Right-clicking inside the In-Place Text Editor and choosing Paragraph
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Whichever way you do it, if you select text first, the tab and indent changes apply 
to the selected text. If you don’t select text first, the changes apply to new text 
from that point forward in the multiline text object.

Line up in columns — now!
The text functionality of AutoCAD is becoming more word processor-like. A few 
releases back, it was simple indents, and then came numbered and bulleted lists. 
The most recent addition to multiline text is columns.

Columns come in two flavors:

 » Static: You specify the number of columns into which you want text to flow. 
Columns are always the same height, and text is allowed to overflow the final 
column if there’s too much of it.

 » Dynamic: As you might expect, these columns are friendlier and more 
flexible, and they’re the life of any party. You can individually adjust column 
heights, and new columns are added automatically to accommodate the text.

Selecting either column type also offers you the Column Settings dialog box, where 
you can specify values numerically rather than drag grips. Figure 13-5 shows a 
block of multiline text imported as an RTF file from a word processor and then 
formatted in dynamic columns using the Manual Height option.

Setting up columns is straightforward, as these steps explain:

1. Open a drawing that contains a large, multiline text object, or create a 
large, multiline text object in a new drawing.

FIGURE 13-5:  
Dynamically 
columnizing 

the text.
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If you already have drawing specifications or general notes in a word processing 
document, or even in a text file, you can right-click inside the mText command’s 
In-Place Text Editor and choose Import Text. The Select File dialog box opens, 
giving you the choice of Rich Text Format (RTF) or ASCII text (TXT) files.

2. If the In-Place Text Editor isn’t already open, either double-click the text; or 
select it, right-click, and choose Mtext Edit.

3. Click Columns in the Insert panel and choose either Dynamic Columns or 
Static Columns.

If you choose Dynamic Columns, select either Auto Height or Manual Height. 
Selecting Manual Height puts grips on each column so that you can adjust their 
height individually (refer to Figure 13-5). Auto Height displays a single grip so 
that the heights of all columns remain the same, but new columns are still 
added as required by the amount of text.

If you choose Static Columns, select the number of columns you want from the 
menu. Clicking 2, for example, creates two columns regardless of the length of 
the text. You may end up with overflowing text or empty columns.

4. Click Close Text Editor on the Ribbon (or OK on the Text Formatting toolbar) 
when you’re satisfied with the column arrangement.

You can revert to a noncolumnar arrangement by clicking the Columns button 
in the Insert panel and choosing No Columns.

Modifying mText
After you create a multiline text object, you can edit it in the same way as a single-
line text object: Select the object, right-click, and choose Mtext Edit or Properties.

 » Mtext Edit: Selecting this option opens the In-Place Text Editor window so 
that you can change the text contents and formatting.

 » Properties: Selecting this option opens the Properties palette, where you can 
change the overall properties of the text object.

 » Quick Properties: Enable this setting on the status bar so that when you 
select a multiline text object, the Quick Properties palette opens, in which you 
can modify a subset of the mText object’s properties.

The easiest way to change the word-wrapping width of a paragraph text object is 
to grip-edit it. Select the text object, click a corner grip, release the mouse button, 
move the cursor, and click again. Chapter 11 describes grip-editing in detail.
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Just like any good word processor or text editor, AutoCAD includes both a spel 
chekcqing and a find-and-replace tool for text. To check the spelling of selected 
annotation objects or the entire drawing, click the Annotate tab on the Ribbon and 
choose Check Spelling from the Text panel to display the Check Spelling dialog 
box. On the same panel, clicking Find Text (or typing FIND and pressing Enter) 
displays the Find and Replace dialog box. Handily, both Find and Replace and Spell 
Check are also accessible from the Text Editor tab’s Spell Check and Tools panels, 
in case you want to replace text or check spelling within a single multiline text 
object. Look up SPell or FIND in the online Help system if you need more informa-
tion on either command.

Turning On Annotative Objects
Annotative objects were introduced in AutoCAD 2008, ending 25 years of calculation 
agony, but a quick show of hands in classes at Autodesk University and AUGI CAD 
Camp reveals that only 20 percent of students, on average, have ever tried using 
annotative objects — and most of the students abandoned them to return to the old 
way, in the belief that they weren’t working. I provide an explanation in a moment.

Make sure that you’re in model space, and follow these steps to enable the use of 
annotative scaling for new or modified annotation objects.

1. Set the Annotation controls.

In the lower-right corner of the AutoCAD status bar, you find three buttons 
with variants of a triangular symbol. They represent the end view of an 
engineer’s triangular scale; an old-timer in your office should be able to show 
you one and how they worked. If the person has a rubber band in the other 
hand, be ready to duck. Click the Annotation Visibility (middle) and 
Automatically Add Scales to Annotative Objects (right-hand) buttons, until 
they’re grayed out and don’t show a small, yellow splash in them. If the 
Annotation Scale (left-hand) button doesn’t display the scale 1:1, click it and 
select 1:1 from the drop-down list.

2. Select an annotative text style.

Use the STyle command as described in the earlier section “Get in style,” and 
set the Annotative text style current. Set its paper text height to 0.125.

3. Create a text object.

Use the TEXT command and create a line of text that says Scale 1:1.

The first time you place annotative text, you’re asked to select a drawing scale, 
and it defaults to the current scale, which is probably what you want, anyway. 
Eventually, it becomes a nuisance, so the check box lets you turn it off.
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4. Change the drawing scale.

Click the Annotation Scale (left-hand) button and choose 1:2 from the drop-
down list. This step sets the current drawing scale to 1:2. Hey, the first piece of 
text disappears! Not to worry — that’s what it’s supposed to do.

5. Create a text object.

Use the TEXT command again to create a line of text that says Scale 1:2, and 
another one that says Both scales. Note that they’re twice as tall as the now-
invisible Scale 1:1 text, even though you didn’t specify a height.

6. Change the drawing scale.

Click the Annotation Scale (left-hand) button and choose 1:1 from the drop-
down list. Interesting! The first piece of text reappears, but the other two 
disappear!

7. Add another scale to an object.

Click the Annotation Scale (left-hand) button and choose 1:2 from the drop-
down list. Then click the Both scales text and right-click. Choose Annotative 
Object Scale and then choose Add/Delete Scales. When the dialog box appears, 
click the Add button in the upper-right corner and then choose 1:1 from the 
list. Click OK, and then click OK again to return to the drawing screen.

8. Change the drawing scale.

Click the Annotation Scale (left-hand) button and choose 1:1 from the drop-
down list. Interesting! The Scale 1:1 text reappears, Scale 1:2 disappears, and 
the Both scales size changes to match the height of the Scale 1:1 text!

9. Change the drawing scale again.

Click the Annotation Scale (left-hand) button and choose 1:5 from the drop-
down list. All three text items disappear!

Here’s what I want you to remember about annotative objects:

 » Upon creation, annotative objects automatically size themselves to suit the 
current drawing scale; they’re visible only when their annotation scales match 
the current drawing scale; and they can have more than one scale attached, 
so they’re visible in more than one drawing scale setting.

Better yet, they exhibit this same behavior in paper space viewports. It thus 
becomes trivially easy to set up drawings with details at other scales. I cover 
this topic in more detail in Chapter 15.

 » If an annotative object has multiple scales attached and you edit its location at 
one scale, its location at the other scales isn’t affected.
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 » When viewing an object with multiple scales, you aren’t looking at multiple 
objects but rather at a single object with multiple representations. To see 
what I mean about different representations, change the text string of the 
Both scales text object that you created earlier to a different value. The new 
value automatically appears in all scale representations for that text object.

Now I reveal the dirty, dark secret of why most people give up on annotative 
objects. It all goes back to the annotative controls:

 » When the Annotation Visibility (middle) button is turned on, all the annotative 
objects at all scales are always visible, regardless of the value of the current 
drawing scale, even if none of the objects has a scale that matches the current 
drawing scale. You should only turn this option on when you want to move 
the different representations of your annotative objects around on-screen.

 » If you turn on the Automatically Add Scales to Annotative Objects (right-hand) 
button and then change the drawing scale, every annotation object retroac-
tively gets the current scale added to it. This is not something you want to do 
except in the situation of when you create a drawing to print at a specific scale 
and then decide to change the scale to suit a different printer or paper size.

By themselves, both options can give you some headaches, but if both options are 
enabled at the same time and you switch the current scale it is not obvious that 
you might have accidentally added the current scale to all the annotative objects 
in your drawing.

Most of the time, for most people, there are way too many scales listed in the 
Add Scales to Object dialog box. AutoCAD has a handy-dandy Edit Drawing Scales 
dialog box that lets you remove those imperial scales from the current drawing if 
you never work in feet and inches. And vice versa, for the metrically challenged. 
To run through the scales, choose Scale List on the Annotation Scaling panel of the 
Ribbon’s Annotate tab. If you make a mistake, pressing the Reset button restores 
all default scales. You can remove those extra scales for all drawings in the Default 
Scale List dialog box, accessible from the User Preferences tab of the Options dia-
log box.

Figure 13-6 shows two views of the same drawing. The hatching and the 1.400 
dimension were created once but have resized themselves to appear correctly in 
the two views at two different scales.
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Gather Round the Tables
You don’t know the meaning of the word tedious unless you’ve tried to create a 
column-and-row data table in older versions of AutoCAD by using the Line and 
TEXT commands. AutoCAD’s table object, and the TABLESTYLE and TABLE com-
mands for creating it, make the job almost fun.

Table objects in AutoCAD are not annotative, so you have just two methods of add-
ing them to drawings: Create them in model space, scaling them up by the drawing 
scale factor (see Chapter 4 for more) or — this one seems more  sensible — create 
them in paper space, defining them by their actual plotted (paper) dimensions.

Tables have style, too
You control the appearance of tables — both text and cells — with table styles just 
as you control the appearance of stand-alone text by using text styles. Use the 
TABLESTYLE command to create and modify table styles. Follow these steps to 
create a table:

1. On the Home tab, click the Annotation panel’s label to open its slideout, 
and then choose Table Style.

The Table Style dialog box appears.

2. In the Styles list, select the existing table style whose settings you want to 
use as the starting point for the settings of the new style.

For example, select the default table style named Standard.

FIGURE 13-6:  
Annotative 

objects resize 
automatically 

as the annota-
tion scale 
changes.
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3. Click New to create a new table style that’s a copy of the existing style.

The Create New Table Style dialog box appears.

4. Enter a new style name and click Continue.

The New Table Style dialog box appears, as shown in Figure 13-7.

5. In the Cell Styles area, with Data showing in the list box, specify settings for 
the data alignment, margins, text, and borders.

The settings you’re likely to change are Text Style, Text Height, and perhaps 
Text Color. All three are on the Text tab. Grid Color is on the Borders tab. If you 
leave colors set to ByBlock, the text and grid lines inherit the color that’s 
current when you create the table. That color will be the current layer’s color.

6. In the Cell Styles area, open the drop-down list and repeat Step 5 for the 
Headers (that is, the column headings) and the Title styles.

7. Click OK to close the New Table Style dialog box.

The Table Style dialog box reappears.

8. Click Close.

The new table style becomes the current table style that AutoCAD uses for 
future tables in this drawing, and the Table Style dialog box closes. Now you’re 
ready to create a table, as described in the next section.

You can access the Manage Cell Styles dialog box directly from the Cell Styles 
drop-down list of the New Table Style dialog box. The Table Cell Format dialog 
box (on the General tab, in the Format row, click the ellipsis button) provides a 
number of additional options for formatting cells by data type.

FIGURE 13-7:  
Setting the 

table.
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AutoCAD stores table styles in the DWG file, so a style that you create in  
one drawing isn’t immediately available in others. You can copy a table style 
from one drawing to another using DesignCenter. Use the steps for copying  
layers between drawings that I outline in Chapter 9, but substitute Tablestyles 
for Layers. Table styles can also be defined in drawing template files, which  
I discuss in Chapter 4.

Creating and editing tables
After you create a suitable table style, adding a table to a drawing is easy, with the 
TABLE command. Here’s how:

1. Set an appropriate layer current.

Assuming that you leave the current color, linetype, and lineweight set to 
ByLayer, as I recommend in Chapter 9, the current layer’s properties control 
the properties of all table parts that were set to ByBlock when in the assigned 
table style. Refer to Step 5 in the preceding section, “Tables have style, too.”

2. On the Home tab’s Annotation panel, click Table.

The Insert Table dialog box appears.

3. Choose a table style from the Table Style drop-down list.

4. Choose an insertion behavior:

• Specify Insertion Point: Pick the location of the table’s upper-left corner; use 
the lower-left corner instead if you set Table Direction to Up in the table 
style. When you use this method (the easiest), you specify the default col-
umn width and number of rows in the Insert Table dialog box.

• Specify Window: Pick the upper-left corner and then the lower-right corner. 
When you use this method, AutoCAD automatically scales the column 
widths and determines how many rows to include.

5. Specify column and row settings.

• If you chose Specify Insertion Point in Step 4, you must set the number of 
columns and data rows that the table should be created with along column 
width and row height.

• If you chose Specify Window in Step 4, AutoCAD sets the column width 
and the number of data rows to Auto. AutoCAD then figures them out, 
basing those values on the overall size of the table that you specify in Steps 
7 and 8. While AutoCAD calculates the column width and number of data 
rows to use for the table automatically, you must still specify the number 
of columns and row height values to create the table.
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6. Click OK.

AutoCAD prompts you to specify the insertion point of the table.

7. Click a point or type coordinates:

• If you chose Specify Insertion Point in Step 4, AutoCAD draws the table 
gridlines, places the cursor in the title cell, and displays the Text Editor tab 
on the Ribbon.

• If you chose Specify Window in Step 4, specify the diagonally opposite 
corner of the table.

AutoCAD draws the table based on the table size you indicated and chooses 
the column width and number of rows.

8. Type a title for the table.

9. Type values in each cell, using the arrow keys or Tab key to move among cells.

The cell right-click menu offers many other options, including copying contents 
from one cell to another, merging cells, inserting rows and columns, changing 
the formatting, and inserting a block which is a graphical symbol; see 
Chapter 17 for information about blocks.

You can insert a field into a table cell. For example, you might create part of a 
title block, with fields serving as the date and drawn by data.

10. Click Close Text Editor on the Ribbon or click OK on the Text Formatting 
toolbar.

Figure 13-8 shows a completed table, along with the Insert Table dialog box.

FIGURE 13-8:  
The Insert  

Table dialog 
box and  

one result  
of using it.
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Edit the cell values by double-clicking in a cell. To change the column width or 
row height, click the table grid and then click and move the blue grips. To change 
the width of one column without altering the overall width of the table, hold down 
the Ctrl key while you move the grip. If you want to change other aspects of a table 
or individual cells in it, select the table or cell and use the Quick Properties palette 
or the Properties palette to make changes.

The DATAEXTRACTION and DATALINK commands are powerful tools in Auto-
CAD. You can use them to link all or part of an Excel spreadsheet into a table in a 
drawing; or interrogate a drawing to produce a great variety of information from 
it (such as sizes, areas, perimeters, and quantities of drawing objects) and then 
create a linked table of the data; or write the data to an Excel spreadsheet — or 
all three options at once. A detailed description of these functionalities is beyond 
the scope of this book, but several online references are available that cover them. 
These two can get you started:

www.cadalyst.com/cad/autocad/tell-me-all-you-know-attribute-
extraction-part-1-learning-curve-autocad-tutorial-6271

www.cadalyst.com/cad/autocad/tell-me-all-you-know-and-even-more- 
advanced-attribute-extraction-part-2-learning-curve-a333333

Take Me to Your Leader
Don’t worry — I’m not a space alien, popular opinion to the contrary. No, I’m 
talking about notes with arrows pointing to drawing objects that you need to 
embellish with some verbiage.

Multiline leaders (mleaders, for short) are a vast improvement over the old-style 
leaders, available in releases before AutoCAD 2008. In fact, they’re so good that 
they should be running the United Nations! Mleaders, unlike the old-style lead-
ers, are single objects. They can also point in multiple directions at a time; just 
don’t ask them which way is the bus station. Finally, multileaders — just like text, 
dimensions, hatching, and other objects you use to document drawings — can be 
annotative.

http://www.cadalyst.com/cad/autocad/tell-me-all-you-know-attribute-extraction-part-1-learning-curve-autocad-tutorial-6271
http://www.cadalyst.com/cad/autocad/tell-me-all-you-know-attribute-extraction-part-1-learning-curve-autocad-tutorial-6271
http://www.cadalyst.com/cad/autocad/tell-me-all-you-know-and-even-more-advanced-attribute-extraction-part-2-learning-curve-a333333
http://www.cadalyst.com/cad/autocad/tell-me-all-you-know-and-even-more-advanced-attribute-extraction-part-2-learning-curve-a333333
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Electing a leader
You can draw multileader objects that consist of leader lines and multiline text at 
the same time by using the MLeaDer command; follow these steps:

1. Set a multileader style that’s appropriate for your needs.

Choose an existing style from the Multileader Style drop-down list on the 
Home tab’s Annotation panel slideout, or create a new style by clicking the 
Multileader Style button on the Annotation slideout. Visit the online help 
system for tips on creating new multileader styles.

2. Choose Multileader from the Annotation panel.

The command line prompts you to select the location of the pointy end of the 
leader arrowhead:

Specify leader arrowhead location or [leader Landing first/
Content first/Options] <Options>:

The initial default method is to locate the arrowhead, followed by the leader 
landing (that is, the short horizontal line between the leader line and the text), 
at which point AutoCAD displays the In-Place Text Editor and you enter the text 
of your note. If you’d rather place the leader landing first, type L and press 
Enter. If you’d rather type the content first, type C and press Enter.

If you want to draw spline-curved rather than straight leader lines, specify the 
number of pick points for the leader lines and press Enter to display multil-
eader options at the command line or the Dynamic Input tooltip. Refer to the 
online Help for more information on the command options.

OLD LEADER STYLES
Two older-style leaders are stored in AutoCAD’s attic. Autodesk hates to throw anything 
away because someone will complain about needing it for a vital custom menu macro 
that was created 20 years ago. These semiretired leaders are no longer accessible on 
menus or toolbars, but they’re still lurking up there, waiting to . . . er, lead you astray. If 
you’ve become attached to typing commands, you may be inclined to type LEADer to 
create those pointy-headed thingies. If you do, be aware that the LEADER command runs 
the positively ancient command for creating notes-with-arrows. There are no options, 
so you see only straight leader lines and infinitely long text strings. LE (the alias of the 
qLEader command) runs the merely elderly command for creating notes-with-arrows; 
this one has a Settings dialog box where you can set some options, and it asks you to 
specify a width for the mText note. However, unlike multileaders, both LEADer and 
qLEader create the leader lines and the text as two separate objects.
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3. Pick a location in the drawing that you want the leader to point to.

If you use an object snap mode, such as NEArest or MIDpoint, to pick a point 
on an object, AutoCAD associates the leader with the object. If you later move 
the object, AutoCAD updates the leader so that it points to the new location.

The command line prompts you for the next point.

4. Pick a second point.

AutoCAD draws a shaft from the arrowhead to this point.

Don’t pick a second point that’s too close to the arrowhead point. If AutoCAD 
doesn’t have enough room to draw the arrowhead, it omits the arrowhead.

By default, AutoCAD lets you pick two points for the leader line: The first point 
locates the arrowhead, and the second point locates the start of the short 
horizontal leader landing. If you need more points than that, restart the 
command and choose Options, Maxpoints and set a new value. After you pick 
the point for the leader landing, the In-Place Text Editor opens.

5. Type your text.

You’re now in the same In-Place Text Editor I describe earlier in this chapter, 
with the same Text Editor tab and options.

6. Click Close.

Your text is added to the drawing, next to the leader.

Figure 13-9 shows several different leaders with notes.

FIGURE 13-9:  
No loss for 

(multi)leaders.
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You can use grips to manipulate a multileader’s individual components, just as if 
it were several objects instead of a single object. Hold down the Ctrl key and click 
a multileader to select different pieces. You can even use grips to adjust the width 
of multileader text as if it were an everyday mText object.

Multi options for multileaders
In addition to using the MLeaDer command itself, multileaders come with a slew 
of formatting, drawing, and editing commands:

 » MLeaderEdit: Use this command to add or remove leader lines from multi-
leader objects. You’ll find each of those functions on the Multileader drop-
down list (refer to Figure 13-9).

 » MLeaderStyle: Multileaders, like text and dimensions, are formatted accord-
ing to named styles. To display the Multileader Style Manager dialog box, click 
Multileader Style on the Home tab’s Annotation slideout.

 » MLeaderAlign: A tedious chore in earlier AutoCAD versions was making all 
the leaders line up by using a construction line and then using object snaps 
to move common points on the leaders to the construction line. To line up 
multileaders, choose Align from the Multileader drop-down list.

 » MLeaderCollect: Multileaders can contain blocks as well as text. I cover 
blocks in Chapter 17. Choose Collect from the Multileader drop-down list to 
gather a group of leaders containing blocks; they’ll rearrange themselves as a 
single multileader containing the multiple blocks.

For more information on any of these commands, look them up by name in the 
Command Reference section of the online help system.

Multileaders and multileader styles can be annotative or non-annotative. Making 
them annotative and assigning appropriate annotation scales is a huge timesaver 
for creating them initially and for creating detail views at different scales.
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Modifying dimensions

Entering New 
Dimensions

In drafting, either CAD or manual, dimensions are special text labels with 
attached lines that, together, clearly indicate the size of things. Although it’s 
theoretically possible to draw all the pieces of a dimension by using AutoCAD 

commands such as Line and mText, dimensioning is such a common drafting task 
that AutoCAD provides special commands to do the job more efficiently. These 
dimensioning commands group the parts of each dimension into a convenient, 
easy-to-edit package, much like a block. In fact, AutoCAD actually produces each 
dimension as something it calls an anonymous block. I discuss blocks in Chapter 17.

Even better, as you edit an object, by stretching a line for example, AutoCAD 
automatically updates the measurement displayed in the dimension text label 
to indicate the object’s new size. And perhaps best of all, AutoCAD’s annotative 
dimensions adjust their text height and arrowhead size automatically to suit the 
annotation scale on the model tab or the viewport scale in a layout. I explain the 
general principles of annotative objects in Chapters 13 and 15; in this chapter, I 
take a close look at annotative dimensions.

Chapter 14
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Adding Dimensions to a Drawing
I start off with an exercise to introduce AutoCAD’s dimensioning functionality by 
creating linear dimensions that show the horizontal or vertical distance between 
two points:

1. Start a new drawing, using the acad.dwt template file.

This step creates a drawing that uses imperial units, even if your default 
installation uses metric. It saves lazy writers from having to duplicate instruc-
tions for metric users.

2. Use the Line command to draw a non-orthogonal line.

A non-orthogonal line is a segment that’s neither horizontal nor vertical. Make 
the line about 6 units long, at an angle of about 30 degrees upward to the right.

3. Set a layer that’s appropriate for dimensions as current.

Okay, you started from a blank template, so it doesn’t have specific layers, but I 
included this step as a gentle reminder. As I discuss in Chapter 9, you normally 
set dedicated layers for visible edges, hidden edges, text, dimensions, section 
lines, hatching, and so on.

AutoCAD 2016 added a significant enhancement to dimensioning. You can now 
define an override layer so that all dimensions automatically end up on their own 
layer. See the "And The Correct Layer Is . . ." section at the end of this chapter.

4. Start the DimLInear command by clicking the down arrow at the bot-
tom of the Dimension button on the left side of the Annotate tab’s 
Dimensions panel and click Linear, or type DLI and press Enter.

AutoCAD prompts you:

Specify first extension line origin or <select object>:

5. To specify the origin of the first extension line, snap to the lower-left end-
point of the line by using an ENDpoint object snap.

If you don’t have ENDpoint as one of your current running object snaps, specify 
a single endpoint object snap by holding down the Shift key, right-clicking, and 
choosing ENDpoint from the menu that appears. See Chapter 8 for more 
about object snaps.

AutoCAD prompts you:

Specify second extension line origin:

You must use object snaps or object selection when applying dimensions in 
order to make later editing work properly.
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6. To specify the origin of the second extension line, snap to the other endpoint 
of the line by using an ENDpoint object snap again.

AutoCAD draws a horizontal dimension (the length of the displacement in the 
left-to-right direction) if you move the cursor above or below the line. It draws a 
vertical dimension (the length of the displacement in the up-and-down 
direction) if you move the cursor to the left or right of the line.

AutoCAD prompts you:

Specify dimension line location or  
[Mtext/Text/Angle/Horizontal/Vertical/Rotated]:

7. Move the mouse to generate the type of dimension you want — horizontal or 
vertical — and then click wherever you want to place the dimension line.

AutoCAD draws the dimension.

When you’re specifying the dimension line location, you usually don’t want to 
object-snap to existing objects. Rather, you want the dimension line and text to 
sit in a relatively empty part of the drawing rather than have it bump into 
existing objects. If necessary, temporarily turn off running object snap (for 
example, click the OSNAP button on the status bar) to avoid snapping the 
dimension line to an existing object.

If you want to be able to align subsequent dimension lines easily, turn on Snap 
mode and set a suitable snap spacing (more easily done than said!) before you 
pick the point that determines the location of the dimension line. See 
Chapter 8 for more information about Snap mode. You can use the DIMSPACE 
command to select several existing dimensions and then automatically space 
them equally.

8. Repeat Steps 4–7 to create another linear dimension of the opposite orienta-
tion (vertical or horizontal).

9. Click the line to select it.

10. Click one of the grips at an end of the line and drag it around.

The dimensions automatically update, live and in real time, to reflect the current 
values as you move the mouse.

You probably don’t want dimension to have four decimal places, or maybe you 
want to use a different font for dimension text, or use both imperial and metric 
units, or show manufacturing tolerances. Not a problem! AutoCAD controls the 
look of dimensions by means of dimension styles, just as it controls the look of 
text and tables with styles. In fact, AutoCAD uses text styles also to control the 
appearance of text in dimensions. I cover dimension styles in more detail later 
in this chapter, but suffice it to say that AutoCAD has about 80 variables that can 
be used to warp dimensions into just about any perversion that your industry or 
company can imagine.
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A Field Guide to Dimensions
AutoCAD provides several types of dimensions and commands with which to draw 
them; most commands are shown in Figure 14-1. These commands are found on 
the Dimensions panel of the Annotate tab on the Ribbon. If you can’t find the but-
ton you want, it’s probably hidden in the drop-down list, under the larger button 
on the left side of this panel. This panel remembers the last button you used, so at 
any given time, it may be displaying any one of the following buttons.

You can also find these basic dimension commands in the upper-right corner 
of the Annotation panel of the Home tab on the Ribbon. Remember that the last 
one you used stays on top, so the one you want now may be under the one that is 
displayed.

WHY DIMENSIONS IN CAD?
You may think that CAD would have rendered text dimensions obsolete. After all, you 
comply with all my suggestions about using AutoCAD’s precision techniques when you 
draw and edit, and you’re careful to draw each object at its true size, right? The contrac-
tor or machinist can use AutoCAD to simply query distances and angles in the DWG file, 
right? Sorry, but no (to the last question, anyway). Here are a few reasons why the tradi-
tional dimensioning that CAD drafting has inherited from manual drafting is likely to be 
around for a while:

• Some people need to or want to use paper drawings when they build some-
thing. Even with mobile devices (such as AutoCAD 360 running on Apple iPad or 
Google Nexus tablets), we’re still some time away from the day when contractors 
haul computers around on their tool belts, never mind mousing around drawings 
while hanging from scaffolding.

• In many industries, paper drawings still rule legally. Your company may supply 
both plotted drawings and DWG files to clients, but your contracts probably specify 
that the plotted drawings govern in the case of any discrepancy. The contracts prob-
ably also warn against relying on any distances that the recipient of the drawings 
measures — using measuring commands in the electronic drawing file or a scale on 
the plotted drawing. The text dimensions are supposed to supply all the dimensional 
information that’s needed to construct the object.

• Dimensions sometimes carry information in addition to the basic length or 
angle. For example, dimension text can indicate the allowable manufacturing toler-
ances or show that a particular distance is typical of similar situations elsewhere on 
the drawing, or they can simultaneously show imperial and metric values.
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In the following list, the three characters (in parentheses) is the shortened  
command name (command alias) you can also enter:

 » Linear — DimLInear (DLI): Indicates the linear extent of an object or the lin-
ear distance between two points. Most linear dimensions are either horizontal 
or vertical, but you can draw dimensions that are rotated to other angles, too.

 » Aligned — DimALigned (DAL): Similar to linear dimensions, but the dimen-
sion line tilts to the same angle as a line drawn through the origin points of its 
extension lines.

You don’t always have to pick points when placing dimensions. Watch the 
command line; it may ask you to

Specify first extension line origin or <select object>:

If you press Enter instead of picking the first point, AutoCAD prompts you to 
select an object. And when you do, it automatically selects each end of the 
object for you.

 » Angle — DimANgle (DAN): Indicates the angular measurement between two 
lines, the two endpoints of an arc, or two points on a circle. The dimension 
line appears as an arc that indicates the sweep of the measured angle.

 » Radial — DimDIameter (DDI), DimRAdius (DRA): A diameter dimension 
calls out the diameter of a circle or an arc, and a radius dimension shows the 
radius of a circle or an arc. You can position the dimension text inside or out-
side the curve; refer to Figure 14-1. If you position the text outside the curve, 
AutoCAD draws (by default) a little cross at the center of the circle or arc. 
AutoCAD automatically adds the diameter and radius symbols to the appro-
priate dimension type.

FIGURE 14-1:  
Examples of 

dimensioning 
commands.
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Because radius and diameter dimensions seem to do the same thing, you 
might wonder when you should use which one. In most drafting disciplines, 
the convention is to use diameter dimensions for whole circles (for example, a 
hole) and use radius dimensions for part circles or arcs (for example, a fillet).

You can also use DimLInear to dimension a circle or an arc. Trying to pick the 
endpoints of a circle can keep you busy for several hours, but if you press 
Enter at the first prompt and then select a circle or an arc, it applies a linear 
dimension across the diameter. You can also use a QUAd object snap to pick 
two diametrically opposite points on the circle.

 » Arc Length — DimARc (DAR): Measures the length along an arc, and then 
applies a curved dimension line that’s concentric with the arc.

 » Jog — DimJOgged (DJO): When dimensioning arcs, it is standard drafting 
practice to create a dimension line that starts at the center of the arc and 
proceeds outward to the arc itself. A problem arises, however, when dimen-
sioning an arc with a very large radius. The center may be at an inconvenient 
location where the dimension line would interfere with other geometry or, 
worse, it may be well beyond the edge of the final drawing. DimJOgged neatly 
solves this problem for you. It works almost exactly like DimARc except that 
it asks you to specify two extra points. After you select the arc (or circle, 
strangely enough), it then asks you to specify a center override point and then 
a location for the jog itself. The resulting dimension line consists of three seg-
ments, starting at the center override point: The first and last point to the real 
center; the middle segment connects the first and last points by putting a jog 
in the line.

 » Ordinate — DimORdinate (DOR): Applies X or Y coordinate values from the 
origin point. Certain types of mechanical parts can have a great many holes 
and other features. The drawing would become impossibly cluttered if you 
were to apply two traditional dimensions to show the X and Y locations of 
each detail. Common practice in this situation is to use ordinate dimension-
ing. Each ordinate dimension appears simply as a single extension line and 
a number showing the X or Y distance from the origin (0,0) of the drawing or 
from the origin of the current user coordinate system (UCS), if there is one. I 
cover UCSs in Chapter 21. Normal practice is to specify the lower-left corner 
of the part as the origin. The X and Y values are usually aligned neatly in a 
row and column along the edge of the part. There are no dimension lines or 
arrowheads.

 » Center lines — DIMCENTER: Creates center lines or center marks on circles 
and arcs without applying a dimension. The definition of lines versus marks 
matches the current dimension style, as described later in this chapter.
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Self-centered
AutoCAD 2017 introduced a new associative functionality in the form of associa-
tive center lines. This involves two commands:

 » CENTERLINES: Prompts you to select two lines. AutoCAD then draws a center-
line midway between the two lines using a long-dash–short-dash line style.

 » CENTERMARK: Prompts you to select a circle or an arc. AutoCAD then draws 
two centerlines that cross at the exact center of the circle or arc.

Now comes the magic part. Centerlines created using these two commands are 
fully associative to the lines, circles, or arcs that were used to define them. If you 
move an arc or a circle or change its radius, or if you move either line or either 
end of either line, the centerlines obediently follow and remain properly centered.

Associative centerlines are automatically placed on a Center lines layer with a 
Center2 linetype override. If this layer doesn’t exist, AutoCAD automatically cre-
ates it with a white/black color and the Continuous linetype. If this layer already 
exists in your template file, AutoCAD uses the color you specified, but ignores the 
linetype assigned to the layer and applies the Center2 linetype override.

Quick, dimension!
Three dimensioning commands can help you place multiple dimensions very 
quickly. They’re found near the middle of the Dimensions panel of the Annotate 
tab on the Ribbon.

 » Continue — DimCOntinue (DCO): Having placed one linear dimension in 
the drawing, you can now carry on placing a series of dimensions end-to-end. 
AutoCAD automatically picks the end of the previous dimension as the start of 
the next one, so you need pick only the end of the next one.

 » Base — DimBaseline (DBA): This one works much like DimCOntinue except 
that AutoCAD selects the start of the previous one as the start of the next one. 
You thus end up with a series of stacked dimensions, all measuring from a 
common starting point.

 » Quick Dimensions — QDIM: Interestingly, this is one of the few dimensioning 
commands that doesn’t start with DIMxxx. When you invoke it, it invites you 
to select objects. The best bet usually is to use one or more window selec-
tions (pick from left to right), each of which completely surrounds several 
objects. Now whenever you press Enter, AutoCAD automatically applies 
DimLInear dimensions wherever it can, and you might be surprised at some 
of those places. It can place dimensions in several formats, including continue, 
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baseline, staggered, ordinate, and several others. For convenience in repeat 
operations, it remembers the last mode you used.

If you want to be superefficient, memorize the three-letter command aliases for 
the dimension commands you use most often, of which DIM should top the list. 
Refer to upcoming Figure 14-2 to see the aliases of the most common commands.

And now for the easy way
AutoCAD 2016 added several enhancements that greatly simplify the application 
of dimensions. The first improvement is the DIM command, which has nothing to 
do with brightness. The DIM command can replace the following five dimension 
commands, resulting in the same dimensions but with a lot less effort:

 » DImLinear: With DIM, after you select two points or an object, moving the 
cursor horizontally produces a vertical dimension and moving the cursor verti-
cally produces a horizontal dimension.

 » DimALigned: Using DIM, once you select two points or an object, moving 
the cursor perpendicular to the imaginary line between the defining points 
produces a dimension that is aligned parallel to the imaginary line between 
the defining points.

 » DimANgle: If you pick two lines or an arc, DIM produces the angle dimension 
between them.

 » DimDIameter and DimRAdius: If you select an arc or a circle, DIM knows the 
difference and applies a diameter or radius dimension as appropriate.

The DIM command has an additional set of characteristics to enhance your dimen-
sioning experience:

 » Unlike the older individual commands, you do not need to differentiate 
between picking exact start and end points as opposed to selecting an 
object. If you select an object such that your pick point is close to an object 
snap point, DIM will snap to it. But if you select an object in such a way that it 
doesn’t find a snap point, DIM automatically selects the picked object.

 » Running object snaps won’t snap to the end of an extension line that is closest 
to the object being dimensioned. Instead, DIM snaps to the end of the dimen-
sion line itself and hence creates a continuing dimension.

 » After you have placed a dimension, you don’t need to restart the DIM com-
mand; it reverts to asking you to begin defining the next dimension. In this 
way, you can place the vast majority of dimensions in a typical drawing with 
just one run of the DIM command.
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 » While the DIM command is running, the command line shows several options 
that can be invoked, of which my favorite is Undo.

 » To terminate the DIM command, pressing ESC or Enter.

The AutoCAD dimensioning commands prompt you with useful information at the 
command line or at dynamic input prompts. Read the prompts during every step 
of the command, especially when you’re trying a dimensioning command for the 
first time. When all else fails . . .

Where, oh where, do my dimensions go?
In this section, I explain where to put dimensions, not where to place them. Huh? 
Right. (By now you should know to place dimensions outside the part outline, with 
smaller ones closer to the part and longer ones farther away, and so on.) In this 
section, I show you the location in the drawing where your dimensions will live. 
You can choose one of three different methods for dimensioning your drawings:

 » You can place dimensions in model space using non-annotative dimen-
sions. This method, the oldest, for many years was the only possible way. I 
mention it here because you’re bound to encounter many of the millions and 
millions of existing drawings that were created this way.

• Advantage: Dimensions are available in model space as you edit the 
drawing.

• Disadvantage: As with text and hatching, dimension objects have to be 
scaled to suit the drawing scale. Placing dimensions on details at other 
scales can get truly ugly. I cover scale factors in Chapters 13 and 15 as well 
as later in this chapter.

 » You can place dimensions in paper space. This was introduced as the 
 second-generation method in an attempt to overcome the scaling issue. You 
can reach from paper space through a layout viewport and snap onto the model 
space objects. Dimensions remain associative and usually change when the 
model space objects change. Paper space layouts are discussed in Chapter 12.

• Advantage: You don’t need to set a dimension scale factor to suit the draw-
ing scale. The dimension scale factor is always 1:1 because paper space 
layouts are usually plotted at full size, and the viewport scale sets the 
model space scale factor.

• Disadvantages: The dimensions aren’t available when editing in model 
space, so you’re flying blind. In addition, the associative connections 
between the paper space dimensions and the model space objects are 
fragile and easily broken. There’s a repair command, but it’s a nuisance to 
have to use it.
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 » You can place dimensions in model space using annotative dimensions.  
This is the newest, latest, greatest, and best way to place dimensions. 
Annotative dimensions automatically size themselves to suit the drawing scale 
that you choose. I discuss annotative text in Chapter 13, annotative hatching 
in Chapter 15, and annotative dimensions later in this chapter.

• Advantages: Dimensions are available in model space while you’re draw-
ing and editing, you don’t need to mess with dimension scale factors, and 
applying dimensions to drawing details that are at a different scale from 
the main drawing becomes trivial.

• Disadvantage: Annotative dimensions have been slow to catch on because 
people are stuck in the older ways (“That’s how we’ve always done it!”) and 
because they don’t understand a couple of subtleties about them that I 
reveal in Chapter 13. If you’re the first in your office to adopt annotative 
dimensions, everyone else will hail you as the Great AutoCAD Guru and will 
pester you to help them learn how to use them.

The Latest Styles in Dimensioning
In this section, I discuss how to set the factors that control the format and appear-
ance of dimensions, but I start with a brief anatomy lesson. AutoCAD uses the 
names shown in Figure 14-2, and described in the following list, to refer to the 
parts of each dimension:

 » Dimension text: The numeric value that indicates the true distance or angle 
between points or lines. Dimension text can include other information in addi-
tion to or instead of the number. For example, you can add a suffix, such as 
TYP., to indicate that a dimension is typical of several similar configurations; 
add manufacturing tolerances; and show dual dimensioning in alternate units.

 » Dimension lines: In linear dimensions, indicate the true distance between 
points. Angular dimensions have curved dimension lines with the center of 
the curve at the vertex point of the objects being dimensioned. For radius 
and diameter dimensions, the dimension line simply points at or through the 
center of the object being dimensioned. See Figure 14-1 for examples of these 
dimension types.

 » Arrowheads: Appear at the end or ends of the dimension lines and empha-
size the extent of the dimensioned length. AutoCAD’s default arrowhead style 
is the closed, filled type shown in Figure 14-2, but you can choose other sym-
bols, such as dots or tick marks, to indicate the ends of the dimension lines. 
Don’t get ticked off about it, but AutoCAD calls the line ending an arrowhead 
even when, as in the case of a tick mark, it doesn’t look like an arrow.
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 » Extension lines: Extend outward from the definition points (also known as 
defpoints) that you select to the dimension lines, usually by snapping to points 
on an object. By drafting convention, a small gap usually exists between the 
defpoint and the beginning of the extension line. Also by convention, exten-
sion lines usually extend just past the dimension lines; refer to Figure 14-2 for 
examples. AutoCAD makes dimensions look tidier by assigning fixed gap sizes 
and projection lengths for the extension lines, and if you need to dimension 
to circles or center lines, you can assign dash-dot linetypes to either or both 
extension lines.

 » Definition points (or defpoints): When you create any kind of dimension, 
defpoints are placed on a special layer named (what else?) Defpoints. The 
program creates the layer automatically the first time you issue a dimension 
command. These tiny points are usually invisible because the objects being 
dimensioned sit on top of them, but you can see them by selecting a dimen-
sion to turn on its grips. The grips appear on the definition points. Because 
you wouldn’t want these points to appear when you plot drawings, nothing 
created on the Defpoints layer ever plots.

By default, no matter which type of dimension you create, AutoCAD groups all 
parts of each dimension (extension lines, dimension lines, arrowheads, and text) 
into a special associative dimension object. Associative has two meanings:

 » The different parts of the dimension function as a single object. When 
you click any part of the dimension, AutoCAD selects all its parts.

 » The dimension is connected to the points on the object that you speci-
fied when you drew the dimension. If you change the size of the object (for 
example, stretch a line), the dimension updates appropriately, as shown in 
Figure 14-3. The lines and arrows move, and the text changes to reflect the 
line’s new size.

FIGURE 14-2:  
The parts of a 

dimension.
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FIGURE 14-3:  
 Changing 

objects 
 automatically 

updates 
dimensions.

USING SYSTEM VARIABLES  
WITH DIMENSIONS
In the early days, AutoCAD controlled the appearance of dimensions by using about 20 
dimensioning system variables. For example, to switch dimension text from showing 
decimal values to showing fractions, the setting of DIMLUNIT would be changed from 
2 to 5. Similarly, DIMDEC sets the number of places of decimal, or the smallest fraction. 
Would you believe 1/256 of an inch? I discuss system variables in Chapter 23.

The problem was that every time you wanted to switch between decimals and fractions, 
you had to change these two variables. To set a system variable, or sysvar, you enter its 
name, followed by a suitable value as determined from the help system. The only reason 
I mention it is that you’re bound to run into older drawings that were done this way.

The good news is that Autodesk later added named dimension styles. You now set up a 
decimal style for dimensions, or a fractional style, or a style with specific manufacturing 
tolerances, and so on. You can create as many dimension styles as you need; all it takes 
is a few mouse clicks to quickly switch between them.
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The associative dimensions I’m talking about here first appeared in AutoCAD 2002. 
Before that, AutoCAD had a more primitive kind of dimensioning. Dimensions 
were single objects, and they updated if you stretched an object if you were careful 
to include the dimension itself in the crossing selection for the Stretch command. 
Here’s where things can become confusing: AutoCAD used to call these old-style, 
single-object dimensions associative, but now calls them non- associative. And what 
used to be called non-associative dimensions before AutoCAD 2002 are now called 
exploded dimensions. But if you explode a dimension, you get four lines, two arrow-
heads, and a piece of text. Sometimes, you can’t tell the players even with a pro-
gram. For more information about how to determine which kind of dimension 
AutoCAD draws, see the “Controlling and editing dimension associativity” section 
later in this chapter. I mention the old style here only because you will probably 
encounter it in old drawings.

Some people will try to warn you that AutoCAD dimensioning is a big, compli-
cated, difficult subject. Don’t be alarmed, however: The basic principles are quite 
simple. The problem is that every industry has its own dimensioning conventions, 
habits, and quirks. As usual, AutoCAD tries to support them all — and, in so doing, 
makes things cumbersome for everyone.

The good news is that you should have to adjust things to suit your specific indus-
try or company only once, and then all dimensions will suit the specified standard. 
The really good news is that it usually takes only a bit of fine-tuning of the default 
settings to cover most of your dimensioning needs.

Dimension styles are saved within the current drawing. The really, really good 
news is that you can save this drawing as a template file (I cover templates in 
 Chapter  4) so that all new drawings created from this template will have the 
dimension styles predefined. Or if you’re working in an office, someone may 
already have set up suitable dimension styles. Or you can use DesignCenter to 
copy styles from one drawing to another.

You add dimensions to a drawing after you’ve drawn at least some of the geom-
etry; otherwise, you won’t have much to dimension! (Well, duh.) Your dimension-
ing and overall drafting efficiency improve if you add dimensions in batches: First 
draw all geometry and then place dimensions. Don’t draw a line, place a dimen-
sion, draw another line, place another dimension. . . .

Creating dimension styles
A dimension style (or dimstyle, for short) is a collection of drawing settings, called 
dimension variables (or dimvars, for short), which are a special class of the system 
variables that I describe in Chapter 23.



266     PART 3  If Drawings Could Talk

If you do need to create your own dimension styles or you want to tweak exist-
ing ones, use the Dimstyle command. You can invoke it by clicking the small, 
diagonal arrow in the lower-right corner of the Dimensions panel of the Annotate 
tab on the Ribbon. The Dimension Style Manager dialog box opens, as shown in 
Figure 14-4.

Every drawing comes with a default dimension style named Standard for imperial 
(feet-and-inches) drawings, or ISO-25 for metric drawings, and matching anno-
tative styles. (I cover annotative dimensions later in this chapter.) Although you 
can use and modify the Standard or ISO-25 style, I suggest that you leave them 
as they are and create your own dimension style(s) for the settings appropriate to 
your work. This approach ensures that you can always use the default style as a 
reference. More important, it avoids a potential conflict that can change the way 
your dimensions look if the current drawing is inserted into another drawing: 
AutoCAD refers to styles by name, so if you have two styles of the same name, one 
will override the other. Chapter 18 describes this potential conflict.

When you install AutoCAD, it checks with the operating system (OS) to see what 
country you selected when the OS was installed, and then sets its measurement 
system accordingly. If you’re in the United States or one of the few other countries 
that still use imperial units, the default dimension style is Standard; most of the 
rest of the world defaults to ISO-25. Canada, on the other hand, is nominally met-
ric, but most people still use imperial. The system variable MEASUREINIT controls 
the default action. If set to 0 (zero), AutoCAD uses imperial units; if set to 1, metric 
units are used. Among other things, this setting also affects text styles (see Chap-
ter 13), hatching (see Chapter 15), and noncontinuous line types (see Chapter 9).

Starting a new drawing from an ISO template, such as acadiso.dwt, forces 
everything to metric, and starting a new drawing from a non-ISO template (for 
example, acad.dwt) forces everything to imperial, regardless of the setting of 
MEASUREINIT.

FIGURE 14-4:  
Yet another 

manager, 
this one for 
dimension 

styles.
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The system variable MEASUREMENT overrides the default for a specific drawing, 
but it affects only text, hatching, and noncontinuous line types.

Follow these steps to create your own dimension style(s):

1. On the Ribbon’s Home tab, click the label of the Annotation panel to open 
the panel slideout, and then click the Dimension Style button.

Alternatively, if that just sounds like too much work, you can type D and press 
Enter. The Dimension Style Manager dialog box appears.

2. In the Styles list, select the existing dimension style whose settings you want 
to use as the starting point for the settings of the new style.

For example, select the default dimension style named Standard or ISO-25.

3. Click the New button to create a new dimension style that’s a copy of the 
existing style.

The Create New Dimension Style dialog box appears.

4. Enter a New Style Name and then select or deselect the Annotative check 
box. Click Continue.

Select the Annotative check box to create an annotative dimension style, or 
deselect it for a non-annotative style.

The New Dimension Style dialog box appears. This dialog box is virtually 
identical to the Modify Dimension Style dialog box, which is displayed when 
you edit a dimension style.

5. Modify dimension settings on any of the seven tabs in the New Dimension 
Style dialog box.

See the descriptions of these settings in the next section of this chapter.

6. Click OK to close the New Dimension Style dialog box.

The Dimension Style Manager dialog box reappears.

7. Click Close.

The Dimension Style Manager dialog box closes, and the new dimension style 
becomes the current dimension style that AutoCAD uses for future dimensions 
in this drawing.

8. Draw dimensions to test the new dimension style.

Avoid changing existing dimension styles that you didn’t create, unless you 
know for sure what they’re used for. When you change a dimension style set-
ting, all existing dimensions using that style change to reflect the revised setting. 
Thus, one small dimension variable change can affect a large number of existing 
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dimensions! To play it safe, rather than modify an existing dimension style, create 
a new style by copying the existing one and then modifying the copy.

A further variation on the already convoluted dimension styles picture is that you 
can create dimension substyles (also called style families), which are variations of 
a main style that affect only a particular type of dimension, such as radial or 
angular. If you open the Dimension Style Manager dialog box and see names of 
dimension types indented beneath the main dimension style names, be aware that 
you’re dealing with substyles.

Adjusting style settings
After you click New or Modify in the Dimension Style Manager dialog box, Auto-
CAD displays a tabbed New Dimension Style dialog box or Modify Dimension Style 
dialog box (the two dialog boxes are identical except for their title bars) with 
a mind-boggling — and potentially drawing-boggling, if you’re not careful — 
array of settings.

Fortunately, the dimension preview that appears on all tabs — as well as on the 
main Dimension Style Manager dialog box — immediately shows the results of 
most setting changes. With the dimension preview and some trial-and-error set-
ting changes, you can usually home in on an acceptable group of settings. For 
more information, use the Help feature in the dialog box: Just hover the mouse 
pointer over the setting that you want to know more about.

If you find the preview image hard to read in the Dimension Style Manager, New 
Dimension Style, or Modify Dimension Style dialog boxes, click and drag the right 
edge of the dialog box to increase the size of the preview image.

Before you start messing with dimension style settings, know what you want your 
dimensions to look like when they’re plotted. If you’re not sure how it’s done in 
your industry, ask others in your office or profession, or look at a plotted drawing 
that someone in the know represents as being a good example. A general rule that 
I’ve found to be helpful in virtually all aspects of life is to stick with the defaults 
unless you know specifically what you want to change and why.

The following few sections introduce you to the more important tabs in the New/
Modify Dimension Style dialog boxes and highlight useful settings. Note that 
whenever you specify a distance or length setting, you should enter size you want 
it to be when the drawing is plotted. I discuss plotting size and scale factors in 
Chapters 13 (text) and 15 (hatching) and later in this chapter.

When you have everything set the way you want it, click OK to close the Modify 
Dimension Style dialog box, and then click Close to exit the Dimension Style Man-
ager. The new style is now current.
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Following lines and arrows
The settings on the Lines tab and the Symbols and Arrows tab control the basic 
look and feel of all parts of your dimensions, except text.

Symbolically speaking
The settings on the Symbols and Arrows tab control the shape and appearance of 
arrowheads and other symbols.

A useful setting is Center Marks. Depending on which radio button you select, 
placing a radius or diameter dimension also identifies the center by placing a 
small center mark, or by placing center lines that extend just beyond the circle 
or arc, or none. The default is the tick mark, but I prefer the line because normal 
drafting practice is usually to show center lines.

Tabbing to text
Use the Text tab to control how dimension text looks, which includes the text style 
and height to use (see Chapter 13) and where to place the text with respect to the 
dimension and extension lines. In particular, note the Text Style drop-down list, 
which shows the text styles available in the drawing. Click the three-dot Browse 
button at the right end of the list to open the Text Style dialog box, and edit or 
create a suitable text style if one doesn’t already exist in your current drawing. 
The default Text Height in imperial units (0.180) is too large for most situations; 
set it to 1/8”, 3mm, or another height that makes sense.

You should define the text style for dimensions with a height of 0 (zero) in the 
Text Style dialog box. See Chapter 13 for more information about variable-height 
and fixed-height text styles. If you specify a fixed-height text style for a dimen-
sion style, the text style’s height overrides the Text Height setting in the New/
Modify Dimension Style dialog boxes. Use a zero-height style to avoid the prob-
lem. A zero-height text style can be a real nuisance when placing text, which 
means that it’s almost mandatory to have at least two text styles defined: one for 
text (fixed height) and one for dimensions (zero height).

Getting fit
The Fit tab includes a bunch of options that control when and where AutoCAD 
shoves the dimension text if it doesn’t quite fit between the extension lines. The 
default settings leave AutoCAD in “maximum attempt at being helpful” mode. 
That is, AutoCAD moves the text, dimension lines, and arrows around automati-
cally so that nothing overlaps. On rare occasions, AutoCAD’s guesses might be 
less than perfect. It’s usually easier to adjust the text placement by grip-editing 
the placed dimension, as I describe in the section “Editing dimension geometry,” 
later in this chapter, instead of messing with dimension style settings.
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Even at its most helpful, AutoCAD sometimes makes a bad first guess about how you 
want dimension text and arrows arranged. If you’re having problems getting the 
look you want, flip the arrows to the other side of the dimension lines by selecting 
the dimension and choosing Flip Arrow from the multifunction grip on the arrow.

Most important, the Fit tab includes the Annotative check box. Using annotative 
dimensions, as I recommend in this chapter, makes dimensioning go a lot more 
smoothly!

The Use Overall Scale Of setting corresponds to the DIMSCALE system variable,  
and you’ll hear long-time AutoCAD drafters refer to it as such. In Chapters  13 
(text) and 15 (hatching), I refer to a scale factor by which text height and hatch 
patterns need to be multiplied so that they plot properly. This principle also 
applies to dimensions: If you’re using old-style non-annotative dimensions, 
this is where that number goes. It resizes text height, arrowhead sizes, and gaps 
accordingly. When Scale Dimensions to Layout (for paper space layout dimen-
sioning) is selected, DIMSCALE is automatically set to 0 (zero). When Annotative 
is selected, DIMSCALE is ignored, and a suitable scale factor is applied to each 
dimension when it’s created.

Using primary units
The Primary Units tab gives you highly detailed control over how AutoCAD for-
mats the characters in the dimension text string. You usually set the unit format 
and precision, and maybe specify a suffix for unitless numbers, if it’s not clear 
from the drawing which units you’re using. You may also change the Zero Sup-
pression settings, depending on whether you want dimension text to read 0.5000, 
.5000, or 0.5. “Zero Suppression!” also makes a great rallying cry for organizing 
your fellow AutoCAD drafters.

AutoCAD 2010 introduced an interesting tweak to dimension text: dimension sub-
units. If the main unit of measure on a drawing is meters, rather than have a bunch 
of smaller distances dimensioned as, say, 0.450, you could create a centimeter 
subunit so that any dimension of less than 1 meter would be shown in centimeters. 
I was always taught a strict drafting standard specifying that all dimensions on 
a drawing must be in the same units. In other words, in a drawing with meters 
as the dimension unit, 0.45 would be correct and 45cm would be incorrect. NASA 
once crashed an expensive probe on Mars because some people were using impe-
rial units and others were using metric. Check your own office standards before 
incorporating this feature, which you can find on the Primary Units tab of the 
New/Modify Dimension Style dialog box.
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Other style settings
If your work requires that you show dimensions in two different systems of 
measure, such as inches and millimeters, use the Alternate Units tab to turn on 
and control alternate units. Alternate Units display both dimensions at a time. 
If your work requires listing construction or manufacturing tolerances, such as 
3.5 +/-0.01, use the Tolerances tab to configure the tolerance format.

AutoCAD includes a separate TOLerance command that draws special symbols 
called geometric tolerances. If you need these symbols, you probably know it and 
you have my sympathies; if you’ve never heard of them, just ignore them. Search 
for the term Geometric Tolerance dialog box in the AutoCAD help system for more 
information.

Changing styles
To switch to a different style, click in the dimension style window in the Dimen-
sions panel of the Annotate tab on the Ribbon, and select a style from the drop-
down list. Beginning with AutoCAD 2014, if you know the name of the style that 
you want to use, just begin typing it at the command line. The AutoCAD command 
line searches for dimension styles; when you see the one you want, just click it.

Scaling Dimensions for Output
You need to adjust the size of text and dimensions that are applied in model space 
to suit the final plotting scale of the drawing. By far, the best way to do this is to 
use annotative dimensions.

Follow these steps to use the Annotative dimension style and apply an annotative 
scale to a dimension:

1. Start a new, blank imperial drawing.

Use the acad.dwt template.

2. Draw a horizontal line about 20 units long.

3. Apply a linear dimension (DimLInear, or DLI) to the line.

Pretty hard to read, isn’t it?

4. Switch to the Annotative dimension style.

Find the Dimension Style drop-down list that reads Standard in the upper-
right corner of the Dimension panel of the Annotate tab on the Ribbon. Click it 
and then choose Annotative.
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5. Change the current drawing annotation scale.

Select the 1:5 scale from the drop-down list, under the Annotation Scale button 
in the lower-right corner of the application window.

6. Use the DIMLIN command again and place a second dimension for the line.

Ah, that’s better, and it didn’t require any esoteric calculations. You now have 
to dimension that measure the length of the line, but the text and arrowheads 
appear at different sizes now.

To avoid confusing results, which is what has turned off most users from using 
annotative annotations, make sure that the Automatically Add Scales button in 
the lower-right corner is turned off. When Automatically Add Scales is enabled, 
AutoCAD updates all annotation objects that support annotative behavior when 
you change the current annotative scale. Having all scales attached to every anno-
tation object is not ideal as it is much harder to control where the new scale rep-
resentations appear in your drawing especially when they might not all be needed. 
I discuss this topic more in Chapter 13.

Dimensioning details at different scales is always the most difficult type of dimen-
sioning, unless you use annotative dimensions.

Here’s the easy way to create a multiscale drawing, such as the one in Figure 14-5:

1. Draw the object at full size in model space, including the small 
notch detail.

2. Select the 1:10 scale from the drop-down list under the Annotation Scale  
button in the lower-right corner of the AutoCAD window.

SCALING DIMENSIONS THE HARD WAY
You used to have to draw the complete object full size, including all the fine details and 
zooming in as necessary. Then you’d copy those elements that made up the fine detail 
and use the SCale command to resize them to suit the detail scale. Finally, you’d apply 
dimensions to the scaled one that had two suitable scale factors: Set the dimension scale 
factor to suit the overall drawing scale (say 1:2), and then set the DIMLFAC (DIMension 
Linear FACtor) to suit the detail scale.

The problem is that your detail is at a different scale. DIMLFAC is a fudge factor applied 
to dimensions that corrects the measured value, so a 1" line in a 5:1 detail measures as 
1 inch, not 5 inches. Ouch.
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3. Apply the three dimensions that show in the Scale 1:10 view in Figure 14-5, 
using an annotative dimension style.

The figure shows paper space, but you’re working in model space.

4. Apply an annotative hatch and then draw the center line.

Turn to Chapter 15 if you’re not sure how to apply an annotative hatch.

5. Edit the properties of the hatch pattern and the 1.400 dimension to add 1:2 
scale factors.

Chapter 15 discusses editing hatch patterns.

6. Make sure that the Automatically Add Annotative Scales button is turned 
off, and change the Annotation Scale to 1:2.

Three existing dimensions disappear, and the hatch and the 1.400 dimension 
resize themselves.

7. Add the 1.500 and 2.400 dimensions.

8. Switch to the paper space Layout1 tab. Click the viewport boundary and then 
grip-edit it approximately to the size and location shown.

Your model space drawing is probably not properly located, and the hatch and 
dimensions don’t show.

9. Click the viewport boundary again, click the Viewport Scale button 
(which probably reads something like 0.694694), and select 1:10 from the 
scale list.

FIGURE 14-5:  
A drawing 

with a detail at 
another scale.
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The viewport zooms accordingly, and the hatch and 1:10 dimensions appear. 
If necessary, double-click in the viewport to enter model space, and then pan 
accordingly.

Don’t zoom or else you lose the scale setting!

10. Double-click outside the viewport to return to the paper space layout.

11. Create a second viewport by using the VPORTS command, or simply copy 
it and then modify the existing one.

12. Repeat Steps 8 and 9 on the new viewport, but use a Viewport Scale of 1:5.

Use the Lock/Unlock button to lock the viewports to prevent inadvertently 
messing with them.

There you have it — a multiview, multiscale detail drawing without duplicating 
any geometry or annotations. To see the real magic of it, go to the model space 
tab and observe that there’s still only one model of the part and no detail at the 
other scale. Use the Stretch command to play with the depth and location of the 
notch. Go back to the Layout1 tab to see how everything has automatically updated 
in both views. Magic!

Editing Dimensions
After you draw dimensions, you can edit the position of the various parts of each 
dimension and change the contents of the dimension text. AutoCAD groups all 
parts of a dimension into a single object.

Editing dimension geometry
The easiest way to change the location of dimension parts is to use grip editing. 
I describe editing with grips in Chapter 11. Just click a dimension, click one of its 
grips, and maneuver away. You’ll discover that certain grips control certain direc-
tions of movement. Selecting a dimension displays grips generally at the text, the 
ends of the dimension lines, and the defpoints.

In AutoCAD 2012, dimensions joined the group of objects that feature multifunc-
tion grips. Click the text grip on a linear dimension and use the grip menu to 
adjust the text location. Click an arrow grip, and you can create a continuous or 
baseline dimension from that end of the dimension, or you can flip the arrow. You 
can do these things by selecting a dimension and changing items in the Properties 
palette, but the multifunction grips are more efficient.
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If you want to change the look of a component of a specific, individual dimension 
(for example, substitute a different arrowhead or suppress an extension line), 
use the Properties palette. See Chapter 11 for more on the Properties palette. All 
dimension settings in the New/Modify Dimension Style dialog boxes (see “Adjust-
ing style settings,” earlier in this chapter) are available from the Properties pal-
ette when you select one or more dimensions.

Follow these tips for editing dimensions:

 » Use smart breaks. In manual drafting, it’s considered bad form to cross object 
lines (that is, real geometry) with dimension lines or extension lines, or to have 
anything cross a dimension line. Dimension Break (DIMBREAK) prompts you to 
select a dimension and then an object to break it. The wild aspect is that it’s a 
smart break. If you do anything to the dimension or to the object being broken 
to change where they cross, the break follows accordingly — and if you change 
either item so that they no longer cross, the break heals itself. Better yet, if you 
change things again so that they cross again, the break reappears!

 » Use the DIMSPACE command. The Dimension Space (DIMSPACE) command 
applies a specified separation between existing linear or angular dimensions. 
If you don’t use the DimBAseline command as the dimensions are created, 
spacing dimensions equally afterwards will require tedious manipulation with 
Snap Mode and the Move command.

 » You don’t always have to draw everything at full size. A fundamental 
mantra in AutoCAD is that you should always draw everything at full size. On 
occasion, however, it isn’t always practical. For example, you may design a 
power-transmission shaft for a large machine. The shaft is 4 inches in diame-
ter and 12 feet long. It has a variety of splines, keyways, and bearing shoulders 
on each end, but the 11-foot section in the middle is simply a straight cylinder. 
If you draw it at full size and scale the plot to fit a suitable paper size, you’ll 
never see the details at each end.

Common practice would be to draw the interesting end details, break out and 
remove the boring center section, and then bring the ends closer together. 
Now you can create a reasonable plot. The problem is that any dimension that 
crosses over the break, such as the overall length, doesn’t show the correct 
value. The solution is to override the value, and then to use the DIMJOGLINE 
command to insert a jog in the dimension line to indicate that the dimension 
line isn’t the true length. I explain how a little later in the section “Editing 
dimension text.”

In spite of the name similarities, don’t confuse DIMJOGLINE with the 
DimJOgged command, covered earlier in this chapter. DIMJOGLINE is for 
linear dimensions, and DimJOgged is for radial dimensions.
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 » Right-click for useful options. If you select one or more dimensions and 
right-click, the menu displays a number of useful options for overriding 
dimension settings or assigning a different style.

 » Sometimes, it’s better to create a new style. When you change a setting 
in the Properties palette, you’re overriding the default style setting for that 
dimension. If you need to make the same change to a bunch of dimensions, 
it’s usually better to create a new dimension style and assign that style to 
them. You can use the Properties palette or the right-click menu to change the 
dimension style that’s assigned to one or more dimensions.

If you manually change a dimvar setting, the setting is applied to the current 
dimension style as an override, and all subsequent dimensions that are 
placed by using this style have the overridden appearance. This can cause 
much the same problem as overriding object properties instead of using dif-
ferent layers; if you edit a dimension style, all existing dimensions that use it 
update, including the ones that you hadn’t expected because they seem to be 
different from the ones you want.

 » Use a mask for the dimension text. You can use the Properties palette to 
turn on AutoCAD’s background mask feature (described in Chapter 13) for 
the text of individual dimensions: Select the dimensions, display the Text 
area in the Properties palette, and find the Fill Color item. Click in the list box, 
scroll down, and select Background to use the drawing background color, 
which usually gives the best results. To ensure that dimension text lies on 
top of other objects, use the TEXTTOFRONT (Chapter 13) or DRAWORDER 
(Chapter 18) commands.

 » Don’t explode dimensions. The AutoCAD eXplode command on the Home 
tab’s Modify panel blows a dimension to smithereens — or at least into a 
bunch of line and multiline text objects. Resist the temptation. Exploding a 
dimension makes it much harder to edit cleanly and eliminates AutoCAD’s 
ability to update the dimension text measurement automatically.

Editing dimension text
In most cases, you shouldn’t have to edit dimension text. Assuming that you draw 
the geometry accurately and pick the dimension points precisely, AutoCAD always 
displays the right measurement. If you change the size of the associated object, 
AutoCAD updates the dimension and its measurement. However, you may occa-
sionally want to override the dimension text (that is, replace it with a different 
measurement) or add a prefix or a suffix to the true measurement.
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AutoCAD creates dimension text as multiline text, so dimension text has the same 
editing options as ordinary text. You have several ways to launch the dimension 
text editor, but the easiest is to simply double-click the dimension text.

AutoCAD displays the true dimension length as text in the actual dimension and 
updates the text if you change the size or location of the object. You can override 
the true length by typing a specific length or another text string. You can pre-
serve the true length by adding a prefix or suffix by inserting <> (that is, the left 
and right angle-bracket characters) as placeholders for the dimension value. For 
example, if you enter About <> and the actual distance is 12.000, AutoCAD displays 
About 12.000 for the dimension text. If you stretch the object later on so that the 
actual distance changes to 14.528, AutoCAD changes the dimension text automati-
cally to read About 14.528. Now you can appreciate the importance of drawing 
and editing geometry precisely!

Avoid the temptation to override the default dimension text by replacing the 
angled brackets with a numeric value unless you plan to use the DIMBREAK com-
mand on the dimension. Doing so eliminates AutoCAD’s ability to keep dimension 
measurements current; even worse, you get no visual cue that the default dis-
tance has been overridden unless you edit the dimension text. If you’re overriding 
dimension text a lot, it’s probably a sign that the creator of the drawing didn’t pay 
enough attention to using precision techniques when drawing and editing. I don’t 
point fingers, but you probably know whom to talk to.

Controlling and editing dimension 
associativity
When you add dimensions by selecting objects or by using Object Snap modes 
to pick points on the objects, AutoCAD normally creates associative dimensions, 
which are connected to the objects and move with them. This is the case in new 
drawings that were originally created in any release of AutoCAD starting with 2002.

If you have to work on drawings created or last edited in versions older than Auto-
CAD 2002, you must set the DIMASSOC system variable to 2 before later releases 
will create associative dimensions. An easy way to make this change for the cur-
rent drawing is to open the Options dialog box (click the Application button and 
choose Options from the bottom of the Application menu), click the User Prefer-
ences tab, and turn on the Make New Dimensions Associative setting. Be aware 
that this setting affects only new dimensions that you draw from now on. To make 
existing non-associative dimensions associative, use the DIMREASSOCiate com-
mand described in the following list. Search for the term DIMASSOC system variable 
in the AutoCAD help system for more information.
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You aren’t likely to need any of these three commands often, but if you do, look up 
the command name in the online help system:

 » DIMREASSOCiate: If you have dimensions that aren’t currently associative 
(probably because they were created in older versions of AutoCAD) or they’re 
associated with the wrong objects, you can use the DIMREASSOCiate com-
mand to associate them with points on the objects of your choice.

 » DimDisAssociate: You can use the DimDisAssociate (DDA) command to sever 
the connection between a dimension and its associated object.

 » DIMREGEN: In a few special circumstances, AutoCAD doesn’t automati-
cally update geometry-driven associative dimensions. In those cases, the 
DIMREGEN (no command alias) command fixes things.

And the Correct Layer Is . . .
Starting with AutoCAD 2016, you can set up AutoCAD so that dimensions are auto-
matically placed on the correct layer. Follow these steps:

1. Start the LAyer command.

Cl ick the Layer Properties button on the Layers panel.

2. Create a new layer.

Give it a suitable name, such as Dims, and assign it a desired color. I discuss 
layers in Chapter 9.

3. Click the Annotate tab of the Ribbon menu.

4. In the Dim Layer Override drop-down list in the middle of the Dimensions 
tab, select your dimension layer.

That’s it! Whenever you add a dimension to this drawing, it will automatically 
land on your dimension layer, regardless of which layer is active.

DO NOT use this layer selection drop-down list if you want to change the current 
layer for other drawing objects. This list sets only the dimension layer.

Create and set your default dimension layer in your template drawing. Any new 
drawings that are created from your template will automatically have your dimen-
sion layer predefined. I discuss templates in Chapter 5.
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IN THIS CHAPTER

Adding hatch patterns to drawings

Applying annotative hatch patterns

Choosing hatch boundaries

Using predefined and user-defined 
hatch patterns

Editing hatches

Down the Hatch!

If you need to fill in closed areas of drawings with special patterns of lines (cross-
hatches, or simply hatches) or solid fills, then this is your chapter. If you were 
hoping to hatch a plot or plot a hatch, see Chapter 16. If you want to hatch an 

egg, look at Raising Chickens For Dummies, by Kimberly Willis and Robert T. Ludlow 
(Wiley).

A hatch in AutoCAD is a separate object that fills a space; has an appearance dictated 
by the hatch pattern assigned to it; and is associated by default with the objects 
that bound the space, such as lines, polylines, and arcs. If you move or stretch the 
boundaries, AutoCAD normally updates the hatches to fill the resized area.

Creating a Hatch
Drafters often use hatches to represent the type of material that makes up an 
object, such as insulation, metal, or concrete. In other cases, hatches helps empha-
size or clarify the extent of a particular element in the drawing — for example, 
showing the location of walls in a building plan or highlighting a swampy area on 
a map so that you know where to avoid building the road. Figure 15-1 shows an 
example of hatches in a structural detail. In mechanical design, it’s used to show 
the cut faces of cross sections.

Chapter 15
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This section gives you a jump-start on the basic process used to create hatches 
and shows you how easy the process is. I also cover many of the options included 
on the Hatch Creation contextual tab on the Ribbon, shown in Figure 15-2, and 
how to edit existing hatched areas.

Follow these steps to hatch an enclosed area by using the pick points method of 
selecting the hatch area:

1. Start a new drawing, using the acad.dwt template for Imperial units or 
acadISO.dwt for metric units.

Draw a circle with a radius of 5 units (Imperial) or 50 units (metric). Draw a 
second circle inside the first with a radius of 2 units (Imperial) or 20 units 
(metric).

2. Start the Hatch command by typing H and pressing Enter or by clicking 
the Hatch button in the Draw panel of the Home tab on the Ribbon.

The Hatch Creation contextual tab on the Ribbon appears, as shown in 
Figure 15-2. Ignore it for now.

3. Move the cursor on the screen.

As the cursor moves within any enclosed area in the drawing, a preview 
appears to show you how the final hatches will look if you pick a point inside 

FIGURE 15-1:  
A big batch o’ 

hatch.

FIGURE 15-2:  
The Hatch 

 Creation 
 contextual tab 
on the Ribbon.
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that particular area. Starting from outside the larger circle, move it into the 
space between circles, and then into the inner circle, and then back into the 
space between circles and note the changes.

4. Change some hatch options.

The quick preview updates as you select variants or change values in the Hatch 
Ribbon panel. Try different patterns. The three little arrows along the right side 
of the Pattern panel scroll through all the different patterns that are available. 
My favorite is Escher.

5. Pick a point in the region between the circles and then press Enter or the 
spacebar.

Congratulations — in only a few seconds, you’ve done something that would 
have taken an hour or more in the days of pencil and paper.

6. Change the diameter of the outer circle:

a. Click the outer circle and then click and drag one of the four outer grips to 
change the diameter of the circle. The hatch pattern updates to match. This 
process is known as associative hatching.

b. Click the inner circle, and then click and drag its center grip to move it outside 
the larger circle. The hole in the pattern of the larger circle fills in and the 
smaller circle gets filled with hatching.

c. Click the smaller circle and then click and drag its center grip to move it back 
inside the larger circle. The smaller circle loses its hatch and reverts to cutting 
a hole in the hatch of the larger circle.

When working with hatches, keep these tips in mind:

 » Place the hatches on a dedicated layer or layers. You can then easily turn 
hatches on or off.

 » Always use the Continuous line type for hatch layers. Most hatch patterns 
use noncontinuous lines that are generated as patterns by the hatch process. 
If you place hatches on a layer with a non-continuous line type then the Hatch 
command tries to create each of its own non-continuous line segments from 
non-continuous lines and the hatch process gets a little bizarre.

 » Modify each hatch separately. By default, when you select a number of 
separate, closed areas and then press Enter, the hatched areas are created as 
a single object. Later, if you edit one hatched area then all areas in the original 
set update. A good example of this would be the cross-section of a complex 
mechanical part. Choose Create Separate Hatches on the Options slideout 
panel if you want to be able to modify each hatched area.
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 » Set the Draw Order drop-down list to specify whether the hatch objects are 
in front of or behind the hatch boundary or other drawing objects, as shown 
in Figure 15-3. By default, they’re sent behind their boundary, which is typically 
what you want. If a hatch is a different color from its boundary and if it’s in 
front of its boundary, the tips of the hatch objects produce a dotted-line effect 
along the boundary.

Starting with AutoCAD 2017, you can set up AutoCAD so that hatches are auto-
matically placed on the correct layer. Follow these steps:

1. Start the LAyer command.

To do so, click the Layer Properties button on the Layers panel of the Home tab.

2. Create a new layer.

Give it a suitable name, such as Hatch, and assign it a color. I discuss layers in 
Chapter 9.

3. Start the Hatch command.

Type H and press Enter or click the Hatch button on the Draw panel of the 
Home tab.

FIGURE 15-3:  
Hatch options 

for every 
 occasion.
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4. Select your Hatch layer.

Click the down arrow at the bottom of the Properties tab to see the slideout 
panel and select your Hatch layer from the drop-down list.

5. Close the Hatch Creation tab by clicking the Close button.

That’s it! From now on, whenever you create a hatch pattern in this drawing it will 
automatically land on the Hatch layer, regardless of which layer is currently active.

Create and set your default Hatch layer in your template drawing. Then any new 
drawings you create from your template will automatically have the Hatch layer 
predefined. I discuss templates in Chapter 5.

Using the Hatches Tab
Now that you know how easily you can create hatched areas, you can explore the 
main options within the contextual Hatch tabs of the Ribbon. When you start the 
Hatch command, you see the Hatch Creation tab. (Refer to Figure 15-2.) But if you 
double-click an existing hatch, you see the Hatch Edit tab, and they’re virtually 
identical.

Working from left to right, the Hatch tab contains these options:

 » Boundaries

The easiest, most intuitive, and most common way to define the boundary of 
a hatch is to simply pick inside a region. If you pick multiple regions within one 
run of the Hatch command, each region is hatched, and the result is one 
hatch object. If you edit the properties of any region later, all regions are 
updated. This strategy is commonly used when hatching the cut faces of a 
cross section; all faces common to a single item automatically maintain 
matching hatch properties.

Choose Create Separate Hatches on the Options slideout panel if you want to 
be able to modify each hatched area independently.

You can also select an area to be hatched by picking specific objects to define 
the boundary, but you must select enough objects to define a fully enclosed 
region. In the earlier section “Creating a Hatch,” you can see how the hatch 
pattern behaves when you select the region between the circles; it doesn’t 
hatch the inner circle. This is island detection. If you select specific objects for 
the boundary, island detection is turned off. If you had selected only the outer 
circle, the hatches would run right over the inner circle.
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Starting with AutoCAD 2014, if you’re picking within multiple bounded areas or 
selecting individual objects, the Hatch command includes an Undo option in 
case you accidentally pick the wrong area or object.

No matter which selection method you choose, the boundary must be air-
tight. Boundary objects can overlap, but they can’t have leaks — not even 
microscopic ones. Technically, a fuzz factor can be set to allow for tiny leaks. 
However, I don’t tell you how to set a fuzz factor because it defeats the pur-
pose of drawing with precision.

Whenever you see the error message A Closed Boundary Could Not Be 
Determined, you need to repair lines or other objects so that they define a fully 
airtight boundary. Sometimes, you can use the Fillet command with a 0 (zero) 
fillet radius to force two lines to meet exactly. Another possibility is to use grip 
editing to align one endpoint precisely with another (see Chapter 11). The Hatch 
command displays red circles at gaps in the not-quite-enclosed area you want 
to hatch. Even if it doesn’t fix the gaps, it shows you where you should fix them.

 » Pattern

The scroll arrows at the right edge of the Pattern panel give access to the 82 
predefined hatch patterns, including nine solid and gradient fills that ship with 
AutoCAD.

Hatch patterns are defined by external files named acad.pat or acadlt.pat 
in imperial units, or acadiso.pat or acadltiso.pat in metric. Each file 
includes definitions for all patterns. You can create your own hatch patterns; 
The Customization Guide in the online Help system explains how. You can buy 
libraries of custom hatch patterns. Any patterns not defined in acad.pat or 
acadiso.pat are referred to as custom patterns, but you must be careful 
when using them. Because they’re external files, they must be available to 
AutoCAD whenever you open a drawing containing them. If you send the 
drawing to someone else, you must also send the pattern definition file, which 
can have copyright issues if you bought the patterns.

Autodesk created the hatch patterns whose names begin with the characters 
AR- (that’s a hyphen at the end) particularly for use in architectural drawings, and 
unlike non-AR patterns, they do represent real objects such as brick and roof 
shakes. The AR patterns were designed with a final hatch scale of 1.0 in mind, 
but in some cases you have to adjust up or down to achieve a suitable scale.

 » Properties

The Properties panel contains buttons for as many as ten properties that 
can be attached to hatches, but many of them can be covered in other ways. 
I identify them by their default values — your results may differ:

• Pattern: See the Pattern panel.

• Use Current: This button, which refers to color, should nearly always be 
ByLayer, which is what the current general color override should be.
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• None: This button refers to background color, which can be useful when 
using hatching to portray actual objects. For example, a brick pattern can 
have a red background so that the hatched region looks like red bricks, as 
shown in Figure 15-4.

• Hatch Transparency: The options for this button range from 0 percent 
(opaque) to 90 percent (nearly transparent).

• Angle: Hatch patterns can be rotated the way you want. For example, in 
mechanical design, you may be cutting a cross section of an assembly. 
Standard practice is to hatch the 
resultant cut faces, usually with 
ANSI31, and to adjust the rota-
tion angles so that each part 
has a different angle to help 
distinguish one from another. 
Note that some patterns (the 
ANSI series, in particular) usually 
have an initial 45-degree rota-
tion built in.

• Scale: Ah, here’s the big one 
(pun intended). I cover it in 
more detail in the “Scaling 
Hatches” section a little later in 
this chapter.

 » Origin

AutoCAD typically creates hatched areas by having them radiate outward 
from the origin, effectively turning them on and off as they encounter bound-
aries. This behavior can cause problems with some real-object patterns, how-
ever. You wouldn’t want a brick wall to start with 68.3 percent of a brick, so the 
Origin option lets you snap to an exact point, as shown in Figure 15-4. You 
may also want to check out Chapter 9’s reference to the need for a brick layer.

 » Options

This one has three suboptions:

• Associative: By default, hatches are associative to their boundaries. They 
know about each other, which explains what happens when you change 
and move boundary objects at any time after the hatching was created.

• Annotative: Like text (described in Chapter 13) and dimensions (described in 
Chapter 14), hatches must be scaled properly to match the drawing scale. I 
cover this topic in more detail in the later section “Scaling Hatches.”

• Match properties: This function lets you select an existing hatch object and 
then copy its properties onto another hatch object, just like the Format 
Painter in many Windows applications.

FIGURE 15-4: 
Poorly laid red bricks (top); properly laid red 
bricks (bottom).
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 » Close

Surprise! This option closes the Hatch tab.

Scaling Hatches
Hatches are annotation objects — like text (see Chapter 13) and dimensions (see 
Chapter  14) — in that they don’t directly contribute to the geometry of what 
you’re drawing. However, they do impart additional information.

Like text and dimensions, hatches also need to be scaled to suit the final drawing 
scale. Start with the common ANSI31 pattern. As defined, it produces parallel lines 
spaced 1/8" apart. So far, so good — but what if you’re drawing the cross section 
of a large part, such as the 10' boom on a backhoe? Remember to always draw at 
full size and then scale when you plot. If you were to apply hatches at the nominal 
1:1 scale and then plot at 1:10 to fit the boom on a smaller sheet of paper, the 1/8" 
hatch spacing becomes 0.0125 inch, which effectively becomes a solid fill. As with 
text and dimensions, you apply a scale factor of 10 to the hatches. The hatch lines 
in the drawing file then turn out to be 1.25 inches apart, which scale down to 1/8" 
when you plot. I also discuss scale factors in Chapter 4.

Scaling the easy way
The easy way to scale a hatch is to select the drawing scale from the Scale List but-
ton in the lower-right corner of the AutoCAD screen, the same as you do for text 
(see Chapter 13) and dimensions (see Chapter 14), and then to turn on the Anno-
tative option in the Options panel of the Hatch tab on the Ribbon. Now whenever 
you create hatches, they scale themselves correctly to suit the current plot scale.

The setting of the Annotative button is good for only the current editing session, 
and it must be reset if you add more hatches later. The AutoCAD Help facility 
states that this setting is saved in the drawing, but it isn’t.

SCALING THE HARD WAY
The hard way (the old way) to scale hatches is to calculate the scale factor before plac-
ing the hatches and then enter it into the appropriate window in the Properties panel 
on the Hatch tab of the Ribbon, in the hope that you don’t need to change the plotting 
scale later. You don’t even want to think about setting the scale for a detail at a different 
scale in the same drawing.
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In Chapter 14 (which describes dimensions), I strongly recommend turning off the 
Automatically Add Scales option when placing annotative text and dimensions, 
because you normally don’t want everything to show at every scale, especially 
when creating details at other scales. Hatches, on the other hand, normally do 
show in every view at every scale, scaled accordingly. You might be tempted to 
turn this option back on for hatches, but if you do, the first time you change the 
drawing scale, the new scale is added to all existing annotative objects. The best 
practice is to edit the hatches and manually add scales, the same as I discuss in 
Chapter 13 for text and Chapter 14 for dimensions.

Don’t confuse annotative and associative, even though both are polysyllabic words 
that start with a and sit next to one another in the Options panel on the Hatch 
Creation tab. Annotative hatch objects scale themselves automatically to suit the 
drawing scale. Associative hatch objects (enabled by default) update to the new area 
when you change the hatch boundary. And if that isn’t enough, Chapter 19 covers 
parametrics, which include annotational annotative associative dimensions.

Annotative versus non-annotative
Figure 15-5 shows two versions of the same drawing, dressed up with annotative 
and non-annotative hatch patterns. As shown by the annotation scales displayed 
on the drawings’ status bars, the annotative hatches change their scales, whereas 
the non-annotative hatches remain unchanged.

Chapter 14 shows another example: The hatches in both views are the same object, 
but because the viewports have different scales, the hatches adjust accordingly.

Before annotative hatches first appeared in AutoCAD 2008, the only way to create 
the effect in these two views in both drawings was to create two separate layers, 
one for each hatch scale, hatch the object twice, and then freeze and thaw layers 
as appropriate.

FIGURE 15-5:  
Hatches  

annotative 
(and not).
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Pushing the Boundaries of Hatch
In the remainder of this chapter, you discover how to refine hatch techniques. I 
describe how to copy existing hatches, take advantage of various options in the 
Hatch and Gradient dialog box (which offers a bit more control than the Hatch 
Creation contextual tab), and choose more complicated hatch boundaries.

Adding style
A minor problem is that, unlike using text and dimensioning, you can’t create 
named styles for hatches. The good news is that three workarounds can help off-
set this issue.

Plagiarism 101 — editing hatches: Suppose that a drawing has several different 
styles of hatches applied with incorrect specifications. Simply select the problem 
hatch, click the Inherit Properties button on the Hatch Editor tab, and select an 
existing hatch to copy its properties. The original hatch inherits all properties of 
the selected hatch.

Select more than one problem hatch at a time to change multiple hatches at once.

Plagiarism 201 — cloning hatches: Suppose that a drawing has several different 
styles of hatches applied, and now you want to hatch another area. You start the 
Hatch command, and the Hatch contextual Ribbon appears. Oops — it shows the 
specifications of the last hatch that was applied, which is quite different from 
what you want to do now. Click the Match Properties button in the Options panel 
of the Hatch Creation tab, or click the Inherit Properties button in the Hatch and 
Gradient dialog box. Pick an existing hatch, and — presto! — all settings are 
updated to match the selected hatch. You can use the cloned settings as is, or you 
can modify them.

Plagiarism 301 — creating hatches: Here’s a technique that even many expe-
rienced users miss. It’s remarkably easy to customize AutoCAD so that a single 
mouse click can produce any hatch style you want. Here’s how:

1. Apply a hatch with the properties you want.

Make sure that the existing hatch is on the correct layer and that the layer has 
all the correct properties.

2. Display the Tool Palette window.

Select the Tool Palettes tool in the Palettes panel on the View tab of the Ribbon. 
(I discuss tool palettes in Chapter 2.)
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3. Display the Hatches and Fills palette by clicking its tab.

If you can’t see this tab, click the overlapping edges of the tabs at the bottom of 
the palette window and select Hatches and Fills from the list that appears.

4. Create a new Hatch tool.

Click once to select the existing hatch object, pause, and then select it again. 
Drag it to the tool palette and drop it.

Don’t double-click too quickly, and don’t click the blue grip, or else you’ll edit 
only the existing object.

5. Use the new Hatch tool.

Click the Hatch tool, and then click inside a closed boundary in the drawing. 
Bingo — instant hatches to your specification. Note that the tool even puts 
hatches on the same layer as the original sample.

You can also simply click and drag the desired pattern from the tool palette to 
the desired boundary.

If you start a new drawing, create a boundary, and then use the Tool Palette to 
hatch it, you may be amazed to find that the new hatches in the new drawing 
are on the correct layer. If the correct layer doesn’t exist in the new drawing, 
AutoCAD creates it to match the original specifications automatically — a pro-
cess known as standardization through customization.

Hatches from scratch
You can use predefined, user-defined, or custom hatch patterns. Most of the time, 
you’ll choose predefined hatch patterns unless some generous soul gives you a 
custom pattern. On the other hand, I haven’t used a user-defined pattern in over 
25 years of using AutoCAD because hatches consist solely of continuous lines. All 
you can define are the spacing and rotation angle and whether the lines are paral-
lel pairs. And all this can be duplicated with standard patterns.

An alternative to using the Ribbon to create the pattern is the Hatch and Gradi-
ent dialog box, as shown in Figure 15-6. You don’t see the hatch object updating 
as you change settings (as on the Ribbon), but you have more control over what 
you end up with. To display the Hatch and Gradient dialog box, click the dialog 
box launcher (the tiny arrow at the right end of the Options panel on the Hatch 
Creation tab of the Ribbon).
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By default, the right third of the Hatch and Gradient dialog box is hidden; to see 
additional hatch options at the right side of the dialog box (as shown in Figure 15-6), 
click the More Options arrow beside the Help button.

Pick a pattern — any pattern:  
Predefined hatch patterns
To use predefined hatch patterns in AutoCAD, select Predefined from the Type 
drop-down list at the top of the Hatch tab in the Hatch and Gradient dialog box. 
This selection sets the stage for choosing the hatch pattern.

You specify a predefined hatch pattern in one of two ways:

 » Pattern drop-down list: If you know the name of the hatch pattern, select 
it from the Pattern drop-down list. The list is alphabetical, except that SOLID 
(that is, a solid fill) appears at the beginning.

 » Pattern button: If you don’t know the pattern name or if you prefer the 
visual approach, click the Pattern button to display the Hatch Pattern palette 
with pattern previews and names. The Pattern button is the tiny button with 
the ellipsis (three dots) to the right of the Pattern drop-down list and pattern 
name.

Figure 15-7 shows more predefined hatch patterns, which cover everything from 
earth to Escher to stars.

FIGURE 15-6:  
The Hatch 
tab in the 
expanded 
Hatch and 

Gradient  
dialog box.
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When is a pattern not a pattern? When it’s a solid fill
AutoCAD treats filling an area with a solid color as a type of hatch. Simply choose 
SOLID from the top of the Pattern drop-down list. You also see several gradient-
fill options, where one color gradually changes to another.

Like any other object, a solid hatch takes on the current layer’s color if you leave 
(as you should) the color set to ByLayer, or it takes on the current object color 
override if someone else who doesn’t know what they’re doing has altered the 
drawing. Therefore, check whether the current object layer and color are set 
appropriately before you use the Solid hatches option. (See Chapter 9 for details.)

Here’s looking through you, kid
The transparency object property in AutoCAD is probably most useful (in 2D, any-
way) when applied to solid fills. You can use transparent solid fills to demarcate 
(distinguish) areas on architectural floor plans or aerial photographs of project 
sites. In addition to ByLater and Solid settings, make sure that the current object 
or layer transparency is set correctly, too.

Editing Hatch Objects
Editing an existing hatch pattern is simple after you’re familiar with the Hatch 
Creation tab on the Ribbon. Follow these steps:

1. Select the hatch object.

AutoCAD opens the Hatch Editor contextual tab on the Ribbon and displays the 
hatch object’s current settings.

FIGURE 15-7:  
A veritable 
plethora of 

hatch patterns.
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2. Make any changes you want and watch the real-time preview as you do. 
When you’re happy, click Close Hatch Editor to retain the changes.

Alternatively, you can use the Properties palette or the Quick Properties palette 
(described in Chapter 9) to make most existing hatch pattern changes. By default, 
AutoCAD displays the Hatch Editor tab when you click a hatch object, and it opens 
the Quick Properties palette when you double-click a hatch object. The Quick 
Properties palette is especially useful for changing several hatches at a time.

Simple grip-editing is also available. Select a hatch and then hover the cursor over 
the round, blue center grip. A contextual menu opens to give you quick access to 
changing the hatch origin, angle, and scale. Don’t be misled by the Stretch option 
on the context menu, though: You can only move a hatch with this option, and 
when you do, it loses its associativity to its boundary.

Here are a few other hatch tips:

 » To make one hatch look like another (without even opening the Hatch 
Editor tab): Click the Match Properties button in the Clipboard panel on the 
Home tab of the Ribbon.

 » To mirror drawing geometry that includes hatches without mirroring 
the hatch angle: Use the MIRRHATCH system variable. This tip can be quite 
useful when creating drawings of symmetrical objects. Model one half, apply 
the hatch, and then use the MIrror command (see Chapter 11) to get the other 
half. The hatch angle remains consistent on both sides of the mirror line.

 » To find the area of any hatch object: Simply select the hatch object and 
then open the Properties palette. The area is listed in the Geometry section, 
near the bottom of the palette.

Don’t go overboard with hatches. Their purpose is to clarify, not to overwhelm, 
the other geometry in the drawing. If your plots comprise a patchwork of hatch 
patterns, it’s time to simplify.

Always apply hatches last, if you can. The Hatch command is smart enough to 
recognize text and dimensions that fall within the hatched area. It treats them like 
sterile eggs and automatically omits hatch zones around them. If you forget, or if 
you need to add a note later in a hatched area, apply background masking to the 
text, as discussed in Chapter 13.
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IN THIS CHAPTER

Configuring printers and plotters

Plotting model space

Plotting to scale

Plotting paper space layouts

Plotting with lineweights and colors

Controlling plotters with plot styles

Troubleshooting plots

The Plot Thickens

Despite the infinitesimally small number of offices without a computer (or 
two) on every desk or in a pocket, many people still want or need to work 
with easily readable electronic drawings (can you spell P-D-F?) or dead-

tree paper drawings. You may need to give hard-copy printouts or PDF files to 
less savvy colleagues who don’t have AutoCAD, or to people on construction sites 
where relatively delicate computers wouldn’t survive long. You may want to print 
hard copies to review during your bus ride home. You may even find that check-
ing drawings the old-fashioned way, with a hard-copy printout and a red pencil, 
turns up errors that managed to remain hidden on the computer screen.

Hard copies may also survive longer as historic records. Some 10-year-old CAD 
files can no longer be opened because the company that produced the software 
that was used to create them no longer exists, and the software won’t run on cur-
rent operating systems. On the other hand, for the ultimate in hard copies, we can 
still read Egyptian stone obelisks that are several thousand years old.

Whatever the reason, you’ll want to print drawings at some point, and probably 
sooner rather than later. Depending on where you are in a project, plotting is the 
pop quiz, midterm, or final exam of your drawing-making semester. This chapter 
helps you ace the test.

Chapter 16
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You Say “Printing,” I Say “Plotting”
Plotting originally meant creating hard-copy output on a device that was capable 
of printing on larger sheets, such as D size or E size (or A1 or A0 for the metrically 
inclined), that measure several feet (or a meter or more) on a side. These plotters 
often used pens to draw, robot-fashion, on large sheets of vellum or drafting film. 
The sheets could then be run through diazo blueline machines, which were copying 
machines that created blueline prints to create less-expensive copies.

Printing meant creating hard-copy output on ordinary printers that used ordinary- 
sized paper, such as A size (letter size, 8½ x 11 inches) or B size (tabloid or ledger 
size, 11 x 17 inches): A4 or A3, for you metric folk.

Nowadays, AutoCAD and most CAD users make no distinction between plotting 
and printing. AutoCAD veterans usually say “plotting,” so if you want to be cool, 
you can do so, too.

Whatever you call it, plotting an AutoCAD drawing is potentially more complicated 
than printing a word-processing document or a spreadsheet. CAD has a larger 
range of different plotters and printers, drawing types, paper sizes, and output 
procedures than other computer applications. AutoCAD tries to help you tame the 
vast jungle of plotting permutations, but you’ll probably find that you have to take 
some time to get the lay of the land and clear a path to the hard copy output you 
want. After you find the sweet spot, plotting becomes quite routine.

The Plot Quickens
Even if you already realize that you won’t master AutoCAD plotting in five minutes 
flat, your boss, employee, spouse, construction foreman, or 11-year-old daughter 
may still want a quick check plot of your drawing.

Plotting success in 16 steps
Here’s the quick, cut-to-the-chase section for plotting a simple drawing — a 
mere 16 steps! This isn’t as bad as it sounds, however, because you see later how 
to save your printing steps so that you can reuse them with considerably less 
effort. For the purpose of this section, we’re assuming that you plot from model 
space: that is, that clicking the Model tab on the status bar shows you the draw-
ing in a way you want to plot. I cover plotting paper space layout tabs in the later 
section “Plotting the Layout of the Land.” This section doesn’t deal with control-
ling plotted lineweights; see the “Plotting Lineweights and Colors” section, later 
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in this chapter, for those details. It should, however, result in a piece of paper 
that bears some resemblance to the information that AutoCAD displays on your 
computer monitor.

Follow these steps to make a simple, not-to-scale, monochrome (black-and- 
white) plot of a drawing:

1. Open the drawing in AutoCAD.

2. Click the Model tab to ensure that you’re plotting the model space 
contents.

If you don’t have the Model and Layout tabs displayed, click the Model button 
(not the MODEL/PAPER button) on the status bar.

I explain model space and paper space in Chapter 12, and how to plot 
paper space layouts in the section “Plotting the Layout of the Land,” later 
in this chapter.

3. Zoom to the drawing’s current extents.

Click the Zoom Extents button on the Navigation bar. If necessary, click the tiny 
down arrow below the Zoom button, and choose Zoom Extents from the 
menu. Or easier yet, type Z E (note the space between the letters) and then 
press Enter.

The extents of a drawing consist of the edges of a rectangular area just large 
enough to include all objects in the drawing.

4. Click the Plot button on the Quick Access toolbar.

The Plot dialog box appears, as shown in Figure 16-1.

AutoCAD automatically appends whatever you’re about to plot in the dialog 
box’s title bar. For example, in Figure 16-1, the dialog box title is Plot – Model. If 
you are plotting from a paper space layout and have changed the layout name, 
the dialog box title is Plot – First Floor Plan (or whatever you renamed it). In this 
book, I call the dialog box (simply) “the Plot dialog box.”

5. In the Printer/Plotter area, select a device from the Name drop-down list.

If your computer has a generic printer attached to it, select Default Windows 
System Printer pc3. If you don’t have a system printer connected, choose 
Microsoft XPS Document Writer. This step creates a file that can be viewed in 
Internet Explorer.

6. In the Paper Size area, select a paper size that’s loaded in the printer or 
 plotter.

For most generic Windows desktop printers, it’s Letter (8.5 x 11 inches, 
portrait), ANSI A-size (11 x 8.5 inches, landscape), or metric A4 (210mm x 
297mm).
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7. In the Plot Area area (sponsored by the Department of Redundancy 
Department), select Extents from the What to Plot drop-down list.

This step plots the entire drawing. The alternatives plot just part of a drawing.

8. In the Plot Offset (Origin Set to Printable Area) area, select the Center the 
Plot check box.

This step centers the drawing on the paper. Alternatively, you can specify an X 
or a Y offset (or both) of 0 (zero) or other amounts to position the plot at a 
specific location on the paper to, for example, avoid a title block.

9. In the Plot Scale area, select the Fit to Paper check box.

This step ensures that the drawing, no matter how large (or small), fits the 
paper. For most real plotting, however, you would plot to a specific scale. I 
cover plotting to a specific scale in the “Instead of fit, scale it” section, later in 
this chapter, for guidance.

10. Click the More Options button (at the lower-right corner of the dialog 
box, next to the Help button).

The Plot dialog box reveals additional settings, as shown in Figure 16-2.

More Options button
FIGURE 16-1:  

The Plot dialog 
box.
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Starting with AutoCAD 2016, the default is for the Plot dialog box to be 
expanded.

11. In the Plot Style Table (Pen Assignments) area, choose monochrome.ctb or 
monochrome.stb from the drop-down list.

This step converts all colors in the drawing to shades of gray. If AutoCAD asks 
whether to assign this plot style table to all layouts, click No for now.

12. In the Plot Options area, make sure that the Plot with Plot Styles check box 
is selected and that the Save Changes to Layout check box is deselected. (See 
Figure 16-2.)

Leaving the Save Changes to Layout check box deselected tells AutoCAD to use 
any plot settings changes that you make only for this plot. AutoCAD reverts to 
the original plot settings the next time you plot the drawing.

After you become confident with plotting, select this check box so that 
AutoCAD does save your plotting settings changes as the default. Alternatively, 
click the Apply to Layout button to make the current plot settings the defaults 
for future plotting of this tab (that is, the Model tab) in this drawing.

13. In the Drawing Orientation area, choose Portrait or Landscape.

The icon (the letter A on a sheet) in the lower-right corner may help you choose 
the orientation that best fits the paper. If you don’t find it helpful, see the full 
preview in Step 14.

14. Click the Preview button to ensure that the drawing appears on the paper at 
the correct orientation and size, as shown in Figure 16-3, and then right-click 
and choose Exit to return to the Plot dialog box.

FIGURE 16-2:  
The expanded 

Plot dialog box.
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15. If you find any problems in the preview, adjust the plot settings (for example, 
Plot Area, Plot Scale, or Drawing Orientation) and repeat the preview until 
the plot looks right.

16. Click OK to create the plot.

When AutoCAD finishes generating and sending the plot, it displays the Plot 
and Publish Job Complete balloon notification from the status bar. To hide 
these notifications, right-click the Plot/Publish Details Report Available icon 
near the right end of the status bar, and then deselect Enable Balloon 
Notification.

There — only 16 steps, as promised. On the other hand, I never promised that this 
plot would be usable. For example, if you tried to plot a large, complex D-size or 
E-size architectural drawing on an A-size sheet of paper, it isn’t readable without 
a microscope. The bottom line, however, is that you produced a plot! Read the 
rest of this chapter for all the details about the numerous other plotting options 
available in AutoCAD. If you had trouble with this plot, jump ahead to the trouble-
shooting section “The Plot Sickens,” later in this chapter.

Getting with the system
One complication you may face in your attempt to create hard copy is that Auto-
CAD has two distinct ways to communicate with plotters and printers. Operating 
systems, and the programs that run on them, use a special piece of software, the 
printer driver, to format data for printing and then send it to the printer or plotter. 
When you configure Windows to recognize a new printer connected to your com-
puter or network, you’re installing the printer’s driver. AutoCAD, like other Win-
dows programs, works with the printers you’ve configured in Windows. AutoCAD 
calls these system printers because they’re part of the Windows operating system.

FIGURE 16-3:  
A preview of 
coming plot-

tractions.
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But AutoCAD, unlike other Windows programs, can’t leave well enough alone. 
The Windows system printer drivers don’t efficiently control some output devices, 
especially some larger plotters. For that reason, AutoCAD comes with specialized 
non-system drivers (that is, drivers that aren’t installed as part of the Windows 
system) for plotters from companies such as Hewlett-Packard, Xerox, KIP, and 
Canon-Océ. These drivers ignore the tidy rules for communicating with Windows 
printers in order to get things done more accurately and a bit more quickly.

Most of the time, using already configured Windows system printers is easiest, 
and they work well with many devices, especially devices such as laser and inkjet 
printers that print on smaller paper. However, if you have a large-format plotter, 
you may be able to get faster plotting, better plot quality, or more plot features by 
installing a non-system driver. To find out more, search for your specific plotter 
using the AutoCAD online Help system.

Configuring your printer
To ensure that AutoCAD recognizes the devices you want to use for plotting, fol-
low these steps:

1. Launch AutoCAD and open an existing drawing or start a new, 
blank drawing.

2. Choose Options on the Application menu or type OP and press Enter to open 
the Options dialog box; then click the Plot and Publish tab.

3. Click the drop-down arrow to view the list just below the Use as Default 
Output Device option, as shown in Figure 16-4.

The list includes two kinds of device configurations, designated by two tiny, 
difficult-to-distinguish icons to the left of the device names:

• Windows: A little printer icon with a sheet of white paper coming out the 
top indicates a Windows system printer configuration.

• Non-system: A little plotter-with-legs icon with a piece of paper coming out 
the front indicates a non-system (that is, AutoCAD-specific) configuration.

The non-system configuration names always end in .pc3 because they’re 
stored in special AutoCAD Plotter Configuration version 3 files. So, if you 
can’t distinguish the difference between the icons, look for the .pc3 at the 
end of the name.



300     PART 3  If Drawings Could Talk

4. Verify that the list includes the printers and plotters you want to have 
 available in AutoCAD.

If they’re not in the list, how you add one depends on your operating system:

• Windows XP: Choose Start➪Printers and Faxes, and then click the Add a 
Printer link under Printer Tasks on the left side of the window.

• Windows Vista: Choose Start➪Control Panel➪Hardware and 
Sound➪Printers➪Add a Printer, and then click Add a Local Printer.

• Windows 7: Choose Start➪Devices and Printers➪Add a Printer, and then 
click Add a Local Printer.

• Windows 8: Hold down the Windows key and then press W. In the Search 
field, enter printers. Under Settings, choose Add Printer.

• Windows 10: Tap Cortina, and then enter printers in the Search field, 
Choose Devices and Printers, and then choose Add a Printer.

If your printer isn’t on the default Windows list, cancel the wizard and hunt 
down a driver disc that came with the printer. Better yet, download the current 
driver from the printer manufacturer’s website.

5. Choose the output device that you want to designate as the default for new 
drawings.

6. Click OK to close the dialog box and retain the changes you made in Step 5.

List of devicesSystem printers

Non-system printers

FIGURE 16-4:  
System 

and non-
system printer 
 configurations.
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You use the AutoCAD Plotter Manager’s Add-a-Plotter Wizard to create configu-
rations with non-system drivers. Choose Plotter Manager on the Plot panel of 
the Ribbon’s Output tab to display an Explorer window containing a shortcut to 
the wizard. This wizard is similar to the Windows Add Printer Wizard; if you can 
handle adding an ordinary printer in Windows, you can probably handle adding a 
non-system plotter configuration to AutoCAD. When you complete the wizard’s 
steps, AutoCAD saves the information in a PC3 (Plotter Configuration version 3) 
file. If you add an HP Designjet printer or certain Canon-Océ wide-format print-
ers, the Add-a-Plotter Wizard advises you to exit and instead install the device as 
a Windows system printer. Many people find that the standard drivers work fine, 
but as I mention later in this chapter, custom drivers may include additional paper 
sizes as well as other handy settings.

Preview one, two
One key to efficient plotting is the liberal use of AutoCAD’s plot preview feature. 
To maintain political balance, I recommend conservative use of other AutoCAD 
options elsewhere in this book.

The postage-stamp-size partial preview in the middle of the Plot dialog box is a 
quick reality check to ensure that the plot fits on the paper and is in the correct 
direction. If the plot area at the current scale is too large for the paper, AutoCAD 
displays thick, red warning lines along the side(s) of the sheet where the drawing 
will be truncated.

Click the Preview button to see a full preview in a separate window. You see exactly 
how the drawing lays on the paper, as well as how the various lineweights, colors, 
and other object plot properties appear. You can zoom and pan around the preview 
by using the right-click menu.

Zooming and panning are simply ways to get a better look at different areas of the 
plot preview. Neither action affects the area of the drawing that’s plotted.

Instead of fit, scale it
In most plotting situations, you plot to a specific scale dictated by your industry, 
rather than let AutoCAD choose an oddball scale (fit) that just happens to maxi-
mize the drawing’s size on the paper. And if you plan to plot to scale the Model tab 
of a drawing, you need to know its drawing scale factor. Chapter 4 describes setup 
concepts, and Chapter 13 provides some tips for determining the scale factor of a 
drawing that someone else created.
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If the drawing was created at a standard scale, such as 1:50 or 1/4" = 1'-0", you 
simply choose the scale from the handy Scale drop-down list in the Plot dialog 
box. If the scale isn’t in the list, something is probably wrong, because you should 
almost always be using standard scales. On the other hand, if you must use a cus-
tom scale, type the ratio between plotted distance and AutoCAD drawing distance 
into the two text boxes below the Scale drop-down list, as shown in Figure 16-5. 
Usually, the easiest way to express the ratio is to type 1 in the upper box and the 
drawing scale factor in the lower box. See Chapter 4 for more information.

Your CAD manager may have edited the Scale drop-down list to add uncommon 
scales or remove scales that your company never uses. If you’re designing espresso 
machines in Milano, for example, you’ll probably never need to plot drawings at 
1/128" = 1'-0". Yes, that scale is on the AutoCAD list.

Creating half-size plots for certain purposes is common in some industries. 
To plot model space at half-size, double the drawing scale factor. For example, 
a 1/8" = 1'-0" drawing has a drawing scale factor of 96, which is equivalent to a 
plot scale of 1 = 96. To make a half-size model space plot of it, specify a plot scale 
of 1 = 192 (or choose 1/16" = 1'-0" from the Scale drop-down list).

Even if you work with drawings created to be plotted at a specific scale, plotting 
with a Fit to Paper scale may be the most efficient way to make a reduced-size 
check plot. For example, drafters in your office might create drawings that are 
plotted on D-size sheets (24 x 36 inches), whereas you have access to a laser 

Choose a
prede�ned scale…

…or type a ratio

FIGURE 16-5:  
Lots of ways to 

scale.
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printer with a B-size (11 x 17 inches) paper tray. By plotting the D-size drawings 
scaled to fit on B-size paper, you produce check plots that are slightly smaller 
than half-size. You can’t measure distances on the check plots with a scale, but 
you can give them a visual check for overall correctness, or use them at project 
progress meetings.

Plotting the Layout of the Land
In the section “Plotting success in 16 steps,” earlier in this chapter, I show you 
how to plot the model space representation of a drawing by making sure that the 
Model tab is active when you open the Plot dialog box. In most industries, how-
ever, model space plotting went the way of the dodo 20 years ago. Paper space 
gives you many additional options for controlling the look of the output without 
having to modify the underlying geometry. So most of the time, you plot a paper 
space layout instead.

Paper space is the environment that’s specifically designed for outputting hard 
copy of your drawings. For information on paper space or layouts, see Chapter 12.

As I explain in Chapter  12, AutoCAD gives you two alternative ways of switch-
ing between full-screen model space and the paper space layouts stored in the 
drawing. If you choose to display the Model and Layout tabs, you simply click the 
appropriate tab to select one. If you have hidden the Model and Layout tabs, use 
the Model and Layout buttons, plus Quick View Layouts, on the status bar or the 
drawing tabs.

Plotting a paper space layout is much like plotting model space except that you 
first find the appropriate layout and verify that its tab is selected before you open 
the Plot dialog box. Follow these steps:

1. Move the mouse pointer across the Layout tabs at the bottom of 
the screen.

A preview of each layout appears as you hover the cursor on each tab.

2. Right-click the tab of the layout that you want to plot.

A multi-item context menu appears with a number of items related to layouts.

3. Click the Plot item in the context menu.

The Plot dialog box appears with the name of the layout to be plotted dis-
played on the title bar. In Figure 16-6, we’re plotting a layout named D-Size 
Layout.
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If no layout was previously set up, AutoCAD creates a default layout. If the 
Show Page Setup Manager for New Layouts setting on the Display tab of the 
Options dialog box is turned on, you see the Page Setup Manager dialog box 
first; just click the Close button. The default layout probably isn’t useful for real 
projects, but you can use it to find out about layout plotting. Refer to 
Chapter 12 for instructions on creating a real layout.

4. Specify a printer/plotter name and a paper size.

If you don’t have a printer capable of producing sheets larger than letter or 
tabloid size, you can still experiment by selecting a device that outputs to a file, 
such as DWG To PDF.pc3.

5. In the What to Plot drop-down list, choose Layout, as shown in Figure 16-6.

The Layout option is available only when plotting a layout tab; Limits is 
available only when plotting the Model tab.

6. Specify the plot offset (such as 0 in both the X and Y directions).

Specifying the plot offset as 0 in both X and Y directions places the lower-left 
corner of the plotted drawing at the lower-left corner of the printable area.

7. In the Plot Scale area, select 1:1 from the Scale drop-down list, as shown in 
Figure 16-6.

One primary advantage of using layouts is that you don’t need to know about 
drawing scale in order to plot the drawing — hence the name paper space. 
Figure 16-6 shows the proper settings for plotting a layout.

FIGURE 16-6:  
Settings for 

plotting a 
paper space 

layout.
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To create a half-size plot of a layout, select 1:2 from the Scale drop-down list. In 
addition, select the Scale Lineweights check box to reduce lineweights propor-
tionally. I cover plotting lineweights in the next section.

If you find that the layout is too big for the plotter’s largest paper size at a plot 
scale of 1:1, you can select Extents from the What to Plot drop-down list and 
then select the Fit to Paper check box in the Plot Scale area. Alternatively, you 
can close the Plot dialog box and fix the problem if you want to have a paper 
space layout that permanently reflects a new paper size. Use the Page Setup 
dialog box to modify the layout settings, or copy the layout and modify the 
new copy.

8. Click the More Options button and change any additional plot options you 
want.

Refer to Steps 11–13 in the earlier section “Plotting success in 16 steps.”

9. Click the Preview button, ensure that the drawing displays on the paper at 
the correct orientation and size, right-click, and choose Exit from the menu 
that appears to return to the Plot dialog box.

If you find any problems in the preview, change the plot settings and preview 
again until it looks right.

10. Click OK to create the plot.

Plotting Lineweights and Colors
In previous sections of this chapter, I help you gain some plotting confidence. 
Those sections show you how to create scaled, monochrome plots with uniform 
lineweights in model space or paper space. Those skills may be all you need, but if 
you care about controlling plotted lineweights and colors or adding special effects 
such as screening (plotting shades of gray), read on.

Plotting with style
Plot styles provide a way to override object properties with alternative plot proper-
ties. See Chapter 9 for information about object properties. The properties include 
plotted lineweight, plotted color, and screening. Figure 16-7 shows the full range 
of options. Plot styles come in two exciting flavors:

 » Color-dependent: Based on the standard way of plotting in earlier versions of 
AutoCAD (before AutoCAD 2000)

 » Named: Provide a newer (but not necessarily better) way
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You may not need to bother with plot styles. If the drawings you want to plot 
have layer and object properties (especially lineweights) that reflect how you want 
objects to plot, you can dispense with plot styles. But most people and most draw-
ings use plot styles, so you should at least be familiar with them.

A couple of common reasons for using plot styles are to

 » Map screen colors to plotted lineweights. If this idea seems completely 
loony to you, try to suspend judgment until you read the “Plotting through 
thick and thin” section, later in this chapter.

 » Create screened lines on monochrome plots. Lines that are screened 
display in various shades of gray, not black. Drafters sometimes use screened 
lines to deemphasize secondary objects that otherwise would overwhelm 
the main objects in the drawing. Screening is expressed as a percentage: 
100 percent is completely black, and 0 percent is invisible. How can you tell 
when your pen has run out of invisible ink? You can see the writing. Anyway, 
on a subdivision layout, you might want to deemphasize all the property and 
house outlines except one.

FIGURE 16-7:  
Editing a color-
dependent plot 

style table.
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Using plot styles
If you want objects in a drawing to plot with properties that differ from their 
display properties, you plot with styles. For example, they can plot with different 
lineweights or colors from the ones you’re using for display purposes. Or you may 
need to map display colors to plotted lineweights. AutoCAD lets you group lists of 
plot styles into plot style tables, each of which is stored in a separate file.

Color-based plot styles live in color-dependent plot style table (CTB) files, and they 
map the 255 AutoCAD display colors to 255 plot styles. AutoCAD automatically 
attaches these color-dependent plot styles to every object, based on — you guessed 
it — the object’s color. Are those AutoCAD programmers brilliant or what? Color-
dependent plot style tables mimic the old color-mapped-to-lineweight plotting 
approach of AutoCAD R14 and earlier releases; this method remains the most 
common one in most companies because it is easy to understand.

The named plot style, introduced in AutoCAD 2000, is an object property, just like 
color, linetype, and lineweight. Named plot styles live in (wouldn’t you know it?) 
named plot style table (STB) files. After you create a new named plot style table, you 
add one or more plot styles, giving them any names you like. Then you assign the 
named plot styles to layers or even to individual objects. See Chapter 9 for more 
information about object and layer properties.

To use the plot styles in a plot style table (whether they’re color-dependent or 
named), you must attach the plot style table to model space or a paper space 
layout. The attached plot style table affects plotting only for that specific model 
space or layout. This approach lets you plot the same drawing in different ways by 
attaching different plot styles to different layout tabs — one plot style per layout 
tab, one plot style table per drawing.

You can attach a plot style to model space or a paper space layout by selecting its 
image in the Quick View Layouts panel and then opening the Plot dialog box; or 
by right-clicking an image, choosing Page Setup Manager, and then clicking the 
Modify button. Choose the plot style table name from the Plot Style Table (Pen 
Assignments) area of the expanded Page Setup or Plot dialog box. See the section 
“Controlling plotted lineweights with screen colors,” later in this chapter, for an 
example.

When you start a new drawing in the usual way by using a template drawing (see 
Chapter 4), the template drawing’s plot style behavior determines whether you 
can choose CTB or STB files. If you want to change from color-dependent plot 
styles to named plot styles (or vice versa) in a particular drawing, use the CON-
VERTPSTYLES command.

The CONVERTPSTYLES command can handle styles that contain spaces in their 
names.
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Creating plot styles
If you’re lucky, someone will provide you with the plot files you need. If that’s 
the case, you must put the CTB or STB files in the Plot Styles folder for AutoCAD 
to recognize them. To find the location of the Plot Styles folder, open the Options 
dialog box, select the Files tab, and look for the Printer Support File Path➪Plot 
Style Table Search Path setting.

If you’re unlucky, you need to be smart enough to know how to create your own 
plot style table files. Personally, we’d rather be lucky than smart; hey, it’s worked 
so far in life! Here’s how to create plot style table files:

1. Click the Application button to open the Application menu, click Print, 
and then choose Manage Plot Styles.

Use the tiny down arrow at the bottom of the list to scroll farther down, if 
necessary. The Plot Styles folder opens in a separate Windows Explorer 
window.

2. Double-click the Add-a-Plot Style Table Wizard program shortcut.

3. Read the opening screen and then click Next.

4. On the Add Plot Style Table – Begin page, choose the Start from Scratch 
option or one of the other three options if you want to start with settings 
from another file. Then click Next.

The remaining steps assume that you chose Start from Scratch. If you chose 
another option, simply follow the wizard’s prompts.

If the creator of a drawing provides you with an AutoCAD R14/AutoCAD LT 98 
PC2 (version 2) or AutoCAD R12/AutoCAD LT 95 PCP (version 1) file, choose the 
Use a PCP or PC2 File option. With this option, the wizard imports color-to- 
plotted-lineweight settings automatically.

5. On the Add Plot Style Table – Pick Plot Style Table page, choose whether you 
want to create a color-dependent plot style table (CTB file) or a named plot 
style table (STB file). Then click Next.

Choose Color-Dependent Plot Style Table to map screen colors to plotted 
lineweights. Choose Named Plot Style Table to create named plot styles that 
you can apply to layers or objects.

6. On the Add Plot Style Table – File Name page, type a name for the new CTB  
or STB file and then click Next.

7. Click the Plot Style Table Editor button on the Add Plot Style Table – Finish 
page.
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The Plot Style Table Editor dialog box opens to the Form View tab if you’re 
creating a color-dependent plot style table (refer to Figure 16-7), or to the Table 
View tab if you create a named plot style table.

If you choose a named plot style in Step 5, the Plot Style Table Editor dialog box 
opens in Table view, with one plot style named Normal in the first data column, 
a blank column to its right, and Add Style and Delete Style buttons at the 
bottom. New named plot styles that you create continue to be added in 
columns to the right of the previous column. For more information, click the 
Help button in the Plot Style Table Editor.

8. If you created a color-dependent plot style table, assign Lineweight, 
Screening, or other plot properties to each color that’s used in the drawing. 
If you created a named plot style table, click the Add Style button and then 
assign plot properties to each of the named styles you create.

To determine which colors are used in a drawing, switch to the AutoCAD 
window and open the Layer Properties Manager palette by clicking the Layer 
Properties button, located on the Layers panel of the Ribbon’s Home tab.

To change a setting for all colors or named styles, select them all first by 
clicking the first color or named style, holding down the Shift key, scrolling to 
the end of the list, and then clicking the last color or named style. Any subse-
quent changes you make are applied to all the selected colors or named styles.

9. Click the Save & Close button to close the Plot Style Table Editor dialog box. 
Then click Finish to complete the steps in the wizard.

The Plot Styles folder now displays the new CTB or STB file.

10. Close the Plot Styles folder by clicking the X on its title bar.

Creating a plot style table the first time can be a harrowing experience because 
you have many options. Just remember that the most likely reason for creating 
one is to map screen colors to plotted lineweights (as I describe in greater detail 
in the next section). Also remember that you may be able to minimize your effort 
by getting a CTB or STB file from the person who created the drawing you want 
to plot.

In Chapter 9, I recommend limiting yourself to the first nine standard AutoCAD 
colors when defining layers, and not a patchwork of the 16.7 million colors that 
AutoCAD makes available. If you follow my advice, your work to create a color-
dependent plot style table is greatly reduced because you have to assign plot prop-
erties for only nine colors rather than worry about hundreds of them.
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For systematic testing of CTB files, you can download the file named plot_ 
screening_and_fill_patterns.dwg from the AutoCAD 2010 Sample Files group 
at www.autodesk.com/autocad-samples. AutoCAD LT users, help yourselves to 
this file too; it isn’t included with the AutoCAD LT sample files. This drawing 
shows an array of color swatches for all 255 AutoCAD colors. The layouts (such 
as Grayscale and Screening 25%) demonstrate how different CTB files attached to 
the same layout produce radically different results.

Named plot styles hold a lot of promise, but in at least a couple of places (such 
as dimensions and tables, for example), they don’t work as well as traditional 
color-based plotting. Dimension properties allow you to assign different colors to 
dimension lines, extension lines, and text. The purpose is to allow different parts 
of a dimension object to print with different lineweights; for example, you can 
have dimension text print with a medium lineweight, the same as the annota-
tion text, while retaining the fine lineweight of extension and dimension lines. 
But because named plot styles are based on objects or layers, you don’t have that 
lineweight control over individual dimension components. The same limitation 
applies to tables, where you can set text to be one color and grid lines to be another.

If you get carried away and decide to take advantage of the 16 million colors (or 
so) in the AutoCAD True Color or Color Book modes, you won’t control lineweights 
with color-dependent plot styles. CTB plot styles affect the lineweights only of 
objects that use the traditional 255 colors of the AutoCAD Color Index set. If you 
want True Color or Color Book colors, use object lineweights or named plot styles 
to control the plotted lineweight.

Plotting through thick and thin
Long ago, manual drafters developed the practice of drawing lines of different 
widths (lineweights) to distinguish different kinds of objects. Manual drafters did 
it with different technical ink pen nib diameters or with different hardnesses of 
pencil lead and varying degrees of pressure on the pencil. Because a computer 
mouse usually doesn’t come supplied with mouse balls of different diameters (and 
we’re going to resist the urge to jump in with a comment about mouse reproduc-
tion, especially now that most mice are of the optical variety), AutoCAD develop-
ers had to figure out how to let users indicate lineweights onscreen and on plots. 
They came up with two different ways to indicate lineweight:

 » Mapping onscreen colors to plotted lineweights: I describe this common 
approach in Chapter 9.

 » Displaying lineweights onscreen to match what the user can expect to 
see on the plot: This approach appeared in AutoCAD 2000.

http://www.autodesk.com/autocad-samples
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Controlling plotted lineweights with object 
 lineweights
Plotting object lineweights is trivial, assuming that the person who created the 
drawing first assigned a lineweight property to layers or objects. See Chapter 9 for 
details. Just make sure that the Plot Object Lineweights check box in the expanded 
Plot dialog box is selected. You can also deselect the Plot with Plot Styles check 
box because plot styles can override the object lineweights with different plotted 
lineweights. You can also make these settings in the Page Setup dialog box for the 
appropriate Layout or Model tab. To access the Page Setup Manager, right-click 
the Quick View Layouts button on the status bar and choose Page Setup Manager.

If you want object lineweights to control plotted lineweights, make sure that the 
Plot Object Lineweights check box is selected in the Plot Options area of the Plot 
or Page Setup dialog box. If you don’t want to plot the lineweights assigned to 
objects, you must deselect both the Plot Object Lineweights and Plot with Plot 
Styles check boxes in the Plot or Page Setup dialog box. Selecting Plot with Plot 
Styles selects Plot Object Lineweights as well.

Controlling plotted lineweights with screen colors
To map screen colors to plotted lineweights, you need a color-dependent plot 
style table (CTB file). If you’re plotting a drawing created by someone else, that 

PLOTTING WITH PLODDERS
Color-as-color and lineweight-as-lineweight seem like great ideas, but Autodesk knew 
(when it added object lineweights back in 1999) that longtime users of AutoCAD wouldn’t 
abandon overnight the approach of mapping old colors to lineweights. Thus, you can still 
control plotted lineweight by display color in AutoCAD.

AutoCAD veterans, by and large, have chosen to stick with the old way for now. They’ve 
done so for a variety of reasons, including inertia, plotting procedures and drawings built 
around the old way, third-party applications that don’t fully support the newer meth-
ods, and the need to exchange drawings with clients and subcontractors who haven’t 
changed. The ripple effect of those who need to, or want to, continue using colors 
mapped to lineweights is lasting a long time. Don’t be surprised if you go with the flow 
for a while.

The default setting in AutoCAD is to plot object lineweights, so that’s the easiest method 
if you don’t have to consider the historical practices or predilections of other people with 
whom you exchange drawings. Mapping screen colors to lineweights requires some ini-
tial work on your part, but after you’ve set up the mapping scheme, the additional effort 
is minimal.
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person may be able to supply you with the appropriate CTB file, or at least with a 
PCP or PC2 file from which you can create the CTB file quickly. The creator of the 
drawing should be able to supply at least a printed chart showing which plotted 
lineweight to assign to each AutoCAD screen color. Use the steps in the earlier sec-
tion “Plotting with style” to copy or create the required CTB file.

Unfortunately, no industry-wide standards exist for mapping screen colors to plot-
ted lineweights. Different offices do it differently. That’s why it’s useful to receive 
a CTB, PCP, or PC2 file with drawings that clients send you. If they use eTransmit, 
the plot style tables and plotter configuration files are included in the package.

WHEN IN DOUBT, SEND IT OUT
Whether you plot to scale or not, with different lineweights or not, or in color or not, 
consider using a service bureau for plotting. In-house plotting on the output devices in 
your office is useful for small check plots on faster laser or inkjet printers. Large-format 
plotting, on the other hand, can be slow and time consuming. If you need to plot lots of 
drawings, you may spend an afternoon loading paper, replenishing ink cartridges, and 
trimming sheets.

Successful plotting service bureaus have large, fast, expensive plotters (that you can only 
dream about owning, even though they’re responsible for babysitting, feeding, and fixing 
these fancy devices). As a bonus, service bureaus can make blueline prints from your 
plots if you need to distribute hard-copy sets to other people.

The downside is that you must ensure that the service bureau receives all necessary 
information and that it can deliver all necessary plots on time. Some service bureaus plot 
directly from DWG files, whereas others ask you to make PLT (plot) files. Some service 
bureaus specialize in color plotting, and others are more comfortable with monochrome 
plotting and making blueline copies.

When you’re choosing a service bureau, look for one that traditionally has served 
 drafters, architects, and engineers. These service bureaus tend to be more knowledge-
able about AutoCAD, and they should have more plotting expertise than the desktop- 
publishing, printing, and copying shops.

Whoever you choose, test some plots well before the day that important set of drawings 
is due. Talk to the plotting people and get a copy of their plotting instructions. Have the 
service bureau create plots of a couple of your typical drawings, and make sure that they 
look the way you want them to.

If you often plot with a service bureau, consider charging the fee to clients as a standard 
expense (as you would with bluelines and copying).
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After you have the appropriate CTB file stored in the Plot Styles folder, follow 
these steps to use it:

1. Move the mouse pointer across the Layout tabs at the bottom of 
the screen.

A preview of each layout appears as you hover the cursor on each tab.

2. Right-click the tab of the layout that you want to plot.

A multi-item context menu appears with a number of items related to layouts.

3. Click the Plot item in the context menu.

The Plot dialog box appears with the name of the layout to be plotted dis-
played on the title bar.

4. In the Plot Style Table (Pen Assignments) area of the Plot dialog box, select 
the CTB file from the drop-down list. (See Figure 16-8.)

The plot style table (CTB file) is attached to the layout or model space tab that 
you clicked in Step 2.

If the drawing uses a named plot style table instead of a color-dependent plot 
style table, select an STB file instead of a CTB file.

FIGURE 16-8:  
Selecting a 

plot style table 
that maps 

screen colors 
to plotted 

lineweights.
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5. Click the Apply to Layout button.

AutoCAD records the plot setting change with the current layout’s configura-
tion information. Assuming that you save the drawing, AutoCAD uses the CTB 
you selected as the default plot style when you (or other people) plot this 
layout in the future.

6. Continue with the plotting procedures described earlier in this chapter.

You can tell whether the current drawing was set up to use color-dependent plot 
styles or named plot styles by looking at the Properties panel on the Ribbon’s Home 
tab. If the upper-right drop-down list is grayed out, shows ByColor, and doesn’t 
display a tooltip, the drawing uses color-dependent plot styles. If this list isn’t 
grayed out and displays the Plot Style tooltip, the drawing uses named plot styles.

Plotting in color
Plotting the colors you see onscreen requires no special tricks. In the absence of a 
plot style table (that is, if you selected None from the drop-down list in the Plot 
Style Table [Pen Assignments] area in the Plot or Page Setup dialog box), AutoCAD 
sends color information as it appears onscreen to the plotter. As long as the output 
device can plot in color, what you see should be what you get.

If you attach a plot style table to the layout you’re plotting (as described in the 
preceding section), you can choose to map screen colors to different plotted col-
ors. In most cases, you don’t want that kind of confusion. Instead, leave the Color 
property in the plot style table set to Use Object Color.

If your goal is not to plot color, verify that the Color property for all plot styles 
is set to Black. If you try to plot colors on a monochrome device, you may find 
that objects appear in various shades of gray, with some colors mapped to lighter 
shades of gray and others to darker shades of gray. This process of mapping colors 
to shades of gray is dithering, and it usually is not what you want in a CAD drawing. 
To override it, use the Plot Style Table Editor, as described in the earlier section 
“Creating plot styles,” to set the Color option for all colors to Black. The default 
setting is Use Object Color. If you don’t already have a plot style table to use, select 
monochrome.ctb for color-based plot styles or select monochrome.stb for named 
plot styles (both of which come with AutoCAD) from the drop-down list in the Plot 
Style Table (Pen Assignments) area of the Plot dialog box.
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To see the full range of AutoCAD colors available on a plotter, or to see how a 
particular plot style table affects plotting, open and then plot the sample file 
plot_screening_and_fill_patterns.dwg, which you can download from www.
autodesk.com/autocad-samples. The Screening 100% layout in this drawing 
contains color swatches for all 255 AutoCAD colors. (This file is available to Auto-
CAD LT users as well.)

It’s a (Page) Setup!
Page setups specify the plotter, paper size, and other plot settings that you use 
to plot a particular layout or the model space of a drawing. AutoCAD maintains 
separate page setups for model space and for each paper space layout. When you 
click the Apply to Layout button in the Plot dialog box (or select the Save Changes 
to Layout check box and then click OK to plot), AutoCAD stores the current plot 
settings as the page setup for the current layout.

You can also name page setups and save them. Then you can switch quickly 
between different plot settings and copy plot settings from one drawing layout to 
another. Named page setups are stored with each drawing, but you can copy them 
from another drawing into the current one with the Page Setup Manager dialog 
box (described later in this section).

If you want to get fancy, you can create named page setups in order to plot the 
same layout (or model space) in different ways, or to copy plot settings from one 
layout to another or one drawing to another. Click the Add button in the Page 
Setup area of the Plot dialog box to create a named page setup from the current 
plot settings. After you create a named page setup, you can restore its plot settings 
by choosing it from the Page Setup Name drop-down list.

For even greater control, right-click the current drawing space tab and then 
choose Page Setup Manager to create, change, and copy page setups. In the Page 
Setup Manager dialog box, as shown in Figure  16-9, you can create new page 
setups and modify existing ones. Click the Modify button to open the Page Setup 
dialog box, which is almost identical to the Plot dialog box. The primary differ-
ence is that you’re changing plot settings rather than actually plotting. The Set 
Current button copies the page setup that you’ve selected on the Page Setups list 
to the current layout tab. With the Import button, you can copy a page setup from 
another drawing or drawing template (DWT) file.

http://www.autodesk.com/autocad-samples
http://www.autodesk.com/autocad-samples
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Continuing the Plot Dialog
Earlier in this chapter, I cover several important options in the Plot dialog box. 
This section reveals finer points to simplify your plotting life. I don’t cover every 
minute, obscure, useful-only-at-cocktail-party-discussions detail, and if this 
sounds like your kind of cocktail party, please remind me that I’m busy that night 
because I could end up monopolizing the conversation. I point out some occasion-
ally useful options to help increase your vocabulary when you’re communicating 
with the Plot dialog box.

Use the tooltips in the Plot dialog box to find out more about any part of the dialog 
box:

1. Hover the mouse pointer over the part of the dialog box that you want to 
know more about.

2. Press F1 or click the Help button at the bottom of the dialog box if the pop-up 
help isn’t helpful.

3. For a more conceptual take on plotting, click the Learn about Plotting 
link to view the Quick Start to Plotting section of the online Help system.

FIGURE 16-9:  
The Page 

Setup Manager 
dialog box.
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The following list explains most of the remaining controls, check boxes, and lists 
in the Plot dialog box:

 » Printer/Plotter: As I describe in the earlier section “Configuring your printer,” 
you use the Name drop-down list to select the Windows system printer or 
non-system driver configuration that you want to use for plotting.

Clicking the Properties button opens the Plotter Configuration Editor dialog 
box, with which you can change media (type of paper) and other properties 
that are unique to the selected plotter or printer. In particular, you can define 
custom paper sizes.

As if AutoCAD’s Plot dialog box settings weren’t overwhelming enough, 
depending on the plot device you may also have to deal with the Plotter 
Configuration Editor dialog box. Some plotter drivers hide important settings 
in this dialog box. To access them, you typically click the Custom Properties 
button near the bottom of the Plotter Configuration Editor dialog box. For 
example, if you’re using the enhanced Windows system driver for HP plotters, 
available at www.designjet.hp.com, you can click the Custom Properties 
button and then the More Sizes button to specify which paper sizes are avail-
able to you on the Paper Size drop-down list of the main Plot dialog box.

If you make any changes in the Plotter Configuration Editor dialog box, 
AutoCAD prompts you to save the changes to a separate PC3 file. You should 
choose Save Changes to the Following File (that is, create a new AutoCAD-
specific configuration that includes the revised settings) and type a configura-
tion name that you’ll recognize later. When you want to plot with custom 
settings, remember to choose the AutoCAD-specific PC3 configuration near 
the end of the Printer/Plotter Name drop-down list, and not the original 
Windows system printer configuration near the beginning of the list.

 » Plot to File: If you need to plot to a file rather than directly to the plotter or 
network printer queue, select the Plot to File option. When you click OK to 
plot, AutoCAD asks you for a plot filename and location. You may need to use 
this option to create files to send to a plotting service bureau.

AutoCAD adds DWFx to its ePlot options — a flavored version of DWF that 
conforms to Microsoft’s XPS page description language. For most people, the 
handiest aspect of this format is that if you plot to DWFx, the resulting file can 
be viewed in Internet Explorer.

Plotting with the DWG to PDF.pc3 file creates versions of the drawing files 
that can be opened and viewed in the free and widely available Adobe Reader 
software.

 » Plot Stamp On: Use this option to turn on and off and configure the contents 
of a text string that AutoCAD adds automatically to the corner of each plot. 
The plot stamp can include useful information, such as the drawing’s filename 
and plot date and time.

http://www.designjet.hp.com
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 » Plot Area: Specify the area of the drawing to plot. Your choices include 
Display, Extents, and Window regardless of whether you’re plotting a paper 
space layout or model space. If you defined named views in the drawing, 
AutoCAD adds a View option. The additional choice is Layout for a paper 
space layout, or Limits for model space.

• Display: The drawing as it’s displayed in the drawing window (including any 
empty space outside the drawing objects).

• Extents: The rectangular area containing all objects in the drawing.

• Limits (full-screen model space only): If you didn’t specifically set the draw-
ing’s model space limits (as I demonstrate in Chapter 3), plotting limits 
produce unpredictable results. Extents is usually a better option.

• Layout (Layouts only): The paper space area you defined when you set up 
the layout.

• Window: A rectangular area that you specify.

• View: A named view that you select from a drop-down list. Chapter 5 
describes named views and how to create them.

Usually, you choose to plot Layout in paper space. For model space, the 
choice depends on how the drawing was set up and what you want to plot. 
Use Window or View to plot only a portion of model space.

 » Plot Offset: A plot offset of X=0 and Y=0 positions the plot at the lower-left 
corner of the plottable area. If you want to move the plot from this default 
position on the paper, enter nonzero numbers or select the Center the Plot 
check box. This check box isn’t available if you select Layout from the What to 
Plot drop-down list because the layout determines the position of the drawing 
relative to the margins of the paper.

 » Shaded Viewport Options: If the drawing includes viewports showing shaded 
or rendered 3D models, use this area to control the plotted appearance.

 » Plot Options: The Plot Object Lineweights and the Plot with Plot Styles check 
boxes control whether AutoCAD uses the features described in the “Plotting 
with style” and “Plotting through thick and thin” sections, earlier in this 
chapter.

 » Hide Paperspace Objects: This check box controls whether AutoCAD hides 
objects that are behind other objects when a 3D model is displayed in a paper 
space viewport.

 » Plot Upside-Down: Select this check box to rotate the plot 180 degrees on the 
paper. This option is handy for plotting in the southern hemisphere and for 
preventing having to cock your head at an uncomfortable angle as you watch 
plots emerge from the plotter.
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AutoCAD normally takes over the program for the duration of the plot. If you have 
a reasonably fast computer with adequate memory, turn on Background Process-
ing in the Options dialog box: Type OP, press Enter, and click the Plot and Publish 
tab; in the Options area, select Plotting.

If you want to automate plotting for a batch of drawings, check out the sheet sets 
feature in AutoCAD and AutoCAD LT. One of the tasks that sheet sets are designed 
to accomplish is the publishing of a set of drawing sheets at one fell swoop. If this 
sounds useful, go to the online Help system and search for Work with Sheets in a 
Sheet Set in the Search Help Resources box.

The Plot Sickens
No matter how many times you read this chapter or how carefully you study the 
AutoCAD documentation, you occasionally run into plotting problems. You’re 
especially likely to encounter problems when trying to plot other people’s draw-
ings, because you don’t always know what plotting conventions they had in mind. 
A plotting convention isn’t a place where spies meet; it’s a standardized approach 
to plotting issues.

If a drawing contains object property overrides instead of ByLayer, you’ll have 
plotting problems. For example, you want to plot an architectural drawing to 
show the client the general room layout. You don’t want to confuse them with all 
the dimensions, so you freeze the Dimension layer. Oops, only half of the dimen-
sions go away, but so do several walls, a couple of windows, and the toilet.

Here are some common plotting problems (in italic) and solutions.

Nothing comes out of the plotter (system printer driver). Check the following:

 » Verify that the printer is plugged in and turned on, that it has paper (and the 
paper isn’t jammed) and plenty of toner or ink, and that it’s connected to 
the computer.

 » If the drawing is a large one, it may take a long time to rasterize.

 » Check whether you can print to the device from other Windows applications. 
If not, it’s not an AutoCAD problem.

 » Try the Windows Print Troubleshooter (although it usually ends up suggesting 
that you ask a friend):

• Windows Vista and Windows 7: Choose Start➪Help and Support, type 
printing troubleshooting in the Search box, press Enter, and then click 
Troubleshoot Printer Problems or Open the Printer Troubleshooter.
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• Windows 8: Hold down the Windows key and press W. In the Search field, 
type printing and then choose Find and Fix Printing Problems.

• Windows 10: Tap Cortina, and then enter fix printing in the Search My Stuff 
field. Choose Find and Fix Printing Problems, and then follow the prompts 
of the wizard.

HP provides its Print and Scan Doctor utility for finding problems troubling its 
printers and scanners. The software is available free from http://support.
hp.com/us-en/document/c03286146.

Nothing comes out of the plotter (non-system printer driver). Choose Plotter Manager 
on the Plot panel of the Ribbon’s Output tab, double-click the plotter configura-
tion, and check the settings.

Objects don’t plot the way they appear onscreen. Check for a plot style table with weird 
settings, or try plotting without a plot style table.

Objects appear ghosted or with washed-out colors. In the plot style table, set Color to 
Black for all colors.

Scaled to Fit doesn’t work correctly in paper space. Change the What to Plot drop-down 
list from Layout to Extents.

The Windows system driver that you downloaded doesn’t have the correct paper sizes. 
In the Plot dialog box’s Printer/Plotter area, click the Properties button to display 
the Plotter Configuration Editor dialog box, click the Custom Properties button 
(near the bottom), and then click the More Sizes button to specify the standard 
and custom paper sizes.

Something else is wrong. Check the plot log: Click the Plot/Publish Details Report 
Available icon near the right end of the status bar and look for error messages.

http://support.hp.com/us-en/document/c03286146
http://support.hp.com/us-en/document/c03286146
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Effectively use blocks, arrays, and xrefs in drawings.

Apply geometric and dimensional constraints and 
formulas — parametrics — to control the behavior of a 
drawing.

Share AutoCAD files through email, FTP, and the cloud.
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IN THIS CHAPTER

Introducing blocks

Creating block definitions with Block

Inserting blocks with Insert

Adding attributes to blocks with 
ATTdef

Removing unwanted block 
definitions with PUrge

The ABCs of Blocks

In Chapter  11, you can see how to copy objects within a drawing, or even to 
another drawing. That’s one way to use AutoCAD to improve drafting efficiency. 
You can make a copy of a DWG file and then modify it to create a similar draw-

ing, which can be an even better productivity booster as long as you’re in the 
habit of making similar drawings. But those are all baby steps compared with the 
techniques I cover in this chapter and in Chapter 18: treating parts of drawings 
as modules that can be reused and updated. AutoCAD calls these modules blocks.

This block treatment applies also to entire drawings, drawings saved in web for-
mat (Design Web Format, or DWF), Autodesk Inventor 3D models, PDFs, MicroSta-
tion DGN files, and raster images. To make drafting production more efficient 
with AutoCAD, you should know how to use blocks, xrefs, the alphabet files — 
consisting of IPTs, IAMs, PDFs, DWFs, and DGNs — and raster files.

In this chapter, I present the ABCs of blocks, including the basic creation of blocks 
and their insertion into drawings, adding attributes (data), and getting rid of 
block definitions you no longer need or want. In Chapter 18, I show you how to 
make even more of existing drawing data, including dynamic blocks, associative 
array objects, and several flavors of external reference files (including PDFs and 
MicroStation DGN files) and raster images.

Chapter 17
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Rocking with Blocks
A block is a collection of objects grouped to form a single object, like the lines that 
make up a chair. You can insert this collection more than once in the same draw-
ing, and when you do, all instances of the block remain identical — that is, the 
drawing has lots of identical chairs.

By redefining the block definition, you can automatically change all instances of 
the block’s insertion at one time. You might do this, for instance, if your boss 
decides to save money by changing all armchairs to armless chairs. Although a 
block lives in a specific drawing, you can transfer copies of it to other drawings. 
Draw the chair once in one drawing, and you can use it in any other drawing.

And you can add fill-in-the-blank text fields, or attributes, to blocks. These 
attributes might be information about the chair, such as its price, where it was 
purchased, and its current owner. You can create single-line or multiline attri-
butes; in addition to having more than one line, multiline attributes have many 
of the formatting options of multiline text, including fields. And blocks both with 
and without attributes can be defined as annotatively scaled objects to boot. See 
 Chapter 13 for a rundown on annotative objects.

To use a block in a drawing, you need two elements: a block definition and one or 
more block insertions. AutoCAD doesn’t always make clear the distinction between 
these two items, but you need to understand the difference to avoid terminal con-
fusion about blocks. Maybe this syndrome should be called blockheadedness?

A block definition lives in an invisible area of the drawing file: the block table. It’s 
one of those sets of named symbols that I describe in Chapter 9. The block table is 
a book of graphical recipes for making different kinds of blocks. Each block defini-
tion is a recipe for making one kind of block. When you insert a block, as described 
in the later section “Inserting Blocks,” AutoCAD creates a special object: a block 
insertion. The block reference points to the recipe and tells AutoCAD, “Hey, draw 
me according to the instructions in this recipe.”

Although a block may look like a collection of stored objects that is given a name, 
it’s a graphical recipe (the block definition) — plus, one or more pointers to that 
recipe (one or more block references). Every time you insert a particular block, you 
create another pointer to the same recipe.

You benefit from using blocks because you can

 » Group objects when they belong together logically. You can draw a screw, 
using lines and arcs, and then make a block definition from all these objects. 
When you insert the screw block, AutoCAD treats it as a single object for copy-
ing and moving, for example.
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 » Save time and reduce errors. Inserting a block is, of course, much quicker 
than redrawing the same geometry again. The less geometry you draw from 
scratch, the less opportunity you have to make a mistake.

 » Gain efficiency of storage when you reuse the same block repeatedly. If 
you insert the same screw block 15 times in a drawing, AutoCAD stores the 
detailed block definition only once. The 15 block references that point to the 
block definition occupy much less space than 15 copies of all the lines, poly-
lines, and arcs. No matter how large the block definition, each insertion adds 
only about 100 bytes to the drawing file size.

 » Edit all instances of a symbol in a drawing by simply modifying a single 
block definition. If you decide that the design requires a different kind of 
screw, you simply redefine the screw’s block definition. With this new recipe, 
AutoCAD then replaces all 15 screws automatically. That’s a heck of a lot faster 
than erasing and recopying 15 screws!

 » Vary the appearance of block references by using dynamic blocks. If the 
design requires a different kind of screw, you simply change the view of the 
screw to the other kind, assuming, of course, that you’ve defined the screw as 
a dynamic block. Every instance of the screw block in the drawing can show a 
different kind of screw. And that’s a heck of a lot more efficient than creating 
15 different block definitions. For the lowdown on creating, inserting, and 
manipulating dynamic blocks, see Chapter 18.

Blocks may not be best for common drawing elements used in multiple drawings, 
however, especially if several people are working on and sharing parts of draw-
ings. If you copy and paste a block from one drawing to another, it creates a new 
block definition within the target drawing and there is no connection back to the 
source drawing. A later modification to a block definition in one drawing does 
not automatically modify all other drawings using that block. If you use a block 
with the company logo in a number of drawings and there is a change in corpo-
rate ownership, you must make the change in each drawing that uses the block. 
Using external reference (xref) files can overcome this problem. I cover XREFs in 
Chapter 18.

If you need to group objects only so that you can more easily select them for copy-
ing or moving, for example, use the AutoCAD Group feature (described more fully 
in Chapter 10). Type Group and press Enter, or simply click the Group button in 
the Groups panel on the Home tab. Then select some objects and you’re done. 
When you’re editing drawings that contain groups, press Ctrl+Shift+A to toggle 
“group-ness” on or off. If you’ve toggled group-ness on, picking any object in 
a group selects all objects in the group. If you’ve toggled it off, picking an object 
selects only that object, even if it happens to be a member of a group. For more 
information, refer to Chapter 10 or visit the online Help index.
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Blocks — along with external references, DWF and PDF underlays, raster images, 
and DGN files — enable you to reuse your work and the work of others, giving 
you the potential to save tremendous amounts of time or to cause tremendous 
problems if you change a file that other people’s drawings depend on. Use these 
features when you can to save time, but do so in an organized and careful way so 
as to avoid problems.

How you use blocks and xrefs depends a lot on the profession and office in which 
you work. Some disciplines and companies use these drawing organization fea-
tures heavily and in a highly organized way, but others don’t. Ask your colleagues 
what the local customs are and follow them.

Creating Block Definitions
To create a block definition from objects in the current drawing, use the Block 
Definition dialog box. The other way to create a block definition is to insert 
another drawing file into the current drawing as a block, which I explain in the 
later section “Inserting Blocks.” The following steps show you how to create a 
block definition by using the Block Definition dialog box:

1. On the Home tab of the Ribbon, click the Create button on the Block 
panel, or type Block and press Enter.

The Block Definition dialog box appears, as shown in Figure 17-1.

Pay attention to layers when you create the objects that make up a block. As a 
rule, block geometry created on most layers retains the color, linetype, 
lineweight, transparency, and plot style properties of those layers. The 
exception to the rule is object geometry created on Layer 0 (zero). If you create 

FIGURE 17-1:  
The Block 
Definition 

dialog box.
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a block by using geometry drawn on Layer 0, the block takes on the properties 
of any layer into which you insert it.

2. Type the block definition’s name in the Name text box.

If you type the name of an existing block definition, AutoCAD warns you when 
you click OK at the end of the process. This isn’t always a bad thing because 
AutoCAD asks whether you want to replace that block definition with the new 
objects you select. This process is known as block redefinition. For example, if 
you have a drawing with a large number of block insertions such as the 
bathtubs in a 1,000-room hotel, you can use a simplified block representation 
during the design process and redefine it to a more complex definition just 
before final plot time.

To see a list of the names of all current blocks in the drawing, open the Name 
drop-down list.

3. Specify the base point (also known as the insertion point) of the block, 
using either of the following methods:

• Enter the coordinates of the insertion point in the X, Y, and Z text boxes.

• Click the Pick Point button and then specify a point on the screen. In this 
case, use an object snap or another precision technique, as described in 
Chapter 8, to grab a specific point on a block’s object.

The base point is the point on the block by which you insert it later, as I describe 
in the next section.

Use an obvious and consistent point for the base point on the group of objects, 
such as the lower-left corner or center, so that you know what to expect when 
you insert the block. If you do not define a base point, AutoCAD uses 0,0,0; 
when you later insert the block, it may appear in an unexpected location.

4. Click the Select Objects button and then select objects to become part of the 
block.

AutoCAD uses the selected objects to create a block definition and displays an 
icon showing those objects next to the block name. Figure 17-2 shows the base 
point and a group of selected objects during the process of creating a new 
block definition.

The components of a block definition 
can include other block insertions 
and so on and so on, as many levels 
deep as you need. If you try to create 
a circular reference, however, 
AutoCAD will object. For example, 
block A can contain block B, which 
can contain block C as long as block 
C doesn’t also contain block A.

FIGURE 17-2:  
Building a block.
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5. In the Objects area, select a radio button to tell AutoCAD what to do with the 
objects that are used to define the block: Retain them in place, convert them 
into a block instance, or delete them.

The default choice, Convert to Block, is usually the best. See Step 9 for a 
description of what happens with each choice.

6. Specify the insert units to which the block will be scaled in the Block Unit 
drop-down list.

When you or someone else drags the block from one drawing into another via 
the DesignCenter palette (described in Chapter 9) or Tool Palettes (described 
later in this chapter, in the “Inserting Blocks” section), the units you specify here 
and the units of the drawing you’re dragging into control the default insertion 
scale factor. The list contains 17 different units, from angstroms to parsecs, but 
doesn’t include fathoms or furlongs, unfortunately.

Three additional features in the Block Definition dialog box give you even more 
control over what happens to blocks as they’re inserted:

• If the Annotative check box is selected: The block insertion is scaled to suit 
the current drawing scale, and additional scales can be applied so that 
the insertion is scaled differently to suit other drawing scales. This feature 
would typically be applied only to symbols (such as north arrows) and not 
to insertions of blocks depicting objects such as toilets or motors. I explain 
the nuts and bolts of annotative objects in Chapter 13.

• If the Scale Uniformly check box is selected: A block is inserted with the 
same X, Y, and Z scale factors. Scale Uniformly is selected automatically if 
Annotative is selected.

• If the Allow Exploding check box is selected: A block can be exploded (as 
explained in Chapter 11) during or after its insertion in a drawing.

7. Enter a description of the block in the Description text area.

You don’t have to enter a description to create a block, but it isn’t a bad idea. 
Think like a database manager and enter a useful description that identifies 
the block to yourself and others.

8. Make sure that the Open in Block Editor check box is deselected.

You don’t need to use the Edit Block Definition dialog box unless you add 
dynamic features to the block. See Chapter 18 to find out more about dynamic 
blocks.
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9. Click OK to complete the block definition process.

AutoCAD stores the block definition in the current drawing’s block table. This 
list describes the behavior of the radio buttons you choose from in Step 5:

• If you select the Convert to Block radio button (the default) in Step 5, 
AutoCAD creates a block reference pointing to the new block definition. 
The objects look the same onscreen, but they are now an instance of the 
block rather than the original, separate objects. Most of the time, this is the 
best choice.

• If you select the Retain radio button, the objects remain in place but aren’t 
converted into a block reference. They remain individual objects with no 
connection to the new block definition. The Retain option is useful if you 
want to define another block using these objects.

• If you select the Delete radio button, the objects disappear, but the block 
definition still gets created. This option is useful when you don’t want to 
insert the block quite yet.

When you define a block, you can include a special kind of variable text object: an 
attribute definition. When you insert a block that contains one or more attribute 
definitions, AutoCAD prompts you to fill in values for the text fields. Attributes 
are useful for elements such as variable title block information (sheet number 
and sheet title, for example), electric motor nameplate information, and symbols 
that contain different codes or callouts. I describe how to create and use attribute 
definitions later in this chapter.

Store commonly used symbol drawings in one or more specific folders that you set 
aside for this purpose. You can use one of these techniques to develop a library of 
frequently used symbols:

 » Create a separate DWG file for each block. Insert these symbols by using 
the Insert command or by dragging them from Windows Explorer into the 
drawing area.

 » Store several symbols as block definitions in one master drawing. Then 
use DesignCenter to import block definitions from this drawing whenever you 
need them.

 » Use the WBLOCK (WriteBlock) command to extract a block definition 
from a drawing and then write a copy of it to disk as a new DWG file. 
Then you can insert the block definition into other drawings as required.
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Inserting Blocks
AutoCAD provides a number of ways to insert a block or a whole drawing file, but 
the most commonly used and most flexible method is using the Insert dialog box. 
To insert a block, follow these steps:

1. Set an appropriate layer current, as described in Chapter 9.

Insert each block on a layer that has something to do with the block’s geometry 
or purpose:

• If all objects in the block definition reside on one layer, you should usually 
insert the block on that layer.

• If the block geometry spans several layers, choose a suitable one to insert the 
block on. For example, a block that shows a gearbox made of geometry on 
layers named Casing, Armature, Shaft, and Fasteners might be inserted on 
a Motors layer.

If any of the block definition’s geometry was created on Layer 0 (zero), the 
geometry inherits the color, linetype, and other object properties of the layer 
on which you insert the block. It’s like chameleons changing color to match 
their surroundings or politicians changing their position to match the day’s 
opinion polls.

2. On the Home tab of the Ribbon, click the Insert button on the Block 
panel.

A slideout panel drops down, displaying a thumbnail view of all block defini-
tions in the current drawing.

3. Click the block definition you want, and then click an insertion point 
for it.

If you want to do something fancier, click the More Options button at the bottom 
of the thumbnail preview slideout panel. The Insert dialog box appears, as shown 
in Figure 17-3.

FIGURE 17-3:  
The Insert 

dialog box.
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1. Enter the block definition name (or external filename) by using one of 
these methods:

• Use the Name drop-down list to select from a list of block definitions in the 
current drawing.

The Name drop-down list supports autocomplete. As you begin to type the 
desired block name, AutoCAD searches through the drawing’s list of block 
names and finishes filling in the name for you.

• Click the Browse button to select an external DWG file and have AutoCAD 
create a block definition from it.

Browse to any existing drawing and then insert it into the current drawing 
to create a new block definition in the host drawing. Note that nothing is 
magical about the incoming drawing. Any existing drawing can be inserted 
into any other drawing. The new definition retains no connection to the 
inserted drawing.

You can use an external drawing to replace a block definition in the current 
drawing. If you click Browse and choose a file whose name matches the name 
of a block definition that’s already in the drawing, AutoCAD asks you to confirm 
the update and, if you agree, updates the block definition in the drawing with 
the current contents of the external file. In this process, block redefinition, 
AutoCAD automatically updates all block insertions that point to the block 
definition.

Earlier in the chapter, I mention the example of using a simplified representa-
tion of a bathtub during the design process and then replacing it with a 
detailed version later. Block redefinition by inserting an existing drawing is the 
fastest and easiest way to do this.

2. Enter the insertion point, scale, and rotation angle of the block.

You can either select the Specify On-Screen check box in each area to specify 
the parameters onscreen at the command prompt or type the values you want 
in the text boxes in the Insertion Point, Scale, and Rotation areas.

Select the Uniform Scale check box to constrain the X, Y, and Z scaling param-
eters to the same value (which is what you want in almost all cases).

3. If you want AutoCAD to create a copy of the individual objects in the block 
instead of a block reference pointing to the block definition, select the 
Explode check box and click OK.

4. If you selected the Specify On-Screen check box for the insertion point, 
scale, or rotation angle, specify these parameters by answering the 
prompts that appear on the command line.
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After you insert a block, all the objects displayed in the block reference behave as 
a single object. When you select any object in the block reference, AutoCAD high-
lights all the objects in it.

AutoCAD gives you three more ways to insert a block:

 » Drag and drop: Drag a DWG file from Windows Explorer and drop it any-
where in the current drawing window. AutoCAD then prompts you to choose 
an insertion point and (optionally) change the default scale factor and rotation 
angle. If you drag the drawing file to AutoCAD’s title bar, the file is instead 
opened as a new drawing.

 » The DesignCenter palette: Drag a block definition from the Blocks section of 
the DesignCenter palette and drop it into the current drawing window. Turn to 
Chapter 9 to find out how to use the DesignCenter.

You can import Inventor part (IPT) and assembly (IAM) models directly into 
AutoCAD 2013 and later. Inventor is AutoCAD’s 3D parametric and associative 
sibling, intended primarily for mechanical design. Imported Inventor files 
come across as dumb 3D solids that lose their parametrics and associativity, 
but they can be modified and edited like any other AutoCAD 3D solid. I cover 
the 2D parametrics of AutoCAD in Chapter 19, and introduce you to 3D mod-
eling in Chapters 21–23.

 » The Tool Palettes window: As is true of using the tool palette for hatching 
(as described in Chapter 15), you first must create and configure appropri-
ate tools. The easiest method is right-clicking a drawing in DesignCenter and 
choosing Create Tool Palette. A new tabbed page is added to the Tool Palettes 
window, containing all block definitions from the drawing you right-clicked. 
Simply click and drag a tool to insert its corresponding block into a drawing.

Dragging blocks from a tool palette doesn’t give you the chance to specify a 
different insertion scale, nor can you use all the precision tools in AutoCAD to 
specify the insertion point precisely, so you may need to move the block into 
place after inserting it. You should first master the other block insertion meth-
ods described in this chapter, especially using the Insert dialog box and 
DesignCenter palette. Then if you find yourself inserting the same blocks fre-
quently, consider creating a tool palette containing them. Check out the Add 
Content with DesignCenter topic in the AutoCAD online Help system for more 
information.

Although the preceding paragraph refers to the Tool Palettes window, palettes in 
AutoCAD aren’t like regular windows or dialog boxes. They’re modeless, so they can 
stay open while you carry out other tasks outside them. The official programmer-
ese term for the palette is enhanced secondary window, or ESW. I stick with palette.
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Be careful when you insert one drawing into another. If the host (or parent) draw-
ing and the inserted (or child) drawing have different definitions for layers that 
share the same name, the objects in the inserted drawing take on the layer char-
acteristics of the host drawing. For example, if you insert a drawing with lines on 
a layer named Walls that’s blue and dashed into a drawing with a layer named 
Walls that’s red and continuous, the inserted lines on the Wall layer turn red and 
continuous after they’re inserted. The same rules apply to linetypes, text styles, 
dimension styles, table styles, multileader styles, and block definitions that are 
nested inside the drawing you’re inserting. As you may recall, parents rule! Yeh, 
I wish.

To modify a block definition after you’ve inserted at least one instance of it, use 
the BEdit (Block Editor) command; choose Block Editor in the Block panel on the 
Home tab, or simply double-click a block insertion. Look up BEDIT in the online 
Help system in AutoCAD.

Attributes: Fill-in-the-Blank Blocks
You may think of attributes as the good (or bad) qualities of your significant 
other, but attributes in AutoCAD are fill-in-the-blank text fields that you can add 
to blocks. When you create a block definition and then insert it several times in 
a drawing, all the ordinary geometry elements (lines, circles, and regular text 
strings, for example) in all instances are exactly identical. Attributes provide a 
little more flexibility in the form of text strings that can be different in each block 
reference.

LOCATE USING GEOGRAPHIC DATA OPTION
Geographic data refers to locating drawing geometry with reference to specific locations 
on planet Earth (so far) defined in one of a number of recognized global coordinate 
systems. Locate Using Geographic Data is an option in the Insert dialog box in AutoCAD. 
This feature promises to be big in the civil engineering community, or possibly in large 
architectural projects, where a ground-based coordinate system is in place. If it sounds 
like an option you need, look in the online Help system and visit a local dealer or training 
center for direction.

AutoCAD 2014 added a lot more geographic data capabilities, including fun-inspired links 
to Google Maps. If you have a GPS-enabled laptop, it can display your current position 
on a site plan as you wander about.
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Suppose that you frequently designate parts in drawings by labeling them with 
distinct numbers or letters enclosed in a circle. If you want to create a block for 
this symbol, you can’t simply draw the number or letter as regular text by using 
the mText (T) or TEXT (DT) commands. When you create a block definition with a 
regular text object (for example, the letter A), the text string is the same in every 
instance of the block (always the letter A). That’s not much help in distinguishing 
the parts.

Instead, you create an attribute definition, which acts as a placeholder for a text 
string that can vary every time you insert the block. You include the attribute 
definition when you create the block definition. Refer to the “Creating Block Defi-
nitions” section, earlier in this chapter. Then every time you insert the block, 
AutoCAD prompts you to fill in an attribute value for each attribute definition.

When the block attribute value was first introduced, and for a long time afterward, 
it was limited to a single line of variable text with a maximum of 255 charac-
ters. AutoCAD 2008 and later supports multiline attributes; in addition to offering 
more than one line, multiline attributes have many of the formatting options of 
multiline text. For more information on creating and inserting blocks with multi-
line attributes, look up Define Block Attributes in the online Help system.

The AutoCAD documentation and dialog boxes often use the term attribute to refer 
indiscriminately to an attribute definition or an attribute value. I attribute a lot of 
the confusion about attributes to this sloppiness. Just remember that an attribute 
definition is the text field or placeholder in the block definition, and an attribute 
value is the specific text string you type when you insert the block.

Creating attribute definitions
You use the Attribute Definition dialog box to create attribute definitions. Clever, 
eh? The steps are similar to creating a text string except that you must supply a 
little more information. Create attribute definitions by following these steps:

1. Change to the layer on which you want to create the attribute definition.

2. To run the ATTdef command, click Define Attributes in the Block panel slide-
out on the Home tab.

The Attribute Definition dialog box appears, as shown in Figure 17-4.

You rarely need to use any of the first four Mode settings (Invisible, Constant, 
Verify, or Preset). Leave them deselected. If you’re curious about what the 
modes do, hover the mouse pointer over an item; if that doesn’t give you 
enough information, click the Help button in the dialog box to find out more.
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3. Select or deselect the Lock Position check box.

If Lock Position is selected, the attributes can’t be relocated within the block 
reference and the whole thing is treated as a single object. Deselecting Lock 
Position allows attributes to be moved by dragging their grips, without moving 
the block reference as a whole.

4. Select or deselect the Multiple Lines check box.

Selecting Multiple Lines in the Mode area disables the Default text box and 
displays a button to open the Multiline Editor. By default, you don’t see the 
whole panoply of formatting options of the mText command’s In-Place Text 
Editor, but you can overscore or underscore text; and from a right-click menu, 
you can import text, assign a background mask, or choose from a number of 
other options. Setting the value of the system variable ATTIPE (Attribute 
In-Place Editor) to 1 enables all formatting options in the In-Place Text Editor. 
See the online Help system for more information.

5. In the Attribute area, type values for the tag (the unique identifier for the 
attribute), the user prompt, and the default value.

The name you type in the Tag text box can’t contain spaces. The Prompt and 
Default text boxes may contain spaces, though.

Attribute values can include fields that update automatically, such as date, 
filename, and system variable settings.

6. (Optional) Click the Insert Field button to the right of the Default text box to 
insert a field.

See Chapter 13 for more information on fields.

FIGURE 17-4:  
The Attribute 

Definition 
dialog box.
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7. (Optional) If you select the Multiple Lines check box in Step 4, click the 
Multiline Editor button (it shows three periods) to enter the multiline default 
attribute value and add any formatting; then click OK.

The text you enter in this step is the default value stored in the attribute 
definition, and you can change it when you insert the block.

8. In the Text Settings area, specify the justification, text style, annotative 
property, text height, rotation, and boundary width (the last for multiline 
attributes only).

The text properties for attribute definitions are the same as those for text 
objects, as covered in Chapter 13.

9. Select the Specify On-Screen check box to choose an insertion point for the 
attribute definition.

An attribute definition’s insertion point is similar to a text string’s base point. 
Remember to use snap, object snap, or another precision tool if you want the 
eventual attribute values to be located at a precise point.

10. Click OK to create the attribute definition.

11. Repeat Steps 1–10 for any additional attribute definitions.

To create a series of attribute definitions in neat rows for a single block, create 
the first one by following Steps 1–9, and then select the Align Below Previous 
Attribute Definition check box for the subsequent definitions. To make a series 
of nonadjacent attributes, create the first one by using Steps 1–10, and then 
copy the first attribute definition and edit the copy by using the Properties pal-
ette. You can prevent attributes from being dragged around the block by 
selecting the Lock Position check box in the Attribute Definition dialog box.

Defining blocks that contain 
attribute definitions
After you create one or more attribute definitions and any other geometry that you 
want to include in the block, you’re ready to create a block definition that contains 
them. Follow the steps in the earlier section “Creating Block Definitions.” At Step 
4 in that section, you can select any attribute definitions before or after you select 
the other geometry. However, you should select each attribute definition one by 
one (clicking each attribute definition rather than selecting multiple attributes 
with a selection window) in the order you want the attribute value prompts to 
appear in the Edit Attributes dialog box. (See upcoming Figure 17-5.) If you don’t 
select the attributes one by one, the block and attributes still work, but the order 
of the attribute prompts in the Edit Attributes dialog box may not be what you 
want.
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You can use the Block Attribute Manager to reorder the attribute definitions in a 
block definition. Choose Attribute ➪ Block Attribute Manager in the Block panel 
slideout on the Home tab to start the BATTMAN command. Yes, Robin, there actu-
ally is such a command name. You can also use this dialog box to edit other attri-
bute definition settings such as the prompt, text style, or layer.

Inserting blocks that contain  
attribute definitions
After you create a block definition 
that contains attribute definitions, 
you insert it the same way you insert 
any other block. Follow the steps in 
the earlier section “Inserting Blocks.” 
At the end of the steps, AutoCAD dis-
plays the Edit Attributes dialog box, as 
shown in Figure 17-5. The dialog box 
contains one row for each of the attri-
bute definitions and has any default 
values filled in. You simply edit the 
values and then click OK.

The ATTDIA (ATTribute DIAlog box) 
system variable controls whether 
AutoCAD prompts for attribute val-
ues in a dialog box (ATTDIA=1) or 
at the command line (ATTDIA=0). If 
you insert a block and see command 
line prompts for each attribute value, 
type a value and press Enter for every attribute value you want to set. When you 
return to the command prompt, type ATTDIA, press Enter, type 1, and press Enter 
again. When you insert blocks with attributes into this drawing in the future, 
AutoCAD displays the Edit Attributes dialog box instead of prompting you at the 
command line.

Editing attribute values
After you insert a block that contains attributes, you can edit the individual attri-
bute values in that block reference with the EATTEDIT command. Click the Single 
drop-down button in the Block panel on the Home tab and click any object in 
the block reference. AutoCAD displays the Enhanced Attribute Editor dialog box 

FIGURE 17-5:  
The Edit Attributes dialog box.
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with the current attribute values, as 
shown in Figure 17-6. The most com-
mon attribute editing operation is to 
edit the text value, which is the text 
string that appears in the block refer-
ence. You also can change properties 
of the attributes, such as layer and 
text style.

Many people use attributes only in 
the way I describe in this chapter, as 
fill-in-the-blank text fields in blocks. 
But attributes also can work with data 
extraction tools. For example, you 
can export attribute values, such as 
part numbers and quantities, to a 
table object in AutoCAD or to a text, spreadsheet, or database file for analysis or 
reporting.

Extracting data
Selecting Extract Data from the Linking & Extraction panel on the Insert tab of the 
Ribbon starts the Data Extraction Wizard. You can find out much more about this 
specialized function in the online Help system. Check out User’s Guide ➪ Share 
Data between Files ➪ Extract Data from Drawings and Spreadsheets. And if you use 
AutoCAD LT and don’t have this wizard, you can still extract attribute information 
to space- or comma-delimited text files by using the Attribute Extraction dialog 
box. These files can be imported into spreadsheets and database programs for 
further processing. For more information, visit the online Help system.

Exploding Blocks
In a regular block definition (not a dynamic block), the objects in each block refer-
ence act like a well-honed marching squadron: If you move or otherwise edit one 
object in the block reference, all objects move or change in the same way. Usually 
this cohesion is a benefit, but occasionally you need to break up the squadron to 
modify a single object and not affect the others.

To explode a block reference into individual objects, click Explode in the Mod-
ify panel on the Home tab; or type X, press Enter, and select the block refer-
ence. When you explode a block reference, AutoCAD replaces it with all objects 

FIGURE 17-6:  
The Enhanced Attribute Editor dialog box.
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(the lines, polylines, and arcs, for example) specified in the block definition. You 
then can edit the objects individually or perhaps use them to make more block 
definitions. Only the block you select is exploded.

When you explode a block that contains attributes, the attribute values revert to 
become attribute definitions (usually not a desirable change). If you truly need 
to explode the block reference, you can erase the attribute definitions and draw 
regular text strings in their place. If you’ve installed the AutoCAD Express Tools 
(not available in AutoCAD LT), you can perform this task automatically with the 
BURST command: Type BURST and press Enter.

Both AutoCAD and AutoCAD LT have an NCOPY command that you can use to 
copy objects contained within blocks without having to explode the block. Auto-
CAD users who are familiar with the Express Tools may already be familiar with 
NCOPY; the command is now in the core of the program and therefore available to 
LT users. In both versions, you can find the Copy Nested Objects tool in the Modify 
panel slideout on the Home tab or simply type NCOPY.

Purging Unused Block Definitions
Each block definition increases the size of the DWG file, as do other named objects, 
such as layers, text styles, and dimension styles. In the case of a large, complex 
block definition, the size increase can be significant. If you delete (or explode) all 
block references that point to a particular block definition, that block definition 
no longer serves any purpose.

You should run the PUrge command periodically in each drawing to purge unused 
block definitions. Click the Application button to open the Application menu, 
choose Drawing Utilities on the left side, and then choose Purge to display the 
Purge dialog box. Click the Purge All button to purge all unused named objects in 
the current drawing.

PUrge isn’t only for blocks: You can also remove empty layers, blank text strings, 
zero-length lines, empty groups, and unused style definitions. In Figure 17-7, the 
Purge dialog box shows the unused dimension, multileader, and text styles that 
can be removed from this drawing with a click of the Purge All button.

Note the Purge Nested Items check box. Some items may not become unused until 
other items are purged. For example, a block definition can contain one or more 
other block definitions as components, and they in turn can contain other com-
ponents. If the parent contains the only use of a child or grandchild, purging the 
parent will orphan the child and so on. When Purge Nested Items is selected, 
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AutoCAD tunnels down through the 
nestings, looking for new orphans. 
These may include block definitions 
or items such as layer, text style, and 
dimension style specifications.

As I mention earlier in this chapter, 
you can insert any existing drawing 
into the current one where it becomes 
a block definition. In a common sce-
nario, you know that another drawing 
of a 1,000-room hotel contains a block 
definition of a bathtub you want to 
use in the master bathroom of a house 
drawing. No problem: Simply insert 
the hotel drawing into the house 
drawing, and then erase or delete the 
hotel drawing insertion. The drawing 
now contains a block definition for the 
bathtub. Oops! Here’s a problem. The 
house drawing file size has suddenly 
increased to government-spending 
numbers because it now contains the 
hotel drawing and all its block defini-
tions, along with elements such as layer, text style, and dimension style specifica-
tions. It’s PUrge to the rescue!

You can clean up a drawing by using the Wblock command to write an entire 
drawing to disk. It writes out only what it needs, but be careful because it also 
cleans out any unused custom layers, styles, and block definitions.

FIGURE 17-7:  
Purging the drawing of unneeded named 
objects.
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IN THIS CHAPTER

Introducing associative arrays, 
external references (xrefs), raster 
images, and dynamic blocks

Creating associative arrays with 
ARray

Attaching and managing xrefs, DWFs, 
and PDFs

Controlling xref paths

Importing other file formats

Attaching and managing raster 
image files

Authoring dynamic blocks

Everything from 
Arrays to Xrefs

Simple arrays have served AutoCAD users well for many years. They’re basi-
cally just a quick way of producing multiple copies of drawing objects in 
regular patterns. If you’re not familiar with simple arrays, flip to Chapter 11.

Associative arrays are dynamic: that is, you can edit them by changing the number 
of items, changing the definition of the objects being arrayed, or substituting a 
different object set for one or more object sets in an array.

An external reference drawing — xref — is like an industrial-strength block. An 
xref is a pointer to a separate drawing file outside the drawing you’re working on. 
When you attach a reference drawing, it appears onscreen and on plots as part 
of your drawing but continues to live as a separate document on your hard drive 

Chapter 18
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or network. If you edit the externally referenced drawing, the appearance of the 
drawing changes in all drawings that reference it. Like a block insertion (more on 
that shortly), an xref attachment increases the drawing file only slightly, regard-
less of the size of the xref file.

A raster image file stores a graphical image as a series of dots. PNG and JPG images 
seen on the Internet or from a digital camera are typical examples. Raster files 
are good for storing photographs, logos, and other images. Read more about ras-
ter images in “Mastering the Raster” later in this chapter. Comparatively, Auto-
CAD vector files are good for storing geometrical objects, such as lines and arcs, 
along with text and other annotations for describing the geometry. Sometimes 
combining raster images with AutoCAD vector files by attaching them to your 
drawing files is handy, and the External References palette makes the process 
straightforward.

Before AutoCAD 2007, external references meant AutoCAD drawing files (and only 
AutoCAD drawing files) that you attached to your current drawing. Images were 
(and still are) raster graphics files that you attached in a similar way but with a 
different command. In AutoCAD 2007 and later, you use the External References 
palette to attach and manage not only externally referenced AutoCAD drawings 
(xrefs) and 2D MicroStation DGN drawing files but also image files and DWF or 
PDF underlays. DWF stands for Design Web Format; a DWF is a lightweight version 
of a DWG file intended for design review or posting on a website. I discuss attach-
ing DWFs and PDFs as external references at the end of this chapter and describe 
the web functions of DWFs in Chapter 20.

Both AutoCAD and AutoCAD LT enable you to attach DGN files to current drawings 
via the External References palette. DGN files are drawing files created by one of 
AutoCAD’s competitors: MicroStation from Bentley Systems. You can also import 
and export DGN drawing data in both AutoCAD and AutoCAD LT. If you’re new 
to AutoCAD, you’re not likely to encounter DGN files unless you’re working for a 
large company that exchanges a lot of drawings with partners and consultants. 
For more information on DGN files in AutoCAD, enter DGN Files in the Search box 
at the top of the online help home page.

As I mention in Chapter  17, blocks, external references, DWF underlays, PDF 
underlays, raster images, and DGN files enable you to reuse your work and the 
work of others, giving you the potential to save tremendous amounts of time — or 
cause tremendous problems if you change a file on which other people’s drawings 
depend. Use these features when you can to save time, but do so in an organized 
and careful way to avoid problems.

In Chapter 17, I introduce blocks as collections of object geometry that are treated 
as single entities in AutoCAD. In that chapter, I also describe giving blocks a little 
more oomph by adding attributes, which are changeable text tags that can differ 
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with each insertion. Other than that kind of slight variation, though, the blocks 
that I describe in Chapter 17 tend to be pretty static.

Blocks, however, don’t have to be static creations. Instead of having a half dozen 
regular blocks for a half dozen different door sizes, you can create a single dynamic 
block that includes all those sizes. Unlike a regular block, in which every instance 
of a particular block is geometrically identical, each instance of a dynamic block 
can display geometric variations. For example, you can insert one furniture block 
three times and have one instance display as a sofa, one as a loveseat, and one as 
an armchair. I talk about block authoring — creating and editing dynamic blocks — 
later in this chapter.

Arraying Associatively
Things used to be so simple back around  .  .  .  oh, AutoCAD 2011. ARray was 
unequivocally a modifying command, just like COpy or ROtate. You filled in values 
in a dialog box, and after a bit of tweaking, you ended up with multiple copies 
of the source object(s), neatly arranged in geometric patterns: either in evenly 
spaced rows and columns, or evenly distributed radially about a center point. Then 
Autodesk programmers decided that old-fashioned arrays weren’t enough, so 
Autodesk took the old ARray command into the lab, wired electrodes to its brain, 
and threw the switch — and up arose the new super array!

Follow these steps to create a rectangular associative array with the ARRAYRECT 
command:

1. Start a new drawing and then create a couple of simple objects — say, a 
line passing through a circle — in the lower left of the screen.

2. Type ARRAYRECT and press Enter.

3. Select the objects (a line and the circle, if you followed my lead) that you 
drew in Step 1 and then press Enter.

4. AutoCAD displays a three-row-by-four-column preview with six blue grips.

5. Click and drag the grips to change the number of rows and columns in the 
array, change the spacing between the rows and columns, and relocate the 
array.

6. Press Enter to create the associative array.

To see what associative means, click any of the objects in the array.

Magic! The blue grips come back, and you can change the number of rows and 
columns and their spacing.
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Comparing the old and  
new ARray  commands
The results of using the ARray command in AutoCAD 2012 and later are so differ-
ent from those in previous releases that I really wish that Autodesk had given it a 
different name. I’m going to do my best to clarify the muddy waters, so here’s the 
terminology I use in this book:

 » Associative array: This is an object type created as a single object from 
separate source objects, using the current (AutoCAD 2012 and later) 
ARray command.

 » ARray: Use this command for creating associative rectangular, polar, path, 
and 3D arrays of existing objects. ARRAYRECT, ARRAYPATH, and ARRAYPOLAR 
are subsets of the ARray command.

 » Simple or non-associative array: Individual copies of source objects are cre-
ated in regular rectangular or polar patterns or by using the -ARray command. 
You can create the exact equivalent of a simple array by repeatedly using the 
COpy command.

 » -ARray: This command line version of the original ARray command has been 
present in AutoCAD for more than 20 years. This version creates only what 
AutoCAD refers to as non-associative, or simple, arrays. I cover the creation of 
this type of array in Chapters 3 and 11.

 » ARRAYCLASSIC: If you type this command, the Classic Array dialog box 
appears. It produces simple, non-associative arrays exactly like those pro-
duced by -ARray.

Some of the differences between simple arrays and associative arrays are

 » A simple array is just multiple copies. When you array objects with -ARray 
or ARRAYCLASSIC, the source objects are simply copied in rectangular or 
radial patterns. They remain as separate lines or circles or whatever the origi-
nal entity type.

An array with a large number of objects in the array and a large number of 
objects within each copy can rapidly reach government spending–sized file 
sizes. Best practice is to create a block of the objects first. I discuss blocks in 
Chapter 17. A further advantage of this practice is that if you change the block 
definition, all insertions of it in the array also update.

 » An associative array is a single object. When you create an associative 
array, the source objects are deleted from the drawing and replaced by a new 
associative array object. An array object is effectively a block. I discuss blocks 
in Chapter 17.
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 » The two array types interact differently with layers. When you create a 
simple array, the copies of the selected drawing objects are placed on the 
same layers as the source. On the other hand, an associative array follows the 
same rules as any block insertion: The new object is placed on whatever layer 
happens to be current. Source objects located on layer 0 (zero) take on the 
properties of the current layer, while source objects on other layers retain the 
properties of their layers.

 » There are two types of simple arrays but three associative types. Simple 
arrays can be rectangular (that is, in evenly spaced rows and columns) or 
polar (evenly arranged around a center point). Associative arrays have a Path 
option as well as Rectangular and Polar patterns.

 » Associative arrays can be edited. An associative array is a single object, 
and so it can be edited as such. Associative arrays (think of them as intelligent 
arrays) have far more editing options than non-associative arrays do. Okay, 
anything much above pretty well none counts as more. With an associative 
array, you can change the quantity values (rows, columns, spacing, and so 
on), you can move and suppress individual items within the array, and you 
can replace individual items with different ones. You can redefine the source 
objects, and every repetition updates. The really good news is that you can 
always put the array back like it was if you mess up too badly.

Associative array objects are recognized as such in AutoCAD 2012 and later and 
can be edited only by using the ARRAYEDIT command. If you save a drawing to 
an AutoCAD 2007 or earlier drawing file format and then open your drawing in an 
earlier AutoCAD release, the associative arrays are treated as anonymous blocks, 
and you can edit the content only by exploding the array. This turns them into 
simple arrays. If you then open a drawing again in AutoCAD 2013 or later, the 
array isn’t associative anymore. I discuss exploding in Chapter 11.

Hip, hip, array!
When associative arrays were introduced in AutoCAD 2012, many reviewers 
were startled to see that the dialog box used for simple arrays had gone away 
and seemed to be replaced by command line input, just like the good old days. 
The disadvantage to command line input is that you must follow a step-by-step 
sequence, and if you make a mistake or change your mind, you have to cancel and 
start over again. The good news is that the ARray command displays a live preview 
so you can see exactly how your array will turn out. The bad news is that AutoCAD 
2012’s interface was a little clunky, much like the old command line version. The 
good news is that it was improved in 2013.
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The following steps show you how to create multiple copies of a set of drawing 
objects, neatly arranged in a grid pattern of several rows and columns.

1. Open a drawing containing some objects you want to array, or draw 
some simple geometry for your source objects.

2. Click Rectangular Array from the Array drop-down button on the Modify 
panel of the Home tab.

Choosing the specific array type from the drop-down list saves you from 
answering one prompt you’d get if you used the ARray command.

When drop-down lists are available, the Ribbon remembers the last selection 
chosen. The Array button may show any one of three different icons. If you like 
the one that’s showing, you can simply select it instead of initiating the 
drop-down list.

3. At the Select Objects prompt, select one or more objects that you want 
to array.

When you finish selecting, AutoCAD displays a three-row-by-four-column 
preview with six blue grips (noted in Figure 18-1) and prompts:

Select grip to edit array or [ASsociative/Base point/COUnt/
Spacing/COLumns/Rows/Levels/eXit]<eXit>:

If Dynamic Input is turned on, the cursor prompt displays:

Select grip to edit or <eXit>:

The Ribbon changes to display the Array Creation contextual tab, as shown in 
Figure 18-1.

4. Enter the number of rows and columns of your source objects that you want 
to be arrayed and also their spacing.

As I mention earlier, when AutoCAD 2012 introduced associative arrays, many 
people commented on what appeared to be a regressive step away from a 
dialog box and back to command line input. The good news is that AutoCAD 
2013 gave you most of the advantages of both methods but few of the 
disadvantages and added yet another variant: the Ribbon.

5. Grip-edit your array.

As you play with the following options, observe how the dynamic preview 
constantly updates.

Each grip (see Figure 18-1) controls a different aspect of your array, as follows:

• Row 1, column 1: Base. You can move your array to a different location 
as you create it. After you select this grip, you can drag and drop it to a 
new location (object snaps work), or you can enter X and Y values at the 
dynamic cursor prompt.
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• Row 1, column 2: Column spacing. Drag this grip (or enter a value at the 
dynamic prompt) to change the spacing of all columns.

You can enter a negative value, or you can drag to the left of row 1, column 
1 to make your array grow in the opposite direction.

• Row 1, column 4: Column quantity. Drag this grip (or enter a value at the 
dynamic prompt) to change the quantity of columns.

• Column 1, row 2: Row spacing. Drag this grip (or enter a value at the 
dynamic prompt) to change the spacing of all rows.

You can enter a negative value, or you can drag below row 1, column 1 to 
make your array grow in the opposite direction.

• Column 1, row 3: Row quantity. Drag this grip (or enter a value at the 
dynamic prompt) to change the quantity of rows.

• Row 3, column 4: Row and column quantity. Drag this grip (or enter values 
at the dynamic prompt) to change the quantity of rows and columns at the 
same time.

6. Check out the other methods of specifying your array.

The AutoCAD 2013 change to the Array feature gave you three basic methods 
for defining your array, one of which is grip editing. The interesting option is 
that the command line continues to show almost all the prompts. Typically, 
command line input forces you to follow a specific sequence, but ARray now 
allows you to enter any command line option at any time.

Row spacing Row and column quantity

Row quantity

Base- move
your array

Column spacing

Column quantity

FIGURE 18-1:  
You’re ready 

to dynamically 
define your 
associative 

array.
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Earlier, I mention that the Ribbon displays the Array Creation contextual tab 
while you’re defining your array. At any time, you can enter specific values for 
anything I have discussed so far, but it also has an extra functionality: The 
Columns and Rows panels each have a Total field, referring to a total distance. 
If you enter values in either window, the column spacing or row spacing (or 
both) will be adjusted so that the number of rows or columns (or both) fit 
exactly within the specified distance.

7. Finish building your array.

If you don’t have a grip selected, the default mode is eXit. Simply press Enter or 
the spacebar, or click the Close Array button on the Ribbon, and you’re done!

The Rows panel of the Array Creation contextual tab of the Ribbon includes options 
for vertical (Z-axis) values. If you’re working in 3D, you can easily create a set of 
bleacher seats, for example, where the higher-numbered rows are at a higher 
elevation so everyone gets a good view.

Creating polar arrays
AutoCAD also offers the ARRAYPOLAR command. This has nothing to do with the 
arctic but instead is used for creating polar (circular) arrays, such as the bolt holes 
in a pipe flange, horses on a carousel, or chambers in a revolver. As I indicate ear-
lier, it may be hidden in the drop-down list under the Array button on the Modify 
tab of the Home panel of the Ribbon.

The basic principles of a polar array are the same as a rectangular one:

 » Each polar array is a single, associative object.

 » Objects within an array can be edited separately. I cover this a little later in this 
chapter.

 » As you create them, you see a dynamic preview of what the final array will 
look like.

 » You can specify your input to the command through grip edits, the command 
window, the dynamic cursor, and the Polar version of the Array Creation tab 
of the Ribbon.

But polar arrays also have a few differences:

 » When you finish selecting the objects to be arrayed, you are asked for a center 
point for the array. Note that normal object snaps can be most helpful here.

 » After you select the center point, a six-item dynamic preview with editing grips 
appears, along with the polar variant of the Array Creation tab of the Ribbon.
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 » Input specifications include

• The radius of the array.

• The number of items in the array.

• The angle to fill.

A gear sector, for example, might need only ten teeth in a 60-degree segment.

• The number of rows.

Although this seems to be strange terminology for a circular pattern, you 
can specify the number of concentric repeats of the circular pattern and 
the radial distance between them, like the growth rings of a tree.

• Whether items are rotated (for example, gear teeth) or not (Ferris wheel seats) 
as the array is produced.

• The number of levels and the Z direction spacing between them.

Down the garden path
Associative arrays have a third type that isn’t available when you use ARRAY-
CLASSIC or -ARray to produce a simple array.

Unlike rectangular and polar arrays, which require only source objects and some 
input parameters, path arrays require an additional piece of drawing geometry — 
a path. A path can be as simple as a line or a circle, or it can be a spline or a 2D or 
3D polyline. Other than that, path arrays behave very much like rectangular and 
polar arrays.

In the following steps, I show you how to use the ARRAYPATH command to bring 
chairs to an elliptical dining room table and use the table itself as the path.

1. Open a drawing containing some objects you want to array along a path 
(or draw some simple geometry for your source object) and then also 
draw a line or an open or a closed spline or polyline for your path.

2. Click Path Array from the Array drop-down button on the Modify panel of 
the Home tab.

AutoCAD prompts:

Select objects:

3. At the Select Objects prompt, select one or more objects that you want to 
array along a path.

You can select any and all AutoCAD object types, including block insertions 
and text.
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Object arraying is done based on the position of the objects relative to the 
starting end of the path object. If you want the arrayed objects to land on the 
path, they must be on the path before you select them.

When you finish selecting objects, AutoCAD prompts:

Select path curve:

4. Select the object you want to serve as the path.

Valid object types include straight lines, open or closed polylines and splines, 
arcs, circles, and ellipses, as well as helixes and 3D polylines.

You don’t have to press Enter after you select the path. AutoCAD immediately 
responds with a lengthy, multi-option prompt, displays a dynamic preview, and 
displays the path version of the Array Creation contextual Ribbon tab.

5. Enter the specifications for your array.

As with rectangular and polar arrays, you can specify the number of items, the 
distance between them, and the length of a portion of the path to fill. A bit of 
experimentation will show that these options are often interrelated; changing 
one forces another one to change. You can also specify whether the arrayed 
objects stay horizontal or rotate to stay parallel to the path.

Again, just like the other array types, you can jump back and forth between 
grip editing, Ribbon entries, the command line options, and Dynamic Input 
tooltip.

6. Finish building your array.

If you don’t have a grip selected, the default mode is eXit. Simply press Enter or 
the spacebar, or click the Close Array button on the Ribbon, and you’re done!

Put the path object on a separate layer. After you complete the array, freeze that 
layer, and the path object becomes invisible. I cover layers in Chapter 9.

Figure 18-2 shows the finished path array.

FIGURE 18-2:  
Down the gar-

den path, using 
a path array.
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Associatively editing
If you click any arrayed element (not the path of a path array), AutoCAD displays 
the Array contextual tab on the Ribbon. From here, you can revise pretty much 
every aspect of the array definition. In addition, the Options panel appears near 
the end of the Array tab.

You need a special tool for tinkering with the entrails of associative arrays, and 
AutoCAD provides it with the ARRAYEDIT command. The three items on the 
Options panel link to the three options of this command. Start with a typical sce-
nario: You just finished the drawing of the garden path when the client comes in 
and announces that the steppingstones need to be bigger.

No problem. Select any one of the steppingstones (but not the spline path curve 
itself) in the array. Now click the Edit Source button in the Options panel of the 
Array tab, and then select any one of the arrayed items. Edit it to your heart’s con-
tent, including adding and moving objects, changing layers, and deleting objects. 
When you’re finished, select Save Changes from the Edit Array panel at the end of 
the current tab of the Ribbon, and all the arrayed items update.

So far, so good, but now the client wants a square steppingstone to replace one 
of the circular ones halfway down the path (see Figure 18-3). No problem. Step 
through the following steps (pun intended):

1. Draw the new steppingstone.

The easiest way to do this is to use the RECtang command, as I discuss in 
Chapter 6.

2. Select the array you want to edit.

Select any object in the path array.

Don’t select the path itself, or you’ll be editing the path, not the array.

3. Click Replace Item on the Options panel of the Array contextual tab.

4. Select the replacement stone. Press Enter to continue.

FIGURE 18-3:  
Going down a 

different path: 
The results 

of editing an 
associative 

array.
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5. Select the base point of the replacement rectangular stone.

Select a point about in the center of the rectangle. This is the point that will end 
up sitting exactly on the path.

6. Select one or more existing circular stones to replace in the array. Press 
Enter to continue.

The objects you select in the array are replaced with the new object.

7. Press Enter or select eXit from the context menu.

Oops! You replaced the wrong steppingstone. No problem. Select the array, and 
then select Reset Array from the Options panel of the Array tab. Voilà! Your changes 
are undone. Now you can replace it with the correct one.

Earlier, I emphasize the importance of selecting an arrayed item in a path array 
and not the path. The reason for this is simple: The path can be edited separately. 
Simply select it and then edit it like the object that it is. When you’re finished, the 
path array updates to match the revised path.

And no matter how much tinkering you do, you can always revert to the original 
state by clicking Reset Array on the Options panel of the Array tab.

Going External
In AutoCAD, an xref (external reference) is a reference to an external drawing 
file — one outside the current drawing — that acts as though it’s part of your 
drawing. It’s a way to see two drawings at the same time, superimposed. Techni-
cally, a reference is a simple pointer from one file to another. The xref is the actual 
pointer, but many people call the combination of the pointer and the external file 
“the xref.” By the way, xref is pronounced exactly as it’s spelled. Just fooling; it’s 
pronounced “ex ref.”

In both AutoCAD and AutoCAD LT, external drawing files are just one of several 
file types you can attach to your current drawing via the Select Reference File dia-
log box. You use this dialog box to attach externally referenced AutoCAD drawings 
(xrefs), raster image files, DWF and DWFx files, PDF files, and MicroStation DGN 
drawing files, among others.

Click the Attach button of the Insert tab’s Reference panel to open the Select Ref-
erence File dialog box. When you attach an external drawing to your current draw-
ing, you become the host of the external file. No need to break out the cocktails 
and canapés, though, because it’s actually your current drawing that’s doing the 
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hosting — and in AutoCAD, it’s called (what else?) the host drawing. You can think 
of the attached xrefs as guests, but most of the time they’re pretty well behaved 
ones — and like the best of guests, they go away as soon as you want them to.

Xrefs have a big advantage over blocks: If a drawing is inserted as a block into 
another drawing, its geometry doesn’t change if the original drawing is changed 
in any way. It always looks the way it looks when it’s inserted. If that drawing is 
attached as an xref, however, AutoCAD will automatically update every host drawing 
to which it’s attached when the host drawing is reopened. You can also manually 
reload the changed xref if you don’t want to close and reopen the host drawing.

When you open a drawing that contains xrefs, AutoCAD displays a little symbol 
(looks like papers with a binder clip) on the right end of the status bar. This sym-
bol alerts you that some of the things you see in the drawing are actually parts of 
other, xref-ed drawings. If an xref changes while you have the host drawing open 
because you or someone else opens and saves the referenced drawing, the status 
bar xref symbol displays an External Reference Files Have Changed balloon 
notification. Simply click the Reload link in the balloon notification to show the 
updated xrefs. If you want to change how AutoCAD checks for changes, look up 
XREFNOTIFY in the online help.

Another advantage that xrefs have over blocks is that their contents aren’t stored 
in your drawing even once. The disk storage space taken up by the original draw-
ing (the xref) isn’t duplicated, no matter how many host drawings reference it. 
This characteristic makes xrefs much more efficient than blocks for larger draw-
ings that are reused several times.

Sure, you can always buy a larger hard drive, so the storage issue isn’t crucial. 
The key benefit of xrefs is that they enable you to organize your drawings so the 
changes you make to a single drawing file automatically ripple through all the 
host drawings into which it’s xref-ed. This benefit is even greater on larger proj-
ects involving multiple drafters, each of whose work may be incorporated in part 
or in whole in the work of others.

You can use xrefs to your advantage in almost any type of drawing. For example, 
several drafters might be working on the components for a large machine, while 
one master drawing brings them all together in the final assembly. Similarly, a 
set of separate architectural drawings could show electrical, plumbing, HVAC, and 
so on with everyone referencing the same floor plan. The host file would contain 
nothing but a title block and xrefs to the other files.

As a bare minimum, the border and title block of almost every drawing should be 
an xref. This saves a tremendous amount of disk space in the long run, plus should 
corporate ownership (and hence the corporate logo) change yet again, you just 
need to revise the xref master files instead of every drawing individually.
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The automatic update feature of xrefs is a big advantage only if you’re organized 
about how you use xrefs. Suppose that an architect creates a plan drawing showing 
a building’s walls and other major features that are common to the  architectural, 
structural, plumbing, and electrical plan drawings. The architect then tells the 
structural, plumbing, and electrical drafters to xref this background plan into 
their drawings so that everyone is working from a consistent and reusable set 
of common plan elements. If the architect decides to revise the wall locations 
and updates the xref-ed drawing, everyone will see the new wall configuration 
and be able to change their drawings. But if the architect absent-mindedly adds 
 architecture-specific objects (toilets and furniture, for example) to the xref-ed 
drawing or shifts all the objects with respect to 0,0, everyone else will unneces-
sarily see the furniture or all the walls shifted over. If people in your office share 
xrefs, create a protocol for who is allowed to modify which file when and what 
communication needs to take place after a shared xref is modified.

Becoming attached to your xrefs
Attaching an external reference drawing is similar to inserting a block, and almost 
as easy. Just use the following steps:

1. Set an appropriate layer current, as described in Chapter 9.

Insert xrefs on a separate layer from all other objects.

Note that if you freeze the layer on which an xref is inserted, the entire xref 
disappears. This behavior can be a handy tip, a nasty surprise, or a fun trick.

2. If the External References palette isn’t already open, click its icon (it looks 
like a sheaf of papers with a bulldog clip and a silhouetted user) on the 
Palettes panel of the View tab to open it.

Use the toolbar at the top of the palette to attach an external DWG file, a DWF 
underlay, a PDF underlay, a MicroStation DGN drawing file, a raster image file, 
or a point cloud. I cover attaching images and DWFs or PDFs later in this 
chapter. If you need to attach DGN files, visit the online help.

3. Click Attach DWG. Click the down arrow if the tooltip offers to attach some-
thing else; see Figure 18-4.

The Select Reference File dialog box appears.

4. Browse to find the file you want to attach, select it, and then click Open.

The Attach External Reference dialog box appears.
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5. Specify the param-
eters for the xref in 
the dialog box.

Parameters include 
the insertion point, 
scaling factors, 
location based on 
geographic data, and 
rotation angle. I 
describe geographic 
location briefly in 
Chapter 17. You can 
set these parameters 
in the dialog box or 
specify them 
onscreen, just like 
you can do when 
inserting a block, as 
described in 
Chapter 17.

The Path Type 
drop-down list 
provides more 
flexibility in how the 
xref path is stored. 
See the “Forging an 
xref path” section, 
later in this chapter, 
for more information.

I recommend that you choose Relative Path instead of Full Path. This makes it 
easier to move a full set of drawings to another location if all the xrefs are 
located below the host.

6. Click OK.

The externally referenced file appears in your drawing.

In drawings that contain many xrefs, locating the one you want can be difficult. 
When you select an object that’s part of an xref in the drawing area, the xref name 
is highlighted in the External References palette. Likewise, selecting an xref in the 
External References palette highlights the attached file geometry in the drawing 
editor.

Attach DWG List view

Tree view

FIGURE 18-4:  
Use the External References palette to 
attach an xref.
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You can select either the Attachment or Overlay option to tell AutoCAD how to 
handle the xref. The choice matters only if you create a drawing that uses xrefs, 
and then your drawing is, in turn, used as an xref. Attachment is the default choice, 
and it dictates that the xref-ed file will always be included with your drawing 
when someone else uses your drawing as an xref. Overlay, the other choice, means 
that you see the xref-ed drawing, but someone who xrefs your drawing won’t see 
the overlaid file. By choosing Overlay, you can xref a map, for example, to your 
drawing of a house, but the map won’t show up when someone else xrefs your 
house drawing. That person can xref the map, if needed. I recommend that you 
use the default Attachment reference type unless you have a specific reason not to.

One use of Overlay mode is to avoid circular references. If drawing A references 
drawing B, which references drawing C, and then C references A, you have an 
infinite loop. If C references A as an overlay, though, C doesn’t see B, and so the 
loop is broken.

Starting with AutoCAD 2014, you can switch the attachment type for an xref 
between Attach and Overlay by double-clicking in the Type column. Better yet, 
a right-click menu option lets you change the xref type for several selected xrefs 
all at once.

Layer-palooza
When you attach or overlay an xref, AutoCAD adds new layers to your current 
drawing that correspond to the layers in the xref-ed DWG file. The new layers 
are assigned names that combine the drawing name and layer name. For exam-
ple, if you xref the drawing MYSCREW.DWG (which has the layer names GEOM-
ETRY, TEXT, and so on), the xref-ed layers will be named MYSCREW|GEOMETRY, 
MYSCREW|TEXT, and so on. By creating separate layers corresponding to each 
layer in the xref-ed file, AutoCAD eliminates the potential problem with blocks 
that I warn you about in Chapter 17, when layers have the same name but different 
color or linetype in the two drawings.

A host drawing with many xrefs can end up with some pretty cluttered dialog 
boxes and palettes. Starting with AutoCAD 2014, xref linetypes are not displayed 
in the linetype list of the Properties palette or of the Ribbon, but the Ribbon still 
displays xref layers, so you can control their visibility.

Creating and editing an  
external  reference file
To create a file that you can use as an external reference, just create a drawing 
and save it. That’s it. You can then create or open another drawing and create 
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an external reference to the previous one. The xref-ed drawing appears in the 
host drawing as a single object, very much like a block insertion. In other words, if 
you click any object in the xref, AutoCAD selects the entire xref. You can measure 
or object snap to the xref-ed geometry, but you can’t modify or delete individual 
objects in the xref. You need to open the xref drawing itself to edit its geometry.

The XOPEN command provides a quick way to open an xref-ed drawing for edit-
ing. You just start the command and pick any object in the xref. Alternatively, you 
can select the xref from the External References palette and then right-click and 
choose Open to open one or more xrefs for editing. See the “Managing xrefs” sec-
tion, later in this chapter, for more information.

An alternative to opening the xref-ed file when you need to edit it is to use the 
REFEDIT command. Use REFEDIT (short for Reference Edit) to edit the external 
file from within the host drawing, rather than having to open the reference in its 
own window. Look up REFEDIT in the AutoCAD online help system’s Command 
Reference.

With several xrefs attached to your drawing, or with a very complex xref, it can 
be difficult to tell which objects belong to the drawing you’re editing and which 
are part of the xref. You can fade your xrefs so you can tell them apart from your 
drawing’s objects as follows:

1. Open a drawing containing an external reference drawing.

Alternatively, you can attach a drawing to your current drawing by following the 
steps in the “Becoming attached to your xrefs” section, earlier in this chapter.

2. On the Insert tab, click the Reference panel label to open the Reference 
slideout.

The Reference slideout also contains the Edit Reference button, which runs the 
REFEDIT command.

3. Click the Xref Fading button to toggle reference fading off and on.

4. Drag the Xref Fading slider to increase or decrease the level of fading in the 
reference file.

The default value is 70; increasing the value toward 90 (the maximum) 
increases the degree of fading, and lowering it reduces the fade level.

Forging an xref path
When you attach an xref, one option is to have the host drawing store the xref’s 
full path — that is, the drive letter and sequence of folders and subfolders all the 
way down to the folder in which the DWG file resides — along with the filename. 
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This behavior corresponds to the Full Path setting in the Path Type drop-down 
list. Figure 18-5 shows the three xref path options. Full Path works fine as long as 
you never move files on your hard drive or network and never send your DWG files 
to anyone else — which is to say, it almost never works fine!

At the other end of the path spectrum, the No Path option causes AutoCAD to 
not store any path with the xref attachment: Only the filename is stored. This 
is the easiest and best option if the host drawings and the xrefs reside in the 
same folder. However, if the host and the xref are in different folders, you have to 
browse to find the reference file every time you open the host drawing.

If you prefer to organize the DWG files for a particular project in more than one 
folder, you’ll appreciate AutoCAD’s Relative Path option, as shown in Figure 18-5. 
This option permits xref-ing across more complex folder structures but avoids 
many of the problems that the Full Path option can cause. For example, you may 
have a host drawing

H:\Project-X\Plans\First floor.dwg

that xrefs

H:\Project-X\Common\Column grid.dwg

If you choose Relative Path, AutoCAD will store the xref path as

..\Common\Column grid.dwg

instead of

H:\Project-X\Common\Column grid.dwg

FIGURE 18-5:  
Follow the path 

less traveled 
when you 

attach an xref.
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This way, if you decide to move the \Project-X folder and its subfolders to a dif-
ferent drive (or send them to someone else who doesn’t have an H: drive), Auto-
CAD can still find the xrefs.

When attaching an external reference, I strongly recommend you check the Path 
Type section and make sure it says Relative Path. If not, select Relative Path from 
the drop-down list from this section.

When you use Relative Path, you’ll see xref paths that include these special codes:

 » Single period (.): This indicates this host drawing’s folder.

 » Double period (..): This indicates the folder above this host drawing’s folder.

You can report on and change xref paths for a set of drawings with the Reference 
Manager (not in AutoCAD LT). See Chapter 20 for more information.

If all these path options and periods leave you feeling punchy, you can keep your 
life simple by always keeping host and xref drawings in the same folder and using 
the No Path option when you attach xrefs. On the other hand, it can get a little 
messy when a file such as a standard title block and border is xref-ed into many 
different drawings for several different projects and you want to keep each proj-
ect’s files in separate folders. The best solution is usually a bit of each; the title 
block and border can have a specific path in each host, but the other project files 
don’t.

Managing xrefs
The External References palette includes many more options for managing xrefs 
after you attach them. Many of these options are hiding in right-click menus. 
Important options include

 » List of external references: You can change between the List view and Tree 
view of your drawing’s external references by clicking the appropriate button 
at the top of the palette (refer to Figure 18-4). You can resize the columns by 
dragging the column dividers or re-sort the list by clicking the column header 
names, just like in Windows or File Explorer.

 » Unload: Right-click an xref and choose Unload to make the selected xref dis-
appear from the onscreen display of your drawing and from any plots you do 
of it but still retain the pointer and attachment information. Right-click again 
and choose Reload to redisplay an unloaded xref.

 » Reload: Right-click an xref and choose Reload to force AutoCAD to reread 
the selected xref-ed DWG file from the disk and update your drawing with its 
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latest contents. This feature is handy when you share xrefs on a network, and 
someone has just made changes to a drawing that you’ve xref-ed.

 » Detach: Right-click an xref in the External References palette and choose 
Detach to completely remove the selected reference to the external file from 
your drawing.

 » Bind: Right-click an xref and choose Bind to bring the selected xref into your 
drawing and turn it into a block definition. The link to the xref will be broken. 
You might use this function, for example, to roll up a complex set of xrefs into 
a single archive drawing, or to send to a client without having to worry about 
the path structure.

If you Bind an xref, any changes made to the xref drawing will no longer 
reflect through to the host.

In many offices, binding xrefs without an acceptable reason for doing so is a 
crime as heinous as exploding blocks indiscriminately. In both cases, you’re 
eliminating an important data management link. Find out what the policies 
are in your company. When in doubt, keep yourself out of a bind. And even 
when you do have a good reason to bind, you generally should do it on a copy 
of the host drawing.

 » Path: Right-click an xref in the External References palette and choose Path to 
bring up a submenu to switch to no path (Remove), Relative, or Absolute.

 » Open: Right-click an xref and choose Open to open one or more xref drawings 
in separate drawing windows. After you edit and save an xref drawing, return 
to the host drawing and use the Reload option in the External References 
palette to show the changes.

None of these options (other than opening and editing the xref) affects the xref-
ed drawing itself; it continues to exist as a separate DWG file. If you need to delete 
or move the DWG file that the xref refers to, do it in Windows or File Explorer.

The fact that the xref-ed drawing is a separate file is a potential source of prob-
lems when you send your drawing to someone else; that someone else needs all 
the files that your drawing depends on, or it will be useless. Make sure to include 
xref-ed files in the package with your drawing. See Chapter 20 to find out how the 
ETRANSMIT command helps.

Both AutoCAD and AutoCAD LT include an additional xref feature called xref clip-
ping. You can clip any kind of externally referenced file or block insertion so that 
only part of it appears in the host drawing. Use the CLIP command to trim away 
unwanted parts of xref drawings, DWF and DWFx files, raster images, MicroSta-
tion DGN files, or PDFs. You can even use CLIP on block insertions. For more 
information, look up CLIP in the online help’s Command Reference section.
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Blocks, Xrefs, and Drawing Organization
Blocks and xrefs are useful for organizing sets of drawings to use and update 
repeated elements. When to use blocks and when to use xrefs isn’t always clear, 
though. Applications for xrefs include

 » The parts of a title block that are the same on all sheets in a project

 » Reference elements that must appear in multiple drawings (for example, wall 
outlines, site topography, and column grids)

 » The individual component parts going into a final assembly drawing for a 
machine or mechanism

 » Assemblies that are repeated in one or more drawings, especially if the 
assemblies are likely to change together (for example, a motor, coupling, 
speed reducer, and base plate assembly in large machines)

 » Pasting up several drawings (for example, details or a couple of plans) onto 
one plot sheet

 » Temporarily attaching a background drawing for reference or tracing

On the other hand, blocks remain useful in simpler circumstances. Situations in 
which you might stick with a block are

 » Components that aren’t likely to change

 » Simple components

 » An assembly that’s used repeatedly but in only one drawing

 » When you want to include attributes (variable text fields) that you can fill in 
each time you insert a block

Blocks let you include attribute definitions; xrefs don’t. Okay, technically you 
can have attributes in xrefs, but they won’t display in the host drawing. Refer 
to Chapter 17 for the lowdown on attributes.

Everyone in a company or workgroup should aim for consistency as to when and 
how they use blocks and xrefs. Check whether guidelines exist for using blocks 
and xrefs in your office. If so, follow them; if not, it would be a good idea to 
develop some guidelines.
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Mastering the Raster
AutoCAD includes four more xref-like features: the ability to attach raster images, 
DWF files, PDF files, and DGN files to drawings. I cover DWF and PDF files in the 
next section and refer you to the online help if you should find some DGN files 
on your hands. The image feature is useful for adding a raster logo to a drawing 
title block or placing a photographed map or scene behind a drawing. A raster, or 
bitmapped, image is one that’s stored as a field of tiny dots.

Raster images often come from digital cameras or from other programs, such as 
Photoshop. Raster images can also come into the computer from scanners that 
read a blueline print, photograph, or other image.

AutoCAD drawings are vector files. A vector drawing is a graphic file defined by 
storing geometrical definitions of a bunch of objects. Typical objects include a line 
(defined by its two endpoints) and a circle (defined by its center point and radius). 
Vector-based images are typically smaller (in terms of the disk space they occupy) 
and more flexible than raster images but also are less capable of displaying visu-
ally rich images, such as photographs.

Whether you’re doing your own scanning or having a service bureau do it for you, 
you need to know that AutoCAD handles most popular image file formats, includ-
ing the Windows BMP format; the popular web graphics formats GIF, JPEG, and 
PNG; common print formats, such as PCX and TIFF; the less popular DIB, FLC, 
FLI, GP4, MIL, RLE, RST, TGA formats, and several even more obscure ones.

Three scenarios in which you could incorporate raster images in your drawing 
include

 » Small stuff: You can add logos, special symbols, and other small images that 
you have in raster files.

 » Photographs and maps: You can add photographs (such as the building site) 
and maps (for example, showing the project location).

 » Vectorization: To convert a raster image into a vector drawing by tracing lines 
in the raster image, you can attach the raster image in your drawing, trace the 
needed lines by using AutoCAD commands, and then detach the raster image. 
This procedure is okay for a simple raster image; add-on software is available, 
from Autodesk and others, to support automatic or semiautomatic vector-
ization of more complex images. In the long run, however, it is often easier, 
faster, and more accurate to simply redraw the image in AutoCAD.
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Your raster image may be distorted a bit; for example, the aspect ratio (ratio of 
width to height) may not be correct, but AutoCAD won’t let you change it. No 
problem; simply attach the raster image, make a block that contains it, and then 
insert the block with different X and Y scale factors. I love cheating.

Using raster images is much like using external references. The raster image isn’t 
stored with your drawing file, though. Instead, a reference to the raster image file 
is established from within your drawing, like an xref. You can clip the image and 
control its size, brightness, contrast, fade, and transparency. These controls fine-
tune the appearance of the raster image onscreen and on a plot.

When you attach raster images, you have to make sure that you send the raster 
files along when you send your drawing to someone else. Raster images are sim-
ply referenced from the drawing and aren’t part of it. If you don’t send the raster 
image file along with the drawing, the drawing displays a rectangle containing 
the name of the missing file in its place. The best way to make sure that you get 
all the required files when sending a drawing file to someone else is to use the 
ETRANSMIT command, which I cover in Chapter 20.

Some raster image files that you find on the Internet may not be appropriate as 
AutoCAD attachments.

Attaching a raster image
Follow these steps to bring a raster image into AutoCAD:

1. If the External References palette isn’t already open, click its icon on the 
Palettes panel of the View tab.

Use the drop-down list on the first toolbar button to attach a drawing; an 
image; or a DWF, PDF, or DGN file.

2. Click Attach Image and locate the image file you want to attach.

The Attach Image dialog box appears, as shown in Figure 18-6.

3. Browse to find the file you want to attach, select it, and then click Open.

The Attach Image dialog box appears.

Click the Show Details button in the Attach Image dialog box to see more 
information about the resolution and image size of the image you’re attaching.

4. Specify the parameters for the attached image in the dialog box.

Parameters include the insertion point, scale factor, and rotation angle. You 
can set these parameters in the dialog box or specify them onscreen, similar to 
what you can do with blocks and external references, as described earlier in 
this chapter.



364     PART 4  Advancing with AutoCAD

The Attach Image dialog box includes the same Full Path, Relative Path, and No 
Path options as those for attaching xrefs. See the “Forging an xref path” 
section, earlier in this chapter.

5. Click OK.

The image appears in your drawing.

6. If you need to ensure that the raster image floats behind other objects in the 
drawing, select the raster image, right-click, choose Draw Order, and then 
choose Send to Back.

The DRaworder command provides additional options for which objects 
appear on top of which other objects. If you need this kind of flexibility, look up 
the DRaworder command in the AutoCAD online help system.

Maintaining your image
You manage the images in your drawing via the External References palette. You 
can view a list of image files that appear in the current drawing, detach (remove) 
image references, and unload and reload images when needed. You can’t bind an 
image to your drawing, though; it always remains an external file.

You can clip images so that only part of the image is displayed in your drawing. 
Choose Clip from the Insert tab’s Reference panel and follow the prompts to clip 
the image. You can have multiple overlapping or distinct pieces of any number 
of images in your drawing, and only the parts you need are loaded into memory 
when you have your drawing open.

Raster image files often are larger than DWG files of corresponding complexity; 
raster file size can affect performance within AutoCAD because the entire raster 
file loads into memory when you’re working on your drawing. If you find raster 
attachments slowing down AutoCAD’s response, then follow these tips:

FIGURE 18-6:  
The Attach 

Image dialog 
box.
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 » Attach raster images late in the production process.

 » Create a lower-resolution version of the raster file, just large enough to create 
the desired effect in your drawing.

 » Right-click an image in the External References palette and choose Unload 
from the context menu to temporarily hide an image without losing the 
attachment information.

In addition, raster files can also dramatically increase the time that AutoCAD takes 
to generate plots (and the plot file sizes). Before you settle on using large raster 
files in your AutoCAD drawing, do some testing on zooming, editing, and plotting.

Starting in AutoCAD 2014, you can insert a link to a mapping service, such as 
Google Earth, to act as an underlay in your drawing.

You Say PDF, I Say DWF
The Adobe PDF (Portable Document Format) format has been around for a very 
long time, and for a while it seemed like Autodesk was trying to supplant it with 
its own universal file format: DWF (Design Web Format). That didn’t happen, but 
if you can’t beat ’em. . . . AutoCAD includes a very acceptable PDF printer driver, 
and both PDF and DWF are suitable candidates for external reference attachments.

You could think of a DWF as DWG Lite because it looks just like a drawing file 
and contains some of the actual drawing file data. I talk more about the web 
side of DWFs in Chapter 20; in this section, I explain how you can use DWFs as 
well as PDFs as reference files in your own drawings. Some people call DWF files 
“dwiffs,” but I’m going to hold off on that one until I start hearing DWG files 
called “dwiggs.” And why is phonetic spelled that way?

You create both DWFs and PDFs from within AutoCAD in one of two ways. Either 
choose Plot and then select a DWF or PDF option in the Printer/Plotter name list, 
or choose Print ➪ Batch Plot from the Application menu and then choose DWF, 
DWFx, or PDF from the Publish To area of the Publish dialog box.

Both file types are compact and secure. Because you can’t edit either PDFs or 
DWFs in AutoCAD, both formats are ideal for two purposes:

 » You can post DWFs or PDFs on the web.

 » You can send your drawings to consultants and clients in a form that they 
can’t mess up.
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Oops, AutoCAD 2017 changed part of the foregoing a bit. It is now possible to 
edit a PDF file in AutoCAD, but there are quite a few limitations, as I describe in 
Chapter 24.

You can attach PDFs or DWFs to your drawing files in pretty much the same way 
you attach drawings as external references. DWFs and PDFs attached to drawing 
files are referred to as DWF underlays or PDF underlays.

As with DWF and DGN attachments, you can object-snap to entities in the PDF 
underlay by enabling the Snap to Underlays function in the Reference panel slide-
out on the Insert tab. Setting PDF parameters is virtually identical to setting DWF 
parameters, and you can attach a PDF to your drawing by using exactly the same 
steps as the ones that follow.

The previous sections show how to attach a DWG and a raster image. Follow these 
steps to attach a DWF or PDF file as an underlay:

1. If the External References palette isn’t already open, click its icon on the 
Palettes panel of the View tab to open it.

Use the toolbar at the top of the palette to attach an external file as an xref, 
a raster image file, or a DGN or DWF underlay. I cover attaching xrefs and 
images earlier in this chapter. See the online help for information on attaching 
DGN files.

2. Click Attach DWF or Attach PDF and then locate the file you want to attach.

The Select Reference File dialog box appears.

3. Browse to find the file you want to attach, select it, and then click Open.

The Attach DWF Underlay or the Attach PDF Underlay dialog box appears.

4. Specify the parameters for the DWF or the PDF in the dialog box.

Parameters include specifying a sheet, the insertion point, scaling factors, 
rotation angle, and path type, as shown in Figure 18-7. You can set these 
parameters in the dialog box or specify them onscreen, just like you can do 
when inserting a block, attaching an xref, or attaching an image, as described 
earlier in this chapter.

5. Click OK.

The externally referenced DWF or PDF file appears in your drawing.

Neither PDF nor DWF files are as precise as DWGs, and that’s why their file size 
is a lot smaller. When using object snaps to locate points in DWFs, you may see 
the word approximate on the Object Snap tooltip. If this is a problem, you can 
increase the precision of your DWF file when you create it.
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AutoCAD allows you to import about 20 different file formats into an AutoCAD 
drawing. Most of these are 3D modeling formats. They are imported into model 
space (not attached or xref-ed), and are used as the basis for additional 3D model-
ing and editing and for generating 2D working drawings from them. I discuss 3D 
to 2D in Chapter 23.

Theme and Variations: Dynamic Blocks
You can add variety to your blocks by making them dynamic. The two most useful 
applications for dynamic blocks are multiple presentations of similar objects and 
manipulation of components within individual block inserts.

AutoCAD’s dynamic blocks feature offers you a great deal of flexibility in block 
creation and insertion, but using them is also a very complicated system with 
its own set of commands and system variables. I recommend that you become 
very familiar with regular block creation and insertion techniques for creating and 
inserting blocks (which I describe in Chapter 17) before you tackle dynamic blocks.

Spend some time planning your dynamic blocks. Sketch out the geometry for each 
variation in appearance (visibility state) and decide where the common base point 
should be. Unless you’re a lot smarter than I am, you’ll probably find that creating 
dynamic blocks is complex enough without trying to design your blocks as you go.

Now you see it
If your drawing shows three different kinds of seats, one approach is to cre-
ate three different standard blocks to represent them all. Alternatively, you 
can create a single dynamic block and define visibility states to cover all three 

FIGURE 18-7:  
The Attach 

PDF Underlay 
dialog box.



368     PART 4  Advancing with AutoCAD

different types. The following steps show you how to make your blocks do double  
(or triple?) duty by using the Edit Block Definition dialog box:

1. Open a drawing that contains some block definitions you’d like to 
combine, or draw some simple geometry to make some similar types 
of objects.

You can find the files I use in this sequence of steps at this book’s companion 
website. Go to www.dummies.com/go/autocadfd17 and download afd18.
zip. The drawing named afd18b.dwg contains the three-piece furniture suite 
(see Figure 18-8) I use to create a dynamic block.

You can create dynamic blocks from scratch, or you can work with existing 
standard (nondynamic) block definitions. Figure 18-8 shows a drawing with 
three nondynamic blocks.

2. On the Block panel of the Home tab, choose Block Editor to open the Edit 
Block Definition dialog box.

3. In the Block to Create or Edit box, specify a new block name or select Current 
Drawing; then click OK to display the Block Editor window.

The Block Editor is a special authoring environment with its own Ribbon tab 
plus a passel of command-line commands. You also have access to the rest of 
the Ribbon tabs, so you can draw and edit just like you would in the regular 
drawing window. The background color is different from the drawing editor’s 
background color to help you remember where you are.

FIGURE 18-8:  
Three blocks 

to make three 
seats.

http://www.dummies.com/go/autocadfd17


CHAPTER 18  Everything from Arrays to Xrefs     369

The Block Editor tab’s Geometric, Dimensional, and Manage panels (see 
Figure 18-9) are elements of the AutoCAD parametric drawing feature. 
AutoCAD LT doesn’t fully support parametric drawing, so the LT Block Editor 
lacks the Geometric and Dimensional panels and gets a miniversion of the 
Manage panel. In this book, I don’t have room to cover parametric constraints 
in dynamic blocks, but I do cover parametric drafting in Chapter 19. The 
concepts are pretty similar to adding parametric features to dynamic blocks.

If you enter a new block name, AutoCAD displays an empty block-authoring 
environment where you draw geometry or insert existing blocks. If instead you 
select Current Drawing, AutoCAD places all drawing objects inside the block-
authoring environment.

4. Create some geometry for the first visibility state. Alternatively, click the 
Home tab, choose Insert on the Block panel, and select an existing block 
definition to serve as the first visibility state.

When creating geometry from scratch, pay attention to where the common 
base point should be. Although you use different blocks to assemble a 
multiple-view block, they should all have the same base point. 0,0 or the exact 
center are good ones for blocks. You don’t want your chairs jumping around 
between different insertion points!

5. If you inserted an existing block in Step 4, deselect all three Specify 
On-Screen check boxes, make sure that the Explode check box is not 
selected, and then click OK.

6. Repeat Steps 4 and 5, drawing or inserting all the necessary geometry.

At this point, your drawing screen may look pretty strange (see Figure 18-9). 
Don’t worry; you’re going to fix it in the next steps.

7. Click the Parameters tab of the Block Authoring Palettes and then click 
Visibility, as shown in Figure 18-9.

If the palettes aren’t open, click Authoring Palettes on the Manage panel on the 
highlighted Block Editor contextual tab of the Ribbon.

AutoCAD prompts you to specify the parameter location.

8. Click to place the parameter marker somewhere other than the base point 
location you chose in Step 4.

AutoCAD places a parameter marker at the selected point and returns to the 
command line. As shown in Figure 18-9, the label Visibility1 appears next 
to the Visibility Parameter marker, and a yellow Alert symbol indicates that no 
action has been assigned to the parameter yet. The controls on the Ribbon’s 
Visibility panel become active.
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The parameter location that you specify will be the spot on the block where the 
dynamic block option grip will be displayed. It’s not crucial where you locate 
this point, but try to pick a sensible location on the object. If you specify the 
same point for the parameter location as the base point for the block, you may 
have a hard time selecting the dynamic option grip.

9. Click Visibility States on the Visibility panel. Click Rename and change 
VisibilityState0 to something more descriptive. Then click OK.

As is the case with other named objects in AutoCAD, best practice is to assign 
useful, descriptive names rather than accept the default generic labels.

10. On the Visibility panel, click the Make Invisible button. At the Select 
Objects prompt, select the geometry or block inserts that should be invisible 
in the current visibility state — that is, those that are not associated with the 
current visibility state — and then press Enter.

AutoCAD prompts:

Hide for current state or all visibility states  
[Current/All] <Current>: C

11. Click Visibility States again and then click New to create a new visibility state.

Visibility Status controls

Block
Editor
panels

Visibility Parameter markerBlock Authoring palettes

FIGURE 18-9:  
Three seats 
in the Block 

Editor.
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12. In the New Visibility State dialog box, enter a descriptive name. Also select 
the Show All Existing Objects in New State option and then click OK.

All your geometry should reappear.

13. Repeat Steps 9 and 10 to create additional visibility states associated with 
the remaining geometry or blocks.

The geometry or block insert associated with the last created visibility state 
should be visible onscreen.

14. Click OK to close the Visibility States dialog box and then click Close Block 
Editor on the Ribbon. Save the changes to your new block or to Current 
Drawing.

AutoCAD displays an alert box asking whether you want to save changes to 
your block. Your choices are

• Cancel: Click Cancel to return to the Block Editor without saving your 
changes.

• Discard changes: Clicking Discard the Changes closes the Block Editor  
without saving your changes.

• Save: Click Save the Changes to update the block and exit.

AutoCAD closes the block-authoring environment and returns to the standard 
drawing editor window.

The Block Editor tab includes a Test Block tool you can use to see what your 
 finished product will look like without the hassle of closing the editor and insert-
ing or manipulating the block inside the drawing editor. Test Block displays the 
geometry and lets you try different parameters; then you can easily return to 
the Block Editor to tweak your masterpiece. You’ll find the Test Block button on 
the Open/Save panel of the Block Editor contextual tab.

Lights! Parameters! Actions!
You can modify the appearance of individual instances of the same block by defin-
ing parameters and actions to move, rotate, flip, or align parts of them. You can 
adjust the block’s appearance while you insert it or at any time afterward. The 
following steps show you how to use the Block Editor to add some action to a block 
definition:

1. Open a drawing that contains some block definitions whose appearance 
you’d like to spice up a little, or draw some simple geometry that might 
make a suitably dynamic block.
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Action parameters are most effective in block definitions that contain groups 
of related objects: for example, an office desk and chair or a furniture 
 arrangement.

2. On the Block panel of the Ribbon’s Home tab, choose Block Editor to open 
the Edit Block Definition dialog box.

3. In the Block to Create or Edit text box, type a new block name or select 
Current Drawing. Then click OK.

4. Create some geometry or insert some blocks.

When you insert blocks, make sure that the Explode check box at the lower-left 
corner of the Insert dialog box is not selected. Then click OK.

Draw the geometry or insert the blocks in a group so that you can insert the 
finished arrangement into your drawings. For example, the upcoming 
Figure 18-10 shows the creation of a dynamic block for one cell of a telephone 
boiler-room call center.

5. Repeat Step 4 until you’ve drawn all the needed geometry or inserted all the 
necessary blocks.

6. Click the Parameters tab of the Block Authoring Palettes and then click 
Rotation Parameter.

AutoCAD prompts you to specify the parameter location.

7. Click to place the parameter marker somewhere on the object geometry 
other than the base-point location.

If you specify the same point for the parameter location as the base point for 
the block, you may have a hard time selecting the dynamic option grip.

8. AutoCAD places a parameter marker at the selected point and returns to the 
command line, prompting you to specify the radius of the rotation param-
eter and the default rotation angle.

The parameter marker’s label appears next to the rotation parameter marker.

9. Click the Actions tab of the Block Authoring Palettes and then click Rotate. 
Select Rotate Parameter, select the objects that should be modified when 
the grip is used, and specify a point for the action’s label.

AutoCAD returns to the command line. At this point, it’s fine to go with default 
values and onscreen pick points.

10. Repeat Steps 6–9, trying different parameters and actions.

For example, choose a Point Parameter and a Move Action.
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Figure 18-10 shows a set of block components, several of which have action 
parameters assigned. After the block is inserted, you can manipulate the 
components to which you’ve added parameters to vary the appearance of the 
blocks. I explain how in the next section.

11. Click Close Block Editor on the Ribbon and save or discard your changes.

AutoCAD closes the block-authoring environment and returns to the standard 
drawing editor window.

Manipulating dynamic blocks
After a dynamic block is inserted in a drawing, you can select it and modify its 
display through a special set of custom grips. That’s what AutoCAD calls them, so 
I’m following suit.

When you select a nondynamic block, you see a single grip at the insertion point. 
When you select a dynamic block, you see at least two (and maybe more) custom 
grips, as well as the insertion point grip. The custom grips usually look different 
from the regular object grips, but not always, so be careful while clicking grips.

The following steps show you how to make your dynamic blocks do the things you 
just spent all this time teaching them to do:

1. Insert a few blocks that contain some dynamic parameters, such as vis-
ibility or action parameters.

If your block inserts don’t have any action parameters, go to Step 4.

Rotation Parameter 
marker

Point Parameter 
marker

FIGURE 18-10:  
A passel of 

 parameters 
ready  

for action.
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2. Select a block that includes some action parameters.

The block insert displays a number of grips (see Figure 18-11). If the insert 
displays only a single square grip, it isn’t a dynamic block.

3. Click one of the custom grips.

For example, clicking a round grip opens the rotation parameter of the object. 
Then you rotate the component as required.

4. Select a block that includes a visibility parameter and then click the visibility 
grip. Choose the desired visibility state from the menu that appears.

For additional information on manipulating actions and visibility states, look up 
Dynamic Blocks in the online help system.

Dynamic blocks, as I suggest more than once, are a powerful — and complicated — 
feature. Prior to AutoCAD 2010, the Block Authoring Palettes contained 10 selectable 
parameters, 8 actions, and 20 parameter sets. AutoCAD 2010 added 12 geometric 
constraints and 6 dimensional constraints. I could write a book on the topic. Until 
I do, AutoCAD’s online help system is your best resource for more information on 
all the possibilities of dynamic blocks. The quickest and most direct way to Auto-
CAD’s own help on the subject is to type Dynamic Blocks into the Search box on the 
program title bar.

FIGURE 18-11:  
Variations on 

dynamic blocks 
(original on the 

right, and a 
handy grip tip 

on a chair at 
left center).
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IN THIS CHAPTER

Introducing parametric drawing

Understanding constraints

Applying geometric and dimensional 
constraints

Editing parametric drawings

Call the Parametrics!

Afew releases back, AutoCAD added a set of parametric drawing tools, and, 
offhand, I can’t think of a more significant new feature in recent years. 
In fact, if you work primarily in 2D, and especially if you’re in the man-

ufacturing business, parametrics in AutoCAD (and, to a very limited degree, in 
AutoCAD LT) might just be the most significant new feature ever since the begin-
ning of orthographic engineering drawings, generally attributed to the Roman 
architect Marcus Vitruvius in the 1st century BC. Contrary to popular opinion, I am 
not so old that I knew him personally.

Parametric tools allow you to create relationships between geometry in a draw-
ing. These relationships help to constrain and restrict changes to a design. If you 
know what I’m talking about, you’re probably pretty interested in finding out 
more about what you can do with parametrics in AutoCAD. If, on the other hand, 
you think parametrics are the folks who show up when you dial 911, the following 
paragraphs should straighten you out.

Imagine this scenario: Your boss has been in a meeting all morning with an 
important client. At two minutes before noon, they emerge. Your boss hands you 
a marked-up printout and rather imperiously commands you: “We need these 
12 dimensions changed and the drawing updated by the time we return from 
lunch.” The drawing involves multiple views, several cross sections, and a couple 
of details at different scales.

Chapter 19
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By the time the pair put on their coats, you’ve met them at the door and handed 
them a printout of the revised drawing. The client invites you to join them for 
lunch.

This chapter shows you how to make this scene happen in real life.

Maintaining Design Intent
Parametric (rule-based) drawing is by far the best way to enforce design intent 
in 2D drafting. Design intent in AutoCAD (or in any other engineering software) 
means that when drawings are edited to make “this part” wider and “that hole” 
larger, all the attached or related objects behave in a predictable way that honors 
the designer’s intentions in creating the drawing.

Before AutoCAD 2010, there was simply no way to maintain the design concepts 
behind an AutoCAD drawing. You could use AutoCAD drawing and editing com-
mands to draw accurate, precise plans, sections, and details, but they were, to 
AutoCAD, simply a bunch of lines and circles.

Suppose that an engineer has taken a second look at a baseplate (see Chapter 3) 
and determined that its 1-1/2” bolts should be changed to 1-3/4”. To revise the 
drawing by using AutoCAD in the traditional way, you draw a new, larger circle for 
the bolt and erase the old one. Now the nut is too small, and so is the hole in the 
plate. Maybe you can’t see it, but you know — and I know — that it’s there. And 
you have four bolts to change — that’s a whole lot of editing to fix this drawing. 
Even so, the good news is that it would still be a lot easier than using paper and 
pencil.

In AutoCAD, you can add some intelligence to those lines and circles by applying 
parametric constraints to them. Rather than try to explain what this term means, 
I’ll show you.

AutoCAD does not support 3D constraints, such as those found in Inventor.

Unfortunately, the following exercise doesn’t work in AutoCAD LT.

Follow these steps to use parametrics to constrain a line to a circle:

1. Start a new drawing.

2. Draw a circle and a line anywhere in the drawing.

Specifying exact sizes and alignments isn’t critical. You’ll see why in a moment, 
and I explain even more a little later in this chapter.
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3. Apply a tangent constraint between the circle and the line.

Parametric functions are found on the Ribbon’s Parametric tab. Nothing in 
AutoCAD should surprise you by now. Click the Tangent button, and then 
select the circle and the line. The sequence doesn’t matter. Observe how they 
move until they’re tangent to each other and how a little gray icon (a constraint 
bar) appears to indicate the type of constraint. Note that tangent doesn’t 
necessarily mean that they touch.

4. Grip-edit the line and the circle.

You can move the circle or line, change the diameter of the circle, or move 
either end of the line — but no matter what you do, the other object obedi-
ently remains tangent. I cover grip editing in Chapter 11.

5. Apply a diameter dimension to the circle.

Don’t use the normal DimDIameter command, described in Chapter 14. 
Instead, click the Diameter button in the upper-right corner of the Dimensional 
panel of the Parametric tab on the Ribbon. When you select the circle as 
prompted, AutoCAD places a funny-looking gray dimension that reads 
something like this: dia1=5.3716. It has the same background color as the 
mText edit box (see Chapter 13); in fact, that’s exactly what it’s inviting you to 
do. When you enter the desired diameter (say, 7.5), the circle resizes to match 
the diameter value you entered, and the line adjusts to remain tangent. It’s the 
opposite of associative dimensions (see Chapter 14).

6. Apply an aligned dimension to the line.

Again, be sure to click the Aligned button from the Dimension panel on the 
Parametric tab, and select each end of the line in turn or press Enter and then 
select the line. This time, when it places the dimension, enter =dia1*2 including 
the equal sign and omitting spaces. The line automatically resizes to become 
twice as long as the diameter of the circle.

7. Double-click the diameter dimensional constraint and type a new value, such 
as 5, and press Enter.

Surprise! The circle size changes, and the line changes its length so that it’s still 
twice as long as the new diameter of the circle. That is one smart drawing. 
Imagine a similar effect on your productivity in creating and editing drawings.

You can still grip-edit the position of the line and circle, but you can’t change 
the diameter of the circle or length of the line using grip editing, nor can you 
stretch the line length any more.
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Defining terms
The word parameter is derived from these two Greek roots:

 » para: To work with, to assist, to work alongside. Think of paramedic ambulance 
attendants. You may have seen an “ambulance” when I mentioned paramet-
rics earlier in this chapter.

 » metros: To measure (hence meter and metric). For the purposes of making 
drawings in AutoCAD, a parameter is a rule that works alongside AutoCAD 
objects. You can think of parametric drawing as rule-based drawing.

AutoCAD’s parametric rules (officially called constraints) fall into two categories:

 » Geometric: Based on object types and relationships between objects; differ-
ent object types have different potential constraints. In the example in the 
preceding step list, I show you how to apply a Tangent constraint between the 
line and the circle — as you move or change one, the other one follows along.

 » Dimensional: Based on dimensioned distances on or between objects or 
points on objects. In the earlier example, you see how to apply a dimensional 
constraint to the circle. Changing the dimension value changes the circle size. 
Better yet, you can establish a relationship between the circle and the line so 
that changing the circle diameter also changes the length of the line.

Both AutoCAD and AutoCAD LT support constraints, but (as is usually the case) 
the feature is limited in LT. If you use the full version of AutoCAD, you can  create 
and modify geometric and dimensional constraints, as I describe in the steps in 
this chapter. If you’re using LT, you can’t create either type of constraint, but you 
can work with existing constraints in drawings that were created in AutoCAD.  
Figure 19-1 shows the difference between the AutoCAD and AutoCAD LT Paramet-
ric tabs.

FIGURE 19-1:  
Parametric 

tabs in  
AutoCAD 

(above) and 
AutoCAD LT 

(below).
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If you’re using AutoCAD LT, or if you just want to check out some ready-made 
parametric possibilities, you can download the sample drawing datasets from 
either www.autodesk.com/autocad-samples or www.autodesk.com/autocadlt-
samples. The parametric samples are architectural_example-imperial.dwg, 
civil_example-imperial.dwg, and mechanical_example-imperial.dwg.

Forget about drawing with precision!
“Are you serious? Throughout this book, you continually nag about the need for 
drawing with precision, and now you want me to forget about it?”

I’m sure that you’re familiar with, or at least have come across, computer acro-
nyms and abbreviations, such as RAM, ROM, DVD, USB, and, of course, CAD. Okay, 
here’s a new one that I coined for a magazine article a few years back: NAD, or 
Napkin-Aided Design. It has been my observation that the vast majority of design 
projects start life as a sketch on a coffee-shop napkin.

A major strength of CAD is that drawings can (and should) be so precise that you 
can make use of information within them, such as areas. A major weakness of 
CAD is that you’re forced to be precise, even early in the design process, when 
circumstances often change. Yes, commands such as Move and Stretch make edit-
ing relatively simple, but relatively is a relative term, and easy to use is easy to say.

With parametrics, you can start out with a NAD sketch that shows the general idea 
of your design. Remember my parametric motto: Close enough is good enough. By 
the way, the motto also applies to horseshoes, hand grenades, and dancing. Then 
apply geometric and dimensional constraints and formulas to control the behavior 
of the drawing, and fine-tune the values until you arrive at your final design.

Constrain yourself
You can apply dimensional or geometric constraints to new geometry as you cre-
ate it, or you can assign constraints to existing geometry in old drawings. You can 
even convert existing associative dimensions to dynamic dimensional constraints. 
The following sections describe the constraints available in each of the two cat-
egories. I start with geometric constraints because I’ve found that it’s usually best 
to pin down objects (pun intended) before applying dimensional constraints so 
that the drawing objects behave in a predictable manner when dimension values 
are changed.

www.autodesk.com/autocad-samples
www.autodesk.com/autocadlt-samples
www.autodesk.com/autocadlt-samples
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Understanding Geometric Constraints
Adding geometric constraints to object geometry is quite simple because it’s much 
like using normal object snaps. In fact, in several cases, AutoCAD’s geometric 
constraints have equivalent object snaps. AutoCAD has tangent, parallel, concen-
tric (center), and perpendicular object snaps, and there are tangent, parallel, con-
centric, and perpendicular geometric constraints. The difference between these 
relations as object snaps and as geometric constraints is that constraints are per-
sistent. Think of them as “sticky” object snaps, as opposed to the “momentary” 
ones described in Chapter 8.

For example, in the example earlier in this chapter, you can see how the line 
always remains tangent to the circle, no matter what. The objects “remember” 
how to get along with their siblings. If I could only figure out a way to make this 
principle work with my kids.

Twelve geometric constraints are at your disposal to apply to drawing objects, and 
the easiest way to apply them is to click buttons on the Geometric panel of the 
Ribbon’s Parametric tab. Table 19-1 presents a list of the geometric constraints 
and explains what they do.

TABLE 19-1 Geometric Constraints
Button Constraint Name What It Does

Coincident Forces two or more points, such as endpoints or midpoints, to coincide; 
can also constrain a point to lie anywhere on an object.

Collinear Forces two or more lines to lie along an infinitely long projection of the first 
line that’s selected.

Concentric Forces the centers of two or more arcs, circles, ellipses, or arc segments of 
polylines to share the same center point.

Fix Locks the location of an object or a point on an object to a specific location 
in the drawing; object can rotate around the fixed point.

Parallel Forces two lines to be parallel; the second line selected becomes parallel to 
the first line.

Perpendicular Forces two lines to be perpendicular to one another. Note that 
perpendicular doesn’t mean only “one horizontal with the other one vertical 
at one end.” Perpendicular means “at right angles to” no matter the angular 
orientation, and the lines do not need to touch or cross.
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Text objects can also be geometrically constrained. You can apply horizontal or 
vertical constraints to text, and you can make text parallel, perpendicular, or col-
linear with lines. Anyone who has had to label utility lines on civil engineering 
drawings in earlier releases so that the text aligns with the linework will enjoy 
this feature.

The three buttons at the right side of AutoCAD’s Geometric panel (and the only 
buttons on AutoCAD LT’s Geometric panel) let you control the visibility of geo-
metric constraint markers:

 » Show All shows all constraint markers.

 » Hide All hides all constraint markers.

 » Show/Hide displays the constraints on selected objects. I wish that you could 
hover the mouse pointer over an object to show the constraints, but you need 
to click an object and then press Enter to see results.

Applying a little more constraint
If you’re using AutoCAD (not AutoCAD LT), you can constrain drawing objects 
geometrically by clicking buttons on the Geometric panel of the Parametric tab. 
In the following steps, I show you how to get started with geometric constraints.

Button Constraint Name What It Does

Horizontal Forces a line or two points to be horizontal relative to the current 
coordinate system.

Vertical Forces a line or two points to be vertical relative to the current coordinate 
system.

Tangent Forces an object to be tangent to a selected arc or circle.

Smooth Joins a selected spline object with another spline, line, arc, or polyline while 
maintaining curvature (also known as G2) continuity.

Symmetric Forces two objects or two points on objects to be symmetrical about an 
imaginary line and is similar to a persistent Mirror command.

Equal Forces two lines or linear polyline segments to be the same length; forces 
two arcs or circles, or an arc and a circle, to have the same radius.
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These steps may seem tedious, but I want you to become familiar with the basic 
properties of each type of constraint. Later, I show you a couple of shortcuts that 
speed things up.

You can find the files I use in this sequence of steps at this book’s companion 
website: Go to www.dummies.com/go/autocadfd17 and download afd19.zip. The 
drawing named afd19c.dwg contains the unconstrained geometry, and drawing 
afd19d.dwg contains the end product.

Follow these steps to use geometric constraints:

1. Start a new drawing. Make the Ribbon’s Parametric tab current, and turn 
off Snap, Ortho, Polar, Osnap, and Otrack on the status bar.

For production drawings, you will want to make sure you use precision drafting 
aids, but in this example, you gain a better sense of parametrics with an 
extremely imprecise drawing.

2. Draw some linework by using the PLine command, and then add a couple 
of circles.

Draw it to look similar to Figure 19-2 if you want to follow these steps closely.

Every drawing is tackled differently, 
so look ahead and figure out the 
most efficient way to apply the 
constraints you need in order to 
maintain your design intent. In this 
example, you end up with two 
concentric circles in the middle of a 
square.

As I mention earlier, applying 
constraints is easier if at least one 
point on the geometry is fixed in 
space. In many cases, consider 
applying the Fix constraint first — 
it constrains a point to a single 
location in the drawing area. This 
topic has nothing to do with 
tomcats.

In this example, I show you how to 
lock one endpoint of the polyline 
into position.

FIGURE 19-2:  
Random shapes in need of constraining.

http://www.dummies.com/go/autocadfd17
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3. Click Fix in the Geometric panel, and then click a point that you want to 
fix in space.

A blue padlock icon displays beside 
the pickbox, and the red pick point 
marker appears when you hover over 
a point that you can constrain (see 
Figure 19-3). In this example, I clicked 
an endpoint on the polyline. The 
padlock icon appears in the con-
straint bar, indicating that the 
endpoint of the polyline segment is 
fixed in place.

With at least one point on the 
geometry fixed in place, you can start 
constraining the geometry by closing 
the gap in the linework.

4. Click Coincident in the Parametric 
tab’s Geometric panel.

You use a coincident constraint to 
make two points coincide. A blue 
coincident icon appears near the pickbox, and as you move the cursor over an 
object, a marker appears over relevant points. In the case of lines or polyline 
segments, they’re at the endpoints and the midpoint.

Use appropriate drawing commands based on your design intent. We use a 
polyline in this example because the ends of the segments are already 
coincident-constrained by being part of a single polyline object. If you had 
drawn this shape with lines, you’d have to apply individual coincident con-
straints to each corner.

5. Click an endpoint on the first polyline segment that you want to connect, 
and then click an endpoint on the second segment.

The endpoint of the second polyline segment jumps to the endpoint of the first 
line, and a small blue square (the marker for coincident constraints) appears at 
the intersection. If you don’t see the little blue square, click Show All in the 
Geometric panel.

6. Apply some orthographic parameters so that the linework starts to look 
a little more like a rectangle. Click Horizontal in the Parametric tab’s 
Geometric panel, and then click a line or polyline segment that you want 
to align with the drawing’s X-axis.

In this example, we picked the bottom segment of the polyline. The segment 
realigns horizontally from the endpoint nearest to the spot where you picked 

FIGURE 19-3:  
Locking down an object in drawing space.
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the line (unless a Fix constraint is added first), and a horizontal constraint 
marker (a constraint bar) appears near the object. A single item is still called 
the constraint bar because, if you add additional constraints to the object, 
they’re added to the existing one, like a toolbar.

7. Click Vertical to align a line or polyline segment with the drawing’s Y-axis.

In this example, we pick the left vertical(-ish) polyline segment. The segment 
realigns at 90 degrees to the horizontal segment, and a constraint bar showing 
a vertical constraint appears. With one line segment horizontally constrained 
and another vertically constrained, you’re halfway to a geometrically precise 
rectangle.

8. Because rectangles have parallel and perpendicular sides, apply those 
constraints to your linework. Click Parallel in the Parametric tab’s 
Geometric panel, click the vertically constrained line segment, and then 
click the line segment opposite to it.

Because a vertical constraint is already applied to one segment, it doesn’t 
matter which line you pick first. If neither line had an existing constraint, the 
second line you picked would become parallel to the first line.

Always prioritize your design intent as you consider which constraints to apply 
and when to apply them. As a general rule, start with the most important ones, 
and drill down to the least important. As I remind you earlier in this chapter, 
applying a fix constraint early in the game can prevent your geometry from 
rearranging itself in ways you don’t expect.

To make the final side of the almost-rectangle orthogonal with the other three, 
you could use another parallel constraint and click the bottom line. However, 
you don’t want to wear out the Parallel button, so use Perpendicular on the 
final segment.

9. Click Perpendicular on the Geometric panel, click either vertical side, and 
then click the non-orthogonal side.

Again, because three of the four sides are already constrained to horizontal 
and vertical, it doesn’t matter which segment you pick first.

Perpendicular means “at right angles to.” It isn’t restricted to “a vertical line 
extending upward from one end of a horizontal line.” A line at an angle to the 
X-axis can still be perpendicular to another, and the lines don’t have to touch.

Some constraints work on one object (horizontal, vertical), and others work on 
two objects (parallel, tangent, perpendicular). If you roll the cursor over a 
two-object constraint, its soul mate lights up.

To delete a constraint, move the mouse pointer over the constraint marker to 
display the constraints bar (see Figure 19-4), right-click, and choose Delete from 
the menu that appears.



CHAPTER 19  Call the Parametrics!     385

From four non-orthogonal, not-even-closed line segments, applying a handful 
of constraints yields a perfect rectangle. However, you really want a square, 
which is where the Equal constraint comes in.

10. Click Equal on the Geometric panel, click the bottom side, and then click 
either of the vertical sides.

It’s a perfect square! Now you have to constrain those circles.

The design intent in this example is to make the circles concentric and to locate 
their centers in the exact center of the rectangle. First, the easy part: Make the 
circles concentric.

11. Click Concentric in the Geometric panel, click one circle, and then click 
the other.

The two circles are concentrically constrained. Try saying that ten times fast. A 
new constraint bar appears in their vicinity. Move one circle by clicking it, and 
watch the other tag along.

As I suggest, concentric is the easy constraint. I’d love to be able to use the Mid 
Between 2 Points object snap and simply click two diagonally opposite corners 
to locate the circles dead center in the rectangle. However, because you can 
constrain only objects or points on objects, you have to add some construction 
geometry to maintain the design intent.

FIGURE 19-4:  
Constraining to 

orthogonal.
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12. Draw a line between diagonally opposite corners using Endpoint object 
snaps, and then apply coincident constraints between the endpoints of this 
line and the corners of the rectangle (see Figure 19-5).

Draw construction geometry on a separate layer, and set that layer to NoPlot 
in the Layer Properties Manager. If you don’t want to even see your construc-
tion geometry (or plot it), turn off the construction geometry layer, or freeze it. 
The geometric constraints will still work.

13. Click Coincident in the Geometric panel. Click either circle so that the 
parametric marker appears in the center, move the pickbox over the 
 construction line, and click when the parametric marker is over the midpoint 
of the line.

You’re done! You can test your design intent by using the Stretch command on 
the corner of the rectangle that doesn’t display a square, blue coincident icon. 
As you drag the corner, you should see the two circles moving, too, always 
maintaining their position in the middle of the rectangle (see Figure 19-6).

Using inferred constraints
Parametrics were a new feature in AutoCAD 2010 and were considerably enhanced 
in AutoCAD 2011 by the addition of inferred constraints. A status bar button (to the 
left of the Snap button) toggles Infer Constraints mode off and on. When it’s on, 
you don’t have to specifically apply many of the geometric constraints.

FIGURE 19-5:  
Adding 

construction 
geometry.
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To produce the best results, go at least partway back to drawing with precision. 
For example, a coincident constraint is applied pretty much any time you use an 
object snap, and horizontal and vertical constraints are placed if polar or ortho 
modes are on.

Inferred constraints also work when editing existing geometry.

Inferred Constraints mode is a powerful component of parametric drafting in 
AutoCAD, but I recommend that you first familiarize yourself with manually 
applying constraints, as described in this chapter.

You AutoConstrain yourself!
The geometric constraints (refer to Table 19-1) are meant to be applied one at a 
time. That level of flexibility is helpful, but it can be pretty darned time-consuming 
to go around a complex object, trying to figure out what the best constraint option 
would be and then applying it.

The Auto Constrain button on the Parametric tab’s Geometric panel can apply a 
whack of constraints to a selection of objects with a single click. Before you exe-
cute that click, however, take a look at the Auto Constrain settings. Click the dialog 
box launcher (the little angled arrow at the right end of the Geometric panel label) 
to open the Constraint Settings dialog box and make the AutoConstrain tab active 
(see Figure 19-7). Choose the constraints you want to apply automatically, and 
their order in the list, so that the ones that should take precedence have a higher 

FIGURE 19-6:  
Full-on 

geometric 
constraints.
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priority. Your best bet initially is to stick with the defaults until you become more 
familiar with how Auto Constrain works.

Auto Constrain works only with geometric constraints, not with dimensional 
constraints.

AutoCAD doesn’t let you overconstrain an object. For example, if a horizontal 
 constraint appears on one line, and a parallel constraint appears between it and 
a  second line, AutoCAD objects if you try to add a horizontal constraint to the 
second line.

Understanding Dimensional Constraints
The normal practice in AutoCAD is to create some geometry using, of course, 
the precision techniques I discuss in Chapter 8 and then apply dimensions as I 
describe in Chapter 14. Assuming that you’re using fully associative dimensions, 
you can then edit the geometry and watch the dimensions update automatically. 
The length of the line or the radius of the circle is in control, and those dimensions 
are driven dimensions because they change when the object geometry changes.

FIGURE 19-7:  
Auto- 

constrainable 
geometric 

relations in 
the Constraint 

Settings  
dialog box.
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Dimensional constraints, unlike regular AutoCAD dimensions, are driving  
dimensions — when you change the value of a dynamic dimension on a line, the 
line changes to match. In other words, the dimension is driving the length of the 
line, not the other way around.

There are only eight dimensional-constraint options, but they cover all the bases, 
as described in Table 19-2.

Practice a little constraint
The objects you add to a drawing from the Dimensional panel aren’t the same as 
the dimension objects you add from the Annotate tab. Dimensional constraints are 
driving dimensions — when you change the value of one of these dimensions, the 
geometry changes.

TABLE 19-2 Dimensional Constraints
Button Constraint Name What It Does

Linear Applies a horizontal or vertical dimensional constraint (similar to 
DIMLINear)

Horizontal Applies a dimensional constraint aligned with the X-axis of the coordinate 
system (similar to DIMLINear’s Horizontal option)

Vertical Applies a dimensional constraint aligned with the Y-axis of the coordinate 
system (similar to DIMLINear’s Vertical option)

Aligned Applies a dimensional constraint aligned with the object or with the points 
being dimensioned (similar to DIMALIgned)

Radial Applies a set value or formula to the radius of an arc or a circle (similar to 
DIMRADius)

Diameter Applies a set value or formula to the diameter of an arc or a circle (similar 
to DIMDIAMeter)

Angular Applies a set value or formula to the angle between two lines or three 
points (similar to DIMANGular)

Convert Converts an existing associative dimension object to a dimensional 
constraint



390     PART 4  Advancing with AutoCAD

A lot is happening behind the scenes as you apply parametric constraints. You can 
get a sense of how these constraints work at keeping drawing objects in order by 
using the Stretch command on objects after you apply a constraint to them.

You can find the files I use in these steps at this book’s companion website: Go 
to www.dummies.com/go/autocadfd17 and download afd19.zip. The drawing 
named afd19a.dwg contains the unconstrained geometry, and the drawing named 
afd19b.dwg contains the end product.

These steps present a simple example of dimensional constraints:

1. Start a new drawing and make the Ribbon’s Parametric tab current.

2. Turn on the appropriate precision drawing aids on the status bar, such as 
Snap, Ortho, and Osnap.

3. Draw some reasonably precise geometry by applying the precision tech-
niques I describe in earlier chapters.

In the following example, I use the RECtang and Circle commands to draw the 
geometry you see in Figure 19-8. The rectangle is ten units square, and the 
2.5-unit-radius circle is deliberately drawn away from the middle of the square.

4. On the Dimensional panel of the Parametric tab, click the top part of the 
Linear split button.

A linear dimension icon appears beside the pickbox, and AutoCAD prompts 
you to either specify the first constraint point or pick an object.

Like the DimLInear command, the Linear dimensional constraint tool is 
inferential — which way you drag the cursor controls whether you create a 

FIGURE 19-8:  
Simple  

geometry, 
badly in  
need of  

constraining.

http://www.dummies.com/go/autocadfd17
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horizontal or vertical dimension. Also, as with DimLInear, you can press Enter 
at the command line and select an object to dimension.

Hover the mouse over the Linear button to see (unlike its neighbor, Aligned) 
that the button is split into two parts. To force a linear dimensional constraint 
to be either horizontal or vertical (rather than dependent on the direction you 
drag the cursor), click the bottom part of the Linear button and choose from 
the drop-down menu.

5. Press Enter at the command line to confirm that you want to select an 
object, and then select the bottom horizontal line segment.

If you see red markers at the midpoint and endpoints of the bottom line, you 
didn’t press Enter — and AutoCAD is in Point Selection mode rather than 
Object Selection mode.

AutoCAD generates a preview of a dimensional constraint and prompts you for 
a location.

6. Click to locate the dimension position.

AutoCAD draws a dimensional constraint with a highlighted text field display-
ing the dimension name (d1, in this example) and the value returned by 
AutoCAD.

7. Press Enter to confirm the value and the dimension location (see Figure 19-9).

Best practice is usually to accept the default value for all dimensional con-
straints as they are applied and then edit them later to the exact values that 
are desired. This avoids problems such trying to make the width of a slot 
greater than the width of the piece that contains the slot, which can turn your 
drawing inside out.

If the dimensional constraints disappear as soon as you place them, click 
the Show All button on the Parametric tab’s Dimensional panel (refer to 
Figure 19-1).

Because dimensional constraints aren’t regular dimension objects, you can’t 
plot them, so it doesn’t matter where you put them or what they look like. I 
show you in the next section how to turn dimensional constraints into properly 
styled, plotable dimensions.

8. Repeat Steps 4–6 and add a dimensional constraint to the rightmost vertical 
edge of the rectangle.

AutoCAD draws a second dimensional constraint, this one named d2.
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Making your drawing even smarter
If your drawing were a traditional mechanical drawing that followed the rules of 
drafting, the placement of a horizontal and vertical dimension in the example of 
the previous section would be enough. Whoever reads your drawing understands 
that if sides are parallel and perpendicular, a dimension on one side applies to 
the opposite side as well. But in this chapter, I talk about intelligent drawings that 
respect design intent — not dumb collections of lines and circles, even if they do 
follow the rules of drafting.

If you stretch a rectangle in various ways (from the upper-left corner, for exam-
ple), you can see that only the bottom and right sides are constrained to 10 units in 
length. You can add two more linear dimensional constraints to the unconstrained 
sides, but then you’d have to remember to edit both dimensions. Rather than con-
strain both sides to be 10 units long, you maintain design intent by making both 
sides equal in length.

You can make the two sides equal by using either dimensional or geometric con-
straints. You should usually apply most, or all, of the geometric constraints to the 
drawing before adding dimensional constraints. This way, the objects behave in a 
more predictable manner when you change the dimension values.

FIGURE 19-9:  
Placing a 

dimensional 
constraint.
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Follow these steps to apply three geometric constraints:

1. On the Geometric panel of the Parametric tab, click Fix (the padlock icon) 
and then click the lower-left corner of the rectangle.

2. On the Geometric panel, click Horizontal and click the bottom side of the 
rectangle. Then click Vertical and click the left side.

Icons appear near the drawing geometry, showing that those three geometric 
constraints are active.

3. On the Dimensional panel of the Parametric tab, click Linear and add a 
dimensional constraint to the top horizontal line.

4. Click to locate the dimension, type d1, and then press Enter when AutoCAD 
prompts you for the dimension text.

Rather than display numeric values, like the first two linear constraints, this 
new dimensional constraint displays fx: d3=d1.

The main part of this expression sets the d3 dimension to equal the value of 
the d1 dimension. The fx: reminds you that other variables in other dimen-
sions are being referenced.

5. Repeat Steps 3 and 4, and this time add a constraint to the vertical line at the 
left. Then enter d2 as the dimension text.

All four dynamic dimensional constraints display their names and a value or 
expression for each one.

Dimensional constraints have names as well as values. They can also include 
expressions or formulas. You can set the default appearance of dynamic dimen-
sional constraints by clicking the dialog box launcher (the little arrow at the right 
end of the Dimensional panel label) to open the Constraint Settings dialog box, 
with the Dimensional tab active (see Figure 19-10). The options are

 » Name: The first linear dimension is named d1, the second d2, and so on. You 
use the dimension names in expressions.

 » Value: The numeric value that you enter into the dimensional constraint (or 
that AutoCAD enters if you don’t override it).

 » Name and Expression: The dimension name shown as equal to an expres-
sion. The expression can be a value, as in this example, or it can be a formula 
that includes other dimension names.
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Using the Parameters Manager
Both AutoCAD and AutoCAD LT include the Parameters Manager palette, acces-
sible from the Manage panels of the Ribbon’s Parametric tab. You can use the 
Parameters Manager to give all those dimensional constraints more sensible 
names than d1 and d2, but you can (even more usefully) enter expressions instead 
of plain numeric values, as I explain in these steps:

1. Click Parameters Manager in the Manage panel.

The Parameters Manager palette appears, showing a list of the dimensional 
constraints applied in the drawing (see Figure 19-11).

In Figure 19-11, the Expression column shows the numeric values that I 
specified for d1 and d2 and the expressions I entered for d3 and d4. The 
read-only Value column shows the calculated value. You can’t change a value 
in the Value column (it’s grayed out to remind you). You can only edit the cells 
in the Expression column.

2. In the d1 row, click in the Expression field to highlight the current value  
(10, in this example). Then click again and type a new value. For example, 
type 13 and press Enter.

The rectangle resizes in the drawing editor, and because the d3 constraint on 
the top side was made equal to the d1 constraint on the bottom side, both 
sides change equally.

Next, you use an equation as an expression.

FIGURE 19-10:  
Format the 

appearance of 
dimensional 

constraints in 
the Constraint 

Settings  
dialog box.
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3. In the d2 row, click in the Expression field to highlight the current value, and 
then type an expression. For example, type d1*0.75 and then press Enter.

The read-only Value column and the drawing geometry show that the new d1 
distance of 13 has been multiplied by 0.75 and is now 9.75 (see Figure 19-12).

4. Close the Parameters Manager.

Constrain the circle so that its center is always at dead center in the rectangle, 
no matter how the rectangle’s size changes.

FIGURE 19-11:  
The  

Parameters 
Manager  

palette.

FIGURE 19-12:  
Editing  

constraints  
in the  

Parameters 
Manager.
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5. Apply a horizontal dimensional constraint from the upper-left corner of the 
rectangle to the center of the circle. Locate the dimension, type d3/2, and 
then press Enter.

Because the rectangle is now dimensionally constrained on all four sides, it 
doesn’t matter which corner you start from. Note that you don’t have to type 
the whole expression: d5=d3/2. AutoCAD knows what you mean!

6. Repeat Step 5, and this time add a vertical constraint from one corner to the 
center of the circle. Locate the dimension, and then type d4/2.

Figure 19-13 shows the object geometry with all constraints added in this 
 section. Who knew that drafting could be such fun?

If your drawing becomes overrun with parameters, you can add parameter filters 
in the Parameters Manager palette. Right-click any parameter and choose Show 
Filter Tree, or click the double right arrow at the top left of the palette to open the 
Filters pane. Click the funnel icon on the toolbar to create a new filter group, and 
then simply drag and drop parameters into the group. Figure 19-14 shows the two 
constraints (refer to Steps 5 and 6 of the preceding step list) dragged into a new 
group filter.

Dimensions or constraints?  
Have it both ways!
After all the hard work of adding dimensional constraints to a drawing, it would 
be a downright shame to have to go back and apply regular dimensions, wouldn’t 
it? Well, you don’t have to. You can make dimensional constraints look and behave 
like regular dimensions. You can go the other way, too, and make your regular 
dimensions act like dimensional constraints.

FIGURE 19-13:  
All locked 

down — 
dimensionally, 

at least.
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Dimensional constraints are available in two flavors:

 » Dynamic: In this default form, a dynamic constraint is gray, with a padlock 
icon next to it in the drawing area. You can make the constraint appear and 
disappear by clicking Show All in the Dimensional panel. Dynamic constraints 
don’t plot, and they’re always legible because they resize as you zoom in and 
out of the drawing.

 » Annotational: This form is controlled as an object property, so you have 
to set it in the Properties palette. Though annotational constraints plot, 
they don’t resize as you zoom in and out, and they don’t disappear as you 
toggle the Show All button on and off. Annotational constraints conform to 
 dimension style settings.

The dimension name format of annotational constraints can be set to Name, Value, 
or Name and Expression, just like dynamic constraints. Refer to Figure  19-10 for 
another look at the Constraint Settings dialog box. If you want to plot a drawing 
with annotational constraints, reset the format so that it doesn’t show the dimen-
sion name or the expression.

Here’s how to turn dynamic dimensional constraints into annotational constraints:

1. Open a drawing that contains some geometry with dimensional 
constraints.

You can also start a new drawing, draw some simple geometry, and add a 
dimensional constraint or two.

FIGURE 19-14:  
Filter  

parameters 
to keep them 

organized.



398     PART 4  Advancing with AutoCAD

2. Select a dynamic constraint, right-click, and choose Properties.

The Properties palette opens with the object properties of the selected 
dimensional constraint listed in table form.

3. Click in the Constraint Form field, 
and in the drop-down list, change 
Dynamic to Annotational (see 
Figure 19-15).

The dynamic constraint becomes 
annotational and takes on the 
appearance of the current 
 dimension style. If you change the 
dimension style in the Properties 
palette, the annotational constraint 
updates to the new dimension style 
format.

You can go the other way, too — 
from regular dimension objects to 
dimensional constraints to convert 
an existing dumb drawing to an 
intelligent parametric one.

4. Add a linear, radius, diameter, 
aligned, or angular dimension 
(that is, a  regular dimension, not 
a dimensional parameter) to your 
drawing geometry.

Nearly every type of dimension 
object has a parametric analog; 
the exceptions are arc length, jogged radius, jogged linear, and ordinate 
 dimensions.

5. Click Convert in the Dimensional panel, select a dimension type (refer to 
Step 4), and press Enter.

The Dimensional Constraint text box displays as soon as you click an associa-
tive dimension, and the dimension becomes a dynamic constraint as soon as 
you press Enter.

FIGURE 19-15:  
Turning dynamic constraints into annotational 
ones.
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The only clue that a dimension is an annotational constraint rather than a  regular 
associative dimension is the padlock icon that appears next to the dimension 
value. You can turn off the display of the padlock from the Constraint Settings 
dialog box, but I recommend that you leave it on. It doesn’t plot anyway, and you 
might decide to delete the dimension without realizing that it’s controlling your 
object geometry.

Annotational dimensions can also be annotative so that they size themselves 
automatically to the drawing scale. I cover annotative dimensions in Chapter 14. 
Annotative and annotational dimensions are also associative, so you can have 
annotative annotational associative dimensions. Try saying that quickly after a 
few drinks.

In this chapter, I present the two varieties of parametric constraints separately, 
but you get the most mileage from this feature when you incorporate both geo-
metric and dimensional constraints with other precision techniques (described in 
Chapter 8). In fact, if you start a drawing by using Snap, Ortho, Osnap, and other 
precision techniques before you add dimensional and parametric constraints, 
you’ll be well on your way to creating a library of intelligent drawings that main-
tain your design intent.

Geometric and dimensional constraints can be equivalent. For example, a 
90-degree-angle dimensional constraint is equal to a perpendicular geometric 
constraint, and AutoCAD doesn’t let you apply both.

All examples in this chapter involve a single drawing view. Geometric constraints 
apply “to infinity,” so you can synchronize objects from one orthographic view 
with objects in another. For example, coincident and collinear constraints can 
link objects in the front view with their equivalents in the top and right-side 
views, and liberal use of the equal constraint means that you should never have to 
measure or dimension anything twice, you should never need more than minimal 
construction geometry, any changes in one view reflect through to the others, and 
your views always remain orthogonally aligned.

Lunchtime!
You may recall that in the opening paragraphs I laid out a scenario wherein 
your boss instructed you to make a number of changes, and I implied that you 
could do them almost instantaneously. If you haven’t already done so, go to 
www.dummies.com/go/autocadfd17 and download afd19.zip. Open the drawing 
named afd19e.dwg which looks like Figure 19-16.

http://www.dummies.com/go/autocadfd17
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Now double-click the dia=1.5000 dimension and change it to dia1=2.0000 and 
then press Enter. Surprise! Two more dimensions change and all three views 
update! While you’re at it, change ang1=30 to ang1=60, change d5=2.5000 to 
d5=2.000, change d6=3.0000 to d6=2.5000, and change d1=10.000 to 8.1250. Then 
print your drawing and head to the door to meet your boss and the client with a 
drawing that looks like Figure 19-17.

FIGURE 19-17:  
Thirty seconds 

later . . .

FIGURE 19-16:  
This part needs 
a few revisions.
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IN THIS CHAPTER

Understanding AutoCAD’s Internet 
features

Fixing file dependencies with 
Reference Manager

Protecting drawings with digital 
signatures

Exchanging drawing files via the 
Internet

Sharing and collaborating with 
AutoCAD 360 and A360

Viewing drawings with DWG 
TrueView

Drawing on the 
Internet

Unless you’ve been living under a rock for the past 30 years, you know that 
the Internet is causing major changes in the way people work. Because of 
the ’Net, most of us communicate differently, exchange files more rapidly, 

and phone out for pizza less frequently. Well, ordering pizza over the Internet is 
easy, but they still have to work out a few of the details to deliver it that way. Years 
ago they tried FAX pizzas, but it didn’t work out. 3D printing, on the other hand. . .

In this chapter, I show you how and when to use AutoCAD Internet features. I also 
cover how the Internet features can connect with traditional CAD tasks, such as 
file sharing. The emphasis of this chapter is on useful, no-nonsense ways to take 
advantage of the Internet in your CAD work.

Chapter 20
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The Internet and AutoCAD: An Overview
The web is changing so quickly that it’s almost impossible to write the definitive 
chapter that spells out exactly how everything works and what’s best for you. My 
intention in this chapter is to steer you toward the features that I feel are of most 
interest.

This is known as the CYA (Cover Your bAckside) paragraph. This chapter describes 
certain Internet features as they are known to exist at the time of this writing, but 
things are subject to change without notice. There is no warranty, expressed or 
implied, that everything will be the same when you try to use it. For example, one 
function changed names four times in six years.

You send me
Email and the cloud have largely replaced blueline prints and overnight delivery 
as the standard means of exchanging drawings. Snail mail (at least for envelopes) 
is dead!

Sending and receiving drawing files doesn’t differ much from sending and receiv-
ing other kinds of files, except that

 » DWG files tend to be bigger than word processing documents and 
spreadsheets. Consequently, you may need to invest in a faster Internet con-
nection, and you can easily run up against email attachment size limits.

 » You can easily forget to include all dependent files. An AutoCAD file may 
not be an island unto itself, but it may also require other files to go with it. I 
tell you in the next section how to make sure that you send all the necessary 
files.

 » It’s often not completely obvious how to plot what you receive. Read 
Chapter 16 and the “Bad reception?” section, later in this chapter, to solve 
plotting puzzles.

Whenever you send DWG files, ask the recipients to open the drawings you’ve 
sent as soon as they receive them so that you both have more time to respond if 
there’s a problem.

Prepare it with eTransmit
Many people naively assume that an AutoCAD drawing is always contained in a 
single DWG file, but that’s often not the case. Each drawing file created in Auto-
CAD can contain references to more than a dozen other kinds of files, the most 
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important of which are described in Table 20-1. Thus, before you start exchang-
ing drawings via the Internet, you need to assemble the drawings with all their 
dependent files.

Table 20-1 doesn’t exhaust the types of files that your DWG files might refer to. 
Custom plotter settings (such as custom paper sizes) may reside in PC3 or PMP 
files. If you use sheet sets, DST files contain information about the sheet struc-
ture. (I don’t cover sheet sets in this book; if you’re interested, check the online 
Help system.) An FMP file controls some aspects of font mapping. Look up sheet 
sets and the FONTALT and FONTMAP system variables in the AutoCAD online help 
system for detailed information.

Rapid eTransmit
Fortunately, AutoCAD’s ETRANSMIT command pulls together all files that the 
main DWG file depends on. Follow these steps to assemble a drawing with all its 
dependent files by using ETRANSMIT:

1. Open the drawing on which you want to run ETRANSMIT.

If the drawing is already open, save it. You have to save the file just before 
using ETRANSMIT.

2. Click the Application button and choose Publish ➪ eTransmit from the 
Application menu.

The Create Transmittal dialog box appears, as shown in Figure 20-1.

3. On the Files Tree tab or the Files Table tab, remove the check mark next to 
any file that you want ETRANSMIT not to copy with the main drawing.

Unless you have assigned custom font mapping, you can omit the Acad.fmp 
file (in AutoCAD) or acadlt.fmp (in AutoCAD LT).

TABLE 20-1 Kinds of Files That DWG Files Commonly Reference
Description File Types Consequence If Missing Explained In

Custom font files SHX, TTF AutoCAD substitutes another font Chapter 13

Other drawings 
(xrefs)

DWG, DGN, DWF, DWFx, 
PDF

Stuff in the main drawing disappears Chapter 18

Raster graphics files JPG, PCX, TIFF, and others Stuff in the drawing disappears Chapter 18

Plot style tables CTB, STB Lineweights and other plotted effects don’t 
look right when the drawing is plotted

Chapter 16
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4. Select a transmittal setup from the list.

Transmittal setups contain settings that control how ETRANSMIT processes the 
drawings and creates the transmittal package. Click the Transmittal Setups 
button to create new setups or modify existing setups. The default Standard 
transmittal setup works fine for most purposes. In any case, you should view 
the settings (click the Modify button) just to see what options you can change if 
you need to later.

If you want AutoCAD to include SHX and TTF font files, including any custom 
fonts that you’re using, you must turn on the Include Fonts setting in the 
transmittal setup. As I discuss in Chapter 13, however, many custom fonts 
work like licensed software. Sending them to others is just like sharing your 
AutoCAD program installation media with others: illegal and unethical. Don’t 
share licensed text fonts outside your organization.

5. Click the View Report button.

You see a report listing the files that ETRANSMIT will copy, along with warnings 
about any files that it can’t locate.

6. Review the report and make sure that ETRANSMIT was able to find all the 
files.

If files are missing, find them and move or copy them to the location where 
ETRANSMIT expects to find them. See the upcoming section, “Help from the 
Reference Manager.”

7. Click OK.

8. Specify the name and location of the transmittal package.

FIGURE 20-1:  
Using eTransmit 

to share 
 drawings.
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9. Click Save.

ETRANSMIT creates the transmittal package (which is a ZIP file by default). 
Zipping creates a single, tidy, compact package of all your DWG, DGN, DWF, 
PDF, raster image, plot style table, and font files — all ready to be emailed.

You may also want to check out the “Autodesk Weather Forecast: Increasing 
Cloud” section, later in this chapter.

FTP for you and me
File Transfer Protocol (FTP) is a system for sharing files over the Internet. A com-
puter that’s connected to the Internet can act as an FTP server, which means that 
part of its hard drive is accessible over the Internet. The person who configures 
the FTP server can place restrictions so that only people who enter a particular 
logon name and password can see and download files. FTP overcomes the file size 
limitations that often occur with email.

Because of all these FTP benefits, people at larger companies commonly place 
drawing files on their company’s FTP sites and tell you to get the files. This 
approach relieves them of having to email you the files, and it relieves you of hav-
ing to wait for that 19.9MB email download when you least expected it.

The person making the files available to you via FTP usually sends you a Uniform 
Resource Locator (URL) that looks like a web page address, except that it starts 
with ftp:// instead of http://. Simply enter the FTP URL into the address field 
of your web browser and follow any instructions regarding the login name, pass-
word, filename that may appear.

Increasing cloudiness
The trend these days is away from private FTP sites due to the proliferation of free 
or inexpensive services such as Google Drive and Dropbox. These services work on 
pretty much the same principle. You upload a file or files and assign access rights. 
The intended recipient or recipients then receive an invitation email that grants 
access to the specified file or files. As an example, see “Cloudy with a Shower of 
DWGs: A360,” later in this chapter.

Okay, here’s a change already. Until recently, A360 was called Autodesk 360. Sub-
ject to change . . .
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Bad reception?
If you are on the receiving end of incoming drawings, as soon as you receive them 
(zipped, I hope!), copy the file to a new folder on your hard drive or a network disk 
and then unzip the files.

Check at least a few drawings in the package to make sure that all the xrefs and 
other reference files, fonts, and raster image files are included. Open each main 
drawing in the folder, press F2 to view the AutoCAD text window, and look for 
missing font and xref error messages, like this example:

Substituting [simplex.shx] for [helv.shx].
Resolve Xref “GRID”: C:\Here\There\Nowhere\grid.dwg
Can’t find C:\Here\There\Nowhere\grid.dwg

Write down each missing file and then tell the sender to get on the ball (in a nice 
way, of course) and send you the missing pieces. While you’re at it, tell that per-
son to buy this book and read this chapter! Or buy it for them yourself.

If you receive drawings with custom TrueType font files (files whose extensions 
are TTF), you must install those files in Windows\Fonts folder (not in one of Auto-
CAD’s support folders) before Windows and AutoCAD will recognize them. Refer to 
your Windows version’s online Help system for instructions on installing fonts.

Help from the Reference Manager
If you move project folders around or transfer drawings to or from somewhere else, 
AutoCAD may not be able to locate any raster image files and DWF/DWFx, DGN, 
PDF underlays (described in Chapter 18) and font files (described in  Chapter 13). 
The ETRANSMIT command, described in the section “Rapid eTransmit,” earlier in 
this chapter, does a good job of gathering dependent reference files, raster files, 
and font files, but it can’t gather what AutoCAD can’t locate.

The AutoCAD Reference Manager utility (not included with AutoCAD LT) is a real 
lifesaver if you’re suffering from file-path perils, whether they occur in your own 
company or when sending files to, or receiving them from, others.

Reference Manager is a separate program, not a command inside AutoCAD. Follow 
these steps to launch the utility from the Windows desktop:

1. Start Reference Manager.

As indicated in other chapters, the process depends on your version of 
Windows and how you have set it up. The bottom line is that Reference 
Manager is a separate program, so it must be started accordingly.
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The Reference Manager program opens, as shown in Figure 20-2.

2. Click the Add Drawings button to add one or more DWG files to the Drawings 
pane on the left.

Navigate to the folder that contains the drawings you want to send, select 
them, and then click Open.

3. In the Reference Manager – Add Xrefs dialog box, choose Add All Xrefs 
Automatically Regardless of Nesting Level.

The Reference Manager processes the drawings and displays all referenced 
objects in its right pane.

4. Click Export Report to create a text report listing all dependent files and their 
paths, or click Edit Selected Paths to modify the paths of selected reference 
files.

5. If you choose to modify any selected paths, click Apply Changes.

When you’re finished exporting reports and repathing reference files (or finding 
reference files that you may never have suspected you had if you hadn’t run the 
Reference Manager), close the Reference Manager window. Click the Help 
button in the Reference Manager to find out more about the utility’s capabilities.

If you always store parent and child DWG files in the same folder, which is the 
simplest approach to dealing with xref paths, you probably don’t need to use the 
Reference Manager.

AutoCAD can also save files in the ubiquitous PDF (Portable Document Format) 
from Adobe Systems. Files can be opened, viewed, and printed from virtually any 
type and model of computing or communicating device. This format can be par-
ticularly useful when you want to show drawing information to people who aren’t 
particularly CAD literate (that is, they aren’t fellow geeks). I have more on this 
topic in Chapter 24.

FIGURE 20-2:  
Reference 
Manager.
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The Drawing Protection Racket
Whether you’re sending DWG or DWF files, you may be concerned about their 
misuse (that is, by the wrong people or for the wrong purposes), abuse (for exam-
ple, modification without your consent), or reuse (on other projects or by other 
people without due compensation to you). Two basic procedures are available for 
securing your files when you send them to others:

 » Password protection: This feature enables you to lock drawing files in older 
releases of AutoCAD. Only someone who types the password you’ve specified 
can open it. Microsoft Office, for example, lets you apply a password to Word 
DOC and DOCx files and to Excel XLS workbook files or to individual work-
sheets in a workbook file.

Due to increasing security requirements, AutoCAD 2016 removed the capabil-
ity to apply passwords. Yes, this sounds backwards, but if you need to secure 
your drawing files, see passwords in AutoCAD’s help facility, where they sug-
gest several commercial password and encryption products.

 » Digital signature: Original paper drawings can’t be modified without leaving 
evidence, and paper copies are obviously copies. Electronic files can be copied 
and modified without leaving much evidence, so a dispute can arise over 
which version is the original. Solution: AutoCAD supports digital signatures. 
Digital signatures don’t prevent unauthorized people from opening the file, 
nor do they prevent anyone from modifying it. All they do is verify that a file 
has or hasn’t been modified since it was signed, if there’s ever a dispute. You 
must first open an account with a digital-certificate provider before you can 
apply them. For more information, see digital signatures in the AutoCAD online 
help system.

Although electronic security features such as the ones described in this section 
can be useful as part of a strategy to protect your work from misuse, they don’t 
substitute for communicating clearly, preferably in the form of written contracts, 
what constitutes appropriate use of drawings that you send to or receive from 
others.

Outgoing!
Okay, you have your drawings bundled up and ready to go. Now what? If the 
package is small enough, email is probably sufficient. On the other hand, if the 
package  is large or you want instant discussion and collaboration, you need a 
cloud solution.
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Autodesk Weather Forecast:  
Increasing Cloud
Even if you just came out from under your rock in the past two hours, you have 
probably heard of the cloud, but you may not really understand what it means. 
Okay, here’s the truth: the cloud really just means the Internet, which in turn 
really just means a huge network of interconnected computers. Some organiza-
tions have put together a large number of computers (a cloud of them, if you will) 
and connected them through and to the Internet. Collectively, they have tremen-
dous computing and storage capabilities. So far, there are two fundamental uses 
for the cloud:

 » Computing: Application software can live and run on the cloud, so your 
computer simply becomes a keyboard and monitor with very long cords back 
to the cloud of computers. This can involve relatively simple applications, such 
as AutoCAD 360 (covered a little later in this chapter), or very complex stress 
analysis operations, but the collective power of the cloud of computers makes 
it possible to do things that are impossible, or at least highly impractical, on 
stand-alone units.

Probably the best example of this is the entertainment industry. Before you 
start producing your own blockbuster computer-generated movie, do the 
math. AutoCAD can produce high-quality, photorealistic images, but it can 
take anywhere from several minutes to a few hours to produce a single frame. 
Now you need 24 or 30 frames per second (fps; movies versus TV) for several 
hours. You soon hit geologic time frames. 3D movies, such as Avatar and How 
to Tame Your Dragon, were produced on rendering farms containing 20,000 to 
30,000 (that’s right; 20 to 30 thousand) computers. I’ve been in one: It was a 
warehouse full of rack after rack of motherboards loaded with RAM and large 
hard drives. No monitors, no keyboards, no mice — just raw computing 
power. I have heard claims that if your personal computer costs one dollar 
per hour to run, several thousand cloud computers still cost you only about 
one dollar per hour.

 » File storage: Cloud servers can collectively contain literally tens of thousands 
of hard drives, each with many terabytes (TB) of storage capacity. A secondary 
benefit of cloud storage is collaboration. If you set things up properly, you can 
share your files instantly, live, with anyone anywhere in the world who is also 
connected to the Internet.

The following sections take a look at a couple of available cloud computing 
solutions.
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Your head planted firmly in the cloud
Besides file sharing, the other main use for the cloud is file storage. Many com-
mercial sites store your files for you for a range of fees, including free sites such 
as Google Drive.

The pros
Here are some advantages of using the cloud for file storage:

 » Security: Do you keep your money under your mattress, or do you put it in 
a bank? The pro side claims that your personal computer is the least-secure 
place in the world to keep your data files. Viruses sneak in, hard drives fail, 
computers get stolen, buildings burn down, and you may not (or, more likely, 
don’t) have a proper backup procedure.

A competent cloud server service is probably using RAID (Redundant Array of 
Independent Disks) technology. The users see it as a single disk drive, but, in 
reality, files are automatically copied to several physical drives. If one drive fails, 
the RAID operating system automatically disconnects that drive and continues 
working with the other drives. A technician swaps out the dead drive on the fly 
and plugs in the new one, and the RAID system automatically refreshes it from 
the good drives. The users don’t even know that anything has happened.

 » Convenience: Because the cloud server is part of the Internet, you can access 
your files anytime from anywhere in the world. Some services, such as A360, 
can allow simultaneous access. Several people scattered all over the globe 
can access, discuss, and edit files at the same time. AutoCAD 360 (discussed 
earlier in this chapter) is an example.

The cons
Here are some disadvantages of using the cloud for file storage:

 » Security: How do you know whether your cloud service is actually follow-
ing proper RAID and backup procedures? Are your files stored in their native 
formats, or are they encrypted? How secure is the site against hackers and 
intruders? Who really owns your files? Can the site raise their rates and then 
hold your files for ransom until you agree to pay the new rates? What if it 
goes bankrupt?

Anything you post to anywhere on the Internet is there forever. You may think 
you have deleted a file moments after you uploaded it, but all you have done 
is to flag as available the space it occupied. The raw data will survive until its 
disk space is needed and a new file overwrites it. By the way, this is also true 
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for local hard drives. Many an embarrassing file has been recovered from 
 discarded drives. In addition, RAID servers by definition hold multiple copies 
of the same file, or a competent cloud service makes regular backups, or both.

The bottom line is that it’s probably not a good idea to post things like the 
drawings of the latest nuclear reactor or those “interesting” photos of you and 
your partner.

 » Convenience: I want to slightly amend one statement from the pros so that 
it now reads, “. . . you can usually access your files almost anytime from almost 
anywhere in the world.” Here’s the scenario: Your four-hour flight to visit an 
important client has just taken off. You have about an hour of work to do 
on one last critical drawing. You fire up your laptop, launch AutoCAD, and 
open — oh, poop! (or words to that effect). No Internet connection. No cloud 
service. No files. You’re doomed.

Cloudy with a Shower of DWGs: A 360
Autodesk has entered the cloudy skies with its A360 service, which gives any-
one up to 5GB of free storage space, plus many other storage and collaboration 
options. Note that you can pay to double the storage capacity.

AutoCAD has a Ribbon tab, shown in 
Figure 20-3, specifically for connect-
ing directly to A360 for online file 
sharing, customized file syncing, and 
more.

The Online tab from AutoCAD 2013 
was renamed Autodesk 360 for 2014 but is now called A360. Subject to change . . . It 
includes a Design Feed button that lets you enter images and posts for online 
sharing, plus several other additions, changes, and deletions from earlier releases.

I don’t bore you with all the details of every option in every panel, because after I 
discuss the general principles, the options are obvious.

ONLINEDOCS is the basic command for signing in to A360. After you’re signed in, 
you can save and upload files to the cloud, share and collaborate with others, and 
download from the cloud. The first time, you’re asked to set up your preferences. 
These can always be changed later, using the other Ribbon buttons that I cover a 
little later.

You sign in to A360 by using your Autodesk Single Sign-on Account. You cre-
ate the account when you install and activate AutoCAD. For a variety of reasons, 
though, you may not have an account or may not know your account information; 

FIGURE 20-3:  
Tie a ribbon around a cloud.
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for example, you may not be the person who installed AutoCAD on the computer 
that you’re using. No problem — you can always create an account on the fly as 
you log in.

For that matter, you can also go directly to the following URL and create an 
account, even if you don’t own AutoCAD. All you need is a valid email address that 
isn’t already linked to an Autodesk account:

https://documents.cloud.autodesk.com/Landing/Index

Don’t select the Keep Me Signed In check box in the Account Sign In dialog box 
if you’re using a computer to which other people have access. If you do, and you 
simply close the browser when you’re finished, ONLINEDOCS doesn’t ask for a 
sign-in name or password the next time it’s invoked. It just signs in directly to 
your account, no matter who is using the computer.

After you’re logged in, ONLINEDOCS opens your A360 Documents list and folders 
in a browser.

Right-click a file to bring up a contextual menu of the various things you can do 
to, or with, the file.

You’re not restricted to uploading AutoCAD drawing files to your A360 account. 
The Select Documents button in the Upload Documents dialog box lets you browse 
to any drive or folder that’s accessible on your computer, including network 
drives, and it lets you select any type of file.

Your A360 documents are also available from many Select File dialog boxes 
throughout AutoCAD. For example, when you open, save, or attach a file, you can 
access the cloud directly from the Places list on the left side of the dialog box.

Now here’s one of the many magic aspects of uploading drawing files to A360. 
An AutoCAD drawing may not be an island unto itself, but it may require access 
to several supporting files — text, dimensions, hatches, plots, and xrefs. This is 
often a problem when you try to send a drawing to someone, because if you miss 
one of the required supporting files, the recipient can have problems opening your 
drawing. Now comes the magic: When you upload drawings directly from Auto-
CAD to the cloud, external references and other dependent files are automatically 
included with the upload. Problem solved. No need to go through the eTransmit 
machinations covered earlier in this chapter.

https://documents.cloud.autodesk.com/Landing/Index
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The optional extras
A360 has a number of options that you can adjust to suit yourself. I don’t go into 
all the gory details, but here are a few highlights of what can be done:

 » You can have AutoCAD automatically save an encrypted copy to the 
cloud every time you save a file or have it copy only files that you select. 
Autodesk recommends the save-every-time option, but you might want to 
read the sections “The pros” and “The cons,” earlier in this chapter, before 
you decide.

 » A360 can let you pimp your ride (oops — I mean sync your settings). If 
you customized AutoCAD and its settings, and if you often use two or more 
different computers, you can have A360 save your personal settings and cus-
tomization to the cloud on the fly while you work.

Now when you go to a different computer and log in, all your settings and cus-
tomizations are downloaded from the cloud, and AutoCAD on the second 
machine looks and runs exactly the same as on your personalized computer. 
The two machines stay synchronized. When you log out, you’re prompted to 
either keep the new settings on the second machine (the perfect option if you 
switch back and forth between your main computer and a laptop) or restore 
the original settings. It’s Kindergarten 102: Be polite. After you finish playing with 
someone else’s toys, you should always put them back where you found them.

 » You can specify which settings to synchronize and which to ignore. The 
list includes options (almost everything in the Options dialog box), customiza-
tion files, printer support files, custom hatch patterns, custom fonts, shapes, 
and linetypes, tool palettes, and drawing templates. You may not want to 
synchronize everything. For example, different computers may have different 
printers.

Sharing and collaborating
With A360, you can share the current drawing with other AutoCAD users. It signs 
you in to the cloud and copies the current drawing to the cloud if it isn’t already 
there. You can specify the email addresses of specific individuals, or you can 
declare it to be public, and you can control the access level of shared documents.

Collaboration involves using AutoCAD 360 in a collaboration session with another 
AutoCAD 360 user. I describe AutoCAD 360 later in this chapter.
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Sender, we have a problem!
Okay, so you’ve emailed your files or posted them to the cloud. Oops, the recipi-
ents don’t own a copy of AutoCAD. No problem. Have them go to http://usa.
autodesk.com/design-review, where they will find two available downloads:

 » Autodesk DWG TrueView: A free Windows program from Autodesk that 
enables anyone to view and print drawing files without having AutoCAD 
installed. It also allows users to do things such as measure distances and 
areas, and freeze, thaw, and change the color of layers. They just can’t 
create or edit anything. There are even free apps available for iOS and 
Android devices.

 » Autodesk Design Review: A free program from Autodesk that works with 
AutoDESK DWG TrueView. It enables anyone to mark up and add comments 
to drawing files without having AutoCAD installed. Again, these free apps are 
available for Windows, iOS, and Android devices.

Many people outside CAD-using companies don’t have access to large-format 
plotters. They’re limited to 8½” x 11” or, at best, 11” x 17” reduced-size check 
plots. Consequently, many people won’t be able to plot your DWF files to scale, 
and they may not even be able to plot them large enough to read everything.

Free AutoCAD!
No, AutoCAD isn’t in prison, at least for the first 30 days. AutoCAD 360 (originally 
named AutoCAD WS; subject to change . . .) is an almost-free version of AutoCAD 
with a limited set of commands that you don’t need a program or even a computer 
to use. The software itself and your drawing files live on an Autodesk web server. 
All you need is a Windows PC and almost any web browser. You don’t need a plug-
in for the browser, so you can run AutoCAD 360 from Internet cafe stations.

You can even use an Internet-enabled device such as a smartphone or a tablet after 
installing the free app. Okay, so maybe it isn’t realistic to do full-time drawing 
creation on an iPhone, but it could be suitable for reviewing drawings or checking 
a specific dimension.

Try it yourself. Go to https://360.autodesk.com/Login, create a free account, 
and log in. You’ll find three sample drawings to play with. Select one and then 
click Open Online. You’ll soon realize that AutoCAD 360 isn’t quite full-blown 
AutoCAD. Realistically, it isn’t even AutoCAD LT. On the other hand, the price is 
right, and I think that you’ll be amazed at what it can do. Disclaimer: Autodesk is 
always working on AutoCAD 360, so even when I state that certain things don’t 
work, they might by the time you try them.

http://usa.autodesk.com/design-review/
http://usa.autodesk.com/design-review/
https://360.autodesk.com/Login
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Autodesk is continually upgrading AutoCAD 360, so the following lists of what you 
can and cannot do in AutoCAD 360 are subject to change.

What you can do
Here’s a quick list of what you can do with AutoCAD 360 at the time I wrote this 
book:

 » Draw most 2D objects (including revision clouds)

 » Use object snaps and Ortho mode

 » Use most of the editing commands, including Undo and Redo

 » Create and manage layers

 » Pan and zoom

 » Switch between model space and paper space layouts

 » Insert and edit blocks

 » Use many of the keyboard mnemonics: L for Line, C for Circle, M for Move, 
and so on

 » Upload files from your computer

 » Download AutoCAD 360 files, which are standard AutoCAD DWG files

 » Print files

 » Create folders and move files between them

Xrefs are supported, including attached raster image files. See Chapter 18 for a 
discussion of xref attachments. Plot styles (discussed in Chapter  16) are sup-
ported, but the style definition files have to be uploaded separately. The Pro ver-
sion adds more functions but is not free.

The free version limits DWG file sizes to a maximum of 10MB and online storage 
space to 5GB. The Pro versions raise the limits to 30MB–40MB per drawing and 
25GB–100GB of storage space. Better yet, you can upload and download any file 
type (documents or spreadsheets, for example) to that storage space, but you can 
open only file types supported by AutoCAD, which include DWG, DXF, and several 
raster formats such as BMP and JPG. My brain hurts.

What AutoCAD 360 can do that AutoCAD can’t do
What you’ll probably find surprising is that AutoCAD 360 can do a few things that 
the full AutoCAD can’t.
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Does the following scenario sound familiar? You’re trying to sell a component to 
someone, or you’re trying to buy a component from someone, or your company 
has another operation somewhere else, or you’re a consultant, and you need to 
discuss the drawing. In the (so-called) good old days, you’d have snail-mailed or 
couriered prints back and forth, with a turnaround time of several days for each 
iteration. These days, you probably email the files and then phone the other party. 
You know the typical conversation: “No, the other hole on the other side!” So far, 
so good. But what if the recipient doesn’t own AutoCAD or is not CAD-literate? 
AutoCAD 360 to the rescue!

Just upload the file to your AutoCAD 360 account, click the Share button, and 
enter one or more email addresses. An email invitation goes out to all recipients, 
inviting them to review the drawing. When the recipients click the link in their 
email, they get signed into your account on AutoCAD 360, even if they don’t have 
an account. AutoCAD 360 then opens the drawing that you shared. Two or more 
people can log in to the same drawing at the same time, and everyone can see 
everyone else’s cursor. If you are using the Pro version, anyone can make changes. 
A text chat box is available for texting each other. AutoCAD 360 keeps a history 
of all changes. Just click to jump back and forth anywhere along the timeline. Try 
doing that in standard AutoCAD.

You can specify a variety of file rights when you issue the invitation. Perhaps you 
want some people to look but not touch or look but not download, or maybe you 
just want them to be able to see a smaller, cropped region of the drawing. You can 
also unshare a file.

What AutoCAD 360 can’t do
As I hint earlier in this chapter, the list of things that AutoCAD 360 cannot do (yet) 
is surprisingly short:

 » The program can’t display 3D objects (see Chapters 21 and 22) on a web 
browser. The 2D viewports created from them (see Chapter 23) can be dis-
played. Three-dimensional objects are displayed on your mobile device if you 
download the free app.

 » Hatching can be created but can’t be edited. It loses its associativity 
(Chapter 15) if the boundary is edited.

 » Layer management (see Chapter 6) is limited to changing the color of layers 
and to moving objects to different layers.

 » Parametrics (see Chapter 19) can’t be applied or edited, and they don’t 
update. On the other hand, they survive a round trip, and upon returning, will 
update any changes made to the related objects.
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 » Annotative objects (see Chapters 13, 14, and 15) display only the configuration 
of the first scale factor that’s applied to them, but they survive a round trip.

Here comes the commercial
As indicated previously in this chapter, AutoCAD 360 is free for the first 30 days. 
After that, you are invited to go to www.autocad360.com/pricing.html, where 
you will find a pricing chart that looks like Figure 20-4. At present (subject to 
change) the main difference between Pro and Pro Plus is that Pro Plus allows for 
larger file sizes and more storage capacity.

FIGURE 20-4:  
AutoCAD 360 
is available at 
three pricing 

levels.

https://www.autocad360.com/pricing.html
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Understand the basics of modeling in 3D.

Set up your 3D working environment.

Generate 2D drawing views and realistic renderings 
from your 3D models.

Access other CAD file formats.
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IN THIS CHAPTER

Understanding the basics of 
modeling in 3D

Accessing modeling tools

Specifying coordinates in 3D

Managing user coordinate systems

Changing the current working plane

Navigating in three dimensions

Applying visual styles

It’s a 3D World  
After All

The addition of the Z coordinate releases your design work in AutoCAD 
from the planar world of two dimensions into a much more lifelike three- 
dimensional space. AutoCAD’s 3D capabilities have grown by leaps and 

bounds since AutoCAD 2007 was released with its souped-up 3D engine. Not only 
have the AutoCAD model creation and editing tools advanced, but it is now also a 
dab hand at visualization and rendering. You can view 3D models from any angle 
or slice through them to see what they look like inside. And finally, because the 
world of technical drawing is still a two-dimensional one, you can use AutoCAD’s 
viewing options to generate 2D drawing views from 3D models.

If you’re an AutoCAD LT user, just sit out most of this chapter and the next two. 
One of the major areas where AutoCAD LT differs from regular AutoCAD is in its 
extremely limited 3D functionality. Even viewing 3D models is much more dif-
ficult than necessary in AutoCAD LT. Those users can acquire nearly all the 3D 
viewing capabilities of the full version of AutoCAD, but you need a separate free 
program to do so. Just go to www.autodesk.com/trueview and download DWG 
Trueview.

Chapter 21

http://www.autodesk.com/trueview
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This chapter takes a look at some of the tools available in AutoCAD’s 3D Model-
ing workspace and introduces you to many of the general concepts of creating 3D 
objects. You also discover how to look at your model from different viewpoints, 
and how to change the way it appears onscreen.

Three-dimensional modeling and visualization is a lot more demanding on com-
puter hardware than 2D drafting; 3D models tend to be bigger than 2D drawings, 
so you may need more disk space. And you’ll certainly be happier with more than 
the bare minimum of RAM required for 2D in AutoCAD. In the online extras for this 
book, I list AutoCAD system requirements and point out the increased resources 
needed for 3D work. In particular, note the desirability of using an engineering 
graphics card as opposed to a gaming card for heavy-duty 3D work.

The 3.5 Kinds of 3D Digital Models
Here are the three basic types of 3D computer models:

 » Wireframe: Consists of edges and vertices only. Although they do occupy 3D 
space, they’re totally unrealistic and difficult to read correctly. AutoCAD can 
help you create wireframe models, but nobody does so any more. You only 
need to view a complex 3D model in wireframe mode to understand why.

 » Surface: Consists of infinitely thin skins that stretch from edge to edge 
of a model. AutoCAD can create two types of surfaces, and hence the 
3.5  reference in the section heading.

• Mesh surfaces are composed of thousands and thousands of three- or four-
sided faces. Mesh surfaces tend to be imprecise. Think of the mirror disco 
ball in a nightclub. From a distance, it looks like a sphere, but as you get 
closer you can see that it is made up of many small, flat patches. A terrible 
punster would say that they make a mesh of the model, but I would never 
stoop so low. Mesh surfaces are most often used for 3D animation or ter-
rain modeling.

• NURBS surfaces: NURBS (Non-Uniform Rational Bezier Spline, if you must 
know) surfaces are far more precise (as you’d expect with a name like that!) 
and are frequently used in consumer product design. Think of a balloon as 
the surface model of a bowling ball.

Due to space limitations, I don’t cover either type of surface modeling in this 
book.

 » Solid: Has edges, surfaces, and mass. It’s a true 3D model, so you can do inter-
ference checking between them to make sure that the parts of an assembly 
will fit together properly. You can also find the surface area, volume, center of 
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gravity, and moments of inertia of 3D models. Unfortunately, AutoCAD always 
assumes that the material has a density of 1. If your real-life part will be made 
from something other than water, you need to multiply the mass values by a 
suitable conversion factor, depending on the actual material being used.

AutoCAD has several commands related to applying materials to solids, but 
they affect only the appearance and not the density.

Although surface and solid models are created and modified differently, the 
3D objects that make up the models are made up of the same subobjects. The sub-
objects that a 3D object is made up of are

 » Vertex: The 3D equivalent of an AutoCAD point object. Vertices are defined by 
a single X,Y,Z coordinate that can exist anywhere in 3D space, and are located 
at the corners of a 3D object. Spheres have no vertices.

 » Edge: The boundary of a face, as defined by two X,Y,Z coordinates, one at 
each vertex.

 » Face: The surface area bounded by three or more edges.

Figure 21-1 shows a simple 3D object (a six-sided cubic shape created with the 
AutoCAD BOX command) and its subobjects.

Tools of the 3D Trade
AutoCAD includes a plethora of tools for creating, editing, viewing, and visual-
izing 3D models. You can find the most commonly used tools for 3D modeling on 
the 3D Modeling workspace’s Ribbon.

FIGURE 21-1:  
Subobjects of a 

3D object.
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AutoCAD comes with two 3D workspaces: 3D Modeling and 3D Basics. I suppose 
the idea is that if you’re new to 3D, you get your feet wet with the 3D Basics 
workspace and then graduate to the 3D Modeling workspace after you gain some 
experience. Personally, I think that the 3D Basics workspace is a waste of time; my 
preference is to have the whole enchilada available from the get-go. In this book, 
I work exclusively with the 3D Modeling workspace.

AutoCAD’s 3D environment is a lot like its 2D version, with important differences. 
You should be aware of the following program settings and elements:

 » Hardware acceleration: Graphics functions, such as changing visual styles 
and running 3DOrbit, can be processed on the main CPU — or, if hardware 
acceleration is enabled, on the graphics card. Turning on hardware accelera-
tion, if your graphics card supports it (which I cover in the next section), nearly 
always improves 3D performance.

 » Workspaces: AutoCAD comes with two 3D workspaces. I highly recommend 
that you use the 3D Modeling workspace. For more about the tools in the 3D 
Modeling workspace, see “Entering the third dimension,” later in this chapter.

 » Drawing window: The drawing window’s background, cursor, and dynamic 
tooltip colors change when you switch between 2D and 3D views, and in 3D 
views when you switch between parallel and perspective projection. Click 
Options on the Application Menu, click the Display tab, and then click the 
Colors button to access color settings for the different interface elements. Note 
that I’ve tweaked the background color on my system so that it’s clear on the 
printed page. Unless you’ve made changes already, you’ll be looking at a very 
dark gray background rather than the light gray one in this chapter’s figures.

 » UCS icon: When you’re working in 3D, the UCS icon shows the orientation of 
the current X,Y plane and the direction of the Z-axis. For information on using 
the UCS icon, see “Changing Planes,” later in this chapter.

Before AutoCAD 2012, the UCS icon merely showed you the orientation of the 
X-, Y-, and Z-axes. If you used the UCS command to set a new UCS, the icon 
reoriented accordingly. Starting in AutoCAD 2012, the selectable UCS icon is in 
the driver’s seat in that you can directly manipulate the icon to change the UCS.

Warp speed ahead
When you start AutoCAD for the first time after installing it, the program assesses 
your computer’s graphics card and — if it’s up to the task — enables hard-
ware acceleration. With hardware acceleration, you can change the view of your 
model — even models with lighting and applied materials — in real time, with 
no deterioration in quality. Hardware acceleration also boosts the overall visual 
 quality of drawing objects as well as regeneration performance.
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Autodesk tests a wide range of cards and drivers with each new release. To find 
out whether your graphics card is supported for AutoCAD, check out the graph-
ics hardware list online at http://usa.autodesk.com/adsk/servlet/syscert? 
siteID=123112&id=18844534.

If your graphics card is unsupported, you may lose some or all of the shading 
and rendering options such as shadows, reflections, transparency, and refraction. 
On the other hand, current generic graphics hardware is often acceptable unless 
you are doing heavy-duty photorealistic renderings of things such as complex 
machinery or highly detailed architectural models.

In any case, if AutoCAD automatically turns on hardware acceleration, you are 
probably good to go.

Entering the third dimension
If you’re new to the 3D game and you’ve been working in 2D until now, you need 
to do a couple of things before you can start a new 3D model in AutoCAD: You 
have to change the workspace, and then you have to open a new file by using a 3D 
template. The following steps explain how:

1. Click the Workspace Switching button on the status bar and then choose 
3D Modeling.

Toolbars, palettes, and Ribbon panels flash on and off, and soon AutoCAD 
settles down to display the Ribbon, as configured for the 3D Modeling 
workspace with a few additional panels.

2. Click the Application button and choose New; then click Drawing.

The Select Template dialog box appears.

3. Choose acad3d.dwt if you’re working in imperial units or acadiso3d.dwt if 
you’re working in metric. Click Open.

A 3D modeling space appears (see Figure 21-2) where, rather than look straight 
down at the drawing area, you look at it at an angle from above.

To switch from 3D to the 2D world, simply click the Workspace Switch button on 
the status bar and choose Drafting and Annotation.

http://usa.autodesk.com/adsk/servlet/syscert?siteID=123112&id=18844534
http://usa.autodesk.com/adsk/servlet/syscert?siteID=123112&id=18844534
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Untying the Ribbon and  
opening some palettes
You can access most of the AutoCAD 3D modeling tools from the Ribbon and 
3D-related palettes. The following list introduces you to the Ribbon tabs and pal-
ettes available in the 3D Modeling workspace. Note that not all items in this list are 
visible in Figure 21-2 and that this list omits some items that aren’t unique to 3D.

 » Home: Contains a subset of the most frequently used 3D tools for creating 
and editing solids, surfaces, and meshes as well as user coordinate system 
(UCS) command options, view tools, 2D drawing and editing commands, and 
layer and group tools.

 » Solid: Contains tools for creating and modifying 3D solids. I show you some of 
the finer points of solid modeling in Chapter 22.

 » Surface: Contains tools used to create, edit, and analyze NURBS surfaces.

 » Mesh: Contains tools used to create and modify meshes, convert them to 
solids, and generate live sections.

 » Render: Contains tools to add lighting and materials to a 3D model, and 
generate rendered output. Chapter 23 presents the basics of rendering in 
AutoCAD.

 » View: Contains tools to navigate, visualize, and change the current view and 
UCS of a 3D model. I cover navigation tools, coordinate systems, and visual 
styles in this chapter.

 » Output: Contains tools to output a 3D model to a DWF or PDF file or even to 
generate a 3D print. I cover plotting 2D drawings in Chapter 16, and outputting  
3D designs to paper isn’t significantly different. See the online Help system for 
specific information. I don’t cover exporting to 3D DWF or 3D printing in this 
book.

FIGURE 21-2:  
Ascending the 

Z-axis.
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The following list describes what you can do with the palettes found on the View 
tab of the Ribbon:

 » Materials Browser: Apply materials to the objects in the current model, and 
manage materials in saved material libraries.

 » Materials Editor: Apply, create, and modify materials in the current model. 
Chapter 23 introduces you to materials.

Applying materials in AutoCAD affects only the appearance and not the 
 density or other properties.

 » Advanced Render Settings: Manage rendering presets.

 » Visual Styles Manager: Create, modify, and manage visual styles in the 
 current model.

The following palettes are found on the Render tab of the Ribbon:

 » Lights in Model: Use this palette to manage lights in the current model.

 » Sun Properties: Use this one to specify the lighting settings for the Sunlight 
system in the current model.

Modeling from Above
So far in this book, I’ve explained how to work with X and Y coordinates only.  
X and Y coordinates by themselves define a two-dimensional plane known (logically  
enough) as the X,Y plane.

In this chapter and in Chapters  22 and  23, you supply a third value — a 
Z  coordinate — to locate geometry above or below the X,Y plane. You use the same 
methods to specify Cartesian (X,Y,Z) coordinates as the ones I set out in Chapters 1 
and 8. You just add a comma and another number. The following techniques can 
be used to specify points in 3D:

 » Coordinate and direct distance entry

 » Point filter

 » Object snap

 » 3D object snap

 » Object snap tracking
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Using 3D coordinate input
I introduce you to 2D coordinate entry in Chapter 8. To recap, the input formats are

 » Absolute Cartesian coordinates: Expressed as X,Y — the distances along the 
X- and Y-axes from the origin (0,0).

 » Relative Cartesian coordinates: Expressed as @X,Y — the distances parallel 
to the X- and Y-axes from the last point.

 » Relative polar coordinates: Expressed as @d<a — the distance and angle in 
the X,Y plane from the last point.

Do not enter spaces after the commas. AutoCAD treats the spacebar the same as 
Enter, and a space messes up the coordinates.

Although you can use these 2D coordinate input methods in 3D, you usually have 
to give AutoCAD just a little more information when you want to work in three 
dimensions. You can use absolute or relative Cartesian coordinates by simply add-
ing a Z coordinate to the end. In addition, there are two 3D–only coordinate for-
mats, both based on 2D polar coordinates. You can enter 3D coordinates with the 
following methods:

 » Absolute Cartesian: Expressed as X,Y,Z. Working with absolute coordinates in 
3D should look familiar because the input is like working in 2D except that you 
add a Z coordinate at the end.

 » Relative Cartesian: Expressed as @X,Y,Z. Relative coordinates in 3D work just 
like they do in 2D except that you add the Z coordinate.

 » Cylindrical: Expressed as @d<a,z. Cylindrical coordinates are similar to rela-
tive polar coordinates (d is the distance and a the angle from the last point in 
the X,Y plane) with the addition of a Cartesian Z coordinate to locate the point 
above or below the X,Y plane.

 » Spherical: Expressed as @d<a1<a2. Spherical coordinates are also based on 
relative polar coordinates, but instead of a Z coordinate to specify a location 
above or below the X,Y plane, you specify an angle from the X,Y plane.

Using point filters
Coordinate entry (as described in the preceding section) is fine if you already 
know the coordinate values or distances in 3D space where you want to locate your 
points. Often, however, you may need to derive 3D points from existing geom-
etry without knowing those exact values. Using point filters, you can locate new 
points based on existing points. You can use point filters to construct 2D and 3D 
coordinates.
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When AutoCAD prompts you to specify a point, you can either enter point filter 
values at the command line or bring up the right-click menu and choose a filter 
option from the Point Filters submenu. After selecting a point filter option, specify 
a point to filter out part of the coordinate value and then enter the requested 
value. For example, use the -X,Y filter to enter your own Z coordinate value after 
specifying a point on the current working plane.

Object snaps and object snap tracking
Object snaps allow you to accurately specify points on existing objects in a 3D 
model. You can use endpoints, midpoints, and center object snaps on 3D objects, 
but AutoCAD also provides a set of object snaps specific to 3D modeling.

Three-dimensional object snaps allow you to specify points on 3D objects that 
regular object snaps don’t recognize, such as a vertex or the center of a face. You 
enable 3D object snaps by clicking the 3D Object Snap button on the status bar. 
Right-click the 3D Object Snap button and choose the running 3D object snap 
modes that you want to use.

Object snap tracking allows you to calculate points that are not on an object by 
using object snap points on existing objects. When working in 3D, you can track 
points on not only the current X,Y plane but also along the Z-axis. While tracking 
points along the Z-axis, AutoCAD provides feedback in the form of a tooltip that 
lets you know you’re moving along the Z-axis in the positive or negative direction.

The ELEVATION system variable allows you to specify a height above or below the 
current working plane. When you enter a 2D coordinate, AutoCAD uses the value 
assigned to the ELEVATION system variable (by default, it’s 0) to create a 3D coor-
dinate. You can set the OSNAPZ system variable to 1, to substitute the Z coordinate 
value of a point specified by using an object snap with the value of ELEVATION.

Changing Planes
Come fly with us while I explain changing planes in AutoCAD. Just step through 
this metal detector over here while I x-ray your bags.

Okay, it’s not that kind of plane. This section covers using the user coordinate sys-
tem (UCS) to control the current working (or X,Y) plane. The UCS icon, displayed 
either at the lower-left corner of the drawing window or at the origin (0,0,0), 
shows you the orientation of the current work plane and the positive direction of 
the Z-axis. I cover UCSs in Chapter 8.
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Displaying the UCS icon
By default, the UCS icon is displayed in both 2D and 3D views. You can lose your 
bearings pretty easily when working in 3D, and I strongly recommend that you 
keep the UCS icon in your sights at all times. You can toggle it on or off by clicking 
the UCS Icon icon (yes, the UCS icon is labeled “UCS Icon”) in the Viewport Tools 
panel of the View tab on the Ribbon.

In previous releases, the UCS icon was merely a graphical indicator of the current 
coordinate system. If you set a new UCS in model space, the UCS icon adjusted to 
show you the orientation of the new X,Y plane and Z-axis. In other words, the UCS 
icon was driven by the current coordinate system. Beginning with AutoCAD 2012, 
the UCS icon moved across to the driver’s seat! You can select the UCS icon and see 
new multifunction grips that allow you to set a new UCS by dragging the grips on 
the origin and the legs of the icon. There’s also a right-click menu. You can enable 
or disable UCS icon selectability on the Settings tab of the UCS dialog box. Type 
UCSMAN and press Enter to open it. In the next section, I show you how to create 
a new UCS by selecting and manipulating the UCS icon.

Adjusting the UCS
Every drawing you create uses the World Coordinate System (WCS), but when 
working in 3D, you need to create additional work planes. User coordinate systems 
(UCSs) are necessary when you need to draw objects on work planes other than the 
WCS. In the real world, think of latitude and longitude as the WCS; street naming, 
house numbering, and hotel room numbers are all local systems and are equiva-
lent to UCSs. Traditional UCSs are static; create one, and it stays current until you 
change it. By default, such coordinate systems are unnamed, but you can assign a 
name and save it for future use.

A couple of releases back, AutoCAD introduced Dynamic UCSs. Because dynamic is 
the opposite of static, what you get is a temporary coordinate system that changes 
as you move the mouse pointer over different planar faces of a 3D object. Click 
the Allow/Disallow Dynamic UCS button on the status bar, or press the F6 key to 
toggle Dynamic UCS on and off.

Name that UCS
The UCS command offers ten options to help you define a new UCS. Access the UCS 
command options from the Coordinates panels on either the View tab or Home tab 
of the Ribbon.

After you select one of these UCS options from the Ribbon, follow the command 
prompts at the command line or the Dynamic Input prompt.
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 » World: Align the UCS to match the WCS.

 » Face: Align the UCS to the face of a 3D solid.

 » View: Align the UCS so that the X plane is perpendicular to your current view-
ing direction.

 » 3 Point: Specify a new origin for the UCS, and then the positive direction of 
the X- and Y-axes. Alternatively, use the multifunction grips on AutoCAD’s UCS 
icon to create a new UCS by moving and realigning the icon.

For more information on all the UCS command’s options, refer to AutoCAD’s 
online Help system.

The more UCSs in your drawing, the more you need help managing them. Auto-
CAD offers a handy-dandy UCS dialog box for doing just that. Open it by clicking 
the dialog box launcher (the little arrow at the right end of the panel label) on the 
Coordinates panel of the View tab or Home tab, or simply type UCSMAN and press 
Enter. The three tabs in the UCS dialog box are

 » Named UCSs: Lists world coordinate system and other types of user coor-
dinate systems. Set a UCS current with the Set Current button, or right-click 
a UCS to rename or delete a named UCS. You can’t rename or delete the 
World UCS.

 » Orthographic UCSs: Lists the six default orthographic coordinate systems 
(front and back, left and right, top and bottom) relative to the WCS. These 
UCSs are automatically created by AutoCAD and can’t be deleted or renamed.

 » Settings: Controls properties of both the UCS icon and the UCS.

After you define a UCS that you think you might want to use again, you can save 
it in the UCS dialog box. I explain how in the following steps, which you begin by 
creating a solid box:

1. Start a new 3D drawing by selecting acad3d.dwt (or acadiso3d.dwt for 
the metric crowd) for the template, and ensure that the 3D Modeling 
workspace is current.

Refer to the steps in the “Entering the third dimension” section, earlier in this 
chapter, if you need a refresher.

2. On the Modeling panel of the Home tab, click Box.

AutoCAD prompts you:

Specify first corner or [Center]:
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3. Type 0,0,0 and then press Enter.

AutoCAD anchors the first corner of the box at the origin of the WCS and 
prompts:

Specify other corner or [Cube/Length]:

4. Drag the cursor away from the first corner and click a point to set the length 
and width of the box.

Exact distances don’t matter in this example. AutoCAD prompts you:

Specify height or [2Point]:

5. Drag the cursor upward from the second corner and click to set the height of 
the box.

AutoCAD creates the 3D box and exits the command.

Then you define the UCS by following these steps:

1. Move the cursor over the UCS icon.

The UCS icon shows the orientation of the world coordinate system. As you 
move the cursor over the icon, it turns a greenish-gold color, indicating that it 
can be selected.

2. Click to select the UCS icon.

A square, multifunction grip appears at the origin, and round, multifunction 
grips appear at the ends of the icon’s legs.

3. Move the cursor over each multifunction grip and look at the grip menus.

Hovering over one of the round grips at the end of a leg lets you choose 
between realigning the selected axis and rotating the UCS around one of the 
unselected axes. Hovering the mouse pointer over the origin grip lets you move 
the UCS origin to a new location and either keep the current alignment of the 
X- and Y-axes or realign them. The third grip option, World, restores the WCS.

Now you use the UCS icon’s multifunction grips to set a new UCS.

4. Click the UCS icon to select it, and then move the cursor over the square, 
multifunction grip at the origin.

The cursor jumps to the origin, and the grip menu appears.

5. From the grip menu, choose Move and Align.

AutoCAD prompts you:

** MOVE AND ALIGN **
   Specify origin point or align to face, surface, or mesh:
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6. Move the cursor to a different corner of the box, and when the UCS icon 
origin is over the corner, click to set the new origin.

If you want, you can drag the round grips on the axes to realign the new UCS.

Finally, you have to save it. Follow these steps:

1. On the Coordinates panel of the Home tab, choose UCS, Named UCS.

AutoCAD displays the UCS dialog box.

2. With the Named UCSs tab current, select Unnamed in the UCSs list.

The new, unnamed UCS is the current UCS in the drawing and is listed at the 
top of the list.

3. Right-click Unnamed and choose Rename from the shortcut menu.

An in-place editor is displayed that allows you to rename the UCS.

4. Type a name for the new UCS and press Enter.

The Unnamed UCS is renamed (see Figure 21-3).

5. Click OK.

The UCS dialog box closes, and the new UCS is saved in the drawing.

FIGURE 21-3:  
Naming a 

custom UCS.
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To switch back and forth between the two UCSs, simply select the one you want to 
use from the Coordinates panel:

 » Use WCS: On the Coordinates panel of the Home tab, choose UCS, World.

 » Use your custom UCS: On the Coordinates panel of the Home tab, click in the 
Named UCS drop-down list and choose the name of the UCS you just saved.

AutoCAD likes giving you lots of choices. You can also restore a named UCS from 
the UCS drop-down list at the bottom of the ViewCube. I fill you in on the View-
Cube in the “Taking a spin around the cube” section, later in this chapter. Or you 
can right-click the UCS icon, choose Named UCS, and then choose the UCS from 
the menu.

Using Dynamic UCS
A named UCS allows you to work on different work planes, but it can take a bit of 
effort to set up, and that can distract you when you’re focused on 3D modeling. 
With Dynamic UCS, you can focus on modeling, not on creating a UCS. To enable or 
disable the Dynamic UCS feature, click the Dynamic UCS button on the status bar.

Figure 21-4 shows an example of drawing a circle on the side of a 3D solid. When 
Dynamic UCS is enabled, AutoCAD highlights the face of the 3D solid that the UCS 
will be aligned with. Click over the face to align the UCS with the face, and then 
finish the command. The circle is aligned with the face of the 3D solid, and the 
previous UCS is then restored.

FIGURE 21-4:  
Dynamically 

create a UCS 
on a 3D solid.
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Navigating the 3D Waters
If you’re new to 3D in AutoCAD, you may be wondering how to look at whatever it 
is you’re modeling from whatever angle you desire.

One way to change viewpoints that work in both 
AutoCAD and AutoCAD LT is to use the preset views 
from the Ribbon. Select the Visualize tab (AutoCAD 
2015 and later) or the View tab (AutoCAD 2014 and 
earlier). Now click the down arrow at the bottom 
of the Views drop-down menu on the Views panel 
(shown in Figure  21-5) to switch to a standard 
orthographic 3D view or an isometric view.

 » The six standard orthographic (straight-on) views 
are Top, Bottom, Left, Right, Front, and Back.

 » The four standard isometric views are SW (left-
front), SE (right-front), NE (right-back), and NW 
(left-back). An isometric view is one in which 
you see the object from above — or below, but 
AutoCAD’s standard views don’t do below.

An isometric view is an unrealistic 3D view because 
all lines that are parallel in reality are also parallel in 
the view. In a perspective view, lines that are par-
allel in reality appear to meet at a vanishing point, 
as parallel lines appear to do in reality. (Think of railroad tracks heading across 
the prairie.) Isometric views are parallel projection views, and you can view 3D 
models by using those views in either the full version of AutoCAD or AutoCAD LT.  
Perspective views are more commonly used in architectural applications, and par-
allel views are more commonly used in mechanical design.

This warning is for AutoCAD LT users. Users of the full version of AutoCAD don’t 
need to worry. AutoCAD LT can open drawings created in the full version. Those 
AutoCAD drawings can be saved with perspective projection current, and if you 
open such a drawing in AutoCAD LT, you can see it in perspective. You can switch 
from perspective to parallel projection by changing the PERSPECTIVE system 
variable’s value from 1 to 0. Be careful if you do this, because you can’t change it 
back again! You could use UNDO to reverse the change, but if you save and close 
the drawing, you’re sunk.

The six orthographic and four isometric views work well for showing 3D models  
of common objects such as mechanical components and buildings. You can also 
change to plan view, which is a top-down view of either the world coordinate 
 system or a UCS.

FIGURE 21-5:  
The 3D Preset Views drop-down 
menu.
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AutoCAD LT has limited 3D viewing capabilities. The same preset views are in both 
AutoCAD and AutoCAD LT, and you can also use the Viewpoint Presets dialog box 
(ddVPoint command) in which you set a viewing position by specifying angles 
in and from the X,Y plane. Finally, there’s the really ugly command-line-only 
VPOINT command, left over from last-millennium releases. Man, that one’s so 
ugly that it’s not even on the Ribbon!

Orbit à go-go
Preset views are fine for many 3D modeling tasks, but if you really want to have 
fun, 3DOrbit (not in AutoCAD LT) is your ticket to it. Orbiting a 3D model in Auto-
CAD is similar in concept to orbiting Earth in a satellite, only a lot cheaper. The 
three orbiter modes are Constrained, Free, and Continuous.

Free Orbit displays an arcball on the screen in the form of a circle representing 
a sphere around the object. You click various places inside, outside, and on the 
arcball and then drag to change the 3D view. The idea is that you’re spinning an 
imaginary sphere containing the model. As you drag the cursor, AutoCAD updates 
the screen dynamically.

Constrained mode is pretty much like Free mode with training wheels in that you 
can orbit only horizontally and vertically.

Continuous mode lets you leave a mode spinning continuously. To change the 
orbit direction and speed, simply click-drag-release the mouse. The model orbits 
in the direction defined by the mouse motion, and the orbit speed is determined 
by how fast the mouse was moving when you released its button.

While you’re using the 3DOrbit command, right-click and select Other Navigation 
Modes to switch between the three modes on the fly.

You might also want to experiment with different projection modes:

 » Parallel projection is the default AutoCAD projection. Lines that are parallel in 
the 3D object remain parallel in the projected view on the screen.

 » Perspective projection makes objects look more realistic (for example, train 
tracks appear to converge in the distance), but lines that are parallel in the 
model don’t appear parallel in perspective projection.

If you manage to 3DOrbit out of control and can no longer see the model, right-
click to display the 3DOrbit shortcut menu and then choose Zoom Extents. The 
Zoom, Pan, and Preset Views options offer other ways to get the model back in 
your sights.
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When you start orbiting with no objects selected, AutoCAD tries to update the dis-
play of everything in the model in real time; with a complex 3D model, the process 
can take some time. To speed things up or to simply regain your bearings, select 
some objects before you start orbiting. Then AutoCAD updates the display of the 
selected objects only. When you exit Orbit mode, the entire model redisplays based 
on the new viewpoint.

Taking a spin around the cube
With so much talk about hybrid devices these days, Autodesk decided to create its 
own, in the form of the ViewCube (not in AutoCAD LT). The interactive ViewCube 
tool (see Figure 21-6) provides visual feedback about the current viewpoint, and 
allows you to set a preset view current or orbit the model, restore a named UCS, 
and define and restore the Home view of a model.

To change the view of the model by using the ViewCube, you can do one of the 
following:

 » Click a corner, an edge, or a face to align the current view with the same view-
point represented on the ViewCube.

 » Click and drag the main area of the ViewCube to orbit the view of the model.

 » Click one of the roll arrows to rotate the current view 90 degrees.

Compass Face Roll arrows EdgeCorner

Adjustment facet
triangle

ViewCube menu

WCS menuFIGURE 21-6:  
ViewCube, the 

multifunctional 
viewing device.
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 » Click one of the adjacent face triangles to switch to the adjacent orthographic 
view that is indicated by the triangle.

 » Click one of the letters (N, E, S, W), or click and drag the compass to rotate the 
view around the center of the drawing.

Home view is a special view you can define so that you have a known reference 
view in the model. That way, if you lose your bearings, you always have a way to 
get back home. You can restore Home view from the ViewCube or from the Steer-
ingWheels right-click menus.

Grabbing the SteeringWheels
SteeringWheels act as a kind of navigation hub that allows you to access several 
different 2D and 3D navigation tools from a single user interface. AutoCAD LT 
includes only the 2D Navigation wheel. AutoCAD (the full version) comes with the 
2D Navigation wheel and three other wheels that are designed to be used with 3D 
modeling. The three additional wheels are

 » View Object: Contains tools to center a model in the current view, zoom in 
and out, or orbit around a model.

 » Tour Building: Contains tools to move the viewpoint forward and backward, 
look around the model from a fixed location, and change the elevation of the 
current viewpoint.

 » Full Navigation: Contains a combination of the tools found on the 2D 
Navigation, View Object, and Tour Building wheels with the addition of tools to 
walk around or fly through a model.

All wheels include the Rewind tool, which allows you to restore a previous view. 
The Rewind tool is similar to the Previous option of the Zoom command.

When a wheel is active, move the cursor over the wedge that contains the tool 
you want to use. For many of the tools, you either click over the tool or click and 
drag to use the tool. Some tools support alternative versions of themselves when 
you press and hold the Shift key. To get an idea of what each tool does, hover 
the cursor over the tool to display a tooltip message. To read more about each 
of the wheels and the tools on them, see AutoCAD’s online Help system. To dis-
play the help that’s specific to the wheels, right-click when a wheel is displayed 
and choose Help from the shortcut menu.
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Visualizing 3D Objects
It really doesn’t seem like that long 
ago when the only way to view 3D 
models was in Wireframe mode, but 
the last several releases have dramat-
ically improved AutoCAD’s visualiza-
tion capabilities. It now has almost 
a dozen different display modes, 
called visual styles, that you can set 
with the click of a drop-down menu. 
Figure 21-7 shows the default visual 
styles, and you can add your own in 
the Visual Styles Manager palette.

Visual styles are collections of settings 
that determine how a 3D model is 
displayed.

 » 2D Wireframe: AutoCAD’s classic 2D viewing mode: full wireframe, dot-based 
grid, the 2D UCS icon, and no perspective.

 » Conceptual: An illustrative kind of shaded view. Colors are unrealistic and 
edges are heavy, but you get a good sense of the model’s form. Refer to 
Figure 21-3 to see an example of the Conceptual visual style.

 » Hidden: Looks slightly like Wireframe view (no surfaces are visible), but edges 
behind faces are hidden.

 » Realistic: Fully shaded, but not rendered visual style; edges are not displayed, 
and a default ambient lighting highlights the faces with different intensities 
of the object color. Materials and textures are visible if they’ve been applied. 
Have a look at Figure 21-8 for an example.

 » Shaded: Similar to Realistic, but with more subdued lighting. Textures do not 
appear in this visual style.

 » Shaded with Edges: Same as the Shaded visual style, except that isolines are 
set to be displayed.

 » Shades of Gray: Like Shaded, except that all object colors are changed to 
 different intensities of gray.

 » Sketchy: Does not apply shading to the faces of 3D objects, but gives the 
edges of 3D objects a hand-sketched look. Somehow, I’m not sure of the logic 
in spending several thousand dollars on hardware and software so that you 
can produce something that looks hand-sketched.

FIGURE 21-7:  
Some new styles to try on.
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 » Wireframe: Pretty much the same as 2D wireframe, except for background 
color, optional perspective, and the 3D (rather than 2D) UCS icon. Figure 21-4 
shows a simple model in the Wireframe visual style.

 » X-ray: Similar to Shaded with Edges, except that Materials and Textures are 
applied like the Realistic visual style, and faces are set to 50 percent opacity.

FIGURE 21-8:  
A manager 

for your visual 
styles.
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AutoCAD’s preconfigured visual styles are only the beginning. You can modify 
any of the styles and create new ones in the Visual Styles Manager palette (see 
Figure 21-8).

To display the Visual Styles Manager, click the dialog box launcher (the little arrow 
at the right end of the panel label) on the Visual Styles panel of the View tab, or 
enter VisualStyles or VSM at the command line and press Enter.

On a Render Bender
The different visual styles presented in this chapter are good for helping you navi-
gate while you’re working on a 3D model. But when it comes time to impress a 
client, you need to use photo-realistic rendering, which I discuss in Chapter 23.
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IN THIS CHAPTER

Understanding pros and cons of 
three-dimensional modeling

Setting up a 3D working environment

Creating 3D solid geometry

Editing 3D models

From Drawings  
to Models

For millennia, people have documented the design and construction of three-
dimensional objects by drawing two-dimensional views of them. Most people 
have continued to use these classical methods in CAD drafting because the 

methods are well understood and work reasonably well. After all, if 2D drawing 
was good enough for guys like Leonardo da Vinci and Andrea Palladio, it should be 
good enough for you, right?

Nonetheless, the past decade or two has seen a trend toward creating 3D CAD 
models and letting the software generate the 2D views more or less automati-
cally. This approach seems more logical, especially if the project documentation 
requires numerous complex views of the same object. Three-dimensional model-
ing is an absolute necessity when you want to create rendered views for presenta-
tion purposes.

And although AutoCAD 3D construction and visualization tools have improved 
dramatically over the years (trust me — you should have seen their behavior as 
recently as AutoCAD 2006!), 3D modeling is still a complex process that requires 
sophistication on the part of the AutoCAD user. Although 3D modeling requires 
only one dimension more than 2D drafting, developing 3D CAD models can seem 
to be more complicated because it involves five more planes. Think of a sheet of 
paper versus the faces of a cube. Users must master new techniques and contend 
with the 2D limitations of most display screens and input devices. On the other 

Chapter 22
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hand, after you have the 3D model, generating traditional 2D drawing views – 
such as front, top, and detail views — is almost trivial.

In Chapter 21, I show you how to move around models that others have made, and 
I explain the principles of 3D coordinate systems that you need to understand to 
work in the AutoCAD 3D environment. This chapter introduces you to the con-
cepts, tools, and techniques of AutoCAD 3D modeling; here, you can get your feet 
wet creating your own 3D objects.

Full 3D support is one main difference between full AutoCAD and AutoCAD LT. If 
you’re using AutoCAD LT, you can look at and plot 3D models created in AutoCAD, 
but you can’t do much 3D object creation or editing yourself. Also, viewing 3D 
models is less flexible in AutoCAD LT because it lacks nearly all the 3D navigation 
and rendering tools included in the full version of AutoCAD.

Is 3D for Me?
Traditional 2D drawings provide clues to help the viewer mentally construct a 
3D model from the 2D image on paper. Multiple views from different viewpoints 
in 3D space give experienced designers, drafters, builders, and tradespeople the 
information they need to make “3D sense” of 2D drawings. Design and drafting 
have succeeded pretty well by using 2D representations as guides to creating 3D 
objects. But at some point, nothing can replace a true 3D model, such as in helping 
someone understand how a building will look when it’s constructed or how two 
parts fit together.

What does “using 3D in AutoCAD” mean? Fundamentally, it means that you cre-
ate models instead of drawings. Rather than generate cross sections of an object or 
individual views of it from certain perspectives, you create a three-dimensional 
model of the object. This 3D depiction of each object includes all the necessary 
information for AutoCAD to create a drawing view from any point of view. Using 
a properly constructed 3D model, AutoCAD can output commands to machines 
to create actual 3D objects, whether they’re 3D printed or created by computer-
controlled machine tools.

As I explain in Chapter 21, AutoCAD can create three types of 3D models: wire-
frame, surface, and solid. In most practical applications of 3D, you select only one 
type for all or most of the objects in the drawing, based on ease of construction 
and the intended use of the model. However, AutoCAD doesn’t prevent you from 
mixing all three types of 3D objects in the same drawing.

After you determine the type of 3D representation to use, you decide on the appro-
priate level of detail and construct the model, using the commands and techniques 
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introduced in this chapter. If you need to, you can go on from there to create any 
required 2D or rendered views (or both) for plotting or viewing onscreen.

Getting Your 3D Bearings
The first challenge in 3D modeling is being able to see a three-dimensional model 
on a two-dimensional computer screen. The normal model space view on the 
Model tab in the drawing area shows a single, projected 2D view of the model — 
the top-down, plan view by default.

AutoCAD provides two model space capabilities that enable you to escape this 
visual flatland:

 » Viewport: Carve the model space drawing area into smaller rectangular areas, 
each of which shows a different view of the model.

 » Viewpoint: Change the point in 3D space from which you look at the model. 
By setting a different viewpoint in each viewport, you can look at several sides 
of the model at the same time. It’s like looking at one of Picasso’s cubist paint-
ings, except that what you see is more orderly.

No matter how much or how little 3D modeling you’re thinking about doing, it’s 
well worth your while to set up a template. I fill you in on drawing templates 
in Chapter 4. If you’ve ever started a new drawing, you’re probably aware that 
AutoCAD already comes with a template for 3D modeling named acad3d.dwt (or 
acadiso3D.dwt, for the metrically inclined). This is fine as far as it goes, but it 
shows only a single view of the model. The next section explains how to improve 
on this template.

Creating a better 3D template
Model space viewports enable you to see several views of the model at one time, 
each from a different viewpoint. For this reason, model space viewports are espe-
cially useful when you’re creating and editing objects in 3D. As you draw and edit, 
the different views help ensure that you’re picking points that are located cor-
rectly in 3D space.

Chapter 12 discusses viewports in paper space, which are useful for creating lay-
outs for use in plots and presentations in both 2D and 3D. Model space viewports, 
which are cousins of paper viewports, are less flexible but simpler, and they’re a 
great help in constructing 3D models.
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Model space viewports divide the screen into separate rectangles with no gaps 
between them. Unlike when you use paper space viewports, you can’t move or 
overlap model space viewports. Starting with AutoCAD 2015, however, you can 
drag a viewport boundary to resize it. When you do this, adjacent viewports also 
re-size themselves in order to maintain the “no gaps or overlaps” rule. You can’t 
plot multiple model space viewports; that’s what paper space is for. And, unlike 
the situation in layouts, a layer that’s visible in one model space viewport is 
always visible in all of them.

You may hear or read references to the tiled viewport, which is just another name 
for the model space viewport. Tiled refers to the way in which model space view-
ports always fill the drawing area, with no gaps and no overlapping allowed. Con-
versely, paper space viewports are sometimes called floating viewports because 
you can move them around, leave gaps between them, and overlap them.

One of the best 3D viewing features goes by the somewhat obscure title of the 
in-canvas viewport control. This little text label that you may have noticed at the 
upper-left corner of the graphic area (see Figure 22-1, for example) is a clickable 
control that lets you set the visual style and the view. What’s especially nifty is that 
double-clicking the plus or minus sign toggles the drawing area between multiple 
tiled viewports already configured for 3D viewing and a single, maximized view-
port. Out of the box, double-clicking the minus (–) sign switches to four view-
ports of equal size showing different views of the geometry. In the figure, you see 
four viewports, four different viewpoints, and four different visual styles. That’s 
extreme for everyday work, but it gives you an idea of the possibilities.

I highly recommend working with multiple viewports when you’re modeling in 
3D. That way, you get to see exactly what you’re doing in all three dimensions 
simultaneously, in real time. My preference is to work mostly in the isometric 
viewport, so I make that one larger than the other three. The in-canvas viewport 
toggle switches back and forth between the last multiple viewport you set up and a 

FIGURE 22-1:  
3D viewing 
from every 
which way.
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maximized viewport. Follow these steps to set up the tiled-viewport configuration 
shown in upcoming Figure 22-2:

1. Switch to the 3D Modeling workspace if you’re not already in it.

Click the Workspace Switching button on the status bar and select 3D 
Modeling. Or in AutoCAD 2016 and earlier, you can also click the Workspace 
drop-down list on the Quick Access toolbar and choose 3D Modeling. If the 
Materials Browser palette opens, close it.

2. Click New on the Quick Access toolbar to open the Select Template  
dialog box.

If a new, blank drawing appears and you don’t see the Select Template dialog 
box, someone has assigned a default template to this button in the Options 
dialog box. In that case, click the Application button (the Big Red A) and choose 
New, and then choose Drawing from the submenu.

3. Choose acad.dwt (choose acadiso.dwt if metric is your preference), and click 
Open.

Yes, I know about the ready-made 3D templates (acad3d.dwt and acadiso3d.
dwt), but trust me — starting this setup is easier from a 2D template.

4. From the Model Viewports panel on the Vizualize tab of the Ribbon, 
choose Named.

The VPORTS command starts and the Viewports dialog box appears.

5. Click the New Viewports tab to make it current; then choose Four: Left  
(my preference) or Four: Right from the Standard Viewports list box.

The Preview panel shows a large, squarish viewport occupying most of the 
work area, with three small, squarish viewports stacked on the left (or right). 
The default 2D setup shows the visual style of all four viewports as 2D 
Wireframe. I explain visual styles in Chapter 21.

6. From the Setup drop-down list, choose 3D.

The visual styles remain as 2D Wireframe, but the view direction (listed as 
Current in 2D Setup) is now SE Isometric in the large viewport, and the three 
small viewports show Top, Front, and Right orthographic views.

When modeling in 3D, look at objects in different ways at the same time. When 
looking at orthographic views (as in drafted drawings), you may want to see all 
your linework. But you can get a better sense of the three dimensionality of the 
model by looking at it in a shaded view. By using multiple viewports, you can 
do both at the same time.
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7. In the Preview area, click inside the large SE Isometric viewport and then 
choose Conceptual from the Visual Style drop-down list.

You’re almost finished. Rather than complete this setup every time you want to 
do some modeling, give the new viewport configuration a name.

8. In the New Name box at the top of the Viewports dialog box, enter a name 
such as V3D, for example, for the configuration.

Figure 22-2 shows the new, named viewport configuration. After you close the 
Viewports dialog box, you can restore this configuration at any time by clicking 
the Named Viewports tab, choosing V3D, and clicking OK.

9. Click OK to save the viewport configuration and close the Viewports  
dialog box.

In Figure 22-3, I turned off the grid in the three small orthographic viewports, 
but whether you leave it on or turn it off is a matter of personal preference.

The Home button in the ViewCube can trip you up by changing to a view you 
don’t expect. I introduce the ViewCube in Chapter 21. If you want to keep the 
current SE Isometric viewpoint, be sure to reset the Home view. To do this, 
simply right-click anywhere in the ViewCube and choose Set Current View as 
Home from the menu that appears. And because you’ve gone to the trouble of 
setting up a shaded 3D viewport, you might want to make it a little more 
realistic and turn on perspective mode at the same time.

Personal preference rules here, but architects tend to use perspective, and 
mechanical designers use parallel views.

FIGURE 22-2:  
Setting up a 3D 

work environ-
ment in the 

Viewports 
dialog box.
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10. In the large 3D viewport, right-click the 
ViewCube to display its shortcut menu and 
then choose Perspective with Ortho Faces 
(see Figure 22-4).

Selecting Perspective shows the orthographic 
views in Perspective mode, and usually you don’t 
want that. Selecting Perspective with Ortho Faces 
resets the projection mode from Perspective to 
Parallel when you switch to an orthographic view.

11. Repeat Step 10, this time selecting Set Current 
View as Home.

Now you can readily return to this viewport configuration, keeping the same 
viewpoint in all viewports, perspective projection in the 3D viewport, and 
parallel projection in the orthographic viewports.

To return to a single viewport later, simply click the plus (+) sign on the 
in-canvas viewport control.

The last thing to do is save the configuration you just set up as a template 
(.dwt) file.

12. Click Save on the Quick Access toolbar. From the Files of Type drop-down 
menu, choose AutoCAD Drawing Template (*.dwt) and enter a filename. 
Click Save.

AutoCAD saves the new 3D template file in the same location as your other 
templates so that you can always select it when you want to do some serious 
3D modeling.

FIGURE 22-3:  
It’s 2D and  

3D all at the 
same time.

FIGURE 22-4:  
Changing settings in the right-
click menu in the ViewCube.
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Seeing the world from new viewpoints
When you choose 3D in the Setup drop-down list in the Viewports dialog box, 
you direct AutoCAD to change the viewpoint in each viewport. The default view-
points when you choose a four-viewport arrangement are top, front, right, and SE 
(southeast) isometric. These viewpoints work well for viewing and constructing 
simple models, but eventually you may want to specify your own, custom view-
point in a particular viewport.

In both AutoCAD and AutoCAD LT, the best (but not 
the easiest) way to change viewpoints is to use the 
drop-down list in the Views panel of the View tab, as 
shown in Figure 22-5, to switch to a standard ortho-
graphic 3D view or an isometric view:

 » The six standard orthographic (straight-on) 
views: Top, Bottom, Left, Right, Front, and Back.

 » The four standard isometric views: SW (left-
front), SE (right-front), NE (right-back), and NW 
(left-back). An isometric view is one in which you 
see the object from above, but not from too high 
above, as though you were hovering in a low-flying 
helicopter or receiving an image from a remote-
operated drone, if they are still legal by the time 
you read this.

The easiest (but not the best) way to change view-
points is to click a named face on the ViewCube (not 
available in AutoCAD LT). I don’t recommend this 
strategy because the ViewCube is only a viewing aid. 
You usually change to an orthographic view because you want to do some drawing 
or modeling there, and for that task, the user coordinate system (UCS) ought to 
orient itself with the view. See Chapter 21 for the skinny on UCSs. Clicking Front 
on the ViewCube shows you a nice front view of the model, but it leaves the UCS 
unchanged, and that can make drawing anything difficult. Clicking Front in the 
Views panel on the View tab does change the UCS to Front so that it matches the 
view and lets you draw without difficulty.

These ten views are standard because they’re often used in manual drafting and 
rendering work. They work well for showing 3D models of common objects such 
as mechanical components and buildings. You can also change to plan view, which 
is a top-down view of either the world coordinate system or a user coordinate 
system. I describe coordinate systems in Chapter 21.

FIGURE 22-5:  
The preset views drop-down 
menu.
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The full version of AutoCAD has the ViewCube, the 3DOrbit command, and the 
Shift+middle mouse button methods of changing 3D viewpoints. All are described 
in Chapter 21. The options in AutoCAD LT are much more limited — you can set 
nonstandard viewpoints by typing ddVPoint and pressing Enter. In the Viewpoint 
Presets dialog box that appears, specify these settings:

 » A viewing angle in the X,Y plane: Imagine moving a camera on a dolly around 
an object while keeping the camera at the same elevation.

 » An angle from the X,Y plane: Imagine using a boom to swoop the camera to 
a different height so that you’re looking at the object from increasingly steep 
angles.

AutoCAD users can set viewpoints the same way, but it’s grossly inefficient com-
pared with the other viewing options.

By default, AutoCAD shows 3D models in 2D wireframe mode, even if you’ve cre-
ated surface or solid objects. If you want to better visualize which objects are in 
front of which other objects, especially in an isometric or other non-orthogonal 
view, you have a couple of options:

 » Select a shaded visual style such as Realistic, Conceptual, X-Ray, or Shades of 
Gray, from the Visual Styles drop-down list on the Visual Styles panel of the 
View tab. See Chapter 21 for the lowdown on visual styles.

 » Render the model, as described in Chapter 23.

AutoCAD LT doesn’t include visual styles because they’re not much use in 2D 
drafting. A drawing saved in a visual style in the full version of AutoCAD does 
display that style when it’s opened in AutoCAD LT. However, you have no way to 
change it to 2D wireframe (or anything else) so that you can work on it.

From Drawing to Modeling in 3D
This section introduces three techniques for creating 3D objects: drawing 3D lines 
and polylines, creating 3D objects from 2D geometry, and creating solids. In Auto-
CAD LT, you can use only the first two techniques. AutoCAD is also quite capable 
at surface modeling, offering both freeform mesh and NURBS surfaces. If you’re 
interested in either of these, check out the online Help system; in the Search 
field, enter creating meshes or surface models. Topics include creating surfaces and 
meshes from scratch and creating solids and surfaces from 2D objects.
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When you draw 3D objects (as when you draw 2D objects), place them on appro-
priate layers and use precision techniques to specify each point and distance. See 
Chapter 8 for more information about precision techniques.

Drawing basic 3D objects
The most basic forms of 3D geometry are wireframe-like objects created by pick-
ing points or entering X,Y,Z coordinates. These objects have no surfaces, so they 
look the same in 2D Wireframe mode or photorealistic renderings. They’re most 
useful as paths for sweeps and lofts, or as edges for surface creation. Basic 3D 
objects include the ones described in this list:

 » Line: The line is a 2D object; although you can specify different Z coordinates 
for start points and endpoints so that they’re not coplanar with the world 
coordinate system, each individual segment is based on its own 2D plane. You 
can, however, use the line for constructing objects in 3D space.

 » 3D Polyline: This object, created by using the 3DPOLY command, is similar to 
the 2D polyline that I describe in Chapter 6, except that the vertices of a 3D 
polyline can have different Z coordinates: a 2D polyline must be planar. Three-
dimensional polylines are useful as paths for sweeps or for fly-throughs. I 
don’t cover walk-throughs or fly-throughs in this book.

 » Spline: This free-form curve is created by using the SPLine command. I 
describe it in a 2D context in Chapter 7. Splines are 3D objects, and vertices 
can have different Z values. The spline is a better option than the 3D polyline 
for sweeps because it has smoother curves.

 » Helix: A helix can be either 2D (think of a mosquito coil or the element on an 
electric range) or 3D (think of Mr. Slinky). It’s made by using the HELIX com-
mand and is especially useful as a path for threaded objects.

You can find the Line, 3DPOLY, and SPLine commands in the Draw panel on the 
Home tab of the Ribbon; the HELIX command is on that panel’s slideout.

The 3DPOLY command is similar to the PLine (plain old 2D polyline) command. 
Though both commands draw a series of connected line segments, they have dif-
ferent capabilities:

 » The 3DPOLY command accepts 3D points for the line segments’ vertices. The 
PLine command requires that all vertices be on the same plane.

 » 3DPOLY is limited to straight line segments. The PLine command can draw arc 
segments and create segments with a uniform or tapered width.

 » Segments created using 3DPOLY can’t display dash-dot linetypes, so 3D poly-
line segments always display as continuous lines.
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The command sequence for drawing 3D segments with the Line or 3DPOLY com-
mand is the same as for drawing 2D segments with the Line or PLine command; 
see Chapter 6 for information on drawing lines. The only difference is that you 
specify 3D coordinates instead of 2D ones. Figure 22-6 shows an example.

Creating 2D representations in this way is straightforward, although tedious, for 
all but the simplest objects. More important, a wireframe model becomes increas-
ingly difficult to decipher as the complexity of the model increases. You see a 
mass of lines representing the edges, and you have difficulty telling which parts 
of which edges are in front of others. To reduce this visual confusion, you need to 
graduate to surface or solid modeling commands. I introduce you to solid model-
ing later in this chapter.

Gaining a solid foundation
Solid modeling is in many ways the culmination of 3D CAD. Solids more accurately 
represent most real-world objects than do wireframes or surfaces. And even when 
representational accuracy isn’t the main issue, it’s easier to construct many kinds 
of models with solids.

Many special-purpose solid modeling programs use a combination of solid and 
surface modeling techniques for maximum flexibility in constructing and edit-
ing 3D models. These kinds of programs — and solid modeling in general — are 
especially popular in mechanical design.

FIGURE 22-6:  
Entering 3D 
coordinates 

to draw a 3D 
polyline.
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Constructing the basic building blocks, or solid primitives, for a solid model in 
AutoCAD isn’t difficult. Just follow these steps:

1. Define a suitable user coordinate system (UCS).

The UCS controls the construction plane and basic 3D orientation of the solid. 
Read about changing planes in Chapter 21.

2. Click the down arrow below the leftmost button in the Modeling panel on 
the Home tab, and then choose a solid primitive from the drop-down list.

As shown in Figure 22-7, your choices are Box, 
Cylinder, Cone, Sphere, Pyramid, Wedge, and 
Torus.

When you see a 3D object in a drawing, you can’t 
tell by looking whether it’s a 2D extruded object, 
surface mesh, or solid — to find out, open the 
Properties palette and select the object. The drop-
down list at the top of the palette shows the type of 
object you selected.

Drawing solid primitives
Solids are the easiest kinds of object to work with 
if  you’re new to 3D. The two types of 3D solid  
object are

 » Primitive: The most basic of 3D building blocks, 
such as boxes, cones, and spheres. Primitive sol-
ids are based on simple geometric shapes, such 
as lines and circles.

 » Complex (or compound): Made by combining 
primitive solids and (optionally) editing them with 
Boolean operations. The following sections focus on creating and modifying 
3D solids.

Boolean editing operations (named for the Victorian English mathematician 
George Boole) use arithmetic-like functions to combine solid objects or remove 
parts of them. The three primary Boolean commands in AutoCAD are UNIon, 
 SUbtract, and INtersect. See “Boolean operations,” later in this chapter, for more 
information.

FIGURE 22-7:  
Everything you need for a solid 
foundation.
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Adding the Third Dimension to 2D Objects
The 2D roots of AutoCAD run deep. Drafting continues to be the primary focus of 
the program, but recent AutoCAD releases shifted focus to become increasingly 
more adept at 3D modeling. This section invites you to create new 3D objects from 
(what I presume is an abundance of) 2D objects.

You can create 3D objects from 2D objects by using a number of different tech-
niques. You can add thickness or extrude an open 2D object to create a surface, or 
take multiple 2D cross sections and create a lofted object that adapts to the shape 
and size of each cross section that’s selected.

Everything mentioned in this main section applies only to AutoCAD (not to Auto-
CAD LT), with the exception of the thickness property.

Adding thickness to a 2D object
Most 2D objects, such as lines and circles, have a thickness property. Changing the 
thickness property of a 2D object doesn’t create a true 3D object, but it does cre-
ate a pseudo-surface that looks like a 3D surface. These pseudo-surfaces can hide 
objects beyond them, but they have limitations. If you add thickness to a circle, 
an open cylinder is created without caps on the top and bottom. If you change the 
thickness of a rectangle (which is a polyline), you end up with four walls but no 
top or bottom.

Extruding open and closed objects
Thickness is one way of adding height to an object, but extruding an object is 
usually a better approach. You can extrude open or closed 2D objects to create a 
3D object. Extruding a closed 2D object (such as a closed polyline, spline, ellipse, 
circle, or region) creates a 3D solid. Extruding an open 2D object (such as an open 
polyline, spline, line, or arc) creates a 3D surface. Figure 22-8 shows the result of 
extruding open and closed objects.

If you want to end up with a 3D solid, you must extrude a single, closed object, 
such as a circle or a closed polyline. If you want to produce a 3D solid from a 
boundary composed of multiple objects, read about PRESSPULL in the later sec-
tion “Pressing and pulling closed boundaries.”
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To extrude an open or a closed 2D object, click Extrude in the Solid panel on the 
Solid tab, or click the Extrude split button in the Modeling panel on the Home tab. 
If you see a button labeled Loft, Revolve, or Sweep, click the lower part of the split 
button and choose Extrude from the drop-down menu. Use the MOde option to 
control whether you create a surface or 3D solid from a closed object, select the 
objects you want to extrude, and specify an extrusion height or distance to create 
the 3D solid.

The DELOBJ system variable controls whether the 2D objects you use to create 
3D solids are retained or erased. Most of the time, you’ll want to keep the source 
geometry, but the default DELOBJ setting erases it. If you want to keep the original 
2D geometry, type DELOBJ and set its value to 0. See Chapter 23 for more about 
system variables. DELOBJ also controls whether the source objects for associative 
arrays (introduced in Chapter 18) are retained or deleted.

Pressing and pulling closed boundaries
The PRESSPULL command allows you to create 3D geometry by extruding a 
closed boundary. PRESSPULL differs from EXTrude in that the EXTrude command 
requires a single, closed 2D object, whereas PRESSPULL can use closed boundaries 
formed by other 3D solids, or by several objects that form a closed region. PRESS-
PULL searches for a suitable boundary in exactly the same manner as the Hatch 
command, which I cover in Chapter 15.

To press or pull within a closed boundary to create a 3D object, click Presspull in 
the Solid panel on the Solid tab, click inside an enclosed boundary, and then drag 
or specify the distance on the extrusion you want to create.

FIGURE 22-8:  
Converting 2D 

to 3D by  
extrusion is as 
easy as 1-2-3.
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Lofting open and closed objects
Lofting lets you select a series of 2D cross sections to create surfaces or 3D solids of 
varying cross sections, such as aircraft wings. The selected cross sections define 
the outer surface that’s generated. You must select a minimum of two cross sec-
tions. If you select open objects, the resulting loft is a 3D surface; if you select 
closed objects, the resulting loft can be either a surface or 3D solid, depending on 
the current value of the MOde option for the LOFT command.

You can loft objects along a path by using guide curves, or only between selected 
cross sections, as shown in Figure 22-9. To loft open or closed 2D objects, open 
the Sweep/Loft drop-down menu in the Solid panel on the Solid tab. Use the MOde 
option to control whether you create a surface or 3D solid from a closed object 
cross section, and specify how the loft object should be calculated.

Sweeping open and closed  
objects along a path
Sweeping is similar to extruding a 2D object except that you specify a path rather 
than a height or distance. The object used as the path can be either an open or a 
closed 2D object and can be only a single object, as shown in Figure 22-10. If you 
sweep an open object, the resulting swept object is a 3D surface; if you sweep a 
closed object, the resulting swept object is a 3D surface or 3D solid based on the 
current value of the MOde option of the SWEEP command. To sweep an open or a 
closed 2D object, open the Sweep/Loft drop-down menu in the Solid panel on the 
Solid tab. Use the MOde option to control whether you create a surface or 3D solid 
from a closed object, select the objects to sweep, and specify a path for the sweep.

FIGURE 22-9:  
Using cross 
sections to 

create a lofted 
object.
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Revolving open or closed  
objects around an axis
Revolving lets you create a 3D surface or 3D solid by turning selected objects 
around an axis, as shown in Figure 22-11. If open objects are selected, the resulting 
revolved object is a 3D surface; if you select closed objects, the resulting revolved 
object is a 3D solid.

To REVolve an open or a closed 2D object, click Revolve in the Solid panel on the 
Solid tab, or click the Revolve split button in the Modeling panel on the Home 
tab. If you see a button labeled Loft, Extrude, or Sweep, click the lower part of the 
split button and choose Revolve from the drop-down list. Use the MOde option to 
control whether you create a 3D surface or 3D solid from a closed object, select the 
objects to revolve, and specify the axis to use.

FIGURE 22-10:  
Sweeping a 

closed object 
along a path.

FIGURE 22-11:  
Revolving a 

closed object 
around an axis.
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Modifying 3D Objects
Many modification techniques and commands that you use in 2D drafting can be 
applied to 3D modeling. In addition, a specialized set of 3D editing commands is 
available. All these commands are in the Modify panel on the Home tab when the 
3D Modeling workspace is current.

Selecting subobjects
Three-dimensional objects themselves are complex objects that can be made up 
of several hundred, or perhaps even thousands, of objects. Although these objects 
never stray from their parents, you can access them individually or in groups via 
subobject selection: selecting a vertex, an edge, or a face of a 3D object. After you 
select a subobject, you can use grip editing and the 3D gizmos (discussed in the 
later section “Working with gizmos”) to manipulate it.

To more easily select subobjects, you can enable subobject filtering from the  
Ribbon. Vertex, edge, and face filters are located on the Subobject Selection Filter 
split button in the Selection panel on the Home and Solid tabs.

The CULLINGOBJ and CULLINGOBJSELECTION system variables help limit object 
selection to the faces that are visible in the current view by ignoring faces around 
the back of the objects being viewed. By default, both these variables are turned 
off, so you can select objects in front and behind. If you have a complex model, 
turn on culling by clicking Culling in the Selection panel on the Home tab. To turn 
off culling, click the Culling button again. The button is shaded blue when the 
feature is enabled.

If you need to select only a face on a 3D object, press and hold the Ctrl key and 
select the face you want to select. This method can be faster than turning subob-
ject filters on and off.

Working with gizmos
Although you can use the Move, ROtate, and SCale commands to modify 3D 
objects, they can sometimes give unexpected results in 3D. Enter the 3DMOVE, 
3DROTATE, and 3DSCALE commands, which all use a gizmo or grip tool when a 
non-orthographic view is current (see Figure 22-12).
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A gizmo restricts or constrains movement along the X,Y plane and the Z-axis. To 
use a gizmo, click an axis on the tool to restrict movement to that axis. You can 
access the three gizmos by using these methods:

 » 3DMOVE: Click 3D Move in the Modify panel on the Home tab, or type 
3DMOVE at the command line.

 » 3DROTATE: Click 3D Rotate in the Modify panel on the Home tab, or type 
3DROTATE at the command line.

 » 3DSCALE: Click 3D Scale in the Modify panel, or type 3DSCALE at the com-
mand line.

You can also access the Move, Rotate, and Scale gizmos in 3D by selecting objects 
when no command is active. You can set the default gizmo that is displayed when 
you use grips in 3D by opening the Gizmo drop-down menu in the Selection panel 
on the Home tab and selecting the gizmo that you want to be active. Right- clicking 
a gizmo lets you switch between different gizmos and constraints.

More 3D variants of 2D commands
Moving, rotating, and scaling objects are certainly the Big Three operations of 3D 
editing, but a number of other 3D variations on 2D editing commands are hiding 
in the wings, awaiting their turns in the spotlight. For more about spotlights, see 
Chapter 23.

Getting your 3D ducks in a row
Making objects align with each other in 3D can be a challenge at times, especially 
if you need to not only move an object in 3D but also rotate and scale it based on 
the specified alignment. AutoCAD has two commands you can use to align objects:

 » ALign: Used to align 2D and 3D objects based on one, two, or three pairs of 
points. Based on the number of pairs of points that are specified and how 
they’re selected, the ALign command might move and rotate the selected 
objects into place. It can also be used to scale objects. On the Home tab, 
choose Align from the Modify panel slideout.

Move Rotate Scale

FIGURE 22-12:  
Using gizmos 

to modify 
objects in 3D.
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 » 3DALign: An improved version of the ALign command that includes additional 
options as well as the ability to move and rotate a copy of the selected objects 
and use Dynamic UCS with the command. Click 3D Align in the Modify panel 
on the Home tab.

Holding up a mirror
The MIrror command is limited to working on the X,Y plane. If you want to mir-
ror objects in 3D, you use the MIRROR3D command. Click 3D Mirror in the Modify 
panel on the Home tab. The MIRROR3D command is similar to the MIrror com-
mand, but you can control the plane on which the mirroring is performed.

The generic 2D MIrror command works also in 3D, but you must employ a trick. As 
indicated in the preceding paragraph, MIrror works only in the X,Y plane — but it 
doesn’t have to be the World X,Y plane. The command works equally well in the 
X,Y plane of the current User Coordinate System (UCS).

Associative arrays, which I discuss in Chapter  18, work in 3D as well as in 2D. 
AutoCAD has long had the 3DARRAY command; it’s similar to the old-style ARray 
command (refer to Chapter 11 to read about that one) in that it doesn’t create an 
associative array object. For information on creating rectangular, polar, and path 
array objects, refer to the online Help system.

Editing solids
You can edit 3D solids in a variety of different ways that you can’t edit other 
objects. You can use grip editing to change the shape of 3D solids, or use Boolean 
operations on a 3D solid to create complex models. You can fillet and chamfer the 
edges of a 3D solid by using the FILLETEDGE and CHAMFEREDGE commands.

Using grips to edit solids
Grip-editing is one of the most direct ways to modify an object. To edit a 3D solid 
by using grips, select the 3D solid when no command is running, and then select 
the grip that you want to use to edit the solid. Pay close attention to the grip you 
select; some grips give you control over changing the overall size of a solid; oth-
ers might change only part of a solid, such as the face or top radius of a cone. 
 Figure 22-13 shows a pyramid with its top radius being edited with grips.
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Boolean operations
As I mention in the earlier “Drawing solid primitives” section, you can join 3D 
solids by using the UNIon command to create a new 3D solid. You can also subtract 
volume from a 3D solid by using another, intersecting 3D solid to determine what 
should be removed with the SUbtract command. The INtersect command can be 
used to calculate a new 3D solid based on the volume that is common to two or 
more intersecting 3D solids. See Figure 22-14 for examples. You can find these 
three commands in the Boolean panel on the Solid tab.

Boolean operations are probably the most-used of the 3D commands. Yes, primi-
tive solids such as a box or a wedge are easy to use, but most real-world 3D objects 
are more complex than the simple primitives. Something as apparently simple as 
a connecting rod on a car engine might require a dozen or so Boolean operations 
to add and subtract simpler solids until you arrive at the final design.

FIGURE 22-13:  
Grip editing a 

pyramid.

FIGURE 22-14:  
Solid  

primitives on 
the left, and 

the result 
of using 

the UNIon, 
SUbtract, 

and INtersect 
 commands.
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You will often need to change to a different user coordinate system (UCS) before 
placing the next subobject to be combined with the base object. The easiest way 
to do this is to turn on UCSDETECT (F6) on the status bar. Then, as you move the 
cursor around while a create command is active, AutoCAD will automatically snap 
the UCS to any planar surface that it passes over.

Filleting and chamfering
Because fillets and chamfers are common real-world features, it’s logical that 
tools for creating them are available. You can fillet or bevel the edges of a 3D solid 
by clicking the Fillet Edge (or Chamfer Edge) split button in the Solid Editing 
panel on the Solid tab.

Both commands allow you to select multiple edges to fillet or bevel. When you 
select an edge, AutoCAD gives you feedback on how the selected edge will be 
affected. Figure  22-15 shows an L-shaped 3D solid that has been filleted and 
chamfered.

To remove a fillet or chamfer, start the Erase command. Then, at the Select 
Objects prompt, hold down the Ctrl key and select the fillet or chamfer to be 
removed. For fillets, you may need to also remove nearby filleted corners that 
might have been created during the application of the fillet.

The FILLETEDGE and CHAMFEREDGE commands were new in AutoCAD 2011. You 
can still use the Fillet and CHAmfer commands on 3D solids, but the new com-
mands are much more efficient.

Slice
The SLice command lets you cut a 3D solid along a plane. You can slice a 3D solid 
by using a planar curve, such as a circle, 2D polyline, or surface, among many 
others. When you slice a 3D solid, you can choose which part of the 3D solid is 
retained, or you can keep both. Figure 22-16 shows a solid model that has been 
sliced in half.

FIGURE 22-15:  
Before  

and after  
filleting and  

chamfering a 
3D solid.
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To start the SLice command, choose Slice from the Solid Editing panel on the Solid 
tab. After the command is started, specify a 3D solid to slice, an axis or object to 
define the cutting plane, and then, finally, which new 3D solids to keep.

FIGURE 22-16:  
Carving up a 
solid model 

with the SLice 
command.
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IN THIS CHAPTER

Creating 2D working drawings from 
3D models

Visualizing 3D models

Lighting your models

Applying materials

Assigning a background

Applying render presets to 3D models

It’s Showtime!

The word design has the same Latin origin as designate: “to point out to or to 
show to others.” If you have an idea and produce it yourself, you aren’t a 
designer — you’re an artist or a craftsman (not that there’s anything wrong 

with that). You don’t become a designer until you tell someone else about your 
idea so that they can do all the dirty, heavy work of producing it.

Two-dimensional orthographic drawings date to Roman times, but only in the 
past few years have I seen a significant change in how things are designed — and 
how designers communicate their visions to others. No, I don’t mean 2D CAD on 
a computer, because that’s simply a more efficient way of producing Roman-style 
drawings. The world we live in is 3D, but paper is 2D. Orthographic engineering 
drawings were developed for the sole purpose of transferring the designer’s 3D 
idea into 2D format. The recipient of the drawing then transfers the idea back into 
3D, first as an image in the mind and then as the physical object.

The significant change is that low-cost computers are now powerful enough, and 
software is becoming sophisticated enough, to let designers work in 3D on their 
personal computers. At the same time, 3D printers can now use a 3D model on 
your computer to produce a real-world object. This type of printer was originally 
developed with mechanical designs in mind, but architectural designers are also 
using it to print scale models of their buildings. More recently, the scale factor 
for printing buildings has become 1:1. That’s right: Full-scale concrete five-story 

Chapter 23
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apartment blocks are being printed in 3D directly from the computer model! How-
ever, the real world still needs (or at least wants) 2D drawings.

Going the other way, or at least going even further into the 3D world, relatively 
low-cost computers and powerful software make it possible for designers to pro-
duce photorealistic rendered images of their 3D models. Clients and customers can 
see the product before it becomes real.

I start this chapter by showing you how to generate 2D drawings from 3D models, 
and then move on to discuss rendering.

Get the 2D Out of Here!
Would you believe that it took less than five minutes to produce Figure 23-1?

Follow these steps to produce a 2D view from a 3D model:

1. Click the Workspace Switching button on the status bar, and then choose 
3D Modeling.

Toolbars, palettes, and Ribbon panels flash on and off, and soon AutoCAD 
settles down to display the Ribbon, as configured for the 3D Modeling 
workspace with a few additional panels.

FIGURE 23-1:  
A drawing, in 
less than five 

minutes!
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2. Set up a 3D model.

Create a new model by using the techniques I discuss in Chapters 21 and 22, or 
open an existing file that contains a 3D model.

You can find the files I use in this step list at this book’s companion website: Go 
to www.dummies.com/go/autocadfd17 and download afd23.zip. The 
drawing named afd23a.dwg contains the model I use in the following steps.

3. Switch to paper space.

Click the Layout 1 tab near the lower-left corner of the screen.

4. Delete the existing viewport by clicking the viewport object (the frame of the 
viewport) and then pressing Delete.

By default, new drawings created from a standard template file contain a 
single viewport. If you’ll frequently create new drawings like this, set up a 
template file with the viewport already deleted. I cover templates in Chapter 4 
and paper space layout viewports in Chapter 12.

5. Click the Base button from the Create View panel on the Layout tab of 
the Ribbon, and then choose From Model Space from the drop-down list.

The VIEWBASE command creates several new layers automatically. By default, 
they’re the opposite of the screen color (black or white), but they always print 
in black. You can change these layers to any color you want (see Chapter 9).

6. Position the base view.

AutoCAD automatically selects what it thinks is an appropriate scale, assuming 
that you’ll place the three standard orthographic views and one pictorial view. 
However, you can change it. Select a suitable place in the lower-left quadrant 
of the layout sheet.

The Drawing View Creation contextual tab appears on the Ribbon (as shown in 
Figure 23-2), a drop-down list of view options appears at the cursor, and an 
option list appears on the command line.

FIGURE 23-2:  
The Drawing 

View Creation 
context tab of 

the Ribbon.

http://www.dummies.com/go/autocadfd17
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7. Define the base view.

Using any one of the three selection methods — Ribbon, cursor, or command 
line — set up the base view as follows:

• Orientation: The view shows what appears to be the bottom view of the 
part because AutoCAD defines top, bottom, and so on relative to the world 
X,Y coordinates. Select Orientation and the Top to create the view you 
want.

• Hidden lines: The preview image in paper space always displays in shaded 
mode, regardless of the visual style of the model in model space. Change 
the Hidden Lines option to Visible and Hidden. The view won’t change yet, 
but don’t worry — it will after you complete the steps.

• Scale: This setting defaults to 1:4, which is suitable for your purposes if you 
started from the sample drawing.

• Visibility, or Edge Visibility: This setting specifies how to display edges that 
are formed where tangent surfaces meet. The normal practice is not to 
display them, but it sometimes causes features to disappear (or partially 
disappear). If you change this setting, hover the cursor over the Edge 
Visibility button in the Appearance panel of the Ribbon and pause for a few 
seconds; a much more extensive tooltip list then explains each option.

• Move: Specify a new location for the view before it is finally created. This 
isn’t such a big deal, though, because views can always be easily moved 
later.

• Exit: Or press Enter.

You can edit any of these view specifications later, view by view.

8. Place the other drawing views.

When you finish placing and defining the base view, AutoCAD automatically 
runs the VIEWPROJ command. All you need is three quick clicks to place the 
top, isometric, and right-side views; then press Enter to have AutoCAD 
generate the views.

9. Edit the isometric projection.

Isometric projections don’t normally show hidden lines. Double-click anywhere 
in the isometric projection to bring up the Drawing View Editor tab on the 
Ribbon, as shown in Figure 23-3.

FIGURE 23-3:  
The Drawing 

View Editor 
context tab on 

the Ribbon.
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Click Hidden Lines on the Appearance tab and choose Shaded with Visible 
Lines from the drop-down list.

If a Ribbon button has a drop-down list, the Ribbon displays the last button 
that was used. Any one of four different buttons may be in this particular 
location.

Figure 23-4 shows three ortho views and a shaded isomeric view, which 
I created in 37.6 seconds.

10. Add annotations.

Add dimensions and text notes in the paper space layout. Dimensions are 
associative to their matching geometry if you use object snaps to the geometry 
when you place them. I cover object snaps in Chapter 8, text in Chapter 13, and 
dimensions in Chapter 14. While you’re at it, perhaps you can use VIEWDETAIL 
to create a detail view at a different scale.

When you submit a drawing to your boss, they’ll be impressed that you 
 managed to create such a complex drawing, including the shaded isometric 
projection, in only three days.

Place text and dimensions on their own layers. I discuss layers in Chapter 9.

An isometric view and an isometric projection are different creatures. An  isometric 
view is normally drawn so that lines that are parallel to the three principal 
axes appear in their true length, and an isometric projection foreshortens them 
due to the tilting and rotating of the viewing angle of the object. Traditional  
paper-and-pencil drawings use isometric views, whereas AutoCAD creates 
 isometric projections.

FIGURE 23-4:  
Average  

creation time: 
9.4 seconds 

per view.
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If you truly want an isometric view, the solution is simply to ignore the usual rule 
about drawing and inserting at full size. When creating an isometric projection, 
use this approximate scale factor to produce an isometric view:

1.2247441227836356744839797834917

You can also edit the insertion later, to make it match this scale factor.

A different point of view
You can apply two different types of editing to 2D views that were generated from 
3D models.

You can edit the view specifications themselves (start with the easy one):

1. Select the base view, and then select the blue grip box that appears in 
the center of the view.

2. Drag and drop the view into a new location.

Interesting! If you move the base view, all the ortho views projected from it 
follow along, with some constraints. The ortho views don’t move in perfect 
unison as a single group, but they maintain their orthographic relationship to 
the base view.

Similarly, you can move projected ortho views in only the direction that still 
maintains their ortho relationship to the base view. Better yet, all attached 
dimensions (you hope) also follow along.

You can also double-click a view and then change the specifications that were 
used to create it. Refer to Step 9 in the step list in the preceding section.

To experience the magic of creating 2D views from a 3D model, return to model 
space and edit the model. For example, add a second hole (hint: subtract a cylin-
der), extend the length of the peg, and then return to the paper space layout. All 
your views and their dimensions are updated, as shown in Figure 23-5.

AutoCAD creates the views as a series of anonymous blocks. They behave much like 
regular blocks, but because they don’t have normal names, you can’t access them 
directly to edit or explode them. I discuss blocks in Chapter 17.
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Additional 3D tricks
In earlier sections of this chapter, I only touch on the 3D-to-2D capabilities of 
AutoCAD — although, if you’re reading the entire chapter, I may have whetted 
your appetite for more. To fully cover the 3D capabilities of AutoCAD would easily 
require a full book on its own (AutoCAD 3D For Dummies, perhaps?), but meanwhile, 
here are a few high points:

 » Don’t want four views? If you don’t want four standard views, you can 
create only the base view and then change its scale factor to better suit the 
sheet size.

 » Need additional base views? If necessary, you can have more than one base 
view in a single layout. For example, one large drawing might show an assem-
bly and its component parts.

 » Didn’t create enough views? Use the VIEWPROJ command to add more 
projected views later. They don’t have to project from the original base view, 
but can project from an existing projected view.

 » No longer need a view? You can delete a view, even a base view, without 
affecting the other views — except that doing so breaks the horizontal and 
vertical links between the views that were projected from it.

 » No 3D model in your drawing? Earlier in this chapter, I used the VIEWBASE 
command to generate views from a 3D model that lived in the model space 
of the current drawing. AutoCAD 2013 introduced functionality so significant 
that it deserves more explanation, which I happily provide in the next section 
of this chapter.

FIGURE 23-5:  
If anything 

changes,  
everything 

changes.
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AutoCAD’s top model
You may have generated 2D drawing views from a 3D model in model space in the 
earlier section “Get the 2D Out of Here.” But if the VIEWBASE command cannot 
find a 3D model in the current drawing file, it opens a standard file dialog box so 
that you can browse for an Autodesk Inventor part or assembly file.

Inventor is the 3D parametric modeling software from Autodesk, primarily 
intended for the mechanical design field. Inventor is fully parametric, in that 
dimensional constraints drive the profiles that define the solid features that con-
sist of the parts that comprise the assembly model that drives the 2D drawing 
views that Jack built. If you change a dimension on a 2D drawing of a part, every-
thing updates, all the way down the line.

OLDER 3D COMMANDS
AutoCAD begat several generations of tools to produce 2D views from 3D objects, and 
each generation generally improves. I list these older 3D commands here because they 
all still work, and you will probably encounter older drawings that were made by using 
them:

• FLATSHOT: This one produces a quick-and-dirty 2D view in model space. It basically 
sets the Z-axis coordinate of objects to 0 (zero). It also creates suitable new layers 
and then creates a block definition and inserts it as the 2D model. The benefit is that 
if you edit the model, you can run it again and redefine the block; the drawback is 
that it can’t create section views, and it takes some complex fiddling to make mul-
tiple views face and align correctly.

• SOLVIEW (Solid View), SOLDRAW (Solid Draw) SOLPROF (Solid Profile), MVSETUP 
(Multi-View Setup): This series of commands is used to create suitable layout view-
ports and then to generate appropriate 2D views into them. The views are created 
as anonymous blocks. The benefit is that they can produce simple cross-section 
views, and they’re produced directly in layout viewports. The drawback is that the 
commands must be used in a specific order, and the views aren’t associative back to 
the model. If you edit the model, you have to delete the views and start over.

• SECTIONPLANE, LIVESECTION, SECTIONPLANEJOG, SECTIONPLANETOBLOCK: 
This family of commands is used to create a series of blocks containing 2D views, 
much like FLATSHOT but with much more versatility and control. The benefit is 
that they can produce more-sophisticated cross sections, such as jogged section 
planes. If you change the model, the block definitions can be re-created to show the 
updated version. The drawback is that it takes some complex fiddling to get multiple 
views to face and align correctly.
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The Inventor file isn’t inserted into the AutoCAD file. Instead, it’s attached like an 
xref. I cover xrefs and DWG files in Chapter 18. VIEWBASE creates a 2D drawing 
view based on it, and additional views can be projected from the base view.

Here’s the magic part: The AutoCAD drawing views are still linked back to the 
Inventor file so that any changes made to the Inventor file reflect down to the 
AutoCAD file, updating it.

Better yet, you can send the AutoCAD DWG file to a client or vendor without hav-
ing to send the source Inventor file. The AutoCAD file contains only anonymous 
blocks for the 2D views and has nothing in model space.

On the other hand, whenever the AutoCAD DWG file has access to the Inventor file, 
the AutoCAD drawing views update and remain in step with any changes made to 
the Inventor model.

Here are more tips for working with AutoCAD and Inventor files:

 » Mix and match 2D drawing views. If VIEWBASE finds an AutoCAD solid in 
your part, you can tell it to ignore it and let you attach it to an Inventor file 
instead. You can have more than one base view in an AutoCAD drawing, so 
you can mix and match 2D drawing views. One or more base views can come 
from an internal AutoCAD 3D model, and others can be linked to external 
Inventor files.

 » Select additional solids. If model space contains more than one solid, 
VIEWBASE allows you to switch back to model space, where you can select 
and deselect solids to appear in the base view. For example, a model of a 
gearbox assembly might consist of many components. Separate views can be 
created, perhaps on several different layouts: one showing an outside view of 
the entire gearbox (which doesn’t need to include the internals such as gears 
and bearings); another showing only the input shaft, gear, bearings, and seals; 
and another showing the output shaft and its related components.

 » Choose a different scale. The VIEWDETAIL command generates detail views 
at scales different from the parent view.

 » Use different section views. The VIEWSECTION command has five options 
for creating section views: Full, Half, Offset, Aligned, and From Object. This 
command creates section views based on existing views in the layout. The cut-
ting plane line that it generates can be manipulated like any regular polyline, 
and the section view then updates accordingly.
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Visualizing the Digital World
Rendering allows you to see how a final product might look before it’s manu-
factured or built in the real world (see Figure 23-6); it definitely helps to sell a 
concept to a client. Although you can show a client a hidden line or shaded view 
of a 3D model, showing a photorealistic render helps make it feel that much more 
real when looking at it.

Before rendering a 3D model, you should

 » Add lighting to highlight features and define shadows.

 » Apply materials to 3D objects by face, object, or layer.

 » Set up a background for your 3D model to be rendered against

All these actions bring realism to a 3D model. This chapter focuses next on each of 
these tasks and then explains the steps to create a rendering.

Adding Lighting
One key ingredient that makes renderings look good is lighting. Lighting helps 
give a model depth by using highlights and shadows. As in the real world, objects 
that are closest to the light source appear the brightest, and objects the farthest 
distance away appear darker.

AutoCAD uses both default and user-defined lighting. Default lighting, as its name 
suggests, is on and available in every drawing, and it gives basic form to your 3D 
model when you click the Render button before adding lighting of your own. All 
types of user-defined lights can cast shadows. Most tools that you use to create 
and edit lights are located on the Lights panel and the Sun & Location panel on 
the Render tab.

FIGURE 23-6:  
Rendering 

compared with 
the Conceptual 

visual style.
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Default lighting
Over the past few years, AutoCAD’s default lighting has improved in quality. Before 
AutoCAD 2007, default lighting consisted of a single, distant light source, always 
directed toward the target of the current view from behind your back. AutoCAD 
2007 added a second default light to help increase the lighting level, and to bal-
ance the lighting in a viewport.

Default lighting can’t cast shadows, 
so I don’t recommend using it for 
final renderings. It does, however, 
work pretty well for quick  conceptual 
 renderings. You can control the 
brightness, contrast, and midtone lev-
els for default lighting by using the 
slider controls on the slideout of the 
Lights panel on the Visualize tab of 
the  Ribbon (see Figure 23-7). AutoCAD 
2014 and earlier have these controls on 
the Render tab of the Ribbon.

Use the DEFAULTLIGHTING system 
variable to enable and disable the 
use of default lighting in the current 
viewport. Set DEFAULTLIGHTING to 0 
when you want user-defined lighting 
to render your 3D model. If you’re using default lighting, the DEFAULTLIGHT-
INGTYPE system variable controls whether one or two default distant lights are 
used: When set to 0, one default light is used; when set to 1, two default lights 
are used.

User-defined lights
Default lights are fine for quick renderings, but they don’t bring renderings to 
life in the way that user-defined lights can. User-defined lights are lights that 
you create (with one exception) and modify in your 3D model. The only user-
definable light type that you can enable and modify, but not create, is the sunlight 
 system — someone else already created it.

The first time you use a user-defined light in a drawing, the Lighting – Viewport 
Lighting Mode alert box is displayed, advising you to turn off default lighting in 
order to see light from user-defined sources. Click Turn Off the Default Lighting 
to disable the default lighting. To turn it back on, open the Lights panel slideout 
on the Render tab and click Default Lighting. Always disable default lighting when 

FIGURE 23-7:  
AutoCAD to lights; extra brightness is a go.
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using user-defined lights; otherwise, you can end up overlighting your model, 
making it look unnatural.

You can create two types of user-defined lights:

 » Generic: This type provides advanced control over how the light is emitted 
and is much more complex.

 » Photometric: This type is more convenient to use because it’s defined to 
represent how actual lights work in the physical world.

The LIGHTINGUNITS system variable controls whether user-defined lights in a 
drawing are represented as generic or photometric. When LIGHTINGUNITS is set 
to 0, generic lights are used; when LIGHTINGUNITS is set to 1 or 2, photometric 
lights are used — 1 indicates American lighting units, and 2 indicates interna-
tional lighting units. Lights don’t have to be removed and added to switch between 
generic and photometric lights; you only need to switch the system variable.

To add a user-defined light to a drawing, click the lower half of the Create Light 
split button on the Lights panel of the Render tab. You can choose from four dis-
tinct types of lights on the flyout (you can see the differences between light types 
in Figure 23-8):

 » Point light: Emits light uniformly in all directions, but the emitted light falls 
off as it moves farther from the source. A point light is similar to a candle or 
a lantern.

 » Spotlight: Emits light in a specific direction. As light travels farther from the 
source, it spreads out in the shape of a cone. A spotlight is like the ones used 
at concerts. You can define the hotspot (the brightest part of the emitted light) 
and the fall-off of the light.

 » Distant light: Emits light along a specified vector and doesn’t decay or fall off, 
like other user-defined lights do. A distant light is similar to the sun.

 » Weblight: Has nothing to do with spiders or the Internet. A weblight combines 
a point light and a spotlight. This type is available only when using photomet-
ric lights, and the way it emits light is determined by an IES file. IES files are 
provided by lighting companies for use in products such as AutoCAD to mimic 
the light patterns given off by the bulbs they manufacture.

AutoCAD — and I —strongly advise against using distant lights when using pho-
tometric lighting. If you decide to ignore this warning, turn down the intensity 
factor of the distant light to avoid washing out the rendering.
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Point lights, spotlights, and weblights can be selected and edited directly in a 
drawing because a glyph is displayed to show where the light is located. Distant 
lights have no associated glyph. A glyph is a nonprinting object displayed in a 
drawing that enables you to select an object that isn’t part of the actual model.

To avoid some of the frustration of applying lights, visit a portrait studio, 
have your portrait taken, and notice how the lights are set up. A brighter light 
is typically placed (about 45 degrees) above and (about 45 degrees) to one side 
of the camera as you face it, and a second, dimmer light is placed lower (about  
30 degrees) and on the other side of the camera.

The shadow knows. . . .
AutoCAD allows you to define lights that don’t generate shadows. Though this 
statement might seem illogical because shadows are cast when light is obscured 
by an object, it’s important because you may want to fill an area with light but not 
have it affect the way shadows are cast.

To control the shadows generated by lights, select a light, right-click, and then 
choose Properties to open the Properties palette. The Shadows option in the Gen-
eral category enables or disables shadow creation from the selected light. The 
Rendered Shadow Details category gives you a large degree of creative control over 
shadow appearance. For more information on putting objects in the shade, open 
the online Help system and search for Render 3D objects for shadows.

Point light

Distant light

Spotlight

Weblight

FIGURE 23-8:  
Lighting 

 primitives with 
the four types 

of user-defined 
lights.
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You can also control how objects 
themselves affect shadows. Select a 3D 
object, right-click, and choose Proper-
ties. In the 3D Visualization category of 
the Properties palette, click the Shadow 
Display drop-down list. You can con-
figure objects to cast shadows, receive 
shadows, cast and receive shadows, or 
ignore shadows altogether.

The Lights in Model 
 palette
In a complex drawing, or in one in 
which you might have added a distant 
light, you use the Lights in Model pal-
ette (see Figure 23-9) to select, delete, 
and access the Properties palette for 
selected lights. To display this pal-
ette, click the Lights panel launcher 
(the little arrow at the right end of the 
Lights panel label).

Sunlight
You can simulate sunlight via the Sun 
Properties palette (see Figure  23-10). 
Adding sunlight to a drawing allows 
you to perform sunlight studies and to 
add realism to both indoor and outdoor 
renderings.

You use the Sun Properties palette to 
locate the sun’s position based on the 
nearest large city or on latitude and lon-
gitude values. You can also use Google 
Earth KML or KMZ files to specify your 
location. In addition to location, you 
can designate the northern direction 
to find the correct daily movement of 
the sunlight in your drawing. To adjust 
the sunlight in a drawing, open the Sun 
Properties palette by clicking the Sun 
& Location panel launcher (the little 
arrow on the panel label).

FIGURE 23-9:  
Ah, yes, you’re on the lights list.

FIGURE 23-10:  
The Sun Properties palette gives you the power 
to control day and night.
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Creating and Applying Materials
Materials also bring your models to life. Materials can be as simple as glossy 
paint, as complex as rough bricks, and anything in between. You can apply rep-
resentations of realistic, real-world materials such as stone, marble, glass, pol-
ished metal, or fabric — the list is almost endless. The materials can be opaque, 
transparent, reflective, or nonreflective. AutoCAD comes supplied with a material 
library of literally thousands of different material types. Assigning them to objects 
can be as simple as dragging from a palette and dropping on an object or it can be 
as complex as you care to make it.

Before AutoCAD 2011, you created and stored materials in individual drawings, 
which made them difficult to manage. AutoCAD 2011 introduced the Materials 
Browser, which makes managing materials much easier. Material definitions, 
which live in a central repository, are attached to each drawing as an external 
reference.

All Autodesk products that use material definitions use the same central library, 
so a model rendered in AutoCAD looks the same as one done in Inventor, Maya, 
or 3ds Max.

Partnered with the Materials Browser is the Materials Editor, accessible from 
a button in the Materials Browser. The Materials Editor edits the properties of 
materials and defines new ones.

The material libraries introduced in AutoCAD 2011 occupied vast amounts of hard 
drive space, which was considered wasteful for people who never did renderings. 
So, as of AutoCAD 2012, most material libraries are online. The first time you click 
the Render button in AutoCAD, it asks whether you want to go online to install the 
Medium Material Library, about 720MB. (Medium refers to the resolution of the 
image files used for materials, typically 1024 x1024 pixels.) If rendering looks 
interesting to you, go ahead and install the library.

Use the MATbrowser command to display the Materials Browser palette (see  
Figure 23-11), from which you can create, edit, and manage in the current draw-
ing or material libraries. You add materials to a drawing by using a preconfigured 
material or creating a custom material.
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Follow these steps to create and manage a new material:

1. On the Visualize tab, choose Materials Browser from the Materials panel.

2. On the Materials Browser palette that opens, click Create a Material (in the 
lower-left corner) and then choose the material template you want to start 
with. For example, choose Metallic Paint.

The Materials Editor palette is displayed (see Figure 23-11).

3. On the Materials Editor palette, click in the Name field, located below the 
preview of the material, and enter a name.

4. Enter new values in the appropriate attributes for the material, and close the 
palette when you’re done.

The attributes that you can edit vary, based on the type of material template 
that you choose to start with. When you finish editing the material, you can 
close or hide the Materials Editor palette. The material is then automatically 
added to the current drawing.

5. (Optional) Save the material in a library to use it in more than one drawing. 
On the Materials Browser palette, at the bottom, click Manage, and then 
select Create New Library.

The Create Library dialog box is displayed.

6. Enter a name and location for the new library. Click Save.

7. On the Materials Browser palette, drag the custom material that you created 
onto the name of the new library.

Now you can access the material from any drawing. You can create categories 
if you want to manage multiple materials within a library. In the Materials 

Materials Browser
palette

Materials Editor
palette

FIGURE 23-11:  
Adding color 
and texture 

to a 3D model 
with the  

Materials 
Browser  

palette (left) 
and the  

Materials 
Editor palette 

(right).
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Browser, right-click the library name, choose Create Category, and then enter a 
name for the new category. After the category is created, simply select the 
material from the right side of the Materials Browser and drag it to the new 
category.

You can open the Materials Editor directly from the Ribbon by clicking the Materi-
als panel launcher (the little arrow at the right end of the Materials panel label).

Which materials you use in a model depends on what you’re trying to represent. 
For example, you might choose to make a material semitransparent, to communi-
cate an idea rather than a true material selection. After you create a material, you 
can apply it to the objects in your 3D model. You can apply materials to objects by

 » Layer: Globally assign materials to all objects on a particular drawing layer 
by assigning a material to the layer. To assign materials by layer, open the 
Materials slideout on the Render tab and choose Attach by Layer.

 » Object: Assign materials to an object by selecting the object and then right-
clicking the material you want to assign in the Materials Browser palette. From 
the menu that appears, choose Assign to Selection. You can also drag and 
drop a material from the Materials Browser palette onto an object in a draw-
ing or change an object’s Material property by using the Properties palette.

 » Face: Assign materials to individual faces of a 3D solid. Select a face using 
Subobject filtering by holding down the Ctrl key and selecting the face you 
want to apply a material to. Right-click the material you want to assign in 
the Materials Browser palette, and then choose Assign to Selection from the 
menu that appears.

Defining a Background
Although your model might look a little more realistic with some user-defined 
lighting and custom materials assigned to it, its setting might look a little, well, 
empty. You can assign backgrounds to fill that empty space beyond the 3D model 
in your scene. A background is a property of named views, and you can set them 
up in the View Manager dialog box. I cover the View command and View Manager 
dialog box in Chapter 5. You can define a background as a solid color, a gradient 
(two or three colors), a raster image, or a sky with a sun (available only when 
using photometric lighting).
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Follow these steps to create a new named view and assign a background to it:

1. On the Views panel of the Visualize tab, click View Manager.

The View Manager dialog box appears.

2. Click New to display the New View/Shot Properties dialog box.

For more on creating named views, see Chapter 12.

3. In the Background 
area, click the Default 
drop-down, choose an 
option to override the 
default background, 
and then click OK.

Choose Solid or 
Gradient if you want a 
studio-type scene, or 
choose Image if you 
have a suitable raster 
image to highlight your 
model. Any of these 
options displays the 
Background dialog 
box where you make 
your settings (see  
Figure 23-12). Choose 
Sun & Sky if you want 
to place your model in 
the great outdoors. (It’s 
always fair weather in 
AutoCAD! Just be aware 
that sunny, fair days 
also tend to slow down 
the program.) Choosing the last option displays the Adjust Sun & Sky 
Background dialog box, as shown in Figure 23-13.

4. After the background is defined, select the view from the Views tree and 
click Set Current.

When the View Manager closes, the new background is displayed.

FIGURE 23-12:  
Painting the canvas of the drawing window.
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For more information on the View 
Manager, see Chapter 5.

If you don’t want to create a named 
view first, enter the BACKGROUND 
command to display the Background 
dialog box.

Rendering a 3D Model
After you add lights, apply materials, 
and define a background for your 3D 
model, you’re ready to press the magic 
button! Clicking Render tells AutoCAD 
to round up all the materials and apply 
them to the objects and faces to which 
they’re assigned. After materials are 
assigned, the background is applied to 
the current viewport, and then, finally, AutoCAD calculates light and shadows 
based on all those property settings I show you how to make earlier in the chapter.

By default, rendering is performed 
in the render window, as shown in  
Figure 23-14. To start rendering your 
virtual fat into digital lard — how’s 
that for a grisly image? — click  Render 
to Size on the Visualize tab’s Ren-
der panel. And to anyone who says 
that Figure 23-14 looks like red paint, 
not red wine, I would reply “You 
haven’t  tasted my homemade red 
wine, have you?”

To help make rendering as easy as  
possible, AutoCAD comes with five 
render presets. A render preset is a con-
figuration of rendering settings that you can use to produce predictable results 
when rendering a model. The presets range in quality of output, from Draft 
through Low, Medium, and High to Presentation Quality.

FIGURE 23-13:  
Here comes the sun!

FIGURE 23-14:  
Rendering a rendering in the render window.



484     PART 5  On a 3D Spree

To set a render preset current, choose the Render Presets drop-down list on the 
Render tab’s Render panel. Choose Manage Render Presets at the bottom of the 
Render Presets drop-down list to open the Render Presets Manager dialog box. 
The Render Presets Manager allows you to create and edit custom render presets. 
You can start with an existing render preset when you create a new one.

In addition to rendering a still image with the RENDER or RENDERCROP com-
mands, you can create an animated walk-through of your model by using 
ANIPATH. To find out more about creating animations, see the AutoCAD online 
Help system.
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IN THIS CHAPTER

Exporting AutoCAD DWG files to 
other file formats

Importing other file formats into 
AutoCAD

Dealing with translation issues

AutoCAD Plays Well 
with Others

So your drawing masterpiece is ready to go. Chapter  16 covers plotting to 
paper, and Chapter 20 discusses the gory details of transmitting drawing 
files via the Internet. So far, so good. But what if you want to include all or 

part of a drawing as an illustration in a written report? What if you need to send a 
drawing to someone who is using a CAD program other than AutoCAD? No prob-
lem. This chapter starts by discussing several different processes for extracting 
drawing information in a variety of file formats.

Next, we come to the flip side. What if you receive a drawing file that isn’t in DWG 
format? Okay, maybe not a problem. AutoCAD can import and edit several other 
file formats.

This chapter concludes with a section on some of the possible pitfalls of dealing 
with file format translations.

Get Out of Here!
AutoCAD has several processes for exporting drawings in formats other than DWG. 
In fact, it often has more than one process for the same format.

Chapter 24
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In Chapter 1 I discuss the difference between the two fundamental file formats for 
storing graphic images. Virtually all CAD programs use a vector format, in which 
the file contains definitions and properties for each object type such as a line, a 
circle, and an arc. Most other graphic programs use some variant of a raster (bit-
map) format, wherein the file simply contains a mapping of the color of each of 
the tiny dots (pixels) that produce the image on screen.

The bad news is that if you want to include CAD drawings in most non-CAD 
 applications, well, many cannot handle a vector format. The good news is that 
AutoCAD can produce a raster file that can then be inserted into things like a Word 
document file.

Things that go BMP in the night
The most basic raster image file is a simple bitmap, usually with the file extension 
BMP (usually pronounced “bump”). The file consists mostly of a whole bunch 
of numbers that correspond to a color number for every individual pixel. One 
 problem with BMP files is that they are not compressed, so as the resolution (the 
number of rows and columns) goes up, the file size goes up exponentially. If you, 
say, double the resolution, the file size quadruples.

The file size problem can be greatly reduced by using any one of several file com-
pression techniques. The basic principle of file compression is that the software 
looks for repetitions and then describes them appropriately. For example, if 
green is color number 3, a horizontal green line in a BMP file would be stored as  
“3 3 3 3 3 3 3 3 3 3 3 3.” A compressed file would store the same information as 
“12x3,” which obviously requires less space. The bad news is that some compres-
sion formats achieve higher compression rates by filtering finer details, so that  
“3 3 3 3 3 3 4 3 3 3 3 3” might still be stored as “12x3.” The false information is 
called an artifact. Artifacts may not be a problem in busy photographs but are a 
problem when details are lost from CAD images.

The most common compressed raster file formats are JPG (“jay-peg”), which 
is used by digital cameras, PNG (“ping”), which is used on websites, and TIF 
(“tiff”), which is used in desktop publishing.

You can extract a raster image from AutoCAD in several ways, ranging from con-
venient to flexible:

 » Press Alt+PrtSc on your keyboard. This method captures the current screen 
view of the current application to the Windows clipboard. You can now paste 
it directly (with Ctrl+V) into many other applications or into a graphics program 
such as Paint for further editing, cropping, and saving to a variety of raster  
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formats. This keystroke combination works equally well for any Windows 
application, by the way, and is convenient because there are no options 
to choose.

 » Use the EXPORT command. This method saves drawings to a file on the 
hard drive in a variety of raster and vector formats. For use in non-CAD 
applications, the two formats to consider are WMF (Windows metafile) and 
BMP (bitmap). This command allows you to select which entities to export; 
press Ctrl+A to select all visible ones. Other than that, there are no options to 
consider.

 » Use the PLOT command. Refer to Chapter 16, where I discuss plotting. The 
Printer/Plotter Name drop-down list includes Publish to Web JPG and Publish 
to Web PNG. When you select either, the Paper Size drop-down list displays a 
variety of image resolutions.

You may need to do a bit of playing with the Plot Area and Plot Scale values to 
get what you want. Extents and Fit to Paper are usually good starting points.

Doing a screen capture or a plot to a raster file is strictly a case of WYGIWYS (what 
you get is what you see). If a detail is small enough that it isn’t visible on-screen 
at the time the image was captured, it isn’t in the raster file and no amount of 
zooming in will bring it back. The only way a raster image can be resized is by 
dropping or adding pixels. Resizing smaller can result in loss of detail, which can 
sometimes mess up a drawing image. In addition, resizing bigger usually doesn’t 
restore the lost detail. I strongly recommend that you play with the capture set-
tings so that the image can be inserted 1:1 in the target document, without the 
need to resize it.

The three panels of Figure  24-1 show possible side effects of resizing a raster 
image.

Vectoring in on WMF
Many people are familiar with the common image formats that I mention earlier 
in this chapter because they are in widespread use on the Internet. What most 
people, including dedicated CAD geeks, don’t know is that Windows supports a 
unique vector format called a Windows Meta File (WMF, pronounced “wmf”).

FIGURE 24-1:  
How to mess 

up a raster 
image.
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Many Windows applications, Word in particular, let you insert a WMF file as an 
illustration. The big advantage of this is that WMF is a mixed raster-vector file 
format, which means that you can zoom in or out all you want without losing 
details. Oh, small stuff may not be visible if you zoom out too far, but it hasn’t 
gone away if you zoom back in. After you insert a WMF file into a Word document, 
you can resize it at will to fit the available space without losing clarity or detail.

To export a drawing in the WMF format, just do the following:

1. On the Application menu, choose Export ➪ Choose Other Formats.

The Export Data file dialog box appears.

2. In the Files of Type drop-down list, select Metafile (*.wmf).

3. Enter a suitable file name and then click Save.

4. When AutoCAD asks, select the drawing objects to be exported.

When you finish selecting, the file is created.

If instead of Step 1 you enter the WMFOUT command at the keyboard, AutoCAD 
jumps directly to Step 4.

And now here are the lumpy bits
The first major issue with exporting a drawing to a WMF file is that the objects to 
be exported have to be visible on-screen and they must all reside in model space 
or paper space. For example, if your border and title block reside in a paper space  
layout and a viewport shows model space, exporting a WMF file from paper 
space  will capture only the border, title block, and viewport boundary — and 
nothing from model space.

Fortunately, there is a simple solution. By the way, have you noticed that I almost 
never bring up a problem unless I also have a solution? Anyway, all you need to 
do is to be in the desired paper space layout. Now go to the Application menu, 
choose Save As, and then click Save Layout as a Drawing. From here, the steps are 
self-explanatory. All visible objects from both universes are collected, and then 
everything is copied into the model space of a new drawing. Now you can export 
the new drawing as a WMF file.

The second issue involves framing. When you create a WMF file, its boundary is 
determined by the visible area of the screen and not by the extents of the objects 
you select. This means that if you have zoomed out to the full extents of your 
drawing but just select a few objects, the resultant image when inserted into a 
Word document will show a large white area with your selected objects showing 
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as a very small detail. The solution is to zoom and frame your objects so that they 
just fill the screen before you select them. This process can even include stretch-
ing and shrinking the height and width of the drawing window.

PDF
The PDF file format by Adobe Systems has become the generic standard for many 
types of information exchange. Much of this derives from its name: PDF stands 
for Portable Document Format. In the early days of computing, a document cre-
ated on the PC version of Word couldn’t be opened by the Mac version and vice 
versa. On the other hand, a PDF file can be opened and displayed by any Windows 
or Mac computer or any iOS or Android device, such as a tablet or an iPhone. All 
you need is the appropriate free reader app from Adobe.

To generate a PDF version of an AutoCAD DWG file, simply go to the Application 
menu and choose Export ➪ PDF. The rest is pretty obvious.

What the DWF?
The AutoCAD DWG format works well for storing drawing information on local 
and network drives, but the high precision and large number of object properties 
that AutoCAD uses make for comparatively large files.

To overcome this size problem and to encourage people to publish drawings on 
the web, Autodesk developed an alternative lightweight vector format for rep-
resenting AutoCAD drawings: Design Web Format (DWF, pronounced “dwiff”). 
A DWF file is a more compact representation of a DWG file. DWF uses less space 
because it’s less precise and doesn’t have all the information that’s in the DWG 
file. Therefore, it takes less transfer time over the web and by email.

Use the EXPORTDWF command to create a DWF file. Click the Application menu 
and then click the Export button to use the EXPORTDWF command.

DWFx is a version of regular DWF that’s compliant with Microsoft’s XML Paper 
Specification (XPS). Had your fill of alphabet soup yet? Everything about DWF 
in this chapter also applies to DWFx. The DWFFORMAT command determines 
whether the PUBLISH, 3DDWF, and EXPort commands output to DWF or DWFx. 
If this sounds like a topic that might be important in your work, look up DWF-
FORMAT in the online help system. Windows Vista through Windows 10 include an 
XPS Viewer, and the long and the short of this feature is that drawings plotted to 
DWFx can be viewed automatically in these Windows versions without AutoCAD 
or any special viewing software.
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DWFx files are essentially electronic-paper–like PDF files — or, more specifically, 
like a sheet of paper with transparent overlays stacked on top of it. Recipients can 
zoom, pan, turn layers on and off, apply markups, and print, but they can’t edit 
anything.

You can create DWF or DWFx files from your drawings and send those files to peo-
ple who don’t have AutoCAD. The recipients can view and plot the DWF files after 
they download the free Autodesk Design Review 2014 program, which is available 
at the Autodesk website at http://usa.autodesk.com/design-review.

Although Autodesk intended to have DWF and DWFx become the standard format 
for lightweight transmission and sharing of CAD designs, it seems that Adobe 
System’s ubiquitous Portable Document Format (PDF) has largely taken over this 
function. I discuss PDFs earlier in this chapter.

3D Print
Okay, all you old Star Trek fans! The Matter Replicator exists! Well, not really, but 
3D printing is getting pretty close. The good news is that this section of the book 
is short.

AutoCAD is able to export 3D solids and watertight 3D meshes in the industry-
standard STereoLithography (STL) file format, which can be used by virtually any 
type, brand, and model of 3D printer. I cover 3D in Chapter 21.

To export an STL file, follow these steps:

1. On the Application menu, choose Export ➪ Choose Other Formats.

The Export Data file dialog box appears.

2. In the Files of Type drop-down list, select Lithography.

3. Enter a suitable file name and click Save.

You can also send your file directly to a 3D printing service bureau, which will 3D 
print the model and mail it to you — for a fee, of course. On the Application menu, 
choose Export ➪ Send to 3D Print Service.

But wait! There’s more!
Between them, AutoCAD’s print, export, save as, and publish functions can export 
drawing files into about 30 different file formats. These formats includes the ones 
already discussed in this chapter, plus several other CAD formats. Plus AutoCAD 
can roll newer AutoCAD files back to earlier releases.

http://usa.autodesk.com/design-review/
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Open Up and Let Me In!
Among other things, Chapter 18 discusses how and why to attach raster images, 
PDF files, and external references (XREFs) to an AutoCAD drawing file.

Editing other drawing file formats
AutoCAD can also create, open, edit, and save a number of other file formats, 
including several other brands of CAD software. I won’t go into all the ins and outs 
here, but I will give you a hint: On the Application menu, look at the options under 
Open and under Import, and then click the Files of Type drop-down list to see the 
list of supported formats.

PDF editing
AutoCAD 2017 added the capability of editing PDF files. From a practical point of 
view, this is viable only if the PDF was created by exporting a drawing file from 
AutoCAD or another CAD program. Yes, AutoCAD can edit a PDF that came from a 
Word document, for example, but trust me, you don’t want to do that.

To edit a PDF drawing, do this:

1. Open a new or existing drawing file.

2. On the Application menu, choose Import ➪ PDF.

3. Press Enter.

4. Browse to and select the desired PDF file using the file dialog box that has 
appeared.

5. Click Open.

The Import PDF dialog box shown in Figure 24-2 appears.

6. Click OK.

For your first try, I suggest you go with the defaults.

Magic! This looks exactly like the original drawing that was used to create the 
PDF! Even all the text, dimensions, colors, layers, and linetypes are correct.

Yes, AutoCAD can now edit a PDF file, but (and it’s a big, uppercase, bold BUT —  
not to be confused with a big butt) before you get all excited at the prospect, 
you may want to consider the following discussion of some of the limitations. 
It’s  possible that these may be inherent in the PDF format or with AutoCAD’s 
 capability to analyze the file or both.
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First, all complex object types have been exploded to their basic constituents. For 
example, all block insertions, hatch patterns, text, and dimensions have been 
reduced to a bunch of individual polylines. That’s right, every line segment in a 
complex hatch pattern has become an individual, independent polyline segment. 
Similarly, dimensions get exploded to polylines and text, and are no longer asso-
ciated with the original definition points.

Worse yet, all text is exploded to individual characters. TrueType fonts survive, 
but the individual characters in AutoCAD’s SHX fonts get redefined as a bunch of 
polyline segments.

I’m not finished! Curves such as splines and arcs also end up as a multitude of 
straight polyline segments.

Ah, but I saved the worst for last. In Chapter 8 in particular, I harp on the need for 
accuracy in AutoCAD drawings. Unfortunately, the PDF file didn’t read that chap-
ter, and so most objects seem to come in with sizes that vary from the original 
drawing in the third and fourth decimal place. This may not sound like much, but 
you will now find that two lines that are supposed to intersect each other or touch 
at their ends probably don’t.

Other than that, PDF editing is perfect.

Translation, Please!
As indicated earlier in this chapter, AutoCAD can both import and export drawing 
files from several brands of CAD software.

FIGURE 24-2:  
The Import 

PDF dialog box.
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No translation is perfect, whether of computer file formats or of human languages. 
Neither of them have exact equivalencies for certain items or terms. The first test 
of any translation is to do a round trip out and back into the original format, and 
then look for the differences. For example, legend has it that programmers did 
a round-trip test when they were writing the first human-language translators. 
What went in was “The spirit is willing but the flesh is weak.” What came back 
was “The booze is okay but the meat’s gone bad.” Even rolling an AutoCAD DWG 
file back to an earlier release can cause loss of things such as parametrics or 3D 
objects that didn’t exist in the earlier release.

You have probably guessed by now that AutoCAD isn’t the only CAD program on 
the market, nor is it even the only one that can process files with the DWG format. 
A number of programs, ranging from lower-cost to free, claim to be AutoCAD 
compatible.

Varying degrees of “compatible” exist, and compatibility isn’t necessarily a func-
tion of price. Degrees of compatibility range from AutoCAD object types that don’t 
exist in the compatible programs but can still be displayed to objects that can be 
damaged or destroyed by a round trip.

Examples of some of the varying degrees of compatibility include the following:

 » 3D: Other CAD programs may not be able to create or edit 3D solids and 
surfaces, may not be able to display them, and might even strip them out of 
an incoming DWG file.

 » Self-scaling annotations: Other CAD programs may not be able to create 
or edit self-scaling annotations or display more than the first scaled variant 
applied to an object. Some programs might strip out the other scales, so they 
don’t survive a round trip.

 » Parametrics: Other CAD programs may not support editing of parametric 
values. Some programs might strip out the parametrics so that they don’t 
survive a round trip.

 » Tables: I discuss tables in Chapter 13. They are basically spreadsheets that 
can be inserted into an AutoCAD drawing. They can then do such things 
as read values from AutoCAD objects or external Excel spreadsheets into 
individual cells and extract cell values out to linked Excel spreadsheets. Earlier 
releases of AutoCAD, and some other CAD programs, don’t support these fea-
tures. At best, the tables will be translated into simple line elements and text 
objects that display the current cell value. Connectivity will be lost. At worst, 
the table may disappear entirely.

The bottom line is that you should conduct round-trip cycles on test files before 
committing hard data.
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Find additional AutoCAD resources.

Discover system variables to make your life easier  
(or maybe just a little more fun).

Discover ten more tricks to working in AutoCAD.
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IN THIS CHAPTER

All things Autodesk

World Wide (CAD) Web

Your local user group

Autodesk User Groups International

Ten AutoCAD 
Resources

As much as I want to make a claim to the contrary, you probably need more 
information than this book and a copy of the software and the software’s 
Help system to reach the highest peaks of AutoCAD mastery. This chap-

ter lists ten likely aids to help you find out more about your favorite software 
program.

Autodesk Feedback Community
If you’re interested in helping shape future releases of AutoCAD, sign in to the 
Autodesk Feedback Community portal (https://beta.autodesk.com) using your 
Autodesk account, and then apply by clicking the Create Account link. If you’re 
accepted, you will, in return for small (or sometimes considerable) time commit-
ments, contribute your ideas to the AutoCAD Futures group or apply to beta-test 
the next release of AutoCAD.

Chapter 25

https://beta.autodesk.com
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Autodesk Discussion Groups
Although independent, newsreader-based discussion groups are still out there, 
the majority of the AutoCAD action nowadays happens in Autodesk’s moderated 
discussion groups. They’re user-to-user groups, but Autodesk employees fre-
quently jump in to answer questions in their areas of expertise. To see what’s 
there, point your browser to forums.autodesk.com to find product-based discus-
sion groups for AutoCAD and AutoCAD LT.

Autodesk’s Own Bloggers
Several Autodesk employees run their own blogs via the company servers, and 
they’re chockablock with tips, techniques, and (occasionally) highly entertaining 
digressions. For a list of all Autodesk blogs, go to www.autodesk.com/blogs.

The AutoCAD-based blogs I highly recommend are Shaan Hurley’s Between the 
Lines (http://autodesk.blogs.com), Heidi Hewitt’s AutoCAD Insider (http://
heidihewett.blogs.com), Kate Morrical’s LT Unlimited (http://ltunlimited.
typepad.com), and Lynn Allen’s Blog (http://lynn.blogs.com). (That’s its 
name  — honest.) And if you want to know more about Lynn Allen, check out 
“The cell phone story” at http://lynn.blogs.com/lynn_allens_blog/2008/02/ 
the-famous-cell.html. When you go to any of these links, tell them I sent you.

Autodesk University
Autodesk University (AU) is an annual event, sponsored by Autodesk. For the past 
few years, the event has settled in Las Vegas, Nevada. If your boss balks at sending 
you, quote a few figures: At AU 2015, 846 instructors presented 835 classes and 
labs to about 10,000 attendees on virtually every conceivable topic related to vir-
tually every Autodesk product. Another 9,000 attended regional sessions in other 
parts of the world, and 53,000 took virtual classes online.

Add over 300 exhibitors showing their wares in about 205 booths — plus, the AU 
support staff and techie types — and you end up sitting down for lunch with about 
13,000 of your best friends. The meals and the evening social sessions are great 
times for networking with your peers, and you can often learn as much as you do 
in the classes. Check out http://au.autodesk.com to find out how to schmooze 
like a pro and return home a guru!

http://www.forums.autodesk.com
http://www.autodesk.com/blogs
http://autodesk.blogs.com/
http://heidihewett.blogs.com/
http://heidihewett.blogs.com/
http://ltunlimited.typepad.com/
http://ltunlimited.typepad.com/
http://lynn.blogs.com/
http://lynn.blogs.com/lynn_allens_blog/2008/02/the-famous-cell.html
http://lynn.blogs.com/lynn_allens_blog/2008/02/the-famous-cell.html
http://au.autodesk.com
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Autodesk Channel on YouTube
If you search the web for solutions to particular AutoCAD issues, you’ve prob-
ably already discovered the YouTube Autodesk channel. You can find dozens and 
dozens of video clips that cover not only AutoCAD and AutoCAD LT but also other 
Autodesk products such as Inventor and Revit. You can subscribe and receive 
email notifications of new videos every few weeks. Check it out at www.youtube.
com/autodesk.

World Wide (CAD) Web
I’m reluctant to list specific sites because they tend to come and go, but Cadalyst 
magazine (www.cadalyst.com) has been in existence for over 30 years. In par-
ticular, click the CAD Software Tutorials link to see the series of tutorials Circles 
and Lines, by Lynn Allen, and The Learning Curve, by yours truly. Ralph Grabowski, 
the technical editor of this edition, has an active blog at www.worldcadaccess.com 
and a weekly emailed newsletter at www.upfrontezine.com.

Your favorite search engine can also be a good friend. Apart from Autodesk’s own 
web presence, thousands upon thousands of other sites are scattered around the 
world. Search by entering AutoCAD tutorials for online exercises, or try AutoCAD 
blogs for independent views and opinions as well as tips and tricks for using Auto-
CAD. You can also try specific Google searches. For example, entering AutoCAD line 
command yields about 670,000 hits!

Your Local Authorized Training Center
Autodesk Authorized Training Centers (ATCs) are located around the world in 
both private institutions and public colleges and institutes. At an ATC, you attend 
scheduled, instructor-led classes where you learn to use AutoCAD from the ground 
up. Courses are designed for rank beginners or experienced users who want to 
learn the latest customization techniques. To find the location of your nearest 
ATC, browse to www.autodesk.com/atc.

http://www.youtube.com/autodesk
http://www.youtube.com/autodesk
http://www.cadalyst.com
http://www.worldcadaccess.com
http://www.upfrontezine.com
http://www.autodesk.com/atc
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Your Local User Group
AutoCAD has inspired an incredibly loyal following in the 30+ years since its initial 
release. One primary reason is the especially enthusiastic individuals who arrange 
to meet one evening per month to talk about what they’ve discovered they can do 
with AutoCAD. These folks are still out there, and although some now have grayer 
hair and more wrinkles, they still love to get together and talk about AutoCAD. 
And most are especially welcoming to newcomers!

Our own local group, the Vancouver AutoCAD Users Society (www.vaus.org), happens 
to be the first (and therefore oldest) user group in existence. To find a nearby group, 
enter AutoCAD user group and the name of your city in your browser’s Search box.

Autodesk User Groups International
Autodesk User Groups International (AUGI) is the umbrella organization of 
the global user group community. You don’t even have to belong to a group to 
 participate. Individuals can join too, and basic membership is free. Browse to  
www.augi.com to find out more.

AUGI is probably best known for the annual wish list it presents to Autodesk; the 
list is compiled from requests from members for changes or new features in Auto-
CAD. It’s often the case that top wish-list items find their way into new releases of 
AutoCAD, so it’s another place where you can help to shape future releases. AUGI 
also supports a series of online and live training sessions, and your membership 
usually earns you a discounted rate to attend Autodesk University.

Books
Although I’d like to fill you in on all the wonders of AutoCAD, I can do only so 
much in a book of this size. I simply don’t have the space to cover such topics as 
data linking and customization.

For more information, visit www.wiley.com and search for AutoCAD to see a list of 
over 100 titles. Ralph Grabowski, the technical editor of this edition, also has more 
than 100 specialized e-books at www.worldcadaccess.com/ebooksonline.

http://www.vaus.org
http://www.augi.com
http://www.wiley.com
http://www.worldcadaccess.com/ebooksonline
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VISRETAIN

Ten System Variables 
to Make Your 
AutoCAD Life Easier

System variables are the settings that AutoCAD checks before it decides how to 
do something. For example, if you leave the system variable SAVETIME at 
its default value of 10, AutoCAD saves the drawing file automatically every 

ten minutes; if you change SAVETIME to 60, the time between automatic saves is 
1 hour. Hundreds of system variables control AutoCAD’s operations.

Most system variables are controlled by the OPtions command, but you can also 
change the value of a system variable by simply typing its name at the AutoCAD 

Chapter 26
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command prompt and pressing Enter. AutoCAD displays the current value of the 
system variable setting and prompts you for a new value. Press Enter to confirm 
the existing setting, or type a value and press Enter to change it.

This list describes the three kinds of system variables in AutoCAD and what hap-
pens when you change them:

 » Saved in the Windows Registry: Affects all drawings when you open them 
on your system, but not necessarily on other computers.

 » Saved in the drawing: Affects only the current drawing, but on any com-
puter. The Drawing icon in the Options dialog box indicates the variables that 
are saved in the drawing. If you change these and then save the drawing as 
a template, all subsequent drawings that you start from this template inherit 
these values. I cover templates in Chapter 4.

 » Not saved anywhere: Lasts only for the current drawing session.

The System Variables section in the Resource area of the online Help system 
indicates the kind of system variable. Several hundred system variables exist, 
but understanding the ones described in this chapter can help make you a happy 
CADster.

APERTURE
APERTURE controls how closely the cursor must be to an object before an object 
snap marker appears. I discuss object snaps in Chapter 11. You can set APERTURE 
from the command line to any value between 1 and 50 pixels, or you can set it in 
the Options dialog box by adjusting the slider to a maximum of 20 pixels. The 
default value is 10.

DIMASSOC
DIMASSOC controls how the AutoCAD dimension objects are created. See Chap-
ter 14 for the lowdown on dimensioning. When DIMASSOC is 0, AutoCAD creates 
exploded dimensions of separate lines, 2D solids, and text. You really don’t want 
to work on DIMASSOC=0 drawings.

When DIMASSOC=1, dimensions are referred to as nonassociative —they’re single 
objects, but they usually don’t update if you change the size of an object.
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When DIMASSOC=2 (the default setting), AutoCAD creates fully associative 
dimensions. You can set this value from the command line or select the Make New 
Dimensions Associative check box after choosing Options ➪ User Preferences.

If you work with older drawings, you’ll likely find that the DIMASSOC value is 1, 
which is the best that releases earlier than AutoCAD 2002 could manage. The 
DIMASSOC setting is stored in the drawing and carries forward from the template.

MENUBAR
When MENUBAR is 1, AutoCAD displays its traditional classic menu bar below the 
application title bar. If MENUBAR is set to 0 (the default), the menu bar doesn’t 
appear. The menu bar can also be turned on and off by using the down arrow at 
the right end of the Quick Access toolbar.

If you’ve been away from AutoCAD for a few years and you feel that you could 
benefit from training wheels while you become accustomed to using the Ribbon, 
display the classic menu bar.

MIRRTEXT
You’ve got to love seeing a clear indication of a system variable’s purpose from its 
name. ROLLOVERTIPS, anyone? You’ll frequently build up a drawing by mirroring 
already-drawn components of it. That’s what the MIrror command does. Luckily, 
AutoCAD realizes that you rarely want to produce a mirror image of any text that 
may be included among the set of objects you’re mirroring. Having to use a mirror 
to read the text on your drawing is counterproductive.

On the other hand, suppose that you want to draw the mold for a cast part, and 
the finished part has some text molded in it, such as a company name or a part 
number. The text features in the mold need to be mirror images so that the final 
cast text is read correctly. No problem: Simply set the MIRRTEXT system variable 
to 1, and the MIrror command mirrors the text. When MIRRTEXT is 0 (the default 
setting), text isn’t mirrored, and the text still reads the right way. MIRRTEXT is 
stored in the drawing and carries forward from the template.
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OSNAPZ
Sometimes, drawing in 3D can be a little puzzling, especially if you’re looking at 
3D objects in orthographic views. Say that you’re looking at a wireframe cube in 
Plan view and you want to draw a line between two diagonal corners on top of the 
cube. By using object snaps to pick the corners, you’ll find, as often as not, that 
the line isn’t on the plane of the top of the box, but that it starts at a top corner 
and ends at a bottom corner. One way around this problem is to set the OSNAPZ 
variable appropriately. Because OSNAPZ is set to 0 by default, AutoCAD finds the 
X,Y,Z coordinates of the snapped-to point — but often, you don’t want that to 
happen. Set OSNAPZ to 1, and AutoCAD replaces the Z value of the picked point 
with the current elevation or the Z value of the first point picked.

Because OSNAPZ affects drawing in three dimensions, it’s unavailable in 
AutoCAD LT.

PICKBOX
The pickbox is the little square box that the cursor turns into when AutoCAD 
prompts you to select an item. You control the pickbox size by setting a value in 
pixels for the PICKBOX variable. The initial setting of PICKBOX is 3, which is fine 
for a lower screen resolution, such as 1024 x 768. But when you start running at 
higher resolutions or when your hair is grayer, your face more wrinkled, and your 
vision not quite as acute as it once was, a higher setting might be more useful.

REMEMBERFOLDERS
Sometimes, you don’t want AutoCAD to start in the same Documents folder where 
every other program stores its files. Maybe you work on a number of projects 
and you want a separate desktop icon for each one to start in a particular folder. 
If so, REMEMBERFOLDERS is your ticket to Nirvana. By default, it’s set to 1, so 
it defaults to storing files in My Documents in Windows XP and Windows 8. It’s 
plain Documents in Windows Vista and Windows 7 and 10.

Set this variable to 0, and it opens from, and saves to, the folder you specify in the 
desktop icon when you start AutoCAD, and in the last folder you visit as you work. 
REMEMBERFOLDERS is stored in the Windows Registry.

There are three signs of old age. The first is loss of memory. I forget the other two.
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ROLLOVERTIPS
You were waiting for this one, weren’t you? ROLLOVERTIPS controls the tooltip-
like message boxes you see when you hover the mouse pointer over objects in the 
drawing area. When ROLLOVERTIPS is set to 1, pausing the cursor on an object 
opens a temporary panel showing the object type with its layer, color, and line-
type. If (like us) you find the panel intrusive, set its value to 0.

This command can serve double duty. You can not only enter it into AutoCAD but 
also (if you have a dog named Tips) use it to teach your pet a neat trick. ROLLO-
VERTIPS is stored in the Windows Registry. And believe it or not (and I would bet 
that you don’t), another system variable is named NOMUTT. Maybe it’s AutoCAD-
ese for BAD DOG TIPS.

TOOLTIPS
A tooltip is the little text box that appears (by default, anyway) when you hover the 
mouse pointer over a toolbar or Ribbon button, or just about anywhere in a dialog 
box. Tooltips are truly useful when you’re getting to know your way around a 
program, but when you have a sense of where things are, they can get in the way. 
By default, TOOLTIPS is set to 1, to appear whenever you hover the mouse pointer 
over a program element.

Set TOOLTIPS to 0 if you don’t want to see tooltips again. The TOOLTIPS setting is 
stored in the Windows Registry.

VISRETAIN
If you work with xrefs (see Chapter  18), you know the potential for competing 
layer properties. Sometimes, you want an xref to look different from the current 
drawing so that you can tell which is which. You can change the layer colors of 
xrefs in the Layer Property Manager, but whether you have to do that every time 
you open a drawing with an attached xref depends on the setting of the VISRE-
TAIN system variable. When VISRETAIN is set to 0, the layer properties in the xref 
take precedence, so you would have to make those changes every time you open 
the host drawing.

When VISRETAIN is set to 1 (the default value), changes you make to layer prop-
erties in the host drawing remain intact every time you open that host drawing; 
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however, those changes have no effect on the external file itself. The VISRETAIN 
value is stored in the current drawing.

And the Bonus Round
This section describes two system variables that are fun to use, even if they don’t 
boost your productivity.

Using MTJIGSTRING, you can substitute as many as ten characters of your choice 
to replace the usual abc prompt when you start the MText command. For example, 
I’m great! just fits.

The last variable I want to tell you about is invoked slightly differently from 
MTJIGSTRING. Enter the following line to turn on the deprecated DOS screen 
menu (which was in use years ago):

(setvar “screenmenu” 1)

The DOS screen menu is fast, has no icons or tooltips, and is fully context- 
sensitive. No longer do you right-click to see command options because it was 
created before 3-button mice even existed. No matter how you start a command, 
its options appear automatically.

Clicking AutoCAD always returns you to the root menu, and clicking **** opens a 
list of the temporary object snap overrides.

The bad news is that the DOS screen menu hasn’t been updated in years because 
it’s deprecated (officially dead but still lying around).
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Ten AutoCAD Secrets

You may have already figured out that your mother never told you about a 
few necessary principles for living your life. Well, AutoCAD has a few prin-
ciples that I don’t tell you about elsewhere in this book.

In this chapter, I list ten additional subjects that you may want to explore on your 
own, using the resources listed in Chapter 25.

Sheet Sets
Very large projects usually involve a great many drawings. At times, you may want 
to look at or plot specific drawings repetitively from a collection. You can use the 
Sheet Set Manager to link individual drawings, and even specific paper-space lay-
outs within drawings, into named sets. See the SHEETSET command.

Chapter 27
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Custom Tool Palettes
Do you regularly use three or four different hatch patterns? Or the same five or six 
standard symbols or details? No problem. If you can drag and drop, you can create 
custom tool palettes from which you can drag and drop elements back into your 
drawings. See the ToolPalettes command.

Ribbon Customization
The Ribbon, and indeed the full specifications for the menu bar and toolbars, are 
stored in a single CUI (Custom User Interface) file. It can be edited and you can 
also have AutoCAD access a secondary CUI file to customize AutoCAD’s interface 
to suit your specific needs. See the CUI command.

Macro Recorder
If you repeatedly perform the same drawing or editing sequence, you can turn on 
the Macro Recorder to record the sequence as you perform it once, and then replay 
it endlessly. (“Holy macro, CadMan!”) See the ACTRECORD command.

Programming Languages
AutoCAD supports a variety of different programming languages:

 » DIESEL is generally used in menu macros and to display program data on the 
status bar.

 » AutoLISP is best suited to custom applications that primarily stay inside 
AutoCAD.

 » .NET, Object ARX, and VBA generally work best in custom applications that 
interact with other types of programs, such as Excel or Word.

See the Developer area of the online Help system.
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Vertical Versions
AutoCAD isn’t the only product made by Autodesk. In fact, the company has about 
140 products and combinations of products called suites, covering a wide range 
of markets in the design and entertainment fields. Virtually all Hollywood special 
effects are produced on Autodesk software (Avatar is one example) along with the 
vast majority of video games and virtually all car ads on TV.

The design products include special versions of AutoCAD for applications such as 
electrical control design, civil engineering, and architecture as well as specialty 
products such as Inventor, which is parametric 3D design and analysis software. 
Do you need to do a stress analysis? Autodesk. How about a virtual wind tunnel? 
Autodesk. Doodling on an iPad? Autodesk. Photographing an object and then 3D 
printing a copy of it? Autodesk.

Language Packs
AutoCAD has been available in a number of languages for many years.

AutoCAD 2013 made using AutoCAD is another language even easier: After install-
ing AutoCAD, simply go to www.autodesk.com and click the Get Support link. 
Browse to find the Data & Downloads section for AutoCAD. There you can find a 
number of different language packs — download and install the ones you need. 
You can then switch between languages simply by launching AutoCAD from the 
appropriate desktop icon.

Multiple Projects or Clients
If you regularly switch between different projects or different clients or both, 
you can make your life easier. For example, you can modify the properties of the 
shortcut icon on your desktop to have AutoCAD start from a specific template file, 
use a specific default folder, use a specific default template file, and start from a 
specific profile in the Options command. Next, create several desktop icons, one 
for each set of circumstances. Then, when you are working on a particular project, 
simply start AutoCAD from the appropriate shortcut, and it comes up ready to 
rumble.

http://www.autodesk.com
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Data Extraction and Linking
AutoCAD (but not AutoCAD LT) can extract properties of objects, including ele-
ments such as the areas surrounded by polylines, and then write them to a table 
within the drawing or extract them to an Excel spreadsheet (or both). See the 
DATAEXTRACTION command.

Untying the Ribbon
I grumbled earlier in the book about the space taken up by the Ribbon as screens 
get wider, not taller. If you want the graphic screen to be closer to the same pro-
portions as a plotted drawing, reduce the screen so that it displays only the panel 
names. The panels fly out when you hover your cursor over their names.

The Ribbon can also be docked along one side or the other instead of across the 
top, and individual tabs can be dragged to a second monitor.
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Index
• A •
A360

about, 411–412
collaborating with, 413
cost of, 414–417
options for, 413
sharing with, 413
troubleshooting, 414
website, 414, 417

A360 tab (Ribbon), 28–29
Absolute Cartesian coordinates, 129, 131, 428
Account Sign In dialog box, 412
accumulating properties, 150–151
accuracy

checking of objects, 133
compared with precision, 128

ACI (AutoCAD Color Index), 152
ACTRECORD command, 508
Add Scales to Object dialog box, 244
Add-Ins tab (Ribbon), 28
Advanced Render Settings palette  

(View tab of Ribbon), 427
ALIASEDIT command, 119
aliases, 4, 32
ALign command, 460
Aligned constraint, 389
ALL option, 172
Allen, Lynn (blogger), 498
Alternate Units tab, 271
angle units, 65
angled brackets, 35
Angular constraint, 389
Annotate tab (Ribbon), 28
annotating drawings, methods for, 223–224
Annotation Visibility button, 244
annotational constraints, 397
annotational dimensions, 399
Annotative function (Hatch tab), 285
annotative hatch objects, 287

annotative objects, 222, 242–245
annotative scaling, 61, 242–245
anonymous block, 253, 470
ANSI31 pattern, 55, 286
APERTURE system variable, 502
APParent Intersection mode, 136
Application menu

about, 21
commands on, 24–25
features of, 25–26

application status bar, 30
applications, 361
Arc command, 112, 114–115
Arc option (ELlipse command), 116
arc segments, adding to polylines, 106–107
Architectural units, 65
arcs, 114–115
area selection, 172
-ARray command, 191–192, 344–345
ARRAYCLASSIC command, 344
ARRAYEDIT command, 178, 345, 351
ARRAYPATH command, 178, 349–350
ARRAYPOLAR command, 178, 348–349
ARRAYRECT command, 178, 343
arrays

about, 341–343
creating, 343, 346–348
creating with ARRAYRECT command, 343

arrowheads, 262–263
associative arrays, 344, 345, 351–352
associative dimension object, 263
Associative function (Hatch tab), 285
associative hatch objects, 287
ATCs (Autodesk Authorized Training Centers), 499
Attach button, 352
Attach External Reference dialog box, 354–355
Attach Image dialog box, 363–364
Attach PDF Underlay dialog box, 366
ATTDIA (ATTribute DIAlog box) system variable, 337
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Attribute Definition dialog box, 334–336
attribute definitions

about, 329, 334
creating, 334–336
defining blocks that contain, 336–337
inserting blocks that contain, 337

attribute values, 334, 337–338
attributes, 324, 333–334, 342–343, 361
AU (Autodesk University), 498
AUGI (Autodesk User Groups International), 500
Auto Constrain button, 387–388
AutoCAD. See also specific topics

about, 1, 9
Cartesian coordinate system, 15–16
closing, 26
drawings, 5, 11–14
DWG file format, 16–17
installing, 27
launching, 10–11
pixels, 14–15
vectors, 14–15

AutoCAD Color Index (ACI), 152
AutoCAD Drawing Setup Roadmap, 64
AutoCAD Insider blog, 498
AutoCAD LT. See AutoCAD
AutoCAD Users Society (website), 500
AutoComplete feature, 32
Autodesk

about, 2
bloggers, 498
discussion groups, 498
website, 509
YouTube channel, 499

Autodesk Authorized Training Centers (ATCs), 499
Autodesk Design Review, 414, 490
Autodesk DWG TrueView, 414
Autodesk Feedback Community (website), 497
Autodesk Single Sign-on Account, 411
Autodesk University (AU), 498
Autodesk User Groups International (AUGI), 500
AutoLISP, 508
Automatically Add Scales to Annotative Objects button, 

244
axes, 16

• B •
Background dialog box, 482
Background Mask dialog box, 237
backgrounds, defining, 481–483
BAK command, 206
base plate, drawing a, 45–53
base point, 180, 326
Between the Lines blog, 498
Bind option (External References palette), 360
bitmap (BMP) files, 14, 486–487. See also raster images
BLEND command, 178, 197–199
block, 248
Block Definition dialog box, 326–329
block definitions

adding action to, 324, 371–373
creating, 326–329
purging, 339–340

block insertion, 324
block redefinition, 326
blocks. See also dynamic blocks

about, 323, 342
anonymous, 253, 470
applications for, 361
attributes, 333–338
benefits of using, 324–325
creating definitions, 326–329
defining, 336–337
exploding, 338–339
inserting, 330–333
purging unused definitions, 339–340
using, 324–326

bloggers (Autodesk), 498
BMP (bitmap) files, 14, 486–487. See also raster  

images
books, as resources, 500
Boolean editing, 454, 462–463
borders, 70–71
Boundaries option (Hatch tab), 283–284
brackets, 35
BReak command, 178, 196–197
B-splines, 117
bulleted lists, 237–240
ByLayer approach, 144–146



Index      513

• C •
Cadalyst magazine (website), 499
calculating non-annotative text height, 228–229
Cartesian coordinate system, 15–16
"The cell phone story" (Allen), 498
CELTSCALE system variable, 79
center lines, 259
Center Marks setting, 269
CENter mode, 136
Center option (ELlipse command), 116
CENTERLINES command, 259
CENTERMARK command, 259
CGA (Color Graphics Adapter), 15
CHAmfer command, 178, 197–199
CHAMFEREDGE command, 461, 463
chanfers, 463
Change Space command, 201
Cheat sheet (website), 6
CHSPACE command, 201
Circle command, 112–114, 390
circles, 112–114
Circles and Lines tutorial, 499
Circumscribed option, 50
clients, multiple, 509
CLIP command, 360
cloning hatches, 288
Close command (Application menu), 25
Close option (Hatch tab), 286
CLOSEALLOTHER command, 25
cloud

about, 405
advantages of, 410
disadvantages of, 410–411
uses for, 409, 410–411

cloud layers, creating, 122
CNC (computer numerically controlled), 129
Coincident constraint, 380
coincident icon, 383
collaboration

with A360, 413
about, 485–486
bitmap (BMP) files, 486–487

collinear, 200
Collinear constraint, 380

Color Graphics Adapter (CGA), 15
Color property, 150
color-dependent plot style table (CTB) files, 307
color-dependent plot styles, 305
colors

plotting, 305–315
printing in, 22

columns
drawing area, 52–53
rearranging order, 158
types of, 240–241

comma (,), 12, 43
command line

about, 4, 12, 22
compared with Dynamic Input, 98
Enter key and, 114
finding layers with, 157
ONLINEDOCS, 411
using, 31–32
working with, 33–34

command-first editing
about, 166
benefits of, 167–168
with Move command, 182
options with, 172

commands
ACTRECORD, 508
ALIASEDIT, 119
ALign, 460
Arc, 112, 114–115
-ARray, 191–192, 344–345
ARRAYCLASSIC, 344
ARRAYEDIT, 178, 345, 351
ARRAYPATH, 178, 349–350
ARRAYPOLAR, 178, 348–349
ARRAYRECT, 178, 343
BAK, 206
BLEND, 178, 197–199
BReak, 178, 196–197
CENTERLINES, 259
CENTERMARK, 259
CHAmfer, 178, 197–199
CHAMFEREDGE, 461, 463
CHSPACE, 201
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commands (continued)

Circle, 112–114, 390
CLIP, 360
CONVERTPSTYLES, 307
COpy, 51, 178, 182–183
COPYCLIP, 183
for curves, 111–112
CUTCLIP, 183
DATAEXTRACTION, 249, 510
DATALINK, 249
DIM, 260–261
DimAligned, 257, 260
DimANgle, 257, 260
DimARc, 258
DimBAseline, 259, 275
DIMBREAK, 275
DIMCENTER, 258
DimCOntinue, 259
DimDIameter, 257–258, 260, 377
DimDisAssociate, 278
for dimensions, 256–262
DimJOgged, 258, 275
DimLinear, 254, 257, 260
DimORdinate, 258
DimRAdius, 257–258, 260
DIMREASSOCiate, 277, 278
DIMREGEN, 278
DIMSPACE, 275
DimSTyle, 162
DLine, 105
DOnut, 112, 119–120
DOO-DOO, 205
DRaworder, 364
DRAWORDER, 276
EATEDIT, 337–338
ELlipse, 112, 115–116
Erase, 173–174, 178
ETRANSMIT, 360, 363, 402–405
eXplode, 178, 197, 276
EXPort, 487, 489
EXPORTDWF, 489
EXtend, 178, 194–196
EXTrude, 456
FILLET, 52, 178, 197–199

FILLETEDGE, 461, 463
FIlter, 175
FLATSHOT, 472
Hatch, 280, 282
HIDEOBJECTS, 175
INtersect, 462
ISOLATEobjects, 175
JOIN, 178, 200, 202
LAyer, 45–46, 162, 278, 282
LAYISO, 159
LEADER, 250
LENgthen, 178, 196
LIMITS, 89
Line, 99, 100–107
LineType, 162
LIVESECTION, 472
LOFT, 457
LTScale (LineTypeScale), 161
MATbrowser, 479
MIrror, 51, 178, 187–188, 461
MLeaDer, 250–252
MLeaderAlign, 252
MLeaderCollect, 252
MLeaderEdit, 252
MLeaderStyle, 252
MLine, 105
MLStyle, 105
Move, 178, 179–180, 181–182, 459–460
MREDO, 206
mText, 229–230, 233–242
MYSETUP, 472
NCOPY, 339
OFFset, 105, 178, 192–194
ONLINEDOCS, 412
OOPS, 205
OVERKILL, 178, 202
PAGESETUP, 210, 211
PASTEBLOCK, 183
PASTECLIP, 183
PEdit (Polyline Edit), 178, 202
PLine, 99, 100–107
PLOT, 68, 487
POLygon, 99, 108–109
Polyline Edit (PEdit), 119
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PRESSPULL, 456
PUBLISH, 489
PUrge, 162, 339
QNEW (Quick NEW), 72
Quick Dimenions, 259–260
RAY, 100
RECtang, 99, 107–108, 390
REDO, 205
REFEDIT, 357
REgen, 94
REgenAll, 93
REVCLOUD, 112, 120–122
REVERSE, 178, 202
REVolve, 458
ROtate, 178, 189–190, 459–460
running, 35
SCale, 69, 178, 190–191, 459–460
SECTIONPLANE, 472
SECTIONPLANEJOG, 472
SECTIONPLANETOBLOCK, 472
SETBYLAYER, 146
SHEETSET, 507
SLice, 463–464
SOLDRAW, 472
SOLPROF, 472
SOLVIEW, 472
SPLine, 112, 117–119
SPLINEDIT, 118
starting, 12
straight-line drawing, 99–100
Stretch, 56–59, 178, 183–187
STyle, 242
SUbtract, 462
SV$, 206
SWEEP, 457
TABLE, 247–249
TABLESTYLE, 245–247
TEXT, 229–230, 230–232, 242
TEXTTOFRONT, 237, 276
3DALign, 461
3DDWF, 489
3DPOLY, 452
TOLerance, 271
TRim, 178, 194–196

U, 205
UNDO, 205
UNIon, 462
UNISOLATEobjects, 175
View, 90
VIEWBASE, 473
VIEWDETAIL, 473
VIEWPROJ, 471
VIEWRES, 94
VIEWSECTION, 473
VPORTS, 447
WBLOCK (WriteBlock), 329, 340
WMFOUT, 488
XLine, 100
XOPEN, 357
Zoom All, 180

compatibility, 492–493
complex (compound), 454
compressing, 184
computer numerically controlled (CNC), 129
computing, using cloud for, 409
Concentric constraint, 380
Conceptual visual style, 439
consistency, of command-first editing, 167
Constrained mode, 436
Constraint Settings dialog box, 387–388, 393–394, 397
constraints

about, 379
applying, 381–386
compared with dimensions, 396–399
deleting, 384
geometric, 380–388
inferred, 386–387

Continuous mode, 436
convenience

as an advantage of using cloud for file storage, 410
as a disadvantage of using cloud for file storage, 411

Convert constraint, 389
Convert to Block radio button, 329
CONVERTPSTYLES command, 307
Coordinate input technique, 127
coordinate system. See world coordinate system (WCS)
COpy command, 51, 178, 182–183
COPYCLIP command, 183
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CPolygon option, 172
Create Library dialog box, 480
Create New Table Style dialog box, 246
Create Transmittal dialog box, 403–404
crosshatches

about, 55–56, 279
adding style, 288–289
creating, 279–283, 289–291
creating from scratch, 289–291
editing, 291–292
Hatch tab, 283–286
modifying, 281
scaling, 286–287

crossing lasso, 171
crossing object selection, 169–170
Crossing option, 172
CTB (color-dependent plot style table) files, 307
CUI (Customizable User Interface), 146
CULLINGOBJ system variable, 459
CULLINGOJSELECTION system variable, 459
current layer, 149, 156
current properties, 147
cursor, 12, 216
curves

about, 97, 111
arcs, 114–115
circles, 112–114
commands for, 111–112
donuts, 119–120
ellipses, 115–116
points, 122–123
revision clouds, 120–122
splines, 117–119

custom font files, 403
custom patterns, 284
custom tool palettes, 508
Customizable User Interface (CUI), 146
customizing Ribbon, 27, 508
CUTCLIP command, 183
Cylindrical coordinates, 428

• D •
dash-dot linetypes, 66
data, extracting/linking, 338, 510

DATAEXTRACTION command, 249, 510
DATALINK command, 249
DDE (Direct distance entry) mode, 139–140
dead-tree paper, 67
Decimal Degrees units, 65
Decimal units, 65
default configuration, 22
default drawing templates, 71
default lighting, 474, 475
DEFAULTLIGHTING system variable, 475
deferred perpendicular, 137
deferred tangent, 137
definition points (defpoints), 263
degenerating, 93–94
Deg/Min/Sec units, 65–66
Delete Duplicate Objects tool, 202
Delete radio button, 329
DELOBJ system variable, 456
Descartes, René (philosopher)

Discourse on Method, 15–16
Design Feed button, 411
Design Feed palette, closing, 20
design intent, maintaining, 376–379
Design Web Format (DWF), 323, 342, 365–367, 489–490
DesignCenter, 162–164, 332
Detach option (External References palette), 360
DGN, 366
Diameter constraint, 389
Diameter (D) option (Circle command), 112
DIESEL, 508
digital signature, 408
DIM command, 260–261
DimAligned command, 257, 260
DimANgle command, 257, 260
DimARc command, 258
DIMASSOC system variable, 502–503
DimBAseline command, 259, 275
DIMBREAK command, 275
DIMCENTER command, 258
DimCOntinue command, 259
DIMDEC system variable, 264
DimDIameter command, 257–258, 260, 377
DimDisAssociate command, 278
dimension associativity, 277–278
dimension geometry, editing, 274–276
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dimension lines, 262–263
dimension scales, setting, 77–79
Dimension Style Manager dialog box, 266, 267, 268
dimension styles (dimstyle), creating, 265–268
dimension text, 262–263, 276–277
dimension variables (dimvars), 265
dimensional constraints, 378, 388–399
dimensions

adding in model space, 223–224
adding in paper space, 223
adding to drawings, 254–255
commands for, 256–262
compared with constraints, 396–399
defined, 253
driven, 388
driving, 389
editing, 274–278
layers and, 278
placing in model space, 261–262
placing in paper space, 261
reasons for having, 256
scaling dimensions for output, 271–274
styles for, 262–271
using system variables with, 264

DimJOgged command, 258, 275
DIMLFAC system variable, 272
DimLinear command, 254, 257, 260
DIMLUNIT system variable, 264
DimORdinate command, 258
DimRAdius command, 257–258, 260
DIMREASSOCiate command, 277, 278
DIMREGEN command, 278
DIMSCALE system variable, 229, 270
DIMSPACE command, 275
DimSTyle command, 162
Direct distance entry (DDE) mode, 127, 139–140
direct-object manipulation, 166
Discourse on Method (Descartes), 15–16
discussion groups (Autodesk), 498
distant light, 476
dithering, 314
DLine command, 105
docking Ribbon, 27, 510
DOnut command, 112, 119–120
donuts, 119–120

DOO-DOO command, 205
double floating-point precision, 93
double period (..), 359
Drafting & Annotation workspace, returning to, 29
Drafting Settings dialog box, 76
dragging and dropping blocks, 332
draw order, setting, 282
drawing area

columns, 52–53
drawing on, 36–37
using, 36–37

drawing commands, groups of, 97
Drawing icon, 502
drawing properties, entering, 79
Drawing Properties dialog box, 79, 237
drawing scale

common architectural, 69
versus drawing scale factor, 68
text and, 228–229

drawing scale factor, versus drawing scale, 68
drawing screen, 20–29
Drawing Units dialog box, 65, 75
Drawing Utilities command (Application menu), 25
Drawing Utilities dialog box, 74
drawing window, for 3D models, 424
drawing(s)

adding dimensions to, 254–255
AutoCAD, 5, 11–14
a base plate, 45–53
basic 3D objects, 452–453
by coordinates, 131–133
copying between, 183
on drawing area, 36–37
exporting in WMF format, 488
geometry, 98
intelligent, 392
lines, 100–107
navigating, 87–88
plotting, 59–62
polylines, 100–107
revision clouds, 120–122
saving, 53
splines, 117–118
techniques for, 98–99
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DRaworder command, 276, 364
driven dimensions, 388
driving dimensions, 389
Dropbox, 405
Dummies (website), 41, 382, 390
DWF (Design Web Format), 323, 342, 365–367, 489–490
DWFx files, 490
DWG file format, 16–17
dynamic blocks

about, 367
manipulating, 373–374
visibility of, 367–371

dynamic columns, 240–241
dynamic constraints, 397
Dynamic Input

compared with command line, 98
PLine command and, 102–103
toggling, 33–34
using, 30–31

Dynamic UCS, using, 434

• E •
EATEDIT command, 337–338
edge object, 423
Edit Block Definition dialog box, 328, 368, 372
Edit Drawing Scales dialog box, 212
editing. See also command-first editing

about, 165, 177
-ARray command, 191–192
attribute values, 337–338
BLEND command, 197–199
Boolean, 454, 462–463
BReak command, 196–197
CHAmfer command, 197–199
controlling visibility of objects, 175–176
COpy command, 179–180, 182–183
crosshatching, 291–292
Delete Duplicate Objects tool, 202
dimension associativity, 277–278
dimension geometry, 274–276
dimension text, 276–277
dimensions, 274–278
EXtend command, 194–196
external reference files, 356–357

Fillet command, 197–199
grips, 203–205
Groups panel, 175
hatches, 288
JOIN command, 200, 202
MIrror command, 187–188
Move command, 179–182
object's properties, 201
Offset command, 192–194
other drawing file formats, 491
OVERKILL command, 202
PEdit (Polyline Edit) command, 202
Portable Document Format (PDF), 491–492
REVERSE command, 202
ROtate command, 189–190
SCale command, 190–191
selecting objects, 168–175
solids, 461–464
Stretch command, 179–180, 183–187
styles of, 166–168
tables, 247–249
toolkit for, 177–179
TRim command, 194–196
troubleshooting, 205–206

electronic paper, 67
electronically drafting, 67
ELEVATION system variable, 429
ELlipse command, 112, 115–116
ellipses, 115–116
encrypted copies, saving, 413
ENDpoint mode, 136
Engineering units, 65
Enter key, command line and, 114
Equal constraint, 381
Erase command, 173–174, 178
ETRANSMIT command, 360, 363, 402–405
eXplode command, 178, 197, 276
exploding blocks, 338–339
EXPort command, 24, 487, 489
EXPORTDWF command, 489
Express Tools tab (Ribbon), 27, 29
EXtend command, 178, 194–196
extension lines, 263
extents, 295
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external reference file (xref)
about, 341–343, 403
applications for, 361
attaching, 354–356
creating, 356–357
editing, 356–357
layers and, 356
managing, 359–360

External References palette, 359–360
extracting

data, 338, 510
raster images, 486–487

EXTrude command, 456

• F •
F1, 37–38
F12 key, 30–31
face, applying materials to objects by, 481
face object, 423
Face option (UCS command), 431
fading objects on locked layers, 159
feedback, 41
Fence option, 172
file formats. See also collaboration

about, 17
editing, 491
types of, 403

file storage, using cloud for, 409, 410–411
File Transfer Protocol (FTP), 405
files

missing, 406
opening using 3D templates, 425–426
receiving, 406
security of, 408
sending, 402
vector, 15

FILLET command, 33, 52, 178, 197–199
FILLETEDGE command, 461, 463
fillets, 463
fill-in-the-blank text fields. See attributes
FIlter command, 175
Find and Replace dialog box, 242
Fit tab, 269–270
Fit to Paper option (Plot dialog box), 70
Fix constraint, 380

fixed height, 227
FLATSHOT command, 472
flexibility, of command-first editing, 167
Fluent User Interface (FUI), 19
Folders tab (DesignCenter), 163
font, 224, 225–226
FONTALT system variable, 403
FONTMAP system variable, 403
Fractional units, 65
framing, 488–489
Free mode, 436
Freeze/Thaw visibility mode, 158
freezing layers, 62, 218
FTP (File Transfer Protocol), 405
FUI (Fluent User Interface), 19
Full Navigation wheel, 438
full path, 357
full view, returning to, 54

• G •
gear icon, 41
generic lighting, 476
geographic data, 333
Geometric CEnter mode, 136
geometric constraints

about, 378, 380–388, 399
applying, 393
using, 382–386

Geometric Tolerance dialog box, 271
geometric tolerances, 271
geometrical properties, 93
geometry, 98, 126
gizmos, 459–460
glyph, 477
Google Drive, 405
Grabowski, Ralph (author)

blog for, 499
e-books of, 500
What’s Inside? AutoCAD for Macintosh, 2

Grads units, 66
Graham, Rick (author)

Mastering AutoCAD For Mac, 2
graphic screen, 21
graphics card, 424–425
Grid Behavior area, 77
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Grid display technique, 127
Grid mode, 75–77
grip-edit, 241
grips, 203–205, 461–464
Group feature, 325
group filter, 159
grouping objects, 325
Groups panel, 175

• H •
hardware acceleration, 424
Hatch and Gradient dialog box, 288, 289–290
Hatch command, 280, 282
Hatch Creation tab, 55
Hatch tab, 283–286
hatches. See crosshatches
hatching, 66
Helix object, 452
Help feature, 37–38
Hewitt, Heidi (blogger), 498
Hidden visual style, 439
Hide All button (Geometric panel), 381
Hide Paperspace Objects option (Plot dialog box), 318
HIDEOBJECTS command, 175
hiding objects on layers, 160
History tab (DesignCenter), 163
Home tab (Ribbon), 28, 426
Home view, 438
Horizontal constraint, 381, 389
horizontal dimension, 255
Hurley, Shaan (blogger), 498

• I •
icons, explained. See also specific icons
images, raster, 14
Imperial units, 40
implied windowing, 169
Import command (Application menu), 24
Infer Constraints technique, 127
inferential, 390
inferred constraints, using, 386–387
InfoCenter, 23–24
input formats, 428
Inscribed option, 50

Insert dialog box, 330–331, 372
Insert Field option, 237
Insert tab (Ribbon), 28
Insert Table dialog box, 247, 248
INSertion mode, 136
installing AutoCAD, 27
intelligent drawings, 392
interface

about, 19, 29–30
Application menu, 24–26
application status bar, 30
command line, 31–32
drawing area, 36–37
drawing screen, 20–29
Dynamic Input, 30–31
F1, 37–38
InfoCenter, 23–24
keyboard, 32–35
palettes, 36
Ribbon, 26–29
sections of, 21–22

Internet features
A360, 411–417
about, 401–402
cloud, 405, 409–417
ETRANSMIT command, 402–405
file security, 408
File Transfer Protocol (FTP), 405
receiving files, 406
Reference Manager, 406–407
sending files, 402

INtersect command, 462
INTersection mode, 136
ISOLATEobjects command, 175
isometric projection, 469
isometric views, 435, 450, 469

• J •
JOIN command, 178, 200, 202

• K •
keyboards

coordinate entry formats, 129–130
using, 32–35
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• L •
language packs, 509
lasso selection mode, 170–171
Last option, 172
launching AutoCAD, 10–11
layer 0, 156
LAyer command, 45–46, 162, 278, 282
layer filters, creating, 159
Layer Properties Manager palette, 46, 151, 157–158
layer states, creating, 158
Layer States Manager dialog box, 158
Layer Transparency dialog box, 154–155
layers

about, 148–149
applying materials to objects by, 481
controlling object properties by, 144–146
creating, 46–47, 151–157
dimensions and, 278
external reference drawings and, 356
freezing, 218
frozen, 62
isolating, 159
manipulating, 157–160
organizing objects on, 99
setting to be current layers, 156
stacking, 148

Layers and Properties control lists, 201
LAYISO command, 159
Layout Properties Manager palette, 155
Layout tab (Ribbon), 29
layout tabs, 212–213
layouts

creating, 217
deleting, 217
setting up in paper space, 210–213

LEADER command, 250
leaders

defined, 221
multiline, 249–252

The Learning Curve tutorial, 499
length units, 65
LENgthen command, 178, 196
lighting, adding, 474–478
LIGHTINGUNITS system variable, 476
Lights in Model palette (Render tab of Ribbon), 427

LIMITS command, 89
Line command, 99, 100–107
Line object, 452
Linear constraint, 389
lines, drawing, 100–107
Lines tab, 269
linetype, setting, 77–79
LineType command, 162
linetype definition, 156
Linetype Manager dialog box, 78
Linetype property, 150
Lineweight property, 150, 157
lineweights, plotting, 305–315
linking data, 510
List of external references option (External References 

palette), 359
lists, 237–240
LIVESECTION command, 472
locking viewport scale, 212
Lock/Unlock visibility mode, 158
LOFT command, 457
lofting, 457
longevity, of command-first editing, 167
LT Unlimited blog, 498
LTScale (LineTypeScale) command, 78, 161
Ludlow, Robert T. (author)

Raising Chickens For Dummies, 279
Lynn Allen's Blog, 498

• M •
M2P mode, 136
Macro Recorder, 508
major axis, 115
Manage Cell Styles dialog box, accessing, 246
Manage tab (Ribbon), 28
mask, 276
Mastering AutoCAD For Mac (Omura and Graham), 2
MATbrowser command, 479
Match Properties function (Hatch tab), 201, 285
materials, creating and applying, 479–481
Materials Browser palette (View tab of Ribbon), 427
Materials Editor palette (View tab of Ribbon), 427
MBUTTONPAN system variable, 87
MEASUREINIT system variable, 66, 266
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MEASUREMENT system variable, 66, 267
MENUBAR system variable, 503
mesh surfaces, 422
Mesh tab (Ribbon), 426
MIDpoint mode, 136
minor axis, 115
MIRRHATCH system variable, 292
MIrror command, 51, 178, 187–188, 461
MIRRTEXT system variable, 188, 503
missing files, 406
MLeaDer command, 250–252
MLeaderAlign command, 252
MLeaderCollect command, 252
MLeaderEdit command, 252
MLeaderStyle command, 252
MLine command, 105
MLStyle command, 105
model geometry, 207, 216
Model palette, 478
model space

about, 36, 70, 207–210
adding dimensions in, 223–224
adding text in, 223–224
checking whether you're in, 216
placing dimensions in, 261–262
snapping into, 218
tips for, 217
utilizing, 73–79

model space layout, plotting, 294–303
model space viewports, 214
Model tab, 212–213
modes, object snap, 136
Modify Dimensions Style dialog box, 268, 269, 270, 275
Morrical, Kate (blogger), 498
Move command, 178, 179–180, 181–182, 459–460
moving objects, 50–51
MREDO command, 206
MSLTSCALE system variable, 79
mText command, 229–230, 233–242
Mtext Edit option (mText command), 241
MTEXTCOLUMN system variable, 235
MTEXTTOOLBAR system variable, 234
MTJIGSTRING system variable, 506
multiline leaders, 249–252
multiline text objects, modifying, 241–242

multilines, 105
multiscale drawings, creating, 272–274
MYSETUP command, 472

• N •
NAD (Napkin-Aided Design), 379
Name and Expression option (Constraint Settings dialog 

box), 393
Name option (Constraint Settings dialog box), 393
named objects, using, 161–162
named plot style table (STB) file, 307
named plot styles, 305
Named UCSs tab (UCS dialog box), 431
named views, creating, 90–92
naming user coordinate systems (UCS), 430–434
Napkin-Aided Design (NAD), 379
naturalness, of command-first editing, 167
Navigate 2D panel, 88
Navigate panel, 88
Navigation bar, 87, 88
navigation buttons, turning off, 88
NCOPY command, 339
NEArest mode, 136
.NET, 508
New command (Application menu), 24
New Dimension Style dialog box, 268, 269, 270, 275
New Page Setup dialog box, 210
New Table Style dialog box, 246
New Text Style dialog box, 227
New View/Shot Properties (New View in AutoCAD LT) 

dialog box, 91–92
NODe mode, 136
non-annotative text height, calculating, 228–229
non-associative array, 344
non-orthogonal line, 254
non-system drivers, 299
nudging, 179
numbered lists, 237–240
NURBS surfaces, 117, 422

• O •
Object ARX, 508
object lineweights, controlling plotted lineweights with, 311
Object option (REVCLOUD command), 121
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Object option (Zoom command), 90
object properties

about, 79, 143, 144
changing, 146–147
controlling, 144–147
DesignCenter, 162–164
layers, 148–161
named objects, 161–162

object snap modes, 136
Object snap overrides technique, 127, 133–137
Object snap technique, 127
Object snap tracking mode, 127, 140, 429
object snaps (osnaps)

in 3D models, 429
about, 133, 142
grips and, 203–204
tools for, 126–129

objects. See also specific objects
applying materials to objects by, 481
checking accuracy of, 133
controlling visibility of, 175–176
deselecting, 169
editing properties of, 201
extruding, 455–456
fading on locked layers, 159
grouping, 325
hiding on layers, 160
isolating on layers, 160
moving, 50–51
named, 161–162
one-by-one selection of, 169
organizing on layers, 99
scaling linetype, 160–161
selecting, 168–175, 184
selecting to stretch, 184
table, 245–249

observable universe (website), 15
Off/On visibility mode, 158
OFFset command, 105, 178, 192–194
offset distance, 192
Omura, George (author)

Mastering AutoCAD For Mac, 2
one-by-one selection, of objects, 169
Online tab. See A360
ONLINEDOCS command, 411, 412

OOPS command, 205
Open command (Application menu), 24
Open Documents (Application menu), 25
Open Drawings tab (DesignCenter), 163
Open option (External References palette), 360
opening files using 3D templates, 425–426
Options (Application menu), 25
Options dialog box, 88, 299, 413
orbiter modes, 436–437
organizing objects on layers, 99
Origin option (Hatch tab), 285
Ortho (F8) button, 48
Ortho mode

about, 127
turning off, 122
turning on, 184–185
using, 139

Orthographic UCSs tab (UCS dialog box), 431
orthographic views, 435, 450
OSNAPZ system variable, 429, 504
output, scaling dimensions for, 271–274
Output tab (Ribbon), 28, 426
OVERKILL command, 178, 202
overriding styles, 276

• P •
padlock icon, 383, 399
Page Setup dialog box, 210–211, 311, 314
Page Setup Manager dialog box, 304, 315
page setups, plotting, 315–316
PAGESETUP command, 210, 211
palettes, using, 36
panning, 54, 85–86
paper, drafting on, 67
paper space

about, 36, 70, 207–210
adding dimensions in, 223
adding text in, 223
checking whether you're in, 216
defined, 303
placing dimensions in, 261
setting up layouts in, 210–213
tips for, 217
tricks for, 217–218
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paper space layout, plotting, 303–305
paper space viewports, 214–216
paper text height, 228
Paragraph dialog box, 239–240
paragraph text, 229
Parallel constraint, 380
PARallel mode, 136
parallel projection, 436
parameter, defined, 378
Parameters Manager, using, 394–396
Parametric tab (Ribbon), 28
parametrics

about, 375–376
categories of, 378
compatibility and, 493
dimensional constraints, 388–399
geometric constraints, 380–388
maintaining design intent, 376–379

password protection, 408
PASTEBLOCK command, 183
PASTECLIP command, 183
Path option (External References palette), 360
Pattern button, 290
Pattern option (Hatch tab), 284
PDF (Portable Document Format), 365–367, 407, 489, 

491–492
PEdit (Polyline Edit) command, 119, 178, 202
period (.), 12, 16, 359
perpendicular, 384
Perpendicular constraint, 380
PERpendicular mode, 136
perspective projection, 436
PERSPECTIVE system variable, 435
photometric lighting, 476
PICKBOX system variable, 504
pixels, 14–15
planes, changing, 429–434
players, accumulating properties, 150–151
PLine command, 99, 100–107
Plot Area option (Plot dialog box), 318
PLOT command, 68, 487
Plot dialog box, 70, 295–296, 301, 303–304, 311, 313, 314, 

315, 316–319
Plot - Model dialog box, 59–61, 295
Plot Offset option (Plot dialog box), 318

Plot Options (Plot dialog box), 318
Plot Scale Confirm dialog box, 61
Plot Stamp On option (Plot dialog box), 317
Plot style property, 150
plot style sheets, 403
Plot to File option (Plot dialog box), 317
Plot Upside-Down option (Plot dialog box), 318
plotted text height, 228
Plotter Configuration Editor dialog box, 317
Plotter Manager's Add-a-Plotter Wizard, 301
plotting

about, 59, 293
colors, 305–315
compared with printing, 294
drawings, 59–62
frozen layers, 62
lineweights, 305–315
model space layout, 294–303
page setups, 315–316
paper space layout, 303–305
Plot dialog box, 316–319
troubleshooting, 319–320

point filters, using, 428–429
point light, 476
POint object, purposes of, 122
Point Style dialog box, 123
points, 97, 122, 184
polar arrays, creating, 348–349
Polar tracking mode, 127, 141
PolarSnap mode, 127, 141
POLygon command, 99, 108–109
Polygonal option (REVCLOUD command), 121
Polyline Edit (PEdit) command, 119, 178, 202
polylines

adding arc segments to, 106–107
connecting lines with, 102–107
drawing, 100–107

Portable Document Format (PDF), 365–367, 407, 489, 
491–492

precision
about, 125
compared with accuracy, 128
controlling, 126–129
object snaps, 133–138
techniques for, 139–142
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tools for, 98, 127
world coordinate system (WCS), 129–133

predefined hatch patterns, 290–291
preparing to write text, 222–224
PRESSPULL command, 456
previewing, 301
Previous option, 90, 172
Primary Units tab, 270
primitives, 454
Print and Scan Doctor utility, 320
Print command (Application menu), 25
print preview, 301
printer driver, 298
Printer/Plotter option (Plot dialog box), 317
printers, configuring, 299–301
printing. See also plotting

in color, 22
compared with plotting, 294

process
about, 39–40
drawing a base plate, 45–53
making templates, 80–84
model space, 73–79
modifying, 55–59
panning, 54
plotting, 59–62
setup, 40–45
templates, 71–73
zooming, 54

programming languages, 508
projects, multiple, 509
properties

accumulating, 150–151
changing, 146–147
drawing, 79
layer, 157
of objects, 201

Properties option (Hatch tab), 284–285
Properties option (mText command), 241
Properties palette, 146–147, 201, 292
property filter, 159
PSLTSCALE system variable, 79
Publish command, 24, 489
Publish dialog box, 365

PUrge command, 162, 339
Purge dialog box, 162
purging block definitions, 339–340

• Q •
QNEW (Quick NEW) command, 72
QUAdrant mode, 136
Quick Access toolbar, 21, 23
Quick Dimenions command, 259–260
Quick Properties option (mText command), 241
Quick Properties palette, 146–147, 201, 232, 292

• R •
Radial constraint, 389
Radians units, 66
Radius option (Circle command), 112
Raising Chickens For Dummies (Willis and Ludlow), 279
raster images

about, 14, 342, 362–363, 403
attaching, 363–364
extracting, 486–487
maintaining, 364–365

RAY command, 100
Realistic visual style, 439
Realtime option (Zoom command), 90
real-time panning, 86
Recent Documents (Application menu), 25
RECtang command, 99, 107–108, 390
Rectangular option (REVCLOUD command), 121
REDO command, 205, 206
REFEDIT command, 357
Reference Manager, 406–407
Reference Manager - Add Xrefs dialog box, 407
REgen command, 94
REgenAll command, 93
regenerating, 93–94
REGEN-MODE system variable, 93
Relative Cartesian coordinates, 428
Relative coordinates, 129, 131
Relative polar coordinates, 130, 131, 428
Reload option (External References palette), 359–360
Remember icon, 5
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REMEMBERFOLDERS system variable, 504
renaming layout tabs, 213
render preset, 483
Render tab (Ribbon), 426
rendering, 474, 483–484
resources, 497–500
Retain radio button, 329
REVCLOUD command, 112, 120–122
REVERSE command, 178, 202
revision clouds, drawing, 120–122
revision numbers, including, 122
REVolve command, 458
revolving, 458
Rewind tool, 438
Ribbon

about, 21, 26
accessing 3D modeling tools from, 426–427
customizing, 27, 508
docking, 27, 510
finding hidden commands on, 112
tabs on, 28–29

right-clicking, 137, 276
rollover highlighting, 172
ROLLOVERTIPS system variable, 505
ROtate command, 178, 189–190, 459–460
Rotation option (ELlipse command), 116
Running object snap technique, 133

• S •
sample files (website), 86
Save As command (Application menu), 24
Save As option, 17
Save command (Application menu), 24
Save Drawing As dialog box, 80, 81
scale, 67–70, 157, 214–216
SCale command, 69, 178, 190–191, 459–460
scale factor, 228
scaling

about, 301–303
crosshatches, 286–287
dimensions for output, 271–274
object's linetype, 160–161

Scientific units, 65
screen capture, 487

screen colors, controlling plotted lineweights with, 
311–314

screening, 305
Search (Application menu), 25
second point, 180
SECTIONPLANE command, 472
SECTIONPLANEJOG command, 472
SECTIONPLANETOBLOCK command, 472
security, cloud, 408, 410–411
Select Annotation Scale dialog box, 231
Select Color dialog box, 152, 153
Select File dialog box, 241, 412
Select Linetype dialog box, 153, 154
Select Reference File dialog box, 352, 354
Select Template dialog box, 41, 72, 81, 447
selection preview features, 172
selection window, 169–170
selection-first editing, 166
self-scaling annotations, compatibility and, 493
sending files, 402
SETBYLAYER command, 146
setting(s)

dimension scales, 77–79
draw order, 282
layers to be current layers, 156
linetype, 77–79
syncing, 413
text styles, 226–228
toggling, 41
units, 74–75

Settings dialog box, 250
Settings tab (UCS dialog box), 431
setup

about, 40–45, 63–64
layouts in paper space, 210–213
roadmap for, 64–71

Shaded Viewport Options (Plot dialog box), 318
Shaded visual style, 439
Shaded with Edges visual style, 439
Shades of Gray visual style, 439
shadows, 477–478
sharing, with A360, 413
sheet sets, 507
SHEETSET command, 507
shift+right-clicking, 137
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Show all button (Geometric panel), 381
Show Menu Bar option, 23
Show/Hide button (Geometric panel), 381
SHX font, 225
simple array, 344, 345
single-line text, 229
Sketchy visual style, 439
SLice command, 463–464
smart breaks, 275
Smooth constraint, 381
snap, 142
Snap mode, 75–77, 127, 139
snapping, into model space, 218
SOLDRAW command, 472
solid boxes, creating, 431–432
solid fill, 291
solid models, 422–423, 453–454
Solid tab (Ribbon), 426
solids, editing, 461–464
SOLPROF command, 472
SOLVIEW command, 472
source object, 200
space tabs, 22
spacebar, 12, 43
special effects, 224
Spherical coordinates, 428
SPLine command, 112, 117–119
SPLINEDIT command, 118
splines, 117–119, 452
spotlight, 476
square brackets, 35
stacking layers, 148
standardization through customization, 289
Start Drawing icon, 10, 41
starting commands, 12
static columns, 240–241
status bar, 22, 129
status bar button, 216
STB (named plot style table) file, 307
SteeringWheels, 438
STL files, exporting, 490
straight lines, 97
straight-line drawing commands, 99–100
Stretch command, 56–59, 178, 183–187

stretching, 205
STyle command, 242
style families, 268
style settings, adjusting, 268–271
styles

adding to crosshatches, 288–289
changing, 271
dimensions and, 262–271
of editing, 166–168
overriding, 276
plot, 305–310
for text, 224–228

subobjects, selecting, 459
suboptions (Hatch tab), 285
SUbtract command, 462
suite, 29
Sun Properties palette (Render tab of Ribbon), 427, 478
sunlight, 478
surface models, 422
Surface tab (Ribbon), 426
Surveyor's Units, 66
SV$ command, 206
SWEEP command, 457
sweeping, 457
Symbols and Arrows tab, 269
Symmetric constraint, 381
syncing settings, 413
system driver, 320
system printer driver, 319–320
system printers, 211, 298
system variables, 264, 501–502. See also specific system 

variables

• T •
TABLE command, 247–249
table objects, 245–249
Table Style dialog box, 245–246
tables, 247–249, 493
TABLESTYLE command, 245–247
tabs

about, 21, 212–213
DesignCenter, 163
Ribbon, 28–29
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Tangent constraint, 381
TANgent mode, 136
Tangent-Tangent-Radius (Ttr) option (Circle command), 

113
Tangent-Tangent-Tangent option (Circle command), 113
Technical Stuff icon, 5
Template Options dialog box, 81
templates

about, 71–73
creating, 80–84
defined, 72
generic, 79
3D, 445–449
using, 218

Temporary override mode, 141
Test Block tool, 371
text

about, 221–222
adding in model space, 223–224
adding in paper space, 223
drawing scale, 228–229
enabling annotative scaling, 242–245
entering, 229–230
mText command, 233–242
multiline leaders, 249–252
preparing to write, 222–224
styles for, 224–228
tabbing to, 269
table objects, 245–249
TEXT command, 230–232

text annotations, 68
TEXT command, 229–232, 242
Text Editor tab, 236
text height, 224
text objects, geometric constraints and, 381
Text Style dialog box, 224, 225, 226, 230, 269
text styles, 224, 226–228
Text tab, 269
text value, 338
TEXTTOFRONT command, 237, 276
thickness, adding, 455
3 Point option (UCS command), 431
3D Basics workspace, 424
3D coordinate entry, input formats for, 428
3D Modeling workspace, 424, 426–427

3D models
about, 421–422, 443–444, 465–466
changing planes, 429–434
compatibility and, 493
model space capabilities in, 445–451
modifying 3D objects, 459–464
navigating, 435–438
producing a 2D view from, 466–473
rendering, 483–484
techniques for, 451–454
tools for, 423–427
types of, 422–423
uses for, 444–445
visual styles, 439–441
Z coordinate, 427–429

3D Object snap technique, 127
3D objects, 423
3D Polyline object, 452
3D printing, 490
3D templates, 445–449
3DALign command, 461
3DDWF command, 489
3DOrbit, 436–437
3DPOLY command, 452
3-Point (3P) option (Circle command), 113
tiled viewports, 214
Tip icon, 5
title blocks, creating, 71
TOLerance command, 271
Tool Palettes window, 332
tools, for 3D models, 423–427
tooltips, 29
TOOLTIPS system variable, 505
Tour Building wheel, 438
translation, 492–493
Transparency property, 150, 291
TRim command, 178, 194–196
troubleshooting

A360, 414
editing, 205–206
plotting, 319–320

TrueType font, 225
2D coordinate entry, input formats for, 428
2D Navigation wheel, 438
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2D objects, adding third dimension to, 455–458
2D wireframe visual style, 439
2-Point (2P) option (Circle command), 113

• U •
U command, 205
UCS (user coordinate systems), 130
UCS dialog box, 430, 431, 433
UCS icon, 216, 424, 429, 430
Undo button, 206
UNDO command, 205
Undo option (COpy command), 183
Uniform Resource Locator (URL), 405
UNIon command, 462
UNISOLATEobjects command, 175
units, 64–66, 74–75
Unload option (External References palette), 359
updates (book), 6
Upload Documents dialog box, 412
URL (Uniform Resource Locator), 405
user coordinate systems (UCS), 130, 430–434
user folders, finding, 82–83
user groups, 500
user-defined lighting, 474, 475–478

• V •
Value option (Constraint Settings dialog box), 393
variable height, 227
VBA, 508
vector drawing, 362
vector file, 15, 487–488
vectorization, 362
vectors, 14–15
versions, 2, 17, 509
vertex object, 423
Vertical constraint, 381, 389
vertical dimension, 255
view, 86
View command, 90
View Manager dialog box, 90, 92, 482
View Object wheel, 438
View option (UCS command), 431
View tab (Ribbon), 28, 426, 427

VIEWBASE command, 473
ViewCube, 88, 437–438, 448–449
VIEWDETAIL command, 473
Viewpoint Presets dialog box, 436
viewports, 211–212, 217, 445
Viewports dialog box, 448
VIEWPROJ command, 471
VIEWRES command, 94
VIEWSECTION command, 473
visibility, 175–176, 367–371
visibility modes, 157–158, 175–176
Visibility States dialog box, 371
VISRETAIN system variable, 505–506
visual styles, in 3D modeling, 439–441
Visual Styles Manager, displaying, 441
Visual Styles Manager palette (View tab of Ribbon), 427
VPORTS command, 447

• W •
Warning icon, 5
WBLOCK (WriteBlock) command, 329, 340
WCS. See world coordinate system (WCS)
weblight, 476
websites. See also specific websites

book updates, 6
B-splines, 117
Cheat sheet, 6
default drawing templates, 71
observable universe, 15
sample files, 86

What’s Inside? AutoCAD for Macintosh (Grabowski), 2
wheel mouse, 54, 86–87
Willis, Kimberly (author)

Raising Chickens For Dummies, 279
window lasso, 171
window object selection, 169–170
Window option, 89, 172
Windows 7, 82, 299, 319
Windows 8, 82–83, 299, 320
Windows 10, 299, 320
Windows Meta File (WMF), 487–488
Windows Registry, system variables in, 502
Windows Vista, 299, 319
Windows XP, 82, 299
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wireframe models, 422
Wireframe visual style, 440
WMF (Windows Meta File), 487–488
WMFOUT command, 488
Workspace Switching button, 29, 447
workspaces, 23, 424
world coordinate system (WCS)

about, 129, 430
drawing by coordinates, 131–133
input, 129–130
user coordinate systems (UCS), 130

World option (UCS command), 431
WPolygon option, 172

• X •
XLine command, 100
XML Paper Specification (XPS), 489

XOPEN command, 357
XPS (XML Paper Specification), 489
X-ray visual style, 440
xref. See external reference file (xref)
xref clipping, 360

• Y •
YouTube, 499

• Z •
Z coordinate, 427–429
Z value, 131
Zoom All command, 89, 180
Zoom command, 89–90
Zoom Extents button, 89
zooming, 54, 88–89
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